User's Guide

STRUCTURAL RESEARCH & ANALYSIS CORP.
First Edition
COSMOS/M 2.7
December 2001

Copyright
This software product is copyrighted and all rights are reserved by Structural Research and Analysis Corporation. (SRAC) Copyright© 1985 - 2002 Structural Research and Analysis Corporation. All Rights Reserved.

The distribution and sale of this product (COSMOS/M Version 2.7) is intended for the use of the original purchaser only and for use only on the computer system specified. The software product may be used only under the provisions of the license agreement that accompanies the product package.

COSMOS/M manuals may not be copied, photocopied, reproduced, translated or reduced to any electronic medium or machine readable form in whole or part without written consent from Structural Research and Analysis Corporation. Structural Research and Analysis Corporation makes no warranty that COSMOS/M is free from errors or defects and assumes no liability for the program. Structural Research and Analysis Corporation disclaims any express warranty or fitness for any intended use or purpose. You are legally accountable for any violation of the License Agreement or of copyright or trademark. You have no rights to alter the software or printed materials. The COSMOS/M program is constantly being developed, modified and checked and any known errors should be reported to Structural Research and Analysis Corporation.

Disclaimer
The authors have taken due care in preparing this manual and the examples presented herein. In no event shall SRAC assume any liability or responsibility to any person or company for direct or indirect damage resulting from the use of the information contained herein or any discrepancies between this information and the actual operation of the software.

Licenses & Trademarks
Use by Structural Research and Analysis Corporation of ANSYS Input Commands and Command Structure herein is licensed under agreement with Swanson Analysis Systems, Inc. All rights reserved. COSMOS/M and COSMOS are registered trademarks of Structural Research and Analysis Corporation. All other COSMOS/M module names are trademarks of Structural Research and Analysis Corporation.

ABAQUS is the registered trademark of Hibbitt, Karlsson & Sorensen, Inc. ANSYS is a registered trademark of Swanson Analysis Systems. AutoCAD is registered in the U.S. Patent and Trademark Office by Autodesk, Inc. DXF and AutoSolid are registered trademarks of Autodesk, Inc. CenBASE/Mil5 is the registered trademark of Information Indexing, Inc. DECStation is the registered trademark of Digital Equipment Corporation. EPSON is the registered trademark of Epson Computers. HP is the registered trademark of Hewlett-Packard. IBM is the registered trademark of International Business Machines Corporation. MSC/NASTRAN is the registered trademark of MacNeal-Schwendler Corp. PATRAN is the registered trademark of PDA Engineering. PostScript, Acrobat, and Acrobat Reader are registered trademarks of Adobe Systems, Inc. SINDA/G is a registered trademark of Network Analysis Associates, Inc. Sun is the registered trademark of Sun Microsystems, Inc. SGI is the trademark of Silicon Graphics, Inc. SolidWorks is a registered trademark of SolidWorks Corporation. Helix Design System is a trademark of MICROCADAM Inc. SDRC I-DEAS is a trademark of Structural Dynamics Research Corporation. MicroStation Modeler is a registered trademark of Bentley Systems, Incorporated. Solid/Edge is a trademark of Intergraph Corporation. Eureka is a trademark of Cad.Lab. All other trade names mentioned are trademarks or registered trademarks of their respective owners.
Contents

1 Introduction .............................................. 1-1
   Overview ................................................. 1-1
   COSMOS/M Structure ..................................... 1-2
   Supported Platforms ...................................... 1-3
   GEOSTAR Features ....................................... 1-4
   COSMOS/M Analysis Modules .............................. 1-9
      The Linear Static Analysis Module (STAR) ............ 1-9
      The Frequency and Buckling Analysis Module (DSTAR) 1-10
      The Heat Transfer Analysis Module (HSTAR) ............ 1-10
   COSMOS/FFE Modules ..................................... 1-11
      The Advanced Dynamic Analysis Module (ASTAR) ....... 1-12
      The Nonlinear Structural Analysis Module (NSTAR) ..... 1-13
      The Fatigue Analysis Module (FSTAR) .................... 1-15
      The Turbulent Flow Package (FLOWPLUS) ............... 1-15
      The Low Frequency Electromagnetic Analysis Module (ESTAR) 1-16
      The Design Optimization and Sensitivity Module (OPTSTAR) 1-17
      The High Frequency Electromagnetic Simulation and Analysis Package (COSMOS/HFS Suite) ... 1-20
   About Solvers ........................................... 1-22
      The Direct Sparse Solver ................................ 1-23
      The Iterative (PCG) Solver ............................. 1-23
      Choosing a Solver ...................................... 1-23
   About This Manual ....................................... 1-27
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applying Loads and Boundary Conditions</td>
<td>2-39</td>
</tr>
<tr>
<td>Performing the Analysis</td>
<td>2-40</td>
</tr>
<tr>
<td>Postprocessing of the Static Analysis Results</td>
<td>2-41</td>
</tr>
</tbody>
</table>

### 3 Exploring GEOSTAR 3-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3-1</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>3-2</td>
</tr>
<tr>
<td>Preprocessing</td>
<td>3-4</td>
</tr>
<tr>
<td>Building the Geometry of the Model</td>
<td>3-5</td>
</tr>
<tr>
<td>Advantages of Using Geometry</td>
<td>3-5</td>
</tr>
<tr>
<td>Geometric Entities in GEOSTAR</td>
<td>3-6</td>
</tr>
<tr>
<td>Classification of Geometry Commands</td>
<td>3-11</td>
</tr>
<tr>
<td>Geometry Information</td>
<td>3-13</td>
</tr>
<tr>
<td>Finite Elements</td>
<td>3-13</td>
</tr>
<tr>
<td>Element Attributes</td>
<td>3-14</td>
</tr>
<tr>
<td>Meshing in Geostar</td>
<td>3-20</td>
</tr>
<tr>
<td>Direct Mesh Generation</td>
<td>3-22</td>
</tr>
<tr>
<td>Parametric Meshing</td>
<td>3-22</td>
</tr>
<tr>
<td>One- and Two-Dimensional Automatic Meshing</td>
<td>3-23</td>
</tr>
<tr>
<td>Procedures for 3D Automatic Meshing</td>
<td>3-25</td>
</tr>
<tr>
<td>Applying Loads and Boundary Conditions</td>
<td>3-40</td>
</tr>
<tr>
<td>Applying Loads Resulting from a Different Analysis Module</td>
<td>3-43</td>
</tr>
<tr>
<td>Multiple Load Cases in Linear Static Analysis</td>
<td>3-45</td>
</tr>
<tr>
<td>Analysis Options</td>
<td>3-46</td>
</tr>
<tr>
<td>Notes On Solvers</td>
<td>3-47</td>
</tr>
<tr>
<td>Direct Skyline Solver</td>
<td>3-48</td>
</tr>
<tr>
<td>Direct Sparse Solver</td>
<td>3-48</td>
</tr>
<tr>
<td>Iterative (PCG) Solver</td>
<td>3-49</td>
</tr>
<tr>
<td>Choosing a Solver</td>
<td>3-49</td>
</tr>
<tr>
<td>Postprocessing</td>
<td>3-53</td>
</tr>
<tr>
<td>The Results Files</td>
<td>3-54</td>
</tr>
<tr>
<td>Combining Load Cases and Static/Dynamic Results</td>
<td>3-55</td>
</tr>
<tr>
<td>Averaging Stress Results</td>
<td>3-55</td>
</tr>
<tr>
<td>Listing Output Results and Extreme Values</td>
<td>3-55</td>
</tr>
<tr>
<td>Deformation and Force/Bending Moment Displays</td>
<td>3-57</td>
</tr>
<tr>
<td>Contour and Vector Displays</td>
<td>3-57</td>
</tr>
</tbody>
</table>
## Contents

- Contour and Vector Displays of User's Data .................................. 3-57
- Isosurfaces and Sectioning ............................................................... 3-58
- 3-12. Commands for Isosurfaces ..................................................... 3-58
- Animation ......................................................................................... 3-58
- X-Y Type Graphs .............................................................................. 3-59
- Viewing Different Plots on the Same Screen ..................................... 3-59
- Display Options ................................................................................ 3-60
- Multi-Window Environment ............................................................... 3-60
- View .................................................................................................. 3-60
- Display Control ................................................................................ 3-60
- General Control Features ................................................................. 3-61
- Problem Title .................................................................................. 3-62
- Session File ...................................................................................... 3-62
- Geometric or Neutral File Format .................................................... 3-62
- Importing GEOSTAR Input Files ....................................................... 3-63
- Copying the Database Files ............................................................... 3-63
- Creating a New Problem .................................................................. 3-64
- Symbol Size Control ......................................................................... 3-64
- Writing Screen Lists to a File ............................................................ 3-65
- Selection Lists .................................................................................. 3-65
- Activating a Set ................................................................................ 3-67
- The Status1 Table ........................................................................... 3-67
- The Status2 Table ........................................................................... 3-69
- Color Code ....................................................................................... 3-69
- Resetting .......................................................................................... 3-70
- COSMOS/M Interface with Other Packages ..................................... 3-70
- Parametric Language ....................................................................... 3-72
- Output Devices ................................................................................ 3-73
- Image Saving, Restoring and Hard Copies ........................................ 3-74
- Saving and Restoring Images ............................................................. 3-78
- Saving or Printing Multiple Images in One Figure ............................. 3-79
- Size Limitations .............................................................................. 3-79
- Diagnosis of Solid Automatic Meshing Problems ............................. 3-82
- Overview of the Automatic Solid Meshing Procedure ....................... 3-82
- Use of Error Messages to Diagnose and Fix Meshing Problems ........ 3-83
- Commands Related to 3D Automatic Meshings ................................. 3-88
- Hierarchical Versus Sweeping Region-Meshing ............................... 3-88
Contents

4  Element Library ............................................. 4-1
   Introduction ................................................ 4-1
   General Description ....................................... 4-99

5  Modeling Examples ......................................... 5-1
   Introduction ................................................ 5-1
   Keyway Model .............................................. 5-3
   Example on Region Meshing ................................ 5-10
   Sprocket Model ............................................ 5-13
   Turbine Casing Model ..................................... 5-15
   Model of a Helicoid ....................................... 5-19
   Model of a Pipe and Curved Surface Connection ........ 5-22
   Model of an Open Pipe with Flange ...................... 5-25
   Model of a Tank with Stiffeners ......................... 5-28
   Pipe Intersection Model ................................... 5-31
   Model of a Lever .......................................... 5-34
   Surface Intersection Example ............................. 5-37
   Example on Dragging Meshed Regions to Generate 3D Mesh .... 5-45
   A Wheel Section: 3D Automatic Meshing Example .......... 5-48
   3D Automatic Meshing for a Widget with Openings ........ 5-57
   Crank Shaft Connector Using 3D Automatic Meshing ........ 5-73
   Welded Angle Connection: 3D Automatic Meshing .......... 5-97
   Example on Selection Lists, Element Coloring and Element Property Changing ................................... 5-117
   Example on Using Parametric Variables .................... 5-131

6  Analysis Examples ........................................... 6-1
   Introduction ................................................ 6-1
   The Extruded Spline Model ................................ 6-3
   Buckling of a Beam ......................................... 6-14
   Natural Frequencies of a Ring ............................. 6-17
## Contents

Beam Loading and Generation of Shear and Moment Diagrams ........ 6-19  
Stress Output for 3D Beam Elements ......................... 6-22  
Substructuring in Linear Static Analysis ..................... 6-25  

### A Units .................................................. A-1  
International System of Units .................................. A-1  
U.S. Customary System of Units ................................ A-2  
Engineering Prefixes ......................................... A-5  
Tables of Consistent Units for COSMOS/M Modules ............ A-5  

### B Database ............................................... B-1  
Database Files ................................................. B-1  
GEOSTAR Module ............................................... B-1  
STAR Module (Linear Static Analysis) ......................... B-4  
STRESS Module (Stress Analysis) .............................. B-4  
RENUMBER Module ............................................. B-5  
DSTAR Module (Frequency and Buckling Analyses) ........... B-6  
HSTAR Module (Thermal Analysis) ............................. B-6  
NSTAR Module (Nonlinear Static and Dynamic Analysis) .... B-7  
FSTAR Module (Fatigue Analysis) .............................. B-9  
FLOWSTAR Module (Computational Fluid Dynamic Analysis) B-9  
ESTAR Module (Electromagnetics Analysis) .................... B-10  
ASTAR Module (Post Dynamic Analysis) ....................... B-11  
OPTSTAR Module (Design Optimization) ...................... B-12  
Database Utility .............................................. B-12  

### C Translators ............................................. C-1  
Working with CAD ............................................. C-2  
IGES Translator ............................................... C-3  
DXF Translator ............................................... C-7  
ABAQUS Translator ........................................... C-10  
ANSYS Translator .............................................. C-11  
COSMOS/M to ANSYS .......................................... C-11  
ANSYS to COSMOS/M .......................................... C-13  
NASTRAN Translator ........................................... C-14  
COSMOS/M to NASTRAN ....................................... C-14  
Postprocessing Nastran Results In GEOSTAR .................. C-16
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>NASTRAN to COSMOS/M</td>
<td>C-16</td>
</tr>
<tr>
<td>PATRAN Translator</td>
<td>C-17</td>
</tr>
<tr>
<td>COSMOS/M to PATRAN</td>
<td>C-18</td>
</tr>
<tr>
<td>PATRAN to COSMOS/M</td>
<td>C-18</td>
</tr>
<tr>
<td>Pro/ENGINEER and PT/Modeler Translators</td>
<td>C-19</td>
</tr>
<tr>
<td>SINDA Translator</td>
<td>C-20</td>
</tr>
<tr>
<td>Installation</td>
<td>C-21</td>
</tr>
<tr>
<td>Using the Translator</td>
<td>C-21</td>
</tr>
<tr>
<td>Guidelines for Thermal Modeling with GEOSTAR</td>
<td>C-25</td>
</tr>
<tr>
<td>Thermal Boundary Conditions</td>
<td>C-26</td>
</tr>
<tr>
<td>Contact Resistance's</td>
<td>C-27</td>
</tr>
<tr>
<td>Coolant Loop Modeling</td>
<td>C-27</td>
</tr>
<tr>
<td><strong>D  COSMOS/M Command Language</strong></td>
<td><strong>D-1</strong></td>
</tr>
<tr>
<td>Concepts of Cosmos/M Language</td>
<td>D-2</td>
</tr>
<tr>
<td>Arithmetic Operations</td>
<td>D-4</td>
</tr>
<tr>
<td>Parameters</td>
<td>D-5</td>
</tr>
<tr>
<td>Parametric Variables</td>
<td>D-7</td>
</tr>
<tr>
<td>Array Parameters</td>
<td>D-11</td>
</tr>
<tr>
<td>Functions</td>
<td>D-16</td>
</tr>
<tr>
<td>Control Structures: GOTO, IF-ELSEIF-ELSE, and LOOP</td>
<td>D-37</td>
</tr>
<tr>
<td>Logical Expressions</td>
<td>D-38</td>
</tr>
<tr>
<td>IF Statement</td>
<td>D-40</td>
</tr>
<tr>
<td>Looping</td>
<td>D-41</td>
</tr>
<tr>
<td>Unconditional Transfer of Control</td>
<td>D-44</td>
</tr>
<tr>
<td>Macro(s)</td>
<td>D-44</td>
</tr>
<tr>
<td>Application Example</td>
<td>D-48</td>
</tr>
<tr>
<td>Special Application: Hydrostatic Pressure</td>
<td>D-53</td>
</tr>
<tr>
<td>Simple Optimization Application</td>
<td>D-56</td>
</tr>
<tr>
<td><strong>E  Troubleshooting</strong></td>
<td><strong>E-1</strong></td>
</tr>
<tr>
<td>Common Problems</td>
<td>E-2</td>
</tr>
<tr>
<td><strong>F  Input File Structure</strong></td>
<td><strong>F-1</strong></td>
</tr>
<tr>
<td>COSMOS/M Input File Structure</td>
<td>F-1</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td></td>
</tr>
</tbody>
</table>
1

Introduction

Overview

COSMOS/M is a complete, modular, self-contained finite element system developed by Structural Research and Analysis Corporation (SRAC) for personal computers and workstations. The program includes modules to solve linear and nonlinear static and dynamic structural problems, in addition to problems of heat transfer, fluid mechanics, electromagnetics and optimization. Modules for such special analysis options as fatigue are also available. The system is constantly developed and maintained by using state-of-the-art techniques and up-to-date hardware capabilities.

This chapter introduces the COSMOS/M product line and outlines the features of its various modules.
Chapter 1   Introduction

**COSMOS/M Structure**

The COSMOS/M system consists of a pre- and postprocessor, various analysis modules, interfaces, translators and utilities. The program is completely modular allowing you to acquire and load only the modules that you need.

GEOSTAR is the basic pre- and postprocessor of the COSMOS/M finite element system. It is an interactive full three-dimensional CAD-like graphic geometric modeler, mesh generator and FEA pre- and postprocessor. You can create the geometric model, mesh it, provide all analysis related information, perform the desired type of analysis, review, plot and print the results, without having to leave the GEOSTAR screen. The program is powerful, intuitive, and easy to learn and use. The average user can learn, create and solve real life problems after few hours of training.

The GEOSTAR program, as shown in Figure 1-1, controls the execution of the various analysis modules of the COSMOS/M package and provides an interactive environment among them. These modules are:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAR</td>
<td>Linear Static Analysis</td>
</tr>
<tr>
<td>FFE STATIC</td>
<td>FFE (Fast Finite Element) Linear Static Analysis</td>
</tr>
<tr>
<td>DSTAR</td>
<td>Buckling, Frequency and Mode Shape Analysis</td>
</tr>
<tr>
<td>FFE FREQUENCY</td>
<td>FFE Frequency Analysis</td>
</tr>
<tr>
<td>NSTAR</td>
<td>Nonlinear Static and Dynamic Analysis</td>
</tr>
<tr>
<td>HSTAR</td>
<td>Heat Transfer Analysis</td>
</tr>
<tr>
<td>FFE THERMAL</td>
<td>FFE Heat Transfer Analysis</td>
</tr>
<tr>
<td>FSTAR</td>
<td>Fatigue Analysis</td>
</tr>
<tr>
<td>ASTAR</td>
<td>Advanced Dynamic Analysis</td>
</tr>
<tr>
<td>OPTSTAR</td>
<td>Optimization</td>
</tr>
<tr>
<td>FLOWPLUS</td>
<td>2D and 3D Laminar and Turbulent Fluid Analysis</td>
</tr>
<tr>
<td>ESTAR</td>
<td>Low Frequency Electromagnetic Analysis</td>
</tr>
<tr>
<td>HFS 2D</td>
<td>2D High Frequency Electromagnetic Analysis</td>
</tr>
<tr>
<td>HFS 3D</td>
<td>3D High Frequency Electromagnetic Analysis</td>
</tr>
<tr>
<td>HFS CAVITY</td>
<td>Resonant Cavities Analysis</td>
</tr>
</tbody>
</table>
Chapter 1   Introduction

The COSMOS/FFE modules are developed for the solution of large problems using sparse matrix technology along with iterative methods combined with novel database management techniques to substantially reduce solution time, disk space, and memory requirements.

Further, GEOSTAR furnishes a 2-way interface with many CAD and Solid Modeling systems. Models created by the following CAD systems can be imported to GEOSTAR:

SolidWorks, Solid/Edge, MicroStation Modeler, AutoCAD, Pro/ENGINEER, PT/Modeler, Helix Design System, Computervision CADDS5, Unigraphics, IDEAS (SDRC), and Eureka. Geometry from other CAD packages may also be tried through IGES files. Fully-integrated products are available for SolidWorks and MicroStation Modeler and seamless interfaces are also available for Pro/ENGINEER, PT/Modeler, Solid/Edge, Helix, and Eureka.

You can also import/export your analysis models to and from the following finite element analysis systems through one-way or two-way translators as shown in Figure 1-1:

ABAQUS, ANSYS, NASTRAN, PATRAN, and SINDA.

In addition, COSMOS/M interfaces with ADAMS (The Mechanical Dynamics Inc. kinematics and dynamics program) for linear stress analysis of kinematic problems.

Supported Platforms

The COSMOS/M system supports Pentiums and compatibles running Windows 95, 98, NT, or Windows 2000.
GEOSTAR Features

The geometric capabilities of GEOSTAR are based on the mixed boundary representation (B-rep) and parametric cubic equations.

A diverse set of geometric modeling capabilities combined with flexible meshing options allow for the creation and meshing of complex models with ease. Loading, boundary, and initial conditions can conveniently be applied in association with geometric entities and in any defined coordinate system.

GEOSTAR has many powerful capabilities and features that work in a user friendly environment. More information on the various aspects of this module are given in Chapter 3.
Chapter 1   Introduction

Pull-Down Menus and Geo Panel
All GEOSTAR commands are accessible by the mouse from the pull-down menus. Commands are grouped in an intuitive way that makes it easy to select and issue the proper command to perform the desired function. Once a command is issued, you will be guided by dialog boxes throughout the input process. Default entries are used where appropriate. The Geo Panel window provides toolbars and buttons for quick access to commonly used commands.

Friendly Interface
GEOSTAR guides you throughout the input process. Items and dialog boxes and prompts list all possible entries. Error messages are issued in a simple and direct manner. Many listing commands are available to inform you on the status of the database. The STATUS1 and STATUS2 commands provide a convenient way to control colors and cross referencing flags. All screen listing can be recorded in a file using the LISTLOG (Control > MISCELLANEOUS > Listlog) command. This function can help you generate reports.

Modeling
You can build your geometry directly in GEOSTAR or you can use your favorite CAD or solid modeling system and export the geometry to GEOSTAR. GEOSTAR's comprehensive list of geometry-related commands makes it possible to quickly and accurately create, modify, list, delete, undelete, pick and identify geometric entities. The geometric entities in GEOSTAR include keypoints, curves, surfaces, volumes, contours, regions, polyhedra and parts. These entities can be combined and used to create complex models. Models created by the following CAD systems can be imported to GEOSTAR:

SolidWorks, Solid/Edge, MicroStation Modeler, AutoCAD, Pro/ENGINEER, PT/Modeler, Helix Design System, Computervision CADDSS5, Unigraphics, IDEAS (SDRC), and Eureka. Geometry from other CAD packages may also be transferred through IGES files. Fully-integrated products are available for SolidWorks and MicroStation Modeler and seamless interfaces are also available for Pro/ENGINEER, PT/Modeler, Solid/Edge, Helix Modeling (MICROCADAM), and Eureka (CadLab).

Structural Research and Analysis offers a special product called COSMOS/DesignSTAR to directly read geometric models from CAD systems. You can perform static, frequency, buckling, heat transfer, electromanetic, and fluid flow analyses in COSMOS/DesignSTAR. Nonlinear structural analysis is being added. COSMOS/DesignSTAR models can be exported to GEOSTAR.
Chapter 1  Introduction

Importing SolidWorks Assemblies

Assemblies from SolidWorks are directly imported as geo files through COSMOS/Works. You can run basic types of analyses in COSMOS/Works or import the geo file to GEOSTAR to perform advanced analyses.

Mesh Generation

Mesh generation is simple and powerful through commands dealing with one, two, and three dimensional models. Meshing commands operate on predefined geometric entities to create a finite element mesh. The degree of control over the meshing process is determined by the user through a variety of commands. Complex multi-connected regions, in particular, can be easily meshed using the contour and region entities. 3D elements can be generated by extruding, sweeping, gliding or dragging 2D elements. In addition, meshing of complex 3D surface and solid geometries is also possible using GEOSTAR's powerful 3D automatic meshing capability. Mesh density can be fully controlled throughout the model.

To further simplify the modeling and meshing of complex problems, the “bond” feature can be used to mesh different parts of the model separately, even using different types of elements if necessary, and then bond them together for analysis.

Loads and Boundary Conditions

Loads and boundary conditions can be directly applied to nodes or elements or indirectly through association with geometric entities. This feature simplifies the process and minimizes the required input time. Loads and boundary conditions should be applied after meshing.

Element Library

GEOSTAR provides an extended element library that gives you the power required to model the physical problem in the most accurate way.

Adaptive Meshing

Adaptive meshing using the H-method provides you with automatic mesh refinement at the areas of stress concentration to evaluate and improve the accuracy of results for linear static analysis problems. The H-method is currently available for the 3-node and the 6-node triangular plane element (TRIANG), 4- and 10-node
tetrahedral solid elements (TETRA4, TETRA4R, TETRA10) and 3-node shell elements (SHELL3, SHELL3T). The P-method internally uses a higher polynomial order (instead of creating additional nodes) to improve the accuracy. The P-method is currently available for the 8-node PLANE2D, 6-node TRIANG, TETRA10 and SHELL9L elements. An option to combine the H and P methods is also available.

**Command Language Programming**

COSMOS/M offers parametric input including arrays, user defined functions and macros to conduct design and sensitivity analyses. With these features, you can build application programs to automatically construct and analyze designs using sophisticated programming functions.

**Selection Lists**

A selection list is a filtered set of the members of an entity. Multiple selection lists can be defined for nodes, elements and geometric entities in GEOSTAR. Once activated, the selection list allows you to operate only on the selected members of that entity. Access will be denied to other members of the entity not included in the list. Various ways to add to or take away from selection lists are provided. A facility to perform set operations like union and intersection is provided for selection lists.

**Multiple Windows**

GEOSTAR works in either the basic screen or multiple window environment. The created windows can be easily manipulated for convenient viewing while developing or processing the model.

**On-Line Help**

The help system for COSMOS/M 2.6 includes:

- a what’s new section describing new and enhanced functionality.
- detailed help for each command accessible from the Help button in the dialog box of the command. Many commands include graphics and procedures to illustrate their functions. Links to related commands are also provided.
- detailed information about all elements in GEOSTAR’s element library with full details and many colored illustrations.
Chapter 1  Introduction

- a quick step-by-step tutorial to help you get started with GEOSTAR.
- procedures to perform various types of analyses.
- error messages and remedies.

**Chronological Record (Session File)**

A file is automatically generated by GEOSTAR to maintain a complete chronological record of all action commands. This file (called the session file) provides a backup in case of problems with the database. A new database can be generated by simply reading the session file into GEOSTAR using the **FILE** (File > **Load**) command.

**Geometric Format**

Recreation of a model from the session file can take a long time due to the fact that it contains intermediate steps that do not contribute to the final state of the model. The geometric format ignores such intermediate steps by operating directly on the database. An ASCII file representing the current state of the model is generated. This file can be later read into GEOSTAR to regenerate the model. The geometric (or neutral) format is a special format in which the equation of the related entity is represented. In addition to saving time, this utility is useful in combining independently created parts of a model. The utility is provided by the **GFORM_OUT** (Control > **UTILITY** > **Create GFM File**) command and can be used for both the geometry and finite element mesh.

**Extended Analysis Options**

GEOSTAR provides all of the necessary commands to define and perform all types of analyses available in the COSMOS/M package.

**Result Evaluation**

Once an analysis is performed, the user can proceed to evaluate the results. The postprocessing capabilities include graphic and text displays of results. Line, color-filled contour, vector plots, isoplane and section plots can be generated for various result quantities in the different modules. Animation is also provided for structural deformations, mode shapes, stresses, strains and many other response quantities. In addition, a utility for time-history or XY type plots is available. Also, you can take advantage of GEOSTAR’s postprocessing capabilities to plot your own data.
Chapter 1  Introduction

COSMOS/M Analysis Modules

The Linear Static Analysis Module (STAR)

STAR uses the linear theory of structures, based on the assumption of small displacements, to calculate structural deformations. STAR calls the STRESS submodule to calculate stresses. The following are some important features:

- Extensive element library (see Chapter 4)
- Isotropic, orthotropic, anisotropic and composite material properties
- Temperature-dependent material properties
- Failure criteria for composite elements
- Prescribed displacements, with or without other loadings
- Coupled degrees of freedom
- Constraint equations
- Thermal, gravitational and centrifugal loadings
- Beam loading
- Asymmetric loading of axisymmetric models
- Inplane effects in the stiffness evaluation
- Multiple load cases in a single run
- Soft spring option to prevent instabilities
- Substructuring capability to build and analyze chosen super-or macro-elements through condensation and recovery process
- Submodeling feature to refine selected portion of the model and re-perform the analysis only for the submodel
- Fluid-solid interaction
- Gap-friction problems
- 2D and 3D crack element options and J-integrals
- Adaptive P-, H-, and HP-versions of the finite element method
- Bonding of (or connecting) non-compatible separate parts of the same model even if nodes and element types don't match. Solid-solid, solid-shell and shell-shell bonds can be specified.
The Frequency and Buckling Analysis Module (DSTAR)

The DSTAR module evaluates natural frequencies and the corresponding mode shapes of a system. The module can also calculate buckling loads and the associated mode shapes. The following are some important features:

- A variety of eigenpairs extraction methods:
  - Subspace iteration
  - Lanczos
  - Jacobi
  - Inverse power iteration
- Calculation of complex eigenvalues
- Frequency shift to calculate eigenvalues in a specified range
- Sturm sequence to check for missed modes
- Lumped and consistent mass matrices
- Inplane effects on stiffness
- Soft spring option
- Piezoelectric analysis for hexahedron SOLID elements to account for coupling between elastic and electric fields (mode shape calculation)
- Mode shape calculations at specified harmonics for axisymmetric models with or without geometric stiffening
- Guyan reduction

The Heat Transfer Analysis Module (HSTAR)

The HSTAR module solves heat transfer problems involving conduction, convection, and radiation. The following are some important features:

- Linear and nonlinear, steady-state and transient heat transfer
- Temperature-dependent material properties
- Time- and temperature-dependent heat sources and sinks
- Time- and temperature-dependent boundary conditions:
  - Heat flux
  - Convection
  - Radiation
Chapter 1  Introduction

- Time dependent prescribed loads and boundary conditions
- Equilibrium iteration schemes:
  - Regular Newton-Raphson (tangent method)
  - Modified Newton-Raphson
- Calculation of radiation view factors
- Thermo-electric coupling for steady-state problems
- Heat transfer/structural coupling where resulting temperatures can be included in structural problems
- Thermal coupling and bonding
- Phase-change

COSMOS/FFE Modules

COSMOS/FFE modules are fast, robust, and accurate finite element programs for the stress (FFE Static), frequency (FFE Frequency), and thermal (FFE Thermal) analyses. The programs exploit a new technology developed at Structural Research for the solution of large systems of simultaneous equations using sparse matrix technology along with iterative methods combined with novel database management techniques to substantially reduce solution time, disk space, and memory requirements.

COSMOS/FFE modules have been written from scratch using state of the art techniques in FEA with two goals in mind: 1) to address basic design needs, and 2) to use the most efficient possible solution algorithms without sacrificing accuracy. The programs are particularly suitable to solve large basic models.

COSMOS/FFE modules are not meant to replace STAR, DSTAR, and HSTAR. The capabilities of a FFE module is a subset of the capabilities of the corresponding conventional solver. The advantage is that FFE solvers for the class of problems they support are far superior in terms of speed and use of computer resources. Refer to the COSMOS/FFE manual for details. Please refer to the Notes About Solvers section in this chapter for more details about solver options.
The Advanced Dynamic Analysis Module (ASTAR)

The ASTAR module uses DSTAR module results and the normal mode superposition method to calculate dynamic response of structures. The following are some important features:

- Extensive element library (see Chapter 4)
- Analysis options:
  - Modal time history
  - Uniform and Multi-base motion
  - Frequency response
  - Shock spectra
  - Response spectra generation
  - Random vibration
  - Steady-state harmonic analysis
  - PSD/Random response
- Several damping models:
  - Scalar
  - Dashpot
  - Discrete viscous
  - Modal viscous
  - Structural
  - Material
- Initial conditions
- Time and frequency curves
- Stress analysis
- 2-node gap element problems with friction
Chapter 1   Introduction

The Nonlinear Structural Analysis Module (NSTAR)

NSTAR solves nonlinear static and dynamic structural problems. The following are some of the module's capabilities:

- Extensive element library (see Chapter 4)
- Geometric nonlinearities:
  - Large displacements (Total and Updated Lagrangian formulations)
  - Large strain formulation for rubber-like materials and von Mises plasticity
- Material Models:
  - Linear elasticity
  - Nonlinear elasticity (user-defined stress-strain curve)
  - Hyperelasticity (Mooney-Rivlin, Ogden, and Blatz-Ko models)
  - Plasticity:
    - von Mises yield criterion with isotropic or kinematic hardening rules
    - Drucker-Prager elastic-perfectly plastic model
    - Concrete material model
  - Creep and viscoelasticity:
- Classical power law for creep
- Exponential creep law
- Linear isotropic viscoelastic model
  - Temperature-dependent material properties for thermo-elastoplastic analysis
  - Wrinkling membrane
  - User-defined material models
- Contact Problems:
  - Gaps, contact lines, and contact surfaces with generalized friction option
- Numerical Procedures:
  - Solution control techniques:
    - Force control
    - Displacement control
    - Riks arc-length control
  - Equilibrium iterations schemes:
    - Regular Newton-Raphson (tangent method)
    - Modified Newton-Raphson
Chapter 1   Introduction

• Quasi-Newton (BFGS) Broyden-Fletcher-Goldfarb-Shanno (secant method)
  – Termination schemes:
    • Convergence criteria
    • Divergence criteria
  – Line search option to improve convergence
  – User-controlled solution tolerances and iterations interval
  – Direct time implicit integration techniques:
    • Newmark-Beta method
    • Wilson-Theta method
  – Damping effects:
    • Rayleigh damping
    • Concentrated dampers
  – Base motion effects
  – Restart option
  – Adaptive automatic stepping algorithm
• Loadings:
  – Concentrated loads (forces and moments)
  – Pressure (with deformation-dependency option)
  – Thermal
  – Centrifugal
  – Gravity
  – Time curves to scale loading
• Other features:
  – Buckling analysis:
    • Limit load analysis
    • Post-buckling analysis (Snap-through, Snap-through/Snap-back, and Multiple Snap-through/Snap back problems)
  – Coupled degrees of freedom
    • Linear constraint equations, node-to-node, node-to-line, and node-to-surface and bond constraints.
  – Prescribed non-zero displacements associated with time curves
  – Initial conditions for dynamic analysis
  – Crack analysis using J-Integral as an elastic/plastic fracture parameter
Chapter 1  Introduction

The Fatigue Analysis Module (FSTAR)

The FSTAR module uses stress results from other modules to perform fatigue analysis. The module estimates the consumed life (fatigue usage factor) of the structural model due to cyclic loading events. The following are some important features:

- Extensive element library (see Chapter 4)
- Analysis procedures:
  - Miner's Rule
  - ASME Boiler and Pressure Vessel Code
  - Simplified elastoplastic formulation using the ASME specification
- Calculation of usage factor at a specified location
- Automatic calculation of the usage factor at all nodes
- Simplified input:
  - Stress results from linear, nonlinear and dynamic analyses as well as user specified stress patterns. Stress profiles based upon results from other modules can be modified by the user before performing a fatigue analysis
  - Fatigue events and associated number of cycles

The Turbulent Flow Package (FLOWPLUS)

FLOWPLUS is developed by Blue Ridge Numerics Inc. and is integrated within the COSMOS/M modeling and analysis environment. The program solves two and three dimensional compressible and incompressible flow and heat transfer problems. The following are some of its important features:

- 2D and 3D elements including quadrilaterals and triangles for plane and axisymmetric problems (with or without swirl) and brick, wedge (prism) or tetrahedral elements for three-dimensional problems.
- Different analysis fields including:
  - External and/or internal flow
  - Forced, natural, mixed and radiative heat transfer
  - Conjugate heat transfer (simultaneous conduction and convection)
  - Distributed resistance/porous media models
- Variety of modeling capabilities for:
  - Newtonian fluids (gases and liquids)
Chapter 1  Introduction

- Theoretically unlimited Reynolds number
- Incompressible flows with variable density (natural or mixed convection)
- Supersonic, Transonic, and Subsonic compressible flows
- Volumetric heat resources

• Boundary conditions are available for:
  - Prescribed
    • Nodal velocity
    • Nodal pressure
    • Nodal temperature
    • Nodal turbulent kinetic energy
    • Nodal turbulent energy dissipation
    • Edge/face heat flux
    • Edge/face film coefficient
    • Edge/face radiative film coefficient
  - Specified pressure

For new enhancements in FLOWPLUS, please refer to the *What's New* chapter in the *Getting Started Manual* or in the online help.

The Low Frequency Electromagnetic Analysis Module (ESTAR)

 chù COSMOS/DesignSTAR offers a 3D low-frequency electromagnetic analysis program.

The ESTAR module solves electromagnetic problems. The following are some of the important features:

• Analysis types:
  - Two-dimensional, axisymmetric and general three-dimensional magnetostatic analysis with current sources and permanent magnets
  - Two- and three-dimensional electrostatic analysis
  - Two-dimensional and axisymmetric transient electromagnetic analysis
  - Infinite elements for two- and three-dimensional magnetostatic and electrostatic problems
  - Nonlinear analysis specifying B-H material curves and/or magnet demagnetization curves
Chapter 1   Introduction

– Current flow analysis to calculate the current distribution and power losses in conductors
– Two-dimensional and axisymmetric frequency domain (AC). Eddy current analysis with multiple phase current loadings
– Energy-based approach to calculate the capacitance matrix for two-dimensional multi-conductor systems

• Iterative schemes for nonlinear analysis:
  – Regular Newton-Raphson (tangent method)
  – Modified Newton-Raphson

• Boundary conditions:
  – Nodal currents
  – Current densities on elements
  – Voltage and magnetic potentials
  – Magnetic coupling
  – Periodic boundary conditions

• Other features:
  – Electro-thermal coupling for current flow and magnetodynamic (Eddy current) analyses
  – Magneto-Structural coupling where resulting magnetic forces can be included in structural problems
  – Direct (Gaussian) and iterative (PCG) solution methods

The Design Optimization and Sensitivity Module (OPTSTAR)

OPTSTAR performs two-dimensional and three-dimensional sizing and shape optimization and sensitivity for structural and thermal applications. The following list summarizes OPTSTAR capabilities:

• Full interaction with GEOSTAR for model creation, results manipulation and display (pre- and postprocessing)
• Access to COSMOS/M and COSMOS/FFE solvers, element and material libraries
• Type of analyses:
  – Linear Static (including multiple load cases)
  – Linear Dynamic (natural frequencies and mode shapes)
  – Linearized Buckling
Chapter 1  Introduction

- Heat Transfer
- Nonlinear

- Design variables:
  - Side constraints (upper and lower limits of design variables)
  - Move limits control

- Shape Applications:
  - Dimensions and parameters used in building the model's geometry

- Sizing Applications:
  - Parameters used to define the model other than the shape parameters
  - For linear static analysis, predefined sizing options include:
    - Cross-sectional area of truss elements
    - Thickness of 2D continuum elements
    - Thickness of shell elements
    - Width and height of beam elements with rectangular cross-sections
    - Thickness and radius of pipe elements

- Optimization behavior constraints:
  - Trimming control
  - Different sets (with lower and upper limits) of:
    - Displacements
    - Relative displacements
    - Stresses
    - Strains
    - Reaction forces
    - Natural frequencies
    - Linearized buckling load factors
    - Velocities
    - Accelerations
    - Temperatures
    - Temperature gradients
    - Heat Fluxes
    - Weight
    - Volume
    - User-defined quantities
Chapter 1   Introduction

- Optimization objective function:
  - Minimization and maximization of one type composed of different sets with user-specified weight factors.
    - Volume
    - Weight
    - Displacement
    - Relative displacement
    - Stress
    - Strain
    - Reaction force
    - Velocity
    - Acceleration
    - Natural frequency
    - Linearized buckling load factor
    - Temperature
    - Temperature gradient
    - Heat flux
    - User-defined quantity

- Sensitivity options:
  - Global, local and offset pre-optimization sensitivity studies, in addition to optimization sensitivity results.
  - Sensitivity response quantities include:
    - Displacements
    - Relative displacements
    - Stresses
    - Strains
    - Reaction forces
    - Velocities
    - Accelerations
    - Natural frequencies
    - Linearized buckling load factors
    - Temperatures
    - Temperature gradients
    - Heat fluxes
Chapter 1  Introduction

• Volume
• Weight
• User-defined quantities

• Numerical techniques:
  – Modified Feasible Directions method
  – Singular Value Decomposition technique
  – Linear, quadratic and cubic approximations
  – Restart and restore options

• Results:
  – Output file
  – X-Y convergence and sensitivity plots
  – Color filled, colored line contour plots, and vector plots of displacement, stress, strain, temperature, temperature gradient, and heat flux for the current model.
  – Animation and plots of deformed shapes for linear static analysis and mode shapes for frequency and buckling analyses.
  – Tabular data reports

The High Frequency Electromagnetic Simulation and Analysis Package (COSMOS/HFS Suite)

COSMOS/HFS consists of 3 modules for high frequency electromagnetic applications. Applications include radio frequencies, microwave, millimeter-wave, wireless, passive wave guide components, MHMIC, MMIC, microstrip, stripline, launches, coupling structures, connectors, transitions, discontinuities, spiral inductors, interdigitated, capacitors, filters, and hybrids. The three modules are:

COSMOS/HFS 2D

COSMOS/HFS 2D module is an integrated package for the electromagnetic analysis and simulation of transmission lines and guiding structures. It combines quasi-static, frequency-dependent and time domain analyses to characterize the propagation characteristics of arbitrary microwave and mm-wave guiding structures and digital circuit interconnects. It can easily be interfaced to time domain circuit
simulators such as SPICE. With its flexible Finite Element Method modeler and advanced Time Domain Simulator, COSMOS/HFS 2D is a truly powerful tool that will enable users to:

- Study new guiding structure designs.
- Tune geometric and/or material parameters to optimize specific characteristics of a guiding structure.
- Rate digital circuit interconnection designs based on distortion and crosstalk data.
- Evaluate the level of dispersion of the guiding structure for a given material and geometric configuration.
- Compute scattering parameters of various circuits through simple cascading techniques.
- Easily interface the results of the field simulator to time domain circuit simulator such as SPICE.

**COSMOS/CAVITY**

The COSMOS/CAVITY module is a general, frequency domain finite element package for the electromagnetic analysis of resonant structures. Its applications include the analysis and design of cavities, dielectric resonators and oscillators. It uses advanced direct, iterative and eigenvalue solvers, within the frequency domain Finite Element Method, to study the resonance behavior of electrical cavities with great flexibility, speed and accuracy. With COSMOS/CAVITY, you will be able to:

- Study new cavity and resonator designs.
- Fine tune geometric and/or material parameters for optimal performance.
- Compute the resonant frequencies and corresponding modal fields for axisymmetric and arbitrary three-dimensional cavities.
- Find simple equivalent electrical circuit models (RLC) for the desired resonant modes.
- Study the effect of material and conductor losses on the quality factor of the cavity.
COSMOS/HFS 3D

COSMOS/HFS 3D simulates 3D passive structures, including scattering parameters, port propagation parameters, and animated full-wave field solutions.

COSMOS/HFS 3D has the following features:

- Tangential vector-based functions.
- Iterative and direct solvers.
- Evaluates S-parameters versus the desired frequency range.
- Supports Citifile, Touchstone, and Compact formats.
- Generalized S-parameter matrix.
- Export of S-parameter in various circuit simulation formats.
- Iterative and direct solvers.
- Arbitrary part geometries.
- Parts only or full model selection.

About Solvers

The finite element method leads to a system of equations that must be solved simultaneously. A complex model can generate a very large system of equations. Each equation represents an unknown quantity that we seek to solve for. Each unknown quantity is also referred to as a degree of freedom (DOF). For example, when solving a static problem, displacements at the nodes are the primary unknowns. For solid models, each node has 3 DOF, for shell models, each node has 6 DOF. A solid model with 10,000 unrestrained nodes, will have 30,000 (10,000 X 3) DOF.

Traditionally, solving a large system of simultaneous equations requires long time and large computer resources.

Structural Research gives utmost attention to providing its software users with the cutting edge solver technology in terms of speed and the use of computer resources.

Solvers can be broadly classified into two main categories: direct and iterative. Multiple solvers are provided for most types of analyses.
Chapter 1   Introduction

The Direct Sparse Solver

The direct sparse solver replaces the old direct solver for all types of analyses. The old direct solver provided with earlier versions of COSMOS/M is based on an older logic called the sky-line.

The direct sparse solver exploits new advanced sparse matrix technology and re-ordering techniques to save time and computer resources. On the average, the new solver is about 15 times faster and it uses about 1/3 of the memory required by the old solver. The savings can be much higher for large problems and shell problems. Assembly problems containing parts made of materials with widely different material properties can produce ill-conditioned matrices. Ill-conditioned matrices can also result from gap/contact problems, especially when friction is considered. The efficiency of iterative methods reduces considerably with ill-conditioned matrices. The Direct Sparse solver is recommended in such cases.

The Iterative (PCG) Solver

The PCG iterative solver compares to the FFE solver provided with earlier versions of COSMOS/M. The PCG iterative solver exploits new technology to save time and computer resources for very large problems (problems with over 200,000 DOF).

The major advantage of the PCG iterative solver is that it works with all elements and element options. For example, FFE solvers do not support composite elements like SHELL3L, SHELL4L, SOLIDL, and many other elements and element group’s options. The PCG iterative solver supports such options.

⚠️ The PCG iterative solver cannot be used to run static analysis problems that include sub-structuring, sub-modeling, or the in-plane effect option.

Choosing a Solver

Generally you can use any of the available solvers for a particular type of analysis. Different solvers should give similar results for the same problem. The following information summarizes the solver options for different types of analyses.
Static Problems

There are 4 solvers for static problems. These solvers are:

- The old direct solver based on the skyline techniques.
- The direct sparse solver based on sparse matrix technology and advanced re-ordering techniques.
- The FFE solver.
- The PCG iterative solver.

The PCG_OPTIONS command (Analysis > Static > PCG_Options) allows you to set the proper options to run a problem using the PCG solver.

Use the A_FFESTATIC command (Analysis > Static > FFE Static Options) prior to running static analysis to select the FFE solver. The other options are selected by the A_STATIC (Analysis > Static > Static Analysis Options) command.

Guidelines on selecting a static analysis solver:

- Use the PCG Iterative solver for large problems (200,000 DOF or more). See the on-line help for the PCG_OPTIONS (Analysis > Static > PCG_Options) command.
- Use the FFE solver or the Direct Sparse solver for small and medium problems (problems with up to 200,000 DOF).
- If your model has elements or options not supported by the FFE solver, use the PCG iterative solver or the Direct Sparse solver.
- Use the Skyline solver for submodeling and substructuring.
- Use the Direct Sparse solver for problems with contact, especially when you turn on the friction effects. However, if the problem is too large, you may have to use the Iterative PCG solver.
• Use the Direct Sparse solver when solving problems with widely varying material properties.

**Frequency Problems**

There are 3 solvers for frequency problems. These solvers are:

- Mode extraction powered by the skyline direct solver.
- The FFE solver.
- Mode extraction powered by the sparse direct solver based on sparse matrix technology and advanced re-ordering techniques.

Use the A_FFEFREQ command (Analysis > Frequency/Buckling > FFE Frequency Options) prior to running frequency analysis to select the FFE solver. The other options are selected by the A_FREQUENCY command (Analysis > Frequency/Buckling > Frequency Analysis Options).

**Guidelines on selecting a frequency analysis solver:**

Here are few guidelines on selecting the appropriate solver:

• Choose any of the 3 solvers for small problems.
• Choose the direct sparse solver or the FFE solver for medium problems (problems with 100,000 to 200,000 DOF).
• Use the FFE solver for large problems (over 200,000 DOF).
• Use the mode extraction routine powered by the FFE solver if your model is not adequately restrained (rigid body modes).
• Use the mode extraction routine powered by the direct sparse solver if you want to consider the effect of loading on the natural frequencies.

• Use the mode extraction routine powered by the direct sparse solver when solving problems with widely varying material properties.

Buckling Problems

There are 2 solvers available for extracting buckling load factors:

• Buckling load factor extraction routine powered by the direct sparse solver.

• Buckling load factor extraction routine powered by the direct skyline solver.

Use the **A_BUCKLING** command (Analysis > Frequency/Buckling > Buckling Analysis Options) to select the desired solver.

**Guidelines on selecting a buckling analysis solver:**

Here are some guidelines on selecting the appropriate solver:

• Choose any of the two solvers for small problems.

• Choose the direct sparse solver for large problems.

• No FFE solver is available for buckling analysis.

Thermal Problems

There are 3 solvers for thermal problems. These solvers are:

• The skyline direct solver based on the skyline techniques.

• The direct sparse solver based on sparse matrix technology and advanced re-ordering techniques.
Chapter 1 Introduction

- The FFE solver.

Use the **A_FFESTHERM** command (Analysis > Heat Transfer > FFE Thermal Options) prior to running thermal analysis to select the FFE solver. The other options are selected by the **A_THERMAL** command (Analysis > Heat Transfer > Thermal Analysis Options).

**Guidelines on selecting a thermal analysis solver:**

- Use the FFE solver or the Direct Sparse solver for small and medium problems (up to 200,000 DOF). There are 3 solvers for thermal problems, the new Direct Sparse solver, the old Skyline direct solver and the old FFE solver. Thermal problems have one DOF per node and hence their solution is usually much faster than structural problems of the same number of nodes.
- Use the Direct Sparse solver when solving assemblies of parts with widely different material properties.
- Use the FFE solver for large problems. FFE does not support the calculation of view factors.

**About This Manual**

The COSMOS/M User Guide is designed to help you get started and to assist you in using the software productively. Every effort has been made to present the materials clearly and concisely. This manual includes six chapters and nine appendices.

Chapter 2 presents a brief description of the basic features of GEOSTAR and the steps required to perform finite element analysis with COSMOS/M. Two detailed step-by-step problems are presented to help you start confidently.

Chapter 3 explores the different capabilities of GEOSTAR starting from building the model's geometry to meshing, applying boundary conditions and loads, performing analysis, checking and postprocessing of the results.

Chapter 4 covers the extensive element library of COSMOS/M. The chapter presents a general description of each element, its coordinate system, the available element group options, different material, sectional and physical properties, and the available element loads. The elements are classified based on the type of analysis.
Chapter 1 Introduction

Chapter 5 presents detailed examples for the modeling procedures in GEOSTAR including its geometry and meshing features. The examples will help build your confidence and proficiency in using GEOSTAR.

Chapter 6 includes examples on the use of GEOSTAR for geometry creation, analysis and postprocessing of some finite element.

Appendix A provides information about installing and operating the COSMOS/M software.

Appendix B presents the commonly used systems of units and a detailed description for the consistent units of the basic quantities in COSMOS/M modules.

Appendix C contains description of the COSMOS/M database files and information about the database utility.

Appendix D describes the capabilities and limitations of the different translators available in the COSMOS/M system. Geometry translators can transfer geometry from various CAD and solid modeling packages to GEOSTAR. FEA translators transfer finite element data between COSMOS/M and other finite element systems.

Appendix E provides information about the COSMOS/M powerful command language features. Among the user-defined parameters are the single variables, functions and arrays along with looping and conditional command processing and logical expressions. In addition, a macro file capability is presented to create subroutine-like environment with which you can call a defined procedure comprised of series of commands for the purpose of establishing your own command.

Appendix F presents some troubleshooting hints for installation, and pre- and postprocessing.

Appendix G provides detailed information for COSMOS/M input file structure.
Getting Started

Introduction

In COSMOS/M, the user interacts only with the GEOSTAR interface. Internal calls and transfers of control to analysis modules are automated to give the user a one screen solution; the user builds the model, specifies all data required by the analysis, executes the suitable analysis module and evaluates the results, all from within GEOSTAR.

This chapter gives general information about GEOSTAR's main features and modes of operation. The material covered in the next sections includes a description of the GEOSTAR screen, various input options and some important database files. In addition, the chapter provides an outline of the general steps required for finite element analysis using COSMOS/M.

This chapter will guide the user through model generation, analysis and postprocessing of a simple problem to help illustrate the basic operation of GEOSTAR as a preprocessing, analysis and postprocessing tool. However, GEOSTAR offers many advanced features and capabilities. Your skill in using it will grow with continued use. A tutorial that uses several types of elements and materials is available in the online help. Additional examples to demonstrate different features of the program and types of analyses are presented in the User’s Guide and other manuals.
Chapter 2  Getting Started

GEOSTAR Screen

After you install the program (see Appendix A), start GEOSTAR by double-clicking the GEOSTAR icon in the COSMOS/M program group. When you type problem name in the Open Problem Files dialog box and press OK, all files related to this problem will have this name and some extensions determined by the type of information they contain. It takes GEOSTAR few seconds to set up the database files. The GEOSTAR opening screen, as shown in Figure 2-1, has three important areas:

1. Geo Panel
   Menu names, describing the general functions of the commands in the menu, are located in the left hand side of the screen. A command is issued by selecting the appropriate menu, submenus, and completing the associated dialog boxes.

2. Console Window
   Command prompts and status messages appear in this area located at the bottom of the screen. Commands and input using the mouse or the keyboard are also shown in this area.

3. Display Window
   Located in the center of the screen, this area is used to build and display the model. Several windows can be created in this area.
Modes of Operation

GEOSTAR can be operated in the following modes:

1. Interactive mode using pull-down menus, push buttons, mouse and the keyboard to interactively issue commands and respond to dialog boxes.

2. Semi-batch mode where the user, while in GEOSTAR, issues a command to read files with valid GEOSTAR commands. Valid files include files from other applications such as CAD programs (IGES and DXF formats) in addition to GEOSTAR files created in a GEOSTAR session or externally by an editor. The user can start in the interactive mode, read a file, and give commands interactively.
Chapter 2   Getting Started

**Tool Bars**

Tool bars help users to quickly select commonly used functions. The available icons are shown in Figure 2-2.

A button can be activated by placing the mouse pointer on it and clicking the left mouse button.

**Menus**

Appearing at the top of the Geo Panel, pull-down menus can be used to select and issue GEOSTAR cryptic and extended (or English-like) commands. The root menus are grouped based on the functions of commands. Some menus contain submenus. If a submenu is selected, the associated commands and submenus will appear. If a command is selected, it will also appear in the console.

These menus are:

- **Geometry** for geometry development and processing.
- **Meshing** for finite element meshing.
- **Propsets** for specification of element groups, material properties, and real constant sets.
- **LoadsBC** for loading and boundary condition specifications of various types of analyses.
- **Analysis** for analysis options and runs execution.
- **File** for file processing.
- **Edit** for editing geometry and finite element entities.
- **Control** for activation and control of numerous processes during and after model generation including CAD interface options.
- **Display** for display options.
- **Results** for postprocessing operations.

Each category listed above is represented by a cluster of menus and submenus in which commands relevant to the function of that category are grouped together. In Appendix F of this manual, a brief description of GEOSTAR commands is given to provide a quick reference and outline of their capabilities.
Chapter 2  Getting Started

Input Options

Mouse Operations

The GEOSTAR program is designed to work best with a mouse. The mouse makes it easy to select a command from a menu, activate a push button, or select an entity from the screen:

1. Selecting a command.
   Move the cursor arrow up to the desired menu. Click the left button to pull down a menu, and move the arrow down through the menu tree until you reach the command you need. Click the left button again to select the command or submenu.

2. Detailed Help System.
   Click on the “help” button in a dialog box, or in the Geo Panel or type “help” and the command name in the console window. A full screen display of detailed help for the command will appear.

3. Activating an icon.
   Click once with the left button of the mouse. The icon you select will be activated and its function will be performed.

4. Selecting an item from the screen.
   Point the mouse to the point, curve, surface or other entity you want to select, and click the left button of the mouse. GEOSTAR highlights the selected item and waits for your confirmation in the dialog box. Click the left button again to confirm the selection. If the highlighted item is not the one you want, press the right button to select the next available entity. Repeat the process until the desired item is highlighted, and then click the left button to select it. When an entity is highlighted, its label is also listed in the dialog box to ensure proper identification.

The Escape Key

The escape key aborts the current command and returns you to the GEOSTAR (GEO>) prompt.
Keyboard Input

Although GEOSTAR is primarily designed for mouse input, users can enter commands through the keyboard as they become more proficient with the program and its commands. To use keyboard input, type the desired command in the console window, press Enter, and GEOSTAR will prompt you for the necessary inputs.

Important GEOSTAR Files

GEOSTAR opens a number of files by adding different extensions to the user-furnished problem name (ufn). Most of the files are database files for internal use by GEOSTAR. The user does not need to interact with most of the files. GEOSTAR uses a number of files to provide help, and a number of other files for fonts and other internal purposes.

The important files that the user may need to access are as follows:

1. ufn.SES (session file)
   This ASCII file stores all action commands issued during a session. The importance of the ufn.SES file comes from the fact that it contains the command history of the model and can be used accordingly to regenerate the model in case of lost or corrupted database. The file can also be used to generate a model on different computer systems.

2. ufn.GFM (geometric or neutral file format)
   This is the default name for the file generated by the GFORM_OUT command. This file is similar to the session file in the sense that it can also be used to regenerate a model. The difference is that it is not chronological and the geometric entities are written in a neutral format. The user is encouraged to generate and keep this file. In addition to serving as an additional security measure, this file can save a lot of computer time in regenerating lengthy models in which extensive editing (deleting, undeleting, modifying and recreating entities) was used. The session file goes through all intermediate steps in generating the model, while the GFM file does not. The utility helps the user combine several parts of a model by using the FILE command to read the desired parts stored in .GFM files with proper offsets.
Chapter 2   Getting Started

3.  ufn.OUT (analysis output file)
    This file is an ASCII file generated during analysis. It contains details of the
performed analysis input, results and messages. The user is advised to inspect
the contents of this file in case of problems. In many situations, a message
describing the cause of the problem will be written in the file. The amount of
information written to this file is controlled by commands in the Analysis >
Output Options submenu. For thermal analysis, the name of the output file is
ufn.TEM.

4.  Other files
    GEOSTAR creates a number of other database files which contain the modeling
information. These files are transparent to the user, and can be divided into two
categories. The first group of files is the GEOSTAR database system, and the
second contains files that are generated by other COSMOS/M modules. More
information is included in Appendix C.

Steps of the FEA Process in COSMOS/M

In this section, it is recommended that a new user read about the commands that we
refer to in order to get familiar with their overall functions.

✍ The How to section in the online help provides detailed procedures on how to
perform various types of analyses.

1.  Decide the analysis type to be performed and the type of elements to be used for
the model at hand. It is important to evaluate, and maybe actually solve, several
alternative models.

2.  Plan a strategy to build the model. Remember that the finite element mesh can
be created either directly, by defining elements and nodes, or indirectly by
creating and meshing geometrical entities. There are eight types of geometric
entities in GEOSTAR: keypoints, curves, contours, surfaces, regions, volumes,
polyhedra and parts. Although it is not always necessary to create and mesh
generic entities to generate a mesh, it would be advantageous in most cases to
do so. Geometry is a very convenient way to generate a model, mesh it and
apply the proper boundary conditions. Analysis modules, however, do not use
the information about geometric entities since all the necessary information is
associated with nodes and elements.
Chapter 2  Getting Started

3. Execute the GEOSTAR program in any work directory and give a name to the problem. This name is common to all files related to that problem. Each file has a different extension that determines the type of information it contains. These files are referred to as the database for that problem. Any disk and subdirectory can be used. The creation of databases in the COSMOS/M directory should be avoided in order to keep the system files intact.

4. Define element groups, material properties and real constant sets using commands in the Propsets menu as follows:
   a. Use the \texttt{EGROUP} (Propsets > \texttt{Element Group}) command to define all element groups to be used in the model.
   b. Use the \texttt{MPROP} (Propsets > \texttt{Material Property}), \texttt{PICK_MAT} (Propsets > \texttt{Pick Material Lib}) or the \texttt{USR_MAT} (Propsets > \texttt{User Material Lib}) commands to define material properties needed for the analysis you plan to perform.
   c. Use the \texttt{RCONST} (Propsets > \texttt{Real Constant}) command to define all needed sectional and other physical properties (real constant) sets.

5. Generate the geometry of the model. Take the time to think about your options. Take advantage of all types of symmetry in the light of GEOSTAR's meshing capabilities.

6. Activate the appropriate element attributes (element group, material property, and real constant sets) for parts of the model to be meshed next. Remember that whenever an element is generated by meshing, it assumes the active attributes. The \texttt{ACTSET} command (Control > ACTIVATE > Set Entity) can be used to change the active sets.

7. Evaluate various options of meshing. Select and issue the appropriate command to generate the mesh for the corresponding part of the model. In large models, use a finer mesh at critical locations since you might exceed the limits on nodes and elements if a very fine mesh were used for the whole model.

8. Repeat steps 6 and 7 as needed. Change one or more of the active sets and mesh the corresponding part. Verify the compatibility of the mesh.

9. List the elements by Edit > LIST > Elements. Verify that elements have the proper attributes. The \texttt{Change El-Prop} command (in Propsets menu) can be used to change the attributes of existing elements. The Analysis > Data Check
Chapter 2  Getting Started

... command verifies that all needed attributes for an element have been defined. The Analysis > Run Check command does more elaborate checking including element connectivity. The user is advised to read the help on these commands.

10. Read the help and then issue the command, Meshing > NODES > Merge. You might need to specify a tolerance value that is different from the default. If nodes belonging to adjacent parts with a common boundary are not merged, then these nodes are not attached (unless coupled), and could separate during analysis. Please read the on-line help for this command.

11. Use the LoadsBC menu to specify the proper loading and boundary conditions. Remember that the specified options are associated with the active coordinate system which could be Cartesian, cylindrical or spherical. If the specified constraints are not enough, the stiffness matrix (or the equivalent for other analyses) will be singular.

12. Evaluate your model by plotting it in various views and settings. Commands in the Display menu provide you with all the necessary tools. Use multiple colors and zoom-in on critical parts. Listing and plotting of various loading and boundary conditions are also recommended.

13. Use one of the “..... Analysis Options” family of commands in the Analysis menu and the associated submenus to specify the details of the desired analysis. The Frequency Options command, for example, specifies the details of the procedure to be used in extracting the eigenpairs (the eigenvalues and mode shapes). The program assumes all default values if the corresponding command is not issued. The List Analysis Option command can be used to list the active analysis options.

14. Use one of the “Run....” family of commands in the Analysis menu to transfer control to the corresponding module to perform the analysis and generate the desired results.

15. If the analysis does not go through successfully, a message will be printed on the screen. This message is also printed in the .OUT (.TEM for thermal analysis) file. Correct the error and run the analysis again.

16. When the GEOSTAR screen returns, pull down the Results menu and study the available commands. Deformed shapes can be directly plotted and animated for structural problems using the Deformed Shape and Animate commands (Results > PLOT > ...). Contour plots for all types of analyses can be generated by activating the desired quantity, and plotting it. The Analysis Type button can
change the active type of analysis for postprocessing. Results can also be listed on the screen using commands available in the Results > LIST and Results > EXTREMES menus.

17. Evaluate the validity of the results by common engineering sense and any experimental or theoretical data. If the actual results are too far from the expected results, review your modeling assumptions, element types, meshing and other input such as dimensions, units, and material properties. Correct any input errors and repeat the analysis. If there is little or no improvement accomplished, redefine the mesh, use finer elements and repeat the analysis.

18. Repeating the analysis with a finer mesh builds confidence in the results and will approach the exact solution in most cases. If you are solving a linear static structural problem you might use the H- or the P-method where the decision of mesh improvement at automatically selected portions of the model relies on an error estimate. (Read the on-line help on the ADAPTIVE (Analysis > STATIC > Adaptive Method) command).
Example 1: Creating and Analyzing a Model in GEOSTAR

A comprehensive step-by-step example is given in this section to provide the user with the necessary information for a confident and fast start. By the end of this example, you will be familiar with the basic features of GEOSTAR for preprocessing, analysis and postprocessing.

Description of the Problem

A square steel plate shown in Figure 2-3 is subjected to in-plane forces of magnitude 1,000 units around the edge of a circular hole in the X- and Y-directions. The forces in the X- and Y-directions are treated as multiple load cases to study their combined effect in the postprocessing phase. The square plate has a side length of 100 units and the thickness is 0.2 units. The radius of the circular opening at the center is 10 units. The plate is modeled with 2D plane stress elements. These elements have two degrees of freedom per node and must be in the X-Y plane. The two degrees of freedom are the X- and Y-translations.

The material of the plate has an elastic modulus of 30 x 10^6 and the Poisson's ratio is 0.3. The plate is fixed at the top and bottom edges.

It is suggested at this point that the user reads about the units in Appendix B. In this example, the unit of length is inches, unit of weight is pound, and that of time is second. The modulus of elasticity should be given in lb/in^2, forces in lb and the units of resulting displacements are in inches and stresses are in lb/in^2.

There are several ways to model this problem. Since this is a plane model, surfaces and regions can be used. In the approach illustrated below, a surface is created and meshed to represent a quarter of the model. The rest of the model is created by generating similar meshed surfaces. The steps are shown in detail in the following sections.
Entering GEOSTAR

It is always preferable not to work in the COSMOS/M directory; the user should use the working directory created after installation or create a new working directory.

Double click on the GEOSTAR icon. GEOSTAR will prompt you with a dialog box for a problem name.

(or from the system level, type: GEOSTAR on Unix platform)

Enter a name for the problem: Plate

Click OK

When you enter “Plate” as a name for the problem, all files related to this problem will have this name and some extensions determined by the type of information they contain. It takes GEOSTAR few seconds to set up the database files before returning to the GEOSTAR console with the “GEO>” prompt.

GEOSTAR is now ready to accept commands which can either typed at the prompt level or pulled down from the menus.

Specifying Properties

It is a good practice to define element groups, materials, and real constant sets in the beginning. All related commands are found in the Propsets menu.

Specifying the Element Group

1. Geo Panel: Propsets > Element Group
   Element group: 1
   Egroup Category: Area (for the Unix version only)
   Element Name: PLANE2D
   Click OK to accept the defaults associated with the element group
Chapter 2   Getting Started

Specifying Material Properties

Next, define the material properties. In this case (linear elastic material) the only needed properties are the Elasticity Modulus (EX) and Poisson’s Ratio (NUXY).

II. Geo Panel: Propsets > Material Property
  Material property set: 1
  Material property name: EX
  Property value (EX): 30e6
  Click OK to continue defining more material properties for material property set 1
  Material property name: NUXY
  Property value (NUXY): 0.30
  Click Cancel to conclude material property entries for set 1

Specifying Real Constants

Next, the section properties are defined using a real constant set.

III. Geo Panel: Propsets > Real Constant
  Associated element group: 1
  Real constant set number: 1
  Click Continue to define information about real constant set 1
  Starting location of the real constant: 1

Poisson’s Ratio (NUXY) is assumed to be 0.30 if not specified.
List and Verify Your Inputs

To verify the element group, material properties and the real constants you have just input you can proceed as follows:

1. Geo Panel: Edit > LIST > Element Groups
   Beginning element group : 1
   Ending element group : 1
   Increment: 1
   Click OK to accept the entries for element group listing

Similarly, you can list material properties and real constants.

Setting the View

For 2D problems, models have to be created in the x-y plane.
Chapter 2  Getting Started

First, clear the Display Window by clicking on the \textbf{CLS} button in the Geo Panel. Then adjust the view inside the Display Window.

\textbf{I. Geo Panel: View Direction icon}

- Click on the “XY-View” button
- Close the View

Setting the Grid

GEOSTAR requires you to set up a grid if you want to snap keypoints with the mouse. To display the grid, the plane where the grid is to be displayed should be set. A plane is defined by its normal (the Z-axis in this case).

\textbf{I. Geo Panel: Geometry > GRID > Plane}

- Axis Normal to the Plane: \textit{Z}
- Offset on Axis: 0.0
- Click \textit{OK} to accept the entries

\textbf{II. Geo Panel: Geometry > Grid > GridOn}

- Click \textit{OK} to accept the defaults

GEOSTAR will define a grid starting from the origin of the axes, with 20 divisions on each axis representing 5 units each. This will allow for maximum coordinate values of 100 for both X and Y on the grid. The dimensions of the grid can be specified as desired.
Creation of Quarter of the Model

Click on the **STATUS1** button, a table will be displayed in which current information on the status of several flags controlling the plotting of geometrical entities (keypoints “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. The table lets you toggle the flags to ON/OFF and select the color of the various entities. We will change the label status of points, curves, and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on ON/OFF flags for **PT**, **CR**, and **SF** and then pressing the left button of the mouse to switch from OFF to ON. After making the three changes, save them by clicking on **Save**.

Now, you need to create a keypoint at the center of the plate.

**I. Geo Panel:** Geometry > POINTS > **Define**
- Keypoint: 1
  - X-Coordinate value: 50
  - Y-Coordinate value: 50
  - Z-Coordinate value: 0
- Click **OK** to accept the entries

Repeat the above command to specify two additional keypoints (points (0.0, 100,0.0) and (100, 100, 0.0)). Then, by using these two points create a straight line to define the top edge of the plate.

**II. Geo Panel:** Geometry > CURVES > **Line with 2 Pts**
- Curve : 1
  - Keypoint 1: 2
  - Keypoint 2: 3
  - Click **OK** to accept the entries

The upper edge (curve 1) connecting keypoints 2 and 3 will be created.
Chapter 2  Getting Started

III. Geo Panel:  Geometry > CURVES > CIRCLES > Circle in Plane
   Curve : 2
   Keypoint at center: 1

You can pick the keypoint by moving the mouse arrow to the keypoint and clicking on it once. The keypoint will be highlighted and its label will appear in the dialog box. Confirm your choice by clicking once more.

Keypoint on zero degree line: 3
Radius of the circle: 10
Angle of the arc (in degrees): 90
Number of segments: 1
Click OK to accept the entries

The model is shown in the following figure, with grid lines removed. Notice that the labels of points and curves are displayed only because we activated their flags in the STATUS1 table.

Next, create a surface using two curves (curves 1 and 2).

IV. Geo Panel:  Geometry > SURFACES > Define by 2 Cr
   Surface : 1
   Curve 1: 1
   Curve 2: 2
   Underlying surface: 0
   Click OK to accept the entries

At this point, you can turn off the grid lines using the Grid Off command in the Geometry > GRID menu. The model is shown in the following figure with grid lines removed.
Chapter 2  Getting Started

V.Geo Panel:  Meshing > PARAMETRIC MESH > Surfaces
Beginning surface : 1
Ending surface : 1
Increment: 1
Number of nodes per element: 4
Number of elements on 1st curve: 3
Number of elements on 2nd curve: 3
Click OK to accept the defaults of spacing ratios for 1st and 2nd curves

The mesh generated is shown in the following figure.

Figure 2-14. Meshing of Surface 1

Generation of the Rest of the Model

The rest of the model will be created by generating three more surfaces by rotating the existing surface as well as the elements generated about an axis normal to its plane that passes through the center. To do this, we need first to create the proper coordinate system.
Chapter 2   Getting Started

I. **Geo Panel:** Geometry > COORDINATE SYSTEMS > 3 Angles
   Coordinate system: 3
   Coordinate system type: Cartesian
   XYZ-coordinate value of origin: (50, 50, 0)
   Click OK to accept the rest of the entries

The created system, system (3), is now active.

Since we would like to automatically generate the remaining three surfaces similar to surface 1, the default meshing flag should be activated.

II. **Geo Panel:** Control > ACTIVATE > Default Meshing
   Entity: SF
   Default mesh flag: 1: On
   Click OK to accept the rest of the entries

The flag can also be activated by using the **Status1** button and by toggling on the flag under DMSH column for surfaces.

We are now ready to generate the rest of the model.

III. **Geo Panel:** Geometry > SURFACES > GENERATION > Generate
    Generation Number: 3
    Beginning surface: 1
    Ending surface: 1
    Increment: 1
    Generation flag: 1: Rotation Only
    Click Continue
    Z-rotation: 90
    Click OK to accept the rest of the entries
The generated model is shown in the figure.

**Node Merge and Compress**

The model has 4 surfaces, 12 curves, 9 keypoints, 36 elements and a total of 64 nodes. The meshing process has generated some coincident nodes at the common boundaries between surfaces. Coincident nodes can be merged using the **MERGE** (Meshing > Nodes > Merge) command. Note that in some cases (e.g. contact problems) coincident nodes should not be merged to allow relative motion.

I. **Geo Panel:** Meshing > NODES > Merge
   
   Click OK to accept the entries in the dialog box
   
   *16 nodes will be merged.*

After the merging process, the node numbering will not be consecutive. In finite element analysis, the node numbers are not required to be continuous and no action is needed to remove the numbering gaps. However, it is a good practice to compress nodes.

II. **Geo Panel:** Edit > COMPRESS > Nodes
   
   Click OK to accept the entries in the dialog box
   
   *13 nodes will be compressed.*

**Specifying Loads and Boundary Conditions**

GEOSTAR lets you use to specify loading and boundary conditions on geometric entities. The actual loading or boundary condition is applied to nodes, element faces, or elements associated with the specified geometric entities. Clear the window display by clicking on the **CLS** button. In order to apply constraints and forces on the curve entities, you need to plot them.

I. **Geo Panel:** Edit > PLOT > Curves
   
   Click **OK** to accept the entries in the dialog box
The directions of constraints are interpreted with respect to the active coordinate system. Any coordinate system can be used to specify these boundary conditions. In this problem we need to activate the global Cartesian system.

II. Geo Panel: Control > ACTIVATE > Set Entity
Set label: Coordinate System
Click Continue
Coordinate system: 0
Click OK to accept

We will start by constraining the upper edge of the plate (curve 1).

III. Geo Panel: LoadsBC > STRUCTURAL > Displacement > Define by Curves
Beginning curve: 1
Displacement label: UX
Value: 0
Ending curve: 1
Increment: 1
Displacement label: UY
Click OK

Similarly, constrain the bottom edge (curve 9). Now, if you plot the element (Geo Panel: Edit > PLOT > Elements), the plate with boundary conditions you just defined will be displayed as shown in the figure.

It should be noted that GEOSTAR automatically fixes degrees of freedom that are not considered by the element at execution time. The Z-translation and all rotations are automatically set to zero since the PLANE2D element considers only X- and Y-translations.

Loading is specified next. We will apply a force of 1000 lb in the X-direction at every node on the circle (i.e. curves 2, 7, 10 and 12). Clear the display window by clicking on the Clear button in the Geo Panel then repLOT all curves (Geo Panel: Edit > PLOT > Curves). Then start applying the forces.

IV. Geo Panel: LoadsBC > STRUCTURAL > Force > Define by Curves
Repeat the above step to define the forces on the nodes associated with curve 10. Then clear the screen, and replot the elements, boundary condition and forces. The model will be as displayed in the following figure. The specified forces are associated with load case number 1 since no other load case was activated. In this example we will use two load cases. Load case 2 will be used to define vertical forces (FY) on the circular opening.

\[ \text{Figure 2-17. Load Case 1: Forces in the X-direction} \]

In a similar way, define a force of -1000 lb at each node on the circle in the Y-direction. The figure shows forces applied under load case number 2.
Model Evaluation

Since your analysis results will only be as good as the model you build, you need to evaluate it for accuracy and completeness. This step involves plotting the elements, the boundary conditions, and the applied forces so that you can inspect them. Start with clearing the window display by clicking on the **CLS** button. Then plot and list the elements.

I. **Geo Panel:** Edit > PLOT > **Elements**

II. **Geo Panel:** Edit > LIST > **Elements**

In a similar way you can plot and list the boundary conditions (LoadsBC > STRUCTURAL > DISPLACEMENT > **Plot**) and the applied forces (LoadsBC > STRUCTURAL > FORCE > **Plot**). Note that only forces associated with the active load case (load case 2) are plotted. To plot forces associated with load case 1, you need to activate it using the **ACTIVATE** command.

III. **Geo Panel:** Control > **ACTIVATE** > **Set Entity**

   Set label: **Load Case**

   Click on **Continue**

   Load case set number: 1

   Click **OK** to accept
Then you can list the forces associated with load case number 1.

Now, you have a complete finite element model of a plate structure with a hole, along with applied boundary conditions, and forces in two load cases. The **Zoom-In** button in the Zoom/Pan/Rotate area of the Geo Panel can give you a close look of the different areas of the model. You can also check your model by the following commands:

IV. **Geo Panel**: Analysis > **Data Check**

V. **Geo Panel**: Analysis > **Run Check**

Please read the on-line help for these commands.

**Analysis**

We will consider linear static and frequency analyses for this model. First, the linear static analysis will be performed. You may access the **A_STATIC** (Analysis > STATIC > **Static Analysis Options**) to specify the details of the analysis and turn on the necessary flags. In this example all default values will be used; thus, there is no need to issue this command. However, if you issue the command, you can click to accept the default values. Then, perform the analysis.

I. **Geo Panel**: Analysis > STATIC > **Run Static Analysis**

GEOSTAR will display status messages as it runs the analysis module. When the analysis is completed, the program will return to the Display Window and wait for your next instruction. Note that an automatic stress calculation is performed by default. However, it can be deactivated by using the **STRESS** (Analysis > STATIC > **Activate Stress Calc**) command and setting the stress calculation flag off. Displacements and stresses are calculated for all load cases.

Next, perform a linear frequency analysis to calculate the lowest four natural frequencies and their corresponding mode shapes.

II. **Geo Panel**: Analysis > FREQUENCY/BUCKLING > **Frequency Options**

Number of required modes: 4
Click OK to accept the rest of the defaults

Since the computation of natural frequencies involves the use of mass matrix, you need to define material density or some lumped masses. Otherwise, the program will terminate because of a null mass matrix. So, define the material density.
Chapter 2   Getting Started

III. Geo Panel: Propsets > Material Property
Material property set: 1
Material property name: DENS
Property value (DENSITY): 7.5e-4
Conclude material property entries for set 1 by clicking on “Cancel”

To append the results of the frequency analysis to the same “plate.OUT” file containing the linear static analysis results you need to turn the append flag on in the printing of the output file. Otherwise, the “plate.OUT” file will be overwritten. Then run the frequency analysis.

IV. Geo Panel: Analysis > OUTPUT_OPTIONS > Set Print Options
Turn on the append to the output flag
Click OK to accept the rest of the defaults

V. Geo Panel: Analysis > FREQUENCY/BUCKLING > Run Frequency

As before, GEOSTAR will display status messages related to normal modes of calculation as it runs the analysis module. At this point, the two analyses are completed and you are ready to evaluate the results directly from GEOSTAR for both of them.

Results

In the postprocessing phase, several options are available.

1. You may examine the results written in the problem output file. This can be done using your preferred editor from the operating system level.

2. You may list the model displacements and stresses using the commands provided in: Geo Panel: Results > LIST. You can also list extreme values of a displacement or a stress component (Geo Panel: Results > Extremes).

3. Finally, graphic postprocessing may be performed to examine deformations, displacements, stresses and mode shapes.

You are now ready to start looking at the results for both linear static and frequency analyses. Frequency analysis is the active type for postprocessing since it was performed last. Create three windows by clicking on the New Win button in the Geo Panel 3 times.
Note that window 4 is the active window since it is the most recently created. To activate the first window, move the mouse to a place inside the first window and click. Adjust the view inside the window to the XY-plane. Then, plot the first mode shape inside the first window.

I. Geo Panel: View Direction icon
   - Click on the Z-View button
   - Close the View

II. Geo Panel: Results > PLOT > Deformed Shape
   - Mode shape number: 1
   - Click OK to accept the defaults

The above procedure can be repeated to plot modes shapes 2, 3, and 4 in the corresponding windows. The results are shown below in the following figure.

Figure 2-19. Frequency and Mode Shape Results from the Frequency Analysis

You can also animate any of the four mode shapes. For example, to animate the first mode shape active the first window, clear the first window and then use the Animate command.
Chapter 2  Getting Started

III. Geo Panel: Results > PLOT > Animate
   Mode shape number: 1
   Click OK to accept the defaults
   You can repeat the above procedure to animate mode shapes 2, 3, and 4 in the corresponding windows.

   To switch to the postprocessing of the linear static analysis, click the Set Post button in the Geo Panel and select the 0: Linear structural option from the Analysis type menu. Load case 1 will be processed first. We will plot the deformed shape, the resultant displacement, and von Mises stress contours each in a separate window. To plot the deformed shape, activate any window and issue the following commands:

   IV. Geo Panel: Results > PLOT > Deformed Shape
      Load case number: 1
      Click OK to accept the defaults
      Then activate and clear the second window.

   V. Geo Panel: Results > PLOT > Animate
      Number of the load case number: 1
      Click OK to accept the defaults

   Next, we will plot displacement and stress contours as follow:

   VI. Geo Panel: Results > PLOT > Displacement/Response/Reaction
      Load case number: 1
      Component: URES: Resultant Displacement
      Click on Contour Plot to select contour plot
      Click OK to accept the defaults of the contour plot dialog box
      Nicer contour plots may be obtained by suppressing the plotting of element edges and plotting the boundaries of the model.

   VII. Geo Panel: Display > DISPLAY_OPTIONS > Eval Element Bound
      Turn on the edge evaluation flag
      Click OK to accept the defaults

   Next, activate window 4 to plot the stress (the von Mises stresses are selected in this example).

   VIII. Geo Panel: Results > PLOT > Stress
      Load case number: 1
Component: VON: von Mises Stress
Click Contour Plot to select contour plot
Click OK to accept the defaults of the contour plot dialog box

Figure 2-20. Results from Load Case 1

The user is encouraged to try various options in plotting the displacement and stress results.

Load case 2 can be processed similarly. Results are shown below in the following figure.
You can trace the variation of results (stresses and displacements in this problem) along an arbitrary path defined by up to 20 nodes. The results are viewed on an XY-type graph in an automatically created window. The X-axis represents the normalized distance starting from the path’s first node and the Y-axis refers to the variation of results. Let’s find stress variation for load case 2, as displayed in window 4.

**Geo Panel:** Results > PLOT > Path Graph

You can use ANIMATE (Geo Panel: Results > PLOT > Animate). The path variation graph is shown in Figure 2-22.
Secondary Load Cases

Before concluding this example, the procedure to define, analyze, and process multiple load cases is outlined.

*Geo Panel:*  Results > Combine Load Case

- New load case number: 51
- Load case number for term 1: 1
- Load case factor for term 1: -1
- Load case number for term 2: 2
- Load case factor for term 2: 2.0

Click **OK** to conclude the command

GEOSTAR uses these factors to calculate results for load case 51. The results for load case 51 can be list, plotted and animated in a similar way to load cases 1 and 2. Results for load case 51 are shown in the figure below.
Chapter 2   Getting Started

Figure 2-23. Results from Load Case 51

Exercises

There are many ways to create the model shown in previous sections in GEOSTAR. It is recommended that the user try alternative ways to create the same model. New problems can be created by exiting GEOSTAR and then re-entering it using a different problem name, or by using the NEWPROB (File > New...) command while in GEOSTAR.

First Exercise

- Create a new problem.
- After setting the view and the grid, use the CRPCORD (Geometry > CURVES > Draw Polyline) command to draw the outer boundaries of the plate.
• Create the center keypoint and use the **CRPCIRCLE** (Geometry > CURVES > CIRCLES > Circle in Plane) command to draw the circular opening.

• Use the **SF2CR** (Geometry > SURFACES > Define by 2 Cr) command to create four surfaces. Each surface is created from a straight edge and an arc.

• Use the **M_SF** (Meshing > PARAMETRIC_MESH > Surfaces) or the **MA_SF** (Meshing > AUTO MESH > Surfaces) to mesh the four surfaces at once.

**Second Exercise**

• Create a new problem.

• Create a keypoint by specifying the coordinates of a corner.

• Use the **CREXTR** (Geometry > CURVES > GENERATION > Extrusion) command to generate one outer straight edge by extruding the generated keypoint in the proper direction.

• Repeat the **CREXTR** command three times to create the other straight edges of the plate.

• Create the center keypoint and the hole using the **PT** and the **CRPCIRCLE** commands (examine ways to create circles by reading the on-line help for commands in the Geometry > CURVES > CIRCLES submenu). Use 12 segments to represent the circle. Use the **CT** (Geometry > CONTOURS > Define) command to create contour number 1 from the outer edges, any one curve should be sufficient to define the contour since no alternative ways are available to close the loop. Specify an average element size of 10.

• Use the **CT** command again to define contour number 2 as the edges of the hole. Again any arc should be sufficient to define this contour. (You might try the CTNU contour to define the number of elements on each single curve instead of **CT**).

• Use the **RG** (Geometry > REGIONS > Define) command to create region number 1 using contours 1 and 2.

• Use the **MA_RG** (Meshing > AUTO_MESH > Regions) command to mesh region 1. The generated mesh will be triangular.

• Use the **MARGCH** (Meshing > AUTO_MESH > Region Mesh Type) command to update the mesh to quadrilateral elements.

**Third Exercise**

When we applied forces on nodes associated with curves 2, 7, 10 and 12, we had
Chapter 2   Getting Started

to do that in two steps since no one pattern can include all of them. A powerful utility called selection lists can be very helpful in such cases. Use the SELWIN (Control > SELECT > By Windowing) command to select the curves of the circle, use the FCR (LoadsBC > STRUCTURAL > FORCE > Define Curves) command to apply forces on all curves. GEOSTAR will apply forces only on elements associated with curves in the selection list. Use the INITSEL (Control > SELECT > Initialize) command to initialize the curves selection list.

Fourth Exercise

- Gravity, centrifugal and thermal loading are referred to as special loading in GEOSTAR.
- The user is encouraged to include gravity loading for the given example, the steps are as follows:
  - Issuing the A_STATIC (Analysis > STATIC > Static Analysis Options) command, read the help and specify “G” for the special loading flag.
  - Specify a value for the acceleration of gravity in the X or Y directions using the ACEL (LoadsBC > STRUCTURAL > GRAVITY > Define Acceleration) command. Special loading is added to other forces and pressure for the active load case. Concentrated masses or a value for density must be specified.

Fifth Exercise

- Define thermal conductivity, KX, using the MPROP (Propsets > Material Property) command.
- Use the NTCR (LoadsBC > THERMAL > TEMPERATURE > Define Curves) command to apply a temperature of 200° around the hole. Specify the temperature on the edges to be 25°.
- Given the R_THERMAL (Analysis > HEAT_TRANSFER > Run Thermal Analysis) command to run a heat conduction analysis.
- Use the ACTTEMP and TEMPPLOT (Results > PLOT > Thermal) commands to load and plot temperature contours.
- Use the A_STATIC,T (Analysis > STATIC > Static Analysis Options) command to specify thermal loading.
- Issue the R_STATIC (Analysis > STATIC > Run Static Analysis) command to perform linear static analysis based on the temperature profile obtained from the thermal analysis.
Example 2: Working with CAD Systems

In this section, you will learn how to analyze models created in other CAD programs. You will find how easy it is to work with models generated in CAD programs in GEOSTAR environment through the incorporation of very powerful IGES translator. A list of the CAD systems that you can work with GEOSTAR is available by issuing the command **CAD_INP** (Control > CAD_System > Read CAD Input).

Description of the Problem

We will analyze a bracket model created by the MicroStation modeler version 5.0. The model is subjected to the loads and boundary conditions shown in the figure.

![Bracket Model with Loads and Boundary Conditions](image)

The bracket is modeled with TERA10 solid elements. These elements have 3 translational degrees of freedom per node. As we did in the first example, we will start by defining element groups and material properties, applying loads and boundary conditions, then running the analysis and visualizing the results.

Starting GEOSTAR

Double click on the GEOSTAR icon. GEOSTAR will prompt you with a dialog box for a problem name.
Enter a name for the problem: **Bracket_Model**
Click **OK**.
Chapter 2  Getting Started

Importing the Model into GEOSTAR

To import the bracket model into GEOSTAR:

I. Geo Panel: Control > CAD_System > Read CAD Input
   CAD system: Pro/E 18+, PT/M 2+
   CAD model IGES file name: Click Find button and navigate to the ExampleProblems folder in the COSMOS/M installation and select the Bracket.igs file. Click OK

In order to ease the process of applying loads and boundary conditions later on, it is recommended to reorient the model by performing a successive rotations about the global coordinate axes using rotation buttons. We will perform rotations about the X-axis first, followed by rotations about the Z-axis as follows:

II. Geo Panel: Click the X-axis button

   Click the rotation button five or six times

   Click the Z-axis button

   Click the rotation button five or six times

The Bracket model will be oriented as shown in the figure below:

Figure 2-25. Orienting the Bracket Model
Specifying Properties

It is a good practice to define elements groups, materials, and real constant sets in the beginning. All related commands are found in the PropSets menu.

Specifying the Element Group

I. **Geo Panel:** Propsets > **Element Group**

- Element group : 1
- Egroup Category: **Volume** (for the Unix version only)
- Element Name: **TETRA10: 10-node tetrahedral solid element**
- Click **Continue**
- Click **OK** to accept the defaults associated with the element group

Specifying Material Properties

Next, define the material properties.

II. **Geo Panel:** Propsets > **Pick Material Lib**

- Material property set : 1
- Material Name: **A_STEEL: ALLOY STEEL**
- Unit Label: **FPS:** British (Inch/Pound/Second)
- Click **OK**

![Figure 2-26. Dialog Box for Applying Material to the Bracket](image)

There is no real constant associated with **TETRA4R** element.

List and Verify Your Inputs

To verify the element group and the material properties you have just input you can proceed as follows:

I. **Geo Panel:** Edit > **LIST > Element Groups**

- Beginning element group : 1
Chapter 2  Getting Started

Ending element group : 1
Increment: 1
Click OK to accept the entries for element group listing

Similarly, you can list the material properties.

Meshing the Model

We will mesh the model with the default element size. To see the default element size:

1. Geo Panel:  Edit > LIST > Polyhedra
   Beginning Polyhedron: 1
   Ending Polyhedron: 1
   Increment: 1
   Click OK

The polyhedra list window opens. Under the Elem_size column a uniform element size of 0.668759 is assigned to all regions of the polyhedron.

Figure 2-27. Listing the Polyhedra of the Bracket

To mesh the model with the default element size:

1. Geo Panel:  Meshing > Auto_Mesh > Parts
   Beginning Part: 1
   Ending Part: 1
   Increment: 1
   Hierarchy check flag: 0: NO
   Element order flag: 1: High
   Number of smoothing iterations: 4
   Number of aspect ratio check iterations: 0
   Jacobian check flag: 0: No
   Click OK
To view the mesh in the shade mode:

1. **Geo Panel:** Display > Display_Option > Shaded Element Plot
   - Shaded plot flag: 1: Flat shade
   - Positive normal side color: 4: Red
   - Negative normal side color: 7: Gray
   - Tolerance intensity for Gouraud shading: 0.2
   - Click OK

   Click the **Repaint** button to refresh the screen

The following model will be displayed

**Figure 2-29. Bracket Model with Finite Element Mesh**
Chapter 2 Getting Started

Applying Loads and Boundary Conditions

We will fix the inside regions of the holes on the two side walls of the bracket. You can either type in the region number in the DRG dialog box or you can select it from the display area by the mouse. If you choose the later option, you will need to plot the regions of the model. To do so, clear the screen by clicking the CLS button, then issue the command RGPLOT (Edit > Plot > Regions).

To fix the faces of the holes:

   - Beginning Region: 26
   - Displacement label: AU: All translations
   - Value: 0
   - Ending Region: 26
   - Increment: 1
   - Click OK

   Figure 2-30. Applying Displacement Boundary Conditions

Repeat this procedure for regions 13, 15, and 28.

Next, we will apply a pressure of magnitude 500 psi normal to the bottom face of the bracket as follows:

   - Beginning Region: 51
   - Pressure magnitude: 500
   - Ending Region: 51
   - Increment: 1
   - Unused option: 0
   - Pressure direction: 4: Normal
   - Click OK
Figure 2-31. Applying Pressure Load

The following figure shows the applied boundary condition and loads on the finite element mesh of the bracket.

Figure 2-32. The Complete Finite Element Model of the Bracket Part

Performing the Analysis

We will consider linear static analysis for this model. To view or modify the static analysis options, issue the command, A_STATIC (Analysis > Static > Static Analysis Options). In this example, all default values will be used; thus, there is no need to issue this command. To perform the static analysis:

1. Geo Panel: Analysis > Static > Run Static Analysis

GEOSTAR will display status messages as it runs the analysis module. When the analysis is completed, the program will return to the Display Window and wait for your next instruction.
Chapter 2  Getting Started

Postprocessing of the Static Analysis Results

In the postprocessing phase, several options are available:

- You can examine the results written in the problem output file. This can be done using your preferred editor from the operating system level.
- You can list the model displacements and stresses using the commands provided in: Geo Panel: Results > LIST. You can also list extreme values of a displacement or a stress component (Geo Panel: Results > Extremes).
- Finally, graphic postprocessing may be performed to examine deformations, displacements, and stresses.

Visualizing Stress Results

To generate a contour plot for the von Mises stress:

1. Geo Panel: Results > Plot > Stress
   Load case number: 1
   Component: VON: von Mises Stress
   Stress flag: 1: Node
   Layer number: 1
   Face flag: 0: Top
   Coordinate System: 0
   Click Contour Plot
   Click OK to accept all the defaults

Figure 2-33. Von Mises Stress Contour Plot
To suppress the display of the element boundaries in the von Mises stress plot, we will use the `BOUNDARY` command (Display > Display_Options > Set Bound Plot).

1. Geo Panel: Display > Display_Options > Set Boundary Plot
   - Boundary plot: 0: None
   - Geometry associated boundary flag: 1: Yes
   - Click OK

![Figure 2-34. Von Mises Stress Plot After Executing the BOUNDARY Command](image)

To generate a section plot for the von Mises stress in the same window:

1. Geo Panel: Results > Plot > Stress
   - Load case number: 1
   - Component: VON: von Mises Stress
   - Stress flag: 1: Node
   - Layer number: 1
   - Face flag: 0: Top
   - Coordinate System: 0
   - Click Section Plot
   - Orientation of section planes: 1:Y
   - Click Continue
   - Number of section planes [1,12]: 12
   - Click OK to accepts the rest of the defaults
Visualizing Displacement Results

To generate contour plot for the resultant displacement:

1. **Geo Panel**: Results > Plot > **Displacement/Response/Reaction**
   - Load case number: 1
   - Component: **URES**: Resultant Displacement
   - Coordinate system: 0
   - Click **Continue**
   - Click **OK** to accept the rest of the defaults

**Figure 2-36. Resultant Displacement Contour Plot**

To animate the displacement plot:

1. **Geo Panel**: Results > Plot > **Animate**
   - Click **OK** to accept all the defaults
Introduction

The success of a finite element method for modeling and analyzing a design is based largely on the procedures used. Regardless of the type of application (structural, thermal, fluid flow, electromagnetic, etc.), numerical simulation by the FEM requires complete information about the domain under consideration. Whatever the case might be, the problem's model must contain all the necessary data for each of the different steps in the numerical computation (geometry, elements, loads, boundary conditions, solution of the system of equations, visualization of results, etc.).

This chapter introduces the techniques and procedures used in GEOSTAR for the creation of the model's geometry, generation of finite element meshes, control of the type of analysis and the graphical display of finite element results. Thus, the basic steps in a finite element analysis, as schematically shown in Figure 3-1, may be presented as follows:

- Create the problem’s geometry
- Mesh the defined geometry with appropriate type of element(s)
- Apply boundary conditions (constraints) on the finite element model
- Define the loads on the model
- Define material properties
- Submit the completed finite element model for analysis
• Interpret and analyze the results

All the operations that are performed prior to submitting the model to analysis are referred to as preprocessing. Postprocessing manipulates the analysis results for easy understanding and interpretation.

**Figure 3-1. Finite Element Analysis Steps**

In the following sections, light will be shed on the above mentioned aspects of the finite element modeling and analysis in COSMOS/M. It is not intended to cover all the details but rather to illustrate the concepts. It is recommended that the user read the relevant sections of the COSMOS/M Command Reference, Basic System and Advanced Modules Manuals in conjunction with this chapter for complete information.

**Coordinate Systems**

Three types of global coordinate systems can be directly used in GEOSTAR:

• Cartesian coordinate system
• Cylindrical coordinate system
• Spherical coordinate system

Figure 3-2 illustrates the different types of coordinate systems in COSMOS/M. The Cartesian coordinate system is the most commonly used. Often, coordinates in other systems are internally mapped into the Cartesian system during analysis. The coordinates of a point in the Cartesian system are established entirely in units of length for one-, two- and three-dimensional geometries (X, Y, Z). All other coordinate systems use a combination of lengths and angles to represent the
Chapter 3   Exploring GEOSTAR

coordinates of a point. The cylindrical coordinate system uses two length measures and an angle to describe the location of a point in three-dimensional space \((R, \theta, Z)\). The polar coordinate system is a special two-dimensional representation of the cylindrical coordinate system \((R, \theta)\). In the spherical coordinate system, two angles and a length quantity are used for coordinate description \((R, \theta, \phi)\).

The following notations are used in COSMOS/M for coordinate systems:

<table>
<thead>
<tr>
<th>Type</th>
<th>Label</th>
<th>Notations on Screen</th>
<th>Notation in Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cartesian ((X, Y, Z))</td>
<td>0</td>
<td>X, Y, Z</td>
<td>X, Y, Z</td>
</tr>
<tr>
<td>Cylindrical ((R, \theta, Z))</td>
<td>1</td>
<td>r, t, z</td>
<td>X, Y, Z</td>
</tr>
<tr>
<td>Spherical ((R, \theta, \phi))</td>
<td>2</td>
<td>r, t, p</td>
<td>X, Y, Z</td>
</tr>
</tbody>
</table>

Moreover, user-created coordinate systems (referred to as local coordinate systems) can be defined using one of the following three commands in the Geometry > Coordinate System submenu:

- **3 Points (CSYS)** 3 keypoints. Defines a local coordinate system based on origin location and three rotations about the global Cartesian axes.
- **3 Angles (CSANGL)** Defines a local coordinate system based on a specified transformation matrix.
- **Matrix (CSMATRIX)**

It should be noted that the local (user-defined) coordinate systems may be labeled 3 to 5000 and may be Cartesian, cylindrical or spherical. Labels 0, 1 and 2 are reserved, as previously shown, for the built-in COSMOS/M global coordinate systems. The user can activate an existing coordinate system using the Control > ACTIVATE > Set Entity command.
Preprocessing

In COSMOS/M, preprocessing includes all the necessary steps that are needed to prepare the model for analysis. This phase of the finite element application contains the following steps:

- Creating the geometric configuration of the model. The geometric entities are very useful for pre- and postprocessing operations. This step is not always required since, for simple models, you can create nodes and elements directly.
- Selecting suitable types of elements to efficiently and accurately represent the physical behavior of the model.
- Generating the finite element mesh, either by meshing geometric entities or by directly defining nodes and elements. This step includes various features such as bonding various parts of the model with or without compatible meshes using the Joint Bond feature, control of mesh density, etc.
- Applying loads and boundary conditions.
- Checking input data and specifying analysis options and desired output results.
Building the Geometry of the Model

The ultimate goal of the preprocessing stage is a finite element model that is fully described for the desired analysis module in terms of nodes and elements. Loading, boundary conditions, analysis flags, and options, are all specified for an analysis module in terms of nodes and elements. It is always possible to define the FEA model without any geometry, but this task becomes increasingly difficult as the complexity of the model increases.

You can import the geometry from your favorite CAD system, or use GEOSTAR to create it. It should be noted that you can mesh and process imported geometry as usual but you may not edit it.

Advantages of Using Geometry

- Facilitate mesh generation:
  Finite element models that can take great effort and long time to generate by directly defining nodes and elements, can be meshed easily and quickly by taking advantage of GEOSTAR’s mesh generation features.

- Simplify loading and boundary conditions specifications:
  As far as the analyses modules are concerned, all loading and boundary conditions must be applied at nodes and/or elements. GEOSTAR allows the user to specify loading and boundary conditions to geometric entities in addition to nodes and elements. Whenever such conditions are applied to geometric entities, GEOSTAR calculates and applies equivalent loads and boundary conditions to all associated nodes and/or elements.

  For some GEOSTAR capabilities, geometry must be used. The BONDING utility, for example, must be applied to geometric entities and can not be specified for element edges or faces (refer to the BONDDEF (LoadsBC > Structural> Bonding> Define Bond parameters) command). Another example is the automatic generation of contact surfaces in NSTAR (refer to the NL_GSAUTO (Analysis > NONLINEAR > CONTACT > Contact Surface by Geometry) command.

- Facilitate postprocessing:
  Using geometric entities helps you examine the results of the analysis. Selection lists act as filters that allow masking certain members of entities. You can select nodes/elements based on their association with geometric entities. For detailed description of multiple selection lists and their use refer to the Control > SELECT menu.
Geometric Entities in GEOSTAR

Finite element modeling is applicable to almost all practical geometry models. The types of geometries encountered can be broadly classified as:

- Discrete geometry which includes points used for representing models such as concentrated masses and connecting springs.
- Lattice geometry (curves) which refers to a grid of line elements. Curves can be meshed to generate line elements like beams and trusses.
- Continuous geometry which is used to represent two- and three-dimensional continuous objects. These objects can be planar or solid. Planar objects can be flat (two-dimensional) or curved (three-dimensional). Solid continuous objects require three-dimensional representation.

In GEOSTAR, the following geometric entities are used:

- Keypoints (PT)
- Curves (CR)
- Surfaces (SF)
- Volumes (VL)
- Contours (CT)
- Regions (RG)
- Polyhedra (PH)
- Parts (PA)

These geometric entities can be classified into two different types:

- Parametric entities represented by curves, surfaces and volumes, where the geometric hierarchy goes from keypoints (as the lowest in the hierarchy order) to curves, surfaces, and volumes. The parametric entities can be used for parametric one-, two- and three-dimensional meshing.
- Non-parametric entities represented by contours, regions, polyhedra and parts, where the geometric hierarchy goes from keypoints (lowest in order) to curves, contours, regions, polyhedra, and parts. The non-parametric entities can be used for the automatic one-, two- and three-dimensional meshing.

Shown below is a detailed description of GEOSTAR's geometric entities.
Keypoints (PT)

Keypoints are the most primitive entity in GEOSTAR, and the lowest in hierarchy. They are part of all other hierarchies. Keypoints can be created by snapping to an active grid on a plane, or by specifying coordinates for a point in space. In addition, keypoints can be relocated or created by operations like symmetry, flipping, extruding and many other options.

Curves (CR)

Curves are one-dimensional parametric entities built from a combination of keypoints in space. Many types of curves can be automatically generated by GEOSTAR, including straight lines, conical curves, splines and Bezier curves. In addition, curves can be relocated or created by operations like symmetry, flipping, extruding, dragging, sweeping and many other operations. The direction of a curve is determined by the order in which its keypoints are connected. The direction of a curve is depicted by an arrow. The arrow is not active by default, but can be activated by the user, when desired, through ACTMARK (Control > ACTIVATE > Entity Mark) or STATUS1 buttons. The direction of a curve, as shown in Figure 3-3, can be reversed using CRREPAR (Geometry > CURVES > MANIPULATION > Reverse Cr Direction).

Figure 3-3. Direction of Curves

Surfaces (SF)

Surfaces are two-dimensional parametric entities that can be planar or curved. A comprehensive command list is provided for generation and manipulation of surfaces, including symmetry, flipping, extrusion, gliding, dragging, scaling and many other options. Automatic alignment is used to generate surfaces from curves, so that the user can define surfaces without the need to change member curves.
directions. The parametric coordinates of a surface are identified by an asterisk (*) that appears on the first parametric curve near its start as shown in Figure 3-4. The second parametric curve starts at the corner closest to the asterisk. Many commands to generate planar and curved surfaces are available.

**Figure 3-4. Surface Orientation**

The formal representation of surfaces in space requires that each pair of boundary curves on opposite sides of a surface have the same general direction. This condition is automatically enforced by the code, giving the user the freedom to define boundary curves in any arbitrary manner. GEOSTAR makes the necessary curve reparameterization before building a surface as long as a non-twisted surface is feasible. Figures 3-5 and 3-6 show two cases where forming a surface using two opposite curves is done without and with the need to reparameterize one of the curves. A surface cannot have more than 4 curves.

**Figure 3-5. Forming a Surface Without the Need for Curve Reparameterizing**
Plotting the asterisk to show the parametric curves of surfaces is possible through the use of the **ACTMARK** command. The **SFREORNT** (Geometry > SURFACES > MANIPULATION > Re-orient) command can be used to reverse the direction of the first parametric curve and the **SFREPAR** (Geometry > SURFACES > MANIPULATION > Reparameterize) command can be used to change the first parametric curve of the surface.

**Volumes (VL)**

Volumes are three-dimensional parametric entities. A comprehensive command list is provided for volume generation and manipulation, including symmetry, flipping, extrusion, gliding, dragging, scaling and many other options. Automatic alignment is used in some commands to generate volumes so that the user can define entities without the need to change their orientations.

The three parametric coordinates of a volume are identified by an asterisk and an arrow, the asterisk appears on the first parametric curve near its start. The second parametric curve starts at the corner closest to the asterisk and the third is identified by an arrow. Figure 3-7 illustrates the parametric curves of a volume.

For proper volume representation, it is recommended that:

1. Normal to any two opposite surfaces defining a volume be in the same direction, i.e., they have the same orientation.

2. There should be curve-to-curve correspondence between the parametric coordinates on any two opposite surfaces defining a volume, which implies that the asterisks identifying the first directional curves on any two opposite surfaces be in the same relative location as noted in Figure 3-7.
3. The automatic alignment flag can instead be used in most situations involving creation of regular shaped volumes. The user, therefore, need not consider such details mentioned before. The commands \texttt{VL2SF, VL4SF, VLCRSF} and \texttt{VL4CR} (Geometry > VOLUMES > 2 Surfaces, 4 Surfaces, 1 Curve 1 Surface, and 4 Curves) have an automatic alignment flag which, when activated, automatically makes the necessary changes to form a feasible volume.

**Contours (CT)**

Contours are closed loops of curves that must lie in the same plane (flat contour) or on an underlying surface. They are used to define regions. Uniform and nonuniform contours can be defined in GEOSTAR. Uniform contours have uniform element distribution specified by either an average element size or by the number of elements on the contour. Nonuniform contours are created by specifying the average element size or the number of elements on each member curve. This information is used when regions are meshed. Contours are used for models with complicated boundaries. Up to 250 curves can define a contour.

**Regions (RG)**

Regions are defined by an outer contour and up to 19 inner contours. All contours of a region must be in the same plane or on an underlying surface. Regions are meshed according to specifications of their member contours. Regions are used for arbitrary two-dimensional areas with cuts and holes.
Chapter 3   Exploring GEOSTAR

Polyhedra (PH)

A polyhedron in GEOSTAR is a continuous multi-sided closed boundary defined by a group of surfaces and/or regions that constitute the entire surface area of a three-dimensional enclosure. Either a surface or a region can be used as a reference entity to define a polyhedron.

Parts (PA)

A part in GEOSTAR is a multi-sided three-dimensional solid defined by the space enclosed by a single or a group of polyhedra.

Classification of Geometry Commands

Figure 3-8 and the following information are intended to help the user get familiar with geometry commands and their cryptic names. As previously mentioned, a command in GEOSTAR may be called by picking from the menus using the mouse, or by typing the command at the “GEO >” prompt using the keyboard.

To generate new entities by operating on entities of the same level, some commands are shown below:

- **Generate**
  Generates new entities from existing ones by translations and/or rotations.

- **Copy**
  Generates new entities by copying existing ones to a coordinate system.

- **Symmetry**
  Generates new entities from existing ones by symmetry.

- **Scaling**
  Generates new entities by scaling existing ones.

It should be noted that the (Generate, Copy, Scaling and Symmetry) group of operations are similar to (Relocate, Move, Flip and Resize) respectively except that the first group generates new entities while the second group modifies existing ones.
The geometric entities can be edited and listed using the following submenus found in the Edit menu:

- **Identify**: Highlights an entity and displays its ID (label).
- **Compress**: Removes labeling gaps.
- **Plot**: Plots on the screen.
- **List**: Lists on the screen.
- **Delete**: Deletes from the database.
- **Undelete**: Undeletes recently deleted entities.
- **Erase**: Erases from the screen.

Refer to the on-line help for detailed description of commands in Geometry menu.
Chapter 3 Exploring GEOSTAR

Geometry Information

You may request, at any time, information about the created geometric entities utilizing the following commands found in the Control > MEASURE menu:

- **Calculate Distance**: Lists the distance between two keypoints.
- **Calculate Length**: Lists the length of a curve or a contour.
- **Calculate Angle**: Lists the angle between three keypoints or two curves.
- **Calculate Area**: Lists the area defined by four keypoints, or the area of surfaces and regions before or after deformation.

Finite Elements

Elements are the fundamental building blocks of finite element analysis. The elements' shape approximates the geometry of the structure, while their mathematical model simulates the physical behavior.

Depending upon the geometry of the modeling domain, one or more of the following types of finite elements can be used for discretization:

1. Concentrated (0D) elements to model 1-node elements like concentrated masses and gaps.

2. One-dimensional (1D) line elements to model beams, columns, rods, bars, stiffeners, cables, etc. The 2-node axisymmetric shell elements, used to discretize axisymmetric structures, may be included in this category.

3. Two-dimensional (2D) area elements for modeling surface structures like plates and shells. The axisymmetric plane elements, used to discretize axisymmetric shell and pressure vessel type structures, may be included in this group based on the modeling space of the structure.

4. Three-dimensional (3D) volume elements for modeling continuums. Hexahedral and tetrahedral-type solid elements.

In COSMOS/M, both H- and P-versions of the finite element method are available in addition to the HP-approach. The classification of the available element types according to the geometry of the modeling domain is shown in Figure 3-9. Another classification based on the behavior of elements if given in Figure 3-10. Complete information about COSMOS/M element library is included in Chapter 4 of this manual and is also available in the online help.
Figure 3-9. Classification of COSMOS/M Elements According to the Geometry Domain

Geometric Classification of Elements

- Concentrated
  - Spring
  - Mass
  - Buoy
- Skeletal 1D
  - Truss
  - Beam
  - Axisymmetric Shell
  - Pipes
- Plane 2D
  - Plane Stress
  - Plane Strain
  - Axisymmetric Body
  - Shells
- Solid Blocks 3D
  - Hexahedral Solid
  - Tetrahedral Solid
  - General (User-Defined)

Figure 3-10. Classification of COSMOS/M Elements According to Their Behavior

Element Behavior Classification

- 1D
  - Truss (bar)
  - Spring
  - Mass
  - Buoy
- 2D
  - Plane Stress
  - Plane Strain
  - Axisymmetric Body
  - Axisymmetric Shell
- 3D
  - Hexahedral Solid
  - Tetrahedral Solid
  - General (User-Defined)
  - Shell
  - 2D Truss
  - 2D Beam
  - 2D Pipe
  - Spring
  - Mass
  - Buoy
  - 3D Truss
  - 3D Beam
  - 3D Pipe
  - Spring
  - Mass
  - Buoy

Element Attributes

In COSMOS/M, elements are associated with the attributes shown below to completely define the behavior of the element:

- Element group (EG)
Chapter 3 Exploring GEOSTAR

- Real Constant set (RC)
- Material Property set (MP)
- Element coordinate system (ECS)

Element attributes can be defined through commands in the Propsets menu. Whenever an element is generated, it assumes the active attributes unless specified by the EPROPSET (Propsets > New Property Set) command.

The active attributes are shown in the tables displayed by STATUS1, STATUS2 and STATUS3 buttons.

A brief description of these attributes is shown next.

Element Groups

Every element in the model's mesh has to be associated with an element group name before performing the analysis. Through element groups, GEOSTAR distinguishes between truss and beam elements, for instance. In addition to the element group name, the EGROUP (Propsets > Element Group) command controls different options related to the element formulation and type of analysis. Shown in Table 3-1 is a list of all element groups that are available in COSMOS/M along with the analysis modules that support them. The EGROUP command may also be utilized to redefine an existing element group.

Element groups with their options can be listed and deleted using the List and Delete submenus of the Edit menu.

In addition to the elements listed in Table 3-1, the user can use 5 more elements defined by commands other than the EGROUP command. These elements are given in Table 3-2 for STAR, ASTAR, NSTAR and ESTAR module.

Table 3-1. Elements Defined by the Element Group Command

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>STAR</th>
<th>DSTAR</th>
<th>ASTAR</th>
<th>NSTAR</th>
<th>OPT-STAR</th>
<th>HSTAR</th>
<th>FLOW-STAR*</th>
<th>EASTAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUSS2D &amp; TRUSS3D</td>
<td>2D/3D truss</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>BEAM2D &amp; BEAM3D</td>
<td>2D/3D beam</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>PIPE</td>
<td>Straight pipe</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>
## Chapter 3  Exploring GEOSTAR

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Description</th>
<th>Supported Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELBOW</td>
<td>Curved pipe</td>
<td>• • • • •</td>
</tr>
<tr>
<td>BOUND</td>
<td>Boundary</td>
<td>• • • •</td>
</tr>
<tr>
<td>MASS</td>
<td>General mass</td>
<td>• • • • • • •</td>
</tr>
<tr>
<td>PLANE2D</td>
<td>4- to 8-node plane stress, plane strain, axisymmetric</td>
<td>• • • • •</td>
</tr>
<tr>
<td>TRIANG</td>
<td>3- to 6-node plane stress, plane strain, axisymmetric</td>
<td>• • • • •</td>
</tr>
<tr>
<td>SHELL3</td>
<td>Triangular thin shell</td>
<td>• • • • • • •</td>
</tr>
<tr>
<td>SHELL4</td>
<td>Quadrilateral thin shell</td>
<td>• • • • • • •</td>
</tr>
<tr>
<td>SHELL3T</td>
<td>Triangular thick shell</td>
<td>• • • • • • •</td>
</tr>
<tr>
<td>SHELL4T</td>
<td>Quadrilateral thick shell</td>
<td>• • • • • • •</td>
</tr>
<tr>
<td>SHELL3L</td>
<td>Composite triangular shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SHELL4L</td>
<td>Composite quadrilateral shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SHELLAX</td>
<td>Axisymmetric shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SHELL6</td>
<td>6-node thin triangular shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SHELL6T</td>
<td>6-node thick triangular shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SHELL9</td>
<td>8- to 9-node isoparametric shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SHELL9L</td>
<td>8- to 9-node isoparametric composite shell</td>
<td>• • • •</td>
</tr>
<tr>
<td>SOLID</td>
<td>8- to 20-node isoparametric hexahedral solid</td>
<td>• • • • • •</td>
</tr>
<tr>
<td>TETRA4 &amp; TETRA10</td>
<td>4- to 10-node tetrahedral solid</td>
<td>• • • • • • •</td>
</tr>
<tr>
<td>TETRA4R</td>
<td>4-node tetrahedral solid with rotation</td>
<td>• • • •</td>
</tr>
<tr>
<td>SOLIDL</td>
<td>8-node composite solid brick</td>
<td>• • • •</td>
</tr>
<tr>
<td>SOLIDPZ</td>
<td>8- to 20-node isoparametric piezoelectric hexahedral solid</td>
<td>* •</td>
</tr>
<tr>
<td>SPRING</td>
<td>Spring element</td>
<td>• • • •</td>
</tr>
</tbody>
</table>
Chapter 3   Exploring GEOSTAR

Table 3-2. Elements Defined by Commands Other Than Element Group Command

<table>
<thead>
<tr>
<th>Element Library Matrix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CRACK elements (associated with 8-node PLANE2D and 20-node SOLID elements)</td>
</tr>
<tr>
<td></td>
<td>Super elements (associated with substructuring)</td>
</tr>
<tr>
<td></td>
<td>Post-dynamic node-to-node gap elements</td>
</tr>
<tr>
<td></td>
<td>Infinite elements (for electrostatic and magnetostatic analyses)</td>
</tr>
</tbody>
</table>

Real Constants

The RCONST (Propsets > Real Constant) command defines the element sectional and other physical properties or real constants (e.g., thickness of SHELL elements). Up to 5000 real constant sets can be used. Depending on the specified element type associated with the real constant set, different options will be prompted (the program prompts for AREA in case of TRUSS elements). Real constant sets can be listed and deleted using the List and Delete submenus of the Edit menu. For beam elements you can choose a cross-section from a built-in library:

AISC Sect Table       assigns a selected section from the AISC code table to the three dimensional beam real constant set.
Beam Section assigns predefined cross-sections for two-dimensional and three-dimensional beam elements.

Material Properties

Mathematical models describing physical behavior such as deformation and conduction are called material models or constitutive equations. Hooke's law, which linearly relates stress with strain by means of a constant elastic modulus, is an example of the stress-strain equation, representing a linear model and its constitutive equation.

The types of materials used in different applications range from heterogeneous materials such as concrete to homogeneous materials such as steel. Material properties may be direction dependent. An isotropic material has identical properties in all directions. Orthotropic materials, on the other hand, have preferred directions of strength which are mutually perpendicular. Anisotropic material properties may vary in each direction. COSMOS/M provides the following types of commonly used material models:

- Linear elastic isotropic models
- Linear elastic orthotropic models
- Linear elastic anisotropic models
- Nonlinear material models
- Isotropic heat conduction material properties
- Orthotropic heat conduction material properties
- Convection and radiation material properties
- Isotropic thermal expansion/contraction material properties
- Orthotropic thermal expansion/contraction material properties
- Various types of damping and mass material properties for dynamics analyses

The **EGROUP** command specifies the material model to be used while the **MPROP** (Propsets > Material Property) command defines the material properties. A maximum number of 999 material sets can be defined. Material Properties can be listed and deleted using the List and Delete submenu of the Edit menu.

In addition, the **PICK_MAT** (Propsets > Pick Material Lib) command selects the material properties from COSMOS/M material library in the following units:

- British system (FPS)
Chapter 3   Exploring GEOSTAR

- International system (SI)
- Metric system (MKS)

Moreover, the USER_MAT (Propsets > User Material Lib) command assigns material properties from a user-defined material library. Detailed information is given in the Command Reference and the Basic System Manuals.

You can define temperature-dependent material properties for most elements in COSMOS/M, by making use of the temperature curve definitions shown in Table 3-3. First, you need to activate temperature curve definition using the ACTSET (Control > ACTIVATE > Set Entity) with TP referring to the set label, and then use the CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve) command to define different temperatures and the corresponding to material properties. You can make use of the MAKE_CYCLE (LoadsBC > FUNCTION CURVE > Repeat Time/Temp) command to repeat defined patterns of the temperature curve.

For nonlinear structural problems, you can define nonlinear elastic or plastic material curves using the MPCTYP (LoadsBC > FUNCTION CURVE > Material Curve Type) and MPC (LoadsBC > FUNCTION CURVE > Material Curve) commands. For Electromagnetic problems, B-H curve definition is also available as shown in

<table>
<thead>
<tr>
<th>Module</th>
<th>Curve Axes</th>
<th>Commands to Create Curve(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Curve</td>
<td>X-Label</td>
<td>Y-Label</td>
</tr>
<tr>
<td>STAR, (ASTAR), NSTAR, HSTAR</td>
<td>Temperature</td>
<td>Material Properties                                                                      LOADS BC &gt; FUNCTION CURVE &gt; Time/Temp Curve</td>
</tr>
<tr>
<td>FLOWSTAR</td>
<td>Temperature</td>
<td>Fluid Properties                                                                          LOADS BC &gt; FUNCTION CURVE &gt; Time/Temp Curve</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material Curve: Non-Linear Elastic</td>
<td>Strain</td>
<td>Stress                                                                                   LOADS BC &gt; FUNCTION CURVE &gt; Mat. Curve Type LOADS BC &gt; FUNCTION CURVE &gt; Material Curve</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material Curve: Non-Linear Plastic</td>
<td>Strain</td>
<td>Stress                                                                                   LOADS BC &gt; FUNCTION CURVE &gt; Mat. Curve Type LOADS BC &gt; FUNCTION CURVE &gt; Material Curve</td>
</tr>
</tbody>
</table>

Table 3-3 Curves Associated with Material Behavior
Chapter 3 Exploring GEOSTAR

It is suggested to plot the temperature, material and B-H curves for revision. Shown in Table 3-3 are nine (9) commands for plotting X-Y type graphs. It should be mentioned that you do not have to use all commands to plot curves associated with the material behavior. Basically, you need to utilize the **INITXYPLOT**, **ACTXYPRE** and **XYPLOT** (Display > XY PLOTS > Initialize, Activate Pre-Proc and Plot Curves) commands. The remaining commands are intended to give you the flexibility to control the features of the graph, list the available data and identify some values of the plotted curves using the mouse.

**Element Coordinate System (ECS)**

The default (or built-in) element coordinate system refers to the local coordinate system defined by the element local nodes. Chapter 4 provides detailed information about the default element coordinate system (ECS = -1). You may choose to change the ECS to a user-defined coordinate system for these purposes:

a. Define material angles of orthotropic materials.
b. Get output stress results for some element groups in the specified ECS.
c. Determines the directions of beam loading.

**Meshing in GEOSTAR**

Users have a wide range of meshing options in COSMOS/M. Selecting the most appropriate method for the application at hand can save time without sacrificing accuracy. It is hoped that the information presented in this section along with the
modeling examples detailed in Chapter 5 will help the user understand and confidently apply the GEOSTAR’s powerful meshing procedures. The subjects discussed in this section include the following:

- Direct Mesh Generation
- Parametric Meshing
- Automatic Meshing
- Carrying the Mesh with Geometry and Creating 2D and 3D meshes from 1D and 2D meshes respectively
- Local Mesh Control
- Adaptive Meshing
- Mesh Refinement
- Bonding Incompatible Meshes
- Automatic Generation of Contact Lines and Surfaces
- Mesh Information

Whatever the method you decide to use, the following commands are common for all of them:

**For Nodes (Meshing > Nodes)**

- **Merge**
  Merges coinciding nodes within specified tolerance
- **Show Merged Nd**
  Displays the nodes that will be merged using Merge
- **Modify**
  Modifies coordinates of nodes

**For Elements (Meshing > Elements)**

- **Merge Element**
  Merges coincident elements
- **Element Order**
  Changes the order of the element
  - 3-node elements to 6-node elements or vice versa
  - 4-node elements to 8-node elements or vice versa
  - 8-node (solid) elements to 20-node (solid) elements or vice versa
  - 4-node tetrahedral elements to 10-node tetrahedral elements or vice versa
Direct Mesh Generation

Nodes and elements are directly defined by the user node-by-node and element-by-element, similar to the approach used in the early stages of FEA. While this procedure is sometimes useful, where just few elements are to be generated, it is usually tedious and time consuming for large models. To improve this primitive method, GEOSTAR provides many commands to generate nodes and elements from existing ones. When elements are generated from existing elements, the corresponding nodes are automatically generated. 3D elements can be generated by extruding, sweeping, gliding, and dragging 2D elements (see Table 3.7). Similarly 2D elements can be generated from 1D elements. The Meshing > NODES > Generation Menu and the Meshing > ELEMENTS > Generation Menu submenus of the Command Reference Manual have complete description.

The general approach to create elements by direct definition is as follows:

- **Define Node**: Defines a node at the specified coordinates in the active coordinate system or creates a node at the location of a keypoint.
- **Define Elem**: Creates an element by specifying its node connectivity. The correct type of associated geometric entity must be specified. For example a 1-node element must be associated with a keypoint (PT), a 1D element must be associated with a curve (CR), and a 2D element must be associated with a surface (SF) or region (RG), and a 3D element must be associated with a volume (VL).

Parametric Meshing

This method applies only to the parametric entities where users have control over the number or size of elements on the geometric entity's parametric curves(s). All the commands within that submenu, related to this type of meshing are in the Meshing > PARAMETRIC submenu. The following commands can be used to operate on 1D, 2D or 3D parametric domains to generate 1D, 2D or 3D elements respectively:

- **Points**: Creates a 1-node element at each keypoint (e.g., MASS or 1-node GAP).
- **Curves**: Creates 1D elements along curves (e.g., TRUSS2D and BEAM3D).
- **Surfaces**: Creates 2D Quadratic or triangular elements by meshing a surface (e.g., PLANE2D and SHELL4).
Chapter 3  Exploring GEOSTAR

**Volumes**  Creates 3D hexahedral, or tetrahedral solid elements by meshing a volume (e.g., SOLID, MAG3D, and TETRA4).

In parametric meshing, users can predict an exact number of the generated elements. During the meshing process, however, users should keep track of the size and number of elements along common edges of surfaces and volumes in order to have a compatible mesh. One drawback that users might face using parametric meshing is that surfaces cannot have more than 4 curves and volumes cannot have more than 6 surfaces. Accordingly, users may have to divide their models into many surfaces and volumes. However, users have full control over the quality of the mesh.

**One- and Two-Dimensional Automatic Meshing**

All the commands related to this type of meshing reside in the Meshing > AUTO MESH submenu. This method applies to both parametric and non-parametric entities. Either the number of elements on the boundary, or the average element size may be specified. For curves, 2-node elements are generated. A third node is added (or an orientation angle has to be specified) in the case of 3D beam elements to define the cross-section orientation. Surfaces, regions, and polyhedra can be triangulated to generate 3- or 6-node elements. The advantage of automatic meshing comes from the fact that a surface is limited to 4 curves but a region can have up to 50 contours, with each contour defined by up to 250 curves. The geometry creation is therefore simpler in many cases. While planar regions are directly created, nonplanar regions need to be underlined by an existing surface. Uniform, or non-uniform meshing can be used. While uniform meshing generates approximately equal-in-size elements, non-uniform meshing generates varying size elements. Non-uniform meshing may be needed for large models, where a fine uniform mesh may generate too many elements. Unlike parametric meshing, the number of elements and the shape of the mesh cannot be exactly predicted.

Some of the commands within the Meshing > AUTO MESH submenu that can be used for one- and two-dimensional automatic meshing are shown in Table 3-4.
### Table 3-4. One- and Two-Dimensional Automatic Meshing Commands

<table>
<thead>
<tr>
<th>Type of Mesh</th>
<th>Command(s)</th>
<th>Shape of Generated Elements</th>
<th>Specified Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Curves</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uniform</td>
<td>Curves</td>
<td>2-node line elements for trusses and beams 3-node for 3D beams</td>
<td>Average element size</td>
</tr>
<tr>
<td><strong>Surfaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uniform</td>
<td>Surfaces</td>
<td>3-node triangular elements</td>
<td>Average size or number of elements along the surface sides</td>
</tr>
<tr>
<td>Non-uniform</td>
<td>Non-uniform surfaces</td>
<td>Number of elements along each side of the surface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface about Pt</td>
<td>Element sizes near and far from a keypoint used as the mesh center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface about Cr</td>
<td>Element sizes near and far from a curve used as the mesh reference</td>
<td></td>
</tr>
<tr>
<td><strong>Regions</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uniform</td>
<td>Regions</td>
<td>3-node triangular elements</td>
<td>Element size unless changed by Curve Elem Size, Contour Elem Size or Region Elem Size</td>
</tr>
<tr>
<td>Non-uniform</td>
<td>Region about Pt</td>
<td>Continuous region with no holes such that the mesh radiates from a keypoint</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Region about Ct</td>
<td>A region defined by two contours such that the mesh radiates from the inner to the outer contour</td>
<td></td>
</tr>
</tbody>
</table>

For regions and surfaces, Surface Mesh Type and Region Mesh Type can be used to change the associated triangular elements to quadratic elements.

### Three-Dimensional Automatic Meshing

COSMOS/M features 3D automatic meshing for solid and shell models. Complex models be easily and quickly meshed. You can use either the 4-node tetra (TETRA4, TETRA4R) or the 10-node tetra (TETRA10) solid elements as well as a variety of triangular shell elements (SHELL3, SHELL3L, SHELL3T, etc.) in your analysis. TETRA4R solid elements have 6 DOF at a node making them compatible with beams and shells. With the 10-node tetrahedral solid element, you can also use the adaptive P-method of finite element analysis to achieve the required level of accuracy by simply increasing the polynomial order.
Chapter 3   Exploring GEOSTAR

The 3D automatic mesh generation feature uses an advancing front with hierarchical technique.

In this mesh generation scheme, the nodes are initially placed throughout the model systematically and then the elements are constructed by connecting these nodes. The elements are checked for aspect ratio and smoothed if necessary to improve the quality of the mesh.

Procedures for 3D Automatic Meshing

The 3D automatic meshing capability has been developed to work in a systematic and convenient manner using the GEOSTAR geometric entities (POLYHEDRON - a hollow volume entity, and PART - a solid volume entity). With these geometric entities, the procedure for 3D automatic meshing of solids and skin-type structures is very simple and straightforward: you just need to build your geometry, define it as hollow or solid, and use the appropriate command, Meshing > AUTO MESH > Polyhedra (surface meshing) or Meshing > AUTO MESH > Parts (solid meshing) to generate your mesh.

For 3D automatic solid or surface meshing, all boundary faces of the solid must be enclosed, i.e., they must be defined as either a region (using the Regions submenu) or a surface (using the Surfaces submenu) to completely enclose a solid or hollow volume. However, cut-outs, holes and openings are permitted in the model. You only need to make sure that the internal faces of these openings are properly defined as surfaces or regions.

If you consider a simple 3D model such as a cube (with no openings) as an example, all six faces of the cube illustrated in Figure 3-11 must be defined as regions or surfaces to enclose the cube.

Figure 3-11. Boundary Faces of a Cube
The 6 faces of the cube (shaded areas in the figure) must be defined as either surfaces or regions to form a POLYHEDRON which defines the skin of a 3D enclosure. To define a 3D solid, a PART must be defined using one or more polyhedrons. You can then use the meshing commands, Meshing > AUTO MESH > Polyhedra and Meshing > AUTO MESH > Parts for 3D automatic surface and solid meshing respectively. Models with open faces can be dealt with by deleting the elements on the required surface or region.

GEOSTAR provides powerful features to automatically generate polyhedra, regions and surfaces from existing entities by means of regeneration, extrusion, sweeping, dragging, moving, gliding, and many others. To build the solid cube discussed here (see Figure 3-11), a square region was first constructed in the X-Y plane using curves 1 through 4 (Geometry > CURVES > Draw Polyline command). This was followed by contour and region definition. The region is then extruded to define a polydron which is used to define the part (Meshing > AUTO MESH > Parts command).

When you define a polyhedron, you will be prompted to input the average element size for use in automatic meshing (this input overrides the average element size defined earlier during contour definitions). When the Meshing > AUTO MESH > Parts command is executed, the advancing front technique proceeds with the initial placement of the nodes throughout the solid as shown in Figure 3-12.

The number of nodes generated depends on the order of tetrahedra to be generated. If you specify the low option for element order in Meshing > AUTO MESH > Parts command, there will be four nodes generated for each tetrahedron. After the nodes are placed, the mesh generation process continues by connecting the generated nodes to form tetrahedra. After a tetrahedron is formed, the mesh generation scheme checks for aspect ratios and internal angles of the element to
ensure good geometry of the elements. If an ill-shaped element is found, the program performs several trials to improve it by relocating the nodes. Figure 3-13 illustrates the process of element generation from initially placed nodes.

Figure 3-13. Advancing Front Technique in Action

After the mesh generation is completed, the program displays a summary on the number of elements and nodes generated and the total volume of the model. You can use the usual commands to list, identify, shade, or shrink elements. You can also use the hidden line removal feature of GEOSTAR to obtain a clear picture of the finite element mesh. Figure 3-14 shows the generated finite element mesh with and without hidden lines.

Figure 3-14. Generated Mesh of TETRA Finite Elements (with and without Hidden Lines)

Note that the pattern of elements obtained in surface meshing of the cube using the Meshing > AUTO MESH > Polyhedra command is the same as that obtained in solid meshing of the cube using the Meshing > AUTO MESH > Parts command with hidden lines removed. A diagram for the steps required in three dimensional automatic meshing is shown in Figure 3-15.
The example of a solid cube meshing discussed above, albeit simple, serves to illustrate how the new 3D automatic meshing of solids and surfaces is performed in GEOSTAR. However, the 3D mesh generation capability is applicable to models with more complex geometries. In Figures 3-16 to 3-21, several examples of 3D solids and their finite element meshes automatically generated (with hidden lines removed) are shown. You can confirm from these figures that the 3D automatic mesh generation feature of COSMOS/M is quite powerful and can be applied to many real world problems. The GEOSTAR session files to create some of the examples shown below are included in the cosmosm/exampleproblems folder.
Chapter 3   Exploring GEOSTAR

Figure 3-17. Solid Model, Geometry and Finite Element Mesh of a Connector
(example file EX3D1.GEO)

Figure 3-18. Solid Model, Geometry and Finite Element Mesh of a Connector
(example file EX3D2.GEO)

Figure 3-19. Solid Model, Geometry and Finite Element Mesh of a Plate-Mounted
Drive Tightener (example file EX3D3.GEO)
Entities for 3D Automatic Meshing

POLYHEDRA are water-tight closed boundary surfaces define by a number of surfaces and/or regions. In other words, a polyhedron is the skin (surface area) of a 3D enclosure. PARTs on the other hand, correspond to 3D solid geometries that are formed from one or more POLYHEDRA. PART entities can therefore be considered as multiply-connected 3D geometries such as solid models with
cavities. Therefore, a PART represents a solid geometric entity which is one order higher than POLYHEDRON in GEOSTAR.

The relationship between polyhedra and part entities is analogous to the relationship between contours and regions, i.e., just as regions are defined by a set of contours, parts are defined by a set of polyhedra. A part can be described as a generalized volume as a region can be described as a generalized surface. You can mesh polyhedra to generate 3- or 6-node shell elements (Meshing > AUTO MESH > Polyhedra command). You can mesh parts to generate 4- or 10-node tetrahedral elements (Meshing > AUTO MESH > Parts). In either case, you will have control of the overall mesh density by specifying the average element size and local mesh control.

**Element Library**

The 3D automatic meshing capability of COSMOS/M generates tetrahedra for solid volumes and triangles for surfaces. The following types of elements can be used when you generate the finite element mesh automatically using Meshing > AUTO MESH > Polyhedra and Meshing > AUTO MESH > Parts commands:

- 3D Solid Meshing: TETRA4, TETRA4R, TETRA10
- 3D Surface Meshing: SHELL3, SHELL3L, SHELL3T, SHELL6, SHELL6T

**Entity Size Limits**

Table 3-5 presents size limits on the geometric entities used in 3D automatic meshing. Several versions that allow larger limits are also available on the CD.

<table>
<thead>
<tr>
<th>Entity Description</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>SURFACES and/or REGIONS in a POLYHEDRON</td>
<td>8000</td>
</tr>
<tr>
<td>POLYHEDRA in a PART</td>
<td>100</td>
</tr>
<tr>
<td>POLYHEDRA</td>
<td>100</td>
</tr>
<tr>
<td>PARTS</td>
<td>100</td>
</tr>
</tbody>
</table>

Several versions are available on the CD. The executable names and special size limitations are shown in the following table:
Chapter 3   Exploring GEOSTAR

For Regular versions (geo.exe, geo128.exe, geo256.exe, geo512.exe & geo1024.exe):

- Polhydra: 100
- Parts: 100
- Keypoints: 24,000
- Curves: 24,000
- Coord. Systems: 5,000

For Special versions (geo256sp.exe & geo512sp.exe):

- Polhydra: 200
- Parts: 200
- Keypoints: 48,000
- Curves: 48,000
- Coord. Systems: 10,000

For Special Part versions (geo256pp.exe & geo512pp.exe):

- Polhydra: 1000

---

<table>
<thead>
<tr>
<th>No. of Nodes/Elements</th>
<th>Executable Name(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>64K</td>
<td>geostar.exe  geo.exe</td>
</tr>
<tr>
<td>128K</td>
<td>gstar128.exe geo128.exe</td>
</tr>
<tr>
<td>256K</td>
<td>gstar256.exe geo256.exe</td>
</tr>
<tr>
<td>256K S</td>
<td>gstr256s.exe geo256sp.exe</td>
</tr>
<tr>
<td>256K S</td>
<td>gstr256p.exe geo256pp.exe</td>
</tr>
<tr>
<td>512K</td>
<td>gstr512s.exe</td>
</tr>
<tr>
<td>512K S</td>
<td>gstr512s.exe geo512sp.exe</td>
</tr>
<tr>
<td>512KP</td>
<td>gstr512p.exe geo512pp.exe</td>
</tr>
<tr>
<td>1024K</td>
<td>gstr512p.exe</td>
</tr>
</tbody>
</table>
Chapter 3   Exploring GEOSTAR

Parts: 1000
Keypoints: 48,000
Curves: 48,000
Coord. Systems: 10,000

Tips on Using 3D Automatic Meshing

Perhaps the best way to understand the 3D automatic meshing capability is through example problems. You are recommended to practice the walk-through example problems presented in Chapter 5. You will notice that most of the effort in 3D automatic mesh generation is in building the geometry of the model.

The tips presented below are quite general and they do not refer to any specific example. They are not in any sense complete. Refer to the Diagnosis of Solid Automatic Meshing Problems section at the end of this chapter for useful suggestions.

- The 3D solid or hollow volume must be completely enclosed by regions or surfaces or a combination of these entities. Cut-outs, holes and openings are permitted in the POLYHEDRON or PART entities. The regions/surfaces that form a polyhedron must represent the entire skin of the solid.
- Regions are preferred over surfaces in defining polyhedra because mesh control and compatibility work better with regions. The RGSF command creates regions from surfaces (Geometry, Regions, Convert Sf to Rg).
- Care must be taken to see that there are no internal or common boundaries or partitions when defining polyhedra and parts. However, if you are required to have internal boundaries or partitions as shown in Figure 3-22 (for models with different material properties, etc.), then you should create multiple polyhedra and parts.
GEOSTAR provides a convenient way to place parts of your model in a selection list. This is done by using the commands of the SELECT submenu and CONTROL main menu and STATUS3 button. For example, you can first place surfaces and regions describing one of the cubes in the figure above (including the common boundary surface or region) in the selection list, and proceed to defining polyhedra and parts. Next, place the surfaces and regions of the remaining cube (including the common boundary surface or region) in the selection list and proceed to defining polyhedra and parts. Use the meshing commands to automatically generate the mesh of both cubes simultaneously.

- It is recommended not to use four curves to define a circular surface as part of your polyhedron for subsequent use in 3D automatic meshing. The circular surface should be defined as either four different surfaces or as a region entity. See illustration in Figure 3-23.
- The average element size is specified when you define a polyhedron. This input overrides the average element size specified during contour definition. You can therefore specify any value for average element size or mesh density during contouring.
- When specifying the average element size, you must exercise caution. It should not be too large when compared to the smallest dimension of the model. If it is more than several orders of magnitude of the smallest model dimension, the program may warn you of this condition and use the default average element size. This default element size will be in the vicinity of the smallest model dimension.
You don't have to apply the same element size value for all parts in order to maintain node compatibility. If you use different element sizes for two parts, the mesh size of the common region follows the firstborn meshed part. Compatibility is not achieved if the two parts have a common surface (not a region). However, you can change a surface into a region. The polyhedra and parts are automatically upgraded to consider this region-to-surface transformation.

The Curve Elem Size, Contour Elem Size, Region Elem Size and Polyhedron Elem Size commands in the Meshing > MESH DENSITY can be used to control the mesh density by specifying density of the polyhedron associated curves.

If you are using TETRA10 elements in your mesh, the mid-nodes of these elements may sometimes appear to be misplaced. This is due to the fact that element plots are drawn by connecting the corner nodes of the elements and they may not include the mid-side nodes. To plot these edges correctly, choose Bilinear in the element plot order entry in the SETE PLOT command (Meshing, Elements, Set Element Plot).

Where possible, use the symmetry features, i.e., construct the geometry and generate the mesh for a quarter or half of the model and then you can duplicate both geometry and mesh for the remaining parts of the model.

For faster and better quality of plotting when using SHADE and HIDDEN (Display > DISPLAY OPTIONS > Shaded Element Plot and Hidden Element Plot) commands, you are recommended to use boundary face evaluation flag in the BOUNDARY (Display > DISPLAY OPTION > Set Bound Plot) command. This feature stores the face numbers of tetrahedral elements associated with a boundary and uses it for element plots. For three dimensional elements that are not created out of geometry you can use the Display > PLOT > DISPLAY
OPT > Eval Element Bound to check all elements and identify the boundary faces similar to “finding the boundary faces associated with geometric entities” flag in the BOUNDARY command.

- The Meshing > ELEMENTS > Element Order command may be used to convert 4-node to 10-node tetrahedral elements.

**Carrying Mesh with Geometry**

It is preferable to operate on elements associated with geometric entities. For example if the geometry exists and meshed for a portion of the model, the rest of the mesh can be generated, in case of symmetry, by operating on elements using command like GENERATE. While the mesh will be correctly generated, the new nodes and elements will not be associated with any geometric entities and all the advantages of the geometry association are lost. A better way is to activate the default meshing flag for the particular entity and use for example SFSYM (Geometry > SURFACES > GENERATION MENU > Symmetry) instead of ELSYM (Meshing > ELEMENTS > GENERATION MENU > Symmetry). Default meshing is easily controlled by the Control > ACTIVATE > Default Meshing or Status1 button. When the new elements are generated, GEOSTAR provides several options to handle their attributes. The New Prop Set command in the Propsets menu provides three options to:

- Use active attributes for all new elements,
- Use the source element attributes, or
- Add given offsets to source attributes.

Furthermore, the user can create two-dimensional and three-dimensional meshes by extruding, sweeping, gliding or dragging already meshed curves, surfaces or regions.

**Local Mesh Control**

The user can specify different element sizes to different portions of the model while ensuring compatibility of the mesh. Local mesh control is generally required for two purposes:

- To use small-size elements for portions of the model where details of the geometry have to be captured while relatively larger elements are utilized elsewhere.
- To use finer mesh at important parts of the model (from results point of view) while allowing coarser mesh at less important parts.
Chapter 3   Exploring GEOSTAR

The following commands in the Meshing > MESH DENSITY submenu control mesh densities:

- **Curve Elem Size**  
  Specifies mesh density for a pattern of curves.

- **Contour Elem Size**  
  Specifies mesh density for all curves associated with a pattern of contours.

- **Region Elem Size**  
  Specifies mesh density for all curves associated with a pattern of regions.

- **Polyhedron Elem Size**  
  Specifies mesh density for all curves associated with a pattern of polyhedra.

It should be mentioned that the above commands work with regions and not surfaces. However, GEOSTAR provides the capability to change surfaces to regions where each new region will be underlined by the corresponding surface. Once this change is made, all density specifications will work as if regions were originally defined.

To achieve a complete control over the mesh density, the following hints can be of great help to the user:

- It is a good practice to build the model's geometry so that a compatible mesh is easy to produce. Make sure that neighboring geometric entities share common lower-order entities. For instance, adjacent surfaces should share common curves while adjacent volumes share common surfaces.

- When a surface is non-uniformly meshed, by specifying the number of elements along each side, users have to make sure that common edges of adjacent surfaces have the same element size. It should be mentioned that the **Curve Elem Size** command does not affect surface meshing.

- Element size for regions are specified when the region's contours are defined. If a contour share common curves, the user has the option to:
  - create a compatible mesh where the number of elements over the common curve is controlled by:
    - the number of elements specified by the previously defined contours,
    - the higher number of elements, or
    - the lower number of elements.
  - generate an incompatible mesh where each contour has a different element size at the common curve.

- Before meshing a region, local mesh density commands override the previously specified element sizes along the region's curves.
Before meshing a polyhedron or a part, local mesh density commands override any previously specified element sizes along the polyhedron's curves.

The common region of two polyhedra or parts assumes the element size of the first mesh unless an element size is forced by the local mesh density commands.

**Adaptive Meshing for Linear Static Problems**

The general approach for development of the finite element method is primarily based on the control of discretization error by uniform or nearly uniform refinement of the finite element mesh. The adaptive mesh technique (targeting reduction of discretization error at automatically selected parts of the mesh) is currently receiving a great deal of attention. The use of polynomials of progressively increasing degree on a fixed finite element mesh is starting to challenge the uniform or nearly uniform refinement.

In order to distinguish between the method of reducing errors of discretization by mesh refinement and the increase of polynomial degree, different labels are assigned for each approach. The H-version of the finite element method refers to a convergence based on progressive reduction of the element size (usually referred to in literature as $h$) and hence the name H-version. On the other hand, the P-version of finite element method is called after the symbol ($p$) usually used to designate the polynomial degree. The general approach of a combined procedure is called HP-version.

In COSMOS/M, an automated approach is available for the three methods. The decision of mesh improvement at automatically selected portions of the model relies on an error estimate. The following elements are available for each method:

<table>
<thead>
<tr>
<th>Adaptive Method</th>
<th>Elements (Linear Static)</th>
</tr>
</thead>
<tbody>
<tr>
<td>H-version</td>
<td>3- and 6-node TRIANG, SHELL3, SHELL3T, TETRA4, TETRA4R, TETRA10</td>
</tr>
<tr>
<td>P-version</td>
<td>6-node TRIANG, 8-node PLANE2D, TETRA10</td>
</tr>
<tr>
<td>HP-version</td>
<td>6-node TRIANG, TETRA10</td>
</tr>
</tbody>
</table>

It should be mentioned however, that the user may also elect to increase the p-order of the whole mesh by a specified value. In this case the mesh is not controlled by an automatic error estimate. In this case one more element can be used in addition to the 6-node TRIANG, 8-node PLANE2D and TETRA10. This element is the 9-node SHELL9L.
Chapter 3   Exploring GEOSTAR

More information about this utility is included in the on-line help and the Command Reference Manual. Examples are included in the Basic System Manual.

**Mesh Refinement**

Mesh refinement is available for triangular and tetrahedral-shaped elements. Two approaches are available:

1. User-controlled process based on user judgment with the help of the GEOSTAR's displayed results including the stress error. Two commands can be used:
   a. Meshing > ELEMENTS > **Refine Mesh** for initial refinement where elements are selected by the user (3-node TRIANG, SHELL3, SHELL3T, SHELL3L, TETRA4, TETRA4R). The refinement procedure automatically takes care of the element attributes (element group, real constants, material properties and element coordinate system).
   b. Meshing > ELEMENTS > **Smoothen Mesh** to smoothen the refined mesh without changing the location of nodes on the boundaries between portions of the model that have different element attributes.

2. Automatic refinement using the H-method option of the Analysis > STATIC > **Adaptive Method** as discussed before (3- and 6-node TRIANG, SHELL3, SHELL3T, TETRA4, TETRA4R, TETRA10). It should be mentioned however that this approach can only be used for linear static analysis.

**Bonding Incompatible Meshes**

It is a good practice to produce compatible meshes for all models. In some situations, however, various parts of the model may be meshed separately. Instead of remeshing all portions of the model to produce a compatible mesh, which could be a time-consuming process, COSMOS/M provides the user with a utility to glue differently meshed interfaces together. The utility can be currently used in linear and nonlinear static structural analysis.

The Basic System Manual provides details and examples on the BOND feature.

**Automatic Generation of Contact Lines and Surfaces**

The Analysis > NONLINEAR > CONTACT > **Contact Surface by Geometry** command can be used for the automatic generation of contact lines and surfaces
used in conjunction with contact problems in NSTAR. The one-node contact elements are also generated automatically on the positive side of contact surfaces or lines. The Command Reference and the Advanced Modules Manuals include more information.

Mesh Information

After completing the mesh procedure of the whole model or even part of it, you can use the following commands found in Control > MEASURE submenu to request information about the mesh elements and nodes:

- **Calculate Distance**: Calculates and lists the distance between two nodes or a keypoint and a node.
- **Calculate Angle**: Calculates and lists the angle between three nodes.
- **Calculate Area**: Calculates and lists the area defined by four nodes. For triangular areas one node has to be repeated.
- **Find Mass Property**: Lists length, area or volume of elements along with mass, center of gravity, moments of inertia and radii of gyration. The command also provides principal moments of inertia and corresponding principal directions with respect to an arbitrary reference Cartesian coordinate system.

Refer to the *Diagnosis of Solid Automatic Meshing Problems* section at the end of this chapter for recommendations on solving meshing problems.

Applying Loads and Boundary Conditions

Load is a generalized term that refers to force, pressure, moment, temperature, base motion and many other types. Boundary condition is also a generalized term that refers to specifying certain values to quantities like displacements, temperature, radiation, etc. to certain locations on the boundary of the model. Loads in GEOSTAR can be applied to nodes/elements directly or through the association with geometric entities, which accelerates significantly the preprocessing stage. GEOSTAR assigns different symbols and colors to graphically display loads and boundary conditions on the finite element model. Loads and boundary conditions must be applied after meshing. If a the mesh is deleted, the specified loads and boundary conditions are deleted as well.
Chapter 3 Exploring GEOSTAR

The types of available loads and boundary conditions depend on the type of analysis. Different types of boundary conditions and loads are available for structural, heat transfer, fluid flow, and electromagnetic problems. For example, you can apply gravity, centrifugal loads and base motion for structural problems. You can also couple degrees of freedom, define point-to-point, point-to-curve, and point-to-surface constraints as well as introduce constraint equations for degrees of freedom. The bonding feature lets you connect non-compatible separately meshed components of the same model.

You can associate the model's loads and boundary conditions with time/temperature curves. For dynamic analysis and nonlinear static analysis with time-dependent material properties (e.g. creep), “time” represents the real time associated with the load application. For other nonlinear applications the “time” value represents a pseudo-variable which refers to the intensity of the applied load or the prescribed boundary condition at a certain “step”. In post-dynamic analysis (ASTAR) you can define frequency curves for harmonic, random and spectral analyses as shown in Tables 3-6 and 3-7. For HSTAR, some loads and boundary conditions can be associated with temperature curves.

Commands in the LoadsBC, Structural, Coupling menu can be used to couple temperatures for thermal analysis.
Table 3-6. Curves Associated with Loads and Boundary Conditions

<table>
<thead>
<tr>
<th>Entities</th>
<th>Module</th>
<th>Curve Axes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Curve</td>
<td>NSTAR</td>
<td>Y-Label* Force, pressure, prescribed displacement, temperature</td>
</tr>
<tr>
<td>Time Curve</td>
<td>HSTAR</td>
<td>Y-Label* Temperature, nodal and element heat, heat flux, convection, radiation, heat flow, etc.</td>
</tr>
<tr>
<td>Time Curve</td>
<td>FLOWSTAR</td>
<td>Y-Label* Pressure, element heat, heat flux, convection, radiation, turbulence kinetic energy, dissipation rate</td>
</tr>
<tr>
<td>Time Curve</td>
<td>ESTAR</td>
<td>Y-Label* Nodal potential, nodal current, electric current or charge density</td>
</tr>
<tr>
<td>Post Dynamic Curve</td>
<td>Time (modal time history)</td>
<td>ASTAR</td>
</tr>
<tr>
<td>Post Dynamic Curve</td>
<td>Frequency (harmonic, random and spectral analysis)</td>
<td>ASTAR</td>
</tr>
<tr>
<td>Fatigue S-N</td>
<td>FSTAR</td>
<td>Y-Label* No. of cycles Alternating stress</td>
</tr>
<tr>
<td>Fatigue S-T</td>
<td>FSTAR</td>
<td>Y-Label* Temperature Design stress</td>
</tr>
<tr>
<td>Temperature Curve</td>
<td>HSTAR</td>
<td>Y-Label* Temperature Nodal heat generation rate, element heat generation rate, element heat convection, radiation</td>
</tr>
</tbody>
</table>

Table 3-7. Association of Loads and Boundary Conditions with Time, Temperature, and Frequency Curve. FLOWSTAR is a discontinued product.

<table>
<thead>
<tr>
<th>Loads and Boundary Conditions</th>
<th>STAR</th>
<th>DSTAR</th>
<th>ASTAR</th>
<th>NSTAR</th>
<th>HSTAR</th>
<th>FLOWSTAR</th>
<th>FLOW-PLUS</th>
<th>ESTAR</th>
<th>OPT-STAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displacement (D)</td>
<td>•</td>
<td>•</td>
<td>• TF</td>
<td>• T</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• T</td>
</tr>
<tr>
<td>Force (F)</td>
<td>•</td>
<td>•</td>
<td>• TF</td>
<td>• T</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• T</td>
</tr>
<tr>
<td>Pressure (P)</td>
<td>•</td>
<td>•</td>
<td>• TF</td>
<td>• T</td>
<td>• T</td>
<td></td>
<td></td>
<td></td>
<td>• T</td>
</tr>
<tr>
<td>Reaction Forces</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Nodal Temperature (NT)</td>
<td>•</td>
<td>•</td>
<td>• T</td>
<td>• T</td>
<td>• T</td>
<td></td>
<td></td>
<td></td>
<td>• T</td>
</tr>
<tr>
<td>Nodal Heat Generation (Q)</td>
<td></td>
<td></td>
<td>• TP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• TP</td>
</tr>
</tbody>
</table>
Chapter 3 Exploring GEOSTAR

| Element Heat Generation Rate (QE) | • TP | • T | •TP |
| Heat Flux (HX) | • T | • T | •T |
| Element Heat Convection (CE) | • TP | • T | •TP |
| Radiation (RE) | • TP | | •TP |
| Velocity (V) | • TF | • | •T | • |
| Turbulence Kinetic Energy (TKE) | | | • |
| Dissipation Rate (EPS) | | | • |
| Nodal Pressure (NPR) | | | • |
| Density (DNS) | | | • |
| Nodal Magnetic Potential (NP) | • | • T |
| Nodal Current (NJ) | • T |
| Electric Current (JE) | • T |
| Euler Boundary Condition (BND) | | • |
| Acceleration | • TF | • T | |

- applicable to the analysis module
- (T) can be associated with time curve
- (F) can be associated with frequency curve
- (P) can be associated with temperature curve

FLOWSTAR is a discontinued product.

Applying Loads Resulting from a Different Analysis Module

You can consider the interaction between different analysis modules in COSMOS/M as shown in Figure 3-24. The results of Heat Transfer, Fluid Flow and Electromagnetic programs can be transmitted into loads for the basic system and the nonlinear structural analysis module.

For instance, you can perform steady-state thermal analysis and use its output as input to linear stress analysis (STAR). Results of transient heat transfer analysis can be read automatically into NSTAR for the different time steps. One of the applications in which this interaction may be particularly useful is pressure vessels (Thermal-Stress analysis). You can also use temperature results of an HSTAR problem as initial temperature to another problem.
The steady state results of ESTAR can be used by STAR and NSTAR. For NSTAR, you have to associate these loads with time curve(s). The commands used are shown in Figure 3-24 and Table 3-8.

**Figure 3-24. Analysis Modules Interaction Diagram**

**Table 3-8. Commands for Analysis Modules Interaction**

<table>
<thead>
<tr>
<th>Prepare Results From</th>
<th>Prepare Results To</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSTAR</td>
<td>STAR</td>
<td>Steady state and transient heat transfer analysis.</td>
</tr>
<tr>
<td>HSTAR</td>
<td>NSTAR</td>
<td>Transient heat transfer analysis. (Steady state results cannot be used in association with time curve(s).)</td>
</tr>
<tr>
<td>HSTAR</td>
<td>HSTAR</td>
<td>Converts the output of a steady state or transient heat transfer analysis of one run to initial temperature conditions of another run of the same problem.</td>
</tr>
</tbody>
</table>
| ESTAR                | ESTAR* NSTAR       | • Steady state electromagnetic problems.  
                        |   • Steady state electromagnetic problems in association with time curve(s). |
| ESTAR                | HSTAR              | Thermo-electric coupling. |
Multiple Load Cases in Linear Static Analysis

It is required in many cases to calculate the response of structures to several loading conditions. The stiffness matrix for linear problems is constant while the load vector varies from one loading condition to another. If loading conditions were to be treated as different problems, then most of the solution steps would be identical including the stiffness matrix calculation and decomposition. Therefore, calculate and decompose the stiffness matrix once and use the generated information to calculate results under the different loading environments.

A loading condition in GEOSTAR is referred to as a load case. By default load case number (1) is active and all defined loading will be associated with load case (1). Other load cases may be activated. All loading conditions are associated with the active load case and will not affect other load cases. A load case defined through this procedure, is referred to as a primary load case. Up to 50 primary load cases can be defined. The utility is supported by STAR and COSMOS/FFE Static.

The principle of superposition states that the response of a linear structure to a loading condition defined by scaling and combining two other loading conditions may be obtained by scaling and combining the results of the two loading conditions in the same way. In GEOSTAR, the user can create a new load case and calculate its results by scaling and combining other load cases. Load cases defined this way are referred to as secondary load cases. Up to 50 secondary load cases can be defined.

While loading varies from one primary load case to another, boundary conditions are kept constant. It is possible however to combine load cases with different boundary conditions using the following procedure:

- Define one or more load cases with a set of boundary conditions.
- Use the Run Static Analysis command to solve.
- Define a new set of boundary conditions.
- Define new load cases.
- Deactivate the previously solved load cases.
- Use the Run Static Analysis command to solve for the new load cases.
- Combine results from the two sets.

In using multiple load cases, note the following:

- If “GAP” elements exist in the model, secondary load cases may be meaningless in most cases.
If inplane loading effects are considered, results are calculated for the active load case only.

If buckling or nonlinear analyses is performed on a database with multiple load cases, only the active case is considered.

The results of secondary load cases are not written to the output file, but you may list and plot the results as usual.

Gravity, centrifugal, and thermal loading are referred to as special loading in GEOSTAR and are only considered if the special loading flag is activated for linear static analysis and nonlinear structural analysis. Special loads are also associated with the active load case while they are defined and may be combined with other mechanical loads.

**Analysis Options**

After preparing all the input data and before submitting the finite element model for analysis, you can check and review the input data for possible errors. Three commands are available in COSMOS/M for such tasks:

Meshing > ELEMENTS > **Check Element**

to check the aspect ratios of elements and delete degenerate elements from the database.

Analysis > **Data Check** to check the existence of:

- an element group,
- a material property set, and
- a real constant set for each element in the database.

Analysis > **Run Check** for a thorough check, performing the function of **Data Check** command in addition to checking the following:

- element coordinate systems,
- non-existing nodes for element definition,
- element distortion (large aspect ratio, highly skewed and warped elements), and
- other features depending on the type of analysis.

Another command, ON by default, is the Analysis > **Re-Number** command which automatically resequences the node numbering to minimize the bandwidth and profile for computational efficiency when using the skyline solver. This is an internal process is entirely internal and does not affect pre- or postprocessing.
Chapter 3   Exploring GEOSTAR

The analysis is carried out by one of the analysis commands shown in Table 3-9. Each program performs operations, depending on the type of analysis, such as generating element shape functions, coordinate transformations, assembling element stiffness matrices, applying boundary conditions and performing solution procedures. However, before starting analysis, you may need to specify some of the parameters related to the analysis and to control the output results of the solution process. Special features can also be chosen prior to executing the analysis command such as activating load cases, adding effect of damping, asking for automatic time stepping, choosing the type of solver, specifying the used formulation, etc.

One important feature of the analysis procedures in COSMOS/M is the ability of the program to continue the solution from the last successful time step for nonlinear structural and transient analyses using the Analysis > Restart command. For the FLOWPLUS module, the restarting command is Analysis > FLUID MECHANICS > Restart Options.

Table 3-9. Types of Analyses in COSMOS/M

<table>
<thead>
<tr>
<th>Type of Analysis</th>
<th>Module</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear static analysis</td>
<td>STAR</td>
<td>Run Static Analysis</td>
</tr>
<tr>
<td>Stress calculations for linear static</td>
<td>STAR</td>
<td>Run Stress Analysis</td>
</tr>
<tr>
<td>Natural frequencies and mode shape calculations</td>
<td>DSTAR</td>
<td>Run Frequency</td>
</tr>
<tr>
<td>Linearized buckling analysis</td>
<td>DSTAR</td>
<td>Run Buckling</td>
</tr>
<tr>
<td>Linear dynamic analysis</td>
<td>ASTAR</td>
<td>Run Post Dynamic</td>
</tr>
<tr>
<td>Nonlinear static and dynamic structural analysis</td>
<td>NSTAR</td>
<td>Run Nonl Analysis</td>
</tr>
<tr>
<td>Linear and nonlinear heat transfer analysis</td>
<td>HSTAR</td>
<td>Run Thermal Analysis</td>
</tr>
<tr>
<td>Fluid flow analysis</td>
<td>FLOWSTAR, FLOWPLUS</td>
<td>Run Flow Analysis</td>
</tr>
<tr>
<td>Linear and nonlinear electromagnetic analysis</td>
<td>ESTAR</td>
<td>Run Emag Analysis</td>
</tr>
<tr>
<td>Fatigue analysis</td>
<td>FSTAR</td>
<td>Run Fatigue Analysis</td>
</tr>
<tr>
<td>Optimization</td>
<td>OPTSTAR</td>
<td>Run Optimization</td>
</tr>
</tbody>
</table>

Notes On Solvers

The finite element method leads to a system of equations that must be solved simultaneously. A complex model can generate a very large system of equations.
Each equation represents an unknown quantity that we seek to solve for. Each unknown quantity is also referred to as a degree of freedom (DOF). For example, when solving a static problem, displacements at the nodes are the primary unknowns. Traditionally, solving a large system of simultaneous equations requires a long time and large computer resources.

Structural Research gives utmost attention to providing its software users with the cutting edge solver technology in terms of speed and the use of computer resources.

Solvers can be broadly classified into two main categories: direct and iterative. Direct solvers are exact but are generally slower than iterative solvers and require more memory. Their efficiency increases in comparison with iterative solvers as you solve stress analysis with more load cases. Iterative solvers are based on trial and error. They produce a solution when errors get smaller than a specified tolerance.

### Direct Skyline Solver

This solver is the oldest solver in COSMOS/M. It is based on factorization of the stiffness matrix and uses Gauss elimination to rearrange the equations. This solver is generally inefficient for large problems.

### Direct Sparse Solver

The direct solver exploits new advanced sparse matrix technology and re-ordering techniques to save time and computer resources. On the average, the new solver is about 15 times faster and it uses about 1/3 of the memory required by the traditional solvers. The savings can be much higher for large problems and shell problems. The new direct sparse solver is particularly useful where iterative methods take longer time to converge.

Assembly problems containing parts made of materials with widely different material properties can produce ill-conditioned matrices. Ill-conditioned matrices can also result from gap/contact problems, especially when friction is considered. The efficiency of iterative methods reduces considerably with ill-conditioned matrices. The new Direct Sparse solver is recommended in such cases.
Iterative (PCG) Solver

The iterative solver is included as an alternative to the FFE solver provided with earlier versions of COSMOS/M. The new iterative (PCG) solver exploits new technology to save time and computer resources for very large problems (problems with over 200,000 DOF).

The major advantage of the new iterative (PCG) solver is that it works with all elements and element options. For example, FFE solvers do not support composite elements like SHELL3L, SHELL4L, SOLIDL, and many other elements and element group’s options. The new iterative (PCG) solver supports all elements and element group’s options.

The new iterative (PCG) solver cannot be used to run static analysis problems that include sub-structuring, sub-modeling, or the in-plane effect option.

Choosing a Solver

Generally you can use any of the available solvers for a particular type of analysis. Different solvers should give similar results for the same problem. The following information summarizes the solver options for different types of analyses.

Static Problems

There are 4 solvers for static problems. These solvers are:
Chapter 3   Exploring GEOSTAR

- The direct solver based on the skyline techniques.
- Sparse: direct sparse solver based on sparse matrix technology and advanced re-ordering techniques.
- The FFE solver.
- The iterative (PCG) solver. Also referred to as the FFEPlus solver.

The **PCG_OPTIONS** command (Analysis > Static > PCG_Options) allows you to set the proper options to run a problem using the PCG solver.

Use the **A_FFESTATIC** command (Analysis > Static > FFE Static Options) prior to running static analysis to select the FFE solver. The other options are selected by the **A_STATIC** (Analysis > Static > Static Analysis Options) command.

**Guidelines on selecting a static analysis solver:**

Here are some guidelines on selecting the appropriate solver:

- Use the Iterative (PCG) solver for large problems (200,000 DOF or more). See the online help for the **PCG_OPTIONS** command.
- Use the FFE solver or the Direct Sparse solver for small and medium problems (problems with up to 200,000 DOF).
- If your model has elements or options not supported by the FFE solver, use the iterative (PCG or FFEPlus) solver or the Direct Sparse solver.
- Use the Skyline solver for submodeling and substructuring.
- Use the Direct Sparse solver for problems with contact, especially when you turn on the friction effects. However, if the problem is too large, you may have to use the Iterative PCG solver.
• Use the Direct Sparse solver when solving problems with widely varying material properties.

Frequency Problems

There are 3 solvers for frequency problems. These solvers are:
• Mode extraction powered by the skyline direct solver.
• The FFE solver.
• Mode extraction powered by the new sparse direct solver based on sparse matrix technology and advanced re-ordering techniques.

Use the **A_FFEFREQ** command (Analysis > Frequency/Buckling > FFE Frequency Options) prior to running frequency analysis to select the FFE solver. The other options are selected by the **A_FREQUENCY** command (Analysis > Frequency/Buckling > Frequency Analysis Options).

**Guidelines on selecting a frequency analysis solver:**

Here are some guidelines on selecting the appropriate solver:
• Choose any of the 3 solvers for small problems.
• Choose the Direct Sparse solver or the FFE solver for medium problems (problems with 100,000 to 200,000 DOF).
• Use the FFE solver for large problems (over 200,000 DOF) or when your model is not adequately restrained (rigid body modes).
• Use the Direct Sparse solver if you want to consider the effect of loading on the natural frequencies.
• Use the Direct Sparse solver when solving problems with widely varying material properties.

**Buckling Problems**

There are 3 solvers available for extracting buckling load factors:
- The Direct Sparse solver.
- The Direct Skyline solver.
- The iterative (PCG) solver. Also refereed to as the FFEPlus solver.

Use the `A_BUCKLING` command (Analysis > Frequency/Buckling > Buckling Analysis Options) to select the desired solver.

**Guidelines on selecting a buckling analysis solver:**

Here are some guidelines on selecting the appropriate solver:
- Choose any of the three solvers for small problems.
- Choose the PCG (FFEPlus) solver or the Direct Sparse solver for large problems.
- No FFE solver is available for buckling analysis.

**Thermal Problems**

There are 4 solvers for thermal problems. These solvers are:
- The Skyline direct solver based on the skyline techniques.
- The direct sparse solver based on sparse matrix technology and advanced re-ordering techniques.
- The iterative (PCG) solver. Also refereed to as the FFEPlus solver.
Chapter 3   Exploring GEOSTAR

- The FFE solver.

Use the **A_FFETHERMAL** command (Analysis > Heat Transfer > FFE Thermal Options) prior to running thermal analysis to select the FFE solver. The other options are selected by the **A_THERMAL** command (Analysis > Heat Transfer > Thermal Analysis Options).

**Guidelines on selecting a thermal analysis solver:**

Thermal problems have one DOF per node and hence their solution is usually much faster than structural problems of the same number of nodes. Here are some guidelines on selecting the appropriate solver:

- Since the FFE solver does not support some of the elements and/or options that HSTAR supports, it is recommended to use HSTAR most of the time. However, if you use FFE for an element/option that is not supported, you will get a message.
- Use the Direct Sparse solver when solving assemblies of parts with widely different thermal properties.
- Use the PCG solver for large problems.

**Postprocessing**

The results obtained by the numerical solution are used to test whether the finite element mesh is acceptable or changes are necessary. Postprocessing refers to the graphical manipulation and display of results after successfully completing the analysis. This step of the finite element application makes the analysis, interpretation and evaluation of the analysis results extremely simple. It should be noted, however, that the postprocessing phase is only a tool to review the analysis output; it is your engineering sense and experience that will help interpret the results and evaluate how appropriate your mesh is. The adaptive techniques of COSMOS/M provide an automatic procedure for such evaluation during the engineering decision-making process.

GEOSTAR provides an efficient graphical environment for quick interpretation and understanding of the analysis results. The postprocessing tools in GEOSTAR can be categorized as follows:
Chapter 3   Exploring GEOSTAR

- Reading results from output files.
- Listing results in text format on the screen including manipulated database information. Manipulation of results involves performing operations such as sorting, scaling, averaging, searching for extreme values, combining results of different load cases, etc.
- Displaying results in graphical format on the screen. This includes color-filled plots, colored lines and vector plots, as well as X-Y type graphs. The user may select one of predefined color sets or define his/her own color sets as explained in Appendix A. A graph is generated by first activating the desired data and then plotting it. The user can animate results from all analyses types.
- Producing hard copies of the output file, text listed on the screen and images.
- Manipulating results using COSMOS/M command language including the macro file feature as explained in Appendix E.

In this section, most of the postprocessing features and commands are outlined. Although the last performed analysis type is by default active, it is always good practice to start the postprocessing phase by setting the type of analysis using the ACTPOST (Results > SET UP > Set Postprocess Type) button command. Use the RESULTS? (Results > Available Results) command to list all the load cases (for linear static analysis) and time steps (for nonlinear static and transient analyses) for which results are available for postprocessing. The user can also identify the value of the plotted quantity at the node (or element) as picked by the mouse.

The Results Files

The analysis-related information of different modules is written in the following ASCII output files:
- ufn.TEM for thermal analysis
- ufn.OUT for other modules

where (ufn) is the user furnished name of the problem. The output file could be very large and it is recommended that users control the amount of information that goes to the file by properly setting the print out options.

The output files can be viewed and edited similarly to any other text.
Combining Load Cases and Static/Dynamic Results

In linear static problems you can define up to 50 primary load cases where results are obtained by solving the equilibrium equations. You can combine some or all of these load cases (in the postprocessing phase) by performing arithmetic operations among the results data and store the outcome in secondary load cases. Moreover, you can, with the same command, combine secondary load cases.

In addition, you can read displacements and stresses for a particular time or frequency step of linear dynamic analysis (ASTAR) and store it as a secondary load case. Accordingly, you can combine both static and vibrational results.

Averaging Stress Results

In displacement-based finite element formulation, stress continuity at nodes is not achieved and you may need to average the stress components at nodes shared by different elements. However, it may also be desired to find von Mises stress, principal stresses, and stress intensity which are all dependent on these stress components. The question then arises of whether to average the stress components and then find the principal stress, for example, or to find the principal stresses first based on the original stress components (without averaging) and then average the principal stresses themselves at the same node but from different elements. The AVERAGE (Results > Average Nodal Stress) command gives you the flexibility to go either way for principal stresses, von Mises stress and stress intensity.

Listing Output Results and Extreme Values

Tabulating results is a powerful and effective way to check and document the analysis output information. The COSMOS/M “LIST” (Results > List) type commands provide the user with a wide range of options to list the results for all nodes and elements or selected sets of them. Displacements can be listed in different coordinate systems. The available results quantities to be listed are given in Table 3-10. Moreover, the user can list the extreme values of selected results within a user-defined range using the “MAX” (Results > Extremes) type commands. In addition, results can be sorted according to the sequence of nodes and elements numbering or according to the results themselves. The user can also define the criterion of extreme according to the algebraic maximum, algebraic minimum or maximum absolute (but returning with the original sign).
### Table 3-10. Listing Results and Their Extreme Values

<table>
<thead>
<tr>
<th>Type of Problem</th>
<th>Output Results All Components</th>
<th>Extreme Value of Results Selected Items Only</th>
</tr>
</thead>
</table>
| Structural Analysis | Displacements/rotations (you can transform results to a different coordinate system) | • Components of displacement/rotation, velocity, acceleration and angular velocity and acceleration.  
• Reaction forces and moments.  
• Resultant displacement velocity, acceleration, and reaction forces and moments. |
|                  | Strains                        | Strain components, equivalent strain, strain energy density, total strain energy |
|                  | Stresses                       | Stress components, von Mises, stress intensity, stress error, interlaminar shear, failure index |
|                  | Axial and shear forces, torsional and bending moments for beam elements at selected locations (linear static analysis) | Axial and shear forces, torsional and bending moments along the full length of beam elements (linear static analysis) |
|                  | Nodal forces, moments and stresses for beam elements (linear static analysis) | Nodal forces, moments and stresses for beam elements (linear static analysis) |
|                  | Gap forces for gap elements in nonlinear analysis | — |
|                  | Natural frequencies (frequency and buckling analyses) | — |
| Thermal Analysis | Nodal temperature, temperature gradient, heat flux | Nodal temperature, temperature gradient, heat flux |
| Fluid Flow Analysis | Velocity, pressure, temperature) or (turbulence kinetic energy, dissipation rate, shear stresses) or (density, mach number) or (temperature gradients),... | Velocity components, stream function, pressure, shear stresses, temperature, temperature gradients, turbulence kinetic energy, dissipation rate, density, mach number,.... |
|                  | Heat flow, heat transfer coefficient, Mass flow rate,... | — |
| Electromagnetic Analysis | Magnetic flux densities, or magnetic field intensities, electric field intensities for elements, or magnetic force for nodes, or average forces for nodes, or electric current densities for elements, or electric field intensities for nodes or electric current densities for nodes,.... | Magnetic flux components, magnetic field intensity components, magnetic force components, average force components, electrical field intensity components, current density components, voltage or nodal potential, power loss,.... |
| Fatigue Analysis | Accumulative fatigue usage factor | — |
Deformation and Force/Bending Moment Displays

The user can plot the deformed shape of structural models under the applied loads as shown in Table 3-11. For beam elements, the user can draw axial and shear force as well as torsional and bending moment diagrams for linear static analysis.

Table 3-11. Deformed Shape and Force/Moment Diagram Commands

<table>
<thead>
<tr>
<th>Function</th>
<th>Type of Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deformed shape</td>
<td>Linear Static</td>
</tr>
<tr>
<td>Forces-bending moments diagrams (beam elements)</td>
<td>Frequency and Buckling</td>
</tr>
<tr>
<td>Load case</td>
<td>Mode shape</td>
</tr>
<tr>
<td>Load case</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Contour and Vector Displays

The contour display shows the distribution of different results data over the model. The user has two options to use colored lines or color-filled areas for contour plotting. The vector display uses arrows to illustrate the magnitude and direction of vector quantities. The length of the arrow reflects the magnitude while the arrowhead shows the direction. It should be mentioned that non-vector quantities cannot be plotted with the vector display option.

In the contouring or vector display process, linear interpolation is used to determine points of equal values or points at which vectors are drawn. For element-to-element discontinuous results such as stresses, thermal fluxes, magnetic fluxes, etc., an averaging process is used at nodes.

Contour and Vector Displays of User's Data

In COSMOS/M, the user can generate the model's mesh, perform the analysis and visualize the results. Moreover, the mesh can be used with other finite element packages, as explained in Appendix D, or read from the database, using the database utility mentioned in Appendix C, for the user's own analysis program. The results can then be processed back in GEOSTAR using user's plot commands for contour and vector displays. It should be mentioned, however, that the mesh information has to exist in COSMOS/M database during the postprocessing phase.
Isosurfaces and Sectioning

You can produce isosurface contour displays in a similar sequence to the contour and vector displays as shown in Table 3-12. First, activate the type of results you wish to process, and use. In addition, you can take sections in three-dimensional plotted models to display color-filled contour graphs of different results data.

3-12. Commands for Isosurfaces

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTDIS, ACTSTN, ACTSTR, ACTTEMP, ACTFLOW, ACTMAG, ACTFTG</td>
<td>Activate the desired results.</td>
</tr>
<tr>
<td>SETPLOT</td>
<td>Controls features of the graph (optional).</td>
</tr>
<tr>
<td>ISOPLOT</td>
<td>Specifies the values and plots the isosurfaces.</td>
</tr>
</tbody>
</table>

Path-Specified Plots

It is sometimes of practical interest to trace the variation of the results along a user-defined path. In GEOSTAR, you can map results data onto an arbitrary path and view the results on an X-Y type graph. The X-axis reflects the normalized distance starting from the path's first node and the Y-axis refers to the variation of results. You first plot the results and then define the path. Up to 20 nodes can be used to specify an arbitrary path along which linear interpolation is used to calculate X-Y plot data.

Animation

In COSMOS/M, you can animate many results including nonlinear and transient responses. The ANIMATE (Results > PLOT > Animate) command allows displaying several frames in rapid succession to produce the animation effect. The user has the option to control the speed and the scale of animated pictures.

You can animate deformed and mode shapes by direct use of the ANIMATE command. For other results data, users have to first plot the required component then animate them.
Chapter 3 Exploring GEOSTAR

X-Y Type Graphs

It is always useful to display the analysis results in X-Y type graphs to visualize the effect of different modeling and analysis parameters on the response. For example, you might need to see the convergence rate of the adaptive analysis in linear static problems, or the load-deflection curve in nonlinear static analysis, or the variation of results with time for transient problems, etc. Included in Table 3-13 are the available labels of X- and Y-axes for different analysis problems.

<table>
<thead>
<tr>
<th>Analysis Module</th>
<th>X-Axis Label</th>
<th>Y-Axis Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAR (adaptive analysis)</td>
<td>Iteration number</td>
<td>Error, total strain energy, degrees of freedom, von Mises stress, max displacement.</td>
</tr>
<tr>
<td>ASTAR</td>
<td>Time or Frequency</td>
<td>Components and resultant of displacement, rotation, velocity, acceleration, angular velocity and acceleration, force, moment, stress.</td>
</tr>
<tr>
<td>NSTAR</td>
<td>Time or displacement</td>
<td>Components and resultant of displacement, rotation, velocity, acceleration, load factor.</td>
</tr>
<tr>
<td>HSTAR</td>
<td>Time</td>
<td>Nodal temperature, components and resultant of temperature gradient, components and resultant of heat flux.</td>
</tr>
<tr>
<td>ESTAR</td>
<td>Time</td>
<td>Components and resultant of magnetic flux, magnetic field intensity, magnetic force, average force, electrical field intensity, current density, voltage or nodal potential, power loss.</td>
</tr>
</tbody>
</table>

X-Y Type Graphs for User's Own Data

The user can plot his/her own created data in GEOSTAR by providing (in a user's prepared file) the number of points in the graph, number of graphs, titles, the independent variable (X-axis) and up to 6 dependent variables (Y-axis).

Viewing Different Plots on the Same Screen

You can view different combinations of the postprocessing plots as well as geometric entities, elements, etc., on the same screen. The user has the ability to either clear or keep the screen before producing new plots. This feature is particularly useful for producing documents and better presentation of different results and model views in the same figure.
Chapter 3 Exploring GEOSTAR

Display Options

This section includes the following display options:

- Creating window environment,
- Viewing transformation,
- Picture manipulation,
- Screen features, and
- Elements display.

Multi-Window Environment

The user can utilize the window capability, just like using GEOSTAR’s display area, to view all stages of building the finite element model during pre- and post-processing phases. Up to 4 windows can be created in the display area, resized, moved, pushed to the background, popped in front of another window, closed, opened and deleted.

View

To perform the viewing transformation, the program must be given not only an object but also a viewpoint. The `VIEW` command requests for the coordinates of such a point to construct with the origin of the coordinate system the view direction. Parameters of up to 10 views may be stored for later use with the displayed pictures. The active coordinate system can be displayed in the current view.

Display Control

There are many operations that users can perform on the displayed pictures during pre- and postprocessing. The displayed objects can be translated, rotated and scaled within GEOSTAR’s display area. A zoomin capability helps the user examine details of the model. In addition, pictures can be distorted and clipped within specified borders. Other picture manipulation features are also available.

Screen Features

Users can control some of the screen display features such as:
Chapter 3   Exploring GEOSTAR

- Screen's background color
- Clearing screen
- Replotting fresh screen with the active parameters
- Writing text to the screen
- Erasing part of the model

Elements Display

Like the work of an artist who draws with a pencil, three-dimensional elements can be plotted with the hidden lines removed to create the feeling of the 3D graphical object. By contrast, elements can be painted similar to pictures produced by painters who normally use brushes to paint in colors. Also, the user can shrink the size of the plotted element. The shrunk element may be useful for the user to check and visualize connectivity of different parts of the model.

General Control Features

This section presents some general utilities to control and facilitate pre- and postprocessing. Among these control features are:

- Giving a title to describe the problem,
- Dealing with a session file,
- Creating a neutral file format,
- Importing GEOSTAR input files,
- Copying the database,
- Symbol size control,
- Writing screen lists in a file,
- Multi-selection sets,
- Activating a set,
- The Status1 and Status2 buttons,
- Controlling colors of plotted entities, and
- Resetting default values.
This section does not cover every control utility available in GEOSTAR. Many other control features are discussed throughout the chapter where they will most help users to understand their intended functions.

Problem Title

The problem title, as opposed to the problem name, can be described in two lines for documentation purposes. The first one contains the title and the second contains both the subtitle and commands respectively. The two line description of the problem appears in the output file and on the screen during the analysis execution.

Session File

The session file (.SES) is an ASCII file to store all the action commands of GEOSTAR operations. The file contains the command history and can be used to regenerate the model or portions of it in case of lost or corrupted database using the FILE (File > Load) command. The stored commands in the file can be listed. The user can write notes, remarks, observations, etc. to the session file.

It should be mentioned that GEOSTAR's issued commands are temporarily saved in a buffer which takes up to three commands, which will be dumped into the session file when the buffer is full. The SAVE (File > Save Database) command can be used to update the session file even if the buffer includes only one command.

Geometric or Neutral File Format

Recreating a model from a session file goes through all intermediate steps including the mistakes that the user made and later corrected. The geometric or neutral file format (.GFM) is similar to the session file in the sense that it can be used to regenerate the model. However, all entities are written in a neutral format, the file is not chronological, and commands like deleting, undeleting, modifying, etc. are not represented in the file.

The file can save a lot of computer time in regenerating lengthy models in which extensive editing (deleting, modifying,... etc.) has been used. The user is encouraged to create this file as an additional security measure.
Chapter 3 Exploring GEOSTAR

Importing GEOSTAR Input Files

The FILE (File > Load) command can be used to read and process any file that contains a sequence of valid GEOSTAR commands. The commands in the file could have been generated by GEOSTAR or any other way; all that matters is that they should be valid GEOSTAR commands.

The utility is particularly useful if the user loses some database files or deletes them to save space. In this case a new problem can be created by using the FILE command button to read the session file (.SES) or the neutral file (.GFM). Another advantage of the FILE command button is to provide users with the flexibility to execute sequences of commands without having to input them on-line one-by-one. For example, the user can create his own material library as follows:

- Open a GEOSTAR problem,
- Use the Propsets > Material Property or the Pick Material Lib command to define all the material sets and material properties desired,
- Exit GEOSTAR and rename the generated session file (.SES) to another name like “mymtrl.lib”,
- Whenever you want to use these material properties in other problems, use the FILE command button to read-in the “mymtrl.lib” file.

Copying the Database Files

The database is automatically saved and updated while you work in GEOSTAR. Action commands operate directly on the related database to add, modify, or delete information. Listing and help commands will only read from the database to display the desired data. Sometimes it is necessary to copy all database files to a new problem name. The SAVE (File > Save Database) command can be used for this purpose, namely copying all the files related to the current problem name to a new name. In addition, the command updates the session file even if the buffer has one command in it. The following are some situations where the SAVE command is useful:

- The user is about to issue a major command and is not sure of its outcome. Use of the SAVE command will help users return to the old database if they need to.
- The user wants to compare two different problems which have many similarities.
It should be noted that copying a database might take a lot of disk space. The user is urged to check the available space before copying.

**Creating a New Problem**

The NEWPROB command closes the current problem and allows the user to start a new problem or switch over to an existing one without exiting GEOSTAR. If the specified name belongs to an existing problem, the user has the choice to open it as an old or new problem. If the user instructs GEOSTAR to open an existing problem as new, all database files will be lost but GEOSTAR will keep a copy of the old session file (.SES) in a file with the same name but extension (.BCK). This measure is taken just in case users need to regenerate the old model or in case they make a mistake by opening an existing problem as new.

In the Unix version, you can issue the NEWPROB command using File > New. In the Windows NT and Windows 95 versions, use File > New to start a new problem or File > Open to switch to an existing one.

**Symbol Size Control**

The user may choose to customize the size of the symbols used in GEOSTAR to plot loads and boundary conditions. This option controls the size of symbols for the following:

- Displacement boundary conditions
- Forces
- Pressure
- Velocity
- Reaction forces
- Coupling

In addition, the option controls the scale used to plot shear and bending moment diagrams for beam elements.
Writing Screen Lists to a File

It is convenient in many cases, for documentation and presentation purposes, to generate a file that contains the information listed by GEOSTAR on the screen during pre- and postprocessing. The LISTLOG command can be used in this regard as follows:

*Geo Panel:* Control > MISCELLANEOUS > List Log
  - List log flag > On
  - List display option flag > On
  - List file name [ufn.lis] > Anyname

Issue listing or help commands. Examples are: ELIST, STRLIST, help Active, etc. The information will be listed on the screen and written to the Anyname file which can then be printed or edited.

All list screens are now recorded in the Anyname file which can then be printed or edited.

It is recommended that the display option flag be deactivated when the LISTLOG command is issued through a file imported by the FILE (File > Load) command. Otherwise, users have to be on-line waiting to continue the screen list.

Selection Lists

The selection and unselection commands can be found in Control > SELECT and Control > UNSELECT menus. The selection feature in GEOSTAR presents a helpful utility to facilitate executing almost every step in pre- and postprocessing phases. Selecting only part of a large model may help the user apply loads and boundary conditions, review the analysis results, display different information, etc. Whenever a selection list is active for a particular entity, GEOSTAR will only process the members of this entity that are in the selection list and will ignore the remaining members. A number of convenient commands are provided for adding to and removing from selection lists including, as shown in Table 3-14, selection by:

- specifying labels,
- picking by the mouse,
- using user-controlled windows,
- defining a range,
- using a reference entity, or
- specifying element properties.
Table 3-14. Selection Utilities

<table>
<thead>
<tr>
<th>Selection Feature</th>
<th>Selection Command</th>
<th>Unselection Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard input of selected entities</td>
<td>SELINP</td>
<td>UNSELINP</td>
</tr>
<tr>
<td>Picking entities by mouse</td>
<td>SELPIC</td>
<td>UNSELPIC</td>
</tr>
<tr>
<td>Forming a window surrounding region of interest</td>
<td>SELWIN</td>
<td>UNSELWIN</td>
</tr>
<tr>
<td>Selection of all members of an entity associated with a reference entity</td>
<td>SELREF</td>
<td>UNSELREF</td>
</tr>
<tr>
<td>Selection of members of an entity within a range defined by X, Y and Z coordinates</td>
<td>SELRANGE</td>
<td>UNSELRANGE</td>
</tr>
<tr>
<td>Elements associated with element groups, material property sets or real constant sets</td>
<td>ESELPROP</td>
<td>UNESELPROP</td>
</tr>
<tr>
<td>Displays and controls multiple selection sets</td>
<td>STATUS3</td>
<td>N/A</td>
</tr>
<tr>
<td>• Complement of a set</td>
<td>SELSETOP</td>
<td>N/A</td>
</tr>
<tr>
<td>• Union of two existing sets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Intersection of two existing sets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Subtraction of two existing sets</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The Unselection Feature removes members of an entity from a selection set. If the specified selection set does not exist, the unselection commands initiate and activate the specified set.

An active selection list causes denial of access to members of the entity that are not on the list. Multiple selection lists are available for each entity type at any time. The **STATUS3** command shows the status of the selection lists which can be changed using the mouse. The user may also operate on existing selection sets using the **SELSETOP** (Control > SELECT > Set Operation) command to find:

- A complement of a set
- Union of two sets
- Intersection of two sets
- Subtraction of two sets

The user should initialize using the **STATUS3** or **INITSEL** (Control > SELECT > Initialize) commands, or deactivate the selection list once the purpose of its creation was achieved. More details are provided in the Command Reference Manual and also in Chapter 5 of this manual.
Activating a Set

The **ACTSET** (Control > ACTIVATE > Set Entity) command is one of the key commands to activate entities and attributes. At any time in GEOSTAR, there should be one active member of the following sets:

- **CS** - Coordinate system
- **EG** - Element group
- **MP** - Material property set
- **RC** - Real constant set
- **ECS** - Element coordinate system
- **LC** - Load case
- **TC** - Time curve
- **TP** - Temperature curve
- **BH** - B-H curve (for magnetic analysis)
- **LOC** - Fatigue location
- **MC** - Material curve
- **SEL** - Selection list

Many actions use the active set in interpreting the action. For example, the default coordinate systems is the the global Cartesian system (CS=0). If you need to create a keypoint or apply a load or boundary condition in a different coordinate system, you must activate it using the **ACTSET** command or the STATUS table.

The Status1 Table

The Status1 table is displayed by the **STATUS1** (Control > Utility > Status Table 1) command or by clicking the Status 1 button in the Geo Panel. It is used to control many important GEOSTAR switches. Functions controlled by this table are:

- Entity colors and labels.
- Control of whether to delete associated lower entities when a higher one is deleted. For example if a polyhedron is deleted, the default is to delete associated keypoints, curves, surfaces, contours, regions, elements and nodes, but the user may activate the keep flag for elements before deleting a geometric entity so that no elements will be deleted. This function may be used to overcome the limits on geometric entities.
- The highest label of entities (MAXM) in database.
Plotting the orientation of parametric entities, which is important in some geometry creation and meshing.

Default meshing, a flag that controls whether the mesh is carried with geometric entities.

Most of STATUS1 switches can be specified by commands like SETCOLOR, ACTPLOT, ACTMARK, ACTNUM, ACTKEEP, and ACTDMESH as shown in Table 3-15.

Table 3-15. Activation Commands

<table>
<thead>
<tr>
<th>Feature</th>
<th>Command(s)</th>
<th>Remark(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection sets</td>
<td>ACTSEL, STATUS3</td>
<td>See the Command Reference Manual</td>
</tr>
<tr>
<td>Activating one member of coordinate systems,</td>
<td></td>
<td>Element attributes, load cases, time, temperature material and B-H curves,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>asymmetric loading curves, fatigue location, selection list.</td>
</tr>
<tr>
<td></td>
<td>ACTSET</td>
<td>STATUS1, STATUS2, and STATUS3 commands show the active sets in the model.</td>
</tr>
<tr>
<td>Plotting geometric entities and associated</td>
<td>ACTPLOT, STATUS1</td>
<td>Controls plotting lower (in hierarchy) entities associated with a higher</td>
</tr>
<tr>
<td>parameters</td>
<td></td>
<td>plotted entity.</td>
</tr>
<tr>
<td></td>
<td>ACTMARK, STATUS1</td>
<td>Controls plotting marks on entities to show directions of their parametric</td>
</tr>
<tr>
<td></td>
<td></td>
<td>directions.</td>
</tr>
<tr>
<td></td>
<td>ACTNUM, STATUS1</td>
<td>Controls the writing of an entity label when plotted.</td>
</tr>
<tr>
<td></td>
<td>ACTKEEP, STATUS1</td>
<td>Controls keeping specified lower (in hierarchy) entity when a higher order</td>
</tr>
<tr>
<td></td>
<td>ACTDMESH, STATUS1</td>
<td>mesh with geometry</td>
</tr>
<tr>
<td></td>
<td></td>
<td>__</td>
</tr>
</tbody>
</table>
Chapter 3 Exploring GEOSTAR

The Status2 Table

GEOSTAR provides commands for plotting loads and boundary conditions by commands like **DPlot** (LoadsBC > STRUCTURAL > DISPLACEMENT > Plot) to plot displacement boundary conditions, and **FPLOT** (LoadsBC > STRUCTURAL > FORCE > Plot) to plot forces.

The **Status2** table is called by the **STATUS2** (Control > Utility > Status 2 Table) command or by clicking the Status 2 button in the Geo Panel. It can be used to control the color of these loads and boundary conditions. In addition, you can control the automatic display of loads and boundary conditions whenever nodes and elements are plotted.

The **Status3** table is called by the **STATUS3** (Control > Utility > Status 3 Table) command or by clicking the Status 2 button in the Geo Panel. It is used to manage deletion lists.

Color Code

In GEOSTAR, different entities, loads, boundary conditions, etc. are assigned default colors. The program however provides the user with the tools to change these colors. A list of some commands that can be utilized to control colors is shown in Table 3-16. Furthermore, the user can control the color information associated with the monitor type by editing and changing some ASCII files in COSMOS/M directory. More details are presented in Appendix A.
Table 3-16. Controlling Colors in GEOSTAR

<table>
<thead>
<tr>
<th>Feature(s)</th>
<th>Command(s)</th>
<th>Remark(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entities colorization</td>
<td>STATUS1</td>
<td>If the chosen color for an entity in STATUS 1 is similar to the background color (as defined by the B_C icon or the BCLR command), the F_C icon or</td>
</tr>
<tr>
<td></td>
<td>SETCOLOR</td>
<td></td>
</tr>
<tr>
<td>Element colors</td>
<td>STATUS 1</td>
<td>The FCLR command can be used to change colors of the entity. Otherwise colors in STATUS1 controls the process.</td>
</tr>
<tr>
<td></td>
<td>SETECLR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACTECLR</td>
<td></td>
</tr>
<tr>
<td>Colors of loads and boundary conditions</td>
<td>STATUS2</td>
<td>Connection between STATUS2 and foreground and background colors is similar to the STATUS1 command.</td>
</tr>
<tr>
<td>Screen background</td>
<td>BCLR</td>
<td>Background color.</td>
</tr>
<tr>
<td>Screen foreground</td>
<td>FCLR</td>
<td>Foreground color. The effect of the command depends on BCLR, STATUS1 and STATUS2 commands.</td>
</tr>
<tr>
<td>Screen filters</td>
<td>FILTER</td>
<td>Filters plots to be exclusively ored with a specified color.</td>
</tr>
</tbody>
</table>

**Resetting**

The **RESET** (Edit > Reset) command takes most of the changeable flags in GEOSTAR back to their default values.

**COSMOS/M Interface with Other Packages**

The user can exchange data between COSMOS/M and other CAD-like systems and finite element analysis packages. This interface is available via GEOSTAR commands or from the operating system for the following translators:

- **IGES**: a two-way interface to read or write files in the IGES format that are created by other CAD packages.
- **DXF**: a two-way interface to read or write files in the DXF format that are created by other CAD packages.
- **ABAQUS**: a one-way interface to translate data between COSMOS/M and ABAQUS.
- **ADAMS**: A bi-directional interface between COSMOS and ADAMS is now available.
Chapter 3  Exploring GEOSTAR

ANSYS  a two-way interface to translate data between COSMOS/M and ANSYS.

NASTRAN a two-way interface to translate data between COSMOS/M and NASTRAN.

PATRAN a two-way interface to translate data between COSMOS/M and PATRAN.

Pro/ENGINEER a one-way interface to translate data from Pro/ENGINEER to COSMOS/M.

SINDA a one-way interface to translate data between COSMOS/M and SINDA.

TEAP a one-way interface to translate data between COSMOS/M and TEAP.

The available interface commands can be found in Control > CAD System and Control > FEM Input menus. A brief description of the available interface commands and programs is given in Table 3-17. More information is included in Appendix D.

Table 3-17. Commands and Programs for COSMOS/M Translators

<table>
<thead>
<tr>
<th>Packages</th>
<th>Translate from</th>
<th>Translate to</th>
<th>Translate from</th>
<th>Translate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD-like systems</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• IGES format)</td>
<td>IGES_OUT</td>
<td>IGES_INP</td>
<td>GS_IGES.EXE</td>
<td>IGES_GS.EXE</td>
</tr>
<tr>
<td>• DXF format</td>
<td>DXF_OUT</td>
<td>DXF_INP</td>
<td>GS_DXF.EXE</td>
<td>DXF_GS.EXE</td>
</tr>
<tr>
<td>ABAQUS</td>
<td>ABAQSINP</td>
<td>—</td>
<td>COS2ABQ.EXE</td>
<td>—</td>
</tr>
<tr>
<td>ANSYS</td>
<td>ANSYSINP</td>
<td>—</td>
<td>COS2ANS.EXE</td>
<td>ANS2COS.EXE</td>
</tr>
<tr>
<td>NASTRAN*</td>
<td>NASTRANINP</td>
<td>—</td>
<td>COS2NAS.EXE</td>
<td>NAS2COS.EXE</td>
</tr>
<tr>
<td>PATRAN</td>
<td>PATTANINP</td>
<td>—</td>
<td>COS2PAT.EXE</td>
<td>PAT2COS.EXE</td>
</tr>
<tr>
<td>Pro/ENGINEER</td>
<td>—</td>
<td>PRO_INP</td>
<td>—</td>
<td>PRO2GEO.EXE</td>
</tr>
<tr>
<td>SINDA**</td>
<td>SINDINP</td>
<td>—</td>
<td>COS2SND.EXE</td>
<td>—</td>
</tr>
<tr>
<td>TEAP</td>
<td>TEAPINP</td>
<td>—</td>
<td>COS2TEAP.EXE</td>
<td>—</td>
</tr>
</tbody>
</table>

* Postprocessing of NASTRAN generated results is available through the POSTNAS.EXE program used from the operating system.

** Results may be displayed in GEOSTAR through a FORTRAN routine to write the SINDA output back to COSMOS/M database.
Parametric Language

Like any other computer language, the user can define and operate on parametric expressions composed of single variables, arrays and functions as shown in Tables 3-18 and 3-19. The COSMOS/M language is very powerful, efficient and can be applied to complex tasks. The parametric language can be found in Control > Parameter. The user is allowed to build the geometry of the model, mesh it, apply boundary conditions, specify loads, run analysis, visualize results, etc., all in terms of user-defined parameters.

Table 3-18. COSMOS/M Language Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Commands to Define</th>
<th>Assign Values</th>
<th>List</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single variables</td>
<td>PARASSIGN</td>
<td>PARASSIGN</td>
<td>PARLIST</td>
<td>PARDEL</td>
</tr>
<tr>
<td>Arrays</td>
<td>ARRDEF</td>
<td>ARRASSIGN</td>
<td>ARRLIST</td>
<td>ARRDDEL</td>
</tr>
<tr>
<td>Functions</td>
<td>FUNCDEF</td>
<td>—</td>
<td>FUNCLIST</td>
<td>FUNCDEL</td>
</tr>
</tbody>
</table>

Table 3-19. Arithmetic Operators in COSMOS/M

<table>
<thead>
<tr>
<th></th>
<th>Addition</th>
<th>Subtraction</th>
<th>Multiplication</th>
<th>Division</th>
<th>Exponentiation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>+</td>
<td>—</td>
<td>*</td>
<td>/</td>
<td>^</td>
</tr>
</tbody>
</table>

Moreover, a macro file capability is provided to create a subroutine-like environment, as shown in Table 3-20, with which users can call a user-defined procedure to perform a given task or develop the user's own command.

It is also possible, as outlined in Tables 3-21 and 3-22, to control the structure of the user's parametric programming through a series of conditional and unconditional statements similar to the procedures followed in any computer language.

Details and applications of the COSMOS/M parametric language are described in Appendix E.
Chapter 3  Exploring GEOSTAR

Table 3-20. Macros in COSMOS/M

<table>
<thead>
<tr>
<th>Function</th>
<th>Procedure</th>
<th>Is it a GEOSTAR Command?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin a macro</td>
<td>SMACRO macro_name argument (i)..... argument (n)</td>
<td>No</td>
</tr>
<tr>
<td>End a macro</td>
<td>$ENDM</td>
<td>No</td>
</tr>
<tr>
<td>Call a macro</td>
<td>CALLMACRO macro_name argument (i)..... argument (n)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 3-21. Control Structure Commands

<table>
<thead>
<tr>
<th>Control Statement</th>
<th>Arguments</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>#GOTO</td>
<td>labelname</td>
<td>Unconditionally go to the specified label.</td>
</tr>
<tr>
<td>#LABEL</td>
<td>labelname</td>
<td></td>
</tr>
<tr>
<td>#IF</td>
<td>condition (logical expression)</td>
<td></td>
</tr>
<tr>
<td>#ELSEIF</td>
<td>condition (logical expression)</td>
<td>Perform all instructions until the next #ELSEIF, #ELSE or corresponding #ENDIF, only if the condition is true.</td>
</tr>
<tr>
<td>#ELSE</td>
<td>labelname</td>
<td></td>
</tr>
<tr>
<td>#ENDIF</td>
<td>labelname</td>
<td></td>
</tr>
<tr>
<td>#LOOP</td>
<td>labelname, number of loops</td>
<td></td>
</tr>
<tr>
<td>#LABEL</td>
<td>labelname</td>
<td>Loop over a sequence of commands ended by the specified label.</td>
</tr>
</tbody>
</table>

Table 3-22. Operators and Connectors of Logical Expressions

<table>
<thead>
<tr>
<th>COSMOS/M Logical Expression Operators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>= =</td>
<td>Equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>&amp; &amp;</td>
<td>And</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Output Devices

There are two basic procedures for printing: 1) using the Windows standard Print dialog box accessible from the File menu, and 2) using GEOSTAR printing drivers available in the CONTROL > DEVICES menu. In both cases, you directly print GEOSTAR's created images or save them in files for subsequent printing or use in other documents. For UNIX platforms, you may use the File > Printer Set-Up command. The following sections give you detailed information about printing from the Control > DEVICES menu.
Image Saving, Restoring and Hard Copies

This section outlines the following capabilities of GEOSTAR:

- Direct printout of images
- Image files
- Printing images saved in files
- Setting paper size, mode, margins and logo
- Saving and restoring images to GEOSTAR screen

Image Mapping Commands

The following GEOSTAR commands can be used to directly print or plot graphic images in the active window on the supported devices. These commands require the configuration of the appropriate device and the existence of the database files.

<table>
<thead>
<tr>
<th>Command</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLOTTER</td>
<td>HP 7475, HP 7550, ColorPro, HP DXF Draft plotters.</td>
</tr>
<tr>
<td>PAINTJET</td>
<td>HP Paintjet XL or HP Paintjet Color Graphics printers.</td>
</tr>
<tr>
<td>LASERJET</td>
<td>HP Laserjet printer.</td>
</tr>
<tr>
<td>DESKJET</td>
<td>HP Deskjet 500C, 500, 550C printers.</td>
</tr>
<tr>
<td>NEC 201</td>
<td>NEC 201 printer.</td>
</tr>
<tr>
<td>HPGL_CRTRG</td>
<td>Any device driven by an HPGL/2 Cartridge.</td>
</tr>
</tbody>
</table>
| SCREENPLOT    | Printers: HP Paintjet, HP Laserjet, HP Deskjet 500C, HPDeskjet 500, HP Deskjet 550, NEC 201 printers  
|               | Plotters: HP 7475, HP 7550, Color Pro, HP DXF Draft Plotters, Plotters with HPGL/2 Cartridge. |

The commands listed above are to be typed directly in the console window. For the Unix version, the user can also use the File > Printer Setup to select a printer or a plotter and then use the File > PRINT menu with “Active Screen” option (source options) to print or plot images in the active window. For the Windows version, the user can either use the commands in the Control > DEVICES menu or use File > Print (or File > Print All Win) to print image on the system default printer.

Image File Formats

The following commands can be used to generate image files. These files can then be mapped to the appropriate devices to create hard copies.
Chapter 3   Exploring GEOSTAR

The commands listed above are to be typed directly in the console window. For the Unix version, the user can also use File > Printer Setup to select the desired image file type (file option) and then use File > Print to save the image file. For the Windows version, the user can find the related commands in the Control > DEVICES > DEVICE_FILE menu.

Printing Image Files

The following commands can be used to print or plot image files produced by the corresponding commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPGLFILE</td>
<td>For use with any device driven by an HPGL/2 Cartridge.</td>
</tr>
<tr>
<td>POSTSCRIPT</td>
<td>For use with any device that can interpret the PostScript language.</td>
</tr>
<tr>
<td>TIFFFILE</td>
<td>Creates a TIFF file to be used and viewed by other systems.</td>
</tr>
<tr>
<td>PCXFILE</td>
<td>Creates a PCX file to be used and viewed by other systems.</td>
</tr>
<tr>
<td>DXF_2D</td>
<td>For use with CAD programs.</td>
</tr>
<tr>
<td>METAFILE</td>
<td>Special image file which can be used with a wide range of devices. The image can be restored using the VIEW_META command or printed out using the PLT_METAFILE or MULTIPRINT commands.</td>
</tr>
<tr>
<td>IMAGESAV</td>
<td>Saves the graphic image in a user-specified window to a file that can be later restored by the IMAGERES command or directed to a printer using the MULTIPRINT command.</td>
</tr>
<tr>
<td>PLOTTER</td>
<td>HP 7475, HP 7550, ColorPro, HP DXF Draft plotters.</td>
</tr>
<tr>
<td>PAINTJET</td>
<td>HP Paintjet XL or HP Paintjet Color Graphics printers.</td>
</tr>
<tr>
<td>LASERJET</td>
<td>HP Laserjet printer.</td>
</tr>
<tr>
<td>DESKJET</td>
<td>HP Deskjet 500C, 500, 550C printers.</td>
</tr>
<tr>
<td>PLT_FILE</td>
<td>Dumps an HPGL or a PostScript file generated by the HPGLFILE or the POSTSCRIPT commands to any device that can interpret the corresponding language.</td>
</tr>
</tbody>
</table>
PLT_METAFILE: Dumps a META file generated by the METAFILE command to HP or GRAPHTEC Plotters, HP Paintjet, HP Laserjet, HP Deskjet 500C, HP Deskjet 500, HP Deskjet 550C, EPSON/IBM/JDL (EPSON or IBM emulation), NEC 201 printers. A stand-alone program (called PLOTFILE) is also available to perform this function. The command is used to print one image file at a time.

MULTIPRINT: Prints image files generated by IMAGESAV, METAFILE, POSTSCRIPT, HPGLFILE commands. The command may be used to print up to 10 previously saved image files (of the same type).

The commands listed above are to be typed directly in the console window. For the Unix version, the user can also use the source option in the File > PRINT menu to select the desired image file type and then output image files to a printer or plotter. For the Windows version, the user can find the related commands in the Control > DEVICES > DEVICE_FILE menu.

Paper Setting

The PAPER_SETUP (Unix: File > Paper Setup; Windows: Control > DEVICES > Paper Setup) command, as located in Figures 3-25 and 3-26, can be used in conjunction with the supported printers and plotters in order to:

a. Choose the paper size (default is 8.5 x 11 in.).

b. Select the paper mode (portrait or landscape, default is landscape).

c. Specify the margins (defaults are 10% left, 10% right, 10% top and 10% bottom).

d. Activate or deactivate the printing of the COSMOS/M logo.

e. Include the user's own logo design instead of COSMOS/M logo. The procedure to create such a logo is as follows:

- Use GEOSTAR to create the logo similar to generating a finite element model using all features for geometry, meshing, display,... etc.
- Try to use SCALE and PSSCALE commands to fit the final logo model in GEOSTAR's active window.
- Save the final image in a meta file using the METAFILE command.
- Use the PAPER_SETUP command

GEO > PAPER_Setup

...........
Logo print flag 0=No 1=Yes [1] > 1
User logo filename [USERLOGO] > “type your logo’s meta file name”
Chapter 3 Exploring GEOSTAR

- Use the **PLT_METAFILE** or **MULTIPRINT** commands to print out your COSMOS/M model along with your own logo's design.

Figure 3-25. Direct Printout from GEOSTAR
Chapter 3  Exploring GEOSTAR

Figure 3-26. Image Saving, Restoring and Printout

Saving and Restoring Images

The following commands can be used to save and restore images back to GEOSTAR's screen. These commands are to be typed directly on the console window.
Chapter 3   Exploring GEOSTAR

The restore images commands can also be found in the File > File View. (Unix: File > Restore Image File and Windows: File > View Meta File.) Note that images saved on one computer with a specified graphics card can be restored on another computer with the same graphics card by copying the corresponding image files.

### Saving or Printing Multiple Images in One Figure

As discussed before in the postprocessing section, the user can use the \texttt{SETERASE} (Results > SETUP > Set Clear Screen Options) command to view different plots on the same screen. The finally produced image (whatever comes out of the \texttt{REPAINT} command) may be directly printed out or saved in an image file for a later hardcopy production. One example of the practical use of this feature is the user's ability to plot a displacement-load curve in the nonlinear analysis showing in the same figure the model, its deformed shape, loads, etc. The outcome is particularly important for presentations and documentation. It should be mentioned that for the X-Y plots, the user might need to use the \texttt{SETXYPLOT} (Display > XY PLOTS > Set Plot Parameter) command to control the size of the graph in order to view it, save it or print it out with other plots.

### Size Limitations

Three variations of the full version of GEOSTAR are included in the COSMOS/M directory. These versions support 64,000, 128,000, 256,000, 512,000, and 1,024,000 nodes/elements, respectively. You have the option to choose the version that best fits your requirements and computer resources. It should be noted that the databases of these versions are not compatible, but you can use the session or gfm files to rebuild the database. 1. Version Notations

The tables below list the size limitations of GEOSTAR and the Analysis Modules.
### Table 3-23. Size Limits of GEOSTAR

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Size Limit</th>
<th>Quantity</th>
<th>Size Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preprocessing</strong></td>
<td></td>
<td><strong>Miscellaneous</strong></td>
<td></td>
</tr>
<tr>
<td>Nodes</td>
<td>64,000/128,000/256,000</td>
<td>Consecutive zooms</td>
<td>10</td>
</tr>
<tr>
<td>Elements</td>
<td>64,000/128,000/256,000</td>
<td>Selection sets per entity</td>
<td>10</td>
</tr>
<tr>
<td>Keypoints</td>
<td>24,000</td>
<td>Number of saved views</td>
<td>10</td>
</tr>
<tr>
<td>Curves</td>
<td>24,000</td>
<td>Text messages</td>
<td>100</td>
</tr>
<tr>
<td>Surfaces</td>
<td>8,000</td>
<td>Function keys (COSMOSM file)</td>
<td>50</td>
</tr>
<tr>
<td>Volumes</td>
<td>2,000</td>
<td>Number of windows</td>
<td>4</td>
</tr>
<tr>
<td>Contours</td>
<td>5,000 (8000 for the 256 k version)</td>
<td>Length of a file name (including path)</td>
<td>40</td>
</tr>
<tr>
<td>Regions</td>
<td>5,000 (8000 for the 256 k version)</td>
<td>Length of a parameter name (single variable, array, function)</td>
<td>10</td>
</tr>
<tr>
<td>Polyhedra</td>
<td>100</td>
<td>Number of parametric arrays</td>
<td>20</td>
</tr>
<tr>
<td>Parts</td>
<td>100</td>
<td>Number of user-defined parametric functions</td>
<td>200</td>
</tr>
<tr>
<td>Coordinate systems</td>
<td>5,000</td>
<td>- Length of an argument name for a function</td>
<td>10</td>
</tr>
<tr>
<td>Curves in a contour</td>
<td>500</td>
<td>- Number of arguments in a function</td>
<td>20</td>
</tr>
<tr>
<td>Contours in a region</td>
<td>120</td>
<td>- Length of a function parametric expression</td>
<td>200</td>
</tr>
<tr>
<td>Surfaces/regions in a polyhedron</td>
<td>2,000</td>
<td>Length of a macro name</td>
<td>10</td>
</tr>
<tr>
<td>Polyhedra in a part</td>
<td>60</td>
<td>Number of arguments for a macro</td>
<td>10</td>
</tr>
<tr>
<td>Joint bond target surfaces</td>
<td>20</td>
<td>Number of user-defined local parametric variables in a macro</td>
<td>50</td>
</tr>
<tr>
<td>Joint bond sets</td>
<td>100</td>
<td>No. of user-defined local functions in a macro</td>
<td>50</td>
</tr>
<tr>
<td>Material property sets</td>
<td>999</td>
<td>Number of local arrays in a macro</td>
<td>10</td>
</tr>
<tr>
<td>Real constant sets</td>
<td>5,000</td>
<td>No. of command lines starting with the number symbol (#) in a session file or a macro</td>
<td>500</td>
</tr>
<tr>
<td>Element groups</td>
<td>5,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Postprocessing</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Isoplanes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Section planes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of X-Y curves per plot</td>
<td>12, 12, 6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 3-24. Size Limits of the Analysis Modules

<table>
<thead>
<tr>
<th>Module</th>
<th>STAR, DSTAR</th>
<th>Size Limit</th>
<th>NSTAR</th>
<th>Size Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary load cases</td>
<td>50</td>
<td>Material property sets</td>
<td>999</td>
<td></td>
</tr>
<tr>
<td>Secondary load cases</td>
<td>50</td>
<td>Coupled degrees of freedom</td>
<td>No Limit</td>
<td></td>
</tr>
<tr>
<td>Coupled degrees of freedom</td>
<td>1,500</td>
<td>Contact lines</td>
<td>20,000</td>
<td></td>
</tr>
<tr>
<td>Constraint equations</td>
<td>1,500</td>
<td>Contact surfaces</td>
<td>20,000</td>
<td></td>
</tr>
<tr>
<td>Gap elements</td>
<td>No Limit</td>
<td>Gap elements</td>
<td>20,000</td>
<td></td>
</tr>
<tr>
<td>Temperature curves</td>
<td>100</td>
<td>Time curves</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>- Points in a temperature curve</td>
<td>5,000</td>
<td>- Points in a time curve</td>
<td>5,000</td>
<td></td>
</tr>
<tr>
<td>- Super elements</td>
<td>99</td>
<td>Temperature curves</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>- Super nodes in a super element</td>
<td>180</td>
<td>- Points for a temperature curve</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>- DOF assoc. with a super element</td>
<td>2,000</td>
<td>Material curves</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Reaction forces</td>
<td>No Limit</td>
<td>- Points in a material curve</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>Prescribed non-zero displacements</td>
<td>No Limit</td>
<td>Water motion tables</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Concentrated forces on a beam (PBEL)</td>
<td>5</td>
<td>Time steps (data from HSTAR)</td>
<td>6,000</td>
<td></td>
</tr>
<tr>
<td>Distributed loads on a beam (PBEL)</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of Eigenpairs:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Lances method</td>
<td>200</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Subspace method</td>
<td>150</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module</th>
<th>ESTAR</th>
<th>Size Limit</th>
<th>HSTAR</th>
<th>Size Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time curves</td>
<td>100</td>
<td>Time curves</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>- Points in a time curve</td>
<td>5,000</td>
<td>- Points in a time curve</td>
<td>5,000</td>
<td></td>
</tr>
<tr>
<td>Electromagnetic B-H curves</td>
<td>25</td>
<td>Temperature curves</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>- Points in a B-H curve</td>
<td>200</td>
<td>- Points in a temperature curve</td>
<td>5,000</td>
<td></td>
</tr>
<tr>
<td>Magnetic current sources</td>
<td>30</td>
<td>Radiating sets</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>Magnetic coupling sets</td>
<td>1000</td>
<td>Radiation target surfaces</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time steps (data for NSTAR)</td>
<td>6,000</td>
<td></td>
</tr>
</tbody>
</table>
Diagnosis of Solid Automatic Meshing Problems

GEOSTAR has a number of tools which permit detailed diagnosis of meshing problems. This document is focused to deal with the diagnosis of automatic meshing problems on solid parts from COSMOS/Works, COSMOS/Edge, COSMOS/Helix, COSMOS/Eureka, COSMOS/Wave, CAD Interface for PT/Modeler, and COSMOS/Engineer. The detailed diagnosis is performed in GEOSTAR after translating the geometry from the CAD package.

Overview of the Automatic Solid Meshing Procedure

Automatic meshing of solid parts in GEOSTAR (performed when the MA_PART command is issued) consists of 2 phases. Understanding what each phase involves is crucial to quick and accurate diagnosis of meshing problems, and the error messages generated indicate the problem.
In the first phase all the faces of the model (regions in GEOSTAR terminology) are meshed individually. There are 2 algorithms in GEOSTAR for meshing regions: hierarchical and sweeping. Hierarchical is the default method, but if the hierarchical method fails on a particular region when meshing a part, the program automatically switches to the sweeping method for that region. Certain error messages, which will be discussed later, indicate when these switches occur. See Appendix B for more details on the algorithms.

At the end of the first phase of meshing, the program connects all the regions together into a "water-tight" solid by merging nodes along edges common to multiple regions. The tolerance specified in the PHDENSITY command is used as a search tolerance to find which nodes should be merged together. Once all the regions are connected together, the program can start filling the interior of the part with elements. But if at any location on the common edges, a set of corresponding nodes from 2 regions do not merge, the geometry is not a "water-tight" solid and part meshing cannot proceed.

The second phase of meshing involves filling the volume of the part with tetrahedral elements. The algorithm essentially starts at one side of the model filling the solid with elements. As it approaches 100% filling of the solid, the nodes are moved around slightly to allow the mesh to better fit the part shape. Problems can occur when the algorithm has problems with filling the particular shape even after rearranging and moving the nodes.

Use of Error Messages to Diagnose and Fix Meshing Problems

The first step in meshing an imported geometry is to set the element size and tolerance using the PHDENSITY command. To get your part to mesh, a couple of general rules apply: 1) Your element size should be no greater than approximately 5 times the smallest dimension on the model. This dimension can be a radius, a cut, a protrusion, etc.; and 2) The tolerance should always be less than 1/2 the smallest model dimension. Using these 2 rules, you can see that a good starting point for the tolerance is 10% of the element size. Two commands that are especially helpful for determining the smallest dimension are PTPLOT and DISTANCE, which plot all the points in the model and allow you to measure distances between points, respectively.

Next, issue the MA_PART command and specify only 1 part. If your model has multiple parts try one at a time so that the problem diagnosis is more straightforward. You will see the message appear "Processing mesh phase: 1." During this phase, each region (face) of the model is meshed. If the region meshing
Chapter 3 Exploring GEOSTAR

fails with the hierarchical method you will see the message "Convergence not achieved on RG ##" appear. This message does not indicate a fatal meshing error; it only indicates that the hierarchical method failed and the program is switching to the sweeping method. You should note the regions that are listed, however, because those regions may still have a problem in their geometry. If the sweeping method fails on a region, you will get the message "Error in triangulation on RG ##." This is a fatal error for the part mesh. If you get either of these messages, plot all regions listed, determine if they reflect the intended geometry, and see if they have any obvious errors (see the figures below for a couple of examples).

You may need to try to mesh the problem regions individually with a number of element sizes and tolerances to find a particular combination that works. Use the RGDENSITY and MA_RG commands to do this.

Next, issue the MA_PART command and specify only 1 part. If your model has multiple parts try one at a time so that the problem diagnosis is more straightforward. You will see the message appear "Processing mesh phase: 1." During this phase, each region (face) of the model is meshed. If the region meshing fails with the hierarchical method you will see the message "Convergence not achieved on RG ##" appear. This message does not indicate a fatal meshing error; it only indicates that the hierarchical method failed and the program is switching to the sweeping method. You should note the regions that are listed, however, because those regions may still have a problem in their geometry. If the sweeping method fails on a region, you will get the message "Error in triangulation on RG ##." This is a fatal error for the part mesh. If you get either of these messages, plot all regions listed, determine if they reflect the intended geometry, and see if they have any obvious errors (see the figures below for a couple of examples). You may need to try to mesh the problem regions individually with a number of element sizes and tolerances to find a particular combination that works. Use the RGDENSITY and MA_RG commands to do this.
A problem sometimes occurs in meshing a region in which circular geometry is tangent to an edge. The program is looking for a continuous area to mesh, but at the point of contact, essentially you have zero width (the passage necks down to zero).

You may add some very simple geometry to fix this situation and avoid the problems as shown in the second sketch. Essentially you are just splitting a single region (with a zero-width passage) into two regions with a simpler point. In most solid modeling programs, you can do this easily with splitting tools.

The spiked region can occur when 2 features are not exactly lined up. Typically, the region shown at the right is not intended, and properly locating the features will fix the problem.

The next step where you may encounter a problem is during the merging of edge nodes to form the "water-tight" solid. If any corresponding nodes do not match, you will get an error message "Probable free edge node ## on curve ## surface/region ##/##." This is another fatal message and meshing of the part will stop. In response to this, you first want to make sure that your element tolerance is 5-10% of the element size (specified in the PHDENSITY command). You can view the current element size and tolerance with the PHLIST command. If the tolerance is less than 5%, change it and try the mesh again. If the tolerance is already 5-10%, increase the tolerance in 5% increments (up to a maximum of 30% of the element size) and try to mesh the part again. Frequently, you will be able to sidestep the free edge problem this way. Sometimes, though, you may also need to change the element size. The meshing algorithm contains procedures to isolate and attempt to fix free edge problems, but it cannot catch 100% of the problems.

In rare cases, after trying a wide variety of element sizes and tolerances, you may still get the free edge errors. If you run into one of these cases, there are a couple more tools/tricks to diagnose the problem and possibly fix it. First, mesh the polyhedron(s) which make up the part using the MA_PH command. Essentially MA_PH performs only the first phase of the part mesh. The same error messages appear, but in the end the surface mesh is generated. Next, clear the screen, then plot only the elements. Issue the SHOW_MERGE command with the free edge option (the default option is merge tolerance). All the nodes in the model which should have been merged to form a "water-tight" solid but were not will be plotted. Then select these nodes using the SELWIN,ND command. Now you can plot only
those selected nodes and use the DISTANCE command to see how far apart the nodes actually are. The distance between the nodes will be greater than the tolerance set by the PHDENSITY command. You can try to increase the tolerance in PHDENSITY slightly above the largest distance between corresponding nodes, then try to mesh the part. If you still cannot eliminate the free edges, plot only the points (PTPLOT) and curves (CRPLOT). Then zoom into the problem area(s) and identify the curves which make up the edge on which the free edge nodes are located. Use CRID to do this. If the corresponding curves are not identical (such as shown below) please contact SRAC Technical Support and be prepared to send the model.

Neighboring regions with mismatching curves (exploded view).

Notice that the right side of Region 1 is made of 2 curves, while the left side of Region 2 has only 1 curve.

The second phase of meshing involves filling the volume with elements. The primary problem which may occur in phase 2 is the problem of merged facets. A facet refers to 1 of the 4 triangular faces on a tetrahedral element, and merged facets typically can occur where there is a very small gap in the model. An error message can occur in 3 places: (1) At the very start of phase 2 - just after "Processing mesh phase: 2" there may be some messages which say "Probable merged facet on Region ## and Region ##"; (2) At the end of meshing you may get a message "Mesh is diverging. Try smaller element size."; or (3) At the end of meshing the messages may appear "Meshing failed. Boundary facets left = ##." During phase 2 meshing you will also see the messages "Elements generated = #### Boundary facets left = ##." Keep an eye especially on the number of boundary facets left. It should essentially decrease monotonically. If it increases or oscillates you probably have a merged facet problem, but let the meshing algorithm run until it stops.

If you get the first error message ("Probably merged facet...") write down the pairs of regions listed, then plot those regions. Typically these regions will show a
portion of the model where there is a very narrow, often unintended, gap. If the gap is intended, though, you will need to reduce the element size and/or tolerance.

The second error message listed above is pretty much self-explanatory. One thing to note, though, is that this message frequently will be preceded by the probable merged facet messages, and you can fix the problem by investigating and fixing the locations of the merged facets.

If either of the first 2 messages occur you should investigate those first. However, there will be some situations in which you get only the "Meshing failed. Boundary facets left" error message. In these situations, there is a file generated which helps diagnosing the problem area. In the GEOSTAR working directory (the 'Look in' directory when you first open GEOSTAR) a text file called temp.ruf is generated. Temp.ruf is a temporary file which is not needed for your problem database; most of this file contains cryptic meshing information. However, when the mesh fails with less than 1000 facets remaining a set of lines starting with "ND" and "EL" are written at the very end of the file. After the meshing algorithm stops, open up temp.ruf in a text editor such as Notepad (use the EDIT command) while GEOSTAR is still open. Scroll to the very bottom, then cut and paste all the ND and EL lines into another text file and save this new text file. Then select File > Load and load the text file. Nodes and elements will be generated in the locations where facets remained, and those locations are the problem areas.
Hierarchical Versus Sweeping Region-Meshing

When meshing a region the nodes are first placed on the boundaries of the region (on the contours), then the interior of the region is filled with nodes. The difference between the hierarchical and sweeping algorithms lies in how these nodes are connected into elements.

- The hierarchical method starts at a boundary of the region and tentatively generates one triangular element from 2 boundary nodes and 1 interior node near the boundary. Then future elements which would be connected to this new element are also tentatively generated. Next the quality (shape and aspect ratio) of these elements is checked to determine an overall quality of this first group of elements. After this the program performs the same check using a different interior node (but the same 2 boundary nodes), getting an overall quality of a

<table>
<thead>
<tr>
<th>Cryptic command</th>
<th>GEOSTAR menu location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRID</td>
<td>Edit &gt; Identify &gt; Curves</td>
</tr>
<tr>
<td>CRPLOT</td>
<td>Edit &gt; Plot &gt; Curves</td>
</tr>
<tr>
<td>DISTANCE</td>
<td>Control &gt; Measure &gt; Calculate Distance</td>
</tr>
<tr>
<td>MA_PART</td>
<td>Meshing &gt; Auto_Mesh &gt; Parts</td>
</tr>
<tr>
<td>MA_PH</td>
<td>Meshing &gt; Auto_Mesh &gt; Polyhedra</td>
</tr>
<tr>
<td>MA_RG</td>
<td>Meshing &gt; Auto_Mesh &gt; Regions</td>
</tr>
<tr>
<td>PHDENSITY</td>
<td>Meshing &gt; Mesh_Density &gt; Polyhedron Elem Size</td>
</tr>
<tr>
<td>PHLIST</td>
<td>Edit &gt; List &gt; Polyhedra</td>
</tr>
<tr>
<td>PTPLOT</td>
<td>Edit &gt; Plot &gt; Points</td>
</tr>
<tr>
<td>RGDENSITY</td>
<td>Meshing &gt; Mesh_Density &gt; Region Elem Size</td>
</tr>
<tr>
<td>RG_PLOT</td>
<td>Edit &gt; Plot &gt; Regions</td>
</tr>
<tr>
<td>SELWIN</td>
<td>Control &gt; Select &gt; by Windowing</td>
</tr>
<tr>
<td>SHOW_MERGE</td>
<td>Meshing &gt; Nodes &gt; Show Merged Nd</td>
</tr>
</tbody>
</table>
second group of elements. This process continues for all interior nodes near the boundary nodes, and the program chooses the element which would produce the highest quality group of elements. So each element is chosen and generated based its own quality as well as the quality of future elements.

- In the sweeping method elements are chosen and generated based only on their own quality; no future elements are considered. The nodes which will make up the element are found by scanning from one side of the element edge to the other, hence the name sweeping. Any nodes found within a search tolerance are examined as possible candidates for making up the element, and the quality of the element using the specific node is determined an compared to elements using other nodes.
Introduction

COSMOS/M offers a comprehensive set of finite elements to analyze structural, thermal, fluid flow, and electromagnetic problems. The elements are grouped in the COSMOS/M element library under different classifications for linear structural analysis, nonlinear structural analysis, thermal analysis, fluid flow analysis and electromagnetic analysis. Every element type is identified by a name. In many cases, the same elements can be used in different analysis types. This chapter provides a complete description of the capabilities and limitations of each element. The EGROUP (Propsets > Element Group) command is used to define the type of elements.

\[
\text{EGROUP, group-number, element-name, option(1)... option(8)}
\]

where the group_number is the element group number, and element_name is the valid element name shown in Tables 4-1 to 4-6. Every element has different analysis and modeling options (maximum of eight entries), designated as Op. 1,..., Op. 8. The available options will be illustrated in the following sections.

Material properties for elements are defined using the MPROP (Propsets > Material Property) command. This command assigns a material set number under which different material properties can be defined. The MPROP command is shown below:
where the argument name refers to the type of material property being defined. The following sections will show the valid material property names for each element.

The sectional properties of elements and related physical properties that are not covered by the MPROP (Propsets > Material Property) command are called Real Constants and are defined by the RCONST command:

```
RCONST,  egROUP,  nset,  slcnst,  ncnst,  const(i)
```

where egroup is the element group associated with the real constant set, and nset is the real constant set number. The argument ncnst is the starting location of the first real constant to be defined. The arguments ncnst and const(i) refer to the number and input values of constants. A complete description of real constants for each element will be provided in the following sections.

Stresses (depending on the type of analysis used) can be obtained in any defined coordinate system during postprocessing. Two flags control the coordinate system for stress calculations:

- The first flag is an option in the EGROUP (Propsets > Element Group) command to specify whether stresses are required in the local or global coordinate systems.
- The second flag is an element attribute referred to as the element coordinate system (ECS). The default value for ECS is (-1) and refers to the default element local coordinate system as defined in the following sections. To associate elements with a particular ECS, this system should be activated before generating these elements. To modify existing ECS values for a pattern of elements, the EPROPCHANGE (Propsets > Change El-Prop) command can be used.
- The flag in the EGROUP command controls the use of ECS values assigned for each element. If the global option is chosen, stresses will be calculated in the global Cartesian coordinates system regardless of the ECS values. If the local coordinate option is used instead, stress output will be in terms of the ECS of each element in this element group. Caution should be exercised however with shell elements because, as will be mentioned in in the following sections, the ECS is dependent on the shell orientation. In GEOSTAR the process of averaging stresses is based on the values obtained in the defined element.
coordinate system. If averaging is performed for elements with different coordinate systems, meaningless results may be obtained. In cases where various ECS values are intentionally used for elements, selection lists in the Control > SELECT menu can be very helpful. To be able to request stress results in an arbitrary coordinate system, you must choose the Global Coordinate System options in the EGROUP command for all element groups in the model.

- If ECS is set to -1 and the stress direction flag is set to local for triangular elements (TRIANG, SHELL3, SHELL3T, SHELL6, SHELL6T, TETRA4, TETRA4R, and TETRA10), stresses will be calculated in the global coordinate system.
Table 4-1. Elements for Structural Linear Analysis (STAR, DSTAR, ASTAR)

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Element Name</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Spar/Truss</td>
<td>TURSS2D</td>
<td>4-8</td>
</tr>
<tr>
<td>3D Spar/Truss</td>
<td>TRUSS3D</td>
<td>4-10</td>
</tr>
<tr>
<td>2D Elastic Beam</td>
<td>BEAM2D</td>
<td>4-12</td>
</tr>
<tr>
<td>3D Elastic Beam</td>
<td>BEAM3D</td>
<td>4-16</td>
</tr>
<tr>
<td>Elastic Straight Pipe</td>
<td>PIPE</td>
<td>4-28</td>
</tr>
<tr>
<td>Elastic Curved Pipe</td>
<td>ELBOW</td>
<td>4-31</td>
</tr>
<tr>
<td>2D 4- to 8-Node Plane Stress, Isoparametric Plane Strain, Body of Revolution</td>
<td>PLANE2D</td>
<td>4-33</td>
</tr>
<tr>
<td>2D 3- to 6 Node Plane Stress, Triangular Plane Strain, Body of Revolution</td>
<td>TRIANG</td>
<td>4-39</td>
</tr>
<tr>
<td>3D 8- to 20-Node Isoparametric Solid</td>
<td>SOLID</td>
<td>4-44</td>
</tr>
<tr>
<td>8-Node Composite Solid</td>
<td>SOLIDL</td>
<td>4-50</td>
</tr>
<tr>
<td>3D 8- to 20-Node Isoparametric Piezoelectric Solid***</td>
<td>SOLIDPZ</td>
<td>4-56</td>
</tr>
<tr>
<td>3D 4- or 10-Node Tetrahedron Solid</td>
<td>TETRA4 or</td>
<td>4-60</td>
</tr>
<tr>
<td>3D 4-Node Tetrahedron Solid with Rotation</td>
<td>TETRA10</td>
<td></td>
</tr>
<tr>
<td>Axisymmetric Shell</td>
<td>SHELLAX</td>
<td>4-69</td>
</tr>
<tr>
<td>Triangular Thin Shell</td>
<td>SHELL3</td>
<td>4-71</td>
</tr>
<tr>
<td>Quadrilateral Thin Shell</td>
<td>SHELL4</td>
<td>4-77</td>
</tr>
<tr>
<td>6-Node Triangular Thin Shell</td>
<td>SHELL6</td>
<td>4-83</td>
</tr>
<tr>
<td>8-or 9-Node Isoparametric Shell Element</td>
<td>SHELL9</td>
<td>4-86</td>
</tr>
<tr>
<td>Triangular Thick Shell</td>
<td>SHELL3T</td>
<td>4-90</td>
</tr>
<tr>
<td>Quadrilateral Thick Shell</td>
<td>SHELL4T</td>
<td>4-95</td>
</tr>
<tr>
<td>6-Node Triangular Thick Shell</td>
<td>SHELL6T</td>
<td>4-99</td>
</tr>
<tr>
<td>Composite Triangular Plate and Shell</td>
<td>SHELL3L</td>
<td>4-100</td>
</tr>
<tr>
<td>Composite Quadrilateral Plate and Shell</td>
<td>SHELL4L</td>
<td>4-106</td>
</tr>
<tr>
<td>8-or 9-Node Isoparametric Composite Shell</td>
<td>SHELL9L</td>
<td>4-112</td>
</tr>
<tr>
<td>General Mass Element</td>
<td>MASS</td>
<td>4-117</td>
</tr>
<tr>
<td>Spring Element</td>
<td>SPRING</td>
<td>4-118</td>
</tr>
<tr>
<td>2-Node Rigid Bar*</td>
<td>RBAR</td>
<td>4-121</td>
</tr>
<tr>
<td>Boundary Element</td>
<td>BOUND</td>
<td>4-122</td>
</tr>
<tr>
<td>2-Node Gap with Friction**</td>
<td>GAP</td>
<td>4-124</td>
</tr>
<tr>
<td>General Stiffness</td>
<td>GENSTIF</td>
<td>4-126</td>
</tr>
</tbody>
</table>

*Not applicable for Buckling (DSTAR)  ** STAR only  *** Frequency analysis only
### Table 4-2. Elements for Structural Nonlinear Analysis (NSTAR)

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Element Name</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Spar/Truss</td>
<td>TURSS2D</td>
<td>4-129</td>
</tr>
<tr>
<td>3D Spar/Truss</td>
<td>TRUSS3D</td>
<td>4-133</td>
</tr>
<tr>
<td>2D Beam</td>
<td>BEAM2D</td>
<td>4-136</td>
</tr>
<tr>
<td>3D Beam</td>
<td>BEAM3D</td>
<td>4-142</td>
</tr>
<tr>
<td>2D 4- to 8-Node Isoparametric, Plane Stress, Plane Strain, Body of Revolution</td>
<td>PLANE2D</td>
<td>4-158</td>
</tr>
<tr>
<td>2D 3- to 6 Node Triangular Plane Stress, Plane Strain, Body of Revolution</td>
<td>TRIANG</td>
<td>4-164</td>
</tr>
<tr>
<td>3D 8- to 20-Node Isoparametric Solid</td>
<td>SOLID</td>
<td>4-170</td>
</tr>
<tr>
<td>3D 4- or 10-Node Tetrahedron Solid</td>
<td>TETRA4 or TETRA10</td>
<td>4-180</td>
</tr>
<tr>
<td>3-Node Triangular Thin Shell</td>
<td>SHELL3</td>
<td>4-188</td>
</tr>
<tr>
<td>4-Node Quadrilateral Thin Shell</td>
<td>SHELL4</td>
<td>4-193</td>
</tr>
<tr>
<td>6-Node Triangular Thin Shell</td>
<td>SHELL6</td>
<td>4-198</td>
</tr>
<tr>
<td>3-Node Triangular Thick Shell</td>
<td>SHELL3T</td>
<td>4-199</td>
</tr>
<tr>
<td>4-Node Quadrilateral Thick Shell</td>
<td>SHELL4T</td>
<td>4-205</td>
</tr>
<tr>
<td>6-Node Triangular Thick Shell</td>
<td>SHELL6T</td>
<td>4-210</td>
</tr>
<tr>
<td>3-Node Composite Triangular Shell</td>
<td>SHELL3L</td>
<td>4-211</td>
</tr>
<tr>
<td>4-Node Composite Quadrilateral Shell</td>
<td>SHELL4L</td>
<td>4-217</td>
</tr>
<tr>
<td>General Mass Element</td>
<td>MASS</td>
<td>4-223</td>
</tr>
<tr>
<td>Nonlinear Spring</td>
<td>SPRING</td>
<td>4-224</td>
</tr>
<tr>
<td>Gap-Friction</td>
<td>GAP</td>
<td>4-230</td>
</tr>
<tr>
<td>Immersed Pipe</td>
<td>IMPIPE</td>
<td>4-240</td>
</tr>
<tr>
<td>Buoy</td>
<td>BUOY</td>
<td>4-252</td>
</tr>
<tr>
<td>General Stiffness</td>
<td>GENSTIF</td>
<td>4-228</td>
</tr>
</tbody>
</table>
### Table 4-3. Elements for Linear and Nonlinear Thermal Analysis (HSTAR)

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Element Name</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radiation Link</td>
<td>RLINK</td>
<td>4-254</td>
</tr>
<tr>
<td>Convection Link</td>
<td>CLINK</td>
<td>4-255</td>
</tr>
<tr>
<td>Pipe Flow Element</td>
<td>HLINK</td>
<td>4-260</td>
</tr>
<tr>
<td>2D Spar/Truss</td>
<td>TRUSS2D</td>
<td>4-8 &amp; 4-129</td>
</tr>
<tr>
<td>3D Spar/Truss</td>
<td>TRUSS3D</td>
<td>4-10 &amp; 4-133</td>
</tr>
<tr>
<td>2D Elastic Beam</td>
<td>BEAM2D</td>
<td>4-12 &amp; 4-136</td>
</tr>
<tr>
<td>3D Elastic Beam</td>
<td>BEAM3D</td>
<td>4-16 &amp; 4-142</td>
</tr>
<tr>
<td>2D 4- to 8-Node Plane Quadrilateral</td>
<td>PLANE2D</td>
<td>4-33 &amp; 4-158</td>
</tr>
<tr>
<td>2D 3- to 6 Node Plane Triangular</td>
<td>TRIANG</td>
<td>4-39 &amp; 4-164</td>
</tr>
<tr>
<td>3D 8- to 20-Node Isoparametric Solid</td>
<td>SOLID</td>
<td>4-44 &amp; 4-170</td>
</tr>
<tr>
<td>3D 4- or 10-Node Tetrahedron Solid</td>
<td>TETRA4 or TETRA 10</td>
<td>4-60 &amp; 4-180</td>
</tr>
<tr>
<td>3D 4-Node Tetrahedron Solid</td>
<td>TETRA4R</td>
<td>4-65</td>
</tr>
<tr>
<td>Triangular Thin Shell</td>
<td>SHELL3</td>
<td>4-71 &amp; 4-188</td>
</tr>
<tr>
<td>6-Node Triangular Thin Shell</td>
<td>SHELL6</td>
<td>4-83</td>
</tr>
<tr>
<td>6-Node Triangular Thick Shell</td>
<td>SHELL6T</td>
<td>4-99</td>
</tr>
<tr>
<td>Quadrilateral Thin Shell</td>
<td>SHELL4</td>
<td>4-77 &amp; 4-193</td>
</tr>
<tr>
<td>Triangular Thick Shell</td>
<td>SHELL3T</td>
<td>4-90 &amp; 4-199</td>
</tr>
<tr>
<td>Quadrilateral Thick Shell</td>
<td>SHELL4T</td>
<td>4-95 &amp; 4-205</td>
</tr>
<tr>
<td>Composite Quadrilateral Plate and Shell</td>
<td>SHELL4L</td>
<td>4-106 &amp; 4-217</td>
</tr>
<tr>
<td>General Mass Element</td>
<td>MASS</td>
<td>4-117 &amp; 4-223</td>
</tr>
<tr>
<td>Thermal 3D Fluid Pipe</td>
<td>FLUIDT</td>
<td>4-256</td>
</tr>
</tbody>
</table>
### Table 4-4. Elements for Fluid Flow Analysis (FLOWSTAR)

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Element Name</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D 4-Node Isoparametric Element</td>
<td>FLOW2D</td>
<td>4-262</td>
</tr>
<tr>
<td>3D 8-Node Isoparametric Element</td>
<td>FLOW3D</td>
<td>4-264</td>
</tr>
</tbody>
</table>

### Table 4-5. Elements for Linear and Nonlinear Electromagnetic Analysis (ESTAR)

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Element Name</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D 4-Node Magnetic Element</td>
<td>MAG2D</td>
<td>4-266</td>
</tr>
<tr>
<td>3D 8-Node Magnetic Element</td>
<td>MAG3D</td>
<td>4-268</td>
</tr>
<tr>
<td>3D 4- or 10-Node Tetrahedron Element</td>
<td>TETRA4 or TETRA 10</td>
<td>4-270</td>
</tr>
</tbody>
</table>
Chapter 4  Element Library

Thermal and Linear Structural 2D Spar/Truss Element (TRUSS2D)

General Description
TRUSS2D is a 2-node uniaxial element for two dimensional structural and thermal models. All elements have to be defined in the X-Y plane as shown in Figure 4-1. Only two translational degrees of freedom per node are considered for structural analysis. Temperature is the only degree of freedom for the thermal module.

Special Features
Buckling, inplane loading.

Default Element Coordinate System (ECS = -1)
The nodal input pattern shown in Figure 4-1 specifies the direction of the element axis. The x-axis goes from the first node to the second. The element y-axis is perpendicular to the x-axis and lies in the X-Y plane.

Element Group Options
Op. 1 to Op. 4: Unused options for this element
Op. 5: Use default value (Linear elastic material type)
Op. 6: Use default value (Small displacement formulation)
Op. 7: Use default value (Material creep is not considered)
Op. 8: Unused options for this element

Real Constants
r1 = Cross-sectional area
r2 = Perimeter (thermal analysis only)

Material Properties
EX = Modulus of elasticity
KX = Thermal conductivity
ALPX = Coefficient of thermal expansion
C = Specific heat
DENS = Density
Chapter 4  Element Library

DAMP  = Material Damping coefficient
ECONX = Electrical conductivity (thermal analysis only)

Element Loadings
• Thermal
• Gravitational

Output Results
Forces and stresses are available in the element coordinate system.

Figure 4-1. 2D Truss

XY: Global Cartesian Coordinate System
xy: Element Coordinate System
Chapter 4  Element Library

**Thermal and Linear Structural 3D Spar/Truss Element (TRUSS3D)**

**General Description**
TRUSS3D is a 2-node uniaxial element for three dimensional structural and thermal models. Only three translational degrees of freedom are considered per node for structural analysis. Temperature is the only degree of freedom for the thermal module.

**Special Features**
Buckling, inplane loading.

**Default Element Coordinate System (ECS = -1)**
The nodal input pattern shown in Figure 4-2 specifies the direction of the element axis. The x-axis goes from the first node to the second. The element y- and z-axes lie in a plane perpendicular to the x-axis.

**Element Group Options**
- **Op. 1 to Op. 4:** Unused options for this element
- **Op. 5:** Use default value (Linear elastic material type)
- **Op. 6:** Use default value (Small displacement formulation)
- **Op. 7:** Use default value (Material creep is not considered)
- **Op. 8:** Unused options for this element

**Real Constants**
- \( r_1 \) = Cross-sectional area
- \( r_2 \) = Perimeter (thermal analysis only)

**Material Properties**
- \( EX \) = Modulus of elasticity
- \( KX \) = Thermal conductivity
- \( ALPX \) = Coefficient of thermal expansion
- \( C \) = Specific heat
- \( DENS \) = Density
Chapter 4   Element Library

DAMP  = Material damping coefficient
ECONX = Electrical conductivity (thermal analysis only)

Element Loadings
• Thermal
• Gravitational

Output Results
Forces and stresses are available in the element coordinate system.

Figure 4-2. 3D Truss

XYZ: Global Cartesian Coordinate System
xyz: Element Coordinate System
**Thermal and Linear Structural 2D Elastic Beam Element (BEAM2D)**

**General Description**
BEAM2D is a 2-node uniaxial element for two-dimensional structural and thermal models. The element has three degrees of freedom (two translations and one rotation) per node for structural analysis. Temperature is the only degree of freedom for the thermal module. All elements have to be defined in the X-Y plane as shown in Figure 4-3.

**Special Features**
Buckling, inplane loading, AISC code check.

**Default Element Coordinate System (ECS = -1)**
The nodal input pattern shown in Figure 4-3 specifies the direction of the element axis. The x-axis goes from the first node to the second. The element z-axis is parallel to and in the positive sense of the global Cartesian Z-axis. The element y-axis is perpendicular to the x-axis and completes, with x- and z-axes, a right-hand Cartesian coordinate system.

**Element Group Options**
- **Op. 1 to Op. 3:** Unused options for this element
- **Op. 4:** Unrelated option to this type of analysis (use default value)
- **Op. 5:** Use default value (Linear elastic material)
- **Op. 6:** Use default value (Small displacement formulation)
- **Op. 7:** Unused option for this element
- **Op. 8:** Unused options for this element

**Real Constants**
There are two different ways to define the section properties:

1. **Using RCONST (Propsets > Real Constants) Command**
   - \( r_1 \) = Cross-sectional area
   - \( r_2 \) = Moment of inertia
   - \( r_3 \) = Depth (diameter for circular cross-sections)
Chapter 4   Element Library

r4 = End-release code (node 1)*
r5 = End-release code (node 2)*
r6 = Shear factor in the element y-axis
r7 = Temperature difference in the element y-axis
r8 = Perimeter (thermal analysis only)

* The end-release code for each end is specified by a six-digit number with combinations of zeros and ones. If a zero (0) is placed in a particular location, the corresponding force is not known and will be calculated by the program, but if a one (1) is placed in that location, the force or moment corresponding to that direction is known to be zero due to a hinge or roller, and the program will remove the force. The six-digit code corresponds in order to the six degrees of freedom at each end of the beam element. For example, end release code 000001 represents a condition in which the forces in the x and y directions are to be calculated and the moment about the Z-axis is zero, i.e., a hinge condition.

2. Using BMSECDEF (Propsets > Beam Section) Command
   This command replaces real constants r1, r2 and r3. Values corresponding to real constants r4, r5, r6 and r7 also have to be input with this command. There are five cross sections available for the BEAM2D section library as shown in Figure 4-4.

1. Solid Rectangular Section
   Constant_1 = Height of the beam (H)
   Constant_2 = Width of the beam (B)

2. Solid Circular Section
   Constant_1 = Radius of the beam (R)

3. Circular Hollow Section (Pipe)
   Constant_1 = Outside diameter (D)
   Constant_2 = Thickness (T)

4. Hollow Rectangular Section (Box)
   Constant_1 = Height of the beam (H)
   Constant_2 = Width of the beam (B)
   Constant_3 = Thickness associated with the height (TB)
   Constant_4 = Thickness associated with the width (TH)

5. Symmetric I-Section
   Constant_1 = Height of the beam (H)
   Constant_2 = Flange width (B)
Constant_3 = Flange thickness (TH)
Constant_4 = Web thickness (TB)

**Material Properties**

- EX = Modulus of elasticity
- KX = Thermal conductivity
- ALPX = Coefficient of thermal expansion
- C = Specific heat
- NUXY = Poisson's ratio
- DENS = Density
- DAMP = Material damping coefficient
- ECONX = Electrical conductivity (thermal analysis only)

**Element Loadings**

- Uniform pressure (in terms of force per unit length)
- Thermal
- Gravitational
- Beam Loading

**Output Results**

Forces, moments, and stresses are available in the element coordinate system.

*Figure 4-3. 2D Elastic Beam*
Chapter 4   Element Library

Figure 4-4. Identification Parameters of the Built-In Section Library for BEAM2D

<table>
<thead>
<tr>
<th>Type 1</th>
<th>Type 2</th>
<th>Type 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Rectangular</td>
<td>Solid Circular</td>
<td>Circular Hollow</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type 4</th>
<th>Type 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hollow Rectangular</td>
<td>Symmetric I</td>
</tr>
</tbody>
</table>

References
**Thermal and Linear Structural 3D Elastic Beam Element (BEAM3D)**

**General Description**
BEAM3D is a 2-node uniaxial element for three-dimensional structural and thermal models. For structural analysis, six (6) degrees of freedom (three translations and three rotations) are considered per node. One (1) degree of freedom per node, representing the temperature is used for the thermal module. A third node or an orientation angle is required only for the element orientation as shown in Figure 4-5.

This element permits using unsymmetric cross-section (Figure 4-6) when the shear center is not coincident with the center of gravity; e.g., channel and L-shape cross-sections can be considered. For the element two nodes (1 and 2) an offset is allowed from the centroidal axis.

**Special Features**
Buckling, Inplane loading, AISC code check, nodes offset, unsymmetric cross-sections, ASME code check.

**Default Element Coordinate System (ECS = -1)**
The element x-axis is defined by a vector that starts at the first node (I) and points towards the second node (J). The orientation of the cross-section is defined by a third node or an angle. The third node, if specified, defines the element y-axis such that it is orthogonal to the element x-axis, starts from the first node towards the third, and lies in the plane defined by the three nodes.

If a third node is not specified, the orientation of the cross-section is defined through real constants $r_{13}$ or $r_{21}$ as the angle between $y_o$ and the element y-axis as shown in Figure 4-5(c). The axis $y_o$ is parallel to the global X-Y plane and normal to the element x-axis. A positive angle is measured from the $y_o$ axis using the right-hand rule such that the thumb points to the positive direction of the element x-axis. Real constant $r_{13}$ and $r_{21}$ are ignored if a third node exists.

The element z-axis completes a right-handed Cartesian coordinate system defined by the element x- and y-axes.
Element Group Options

**Op. 1:** Section type
   - = 0; symmetric (default)
   - = 1; unsymmetric
   - = 2; symmetric tapered

**Op. 2 and Op. 3:** Unused options for this element

**Op. 4:** Unrelated option for this type of analysis (use default value)

**Op. 5:** Use default value (Linear elastic Material)

**Op. 6:** Use default value (Small displacement formulation)

**Op. 7:** Unused option for this element

**Op. 8:** Unused option for this element

Real Constants

There are two different ways to define the section properties:

1. Using **RCONST** (Propsets > Real Constants) Command

   **Symmetric and Unsymmetric Sections (Op. 1 = 0 or 1)**
   - \( r_1 \) = Cross-sectional area
   - \( r_2 \) = Moment of inertia about the element y-axis
   - \( r_3 \) = Moment of inertia about the element z-axis
   - \( r_4 \) = Depth of beam (y-axis) or the diameter for a circular cross-section
   - \( r_5 \) = Width of beam (z-axis) or the diameter for a circular cross-section
   - \( r_6 \) = End-release code (node 1)*
   - \( r_7 \) = End-release code (node 2)*
   - \( r_8 \) = Torsion constant \( J \) (Polar moment of inertia for circular sections)*****
   - \( r_9 \) = Shear factor in the element y-axis \( (A_{sy}/A)\)**
   - \( r_{10} \) = Shear factor in the element z-axis \( (A_{sz}/A)\)**
   - \( r_{11} \) = Temperature difference in the element y-axis
   - \( r_{12} \) = Temperature difference in the element z-axis
   - \( r_{13} \) = Orientation angle (degrees)
   - \( r_{14} \) = CTOR; Constant for maximum shear stress calculation*****

   **Unsymmetric Section only (Op. 1 = 1)**
   - \( r_{15} = DX_1 \) x-distance of the section centroid relative to the nodal point location at node 1***
   - \( r_{16} = DX_2 \) x-distance of the section centroid relative to the nodal point location at node 2***
### Chapter 4  Element Library

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>r17 = DY1</td>
<td>y-distance of the section centroid relative to the nodal point location at node 1 ***</td>
</tr>
<tr>
<td>r18 = DY2</td>
<td>y-distance of the section centroid relative to the nodal point location at node 2 ***</td>
</tr>
<tr>
<td>r19 = DZ1</td>
<td>z-distance of the section centroid relative to the nodal point location at node 1 ***</td>
</tr>
<tr>
<td>r20 = DZ2</td>
<td>z-distance of the section centroid relative to the nodal point location at node 2 ***</td>
</tr>
<tr>
<td>r21 = DYSC1</td>
<td>y-distance of the shear center relative to the section centroid at node 1 ****</td>
</tr>
<tr>
<td>r22 = DZSC1</td>
<td>z-distance of the shear center relative to the section centroid at node 1 ****</td>
</tr>
<tr>
<td>r23 = DYSC2</td>
<td>y-distance of the shear center relative to the section centroid at node 2 ****</td>
</tr>
<tr>
<td>r24 = DZSC2</td>
<td>z-distance of the shear center relative to the section centroid at node 2 ****</td>
</tr>
<tr>
<td>r25 = Ty</td>
<td>y-distance of the point where stresses are to be calculated ****</td>
</tr>
<tr>
<td>r26 = Tz</td>
<td>z-distance of the point where stresses are to be calculated ****</td>
</tr>
<tr>
<td>r27 = Iyz</td>
<td>Centroidal product of inertia of the element cross-section</td>
</tr>
</tbody>
</table>

**Symmetric Tapered (Op. 1 = 2)**

(Sec. 1) and (Sec. 2) refers to sectional properties of the beam at nodes 1 and 2.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>r1 =</td>
<td>Cross-sectional area for (Sec. 1)</td>
</tr>
<tr>
<td>r2 =</td>
<td>Cross-sectional area for (Sec. 2)</td>
</tr>
<tr>
<td>r3 =</td>
<td>Moment of inertia about the element y-axis at (Sec. 1)</td>
</tr>
<tr>
<td>r4 =</td>
<td>Moment of inertia about the element y-axis at (Sec. 2)</td>
</tr>
<tr>
<td>r5 =</td>
<td>Moment of inertia about the element z-axis at (Sec. 1)</td>
</tr>
<tr>
<td>r6 =</td>
<td>Moment of inertia about the element z-axis at (Sec. 2)</td>
</tr>
<tr>
<td>r7 =</td>
<td>Depth of beam (y-axis) at (sec. 1) or the diameter in case of a circular cross-section</td>
</tr>
<tr>
<td>r8 =</td>
<td>Depth of beam (y-axis) at (sec. 2) or the diameter in case of a circular cross-section</td>
</tr>
<tr>
<td>r9 =</td>
<td>Depth of beam (z-axis) at (sec. 1) or the diameter in case of a circular cross-section</td>
</tr>
<tr>
<td>r10 =</td>
<td>Depth of beam (z-axis) at (sec. 2) or the diameter in case of a circular cross-section</td>
</tr>
<tr>
<td>r11 =</td>
<td>End-release code at (node 1)*</td>
</tr>
<tr>
<td>r12 =</td>
<td>End-release code at (node 2)*</td>
</tr>
</tbody>
</table>
r13 = Torsion constant J of (sec. 1)*****
r14 = Torsion constant J of (sec. 2)*****
r15 = Shear factor in the element y-axis**
r16 = Shear factor in the element z-axis**
r17 = Temperature difference in the element y-axis
r18 = Temperature difference in the element z-axis
r19 = Perimeter (thermal analysis only)
r20 = CTOR; Constant for maximum shear stress calculation*****
r21 = Orientation angle (degrees)

* The end-release code for each end is specified by a six-digit number with combinations of zeros and ones. If a zero (0) is placed in a particular location, the corresponding force is not known and will be calculated by the program, but if a one (1) is placed in that location, the force or moment corresponding to that direction is known to be zero due to a hinge or roller, and the program will remove the force. The six-digit code corresponds in order to the six degrees of freedom at each end of the beam element. For example, end release code 101100 for a 3D beam element represents a condition in which the forces in the x- and z-directions and the moment about the x-axis are zero, and the force in the y-direction and moments about y- and z-axes are to be calculated.

** Asy = beam cross-sectional area effective in shear in y-direction.
Asz = beam cross-sectional area effective in shear in z-direction.

*** Offset distances (Dy, Dz) shown in Figure 4-6 are measured positive from the nodal point in the positive element coordinate directions.

**** Stress point (Ty, Tz) and shear center distances (DYSC, DZSC) shown in Figure 4-6 are measured positive from the center of gravity in the positive element coordinate directions.

***** J and CTOR given below for some Beam cross-sections shown in Figure 4-7:

\[ \tau_{\text{max}} = \frac{(T)(\text{CTOR})}{J} \quad \text{where } T \text{ is the Torsional moment.} \]

2. Using BMSECDEF (Propsets > Beam Section) Command
This command replaces some of the real constants defined before. However, values corresponding to real constants:

- r6, r7, r9, r10, r11, 12 and r13 (for symmetric sections)
- r6, r7, r9 to r13, r15 to r20, r25 and r26 (for unsymmetric sections)
- r11, r12, and r15 to r20 (for symmetric tapered sections)
also have to be input by this command.

There are 11 cross-sections available for the BEAM3D section library as shown in Figure 4-9.

1. Solid Rectangular Section
   - Symmetric/Unsymmetric Beams
     Constant_1 = Height of the beam (H)
     Constant_2 = Width of the beam (B)
   - Symmetric Tapered Beam
     Constant_1 = Height of the beam at node 1 (H1)
     Constant_2 = Width of the beam at node 1 (B1)
     Constant_3 = Height of the beam at node 2 (H2)
     Constant_4 = Width of the beam at node 2 (B2)

2. Solid Circular Section
   - Symmetric/Unsymmetric Beams
     Constant_1 = Radius (R)
   - Symmetric Tapered Beam
     Constant_1 = Radius at node 1 (R1)
     Constant_2 = Radius at node 2 (R1)

3. Circular Hollow Section (Pipe)
   - Symmetric/Unsymmetric Beams
     Constant_1 = Outside Diameter (D)
     Constant_2 = Thickness (T)
   - Symmetric Tapered Beam
     Constant_1 = Outside Diameter at node 1 (D1)
     Constant_2 = Thickness at node 1 (T1)
     Constant_3 = Outside Diameter at node 2 (D2)
     Constant_4 = Thickness at node 2 (T2)

4. Hollow Rectangular Section (Box)
   - Symmetric/Unsymmetric Beams
     Constant_1 = Height of the beam (H)
     Constant_2 = Width of the beam (B)
     Constant_3 = Thickness associated with the height (TB)
     Constant_4 = Thickness associated with the width (TH)
   - Symmetric Tapered Beam
     Constant_1 = Height of the beam at node 1 (H1)
     Constant_2 = Width of the beam at node 1 (B1)
     Constant_3 = Thickness associated with the height at node 1 (TB1)
     Constant_4 = Thickness associated with the width at node 1 (TH1)
Chapter 4   Element Library

Constant_5 = Height of the beam at node 2 (H2)
Constant_6 = Width of the beam at node 2 (B2)
Constant_7 = Thickness associated with the height at node 2 (TB2)
Constant_8 = Thickness associated with the width at node 2 (TH2)

5.  I-Section
   - Symmetric/Unsymmetric Beams
     Constant_1 = Height of the beam (H)
     Constant_2 = Flange width (B)
     Constant_3 = Flange thickness (TH)
     Constant_4 = Web thickness (TB)
   - Symmetric Tapered Beam
     Constant_1 = Height of the beam at node 1 (H1)
     Constant_2 = Flange width at node 1 (B1)
     Constant_3 = Flange thickness at node 1 (TH1)
     Constant_4 = Web thickness at node 1 (TB1)
     Constant_5 = Height of the beam at node 2 (H2)
     Constant_6 = Flange width at node 2 (B2)
     Constant_7 = Flange thickness at node 2 (TH2)
     Constant_8 = Web thickness at node 2 (TB2)

6.  Trapezoidal Solid Section
    Constant_1 = Height of the beam (H)
    Constant_2 = Bottom width of the beam (B1)
    Constant_3 = Top width of the beam (B2)
    (Note that H > B1 > B2)

7.  Thin-Walled Channel Section
    Constant_1 = Height of the beam (H)
    Constant_2 = Flange width (B)
    Constant_3 = Flange thickness (TH)
    Constant_4 = Web thickness (TB)

8.  Thin-Walled Z-Section
    Constant_1 = Height of the beam (H)
    Constant_2 = Flange width (B)
    Constant_3 = Flange thickness (TH)
    Constant_4 = Web thickness (TB)

9.  Thin-Walled T-Section
    Constant_1 = Height of the beam (H)
    Constant_2 = Flange width (B)
Chapter 4  Element Library

Constant_3 = Flange thickness (TH)
Constant_4 = Web thickness (TB)

10. Thin-Walled L-Section
   Constant_1 = Height of the beam (H)
   Constant_2 = Width (B)
   Constant_3 = Thickness associated with the height (TB)
   Constant_4 = Thickness associated with the width (TH)

11. User-Defined Thin-Walled Section (section number = 0)
   (Used with the unsymmetric section option of EGROUP)
   Constant_1 = y-coordinate of the cross-section's first node
   Constant_2 = z-coordinate of the cross-section's first node
   Constant_3 = Thickness of the first segment

   . . .
   . . .
   . . .
   Repeat constants_1, 2, and 3 for (up to) 20 nodes

Examples for the user-defined section are shown in Figure 4-10. It should be noted that:

- The wall thickness of the section has to be small compared to the total length of the section.
- During the input process of coordinates and thickness at the section nodes, the beginning and end node numbers of each segment have to be consecutive.
- A zero (0.0) thickness has to be always associated with the first node.
- In case of tracing back a previously defined segment, a zero (0.0) thickness has to be used at the end node of this segment.
- Multi-cell sections are not supported.
- For a closed section (single cell), nodes have to be defined in the counterclockwise direction.
- If the section includes a closed cell, the input process has to start with one of the cell segments.

Material Properties

EX      = Modulus of elasticity
KX      = Thermal conductivity
Chapter 4  Element Library

ALPX = Coefficient of thermal expansion
C = Specific heat
NUXY = Poisson's ratio
DENS = Density
DAMP = Material damping coefficient
ECONX = Electric conductivity (thermal analysis only)

Element Loadings
Uniform lateral pressure (in terms of force per unit length): offset effect is not considered.

- Thermal
- Gravitational
- Beam Loading

Output Results
Forces, moments, and stresses are available in the element coordinate system shown in Figure 4-8.

Figure 4-5. 3D Symmetric Elastic Beam

XYZ: Global Cartesian Coordinate System
xyz: Element Coordinate System
1 2 3 4: Face numbers for pressure application
Figure 4-5. 3D Symmetric Elastic Beam (Continued)

(b) Alignment Definition Using an Orientation Angle

(c) Element y-axis is Parallel to Global X-Y Plane if Angle = 0° (K is omitted)

Figure 4-6. 3D Unsymmetric Elastic Beam

CG: Center of gravity (Centroid) of cross section
SC: Shear center of cross section
I: Nodal point
SP: Point at which the stress is required

y and z axes define the element coordinate system. The positive values are in the direction of the arrows.
Figure 4-7. J and CTOR for Some Beam Cross-Sections

<table>
<thead>
<tr>
<th>Cross-Section</th>
<th>CTOR and J</th>
<th>Shear Factor</th>
</tr>
</thead>
</table>
| \[
\text{CTOR} = r ; J = Ip = \frac{\pi r^4}{2} \\
\text{CTOR} = r ; J = Ip = Iyy + Izz \\
\text{CTOR} = \frac{(3a + 1.8b)}{8a^2 b^2} \cdot J
\] | \[
\frac{9}{10} = 0.90 \\
\frac{1}{2} = 0.50 \\
\frac{5}{6} = 0.8333
\] | Where: \[
J = a b^3 \left[ \frac{16}{3} - 3.36 \frac{b}{a} \left( 1 - \frac{b}{12a^2} \right) \right]
\] |

Figure 4-8. Directions of Forces and Moments for 3D Elastic Beam
Figure 4-9. Identification Parameters of the Built-In BEAM3D Section Library (viewed by looking into the negative x-direction)

- **Type 1** (Rectangular)
- **Type 2** (Solid Circular)
- **Type 3** (Circular Hollow)
- **Type 4** (Hollow Rectangular)
- **Type 5** (Symmetric I)
- **Type 6** (Trapezoidal Solid)
- **Type 7** (Channel)
- **Type 8** (Z)
- **Type 9** (T)
- **Type 10** (L)
- **Type 0** (User Defined Thin-Walled)
Figure 4-10. Examples for the User-Defined Section

<table>
<thead>
<tr>
<th>Input</th>
<th>Cross Section</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>Thickness</td>
<td>Segments</td>
</tr>
<tr>
<td>1</td>
<td>0.0</td>
<td>1, 2</td>
</tr>
<tr>
<td>2</td>
<td>t_1</td>
<td>1, 2, 1_1</td>
</tr>
<tr>
<td>3</td>
<td>t_2</td>
<td>2, 3, 1_2</td>
</tr>
<tr>
<td>4</td>
<td>0.0</td>
<td>3, 4, 1_3</td>
</tr>
<tr>
<td>5</td>
<td>t_3</td>
<td>4, 5, 1_4</td>
</tr>
<tr>
<td>6</td>
<td>t_4</td>
<td>5, 6, 1_5</td>
</tr>
<tr>
<td>7</td>
<td>t_5</td>
<td>6, 7, 1_6</td>
</tr>
<tr>
<td>8</td>
<td>0.0</td>
<td>i-Section</td>
</tr>
<tr>
<td>9</td>
<td>t_6</td>
<td>Closed Section</td>
</tr>
</tbody>
</table>

References
**Linear Structural Elastic Straight Pipe Element (PIPE)**

**General Description**
PIPE is a 2-node uniaxial element for three-dimensional structural models. Six degrees of freedom (three translations and three rotations) are considered per node. The element can be regarded as a special case of the 3D ELASTIC BEAM for which input requirements are reduced due to the tubular cross section geometry.

**Special Features**
Buckling, Inplane loading.

**Default Element Coordinate System (ECS = -1)**
The nodal input pattern is shown in Figure 4-11. The element x-axis is defined by a vector that starts at the first node (I) and points towards the second node (J). The element’s y axis is created parallel to the line resulting from intersecting the global X-Y plane with a plane normal to the element’s x axis. If these two planes are parallel to each other, the element’s y axis is created parallel to the global Y-axis. The element’s z-axis completes a right-handed Cartesian coordinate system.

**Element Group Options**
*(None)*

**Real Constants**
\[ r1 = \text{Outer diameter} \]
\[ r2 = \text{Wall thickness} \]
\[ r3 = \text{Internal pressure} \]

**Material Properties**
\[ EX = \text{Modulus of elasticity} \]
\[ ALPX = \text{Coefficient of thermal expansion} \]
\[ NUXY = \text{Poisson's ratio} \]
\[ DENS = \text{Density} \]
\[ DAMP = \text{Material damping coefficient} \]
Chapter 4  Element Library

Element Loadings
- Thermal
- Internal pressure
- Gravitational

Output Results
Forces and stresses are available in the element coordinate system. The direction of forces are similar to those of the 3D BEAM element shown in Figure 4-8.

Figure 4-11 Elastic Straight Pipe
Chapter 4   Element Library

Reference
Chapter 4 Element Library

Linear Structural Elastic Curved Pipe Element (ELBOW)

General Description
ELBOW is a 3-node uniaxial circular pipe element for three-dimensional structural models. The third node is needed to establish the center of curvature of the element. Six degrees of freedom (three translations and three rotations) per node are considered at the two end nodes.

Special Features
The ASME flexibility factor is applied in the element stiffness formulation.

Default Element Coordinate System (ECS = -1)
The nodal input pattern for this element is shown in Figure 4-12. The element y-axis goes from each end node to the third node (normal to the longitudinal axis of the elbow). The element x-axis is perpendicular to the y-axis and lies in the plane formed by the three nodes (tangent to the elbow axis at each node). The positive direction of the x-axis goes from the first to the second node. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options
(None)

Real Constants
r1 = Outer diameter
r2 = Wall thickness
r3 = Internal pressure
r4 = Radius of curvature

Material Properties
EX = Modulus of elasticity
ALPX = Coefficient of thermal expansion
NUX = Poisson's ratio
DENS = Density
DAMP = Material damping coefficient
Chapter 4  Element Library

Element Loadings

- Thermal
- Gravitational
- Internal pressure

Output Results

Forces, moments, and stresses are available in the element coordinate system at end nodes.

Figure 4-12. Elastic Elbow Element

References


General Description
PLANE2D is a 4- to 8-node two dimensional element for plane stress, plane strain, or axisymmetric (body of revolution) for structural and thermal problems. When used for structural problems, the element supports axisymmetric geometry with nonsymmetric (asymmetric) loading.

All elements have to be defined in the global X-Y plane (default) or the x-y plane of the Cartesian coordinate system specified by the CSREF command (Geometry > Coordinate_Systems> Reference for 2D Model). Axisymmetric structures have to be modeled in the positive x half plane, in which x represents the radial direction and y refers to the axis of symmetry for axisymmetric structures.

Results of axisymmetric models with asymmetric loading is available in 3D based on entries specified in the A_ASYM command (Analysis, STATIC, Asymmetric Load Options).

In general, two translational degrees of freedom (UX and UY) per node are considered for structural analysis. In the case of axisymmetric structures with asymmetric loading conditions or frequency and buckling analysis of axisymmetric structures for different circumferential harmonic numbers, an additional translational degree of freedom along the Z-axis to account for asymmetric conditions and modes is required. One degree of freedom, representing temperature, is used for the thermal problems.

The nodal input pattern is shown in Figure 4-13 for an 8-node element illustrating its local node numbering. The element however can be used with 4- to 8-nodes by assigning zeros (0) at the locations of missing nodes. Triangular shaped elements can also be considered. In this case, the third and fourth nodes (in case of 4-node elements) and the third, fourth and seventh nodes (in case of 5- to 8-node elements) will be assigned the same global node number, as shown in Figure 4-13. Both clockwise and counter-clockwise node numbering are allowed.

Special Features
Buckling, Inplane loading, Fluid-solid interaction, Adaptive P-Method for the 8-node structural elements with axisymmetric loading (polynomial order up to 10).
Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second, and the element y-axis is normal to the x-axis toward the fourth node.

Element Group Options

Op. 1: Solid/Fluid flag
- 0; Solid (regular structural or thermal element)
- 1; 4-Node Fluid (incompressible fluid element)

For structural or thermal elements (Op. 1 = 0), the other options are:

Op. 2: Integration Type (See Note 1)
- 0; Reduced integration
- 1; QM6 incompatible element; full integration for 8-node elements (default)
- 2; Full integration
- 3; U/P Method (unrelated option to this type of analysis)

Op. 3: Type
- 0; Plane Stress (default)
- 1; Axisymmetric (a one radian sector is considered, and hence, forces should be applied based on one radian)
- 2; Plane Strain
- 3; Axisymmetric structure with non-symmetric loading

Op. 4: Stress Direction
- 0; stresses are calculated in global Cartesian coordinate system
- 1; stresses are calculated in the defined local element coordinate system

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small)

Op. 7: Material Creep. Use default value (material Creep is not considered)

Op. 8: Strain plasticity. Use default value (0: Small plasticity)

For fluid elements (Op. 1 = 1), the other options are:

Op. 2: Unused option

Op. 3: 2D Type
- 1; Axisymmetric with symmetric loading
- 2; Plane Strain (default)

Op. 4 to Op. 8: Unused options for this element
Chapter 4   Element Library

Real Constants
r1 = Thickness (only for plane stress analysis)
r2 = Material angle (Beta)
The material angle is measured with respect to the element coordinate system as specified by the ECS attribute of each element.

Material Properties
For structural or thermal elements (Op. 1 = 0)
(See Figure 4-13 for material directions)

EX  = Modulus of elasticity in the first material direction
EY  = Modulus of elasticity in the second material direction
KX  = Thermal conductivity in the first material direction
KY  = Thermal conductivity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
C   = Specific heat
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
GXY  = Shear modulus relating the first and second material directions
DENS = Density
DAMP = Material damping coefficient
ECONX = Electrical conductivity in the first material direction (thermal analysis only)
ECONY = Electrical conductivity in the second material direction (thermal analysis only)

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:
1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.
4. Thermal conductivity in two directions are defined and are unequal.

The following condition has to be satisfied for proper representation of orthotropic properties in the $i^{th}$ and $j^{th}$ material directions: $\nu_{ij}/E_i = \nu_{ji}/E_j$
Element Loadings

- Thermal
- Gravitational
- Pressure (applied normal to element faces)

Output Results

Stress components including the von Mises stress are available at all nodes and the center of the element in either global or element coordinate directions.

Principal stresses may also be optionally requested at the element center.

For the fluid option, pressure is printed at the center of each element.

Note on Numerical Integration

Option 2 defines the numerical integration scheme which may be specified as one of the following options:

1. Reduced Integration
   For 4-node elements:
   - 2 x 2 Gauss integration for bending terms
   - 1 x 1 Gauss integration for shear terms
   Overcomes parasitic shear effects; handles nearly incompressible materials; not available for orthotropic models.
   For 8-node elements:
   - 2 x 2 Gauss integration for bending terms
   - 2 x 2 Gauss integration for shear terms

2. QM6 (Available for 4-node elements only)
   - 2 x 2 Gauss integration for all terms including the effect of bubble functions which introduce additional internal degrees of freedom.
   Overcomes parasitic shear effects, handles nearly incompressible materials, in general more stable with better accuracy, but more costly in terms of
Chapter 4   Element Library

solution time.

3. Full Integration

For 4-node elements:
   2 x 2 Gauss integration for all terms.
   Fastest and simplest solution option, does not overcome parasitic shear
effects.

For 8-node elements:
   3 x 3 Gauss integration for all terms.
   This option should not be used for 8-node elements if the value of the
   Poisson's ratio is greater than 0.48. For this special case reduced
   integration should be used instead.

Figure 4-13. Quadrilateral 2D Element

References

   Program for Static and Dynamic Response of Nonlinear Systems,” SESM
Chapter 4  Element Library

Thermal and Linear Structural 2D 3- to 6-Node Triangular Plane Stress, Plane Strain, and Body of Revolution Element (TRIANG)

General Description
TRIANG is a 3- to 6-node triangular, two-dimensional element for plane stress, plane strain, or axisymmetric structural and thermal models. All elements have to be defined in the global X-Y plane (default) or the x-y plane of the Cartesian coordinate system specified by the \texttt{CSREF} command (Geometry \textgreater{} Coordinate Systems> Reference for 2D Model). Axisymmetric structures have to be modeled in the positive x half plane, in which x represents the radial direction and y refers to the axis of symmetry for axisymmetric structures. Only two translational degrees of freedom (UX and UY) per node are considered for structural analysis. One degree of freedom per node, representing temperature, is used for the thermal module.

The nodal input pattern for this element is shown in Figure 4-14. Both clockwise and counter-clockwise node numbering are allowed. For transitional elements, missing nodes are issued zeros (0) at their location during the element connectivity definition.

Special Features
Buckling, Inplane loading, Adaptive P- and HP-methods for the 6-node structural elements (polynomial degrees up to 10), Adaptive H-method.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis is normal to the x-axis toward the third node.

Element Group Options
\textbf{Op. 1:} Unused option for this element
\textbf{Op. 2:} Integration Type (See Figure 4-15)
= 0; 1-point integration
= 1; 3-point integration
\textbf{Op. 3:} 2D-Type
= 0; Plane Stress (default)
= 1; Axisymmetric
= 2; Plane Strain
Op. 4: Stress Direction (in the output file)
  = 0; stresses are calculated in the global Cartesian coordinate system (default)
  = 1; stresses are calculated in the defined element local coordinate system.
  \( \text{If ECS} = -1, \text{ stresses and strains are calculated in the global coordinate system.} \)

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: small)

Op. 7: Material Creep. Use default value (material creep is not considered)

Op. 8: Strain Plasticity. Use default value (0: Small)

Real Constants

- \( r_1 \) = Thickness (only for plane stress analysis)
- \( r_2 \) = Material angle (Beta)

  The material angle is measured with respect to the element coordinate system as specified by the ECS attribute of each element.

Material Properties

(See Figure 4-14 for material directions)

- \( EX \) = Modulus of elasticity in the first material direction
- \( EY \) = Modulus of elasticity in the second material direction
- \( KX \) = Thermal conductivity in the first material direction
- \( KY \) = Thermal conductivity in the second material direction
- \( GXY \) = Shear modulus relating the first and second material directions
- \( NUXY \) = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
- \( C \) = Specific heat
- \( ALPX \) = Coefficient of thermal expansion in the first material direction
- \( ALPY \) = Coefficient of thermal expansion in the second material direction
- \( DENS \) = Density
- \( DAMP \) = Material damping coefficient
- \( ECONX \) = Electric conductivity in the first material direction (thermal analysis only)
- \( ECONY \) = Electric conductivity in the second material direction (thermal analysis only)
Chapter 4   Element Library

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.
4. Thermal conductivity in two directions are defined and are unequal.

The following condition has to be satisfied for proper representation of orthotropic properties in the $i^{th}$ and $j^{th}$ material directions:

$\frac{\nu_{ij}}{E_i} = \frac{\nu_{ji}}{E_j}$

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.

Element Loadings

- Thermal
- Gravitational
- Pressure (applied normal to element faces)

Output Results

Stress components in the global or local coordinate systems and von Mises stress are available at all nodes and the center of the element.

Principal stresses may also be optionally requested at the element center.
Figure 4-14. 2D Triangular Element

XY: Global Cartesian Coordinate System
xy: Element Coordinate System
a: First material direction
b: Second material direction
1 2 3 4: Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)

If ECS = -1, the x axis of the element is the vector from node 1 to node 2 in the element connectivity.
Note on Numerical Integration

Option 2 defines the integration scheme where one or three points may be used as shown in Figure 4-15:

Reference

Thermal and Linear Structural 3D 8- to 20-Node Isoparametric Solid Element (SOLID)

General Description
SOLID is an 8- to 20-node three dimensional element for the analysis of structural and thermal problems. Three translational degrees of freedom per node are considered for structural analysis. Only one degree of freedom per node, representing the temperature, is used for the thermal module.

The nodal input pattern is shown in Figure 4-16 for the local node numbering of a 20-node element. Both clockwise and counter-clockwise node numbering are allowed. Transitional elements can be considered by issuing zeros (0) at the location of missing nodes during the element connectivity definition. Prism and tetrahedron-shaped elements may be considered only with the 8-node element option. Prism-shaped elements may be formed by duplicating nodes (3 and 4) and (7 and 8). Pyramid elements are obtained if nodes 5, 6, 7 and 8 have the same global node number. Figure 4-17 illustrates the latter two element shapes.

Special Features
Buckling, Geometric Stiffness consideration (inplane loading flag), Fluid-solid interaction.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 4. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options

Op. 1: Solid/Fluid flag
  = 0; Solid (solid element)
  = 1; 8-Node Fluid (8-node incompressible fluid element)

For solid elements (Op. 1 = 0)

Op. 2: Integration Type (see Note for PLANE2D element)
  = 0; Reduced integration (Displacement-based formulation): only for isotropic materials
Chapter 4  Element Library

(2 x 2 x 2 integration points for bending terms and 1 integration point for shear terms for 8-node elements)
(2 x 2 x 2 integration points for 9- to 20-node elements)

= 1; 8-node hybrid element: Displacement and stress-based (Mixed) formulation (default)
(2 x 2 x 2 integration points)

= 2; full integration (Displacement-based formulation)
(2 x 2 x 2 integration points for 8-node elements)
(3 x 3 x 3 integration points for 9- to 20-node elements)

= 3; U/P method (unrelated option to this type of analysis)

Op. 3: Unused option for this element

Op. 4: Stress Direction
= 0; stresses are calculated in the global Cartesian coordinate system
= 1; stresses are calculated in the defined element local coordinate system

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small)

Op. 7: Material Creep. Use default value (material creep is not considered)

Op. 8: Strain plasticity. Use default value (0: Small)

For fluid elements: (Op. 1 = 1)

Op. 2 to Op. 8: Unused options for this element

Real Constants

Nine constants have to be defined in case of using orthotropic or anisotropic models. The nine values are used to determine the coordinates of three points (1’, 2’, 3’) to define the material coordinate system. The first direction of the material coordinate system, denoted by “a” in Figure 4-16, is defined by a vector connecting point 1’ to point 2’. The b-axis (second material direction) lies in the plane of the three defined points and goes from a-axis toward the third point. The c-axis (third material direction) completes a right-hand Cartesian coordinate system. The above material directions are defined with respect to the defined element coordinate system as specified by the active ECS.

r1 = x-coordinate of point 1’
r2 = y-coordinate of point 1’
r3 = z-coordinate of point 1’
r4 = x-coordinate of point 2’
r5 = y-coordinate of point 2’
r6 = z-coordinate of point 2’
r7 = x-coordinate of point 3’
r8 = y-coordinate of point 3’
r9 = z-coordinate of point 3’

The real constants are interpreted based on the element coordinate system (ECS).

Material Properties

1. Isotropic and Orthotropic Materials (See Figure 4-16 for material directions)
   EX = Modulus of elasticity in the first material direction
   EY = Modulus of elasticity in the second material direction
   EZ = Modulus of elasticity in the third material direction
   KX = Thermal conductivity in the first material direction
   KY = Thermal conductivity in the second material direction
   KZ = Thermal conductivity in the third material direction
   C = Specific heat
   NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
   NUYZ = Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the second direction)
   NUXZ = Poisson's ratio relating the first and third material directions (strain in the third direction due to unit strain along the first direction)
   ALPX = Coefficient of thermal expansion in the first material direction
   ALPY = Coefficient of thermal expansion in the second material direction
   ALPZ = Coefficient of thermal expansion in the third material direction
   DENS = Density
   GXY = Shear modulus relating the first and second material directions
   GYZ = Shear modulus relating the second and third material directions
   GXZ = Shear modulus relating the first and third material directions
   DAMP = Material damping coefficient
   ECONX = Electric conductivity in the first material direction (thermal analysis only)
   ECONY = Electric conductivity in the second material direction (thermal analysis only)
Chapter 4  Element Library

ECONZ  =  Electric conductivity in the third material direction (thermal analysis only)

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in at least two directions are defined and are unequal.
2. Poisson's ratio in at least two planes are defined and are unequal.
3. Thermal coefficients in at least two directions are defined and are unequal.
4. Thermal conductivity in at least two directions are defined and are unequal.
5. The anisotropic material matrix is defined (MC11, MC12,..., MC66).

The following condition must be met for proper representation of orthotropic properties in the i\textsuperscript{th} and j\textsuperscript{th} material directions:

$$\frac{\nu_{ij}}{E_i} = \frac{\nu_{ji}}{E_j}$$

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.

6. General Anisotropic Material

MC11, MC12,..., MC66 (Total of 21 entries) to define either the anisotropic material stiffness or compliance matrix in the material coordinate system:

\[
\begin{bmatrix}
MC11 & MC12 & MC13 & MC14 & MC15 & MC16 \\
MC22 & MC23 & MC24 & MC25 & MC26 \\
MC33 & MC34 & MC35 & MC36 \\
MC44 & MC45 & MC46 \\
MC55 & MC56 \\
Sym. & & & & & MC66
\end{bmatrix}
\]

The 21 material properties can be used also to define isotropic and orthotropic material properties.

It should be noted that the anisotropic material matrix elements overrides any other defined (related) material properties.

For fluid elements (Op. No. 1 = 1)

EX  =  Fluid elastic (bulk) modules
GXY  = 10\textsuperscript{-9} EX (an arbitrary small number to provide some shear rigidity)
Element Loadings

- Thermal
- Gravitational
- Pressure (applied normal to element faces):

The direction of the applied pressure on the six faces of the 3D solid element is controlled by the order in which the element is labeled. The first four node labels define face 5. Looking from outside of the element to face 5, if the face is labeled in the counter-clockwise direction, positive pressure value simply inward loading to this face as well as the other five. Conversely, if face 5 is labeled in the clockwise direction, positive pressure to any of the faces implies outward loading.

Output Results

Stress components in either the global or element coordinate directions including the von Mises stress are available at all nodes and the center of the element. The directions of the stress components are shown in Figure 4-18.

Principal stresses may also be optionally requested at the element center.

Figure 4-16. 3D Isoparametric Solid
Chapter 4  Element Library

Figure 4-17. 3D 8-Node Solid

Figure 4-18. 3D Isoparametric Solid

References
**Thermal and Linear Structural Composite 3D 8-Node Solid Element (SOLIDL)**

**General Description**

SOLIDL is an 8-node multi-layer three-dimensional solid element for thermal structural models. The element may have up to 25 layers with uniform or nonuniform thicknesses. Each layer may have a different isotropic or orthotropic material. Anisotropic material properties are also considered.

For thermal analysis, one degree of freedom per node is considered. For structural models, three translational degrees of freedom are considered per node. The nodal input pattern for this element is shown in Figure 4-19. The material directions are based on the element coordinate system (EC) attribute which can be obtained by listing the elements or changed using the `EPROPCHANGE (Propsets, Change El-Prop)` command.

**Special Features**

Nearly incompressible materials (with Poisson's ratio close to 0.499) can be handled by this element without any special treatment.

**Default Element Coordinate System (ECS = -1)**

The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 4. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

**Op. 1:** Integration Type
- 0: Hybrid: Displacement and stress-based (Mixed) formulation (default)
- 1: Full: Displacement-based formulation
  (Both options use 2 x 2 x 2 integration points)

**Op. 2:** Number of Layers
Number of layers in the element (1 to 25)

**Op. 3:** Stress Direction
- 0: calculate stresses in the global Cartesian system (default)
- 2: calculate stresses in the material directions (see Real Constants)

*Entering 1 for the stress direction is similar to entering 2.*

**Op. 4:** Layer to print stresses
Chapter 4  Element Library

= NL; layer number for which stresses will be written in the plot file
= 0; stresses on nodes (1 to 4) and nodes (5 to 8) are calculated based on the bottom layer (layer 1) and the top layer (layer NLAYERS), respectively.
(default)

Op. 5 to Op. 8: Unused options for this element.

Real Constants

The first two constants are input-type flags. The rest of constants define layer thicknesses and material properties.

If the default coordinate system is used (EC=-1), the first material direction, denoted by (a) as shown in Figure 4-19, is obtained by rotating the line connecting nodes (1 and 2) by an angle ($\phi$) counter-clockwise relative to the plane formed by nodes (1, 2 and 3). The second material direction (b) lies in a plane parallel to the plane defined by (1, 2 and 3) perpendicular to (a) toward node 4. The third material direction (c) completes a right-hand Cartesian coordinate system. If EC is set to some other coordinate system, then the material directions are defined based on it.

r1 = Thickness flag
  = 0; input real layer thickness (default)
  = 1; input layer thickness ratio

r2 = Symmetry flag
  = 0; input every layer (default, must be used if the number of layers is odd)
  = 1; symmetric input information regarding only half of the total number of layers need to be specified (See Figure 4-21)
  = 2; antisymmetric input information regarding only half of the total number of layers need to be specified (See Figure 4-21)

For Layer No. 1 (See Figure 4-18 for the element sides)

r3 = Material number for layer 1
r4 = Material angle for layer 1
r5 = Thickness (or thickness ratio) of layer 1 along side 1-5
r6 = Thickness (or thickness ratio) of layer 1 along side 2-6 (default is r5)
r7 = Thickness (or thickness ratio) of layer 1 along side 3-7 (default is r6)
r8 = Thickness (or thickness ratio) of layer 1 along side 4-8 (default is r7)
For Layer No. NL

r[6(NL-1)+3] = Material number for layer NL
r[6(NL-1)+4] = Material angle for layer NL
r[6(NL-1)+5] = Thickness (or thickness ratio) of layer NL along side 1-5
r[6(NL-1)+6] = Thickness (or thickness ratio) of layer NL along side 2-6
(default is r[6(NL-1)+5])
r[6(NL-1)+7] = Thickness (or thickness ratio) of layer NL along side 3-7
(default is r[6(NL-1)+6])
r[6(NL-1)+8] = Thickness (or thickness ratio) of layer NL along side 4-8
(default is r[6(NL-1)+7])

Material Properties

(See Figure 4-17 for material directions)

EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
EZ = Modulus of elasticity in the third material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
NUYZ = Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the second direction)
NUXZ = Poisson's ratio relating the first and third material directions (strain in the third direction due to unit strain along the first direction)
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
ALPZ = Coefficient of thermal expansion in the third material direction
GXY = Shear modulus relating the first and second material directions
GXZ = Shear modulus relating the second and third material directions
GYZ = Shear modulus relating the first and third material directions
DENS = Density
DAMP = Material damping coefficient
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
KZ = Thermal conductivity in the third material direction
C = Specific heat
Element Loadings

- Thermal
- Gravitational
- Pressure (applied normal to element faces)

Output Results

Stress components are available in the global Cartesian coordinate directions at the center of each layer. Additional global stresses are printed out at the eight corners of each layer.

For plots, element stress plots show the stresses at the center of any requested layer, whereas nodal stresses show the stresses at the 8 corners of the requested layer. If no layer is requested, stresses at nodes (1 to 4) and nodes (5 to 8) take the corner stresses of layer 1 and layer NL respectively.

Figure 4-19. Composite Solid Element
Example of 8 symmetric and antisymmetric layer input. (In both cases, properties of only layer 1 through layer 4 need to be defined.)
Chapter 4  Element Library

References

Linear Structural 3D 8- to 20-Node Isoparametric Piezoelectric Solid Element (SOLIDPZ)

General Description
SOLIDPZ is an 8- to 20-node three dimensional solid element for the analysis of structural models. The element has three translational degrees of freedom and an electric potential as a fourth degree of freedom per node. The rotation about x-axis represents the electric potential.

The nodal input pattern is similar to that of SOLID element, shown in Figure 4-16, for the 20-node element. Both clockwise and counter-clockwise node numbering are allowed. Transitional elements can be considered by issuing zeros (0) at the location of missing nodes during the element connectivity definition. Prism and tetrahedron-shaped elements may be considered only with the 8-node element option. Prism-shaped elements may be formed by duplicating nodes (3 and 4) and (7 and 8). Pyramid elements are obtained if nodes 5, 6, 7 and 8 have the same global node number. Figure 4-17 illustrates the latter two element shapes.

Special Features
Mode shapes calculation.

Default Element Coordinate System (ECS = -1):
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 4. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options
Op. 2: Integration Type (see Note for PLANE2D element)
  = 0; Reduced integration (only for isotropic materials)
    (2 x 2 x 2 integration points for bending terms and 1 point for shear terms for 8-node elements)
    (2 x 2 x 2 integration points for 9- to 20-node elements)
  = 2; Full integration
    (2 x 2 x 2 integration points for 8-node elements)
    (3 x 3 x 3 integration points for 9- to 20-node elements)
Op. 3: Unused option for this element
Chapter 4  Element Library

Op. 4: Stress Direction
  = 0; stresses calculated in the global Cartesian coordinate system
  = 1; stresses calculated in the defined element local coordinate system

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small)

Op. 7: Material Creep. Use default value (material creep is not considered)

Op. 8: Strain plasticity. Use default value (0: Small)

Real Constants
Nine constants have to be defined in case of using orthotropic or anisotropic models. The nine values are used to determine the coordinates of three points (1’, 2’, 3’) to define the material coordinate system and accordingly the coordinate system for the piezoelectric and dielectric matrices. The first direction of the material coordinate system denoted by “a” in Figure 4-16, is defined by a vector connecting point 1’ to point 2’. The b-axis (second material direction) lies in the plane of the three defined points and goes from a-axis toward the third point. The c-axis (third material direction) completes a right-hand Cartesian coordinate system. The above material directions are defined with respect to the defined element coordinate system as specified by the active ECS.

\[
\begin{align*}
r_1 &= x\text{-coordinate of point 1’} \\
r_2 &= y\text{-coordinate of point 1’} \\
r_3 &= z\text{-coordinate of point 1’} \\
r_4 &= x\text{-coordinate of point 2’} \\
r_5 &= y\text{-coordinate of point 2’} \\
r_6 &= z\text{-coordinate of point 2’} \\
r_7 &= x\text{-coordinate of point 3’} \\
r_8 &= y\text{-coordinate of point 3’} \\
r_9 &= z\text{-coordinate of point 3’}
\end{align*}
\]

The real constants are interpreted based on the element coordinate system (ECS)

Material Properties
1. Isotropic and Orthotropic Materials (See Figure 4-16 for material directions)
   \[
   \begin{align*}
   EX &= \text{Modulus of elasticity in the first material direction} \\
   EY &= \text{Modulus of elasticity in the second material direction} \\
   EZ &= \text{Modulus of elasticity in the third material direction}
   \end{align*}
   \]
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
NUYZ = Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the second direction)
NUXZ = Poisson's ratio relating the first and third material directions (strain in the third direction due to unit strain along the first direction)
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
ALPZ = Coefficient of thermal expansion in the third material direction
DENS = Density
GXY = Shear modulus relating the first and second material directions
GYZ = Shear modulus relating the second and third material directions
GXZ = Shear modulus relating the first and third material directions
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
KZ = Thermal conductivity in the third material direction
ECONX = Electric conductivity in the first material direction
ECONY = Electric conductivity in the second material direction
ECONZ = Electric conductivity in the third material direction
DAMP = Material damping coefficient

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in at least two directions are defined and are unequal.
2. Poisson's ratio in at least two planes are defined and are unequal.
3. Thermal coefficients in at least two directions are defined and are unequal.
4. The anisotropic material matrix is defined (MC11, MC12,..., MC66 material properties).

The following conditions must be met for proper representation of orthotropic properties in the $i^{th}$ and $j^{th}$ material directions: $\nu_{ij}/E_i = \nu_{ji}/E_j$

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.

5. General Anisotropic Material:
Chapter 4   Element Library

MC11, MC12,....., MC66 (Total of 21 entries) to define either the anisotropic material stiffness or compliance matrix in the material coordinate system:

\[
\begin{align*}
MC_{11} & \quad MC_{12} & \quad MC_{13} & \quad MC_{14} & \quad MC_{15} & \quad MC_{16} \\
MC_{22} & \quad MC_{23} & \quad MC_{24} & \quad MC_{25} & \quad MC_{26} \\
MC_{33} & \quad MC_{34} & \quad MC_{35} & \quad MC_{36} \\
MC_{44} & \quad MC_{45} & \quad MC_{46} \\
MC_{55} & \quad MC_{56} \\
\text{Sym.} & & & & & MC_{66}
\end{align*}
\]

The 21 material properties can be used also to define isotropic and orthotropic material properties.

It should be noted that the anisotropic material matrix elements overrides any other defined (related) material properties.

PC11, PC12,....., PC63 (Total of 18 entries) to define the Piezoelectric material matrix in the material coordinate system:

\[
\begin{align*}
PC_{11} & \quad PC_{12} & \quad PC_{13} \\
PC_{21} & \quad PC_{22} & \quad PC_{23} \\
PC_{31} & \quad PC_{32} & \quad PC_{33} \\
PC_{41} & \quad PC_{42} & \quad PC_{43} \\
PC_{51} & \quad PC_{52} & \quad PC_{53} \\
PC_{61} & \quad PC_{62} & \quad PC_{63}
\end{align*}
\]

DC11, DC12,....., DC33 (Total of 6 entries) to define the Dielectric material matrix in the material coordinate system:

\[
\begin{align*}
DC_{11} & \quad DC_{12} & \quad DC_{13} \\
DC_{22} & \quad DC_{23} \\
\text{Sym.} & & \quad DC_{33}
\end{align*}
\]

Element Loadings

(None)

Output Results

Mode shapes and the corresponding natural frequencies are available.

References

Chapter 4  Element Library

*Thermal and Linear Structural 3D 4- or 10-Node Tetrahedron Solid Element (TETRA4 or TETRA10)*

**General Description**

TETRA4 is a 4-node and TETRA10 is a 10-node three dimensional tetrahedral solid element for structural and thermal problems. Three translational degrees of freedom per node are considered for structural analysis. Only one degree of freedom per node, representing the temperature, is used for the thermal module.

The nodal input pattern for this element is shown in Figures 4-22 and 4-23. Both clockwise and counter-clockwise node numbering are allowed. All midside nodes should fall within the middle third of the element edges.

**Special Features**

Buckling, Geometric stiffness consideration (inplane loading flag), Adaptive P-Method (polynomial degrees up to 4).

**Default Element Coordinate System (ECS = -1)**

The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 3. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

- **Op. 1**: Unrelated option to this type of analysis (use default value)
- **Op. 2**: Unrelated option to this type of analysis (use default value)
- **Op. 3**: Unrelated option to this type of analysis (use default value)
- **Op. 4**: Stress Direction (in the output file)
  - = 0; stresses are calculated in the global coordinate system
  - = 1; stresses are calculated in the defined local coordinate system

  If ECS = -1, stresses and strains are calculated in the global coordinate system.

- **Op. 5**: Material Type. Use the default value (0: Linear Elastic)
- **Op. 6**: Displacement Formulation. Use the default value (0: Small)
- **Op. 7**: Material Creep. Use the default value (material creep is not considered)
- **Op. 8**: Strain plasticity. Use default value (0: Small)
Chapter 4  Element Library

Real Constants

Nine constants have to be defined in case of using orthotropic or anisotropic models. The nine values are used to determine the coordinates of three points (1’, 2’, 3’) to define the material coordinate system. The first direction of the material coordinate system, denoted by “a” in Figure 4-22, is defined by a vector connecting point 1’ to point 2’. The b-axis (second material direction) lies in the plane of the three defined points and goes from a-axis toward the third point. The c-axis (third material direction) completes a right-hand Cartesian coordinate system. The above material directions can be defined with respect to the defined element coordinate system as specified by the active ECS.

\[ r_1 = \text{x-coordinate of point 1'} \]
\[ r_2 = \text{y-coordinate of point 1'} \]
\[ r_3 = \text{z-coordinate of point 1'} \]
\[ r_4 = \text{x-coordinate of point 2'} \]
\[ r_5 = \text{y-coordinate of point 2'} \]
\[ r_6 = \text{z-coordinate of point 2'} \]
\[ r_7 = \text{x-coordinate of point 3'} \]
\[ r_8 = \text{y-coordinate of point 3'} \]
\[ r_9 = \text{z-coordinate of point 3'} \]

The real constants are interpreted based on the element coordinate system (ECS).

Material Properties

1. Isotropic and Orthotropic Materials *(See Figure 4-22 for material directions)*

\[ EX = \text{Modulus of elasticity in the first material direction} \]
\[ EY = \text{Modulus of elasticity in the second material direction} \]
\[ EZ = \text{Modulus of elasticity in the third material direction} \]
\[ KX = \text{Thermal conductivity in the first material direction} \]
\[ KY = \text{Thermal conductivity in the second material direction} \]
\[ KZ = \text{Thermal conductivity in the third material direction} \]
\[ NUXY = \text{Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)} \]
\[ NUYZ = \text{Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the second direction)} \]
\[ NUXZ = \text{Poisson's ratio relating the first and third material directions (strain} \]
in the third direction due to unit strain along the first direction

**ALPX** = Coefficient of thermal expansion in the 1st material direction
**ALPY** = Coefficient of thermal expansion in the second material direction
**ALPZ** = Coefficient of thermal expansion in the third material direction
**C** = Specific heat
**DENS** = Density
**GXY** = Shear modulus relating the 1st and second material directions
**GYZ** = Shear modulus relating the second and third material directions
**GXZ** = Shear modulus relating the 1st and third material directions
**DAMP** = Material damping coefficient
**ECONX** = Electric conductivity in the first material direction (thermal analysis only)
**ECONY** = Electric conductivity in the second material direction (thermal analysis only)
**ECONZ** = Electric conductivity in the third material direction (thermal analysis only)
**DAMP** = Material damping coefficient

6. General Anisotropic Material

MC11, MC12,……, MC66 (Total of 21 entries) to define either the anisotropic material stiffness or compliance matrix in the material coordinate system:

\[
\begin{bmatrix}
MC11 & MC12 & MC13 & MC14 & MC15 & MC16 \\
MC22 & MC23 & MC24 & MC25 & MC26 \\
MC33 & MC34 & MC35 & MC36 \\
\end{bmatrix}
\]
Chapter 4   Element Library

The 21 material properties can be used also to define isotropic and orthotropic material properties.
It should be noted that the anisotropic material matrix elements overrides any other defined (related) material properties.

Element Loadings

• Thermal
• Gravitational
• Pressure

Output Results

Stress components in the global or local coordinate directions including the von Mises stress are available at the center and at the nodes of the element. Principal stresses may also be optionally requested at the element center.

Figure 4-22. 4-Node Tetrahedron Element
Figure 4-23. 10-Node Tetrahedron Element

References
Chapter 4  Element Library

Linear Structural 3D 4-Node Tetrahedron Solid with Rotation Element (TETRA4R)

General Description
TETRA4R is a 4-node three-dimensional tetrahedral solid element for the analysis of structural models. Three translational and three rotational degrees of freedom are considered per node, allowing the element to be easily connected to BEAM3D and all SHELL elements.

The nodal input pattern for this element is shown in Figure 4-24. Both clockwise and counter-clockwise node numbering are allowed.

Special Features
Adaptive H-method.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 3. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options
Op. 1 to Op. 3: Unused options for this element
Op. 4: Stress Direction (in the output file)
  = 0; stresses are calculated in the global coordinate system
  = 1; stresses are calculated in the defined local coordinate system

  If ECS = -1, stresses and strains are calculated in the global coordinate system.

Op. 5 to Op. 8: Unused options for this element

Real Constants
Nine constants have to be defined in case of using orthotropic or anisotropic models. The nine values are used to determine the coordinates of three points (1’, 2’, 3’) to define the material coordinate system. The first direction of the material coordinate system, denoted by “a” in Figure 4-24, is defined by a vector connecting point 1’ to point 2’. The b-axis (second material direction) lies in the plane of the three defined points and goes from a-axis toward the third point. The c-axis (third material direction) completes a right-hand Cartesian coordinate system. The above material
directions can be defined with respect to the defined element coordinate system as specified by the active ECS.

\[ \begin{align*}
  r_1 &= \text{x-coordinate of point 1}' \\
  r_2 &= \text{y-coordinate of point 1}' \\
  r_3 &= \text{z-coordinate of point 1}' \\
  r_4 &= \text{x-coordinate of point 2}' \\
  r_5 &= \text{y-coordinate of point 2}' \\
  r_6 &= \text{z-coordinate of point 2}' \\
  r_7 &= \text{x-coordinate of point 3}' \\
  r_8 &= \text{y-coordinate of point 3}' \\
  r_9 &= \text{z-coordinate of point 3}' 
\end{align*} \]

The real constants are interpreted based on the element coordinate system (ECS).

Material Properties

1. Isotropic and Orthotropic Materials (*See Figure 4-24 for material directions*)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(E_x)</td>
<td>Modulus of elasticity in the first material direction</td>
</tr>
<tr>
<td>(E_y)</td>
<td>Modulus of elasticity in the second material direction</td>
</tr>
<tr>
<td>(E_z)</td>
<td>Modulus of elasticity in the third material direction</td>
</tr>
<tr>
<td>(k_x)</td>
<td>Thermal conductivity in the first material direction</td>
</tr>
<tr>
<td>(k_y)</td>
<td>Thermal conductivity in the second material direction</td>
</tr>
<tr>
<td>(k_z)</td>
<td>Thermal conductivity in the third material direction</td>
</tr>
<tr>
<td>(\nu_{xy})</td>
<td>Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)</td>
</tr>
<tr>
<td>(\nu_{yz})</td>
<td>Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the first direction)</td>
</tr>
<tr>
<td>(\nu_{xz})</td>
<td>Poisson's ratio relating the first and third material directions (strain in the third direction due to unit strain along the first direction)</td>
</tr>
<tr>
<td>(\alpha_{px})</td>
<td>Coefficient of thermal expansion in the first material direction</td>
</tr>
<tr>
<td>(\alpha_{py})</td>
<td>Coefficient of thermal expansion in the second material direction</td>
</tr>
<tr>
<td>(\alpha_{pz})</td>
<td>Coefficient of thermal expansion in the third material direction</td>
</tr>
<tr>
<td>(\rho)</td>
<td>Density</td>
</tr>
<tr>
<td>(c)</td>
<td>Specific heat</td>
</tr>
<tr>
<td>(G_{xy})</td>
<td>Shear modulus relating the first and second material directions</td>
</tr>
</tbody>
</table>
Chapter 4 Element Library

GYZ = Shear modulus relating the second and third material directions
GXZ = Shear modulus relating the first and third material directions
DAMP = Material damping coefficient
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)
ECONZ = Electric conductivity in the third material direction (thermal analysis only)

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:
1. Moduli of elasticities in at least two directions are defined and are unequal.
2. Poisson's ratio in at least two planes are defined and are unequal.
3. Thermal coefficients in at least two directions are defined and are unequal.
4. Thermal conductivity in at least two directions are defined and are unequal.
5. The anisotropic material matrix is defined (MC11, MC12,..., MC66 material properties).

The following conditions must be met for proper representation of orthotropic properties in the i\textsuperscript{th} and j\textsuperscript{th} material directions:
\[
\frac{v_{ij}}{E_i} = \frac{v_{ji}}{E_j}
\]
Where \( v_{ij}, E_i, \) and \( E_j \) are provided as input and \( v_{ji} \) calculated internally by the program.

6. General Anisotropic Material
MC11, MC12,...., MC66 (Total of 21 entries) to define either the anisotropic material stiffness or compliance matrix in the material coordinate system:

\[
\begin{align*}
MC11 & \quad MC12 & \quad MC13 & \quad MC14 & \quad MC15 & \quad MC16 \\
MC22 & \quad MC23 & \quad MC24 & \quad MC25 & \quad MC26 \\
MC33 & \quad MC34 & \quad MC35 & \quad MC36 \\
MC44 & \quad MC45 & \quad MC46 \\
MC55 & \quad MC56 \\
Sym. & \quad MC66
\end{align*}
\]

The 21 material properties can be used also to define isotropic and orthotropic material properties.
It should be noted that the anisotropic material matrix elements overrides any other defined (related) material properties.
Chapter 4  Element Library

Element Loadings
- Thermal
- Gravitational
- Pressure

Output Results
Stress components in the global or local coordinate directions including the von Mises stress are available at the center and at the nodes of the element. Principal stresses may also be optionally requested at the element center.

Figure 4-24. 4-Node Tetrahedron Element with Rotation

| XYZ: Global Cartesian Coordinate System |
| xyz:  Element Coordinate System         |
| a:  First material direction           |
| b:  Second material direction          |
| c:  Third material direction           |

Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)

References
Chapter 4  Element Library

Linear Structural Axisymmetric Shell Element
(SHELLAX)

General Description
The SHELLAX is a 2-node straight conical shell element with constant cross section for the analysis of axisymmetric structural models. The shell element is geometrically symmetric, but the loading could be either axisymmetric or non-axisymmetric. Also in the case of frequency and buckling analysis, the mode shapes can be either axisymmetric or non-axisymmetric. In the formulation, both bending and “inplane” or “membrane” forces are considered. The shear deformation, however, is neglected making the element suitable for thin shell problems.

Structures have to be modeled in the positive X half-plane, where X represents the radial direction and Y refers to the axis of axial symmetry.

In general, four degrees of freedom are considered per node: three translations along the global X, Y and Z axes and one rotation about the global Z-axis. For static analysis with axisymmetric loading, only three degrees of freedom are considered; these are: two translations along the X and Y axes and one rotation about the Z-axis. In the case of non-axisymmetric (asymmetric) loading, and frequency and buckling analyses, however, different circumferential harmonic numbers may require the translational degree of freedom along the Z-axis to account for asymmetric conditions and modes.

The element can be used for both isotropic and orthotropic material models.

Special Features
Buckling, Inplane loading.

Default Element Coordinate System (ECS = -1)
The nodal input pattern for this element is shown in Figure 4-25. For the element coordinate system, the x-axis goes from the first node to the second. The element y-axis is perpendicular to the x-axis, in the outward direction. The element z-axis (circumferential direction) is parallel to the global Z-axis and completes a right-hand Cartesian coordinate system.

Element Group Options
(None)

Real Constants
r1 = Shell thickness
Chapter 4   Element Library

Material Properties
EX = Modulus of elasticity in the meridian direction (element x-direction)
EY = Modulus of elasticity in the circumferential direction (global Z-direction)
NUXY = Poisson's ratio
DENS = Density
DAMP = Material damping coefficient.

Element Loadings
• Gravitational (in axial direction)
• Nodal loads per unit radian (both symmetric and asymmetric)
• Pressure (applied normal to element face) (both symmetric and asymmetric)

Output Results
Forces and moments per unit length are available for each element in the element coordinate system at the two end nodes as shown in Figure 4-25. The stress components are also calculated and printed in the element coordinate system at the center of the element.

Figure 4-25. Axisymmetric Shell

Reference
Chapter 4 Element Library

**Thermal and Linear Structural Triangular Thin Shell Element (SHELL3)**

**General Description**

SHELL3 is a 3-node triangular thin shell element with membrane and bending capabilities for the analysis of three dimensional structural and thermal models. The shear deformation effect is neglected for this element. Six degrees of freedom per node (three translations and three rotations) are considered for structural analysis. Only one degree of freedom per node, representing the temperature, is used for the thermal module. The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thick plates or shells, as determined by standard guidelines, SHELL3T is recommended. Both of SHELL3T and SHELL3 have identical inputs which permit exchanging one for the other by simply altering the element name.

**Special Features**

Buckling, Inplane loading, Adaptive H-method.

**Default Element Coordinate System (ECS = -1)**

The nodal input pattern for the element is shown in Figure 4-26. Both clockwise and counter-clockwise node numbering are allowed. For element coordinate system, the x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes, perpendicular to x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

**Other Element Coordinate Systems (ECS ≠ -1)**

When a defined element coordinate system (x\_e,y\_e,z\_e), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (\( \alpha \)) between the x\_e axis and the normal to the surface (z) is greater than 45° (\( \alpha > 45° \)), the element x-axis is considered as the projection of x\_e on the element plane.
Chapter 4  Element Library

- If the angle (α) between the xc axis and the normal to the surface (z) is less than or equal to 45° (α < or = 45°), the element x-axis is considered as the projection of yc on the element plane.

- The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options

Op. 1: Unused option for this element

Op. 2: Analysis
   = 0; Regular shell analysis (Membrane + bending)
   = 1; Membrane analysis *
   = 2; Shear panel analysis
   = 3; Transverse shear

Op. 3: Stress print-out option
   = 0; print forces per unit length and stresses at center of element
   = 1; add print-out of nodal forces
   = 2; add print-out of nodal stresses

Op. 4: Stress Direction (in the output file)
   = 0; stresses are calculated in the global Cartesian coordinate system
   = 1; stresses are calculated in the defined element local coordinate systems
   \[^{2}\text{If ECS = -1, stresses and strains are calculated in the global coordinate system}\]
   = 2; stresses are calculated in the material directions (see figure 4-26)

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small)

Op. 7: Unused option

Op. 8: Strain plasticity. Use default value (0: Small)

* For flat membrane structures with transverse loads, it is recommended that the problem start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. Since no equilibrium iterations are performed in linear analysis, results may not be accurate enough. Nonlinear analysis is strongly recommended.
Real Constants
r1 = Thickness
r2 = Temperature gradient
r3 = Foundation stiffness (see note 2 for SHELL4 element)
r4 = Material Angle (Beta)
r5, r6= Unused by linear analysis

Material Properties
EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
C = Specific heat
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
DENS = Density
GXY = Shear modulus relating the first and second material directions
DAMP = Material damping coefficient
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)

Element Loadings
• Thermal
• Gravitational
• Pressure (applied normal to element faces)

Output Results
Stress components including von Mises stress are available in the element coordinate system at the centroid of the element for top and bottom fibers. Principal stresses may optionally be requested. In addition, nodal force per unit length and stress components can also be calculated and printed (see Op. 3). The directions of force and moment components per unit length for this element are illustrated in Figure 4-28.
Figure 4-26. 3-Node Triangular Thin Shell

XY:  Global Cartesian Coordinate System
xyz:  Element Coordinate System

Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)

β defined by ECS

local y axis defined by ECS

First (x) material direction

Second material direction

local x axis defined by ECS

If ECS = -1, β is measured differently for each element which may not be proper to use for non-isotropic materials.
Figure 4-27. Coordinate System Modification for Shell Elements

\[ \alpha \leq 45^\circ \]

\[ \alpha > 45^\circ \]

\( x = \text{projection of } x^0 \text{-axis on the shell plane} \)

\( z = \text{normal to the shell plane} \)

\( x^0 \), \( y^0 \), \( z^0 \):

Defined element coordinate system

(\( E^0 \pi^{-1} \))

\( xyz \):

Modified element coordinate system

\( x = \text{projection of } y^0 \text{-axis on the shell plane} \)

\( z = \text{normal to the shell plane} \)
Chapter 4   Element Library

Figure 4-28. Direction of Force and Moment Components Per Unit Length for Thin Shells

References

Chapter 4   Element Library

Thermal and Linear Structural Quadrilateral Thin Shell Element (SHELL4)

General Description
SHELL4 is a 4-node quadrilateral thin shell element with membrane and bending capabilities for the analysis of three dimensional structural and thermal models. The shear deformation effect is neglected. Six degrees of freedom per node (three translations and three rotations) are considered for structural analysis. Only one degree of freedom per node, representing the temperature, is used for the thermal module. The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thick plates or shells, as determined by standard guidelines, SHELL4T is recommended.

Special Features
Buckling, Inplane loading.

Default Element Coordinate System (ECS = -1)
The nodal input pattern for this element is shown in Figure 4-30. Both clockwise and counter-clockwise node numbering are allowed. A triangular element is considered if the third and fourth nodes have the same global node number. For the element coordinate system, the x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the first three nodes, perpendicular to the element x-axis toward the fourth node. The element z-axis completes a right-hand Cartesian system.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xₑyₑzₑ), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (α) between the xₑ axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of xₑ on the element plane.
Element Group Options

Op. 1: Type (see Note 1)
  = 0; QUAD 2 element (2 triangles to form a quadrilateral)
  = 1; QUAD 4 element (4 triangles to form a quadrilateral)
  = 2; QUAD element (4 node quadrilateral element)
  = 3; QM6 (4 node quadrilateral element)

Op. 2: Analysis option
  = 0; Regular shell analysis (Membrane + bending)
  = 1; Membrane analysis *
  = 2; Shear panel analysis (Shear terms only)
  = 3; Transverse shear

Op. 3: Stress print-out option
  = 0; print forces per unit length and stresses at center of element
  = 1; add print-out of nodal forces
  = 2; add print-out of nodal stresses

Op. 4: Stress Direction
  = 0; stresses are calculated in the global Cartesian coordinate system
  = 1; stresses are calculated in the defined element local coordinate system
  = 2; stresses are calculated in the material directions (see figure 4-30)

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small)

Op. 7: Unused option for this element.

Op. 8: Strain Plasticity. Use default value (0: Small)

* For flat membrane structures with transverse loads, it is recommended that the problem start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. Since no equilibrium iterations are performed in linear analysis, results may not be accurate enough. Nonlinear analysis is strongly recommended.

Real Constants
r1 = Thickness
Chapter 4  Element Library

\[ r_2 = \text{Temperature gradient} \]
\[ r_3 = \text{Foundation stiffness (see Note 2)} \]
\[ r_4 = \text{Material Angle (Beta)} \]
\[ r_5, r_6 = \text{Unrelated constants to this type of analysis} \]

**Material Properties**

- \( EX \) = Modulus of elasticity in the first material direction
- \( EY \) = Modulus of elasticity in the second material direction
- \( KX \) = Thermal conductivity in the first material direction
- \( KY \) = Thermal conductivity in the second material direction
- \( NUXY \) = Poisson's ratio
- \( C \) = Specific heat
- \( ALPX \) = Coefficient of thermal expansion in the first material direction
- \( ALPY \) = Coefficient of thermal expansion in the second material direction
- \( DENS \) = Density
- \( GXY \) = Shear modulus relating the first and second material directions
- \( DAMP \) = Material damping coefficient
- \( ECONX \) = Electric conductivity in the first material direction (thermal analysis only)
- \( ECONX \) = Electric conductivity in the second material direction (thermal analysis only)

**Element Loadings**

- Thermal
- Gravitational
- Pressure (applied normal to element faces)

**Output Results**

Stress components including von Mises stress are available in the element coordinate systems at the centroid of the element for top and bottom fibers. Principal stresses may optionally be requested. In addition nodal force per unit length and stress components can also be printed (see Op. 3). The directions of force and moment components per unit length for this element are illustrated in Figure 4-28.
Note 1:
Quad elements are internally treated as follows:

1. QUAD2 Element
   Formed from two triangles as shown; stiffness matrix calculation is fast; accuracy is good; in symmetric problems it may display slight anti-symmetry behavior.

2. QUAD4 Element
   Formed from four triangles as shown; stiffness matrix calculations are slow; accuracy is good; in symmetric problems it shows symmetry behavior.
Note 2:
Elaboration on Real Constant No. 3 (Foundation stiffness, $K_f$)
For a non-zero value of this real constant, a spring is considered at each node, applying a stiffness in the out-of-plane direction (normal to plane of the element). The stiffness for each spring is equal to:

$$K_i = \frac{K_f A}{n}$$

where:
- $K_i$ = Normal stiffness at node i
- $A$ = Area of the element
- $K_f$ = Foundation stiffness
- $n$ = Number of the element nodes

The stress program calculates the foundation pressure according to,

$$\sigma = K_f \sum_{i=1}^{n} \frac{w_i}{n}$$

where:
- $w_i$ = lateral displacement at node i
References

Chapter 4   Element Library

Thermal and Linear Structural 6-Node Triangular Thin Shell Element (SHELL6)

General Description
SHELL6 is a 6-node triangular thin shell element with membrane and bending capabilities for the analysis of three dimensional structural and thermal models. The shear deformation effect is neglected for this element. Six degrees of freedom per node (three translations and three rotations) are considered for structural analysis.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

Special Features
Buckling, Inplane loading.

Default Element Coordinate System (ECS = -1)
The nodal input pattern for the element is shown in Figure 4-29. Both clockwise and counter-clockwise node numbering are allowed. For element coordinate system, the x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes, perpendicular to x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system \((x_\text{ey},z_\text{ez})\) is different from the default element coordinate system \((ECS = -1)\), the program considers a modified element coordinate system \((xyz)\) similar to that described in Figure 4-27 for SHELL3.

Element Group Options

**Op. 1:** Analysis
\[
= 0; \text{ Regular} \\
= 1; \text{ Membrane} \\
= 3; \text{ Transverse shear}
\]

**Op. 2:** Element type
\[
= 0; \text{ Curved (formulation based on curved edges)} \\
= 1; \text{ Assembled (formulation based on 4 SHELL3 elements)}
\]

**Op. 3:** Unused option for this element

**Op. 4:** Stress Direction
Chapter 4  Element Library

= 0; stresses are calculated in the global Cartesian coordinate system
= 1; stresses are calculated in the defined element local coordinate systems
= 2; stresses are calculated in the material directions (see figure 4-26)

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small displacement formulation)

Op. 7: Unused option for this element

Op. 8: Strain plasticity. Use default value (0: Small strain plasticity)

Real Constants
r1 = Shell thickness
r2 = Temperature gradient
r3 = Unused real constant
r4 = Material angle (Beta)
r5, r6=Unused constants by this type of analysis

Material Properties
EX = Modulus of elasticity in the first material direction
EX = Modulus of elasticity in the second material direction
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
NUXY = Poisson’s ratio relating the first and second material directions
C = Specific heat
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
DENS = Density
GXY = Shear modulus relating the first and second material directions
DAMP = Material damping coefficient
ECONX = Electric conductivity in the first material direction
ECONY = Electric conductivity in the second material direction

Element Loadings
• Thermal
• Gravitational
• Pressure (applied normal to element faces)
Chapter 4  Element Library

Output Results

Stress components including von Mises stress are available in the element coordinate system at the centroid of the element for top and bottom fibers. Principal stresses may optionally be requested.

Figure 4-29. 6-Node Triangular Thin Shell

References


**Linear Structural 8/9-Node Isoparametric Shell Element (SHELL9)**

**General Description**

SHELL9 is an 8- or 9-node quadrilateral shell element with membrane, bending and shear capabilities for the analysis of three-dimensional structural models. Six degrees of freedom (three translations and three rotations) are considered per node.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

The nodal input pattern can be specified in both clockwise and counter-clockwise directions. The ninth (9th) node (if any) must be placed at the center of the element.

**Special Features**

Buckling, Inplane loading.

**Default Element Coordinate System (ECS = -1)**

The element is a curved lamina in three dimensional space. At any point of the element curved surface the z-axis of the local coordinate system is normal to the element mid-plane and the x- and y-axes lie in the tangent plane. The direction of the element axes (x and y) are related to the natural coordinates ($\xi$, $\eta$) as shown in Figure 4-33. Given in the Figure also, an example of the element coordinate system at node 3. A special case of the element coordinate system for a cylindrical surface is shown in Figure 4-34.

**Other Element Coordinate Systems (ECS ≠ -1):**

When a defined element coordinate system ($x_ey_ycz_e$), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle ($\alpha$) between the xe axis and the normal to the surface (z) is greater than 45° ($\alpha > 45^\circ$), the element x-axis is considered as the projection of $x_e$ on the element plane.
- If the angle ($\alpha$) between the xe axis and the normal to the surface (z) is less than or equal to 45° ($\alpha < 45^\circ$), the element x-axis is considered as the projection of $y_e$ on the element plane.
Chapter 4  Element Library

- The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

**Op. 1:** 9/8 Node Element  
= 0; use 9-node element (default)  
= 1; use 8-node element

**Op. 2:** Integration method (see References)  
= 0; Reduced+GAMA-PHI method  
= 1; Reduced integration

**Op. 3:** Unused option for this element

**Op. 4:** Stress Direction  
= 0; stresses are calculated in the global Cartesian coordinate system  
= 1; stresses are calculated in the default element coordinate system  

\[\text{If ECS = -1, stresses and strains are calculated in the global coordinate system.}\]

\[\text{If stresses are requested in a local coordinate system (ECS \neq -1), the coordinate system at the center of the element is used.}\]

\[= 2; \text{stresses are calculated in the material directions (see figure 4-33)}\]

**Op. 5 to Op. 8:** Unused options for this element

**Real Constants**

r1 = Shell thickness  
r2, r3= Unused real constants  
r4 = Material angle (Beta)

**Material Properties**

EX = Modulus of elasticity in the first material direction  
EY = Modulus of elasticity in the second material direction  
KX = Thermal conductivity in the first material direction  
KY = Thermal conductivity in the second material direction  
NUXY = Poisson's ratio relating the first and second material directions  
C = Specific heat  
ALPX = Coefficient of thermal expansion in the first material direction  
ALPY = Coefficient of thermal expansion in the second material direction  
DENS = Density
Chapter 4   Element Library

GXY = Shear modulus relating the first and 12th material directions
DAMP = Material damping coefficient
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)

Element Loadings
- Thermal
- Gravitational
- Pressure (applied to element faces)

Output Results
Forces and stress components are available in the nodal coordinate system for each node of the element. Stresses for top and bottom fibers are also calculated.

Figure 4-33. 9-Node Isoparametric Shell Element
Chapter 4  Element Library

Figure 4-34. SHELL9 as Part of a Cylindrical Surface

References


Thermal and Linear Structural Triangular Thick Shell Element (SHELL3T)

General Description
SHELL3T is a 3-node triangular thick shell element with membrane and bending capabilities for the analysis of three-dimensional structural and thermal models. The element accounts for shear deformation effects. Six degrees of freedom per node (three translations and three rotations) are considered for structural analysis. Only one degree of freedom per node, representing temperature, is used for the thermal module.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thin plates or shells, as determined by standard guidelines, SHELL3 is recommended instead. Both of these elements (SHELL3T and SHELL3) have identical inputs which permit exchanging one for the other by simply altering the element name.

Special Features
Buckling, Inplane loading.

Default Element Coordinate System (ECS = -1)
The nodal input pattern for the element is shown in Figure 4-35. Both clockwise and counter-clockwise node numbering are allowed for the element coordinate system. The x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes, perpendicular to x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xeyezc), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
Chapter 4 Element Library

- If the angle ($\alpha$) between the $x_e$ axis and the normal to the surface ($z$) is greater than $45^\circ$ ($\alpha > 45^\circ$), the element $x$-axis is considered as the projection of $x_e$ on the element plane.

- If the angle ($\alpha$) between the $x_e$ axis and the normal to the surface ($z$) is less than or equal to $45^\circ$ ($\alpha \leq 45^\circ$), the element $x$-axis is considered as the projection of $y_e$ on the element plane.

- The element $y$-axis is defined so that $z$-axis completes a right-hand Cartesian system with $x$- and $y$-axes.

Element Group Options

**Op. 1:** Unused option for this element

**Op. 2:** Analysis
  - $= 0$; Regular shell analysis (Membrane + bending)
  - $= 1$; Membrane analysis *
  - $= 2$; Shear panel analysis (Shear terms only)

**Op. 3:** Stress print-out option
  - $= 0$; print forces per unit length and stresses at center of element
  - $= 1$; add print-out of nodal forces
  - $= 2$; add print-out of nodal stresses

**Op. 4:** Stress Direction (in the output file)
  - $= 0$; stresses are calculated in the global Cartesian coordinate system
  - $= 1$; stresses are calculated in the defined element local coordinate system

  * If ECS = -1, stresses and strains are calculated in the global coordinate system.

  * If ECS = -2, stresses are calculated in the material directions (See figure 4-35)

**Op. 5:** Material Type. Use default value (0: Linear Elastic).

**Op. 6:** Displacement Formulation. Use default value (0: Small)

**Op. 7:** Unused option for this element

**Op. 8:** Strain plasticity. Use default value (0: Small)

* For flat membrane structures with transverse loads, it is recommended that the problem start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. Since no equilibrium iterations are performed in linear analysis, results may not be accurate enough. Nonlinear analysis is strongly recommended.
Chapter 4   Element Library

Real Constants
r1 = Thickness
r2 = Temperature gradient
r3 = Foundation stiffness (see second note in the SHELL4 element section)
r4 = Material Angle (Beta)
r5, r6= not used in linear analysis

Material Properties
EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
NUXY = Poisson's ratio
C = Specific heat
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
DENS = Density
GXY = Shear modulus relating the first and second material directions
DAMP = Material damping coefficient

Element Loadings
• Thermal
• Gravitational
• Pressure (applied normal to element faces)

Output Results
Stress components including von Mises stress are available in the element coordinate systems at the centroid of the element for top and bottom fibers. Principal stresses may optionally be requested. In addition, nodal forces per unit length and stress components can be calculated and printed in the output file (see Op. 3). The directions of force and moment components per unit length for this element are illustrated in Figure 4-36.
Figure 4-35. 3-Node Triangular Thick Shell

XYZ: Global Cartesian Coordinate System
xyz: Element Coordinate System
6 13: Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)

If ECS = -1, $\beta$ is measured differently for each element which may not be proper to use for non-isotropic materials.
Figure 4-36. Direction of Force and Moment Components Per Unit Length as Defined by COSMOS/M for Thick Shells

References

Chapter 4  Element Library

Thermal and Linear Structural Quadrilateral Thick Shell Element (SHELL4T)

General Description
SHELL4T is a 4-node quadrilateral thick shell element with membrane and bending capabilities for the analysis of three dimensional structural and thermal models. The element accounts for shear deformation effects. Six degrees of freedom per node (three translations and three rotations) are considered for structural analysis. Only one degree of freedom per node, representing the temperature, is used for the thermal module. A triangular element is considered if the third and fourth node are assigned the same global node number.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thin plates or shells, as determined by standard guidelines, SHELL4 is recommended.

Special Features
Buckling, Inplane loading.

Default Element Coordinate System (ECS = -1)
The nodal input pattern for the element is shown in Figure 4-37. Both clockwise and counter-clockwise node numbering are allowed. For the element coordinate system, the x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the first three nodes, perpendicular to the element x-axis toward the fourth node. The element z-axis completes a right-hand Cartesian system.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xe,ye,ze), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (α) between the xe axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of xe on the element plane.
Chapter 4  Element Library

- If the angle ($\alpha$) between the xe axis and the normal to the surface (z) is less than or equal to 45° ($\alpha \leq 45^\circ$), the element x-axis is considered as the projection of $y_e$ on the element plane.

- The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options

Op. 1: Type of shell element (see SHELL4)
   = 0; QUAD2 element (2 triangles to form a quadrilateral)
   = 1; QUAD4 element (4 triangles to form a quadrilateral)
   = 2; QUAD element (4-node quadrilateral element)
   = 3; QM6 (4-node quadrilateral element)

Op. 2: Analysis
   = 0; Regular shell analysis (Membrane + bending)
   = 1; Membrane analysis *
   = 2; Shear panel analysis (shear terms only)

Op. 3: Stress print-out option
   = 0; print forces per unit length and stresses at center of element
   = 1; add print-out of nodal forces
   = 2; add print-out of nodal stresses

Op. 4: Stress Direction
   = 0; stresses are calculated in the global Cartesian coordinate system
   = 1; stresses are calculated in the defined element local coordinate system
   = 2; stresses are calculated in the material directions (see figure 4-37)

Op. 5: Material Type. Use default value (0: Linear Elastic)

Op. 6: Displacement Formulation. Use default value (0: Small displacement formulation)

Op. 7: Unused option for this element

Op. 8: Strain plasticity. Use default value (small strain plasticity)

* For flat membrane structures with transverse loads, it is recommended that the problem start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. Since no equilibrium iterations are performed in linear analysis, results may not be accurate enough. Nonlinear analysis is strongly recommended.

Real Constants

r1  = Thickness
Chapter 4  Element Library

r2  = Temperature gradient
r3  = Foundation stiffness (see Note 2 of the SHELL4 element)
r4  = Material Angle (Beta)
r5,r6 = Unrelated constants for this type of analysis

Material Properties
EX  = Modulus of elasticity in the first material direction
EY  = Modulus of elasticity in the second material direction
KX  = Thermal conductivity in the first material direction
KY  = Thermal conductivity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions
C   = Specific heat
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
DENS = Density
GXY  = Shear modulus relating the first and second material directions
DAMP = Material damping coefficient
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)

Element Loadings
• Thermal
• Gravitational
• Pressure (applied normal to element faces)

Output Results
Stress components including von Mises stress are available in the element coordinate system at the centroid of the element for top and bottom fibers. Principal stresses may optionally be requested. In addition, nodal force per unit length and stress components can also be calculated and printed in the output file (see Op. 3). The directions of force and moment components per unit length are illustrated in Figure 4-36.
Figure 4-37. 4-Node Quadrilateral Thick Shell

References


**Thermal and Linear Structural 6-Node Triangular Thick Shell Element (SHELL6T)**

**General Description:**

SHELL6T is a 6-node triangular thick shell element used for thermal and structural analysis. For structural analysis, the element supports membrane and bending capabilities. The element accounts for shear deformation effects. The element has 1 degree of freedom per node when used for thermal analysis and six degrees of freedom per node (three translations and three rotations) when used for structural analysis.

For problems involving very thin plates or shells, as determined by standard guidelines, SHELL6 is recommended. The element’s formulation is based on an assembly of SHELL3T elements. The nodal input pattern for this element is shown in the figure.

For all other details, refer to the linear SHELL3T element.
Chapter 4  Element Library

Linear Structural Composite Triangular Plate and Shell Element (SHELL3L)

General Description
SHELL3L is a 3-node multi-layer triangular shell element with membrane and bending capabilities for the analysis of three-dimensional structural models. Up to fifty (50) layers can be used. Each layer can be associated with different isotropic or orthotropic material properties. Six degrees of freedom (three translations and three rotations) are considered per node.

The nodal input pattern for this element is shown in Figure 4-38. Both clockwise and counterclockwise node numbering are allowed.

Special Features
Buckling, Inplane loading, Failure criteria.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second, and the element y-axis lies in the plane defined by the three nodes, perpendicular to the x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with the x and y axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (x_cy_cz_c), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (\(\alpha\)) between the \(x_c\) axis and the normal to the surface (z) is greater than 45° (\(\alpha > 45^\circ\)), the element x-axis is considered as the projection of \(x_c\) on the element plane.
- If the angle (\(\alpha\)) between the \(x_c\) axis and the normal to the surface (z) is less than or equal to 45° (\(\alpha < \text{ or } = 45^\circ\)), the element x-axis is considered as the projection of \(y_c\) on the element plane.
- The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.
Element Group Options

**Op. 1:** Unused option for this element

**Op. 2:** Number of layers in the element (1 to 50)

**Op. 3:** Stress Direction

- = 0; stresses are calculated in the global Cartesian coordinate system (default)
- = 1; stresses are calculated in the defined element local coordinate system
- = 2; stresses are calculated in the material directions (See figure 4-38)

**Op. 4:** Unused option for this element

**Op. 5:** Failure Analysis. Use default value (0: Linear Elastic). For failure criteria, see A_STRESS command.

**Op. 6:** Displacement Formulation. Use default value (0: Small)

**Op. 7:** Layer flag. (prompted only if Number of Layers = 3 in Op. 2)

- = 0; Composite
- = 1; Sandwich

**Op. 8:** Unused option for this element

Real Constants

Figure 4-39 shows the convention for thickness definition and temperature distribution of a multi-layer composite shell element. The material angle ($\beta$) for each layer is defined relative to the element coordinate system as shown in Figure 4-38.

(If Op. 2 \(\neq\) 3 or Op. 2 = 3 but Op. 7 = 0)

- \(r_1\) = Distance from reference plane to upper surface (\(r_1\) is positive when upper surface is above the reference plane)
- \(r_2\) = Temperature gradient for the element
- \(r_3\) = Thickness of layer 1
- \(r_4\) = Material number for layer 1
- \(r_5\) = Material angle ($\beta$) for layer 1
- \(r_6\) = Thickness of layer 2
- \(r_7\) = Material set number associated with layer 2
- \(r_8\) = Material angle ($\beta$) for layer 2
- \(r_{3(NL-1) + 3}\) = Thickness of layer NL
- \(r_{3(NL-1) + 4}\) = Material set number associated with layer NL
- \(r_{3(NL-1) + 5}\) = Material angle ($\beta$) or layer NL

(If Op. 2 = 3 and Op. 7 = 1)
r1 = Distance from reference plane to upper surface (r1 is positive when upper surface is above the reference plane)

r2 = Temperature gradient

r3 = Thickness of layers 1 and 3

r4 = Material set number of layers 1 and 3

r5 = Thickness of layer 2

r6 = Material set number of layer 2

Material Properties

* If the default value (1.0e6) of r1 is accepted, the reference surface is defined as the neutral surface and r1 will be calculated as follows:

1. For calculating the mass moment of inertia:

\[
\begin{align*}
\sum_{i=1}^{NL} \rho(i) & \left[ z^2(i+1) - z^2(i) \right] \\
\sum_{i=1}^{NL} \rho(i) & \left[ z(i+1) - z(i) \right]
\end{align*}
\]

\[
r1 = \frac{\sum_{i=1}^{NL} \rho(i) [z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} \rho(i) [z(i+1) - z(i)]}
\]

where,

\( NL \) = number of layers
\( \rho(i) \) = density for layer i
\( z(i) \) and \( z(i+1) \) = z-coordinates of bottom and top surfaces of layer i

2. For calculating the bending strains, stresses, and material matrix:

\[
\begin{align*}
\sum_{i=1}^{NL} E_k(i) & \left[ z^2(i+1) - z^2(i) \right] \\
\sum_{i=1}^{NL} E_k(i) & \left[ z(i+1) - z(i) \right]
\end{align*}
\]

\[
\xi_k = \frac{\sum_{i=1}^{NL} E_k(i) [z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} E_k(i) [z(i+1) - z(i)]}
\]

where \( E_k \) = modulus of elasticity in k-direction

EX = Modulus of elasticity in the first material direction

EY = Modulus of elasticity in the second material direction

NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)

KX = Coefficient of thermal conductivity in the first material direction

KY = Coefficient of thermal conductivity in the second material direction

ALPX = Coefficient of thermal expansion in the first material direction

ALPY = Coefficient of thermal expansion in the second material direction
Chapter 4  Element Library

GXY = Shear modulus relating the first and second material directions
DENS = Density
ECONX = Electric conductivity in the first material direction
ECONY = Electric conductivity in the second material direction
SIGXT = Tensile strength in the first material direction
SIGXC = Compressive strength in the first material direction
SIGYT = Tensile strength in the second material direction
SIGYC = Compressive strength in the second material direction
SIGXY = Shear strength in the plane defined by first and second material directions
DAMP = Material damping coefficient

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the $i^{th}$ and $j^{th}$ material directions:

$$\nu_{ij}/E_i = \nu_{ji}/E_j$$

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.

Element Loadings

- Thermal
- Gravitational
- Pressure (applied normal to element faces)

Output Results

Stress components and von Mises stress are available in the element coordinate directions at the center of the top and bottom surfaces of each layer. Principal stresses may also be optionally requested.
**Chapter 4  Element Library**

**References**


**Figure 4-38. 3-Node Layered Shell Element**

If ECS = -1, β is measured differently for each element which may not be proper to use for non-isotropic materials.
Figure 4-39. Composite Triangular Plate and Shell

Convention for Thickness Definition and Temperature Distribution.

(r1) is positive when upper-surface is above the reference plane.
**Chapter 4   Element Library**

---

**Thermal and Linear Structural Composite Quadrilateral Plate and Shell Element (SHELL4L)**

**General Description**

SHELL4L is a 4-node multi-layer quadrilateral shell element with membrane and bending capabilities for the analysis of three-dimensional structural and thermal models. Up to fifty (50) layers can be used. Six degrees of freedom (three translations and three rotations) are considered per node. Only one degree of freedom per node, representing the temperature, is used for the thermal module.

Each layer can be associated with different isotropic or orthotropic material properties.

The nodal input pattern for this element is shown in Figure 4-40. Both clockwise and counter-clockwise node numbering are allowed. A triangular element is assumed if the third and fourth nodes have the same global node number.

**Special Features**

Buckling, Inplane loading, Failure criteria.

**Default Element Coordinate System (ECS = -1)**

The element x-axis goes from the first node to the second, and the element y-axis lies in the plane defined by the first three nodes, perpendicular to x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with x and y axes.

**Other Element Coordinate Systems (ECS ≠ -1)**

When a defined element coordinate system (xe,ye,ze), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (α) between the xe axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of xe on the element plane.
• If the angle (\(\alpha\)) between the xe axis and the normal to the surface (z) is less than or equal to 45° (\(\alpha \leq 45^\circ\)), the element x-axis is considered as the projection of \(y_e\) on the element plane.
• The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

**Op. 1:** Type of shell element (See SHELL4)
- = 0; QUAD2 element (2 triangles to form a quadrilateral)
- = 1; QUAD4 element (4 triangles to form a quadrilateral)
- = 2; QUAD element (4-node quadrilateral element)

**Op. 2:** Number of Layers in the element (1 to 50)

**Op. 3:** Stress Direction
- = 0; stresses are calculated in the global Cartesian coordinate system (default)
- = 1; stressed are calculated in the defined element local coordinate system
- = 2; stresses are calculated in the material directions (see figure 4-40)

**Op. 4:** Unused option for this element

**Op. 5:** Failure Analysis. Use default value (0: Linear Elastic). For failure criteria, see **A_STRESS** command.

**Op. 6:** Displacement Formulation. Use default value (0: Small)

**Op. 7:** Layer flag (prompted only if NL = 3 in Op. 2).
- = 0; Composite
- = 1; Sandwich

**Op. 8:** Unused option for this element

**Real Constants**

Figure 4-39 shows the convention for thickness definition and temperature distribution of a multi-layer composite shell element. The material angle (\(\beta\)) for each layer is defined relative to the element coordinate system as shown in Figure 4-40.

*(If Op. 2 \neq 3 or Op. 2 = 3 but Op. 7 = 0)*

- \(r_1\) = Distance from reference plane to upper surface (\(r_1\) is positive when upper surface is above the reference plane.)
- \(r_2\) = Temperature gradient for the element
- \(r_3\) = Thickness of layer 1
- \(r_4\) = Material number for layer 1
- \(r_5\) = Material angle (\(\beta\)) for layer 1
- \(r_6\) = Thickness of layer 2
Chapter 4  Element Library

\[ r_7 = \text{Material number associated with layer 2} \]
\[ r_8 = \text{Material angle (β) for layer 2} \]
\[ r_{3(NL - 1) + 3} = \text{Thickness of layer } NL \]
\[ r_{3(NL - 1) + 4} = \text{Material set number associated with layer } NL \]
\[ r_{3(NL - 1) + 5} = \text{Material angle (β) for layer } NL \]

(If Op. 2 = 3 and Op. 7 = 1)
\[ r_1 = \text{Distance from reference plane to upper surface} (r_1 \text{ is positive when upper-surface is above the reference plane.}) \]
\[ r_2 = \text{Temperature gradient} \]
\[ r_3 = \text{Thickness of layers 1 and 3} \]
\[ r_4 = \text{Material set number of layers 1 and 3} \]
\[ r_5 = \text{Thickness of layer 2} \]
\[ r_6 = \text{Material set number of layer 2} \]

* If the default value (1.0e6) of \( r_1 \) is accepted, the reference surface is defined as the neutral surface and \( r_1 \) will be calculated as follows:

\[ r_1 = \xi = \frac{\sum_{i=1}^{NL} \rho(i)[z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} \rho(i)[z(i+1) - z(i)]} \]

1. For calculating the mass moment of inertia:

\[ \sum_{i=1}^{NL} \rho(i)[z^2(i+1) - z^2(i)] \]

2. For calculating the bending strains, stresses, and material matrix:

\[ \xi_k = \frac{\sum_{i=1}^{NL} E_k(i)[z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} E_k(i)[z(i+1) - z(i)]} \]

where \( E_k \) = modulus of elasticity in k-direction
Chapter 4  Element Library

Material Properties
(For material directions, see Figure 4-40)

EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
GXY = Shear modulus relating the first and second material direction
DENS = Density
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)
SIGXT = Tensile strength in the first material direction
SIGXC = Compressive strength in the first material direction
SIGYT = Tensile strength in the second material direction
SIGYC = Compressive strength in the second material direction
SIGXY = Shear strength in the plane defined by first and second material directions
DAMP = Material damping coefficient

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.
4. Thermal conductivity in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the ith and jth material directions:

$$\nu_{ij}/E_i = \nu_{ji}/E_j$$

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.
Element Loadings
- Thermal
- Gravitational
- Pressure (applied normal to element faces)

Output Results
Stress components and von Mises stress are available in the element coordinate directions at the center of top and bottom surfaces of each layer. Principal stresses may also be optionally requested.

Figure 4-40. Composite Quadrilateral Plate and Shell

| XYZ: | Global Cartesian Coordinate System |
| xyz: | Element Coordinate System |
| abc: | Material Coordinate System |
| 1-5: | Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward) |
Chapter 4 Element Library

References


Chapter 4  Element Library

Linear Structural Composite 8/9-Node Isoparametric Shell (SHELL9L)

General Description
SHELL9L is an 8- or 9-node quadrilateral shell element with membrane, bending and shear capabilities for the analysis of three-dimensional structural models, constructed of fiber-reinforced laminated composites. Six degrees of freedom (three translations and three rotations) are considered per node.

The element is assumed to have constant thickness with isotropic and orthotropic material properties for each layer.

The nodal input pattern can be specified in both clockwise and counter-clockwise directions. The ninth (9th) node (if any) must be placed at the center of the element.

Special Features
Buckling, Inplane loading, P-Method (polynomial degrees up to 5).

Default Element Coordinate System (ECS = -1)
The element is a curved lamina in three dimensional space. At any point of the element curved surface the z-axis of the local coordinate system is normal to the element mid-plane and the x- and y-axes lie in the tangent plane. The direction of the element axes x and y are related to the natural coordinates (ξ, η) as shown in Figure 4-33. Given in the Figure also, an example of the element coordinate system at node 3. A special case of the element coordinate system for a cylindrical surface is shown in Figure 4-34.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xeyez), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

• The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.

• If the angle (α) between the xₜ axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of xₜ on the element plane.
If the angle ($\alpha$) between the $x_e$ axis and the normal to the surface ($z$) is less than or equal to 45° ($\alpha \leq 45^\circ$), the element $x$-axis is considered as the projection of $y_e$ on the element plane.

The element $y$-axis is defined so that $z$-axis completes a right-hand Cartesian system with $x$- and $y$-axes.

**Element Group Option**

**Op. 1:** 9/8 Node Element
- $= 0$; use 9-node element (default)
- $= 1$; use 8-node element

**Op. 2:** Integration method (see references)
- $= 0$; Reduced+GAMA-PHI method
- $= 1$; Reduced integration

**Op. 3:** Number of Layers in the element (1 to 50)

**Op. 4:** Unused option for this element

**Op. 5:** Stress Direction (in the output file)
- $= 0$; stresses are calculated in the global Cartesian coordinate system
- $= 1$; stresses are calculated in the default element coordinate system

*$*$ If ECS = -1, stresses and strains are calculated in the global coordinate system.

*$*$ If stresses are requested in a local coordinate system (ECS $\neq -1$), the coordinate system at the center of the element is used.
- $= 2$; stresses are calculated in the material directions (*see figure 4-41*)

**Op. 6 and Op. 8:** Unused options for this element

**Real Constants**

Figure 4-39 shows the convention for thickness definition and temperature distribution of a multi-layer composite shell element.

For each layer, the material coordinate system (abc) is shown in Figure 4-41. The material angle ($\beta$) is defined relative to the element coordinate system.

- $r_1 =$ Distance from reference plane to upper surface ($r_1$ is positive when upper surface is above the reference plane)
- $r_2 =$ Temperature gradient for the element
- $r_3 =$ Thickness of layer 1
- $r_4 =$ Material number for layer 1
- $r_5 =$ Material angle ($\beta$) for layer 1
r6 = Thickness of layer 2
r7 = Material set number associated with layer 2
r8 = Material angle ($\beta$) for layer 2
r[3(NL-1)+3] = Thickness of layer NL
r[3(NL-1)+4] = Material set number associated with layer NL
r[3(NL-1)+5] = Material angle ($\beta$) for layer NL

If the default value (1.0e6) of r1 is accepted, the reference surface is defined as the neutral surface and r1 will be calculated as follows:

1. For calculating the mass moment of inertia:

\[
\xi = \frac{\sum_{i=1}^{NL} \rho(i)[z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} \rho(i)[z(i+1) - z(i)]}
\]

where,

NL = number of layers
\(\rho(i)\) = density for layer i
\(z(i)\) and \(z(i+1)\) = z-coordinates of bottom and top surfaces of layer i

2. For calculating the bending strains, stresses, and material matrix:

\[
\xi_k = \frac{\sum_{i=1}^{NL} E_k(i)[z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} E_k(i)[z(i+1) - z(i)]}
\]

where,

k = x or y
\(\xi = (\xi_x + \xi_y) / 2\)

where \(E_k\) = modulus of elasticity in k-direction

Material Properties

Material properties associated with each element layer are:
Chapter 4  Element Library

EX  = Modulus of elasticity in the first material direction  
EY  = Modulus of elasticity in the second material direction  
NUXY = Poisson's ratio relating the first and second material direction (strain in the second direction due to unit strain along the first direction)  
KX  = Thermal conductivity in the first material direction  
KY  = Thermal conductivity in the second material direction  
ALPX = Coefficient of thermal expansion in the first material direction  
ALPY = Coefficient of thermal expansion in the second material direction  
GXY = Shear modulus relating the first and second material directions  
DENS = Density  
DAMP = Material damping coefficient  
ECONX = Electric conductivity in the first material direction  
ECONY = Electric conductivity in the second material direction

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal. 
2. Poisson's ratio in two planes are defined and are unequal. 
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the \( i^{th} \) and \( j^{th} \) material directions:

\[
\frac{\nu_{ij}}{E_i} = \frac{\nu_{ji}}{E_j}
\]

Where \( \nu_{ij}, E_i, \) and \( E_j \) are provided as input and \( \nu_{ji} \) calculated internally by the program.

Element Loadings

- Thermal
- Gravitational
- Pressure (applied to element faces)

Output Results

Forces per unit length and stress components are available in the element coordinate systems for each layer.
Chapter 4   Element Library

Figure 4-41. Composite 9-Node Isoparametric Shell Element

XYZ:  Global Cartesian Coordinate System
xyz:  Element Coordinate System
a:  First material direction
b:  Second material direction
c:  Third material direction

Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)

References


Chapter 4  Element Library

*Thermal and Linear Structural General Mass Element (MASS)*

**General Description**
MASS is a one node concentrated mass element to define a lumped mass at a node in structural and thermal models. Up to six (6) degrees of freedom can be considered for each element, defined in the global coordinate system.

**Special Features**
*(None)*

**Default Element Coordinate System (ECS = -1)**
The global Cartesian coordinate system is always considered as the default element coordinate system.

**Element Group Options**
*(None)*

**Real Constants**
Only r7 is to be specified for the Thermal module.

- r1 = Mass in X-direction
- r2 = Mass in Y-direction
- r3 = Mass in Z-direction
- r4 = Rotary inertia about X-axis
- r5 = Rotary inertia about Y-axis
- r6 = Rotary inertia about Z-axis
- r7 = Thermal Capacity defined in units of heat energy (thermal analysis only)

**Material Properties**
*(None)*

**Element Loadings**
*(None)*

**Output Results**
*(None)*
Linear Structural Spring Element (SPRING)

General Description
SPRING is a 1-, 2-, or 3-node element for use in structural models. The element can have axial, transverse, and rotational stiffnesses. The transverse degrees of freedom are not supported for 1-node elements. For 2-node elements, the transverse stiffness is assumed constant in all transverse directions.

Special Features
(None)

Default Element Coordinate System (ECS = -1)
The element coordinate system is illustrated in Figure 4-42. For 1-node elements, the element x axis (also called r axis) is along the global X, Y, or Z as specified in option 2 of the element group definition. For 2- and 3-node elements, the x (or r) direction goes from node 1 to node 2. To define the s and t directions, let ss denote a unit vector defined as follows:

- For 3-node elements, ss connects node 1 to node 3
- For 2-node elements, ss is in the global X axis unless the element is defined along the X axis, in which case ss falls along the global Y axis
- The s and t directions are then determined by: \( \mathbf{t} = \mathbf{r} \times \mathbf{ss} \) and \( \mathbf{s} = \mathbf{t} \times \mathbf{r} \), where the x operator refers to vector cross product

Refer to Figure 4-42 for a schematic representation of the SPRING element.

Element Group Options

Op. 1: Spring Type
= 0; Axial and transverse spring (default)
= 1; Rotational spring
= 2; Axial, transverse, and Rotational

Op. 2: Number of nodes
= 1; 1-node element
= 2; 2-node element (default)
= 3; 3-node element

Op. 3: Degrees of freedom for the 1-node element (used only if Op. 2 = 1)
= 1; UX, translational degree of freedom along global Cartesian X-direction
= 2; UY, translational degree of freedom along global Cartesian Y-direction
Chapter 4  Element Library

= 3; UZ, translational degree of freedom along global Cartesian Z-direction
= 4; ROTX, rotational degree of freedom about global Cartesian X-direction
= 5; ROTY, rotational degree of freedom about global Cartesian Y-direction
= 6; ROTZ, rotational degree of freedom about global Cartesian Z-direction
= 7; UX and ROTX
= 8; UY and ROTY
= 9; UZ and ROTZ

Op. 4: Unused option for this element
Op. 5: Use default value (linear behavior)
Op. 6: Use default value (small displacement formulation)
Op. 7: Unused option for this element
Op. 8: Unused option for this element

Real Constants

The prompted real constants depend on entries used in defining the element group. r3 and r4 are not used with 1-node elements.

r1 = Axial stiffness
r2 = Rotational stiffness
r3 = Transverse stiffness in the s direction
r4 = Transverse stiffness in the t direction

Element Loadings

(None)

Material Properties

(None)

Output Results

Axial forces and torsional moments are available in the element coordinate system.
Figure 4-42. Spring Element

3-Node SPRING Element
XYZ Global Cartesian Coordinate System
elements coordinate System

2-Node SPRING Element
The r axis is along the global X axis. The ss vector is parallel to the global Y-axis.

2-Node SPRING Element
The r axis has a general orientation. The ss vector is parallel to the global X axis.
Linear Structural Rigid Bar Element (RBAR)

General Description
RBAR is a 2-node rigid bar element as shown in Figure 4-43. The element behaves in a rigid body manner forcing the two nodes to undergo the same rotation without suffering axial or shear deformations. Up to six (6) degrees of freedom can be used per node depending on the type of elements connected to the rigid bar.

Special Features
Not applicable for buckling problems.

Element Group Options
(None)

Real Constants
r1 = Rigid bar stiffness (default is $1.0 \times 10^{10}$)

Material Properties
(None)

Element Loadings
(None)

Output Results
(None)

Figure 4-43. Rigid Bar Element
Linear Structural Boundary Element (BOUND)

General Description
BOUND is a 2-node uniaxial element for three-dimensional structural models to constrain the structure in an arbitrary direction against translation and/or rotation. Two degrees of freedom (one translation and one rotation) are considered for the first node, while the second node must be completely fixed. A third node is required only for the element orientation if the element is used to constrain rotation.

Special Features
(None)

Default Element Coordinate System (ECS = -1)
The nodal input pattern, shown in Figure 4-44, specifies the direction of the element x-axis which also corresponds to the direction of the translational degree of freedom of the element. The x-axis goes from the second node to the first. The element y-axis lies in the plane defined by the three nodes, perpendicular to x-axis towards the third node. The element z-axis, about which the rotational degree of freedom is defined, completes a right-hand Cartesian system.

Element Group Options
Op. 1: Type of boundary
= 0; axial spring (default)
= 1; rotational spring
= 2; both axial and rotational springs
Op. 2 to Op. 8: Unused options for this element

Real Constants
r1 = Axial stiffness
r2 = Rotational stiffness

Material Properties
(None)
Chapter 4  Element Library

Element Loadings

(None)

Output Results

Forces and moments are available in the element coordinate system.

Figure 4-44. Boundary Element
Chapter 4  Element Library

Thermal and Linear Structural Gap Element (GAP)

General Description
GAP is a 2-node element for two- or three-dimensional interface problems in structural models. The element behaves similar to a rigid link which can resist either compression or tension in the direction normal to the interface:

- A compressive gap resists compression once the relative contraction between the two nodes exceeds the defined gap distance.
- A tensile gap limits the relative expansion between the two nodes to the gap distance.

Static friction effects, when present, are accounted for by the product of the gap’s normal force and the coefficient of friction. Sliding friction is not supported by the linear gap-friction elements. Static friction can be considered only for two-dimensional problems.

For thermal problems, the program enforces equal temperatures at the two nodes.

Default Element Coordinate System (ECS = -1)
The direction of the gap goes from the first to the second node. The contact surface is normal to the gap direction.

Element Group Options
Op. 1 and Op. 2: Unrelated options to this type of analysis (use default values)
Op. 3: Use default value (friction can be considered only in the X-Y plane)
Op. 4: Use default value (node to node element)
Op. 5: Unused options for this element
Op. 6: Gap distance calculations for compressive gap elements
  = 0; user-calculated (default)
  = 1; automatic calculations such that the two nodes contact each other (not applicable for tensile gaps)
Op. 7: Unused option for this element
Op. 8: Unused option for this element

Real Constants
r1 = Gdist - allowable relative displacement between 2 nodes with no gap resistance.
> 0.0 gap resists compression
= 0.0 gap is originally closed and resists compression
< 0.0 gap resists tension

r2 = Gfric - Coefficient of friction used for defining the static friction force.
Not used for thermal analysis.

r3 to r7 = Unrelated constants to this type of analysis.

Material Properties
(None).

Element Loadings
(None)

Output Results
For every load case, the gap forces are available in the global Cartesian directions.

Figure 4-45. Node-to-Node Gap Element
General Stiffness/Conduction Element for Linear Structural and Heat Transfer Modules (GENSTIF)

General Description
The GENSTIF is a 2-node user-defined element for use with structural/thermal models. The element is supported by STAR, DSTAR, and HSTAR. FFE modules do not support this element.

When used for structural problems, up to six degrees of freedom per node are considered as shown in Figure 4-46 for structural problems. The maximum size of the symmetrical matrix is 12X12 (a total of 78 terms).

When used as a conduction element, the GENSTIF element is recognized by HSTAR only. FFE THERMAL does not support this option. When used for heat transfer, two matrices can be specified the conduction matrix and the thermal capacitance matrix. The size of each matrix is 2X2 (3 terms).

The stiffness/conduction matrix must be symmetric, positive or semi-positive definite, and defined in terms of the global Cartesian coordinate system.

Special Features

**Op. 1:** Stiffness/Conduction flag
- = 0; Stiffness (for structural problems)
- = 1; Conduction (for thermal problems)
- = 2; Both (structural and thermal)

Other options are not used.

Element Group Options

*(None)*

Real Constants

- The order of the real constant depends on option in the element group definition.
- \( r_1 = K_{1,1}/C_{1,1} \): stiffness/conduction term at row 1, column 1
- \( r_2 = K_{1,2}/C_{1,2} \): stiffness/conduction term at row 1, column 2
- \( r_3 = K_{1,3}/C_{2,2} \): stiffness term at row 1, column 3 or conduction term at row 2, column 2
Chapter 4  Element Library

\[ \begin{align*}
\text{r4} & = K_{1,4}/CT_{1,1}: \text{stiffness term at row 1, column 4 or thermal capacity term at row 1, column 1.} \\
\text{r5} & = K_{1,5}/CT_{1,2}: \text{stiffness term at row 1, column 4 or thermal capacity term at row 1, column 2} \\
\text{r6} & = K_{1,6}/CT_{2,2}: \text{stiffness term at row 1, column 4 or thermal capacity term at row 2, column 2.} \\
\text{r7} & = K_{1,7}: \text{stiffness term at row 1, column 7} \\
\text{r8} & = K_{1,8}: \text{stiffness term at row 1, column 8} \\
\text{r9} & = K_{1,9}: \text{stiffness term at row 1, column 9} \\
\text{r10} & = K_{1,10}: \text{stiffness term at row 1, column 10} \\
\text{r11} & = K_{1,11}: \text{stiffness term at row 1, column 11} \\
\text{r12} & = K_{1,12}: \text{stiffness term at row 1, column 12} \\
\text{r13} & = K_{2,2}: \text{stiffness term at row 2, column 2} \\
\text{r14} & = K_{2,3}: \text{stiffness term at row 2, column 3} \\
\text{r15} & = K_{2,4}: \text{stiffness term at row 2, column 4} \\
\text{r16} & = K_{2,5}: \text{stiffness term at row 2, column 5} \\
\text{r17} & = K_{2,6}: \text{stiffness term at row 2, column 6} \\
\text{r18} & = K_{2,7}: \text{stiffness term at row 2, column 7} \\
\text{r19} & = K_{2,8}: \text{stiffness term at row 2, column 8} \\
\text{r20} & = K_{2,9}: \text{stiffness term at row 2, column 9} \\
\text{r21} & = K_{2,10}: \text{stiffness term at row 2, column 10} \\
\text{r22} & = K_{2,11}: \text{stiffness term at row 2, column 11} \\
\text{r23} & = K_{2,12}: \text{stiffness terms at row 2, column 12} \\
\text{r24} & = K_{12,12}: \text{stiffness terms at row 12, column 12} \\
\end{align*} \]

The following real constants are defined only when \textbf{Both} is specified in Op. 1 of the element group definition.

\[ \begin{align*}
\text{r79} & = C_{1,1}: \text{conduction term at row 1, column 1} \\
\text{r80} & = C_{1,2}: \text{conduction term at row 1, column 2} \\
\text{r81} & = C_{2,2}: \text{conduction term at row 2, column 2} \\
\text{r82} & = CT_{1,1}: \text{thermal capacity term at row 1, column 1} \\
\text{r83} & = CT_{1,2}: \text{thermal capacity term at row 1, column 2} \\
\text{r84} & = CT_{2,2}: \text{thermal capacity term at row 2, column 2} \\
\end{align*} \]

Material Properties

\textit{(None)}

Element Loadings

\textit{(None)}

Output Results

No special output directly related to the General Stiffness element are provided by the program. Only nodal displacements are calculated and printed in the output file.
Figure 4-46. General Stiffness Element

Figure 4-47. Stiffness Matrix Terms $K_{ij}$

<table>
<thead>
<tr>
<th>Col J</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row I</td>
<td>r1</td>
<td>r2</td>
<td>r3</td>
<td>r4</td>
<td>r5</td>
<td>r6</td>
<td>r7</td>
<td>r8</td>
<td>r9</td>
<td>r10</td>
<td>r11</td>
<td>r12</td>
</tr>
<tr>
<td>1</td>
<td>r13</td>
<td>r14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>r15</td>
<td>r16</td>
<td>r17</td>
<td>r18</td>
<td>r19</td>
<td>r20</td>
<td>r21</td>
<td>r22</td>
<td>r23</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>r24</td>
<td>r25</td>
<td>r26</td>
<td>r27</td>
<td>r28</td>
<td>r29</td>
<td>r30</td>
<td>r31</td>
<td>r32</td>
<td>r33</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>r34</td>
<td>r35</td>
<td>r36</td>
<td>r37</td>
<td>r38</td>
<td>r39</td>
<td>r40</td>
<td>r41</td>
<td>r42</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>r43</td>
<td>r44</td>
<td>r45</td>
<td>r46</td>
<td>r47</td>
<td>r48</td>
<td>r49</td>
<td>r50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>r51</td>
<td>r52</td>
<td>r53</td>
<td>r54</td>
<td>r55</td>
<td>r56</td>
<td>r57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>r58</td>
<td>r59</td>
<td>r60</td>
<td>r61</td>
<td>r62</td>
<td>r63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>r64</td>
<td>r65</td>
<td>r66</td>
<td>r67</td>
<td>r68</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>r69</td>
<td>r70</td>
<td>r71</td>
<td>r72</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td>r73</td>
<td>r74</td>
<td>r75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>r76</td>
<td>r77</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Number of real constants depends on Op. 1: Stiffness/Conduction flag, 
- 0: Stiffness (for structural problems), 12x12 matrix (78 real constants)
- 1: Conduction (for thermal problems), 2 2x2 matrices (6 real constants)
- 2: Both (structural and thermal), 3 matrices (84 real constants)
**Nonlinear 2D Spar/Truss Element (TRUSS2D)**

**General Description**

TRUSS2D is a 2-node uniaxial element for two dimensional nonlinear structural models. Only two translational degrees of freedom are considered per node. All elements have to be defined in the X-Y plane as shown in Figure 4-48.

**Special Features**

Linear elasticity, Plasticity, Thermo-plasticity, Large displacement, Nonlinear elasticity, User-defined material models, Creep and Cable-type behavior. (See Notes).

**Default Element Coordinate System (ECS = -1)**

The element x-axis goes from the first node to the second. The element z-axis is perpendicular to x-axis, parallel to and in the positive direction of the global Cartesian Z-direction. The element x-, y- and z-axes completes a right-hand Cartesian system.

**Element Group Options**

- **Op. 1 to Op. 4:** Unused options for this element
- **Op. 5:** Material type option
  - = 0; linear elastic material model (default)
  - = 1; von Mises elasto-plastic model (isotropic hardening)
  - = 2; von Mises elasto-plastic model (kinematic hardening)
  - = 4; nonlinear elastic model
  - = 8; viscoelastic material model
  - = 11; concrete model
  - = 12; Tresca isotropic plasticity model
  - = 13; Tresca kinematic plasticity model
  - = -20 to -1; user-defined model
- **Op. 6:** Large displacement option
  - = 0; small displacement formulation (default)
  - = 1; large displacement formulation
Op. 7: Material creep option
   = 0; do not consider creep
   = 1; consider creep effect
   = -100 to -1; user's creep model

Op. 8: Unused option for this element

Real Constants
   r1 = Cross-sectional area
   r2 = Unrelated constant to this type of analysis
   r3 = Initial axial force (to be specified only with the large displacement
        formulation option)
   r4 = Initial axial strain (to be specified only with the large displacement
        formulation option)

Material Properties
   EX = Modulus of elasticity
   ALPX = Coefficient of thermal expansion
   ETAN = Tangent modulus for bilinear elasto-plastic models
   SIGYLD = Yield stress of bilinear elasto-plastic models
   DENS = Density
   CREEPC = Creep constants for the classical creep law (3 constants)
   CREEPX = Creep constants for the exponential creep law (7 constants)
   K1, K2,..., K8 = Bulk relaxation (first, second,..., eighth) moduli
   TAUK1, TAUK2,..., TAUK8 = Time associated with K1 through K8
   REFTEMP = Glassy transition temperature
   VC1, VC2 = First and Second constants of the WLF equation
   MCij = User-defined material constants (up to 20 values). Constants
         are designated as MC11, MC12,... MC56 (i = 1, 6 and j = i, 6.
         MC66 is not used)
   FPC = Concrete ultimate compressive strength
   EPSU = Concrete ultimate compressive strain

Element Loadings
   • Thermal
   • Gravitational
**thirdOutput Results**
Forces and stresses are available in the element coordinate system.

For the concrete model, either the damage factor or the yield factor can be chosen in the output. The option is given in the Analysis > NONLINEAR > Print Ops command.

**Figure 4-48. 2D TRUSS**

---

**A. Cable-type behavior**

For the TRUSS2D element to behave as a Cable-element, the element has to be associated with a stress-strain curve similar to the one shown in Figure 4-49. The stress-strain curve shows no compression resistance. Two steps have to be followed:

1. Define the type of stress-strain curve using:
   
   LoadsBC > FUNC CURVE > **Material Curve Type**
   
The default value (0), which refers to an elastic curve, must be used.

2. Define the stress-strain curve using:
   
   LoadsBC > FUNC CURVE > **Material Curves**
   
   It should be mentioned that users may have to specify initial force (r3) and/or initial strain (r4) for a cable-type behavior.
B. For nonlinear elastic material model of a bar element, the stress-strain curve should be specified in the compression region to keep the truss element active in compression.

Reference
Chapter 4  Element Library

Nonlinear 3D Spar/Truss Element (TRUSS3D)

General Description
TRUSS3D is a 2-node uniaxial element for three dimensional nonlinear structural models. Only three translational degrees of freedom are considered per node.

Special Features
Linear elasticity, Plasticity, Thermo-plasticity, Large displacement, Nonlinear elasticity, User-defined material models, Creep and Cable-type behavior. (See Notes for nonlinear TRUSS2D).

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y and z-axes lie in a plane perpendicular to the x-axis as shown in Figure 4-50.

Element Group Options

Op. 1 to Op. 4: Unused options for this element

Op. 5: Material type option
= 0; linear elastic material model (default)
= 1; von Mises elasto-plastic model (isotropic hardening)
= 2; von Mises elasto-plastic model (kinematic hardening)
= 4; nonlinear elastic model
= 8; viscoelastic material model
= 11; concrete model
= 12; Tresca isotropic plasticity model
= 13; Tresca kinematic plasticity model
= -20 to -1; User-defined models.

Op. 6: Large displacement option
= 0; small displacement formulation (default)
= 1; large displacement formulation

Op. 7: Material creep option
= 0; do not consider creep
= 1; consider creep effect
= -100 to -1; user’s creep model

Op. 8: Unused option for this element
Chapter 4  Element Library

Real Constants
r1 = Cross-sectional area
r2 = Unrelated constant to this type of analysis
r3 = Initial axial force (to be specified only with the large displacement formulation option)
r4 = Initial axial strain (to be specified only with the large displacement formulation option)

Material Properties
EX = Modulus of elasticity
ALPX = Coefficient of thermal expansion
ETAN = Tangent modulus for bilinear elasto-plastic models
SIGYLD = Yield stress of bilinear elasto-plastic models
DENS = Density
CREEPC = Creep constants for the classical creep law (3 constants)
CREEPX = Creep constants for the exponential creep law (7 constants)
K1, K2,..., K8 = Bulk relaxation (first, second,..., eighth) moduli
TAUK1, TAUK2, ...
   TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and Second constants of the WLF equation
MCij = User-defined material constants (up to 20 values). Constants are designated as MC11, MC12,... MC56 (i = 1, 6 and j = i, 6. MC66 is not used)
FPC = Concrete ultimate compressive strength
EPSU = Concrete ultimate compressive strain

Element Loadings
• Thermal
• Gravitational

Output Results
Forces and stresses are available in the element coordinate system. For the concrete model, either the damage factor or the yield factor can be chosen in the output. The options is given in the Analysis > NONLINEAR > Print Ops command.
Reference
Nonlinear 2D Beam Element (BEAM2D)

General Description
BEAM2D is a 2-node uniaxial beam element for two-dimensional nonlinear structural models. All the elements have to be modeled in the X-Y plane. The element has three degrees of freedom (two translations and one rotation) per node. The nodal input pattern is shown in Figure 4-51.

Special Features
Linear elasticity, Large displacement, Finite rotation, Elasto-plasticity, Nonlinear elasticity, Viscoelasticity and Temperature-dependent linear elastic analysis.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element z-axis is parallel to and in the positive sense of the global Cartesian Z-axis. The element y-axis is perpendicular to the x-axis and completes, with x- and z-axes, a right-hand Cartesian coordinate system.

Element Group Options
Op. 1 to Op. 3: Unused options for this element
Op. 4: Integration Method (only for material nonlinearity - see Note)
  = 0; Gauss Quadrature integration (default)
  = 1; Newton-Cotes integration
Op. 5: Material models
  = 0; linear elastic material model (default)
  = 1; von Mises elasto-plastic model (isotropic hardening)
  = 2; von Mises elasto-plastic model (kinematic hardening)
  = 4; nonlinear elastic model
  = 8; viscoelastic material model
Op. 6: Large displacement option
  = 0; small displacement formulation (default)
  = 1; large displacement formulation
Op. 7: Unused option for this element
Op. 8: Unused option for this element
Chapter 4   Element Library

Real Constants
There are two different ways to define the section properties:

1. Using RCONST Command
   r1 = Cross-sectional area
   r2 = Moment of inertia
   r3 = Depth or diameter for circular cross-sections
   r4 = End-release code (node 1)*
   r5 = End-release code (node 2)*
   r6 = Shear factor in the element y-axis
   r7 = Temperature difference in the element y-axis
   r8 = Unrelated constant to this type of analysis

   * The end-release code for each end is specified by a six-digit number with combinations of zeros and ones. If a zero is placed in a particular location, the corresponding force is not known and will be calculated by the program, but if a one (1) is placed in that location, the force or moment corresponding to that direction is known to be zero due to a hinge or roller, and the program will remove the force. The six-digit code corresponds in order to the six degrees of freedom at each end of the beam element. For example, end-release code 000001 for a 2D beam element represents a condition in which the forces in the x and y directions are to be calculated and the moment about the Z-axis is zero, i.e., a hinge condition

2. Using BMSECDEF (Propsets > Beam Section) Command
   This command replaces real constants r1, r2 and r3. Values corresponding to real constants r4, r5, r6 and r7 also have to be input with this command. There are five cross sections available for the BEAM2D section library as shown in Figure 5-52.
   1. Solid Rectangular Section
      Constant_1 = Height of the beam (H)
      Constant_2 = Width of the beam (B)
   2. Solid Circular Section
      Constant_1 = Radius of the beam (R)
   3. Circular Hollow Section (Pipe)
      Constant_1 = Outside diameter (D)
      Constant_2 = Thickness (T)
4. Hollow Rectangular Section (Box)
   Constant_1 = Height of the beam (H)
   Constant_2 = Width of the beam (B)
   Constant_3 = Thickness associated with the height (TB)
   Constant_4 = Thickness associated with the width (TH)

5. Symmetric I-Section
   (This section is assumed thin-walled if material nonlinearities are considered)
   Constant_1 = Height of the beam (H)
   Constant_2 = Flange width (B)
   Constant_3 = Flange thickness (TH)
   Constant_4 = Web thickness (TB)

Material Properties
EX = Modulus of elasticity
ALPX = Coefficient of thermal expansion
NUXY = Poisson's ratio
DENS = Density
ETAN = Tangent modulus for bilinear elasto-plastic models
SIGYLD = Yield stress of bilinear elasto-plastic models
G1, G2,..., G8 = Shear relaxation (first, second,..., eighth) moduli
K1, K2,..., K8 = Bulk relaxation (first, second,..., eighth) moduli
TAUK1, TAUK2, ...
    TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and Second constants of the WLF equation

Element Loadings
Uniform pressure in terms of force per unit length (deformation dependency option)
• Thermal
• Gravitational
Output Results

Forces, moments, and stresses are available in the element coordinate system:

*For Linear Elastic Material Models:*

- $F_r, V_s =$ Nodal forces in element x- and y-directions
- $M_t =$ Nodal moment about the element z-direction
- $P/A =$ Centroidal stress ($F_r/A$)
- $M_t/St =$ Bending stress on the element -y side ($M_t h/2 I_z$)
- $S_{max} =$ Maximum stress $P/A + |M_t/St|$  
- $S_{min} =$ Minimum stress $P/A - |M_t/St|$

*where*

- $A =$ Cross-section area
- $h =$ Depth of beam
- $I_z =$ Moment of Inertia

*For Nonlinear Material Models*

Stresses $\tau_{xx}$ and $\tau_{xy}$ are available at selected integration points as described in the Note and Figures 4-53 and 4-54.

<table>
<thead>
<tr>
<th>Point</th>
<th>Integration y / H</th>
<th>Stress Points</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Newton-Cotes</td>
<td>Gaussian Quadrature</td>
</tr>
<tr>
<td>1</td>
<td>-.50</td>
<td>-0.4531</td>
</tr>
<tr>
<td>2</td>
<td>-.30</td>
<td>-0.2692</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0.50</td>
<td>0.2692</td>
</tr>
<tr>
<td>5</td>
<td>0.30</td>
<td>0.4531</td>
</tr>
</tbody>
</table>

Notes

Numerical Integration and Stress points for Section Number (1).
Figure 4-51. 2D Elastic Beam

XY: Global Cartesian Coordinate System
xy: Element Coordinate System
① ③: Face number for pressure application

Figure 4-52. Identification Parameters of the Built-In Section Library for BEAM2D

Type 1
- Solid Rectangular

Type 2
- Solid Circular

Type 3
- Circular Hollow

Type 4
- Hollow Rectangular

Type 5
- Symmetric I
Chapter 4  Element Library

Figure 4-53. Gauss Quadrature

Figure 4-54. Newton Cotes

References
Nonlinear 3D Beam Element (BEAM3D)

General Description
BEAM3D is a 2-node uniaxial beam element for three-dimensional nonlinear structural models. Six degrees of freedom (three translations and three rotations) are considered for each node. A third node or an orientation angle is required for the element orientation as shown in Figure 4-55. Unsymmetric cross-sections, when the shear center is not coincident with the center of gravity, can be considered (for example, channel and L-shape cross-sections). An offset from the centroidal axis of the beam is allowed for nodes (1 and 2).

Special Features
Linear elasticity, Large displacement, Finite rotation, Elasto-plasticity, Nonlinear elasticity, Viscoelasticity and Temperature-dependent linear elastic analysis.

Default Element Coordinate System (ECS = -1)
The element x-axis is defined by a vector starting from the first node towards the second. The orientation of the cross-section is defined by a third node or an angle. The third node, if specified, defines the element y-axis such that it is orthogonal to the element x-axis, starts from the first node towards the third, and lies in the plane defined by the three nodes.

If a third node is not specified, the orientation of the cross-section is defined through real constants r13 or r21 as the angle between yo and the element y-axis as shown in Figure 4-55(c). The axis yo is parallel to the global X-Y plane and normal to the element x-axis. A positive angle is measured from the yo axis using the right-hand rule such that the thumb points to the positive direction of the element x-axis. Real constants r13 and r21 are ignored if a third node exists.

The element z-axis completes a right-handed Cartesian coordinate system defined by the element x- and y-axes.

Element Group Options
Op. 1: Section type
   = 0; symmetric (default)
   = 1; unsymmetric
   = 2; symmetric tapered
Op. 2: Unused option for this element
Op. 3: Unused option for this element
Op. 4: Integration Method (only for material nonlinearity - see Note)
   = 0; Gauss Quadrature integration (default)
   = 1; Newton-Cotes integration
Op. 5: Material models
   = 0; linear elastic material model (default)
   = 1; von Mises elasto-plastic model (isotropic hardening)
   = 2; von Mises elasto-plastic model (Kinematic hardening)
   = 4; nonlinear elastic model
   = 8; viscoelastic material model
Op. 6: Large displacement option
   = 0; small displacement formulation (default)
   = 1; large displacement formulation
Op. 7: Unused option for this element
Op. 8: Unused option for this element

Real Constants
There are two different ways to define the section properties:
1. Using RCONST Command

   Symmetric and Unsymmetric Sections (Op. 1 = 0 or 1)
   r1 = Cross-sectional area
   r2 = Moment of inertia about the element y-axis
   r3 = Moment of inertia about the element z-axis
   r4 = Depth of beam (y-axis) or the diameter for a circular cross-section
   r5 = Width of beam (z-axis) or the diameter for a circular cross-section
   r6 = End-release code (node 1)*
   r7 = End-release code (node 2)*
   r8 = Torsion constant J (Polar moment of inertia for circular sections)*****
   r9 = Shear factor in the element y-axis (Asy/Area)**
   r10 = Shear factor in the element z-axis (Asz/Area)**
   r11 = Temperature difference in the element y-axis
   r12 = Temperature difference in the element z-axis
   r13 = Orientation angle (degrees)
   r14 = CTOR; Constant for maximum shear stress calculation*****
Unsymmetric Section only (Op. 1 = 1)

- $r_{15} = DX1$: x-distance of the section centroid relative to the nodal point location at node 1
- $r_{16} = DX2$: x-distance of the section centroid relative to the nodal point location at node 2
- $r_{17} = DY1$: y-distance of the section centroid relative to the nodal point location at node 1
- $r_{18} = DY2$: y-distance of the section centroid relative to the nodal point location at node 2
- $r_{19} = DZ1$: z-distance of the section centroid relative to the nodal point location at node 1
- $r_{20} = DZ2$: z-distance of the section centroid relative to the nodal point location at node 2
- $r_{21} = DYSC1$: y-distance of the shear center relative to the section centroid at node 1
- $r_{22} = DZSC1$: z-distance of the shear center relative to the section centroid at node 1
- $r_{23} = DYSC2$: y-distance of the shear center relative to the section centroid at node 2
- $r_{24} = DZSC2$: z-distance of the shear center relative to the section centroid at node 2
- $r_{25} = Ty$: y-distance of the point where stresses are to be calculated
- $r_{26} = Tz$: z-distance of the point where stresses are to be calculated
- $r_{27} = Iyz$: Centroidal product of inertia of the element cross-section

Symmetric Tapered (Op. 1 = 2)

(Sec. 1) and (Sec. 2) will refer to sectional properties of the beam at nodes 1 and 2.

- $r_{1} = $ Cross-sectional area for (Sec. 1)
- $r_{2} = $ Cross-sectional area for (Sec. 2)
- $r_{3} = $ Moment of inertia about the element y-axis at (Sec. 1)
- $r_{4} = $ Moment of inertia about the element y-axis at (Sec. 2)
- $r_{5} = $ Moment of inertia about the element z-axis at (Sec. 1)
- $r_{6} = $ Moment of inertia about the element z-axis at (Sec. 2)
- $r_{7} = $ Depth of beam (y-axis) (Sec. 1) or the diameter for a circular cross-section
- $r_{8} = $ Depth of beam (y-axis) (Sec. 2) or the diameter for a circular cross-section
- $r_{9} = $ Depth of beam (z-axis) (Sec. 1) or the diameter for a circular cross-section
- $r_{10} = $ Depth of beam (z-axis) (Sec. 2) or the diameter for a circular cross-section
- $r_{11} = $ End-release code at (node 1)
Chapter 4  Element Library

r12 = End-release code at (node 2)*
r13 = Torsion constant J of (Sec. 1)*****
r14 = Torsion constant J of (Sec. 2)*****
r15 = Shear factor in the element y-axis**
r16 = Shear factor in the element z-axis**
r17 = Temperature difference in the element y-axis
r18 = Temperature difference in the element z-axis
r19 = Unrelated constant to this type of analysis
r20 = CTOR; Constant for maximum shear stress calculation*****
r21 = Orientation angle (degrees)

* The end-release code for each end is specified by a six-digit number with combinations of zeros and ones. If a zero is placed in a particular location, the corresponding force is not known and will be calculated by the program, but if a one (1) is placed in that location, the force or moment corresponding to that direction is known to be zero due to a hinge or roller, and the program will remove the force. The six-digit code corresponds in order to the six degrees of freedom at each end of the beam element. For example, end release code 101100 for a 3D beam element represents a condition in which the forces in the x- and z-directions and the moment about the x-axis are zero, and the force in the y-direction and moments about y- and z-axes are to be calculated.

** Asy = beam cross-sectional area effective in shear in y-direction.
Asz = beam cross-sectional area effective in shear in z-direction.

*** Offset distances (Dy, Dz) shown in Figure 4-56 are measured positive from the nodal point in the positive element coordinate directions.

**** Stress point (Ty, Tz) and shear center distances (DYSC, DZSC) shown in Figure 4-56 are measured positive from the center of gravity in the positive element coordinate directions.

***** J and CTOR given below for some Beam cross-sections shown in Figure 4-57:
\[ \tau_{\text{max}} = \frac{(T)(\text{CTOR})}{J} \]

2. Using **BMSECDEF** Command

This command replaces some of the real constants defined before. However, values corresponding to real constants:
r6, r7, r9, r10, r11, r12, and r13 (for symmetric sections)
r6, r7, r9 to 13, r15 to r20, r25 and r26 (for unsymmetric sections)
r11, r12, r15 to r20 (for symmetric tapered sections)
also have to be input by this command.

There are 11 cross-sections available for the BEAM3D section library as shown in Figure 4-58.

1. Solid Rectangular Section
   - Symmetric/Unsymmetric Beams
     Constant_1 = Height of the beam (H)
     Constant_2 = Width of the beam (B)
   - Symmetric Tapered Beam
     Constant_1 = Height of the beam at node 1 (H1)
     Constant_2 = Width of the beam at node 1 (B1)
     Constant_3 = Height of the beam at node 2 (H2)
     Constant_4 = Width of the beam at node 2 (B2)

2. Solid Circular Section
   - Symmetric/Unsymmetric Beams
     Constant_1 = Radius (R)
   - Symmetric Tapered Beam
     Constant_1 = Radius at node 1 (R1)
     Constant_2 = Radius at node 2 (R1)

3. Circular Hollow Section (Pipe)
   - Symmetric/Unsymmetric Beams
     Constant_1 = Outside Diameter (D)
     Constant_2 = Thickness (T)
   - Symmetric Tapered Beam
     Constant_1 = Outside Diameter at node 1 (D1)
     Constant_2 = Thickness at node 1 (T1)
     Constant_3 = Outside Diameter at node 2 (D2)
     Constant_4 = Thickness at node 2 (T2)

4. Hollow Rectangular Section (Box)
   - Symmetric/Unsymmetric Beams
     Constant_1 = Height of the beam (H)
     Constant_2 = Width of the beam (B)
     Constant_3 = Thickness associated with the height (TB)
     Constant_4 = Thickness associated with the width (TH)
Chapter 4   Element Library

- Symmetric Tapered Beam
  Constant_1 = Height of the beam at node 1 (H1)
  Constant_2 = Width of the beam at node 1 (B1)
  Constant_3 = Thickness associated with the height at node 1 (TB1)
  Constant_4 = Thickness associated with the width at node 1 (TH1)
  Constant_5 = Height of the beam at node 2 (H2)
  Constant_6 = Width of the beam at node 2 (B2)
  Constant_7 = Thickness associated with the height at node 2 (TB2)
  Constant_8 = Thickness associated with the width at node 2 (TH2)

5. I-Section
   (This section is assumed thin-walled if material nonlinearities are considered)
   - Symmetric/Unsymmetric Beams
     Constant_1 = Height of the beam (H)
     Constant_2 = Flange width (B)
     Constant_3 = Flange thickness (TH)
     Constant_4 = Web thickness (TB)
   - Symmetric Tapered Beam
     Constant_1 = Height of the beam at node 1 (H1)
     Constant_2 = Flange width at node 1 (B1)
     Constant_3 = Flange thickness at node 1 (TH1)
     Constant_4 = Web thickness at node 1 (TB1)
     Constant_5 = Height of the beam at node 2 (H2)
     Constant_6 = Flange width at node 2 (B2)
     Constant_7 = Flange thickness at node 2 (TH2)
     Constant_8 = Web thickness at node 2 (TB2)

6. Trapezoidal Solid Section
   Constant_1 = Height of the beam (H)
   Constant_2 = Bottom width of the beam (B1)
   Constant_3 = Top width of the beam (B2)
   (Note that H > B1 > B2)

7. Channel Section
   (This section is assumed thin-walled if material nonlinearities are considered)
   Constant_1 = Height of the beam (H)
   Constant_2 = Flange width (B)
   Constant_3 = Flange thickness (TH)
   Constant_4 = Web thickness (TB)
Chapter 4 Element Library

8. Z-Section
   (This section is assumed thin-walled if material nonlinearities are considered)
   Constant_1 = Height of the beam (H)
   Constant_2 = Flange width (B)
   Constant_3 = Flange thickness (TH)
   Constant_4 = Web thickness (TB)

9. T-Section
   (This section is assumed thin-walled if material nonlinearities are considered)
   Constant_1 = Height of the beam (H)
   Constant_2 = Flange width (B)
   Constant_3 = Flange thickness (TH)
   Constant_4 = Web thickness (TB)

10. L-Section
    (This section is assumed thin-walled if material nonlinearities are considered)
    Constant_1 = Height of the beam (H)
    Constant_2 = Width (B)
    Constant_3 = Thickness associated with the height (TB)
    Constant_4 = Thickness associated with the width (TH)

11. User-Defined Thin-Walled Section (section number = 0)
    (Used with the unsymmetric section option of EGROUP)
    Constant_1 = y-coordinate of the cross-section's first node
    Constant_2 = z-coordinate of the cross-section's first node
    Constant_3 = Thickness of the first segment
    . . .
    . . .
    . . .
    Repeat constants_1, 2, and 3 for (up to) 20 nodes

Examples for the user-defined section are shown in Figure 4-10. It should be noted that:

- The wall thickness of the section has to be small compared to the total length of the section.
During the input process of coordinates and thickness at the section nodes, the beginning and end node numbers of each segment have to be consecutive.

A zero (0.0) thickness has to be always associated with the first node.

In case of tracing back a previously defined segment, a zero (0.0) thickness has to be used at the end node of this segment.

Multi-cell sections are not supported.

For a closed section (single cell), nodes have to be defined in the counter-clockwise direction.

If the section includes a closed cell, the input process has to start with one of the cell segments.

**Material Properties**

EX = Modulus of elasticity
ALPX = Coefficient of thermal expansion
NUXY = Poisson's ratio
DENS = Density
ETAN = Tangent modulus for bilinear elasto-plastic material models
SIGYLD = Yield stress of bilinear elasto-plastic material models
G1, G2,..., G8 = Shear relaxation (first, second,..., eighth) moduli
TAUG1, TAUG2,
..., TAUG8 = Time associated with G1 through G8
K1, K2,..., K8 = Bulk relaxation (first, second,..., eighth) moduli
TAUK1, TAUK2,
..., TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and Second constants of the WLF equation

**Element Loadings**

- Uniform pressure (in terms of force per unit length)
  - Pressure loading can be deformation-dependent
  - Pressure loading is applied without considering the effect of offsets
- Thermal
- Gravitational
Output Results

Forces, moments, and stresses are available in the element coordinate system. The directions of the output forces and moments are shown in Figure 4-59.

For Linear Elastic Material Models

- \( F_r, V_s, V_t \) = Nodal forces in the element x-, y-, and z-directions
- \( T_r, M_s, M_t \) = Nodal moments in the element x-, y-, and z-directions
- \( P/A \) = Centroidal stress \((F_r/A)\)
- \( T_r.C_tor/J \) = Torsional stress
- \( M_s/S_s \) = Bending stress on the element +z or Tz side symmetric section:
  
  \[
  M_s.b/2I_y; \text{ unsymmetric section: } (M_s.I_z + M_t.I_yz).T_z/(I_y.I_z-I_yz^2)
  \]
- \( M_t/S_t \) = Bending stress on the element -y or Ty side symmetric section:
  
  \[
  M_t.h/2I_z; \text{ unsymmetric section: } -(M_t.I_y + M_s.I_yz).T_y/(I_y.I_z-I_yz^2)
  \]
- \( S_{max} \) = Maximum stress for symmetric beams \((P/A + |M_s/S_s| + |M_t/S_t|)\)
- \( S_{min} \) = Minimum stress for symmetric beams \((P/A - |M_s/S_s| - |M_t/S_t|)\)
- \( S(y,z) \) = Combined stress at point \((T_y, T_z)\) for unsymmetric beams \((P/A + M_s/S_s + M_t/S_t)\)

where:

- \( A, I_y, I_z, h, b, J, C_{tor}, T_y, T_z, \text{ and } I_{yz} \)
- \( r_1, r_2, r_3, r_4, r_5, r_8, r_{14}, r_{25}, r_{26}, \text{ and } r_{27} \)

Torsional force \((T_r)\) and stress are estimated at the shear center

For Nonlinear Material Models

Stresses \( \tau_{xx}, \tau_{xy}, \tau_{xz} \) or \( \tau_{xs} \) are available at selected integration points as described in the Note and Figure 4-58.
Chapter 4   Element Library

Figure 4-55. 3D Symmetric Beam

(a) Alignment Definition Using a Third Node

(b) Alignment Definition Using an Orientation Angle

(c) Element y-axis is Parallel to Global X-Y Plane if Angle $\theta = 0^\circ$ (K is omitted)

XYZ: Global Cartesian Coordinate System

xyz: Element Coordinate System

1 2 3 4: Face numbers for pressure application
**Figure 4-56. 3D Unsymmetric Beam**

- **CG:** Center of gravity (Centroid) of cross section
- **SC:** Shear center of cross section
- **t:** Nodal point
- **SP:** Point at which the stress is required

---

**Figure 4-57. J and CTOR Constants for Some Beam Cross-Sections**

<table>
<thead>
<tr>
<th>Cross-Section</th>
<th>CTOR and J</th>
<th>Shear Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CTOR = r ; J = Ip = ( \frac{\pi r^4}{4} )</td>
<td>( \frac{9}{10} = 0.90 )</td>
</tr>
<tr>
<td></td>
<td>CTOR = r ; J = Ip = Iyy + Izz</td>
<td>( \frac{1}{2} = 0.50 )</td>
</tr>
<tr>
<td></td>
<td>CTOR = ( \frac{(3a + 1.8b)}{8a^2b^2} \cdot J )</td>
<td>( \frac{5}{6} = 0.8333 )</td>
</tr>
</tbody>
</table>

Where:

\[
J = ab^3 \left[ \frac{16}{3} - 3.36 \frac{b}{a} \left( 1 - \frac{b^4}{12a^2} \right) \right]
\]
Figure 4-58. Identification Parameters of the Built-in BEAM3D Section Library (viewed by looking in the negative x-direction)

- **Type 1**: Rectangular
- **Type 2**: Solid Circular
- **Type 3**: Circular Hollow
- **Type 4**: Hollow Rectangular
- **Type 5**: Symmetric I
- **Type 6**: Trapezoidal Solid
- **Type 7**: Channel
- **Type 8**: Z
- **Type 9**: T
- **Type 10**: L
- **Type 0**: User Defined Thin-Walled
Note
Numerical Integration and Stress Points for the Built-in BEAM3D Section Library (see Figure 4-58).
### Section Number = 1 and 6

<table>
<thead>
<tr>
<th>Point</th>
<th>Integration Points</th>
<th>Stress Points</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Newton-Cotes</td>
<td>Gaussian Quadrature</td>
</tr>
<tr>
<td></td>
<td>y/H</td>
<td>z/B</td>
</tr>
<tr>
<td>1</td>
<td>-0.5</td>
<td>-0.5</td>
</tr>
<tr>
<td>2</td>
<td>-0.5</td>
<td>-0.3</td>
</tr>
<tr>
<td>3</td>
<td>-0.5</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>-0.5</td>
<td>0.3</td>
</tr>
<tr>
<td>5</td>
<td>-0.3</td>
<td>-0.5</td>
</tr>
<tr>
<td>6</td>
<td>-0.3</td>
<td>-0.3</td>
</tr>
<tr>
<td>7</td>
<td>-0.3</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>-0.3</td>
<td>0.3</td>
</tr>
<tr>
<td>9</td>
<td>-0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>10</td>
<td>-0.3</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>0</td>
<td>-0.5</td>
</tr>
<tr>
<td>12</td>
<td>0</td>
<td>-0.3</td>
</tr>
<tr>
<td>13</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>0</td>
<td>0.3</td>
</tr>
<tr>
<td>15</td>
<td>0</td>
<td>0.5</td>
</tr>
<tr>
<td>16</td>
<td>0.3</td>
<td>-0.5</td>
</tr>
<tr>
<td>17</td>
<td>0.3</td>
<td>-0.3</td>
</tr>
<tr>
<td>18</td>
<td>0.3</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>0.3</td>
<td>0.3</td>
</tr>
<tr>
<td>20</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>21</td>
<td>0.5</td>
<td>-0.5</td>
</tr>
<tr>
<td>22</td>
<td>0.5</td>
<td>-0.3</td>
</tr>
<tr>
<td>23</td>
<td>0.5</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>0.5</td>
<td>0.3</td>
</tr>
<tr>
<td>25</td>
<td>0.5</td>
<td>0.5</td>
</tr>
</tbody>
</table>
Section Number = 2

<table>
<thead>
<tr>
<th>Point</th>
<th>Integration Points</th>
<th>Stress Points</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Newton-Cotes</td>
<td>Gaussian Quadrature</td>
</tr>
<tr>
<td></td>
<td>r/R* s/pv*</td>
<td>r/R* s/p*</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0.6</td>
<td>0.5385</td>
</tr>
<tr>
<td>3</td>
<td>1.0</td>
<td>0.9062</td>
</tr>
<tr>
<td>4</td>
<td>0.6</td>
<td>0.25</td>
</tr>
<tr>
<td>5</td>
<td>1.0</td>
<td>0.25</td>
</tr>
<tr>
<td>6</td>
<td>0.6</td>
<td>0.5</td>
</tr>
<tr>
<td>7</td>
<td>1.0</td>
<td>0.5</td>
</tr>
<tr>
<td>8</td>
<td>0.6</td>
<td>0.75</td>
</tr>
<tr>
<td>9</td>
<td>1.0</td>
<td>0.75</td>
</tr>
<tr>
<td>10</td>
<td>0.6</td>
<td>1.0</td>
</tr>
<tr>
<td>11</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>12</td>
<td>0.6</td>
<td>1.25</td>
</tr>
<tr>
<td>13</td>
<td>1.0</td>
<td>1.25</td>
</tr>
<tr>
<td>14</td>
<td>0.6</td>
<td>1.5</td>
</tr>
<tr>
<td>15</td>
<td>1.0</td>
<td>1.5</td>
</tr>
<tr>
<td>16</td>
<td>0.6</td>
<td>1.75</td>
</tr>
<tr>
<td>17</td>
<td>1.0</td>
<td>1.75</td>
</tr>
</tbody>
</table>

* (r) is in the radial direction
(s) is in the circumferential direction
(π) = 3.14159

Section Number = 3

A Trapezoidal rule is used with Nine (9) integration points. The integration points divide the circumference to equally spaced segments. Stresses TAUXX and TAUXS are available for points 1, 3, 5 and 7 as shown in Figure 4-58 where the (s) direction is counter-clockwise or along the consecutive integration point numbering.

Section Number = 4, 5, 7, 8, 9 and 10

Simpson's rule is used for integration. The integration points divide the cross-section to equally spaced segments.
Chapter 4  Element Library

<table>
<thead>
<tr>
<th>Section Number</th>
<th>Number of Integration Points</th>
<th>Stress Points for TAUXX and TAUXS*</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>17</td>
<td>1,3,5,7,9,11,13,15</td>
</tr>
<tr>
<td>5</td>
<td>17</td>
<td>1,3,5,9,11,13,17</td>
</tr>
<tr>
<td>7</td>
<td>9</td>
<td>1,3,5,7,9</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>1,3,5,7,9</td>
</tr>
<tr>
<td>9</td>
<td>11</td>
<td>1,3,5,9,11</td>
</tr>
<tr>
<td>10</td>
<td>9</td>
<td>1,3,5,7,9</td>
</tr>
</tbody>
</table>

* The (S) direction is counterclockwise for the closed cross-section or along the consecutive integration point numbering.

Section Number = 0 (User-defined section)

Simpson's rule is used for integration. The number of integration points equals the number of section defined nodes. Stress components TAUXX and TAUXS are available at the integration point defined by real constants r25 and r26 (Ty, Tz). The (s) direction is counter-clockwise for the closed cross-section or along the consecutive integration point numbering.

References

Nonlinear 2D 4- to 8-Node Isoparametric Plane Stress, Plane Strain, and Body of Revolution Element (PLANE2D)

General Description
PLANE2D is a 4- to 8-node isoparametric two-dimensional element for the nonlinear analysis of plane stress, plane strain or axisymmetric models. All elements have to be defined in the global X-Y plane (default) or the x-y plane of the Cartesian coordinate system specified by the CSREF command (Geometry > Coordinate_Systems > Reference for 2D Model). All elements have to be defined in the X-Y plane. Axisymmetric structures have to be modeled in the positive x half plane, in which x represents the radial direction and y refers to the axis of symmetry. Only two translational degrees of freedom are considered for each node.

The nodal input pattern is shown in Figure 4-60 for an 8-node element illustrating its local node numbering. The element however can be used with 4- to 8-nodes by issuing zeros (0) at the location of the missing nodes during the element connectivity definition. Triangular shaped elements can also be considered. In this case, the third and fourth nodes (for 4-node elements) and the third, fourth and seventh nodes (for 5- to 8-node elements) have to be assigned the same global node number, as shown in Figure 4-60. Both clockwise and counter-clockwise node numbering are allowed.

Special Features
Plasticity, Thermo-plasticity, User-defined material models, Large displacement, Nonlinear elasticity, Mooney-Rivlin, Ogden and Blatz-Ko models, Wrinkling membrane, Viscoelasticity and Creep

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second, and the element y-axis is normal to the x-axis toward the fourth node.

Element Group Options
Op. 1: Solid/Fluid flag. Use default value (0: Solid)
Op. 2: Integration type
For 4-node elements:
= 0 or 1; QM6 incompatible element (default)
= 2; Full integration (2 x 2 integration points)
= 3; displacement-pressure (u/p) method:
Chapter 4  Element Library

(Available for Mooney-Rivlin, Ogden, and large strain plasticity models.)

For 5- to 8-node elements:

= 0; reduced integration (2 x 2 integration points)
= 1 or 2; full integration (3 x 3 integration points) (default)
= 3; displacement-pressure (u/p) method:
(Available for Mooney-Rivlin, Ogden, and large strain plasticity models.)

Op. 3: Type
= 0; Plane Stress (default)
= 1; Axisymmetric (a one radian sector is considered, thus loads for a one radian sector should be applied).
= 2; Plane Strain

Op. 4: Stress Direction
= 0; stresses are calculated in the global Cartesian coordinate system
= 1; stresses are calculated in the coordinate system defined in the ECS for each element

Op. 5: Material Type
= 0; linear elastic material model (default)
= 1; von Mises elasto-plastic model (isotropic hardening)
= 2; von Mises elasto-plastic model (kinematic hardening)
= 3; Mooney-Rivlin (hyperelastic model)
= 4; nonlinear elastic model
= 5; Drucker-Prager elastic-perfectly-plastic model (only for plane strain and axisymmetric cases)
= 6; Ogden hyperelastic material model
= 8; viscoelastic material model
= 9; Blatz-Ko hyperelastic material model
= 10; wrinkling membrane for plane stress (with Op. 3 = 0)
= 11; concrete model
= 12; Tresca isotropic plasticity model
= 13; Tresca kinematic plasticity model
= -20 to -1; user-defined model

Op. 6: Displacement Formulation
= 0; Small displacement formulation (default)
= 1; Updated Lagrangian formulation
= 2; Total Lagrangian formulation

Op. 7: Material creep
= 0; do not consider creep
= 1; include creep effects
= -100 to -1; user’s creep model
Op. 8: Strain plasticity
   = 0; Small
   = 1; Large

Real Constants
r1 = Thickness (only for plane stress analysis)
r2 = Material angle (β)
The material angle is measured with respect to the coordinate system specified by the ECS attribute of each element.

Material Properties (See Figure 4-60 for material directions)
EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
GXY = Shear modulus relating the first and second material directions
ECONX = Electric conductivity in the first material direction
ECONY = Electric conductivity in the second material direction
DENS = Density
ETAN = Tangent modulus for bilinear elasto-plastic models
SIGYLD = Yield stress of bilinear elasto-plastic models
CREEPC = Creep constants for the classical creep law (3 constants)
CREEPX = Creep constants for the exponential creep law (7 constants)
FRCANG = Angle of internal friction
COHESN = Cohesive strength
MOONEY_A = First constant of the Mooney-Rivlin material model
MOONEY_B = Second constant of the Mooney-Rivlin material model
MOONEY_C = Third constant of the Mooney-Rivlin material model
MOONEY_D = Fourth constant of the Mooney-Rivlin material model
MOONEY_E = Fifth constant of the Mooney-Rivlin material model
MOONEY_F = Sixth constant of the Mooney-Rivlin material model
Chapter 4   Element Library

MU1 = First constant of the Ogden material model
MU2 = Second constant of the Ogden material model
MU3 = Third constant of the Ogden material model
MU4 = Fourth constant of the Ogden material model
ALPH1 = First power coefficient of the Ogden material model
ALPH2 = Second power coefficient of the Ogden material model
ALPH3 = Third power coefficient of the Ogden material model
ALPH4 = Fourth power coefficient of the Ogden material model
G1, G2, ..., G8 = Shear relaxation (first, second, ..., eighth) moduli
TAUG1, TAUG2, ...
TAUG8 = Time associated with G1 through G8
K1, K2, ..., K8 = Bulk relaxation (first, second, ..., eighth) moduli
TAUK1, TAUK2, ...
TAUK8 = Time associated with K1 through K8
REFTEMP = Glass transition temperature
VC1, VC2 = First and second constants of the WLF equation
Mcij = User-defined material constants (up to 20 values). Constants are designated as MC11, MC12, ..., MC56 (i = 1, 6 and j = i, 6. MC66 is not used)
FPC = Concrete ultimate compressive strength
EPSU = Concrete ultimate compressive strain
DAMP = Material damping coefficient

Orthotropic material properties are not available for elasto-plastic models.

For linear elastic material models, the element is assigned orthotropic properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the ith and jth material directions:

\[ \nu_{ij}/E_i = \nu_{ji}/E_j \]

Where \( \nu_{ij}, E_i, \) and \( E_j \) are provided as input and \( \nu_{ji} \) calculated internally by the program.
Element Loadings

- Thermal
- Gravitational
- Pressure (with or without deformation-dependency)

Output Results

Stress components including the von Mises stress are available at all nodes and at the center of each element in either the global Cartesian coordinate system or the local coordinate system defined by the ECS. For plasticity, wrinkling, creep, concrete, and visco-elastic models, stresses are written at the integration points. For all other material models, stresses are written at the nodes. See Figures 4-61 and the corresponding tables. For the concrete model, either the damage factor or the yield factor can be chosen in the output. The option is given in the Analysis > NONLINEAR > Print Ops command.

Figure 4-60. 2D Isoparametric Solid

If ECS = -1, the x axis of the element is the vector from node 1 to node 2 in the element connectivity.
Figure 4-61. Stress Printout Convention for 2D Continuum Elements)

Integration Point Locations for PLANE2D Elements - 2 Point Integration (2x2)

<table>
<thead>
<tr>
<th>Location</th>
<th>r-Coordinate</th>
<th>s-Coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.57735</td>
<td>-0.57735</td>
</tr>
<tr>
<td>2</td>
<td>-0.57735</td>
<td>+0.57735</td>
</tr>
<tr>
<td>3</td>
<td>+0.57735</td>
<td>-0.57735</td>
</tr>
<tr>
<td>4</td>
<td>+0.57735</td>
<td>+0.57735</td>
</tr>
</tbody>
</table>

Integration Point Locations for PLANE2D Elements - 3 Point Integration (3x3)

<table>
<thead>
<tr>
<th>Location</th>
<th>r-Coordinate</th>
<th>s-Coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>2</td>
<td>-0.774597</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>-0.774597</td>
<td>+0.774597</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>-0.774597</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>+0.774597</td>
</tr>
<tr>
<td>7</td>
<td>+0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>8</td>
<td>+0.774597</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>+0.774597</td>
<td>+0.774597</td>
</tr>
</tbody>
</table>

References


Nonlinear 2D 3- to 6-Node Triangular Plane Stress, Plane Strain, and Body of Revolution Element (TRIANG)

General Description
TRIANG is a 3- to 6-node triangular two-dimensional element for plane stress, plane strain, or axisymmetric nonlinear structural models. All elements have to be defined in the global X-Y plane (default) or the x-y plane of the Cartesian coordinate system specified by the CSREF command (Geometry > Coordinate Systems> Reference for 2D Model). Axisymmetric structures have to be modeled in the positive x half plane, in which x represents the radial direction and y refers to the axis of symmetry for axisymmetric structures. Only two translational degrees of freedom (UX and UY) are considered for each node.

The nodal input pattern for this element is shown in Figure 4-62. Both clockwise and counter-clockwise node numbering are allowed. For transitional elements, missing nodes are issued zeros (0) at their location during the element connectivity definition.

Special Features
Plasticity, Thermo-plasticity, User-defined material models, Large displacement, Nonlinear elasticity, Mooney-Rivlin, Ogden and Blatz-Ko models, Wrinkling membrane, Viscoelasticity and Creep.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis is normal to the x-axis toward the third node.

Element Group Options
Op. 1: Unused option for this element
Op. 2: Integration Type. Use default value (1-point integration for 3-node elements and 3-point integration for 6-node elements)
Op. 3: 2D Type
  = 0; Plane Stress (default)
  = 1; Axisymmetric
  = 2; Plane Strain
Op. 4: Stress Direction
  = 0; stresses are calculated in the global Cartesian coordinate system
  = 1; stresses are calculated in the coordinate system defined in the ECS for each element.
**Op. 5: Material Type**
- = 0; linear elastic material model (default)
- = 1; von Mises elasto-plastic model (isotropic hardening)
- = 2; von Mises elasto-plastic model (kinematic hardening)
- = 3; Mooney-Rivlin (hyperelastic model)
- = 4; nonlinear elastic model
- = 5; Drucker-Prager elastic-perfectly-plastic model (only for plane strain and axisymmetric cases)
- = 6; Ogden hyperelastic material model
- = 8; viscoelastic material model
- = 9; Blatz-Ko hyperelastic material model
- = 10; wrinkling membrane model for plane stress (with Op. 3 = 0)
- = 11; concrete model
- = 12; Tresca isotropic plasticity model
- = 13; Tresca kinematic plasticity model
- -20 to -1; user-defined model

**Op. 6: Displacement Formulation**
- = 0; Small displacement formulation (default)
- = 1; Updated Lagrangian formulation
- = 2; Total Lagrangian formulation
- -100 to -1; user-creep model

**Op. 7: Material Creep**
- = 0; do not consider creep
- = 1; include creep effects

**Op. 8: Strain plasticity**
- = 0; Small strain
- = 1; Large strain

**Real Constants**

- \( r_1 \): Thickness (only for plane stress analysis)
- \( r_2 \): Material angle (Beta)

The material angle is measured with respect to the default element coordinate system, as shown in Figure 4-62 for ECS = -1, or with respect to the local coordinate system defined by the ECS for each element as shown in Figure 4-62.
Material Properties
(See Figure 4-62 for material directions)

EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
GXY = Shear modulus relating the first and second material directions
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
DENS = Density
ECONX = Electric conductivity in the first material direction
ECONY = Electric conductivity in the second material direction
ETAN = Tangent modulus for bilinear elasto-plastic models
SIGYLD = Yield stress of bilinear elasto-plastic models
CREEPC = Creep constants for the classical creep law (3 constants)
CREEPX = Creep constants for the exponential creep law (7 constants)
FRCANG = Angle of internal friction
COHESN = Cohesive strength
MOONEY_A = First constant of the Mooney-Rivlin material model
MOONEY_A = Second constant of the Mooney-Rivlin material model
MOONEY_C = Third constant of the Mooney-Rivlin material model
MOONEY_D = Fourth constant of the Mooney-Rivlin material model
MOONEY_E = Fifth constant of the Mooney-Rivlin material model
MOONEY_F = Sixth constant of the Mooney-Rivlin material model
MU1 = First constant of the Ogden material model
MU2 = Second constant of the Ogden material model
MU3 = Third constant of the Ogden material model
MU4 = Fourth constant of the Ogden material model
ALPH1 = First power coefficient of the Ogden material model
ALPH2 = Second power coefficient of the Ogden material model
Chapter 4   Element Library

ALPH = Third power coefficient of the Ogden material model
ALPH4 = Fourth power coefficient of the Ogden material model
G1, G2, ..., G8 = Shear relaxation (first, second, ..., eighth) moduli
TAUG1, TAUG2, ..., TAUG8 = Time associated with G1 through G8
K1, K2, ..., K8 = Bulk relaxation (first, second, ..., eighth) moduli
TAUK1, TAUK2, ..., TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and second constants of the WLF equation
Mcij = User-defined material constants (up to 20 values. Constants are designated as MC11, MC12, ..., MC56 (i = 1, 6 and j = i, 6. MC66 is not used)
FPC = Concrete ultimate compressive strength
EPSU = Concrete ultimate compressive strain

Orthotropic material properties are not available for elasto-plastic models.

For linear elastic material models, the element is assigned orthotropic properties if at least one of the following conditions is satisfied:
1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the ith and jth material directions:

\[ \frac{\nu_{ij}}{E_i} = \frac{\nu_{ji}}{E_j} \]

Where \( \nu_{ij} \), \( E_i \), and \( E_j \) are provided as input and \( \nu_{ji} \) calculated internally by the program.

Element Loadings

- Thermal
- Gravitational
- Pressure (with or without deformation-dependency)
Output Results

Stress components including the von Mises stress are available at all nodes and at the center of the element in either the global coordinate system, or the coordinate system defined by the ECS for each element. For plasticity, wrinkling, creep, concrete, and visco-elastic models, stresses are written at the integration points. For all other material models, stresses are written at the nodes. See Note for linear TRIANG.

For concrete model, either the damage factor or the yield factor can be chosen in the output. The option is given in the Analysis > NONLINEAR > Print Ops command.

**Figure 4-62. 2D Triangular Element**

If ECS = -1, β is measured differently for each element which may not be proper to use for non-isotropic materials.
Reference

Nonlinear 3D 8- to 20-Node Isoparametric Solid Element (SOLID)

General Description
SOLID is an 8- to 20-node isoparametric three-dimensional solid element for nonlinear analysis of structural models. Only three translational degrees of freedom are considered per node.

The nodal input pattern is shown in Figure 4-63 for the local node numbering of a 20-node element. Both clockwise and counter-clockwise node numbering are allowed. Transitional elements can be considered by issuing zeros (0) at the location of missing nodes during the element connectivity definition. Prism and tetrahedron-shaped elements may be considered only with the 8-node element option. Prism-shaped elements may be formed by duplicating nodes (3 and 4) and (7 and 8). Pyramid elements are obtained if nodes 5, 6, 7 and 8 have the same global node number. Figure 4-64 illustrates the latter two element shapes.

Special Features
Plasticity, Thermo-plasticity, User-defined material models, Large displacement, Nonlinear elasticity, Mooney-Rivlin, Ogden and Blatz-Ko models, Viscoelasticity and Creep.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 4. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options
Op. 1: Solid/Fluid flag. Use default value (0: Solid element)
Op. 2: Integration Type.

For 8-node elements:
= 0 or 1; hybrid element for geometric nonlinearity only, mixed displacement and stress formulation (default)
= 2; full integration, displacement-based formulation (2 x 2 x 2 integration points)
= 3; displacement-pressure (u/p) method:
(Available for Mooney-Rivlin, Ogden, and large strain plasticity models.)
For 9- to 20-node elements:

= 0; reduced integration, displacement-based formulation (2 x 2 x 2 integration points)
= 1 or 2; full integration, displacement-based formulation (3 x 3 x 3 integration points)

Op. 3: Unused option for this element

Op. 4: Stress Direction

= 0; stresses are calculated in the global Cartesian coordinate system
= 1; stresses are calculated in the coordinate system defined in the ECS for each element

Op. 5: Material type

= 0; linear elastic material model (default)
= 1; von Mises elasto-plastic model (isotropic hardening)
= 2; von Mises elasto-plastic model (kinematic hardening)
= 3; Mooney-Rivlin hyperelastic model
= 4; nonlinear elastic model
= 5; Drucker-Prager elastic-perfectly-plastic model
= 6; Ogden hyperelastic material model
= 8; viscoelastic material model
= 9; Blatz-Ko hyperelastic material model
= 11; concrete model
= 12; Tresca isotropic plasticity model
= 13; Tresca kinematic plasticity model
= -20 to -1; user-defined model

Op. 6: Displacement Formulation

= 0; Small (default)
= 1; Updated Lagrangian
= 2; Total Lagrangian

Op. 7: Material Creep

= 0; do not consider creep
= 1; include creep effects
= -100 to -1; user’s creep model

Op. 8: Strain plasticity

= 0; Small
= 1; Large
Real Constants

Nine constants have to be defined in case of using orthotropic or anisotropic models. The nine values are used to determine the coordinates of three points (1’, 2’, 3’) to define the material coordinate system. The first direction of the material coordinate system, denoted by “a” in Figure 4-63, is defined by a vector connecting point 1’ to point 2’. The b-axis (second material direction) lies in the plane of the three defined points and goes from a-axis toward the third point. The c-axis (third material direction) completes a right-hand Cartesian coordinate system. The above material directions are defined with respect to the defined element coordinate system as specified by the active ECS.

\[
\begin{align*}
    r_1 &= x\text{-coordinate of point 1’} \\
    r_2 &= y\text{-coordinate of point 1’} \\
    r_3 &= z\text{-coordinate of point 1’} \\
    r_4 &= x\text{-coordinate of point 2’} \\
    r_5 &= y\text{-coordinate of point 2’} \\
    r_6 &= z\text{-coordinate of point 2’} \\
    r_7 &= x\text{-coordinate of point 3’} \\
    r_8 &= y\text{-coordinate of point 3’} \\
    r_9 &= z\text{-coordinate of point 3’}
\end{align*}
\]

The real constants are interpreted based on the element coordinate system (ECS).

Material Properties

\[
\begin{align*}
    E_X &= \text{Modulus of elasticity in the first material direction} \\
    E_Y &= \text{Modulus of elasticity in the second material direction} \\
    E_Z &= \text{Modulus of elasticity in the third material direction} \\
    \nu_{XY} &= \text{Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)} \\
    \nu_{YZ} &= \text{Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the second direction)} \\
    \nu_{XZ} &= \text{Poisson's ratio relating the first and third material directions (strain in the third direction due to unit strain along the first direction)} \\
    K_X &= \text{Thermal conductivity in the first material direction} \\
    K_Y &= \text{Thermal conductivity in the second material direction}
\end{align*}
\]
Chapter 4 Element Library

KZ = Thermal conductivity in the third material direction
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
ALPZ = Coefficient of thermal expansion in the third material direction
DENS = Density
GXY = Shear modulus relating the first and second material directions
GYZ = Shear modulus relating the second and third material directions
GXZ = Shear modulus relating the first and third material directions
ECONX = Electric conductivity in the first material direction
ECONY = Electric conductivity in the second material direction
ECONZ = Electric conductivity in the third material direction
CREEPC = Creep constants for classical creep law (3 constants)
CREEPX = Creep constants for the exponential creep law (7 constants)
ETAN = Tangent modulus for bilinear elasto-plastic models
SIGYLD = Yield stress for bilinear elasto-plastic models
FRCANG = Angle of internal friction
COHESN = Cohesive strength
MOONEY_A = First constant of the Mooney-Rivlin material model
MOONEY_B = Second constant of the Mooney-Rivlin material model
MOONEY_C = Third constant of the Mooney-Rivlin material model
MOONEY_D = Fourth constant of the Mooney-Rivlin material model
MOONEY_E = Fifth constant of the Mooney-Rivlin material model
MOONEY_F = Sixth constant of the Mooney-Rivlin material model
MU1 = First constant of the Ogden material model
MU2 = Second constant of the Ogden material model
MU3 = Third constant of the Ogden material model
MU4 = Fourth constant of the Ogden material model
ALPH1 = First power coefficient of the Ogden material model
ALPH2 = Second power coefficient of the Ogden material model
ALPH3 = Third power coefficient of the Ogden material model
ALPH4 = Fourth power coefficient of the Ogden material model
G1, G2,..., G8 = Shear relaxation (first, second,..., eighth) moduli
Chapter 4  Element Library

TAUG1, TAUG2, 
..., TAUG8 = Time associated with G1 through G8
K1, K2,..., K8 = Bulk relaxation (first, second,..., eighth) moduli
TAUK1, TAUK2, 
..., TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and second constants of the WLF equation
Meij = User-defined material constants (up to 20 values). Constants are designated as MC11, MC12,... MC56 (i = 1, 6 and j = i, 6. MC66 is not used)
FPC = Concrete ultimate compressive strength
EPSU = Concrete ultimate compressive strain

Orthotropic material properties are not available for elasto-plastic models.

For linear elastic material models, the element is assigned orthotropic properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the $i^{th}$ and $j^{th}$ material directions:

$$\nu_{ij}/E_i = \nu_{ji}/E_j$$

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.

Element Loadings

- Thermal
- Gravitational
- Pressure (with or without deformation-dependency):

The direction of the applied pressure on the six faces of the element is controlled by the order in which the element is labeled. The first four node labels define face 5. Looking from outside of the element to face 5, if the face is labeled in the counter-clockwise direction, positive pressure values imply inward loading to this face as well as the other five. Conversely, if face 5 is labeled in the clockwise direction, positive pressure to any of the faces implies outward loading.
Output Results

Stress components in either the global coordinate system or the coordinate system defined by the ECS for each element are available at all nodes and at the center of each element. The directions of the stress components are illustrated in Figure 4-65 for ECS = -1. For plasticity, wrinkling, creep, concrete, and visco-elastic models, stresses are written at the integration points. For all other material models, stresses are written at the nodes. See Figures 4-66 and 4-67.

For the concrete model, either the damage factor or the yield factor can be chosen in the output. The option is given in the Analysis > NONLINEAR > Print Ops command.

Figure 4-63. 3D Isoparametric Solid

<table>
<thead>
<tr>
<th>XYZ:</th>
<th>Global Cartesian Coordinate System</th>
</tr>
</thead>
<tbody>
<tr>
<td>xyz:</td>
<td>Element Coordinate System</td>
</tr>
<tr>
<td>abc:</td>
<td>Material Coordinate System</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7</td>
<td>Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)</td>
</tr>
</tbody>
</table>
Figure 4-64. Nonlinear 3D 8-Node Solid

Prism Shaped Solid Element

Pyramid Shaped Solid Element

Figure 4-65. 3D Isoparametric Solid

Directions of stress components output by COSMOS/M
Chapter 4 Element Library

Figure 4-66. 8-Node 3D Solid Element (2x2x2 Integration Points)

Section 1
\( t = -0.57735 \)

Section 2
\( t = +0.57735 \)
Figure 4-67. 20-Node 3D Solid Element (3x3x3 Integration Points)

Integration Point Locations for SOLID Elements
2 Point Integration (2x2x2)

<table>
<thead>
<tr>
<th>Location</th>
<th>r-Coordinate</th>
<th>s-Coordinate</th>
<th>t-Coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section 1</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>-0.57735</td>
<td>-0.57735</td>
<td>-0.57735</td>
</tr>
<tr>
<td>2</td>
<td>-0.57735</td>
<td>+0.57735</td>
<td>-0.57735</td>
</tr>
<tr>
<td>3</td>
<td>+0.57735</td>
<td>-0.57735</td>
<td>-0.57735</td>
</tr>
<tr>
<td>4</td>
<td>+0.57735</td>
<td>+0.57735</td>
<td>-0.57735</td>
</tr>
<tr>
<td><strong>Section 2</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-0.57735</td>
<td>-0.57735</td>
<td>+0.57735</td>
</tr>
<tr>
<td>6</td>
<td>-0.57735</td>
<td>+0.57735</td>
<td>+0.57735</td>
</tr>
<tr>
<td>7</td>
<td>+0.57735</td>
<td>-0.57735</td>
<td>+0.57735</td>
</tr>
<tr>
<td>8</td>
<td>+0.57735</td>
<td>+0.57735</td>
<td>+0.57735</td>
</tr>
</tbody>
</table>
### Integration Point Locations for SOLID Elements

#### 3 Point Integration (3x3x3)

<table>
<thead>
<tr>
<th>Location</th>
<th>r-Coordinate</th>
<th>s-Coordinate</th>
<th>t-Coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.774597</td>
<td>-0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>2</td>
<td>-0.774597</td>
<td>0</td>
<td>-0.774597</td>
</tr>
<tr>
<td>3</td>
<td>-0.774597</td>
<td>+0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>-0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>0</td>
<td>-0.774597</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>+0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>7</td>
<td>+0.774597</td>
<td>-0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>8</td>
<td>+0.774597</td>
<td>0</td>
<td>-0.774597</td>
</tr>
<tr>
<td>9</td>
<td>+0.774597</td>
<td>+0.774597</td>
<td>-0.774597</td>
</tr>
<tr>
<td>10</td>
<td>-0.774597</td>
<td>-0.774597</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>-0.774597</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>-0.774597</td>
<td>+0.774597</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>0</td>
<td>-0.774597</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>0</td>
<td>+0.774597</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>+0.774597</td>
<td>-0.774597</td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>+0.774597</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>18</td>
<td>+0.774597</td>
<td>+0.774597</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>-0.774597</td>
<td>-0.774597</td>
<td>+0.774597</td>
</tr>
<tr>
<td>20</td>
<td>-0.774597</td>
<td>0</td>
<td>+0.774597</td>
</tr>
<tr>
<td>21</td>
<td>-0.774597</td>
<td>+0.774597</td>
<td>+0.774597</td>
</tr>
<tr>
<td>22</td>
<td>0</td>
<td>-0.774597</td>
<td>+0.774597</td>
</tr>
<tr>
<td>23</td>
<td>0</td>
<td>0</td>
<td>+0.774597</td>
</tr>
<tr>
<td>24</td>
<td>0</td>
<td>+0.774597</td>
<td>+0.774597</td>
</tr>
<tr>
<td>25</td>
<td>+0.774597</td>
<td>-0.774597</td>
<td>+0.774597</td>
</tr>
<tr>
<td>26</td>
<td>+0.774597</td>
<td>0</td>
<td>+0.774597</td>
</tr>
<tr>
<td>27</td>
<td>+0.774597</td>
<td>+0.774597</td>
<td>+0.774597</td>
</tr>
</tbody>
</table>

### References


Nonlinear 3D 4- and 10-Node Tetrahedron Solid Element (TETRA4 or TETRA10)

General Description
TETRA4 is a 4-node and TETRA10 is a 10-node three dimensional tetrahedral solid element for nonlinear structural problems. Only three translational degrees of freedom are considered per node.

The nodal input pattern for this element is shown in Figures 4-68 and 4-69. Both clockwise and counterclockwise node numbering are allowed. All midside nodes should fall within the middle third of the element edges.

Special Features
Plasticity, Thermo-plasticity, User-defined material models, Large displacement, Nonlinear elasticity, Mooney-Rivlin, Ogden and Blatz-Ko models, Viscoelasticity and Creep.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes (1, 2, 3), perpendicular to the x-axis toward node 3. The element z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options
Op. 1: Unrelated option to this type of analysis (use default value)
Op. 2: Integration Type
   = 0; 1-point integration (only for TETRA4)
   = 1; 4-point integration (default)
   = 2; 16-point integration (NSTAR only)
Op. 3: Unrelated option to this type of analysis (use default value)
Op. 4: Stress Direction
   = 0; stresses are calculated in the global Cartesian system
   = 1; stresses are calculated in the coordinate system defined by the ECS for each element
Op. 5: Material Type
   = 0; linear elastic material model (default)
   = 1; von Mises elasto-plastic model (isotropic hardening)
Chapter 4  Element Library

- 2; von Mises elasto-plastic model (kinematic hardening)
- 3; Mooney-Rivlin hyperelastic model
- 4; nonlinear elastic model
- 5; Drucker-Prager elastic-perfectly-plastic model
- 6; Ogden hyperelastic model
- 8; viscoelastic material model
- 9; Blatz-Ko hyperelastic material model
- 11; concrete model
- 12; Tresca isotropic plasticity model
- 13; Tresca kinematic plasticity model
- -20 to -1; user-defined model

Op. 6: Displacement Formulation
- 0; Small displacement formulation (default)
- 1; Updated Lagrangian
- 2; Total Lagrangian

Op. 7: Material creep
- 0; do not consider creep
- 1; include creep effects
- -100 to -1; user’s creep model

Op. 8: Strain plasticity
- 0; Small
- 1; Large

Real Constants
Nine constants have to be defined in case of using orthotropic or anisotropic models. The nine values are used to determine the coordinates of three points (1’, 2’, 3’) to define the material coordinate system. The first direction of the material coordinate system, denoted by “a” in Figures 4-68 and 4-69, is defined by a vector connecting point 1’ to point 2’. The b-axis (second material direction) lies in the plane of the three defined points and goes from a-axis toward the third point. The c-axis (third material direction) completes a right-hand Cartesian coordinate system. The above material directions can be defined with respect to the defined element coordinate system as specified by the active ECS.

\[ r1 = x\text{-coordinate of point 1’} \]
\[ r2 = y\text{-coordinate of point 1’} \]
\[ r3 = z\text{-coordinate of point 1’} \]
\[ r4 = x\text{-coordinate of point 2’} \]
\[ r5 = y\text{-coordinate of point 2’} \]
\[ r6 = z\text{-coordinate of point 2’} \]
r7 = x-coordinate of point 3’
r8 = y-coordinate of point 3’
r9 = z-coordinate of point 3’

The real constants are interpreted based on the element coordinate system (ECS)

**Material Properties**

EX = Modulus of elasticity in the first material direction

EY = Modulus of elasticity in the second material direction

EZ = Modulus of elasticity in the third material direction

NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)

NUYZ = Poisson's ratio relating the second and third material directions (strain in the third direction due to unit strain along the second direction)

NUXZ = Poisson's ratio relating the first and third material directions (strain in the third direction due to unit strain along the first direction)

ALPX = Coefficient of thermal expansion in the first material direction

ALPY = Coefficient of thermal expansion in the second material direction

ALPZ = Coefficient of thermal expansion in the third material direction

DENS = Density

GXY = Shear modulus relating the first and second material directions

GYZ = Shear modulus relating the second and third material directions

GXZ = Shear modulus relating the first and second material directions

KX = Thermal conductivity in the first material direction

KY = Thermal conductivity in the second material direction

KZ = Thermal conductivity in the third material direction

ECONX = Electric conductivity in the first material direction

ECONY = Electric conductivity in the second material direction
Chapter 4   Element Library

ECONZ = Electric conductivity in the third material direction
CREEPC = Creep constants for the classical creep law (3 constants)
CREEPX = Creep constants for the exponential creep law (7 constants)
ETAN = Tangent modulus for bilinear elasto-plastic models
SIGYLD = Yield stress for bilinear elasto-plastic models
FRCANG = Angle of internal friction
COHESN = Cohesive strength
MOONEY_A = First constant of the Mooney-Rivlin material model
MOONEY_B = Second constant of the Mooney-Rivlin material model
MOONEY_C = Third constant of the Mooney-Rivlin material model
MOONEY_D = Fourth constant of the Mooney-Rivlin material model
MOONEY_E = Fifth constant of the Mooney-Rivlin material model
MOONEY_F = Sixth constant of the Mooney-Rivlin material model
MU1 = First constant of the Ogden material model
MU2 = Second constant of the Ogden material model
MU3 = Third constant of the Ogden material model
MU4 = Fourth constant of the Ogden material model
ALPH1 = First power coefficient of the Ogden material model
ALPH2 = Second power coefficient of the Ogden material model
ALPH3 = Third power coefficient of the Ogden material model
ALPH4 = Fourth power coefficient of the Ogden material model
G1, G2, ..., G8 = Shear relaxation (first, second, ..., eighth) moduli
TAUG1, TAUG2, ...
TAUG8 = Time associated with G1 through G8
K1, K2, ..., K8 = Bulk relaxation (first, second, ..., eighth) moduli
TAUK1, TAUK2, ...
TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and second constants of the WLF equation
MCij = User-defined material constants (up to 20 values). Constants are designated as MC11, MC12, ..., MC56 (i = 1, 6 and j = i, 6. MC66 is not used)
FPC = Concrete ultimate compressive strength
EPSU = Concrete ultimate compressive strain
Orthotropic material properties are not available for elasto-plastic models.

For linear elastic material models, the element is assigned orthotropic properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the \(i^{th}\) and \(j^{th}\) material directions: \(\nu_{ij}/E_i = \nu_{ji}/E_j\)

Where \(\nu_{ij}, E_i,\) and \(E_j\) are provided as input and \(\nu_{ji}\) calculated internally by the program.

**Element Loadings**

- Thermal
- Gravitational
- Pressure (with or without deformation-dependency):

The direction of the applied pressure on the four faces of the element is controlled by the order in which the element is labeled. The first three node labels define face 1. Looking from outside of the element to face 1, if the face is labeled in the counter-clockwise direction, positive pressure values imply inward loading to this face as well as the other three. Conversely, if face 1 is labeled in the clockwise direction, positive pressure to any of the faces implies outward loading.

**Output Results**

Stress components in either the global coordinate system or in the coordinate system defined by the ECS for each element are available at all nodes and at the center of each element. For plasticity, wrinkling, creep, concrete, and visco-elastic models, stresses are written at the integration points. For all other material models, stresses are written at the nodes. See Figure 4-70.

For the concrete mode, either the damage factor or the yield factor can be chosen in the output. The option is given the Analysis > NONLINEAR > **Print Ops** command.

**References**


Figure 4-68. 4-Node Tetrahedron Element
Figure 4-69. 10-Node Tetrahedron Element
Figure 4-70. Location of Stress Printout for TETRA4 and TETRA10

1-Point Integration
(only for TETRA4)

<table>
<thead>
<tr>
<th>Point</th>
<th>r</th>
<th>s</th>
<th>t</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>0.25</td>
<td>0.25</td>
<td>0.25</td>
</tr>
</tbody>
</table>

| 4-Point Integration |

<table>
<thead>
<tr>
<th>Point</th>
<th>r</th>
<th>s</th>
<th>t</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>β₁</td>
<td>β₁</td>
<td>β₁</td>
</tr>
<tr>
<td>c</td>
<td>α₁</td>
<td>β₁</td>
<td>β₁</td>
</tr>
<tr>
<td>d</td>
<td>β₁</td>
<td>α₁</td>
<td>β₁</td>
</tr>
<tr>
<td>e</td>
<td>β₁</td>
<td>β₁</td>
<td>α₁</td>
</tr>
</tbody>
</table>

α₁ = 0.5854101966249685
β₁ = 0.1381966011250150

| 16-Point Integration |

<table>
<thead>
<tr>
<th>Point</th>
<th>r</th>
<th>s</th>
<th>t</th>
</tr>
</thead>
<tbody>
<tr>
<td>f</td>
<td>β₂</td>
<td>β₂</td>
<td>β₂</td>
</tr>
<tr>
<td>g</td>
<td>α₂</td>
<td>β₂</td>
<td>β₂</td>
</tr>
<tr>
<td>h</td>
<td>β₂</td>
<td>α₂</td>
<td>β₂</td>
</tr>
<tr>
<td>i</td>
<td>β₂</td>
<td>β₂</td>
<td>α₂</td>
</tr>
</tbody>
</table>

α₂ = 0.7716429020672371
β₂ = 0.0761190326442543
3-Node Nonlinear Triangular Thin Shell Element (SHELL3)

General Description
SHELL3 is a 3-node triangular thin shell element with membrane and bending capabilities for nonlinear analysis of three dimensional structural models. The shear deformation effect is neglected. Six degrees of freedom (three translations and three rotations) are considered per node.

For problems involving thick plates or shells, as determined by standard guidelines, SHELL3T is recommended. Both SHELL3T and SHELL3 have identical inputs which permit exchanging one for the other by simply altering the element name.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

The nodal input pattern for this element is shown in Figure 4-71. Both clockwise and counter-clockwise node numbering are allowed.

Special Features
Orthotropic materials, Temperature-dependent material properties, Large displacements, Plasticity, Mooney-Rivlin and Ogden hyperelasticity models, Nonlinear elasticity, Viscoelasticity and Wrinkling membrane.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes, perpendicular to x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with x and y axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (x_eY_eZ_e), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (α) between the x_e axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of x_e on the element plane.
Chapter 4   Element Library

- If the angle ($\alpha$) between the $x_e$ axis and the normal to the surface ($z$) is less than or equal to $45^\circ$ ($\alpha \leq 45^\circ$), the element $x$-axis is considered as the projection of $y_e$ on the element plane.

- The element $y$-axis is defined so that $z$-axis completes a right-hand Cartesian system with $x$- and $y$-axes.

Element Group Options

**Op. 1:** Unused option for this element

**Op. 2:** Analysis
- $= 0$; Regular (Membrane + bending) shell analysis (default)
- $= 1$; Membrane analysis*
- $= 2$; Shear panel, not used by nonlinear analysis
- $= 3$; Transverse shear (include transverse shear terms)

**Op. 3:** Stress print-out option
- $= 0$; print forces and stresses at the center of the element
- $= 1$; add print-out of nodal forces
- $= 2$; add print-out of nodal stresses

**Op. 4:** Stress Direction
- $= 0$; stresses are calculated in the global Cartesian coordinate system
- $= 1$; stresses are calculated in the defined element local coordinate system unless ECS=-1 where stresses are calculated in the global directions.
- $= 2$; stresses are calculated in the material directions

**Op. 5:** Material type
- $= 0$: Lin; linear elastic material model (default)
- $= 1$: VMI; von Mises elasto-plastic model (isotropic hardening)
- $= 2$: VMK; von Mises elasto-plastic model (kinematic hardening)
- $= 3$: MR; Mooney-Rivlin hyperelastic model
- $= 4$: NLE; nonlinear elastic model
- $= 6$:OH; Ogden hyperelastic model
- $= 8$:VEM; viscoelastic material model
- $= 10$:WM; wrinkling membrane model

**Op. 6:** Displacement Formulation
- $= 0$; Small (default)
- $= 1$; Large

**Op. 7:** Unused option

**Op. 8:** Strain plasticity
- $= 0$; Small (default)
- $= 1$; Large
Chapter 4  Element Library

Real Constants

- r1 = Shell thickness
- r2 = Temperature gradient
- r3 = Foundation stiffness, not used by nonlinear analysis
- r4 = Material angle (Beta) measured in reference to the x-axis of the element (ECS)
- r5 = Prestress value for x- and y-directions of the element
- r6 = Prestrain value for x- and y-directions of the element

Material Properties (See Figure 4-71 for material directions)

- EX = Modulus of elasticity in the first material direction
- EY = Modulus of elasticity in the second material direction
- KX = Thermal conductivity in the first material direction
- KY = Thermal conductivity in the second material direction
- NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
- C = Specific heat
- ALPX = Coefficient of thermal expansion in the first material direction
- ALPY = Coefficient of thermal expansion in the second material direction
- DENS = Density
- GXY = Shear modulus relating the first and second material directions
- DAMP = Material damping coefficient
- ECONX = Electric conductivity in the first material direction (thermal analysis only)
- ECONY = Electric conductivity in the second material direction (thermal analysis only)

* Since no flexural stiffness is considered with the membrane option, it is essential to include the geometric stiffness in the analysis regardless of the large displacement option. For flat membrane structures with transverse loads, it is required that the initial configuration of the structure start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. If material nonlinearity is involved, it is difficult to include the initial state of stress. A prestress and prestrain (defined as real constants) should be specified along with the assumed deflected shape. Approximate values for prestress and prestrain may be evaluated by applying a small load to the structure and using the regular shell analysis in Op. 2. Rotational degrees of freedom are to be fixed and three translational degrees of freedom are left per node.
Chapter 4   Element Library

Element Loadings

- Thermal
- Gravitational
- Pressure (with or without deformation-dependency)

Output Results

Stress components and von Mises stress are available in the defined element local coordinate directions at the centroid of the element top and bottom fibers. Principal stresses are also calculated and written in the output file at the center of top and bottom faces. Nodal forces or stresses are optionally added (see Op. 3). Nodal stresses are computed in either the global Cartesian coordinate system or in the coordinate system defined by the ECS for each element (see Op. 4).

Figure 4-71. Nonlinear Triangular Thin Shell

If ECS = -1, $\beta$ is measured differently for each element which may not be proper to use for non-isotropic materials.
Figure 4-72. Direction of Force and Moment Components Per Unit Length as Defined by COSMOS/M for Nonlinear Thin Shells

References


Chapter 4  Element Library

4-Node Nonlinear Quadrilateral Thin Shell Element (SHELL4)

General Description
SHELL4 is a 4-node quadrilateral thin shell element with membrane and bending capabilities for nonlinear analysis of three dimensional structural models. The shear deformation effect is neglected for this element. Six degrees of freedom (three translations and three rotations) are considered per node.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thick plates or shells, as determined by standard guidelines, SHELL4T is recommended.

The nodal input pattern for this element is shown in Figure 4-73. Both clockwise and counter-clockwise node numbering are allowed. A triangular element is assumed if the third and fourth nodes have the same global node number.

Special Features
Orthotropic materials, Temperature-dependent material properties, Large displacements, Plasticity, Mooney-Rivlin and Ogden hyperelasticity models, Nonlinear elasticity, Viscoelasticity and Wrinkling membrane.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the first three nodes, perpendicular to the element x-axis toward the fourth node. The element z-axis completes a right-hand Cartesian system.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xeyez), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (α) between the x_e axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of x_e on the element plane.
If the angle ($\alpha$) between the $x_e$ axis and the normal to the surface ($z$) is less than or equal to 45° ($\alpha \leq 45°$), the element x-axis is considered as the projection of $y_c$ on the element plane.

The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

**Op. 1:** Type of shell element (see Note 1 of linear SHELL4)
- = 0; QUAD2 element (2 triangles to form a quadrilateral)
- = 1; QUAD4 element (4 triangles to form a quadrilateral) (default)
- = 2; QUAD
- = 3; QM6

**Op. 2:** Analysis
- = 0; Regular (Membrane + bending) shell analysis (default)
- = 1; Membrane analysis *
- = 2; Shear panel, Not used by nonlinear analysis
- = 3; Transverse shear (include transverse shear terms)

**Op. 3:** Stress print-out option
- = 0; print forces and stresses at the center of the element
- = 1; add print-out of nodal forces
- = 2; add print-out of nodal stresses

**Op. 4:** Stress Direction
- = 0; stresses are calculated in the global Cartesian coordinate system (default)
- = 1; stresses are calculated in the defined element local coordinate system
- = 2; stresses are calculated in the material directions (see figure 4-73)

**Op. 5:** Material type
- = 0: Lin; linear elastic material model (default)
- = 1: VMI; von Mises elasto-plastic model (isotropic hardening)
- = 2: VMK; von Mises elasto-plastic model (kinematic hardening)
- = 3: MR; Mooney-Rivlin hyperelastic model
- = 4; NLE; nonlinear elastic model
- = 6:OH; Ogden hyperelastic model
- = 8:VEM; viscoelastic material model
- = 10:WM; wrinkling membrane model

**Op. 6:** Displacement Formulation
- = 0; Small displacement formulation (default)
- = 1; Large displacement formulation

**Op. 7:** Unused option for this element

**Op. 8:** Strain plasticity
= 0; Small (default)
= 1; Large

* Since no flexural stiffness is considered with the membrane option, it is essential to include the geometric stiffness in the analysis regardless the large displacement option. For flat membrane structures with transverse loads, it is always required that the initial configuration of the structure start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. If material nonlinearity is involved, it is difficult to include the initial state of stress. A prestress and prestrain (as defined by the real constant command) should be specified along with the assumed deflected shape. Approximate values for prestress and prestrain values may be evaluated by applying a small load to the structure and using the regular shell analysis in Op. 2. Rotational degrees of freedom are to be fixed and three translational degrees of freedom are left per node.

**Real Constants**

r1 = Stress thickness
r2 = Temperature gradient
r3 = Foundation stiffness
r4 = Material angle (Beta) measured in reference to the x-axis of the element (ECS)
r5 = Prestress value for x- and y-directions of the element
r6 = Prestrain value for x- and y-directions of the element

**Material Properties** *(See Figure 4-73 for material directions)*

EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions
C = Specific heat
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
DENS = Density
GXY = Shear modulus relating the first and second material directions
DAMP = Material damping coefficient
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONX = Electric conductivity in the second material direction (thermal analysis only)

**Element Loadings**
- Thermal
- Gravitational
- Pressure (with or without deformation-dependency)

**Output Results**
Stress components and von Mises stress are available in the defined element local coordinate directions at the centroid of the element at top and bottom fibers. Principal stresses are also calculated and written in the output file at the center of top and bottom faces. Nodal forces or stresses are optionally added (see Op. 3). Nodal stresses are computed in either the global Cartesian coordinate system or in the coordinate system defined by the ECS for each element (see Op. 4).

*Figure 4-73. Nonlinear 4-Node Quadrilateral Thin Shell*
Chapter 4  Element Library

References

SHELL6 is a 6-node triangular thin shell element with membrane and bending capabilities for nonlinear structural analysis. The element does not account for shear deformation effects. Six degrees of freedom (three translations and three rotations) are considered per node.

For problems involving thick plates or shells, as determined by standard guidelines, SHELL6T is recommended. The element’s formulation is based on an assembly of SHELL3 elements. The nodal input pattern for this element is shown in the figure.

For all other details, refer to the nonlinear SHELL3 element.
Chapter 4   Element Library

3-Node Nonlinear Triangular Thick Shell Element
(SHELL3T)

General Description
SHELL3T is a 3-node triangular thick shell element with membrane and bending capabilities for nonlinear analysis of three dimensional structural models. The element accounts for shear deformation effects. Six degrees of freedom (three translations and three rotations) are considered per node.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thin plates or shells, as determined by standard guidelines, SHELL3 is recommended. Both SHELL3T and SHELL3 have identical inputs which permit exchanging one for the other by simply altering the element name.

The nodal input pattern for this element is shown in Figure 4-74. Both clockwise and counter-clockwise node numbering are allowed.

Special Features
Orthotropic materials, Temperature-dependent material properties, Large displacements, Plasticity, Mooney-Rivlin and Ogden hyperelasticity models, Nonlinear elasticity, Viscoelasticity and Wrinkling membrane.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes, perpendicular to x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with x and y axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (x\textsubscript{e}y\textsubscript{e}z\textsubscript{e}), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (\(\alpha\)) between the x\textsubscript{e} axis and the normal to the surface (z) is greater than 45° (\(\alpha > 45°\)), the element x-axis is considered as the projection of x\textsubscript{e} on the element plane.
Chapter 4  Element Library

- If the angle ($\alpha$) between the $x_c$ axis and the normal to the surface ($z$) is less than or equal to 45° ($\alpha \leq 45^\circ$), the element x-axis is considered as the projection of $y_c$ on the element plane.

- The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

Element Group Options

**Op. 1**: Unused option for this element

**Op. 2**: Analysis

- 0; Regular (Membrane + bending) shell analysis (default)
- 1; Membrane analysis *
- 2; unrelated option to this type of analysis

**Op. 3**: Stress print-out option

- 0; print forces and stresses at the center of the element
- 1; add print-out of nodal forces
- 2; add print-out of nodal stresses

**Op. 4**: Stress Direction

- 0; stresses are calculated in the global Cartesian coordinate system (default)
- 1; stresses are calculated in the defined element local coordinate system unless ECS=-1 where stresses are calculated in the global directions.
- 2; stresses are calculated in the material directions (See figure 4-74)

**Op. 5**: Material Type

- 0; linear elastic material model (default)
- 1; von Mises elasto-plastic model (isotropic hardening)
- 2; von Mises elasto-plastic model (kinematic hardening)
- 3; Mooney-Rivlin hyperelastic model
- 4; nonlinear elastic model
- 6; Ogden hyperelastic model
- 8; viscoelastic material model
- 10; wrinkling membrane model (with Op. 2 = 1)

**Op. 6**: Displacement Formulation

- 0; Small (default)
- 1; Large

**Op. 7**: Unused option for this element

**Op. 8**: Strain plasticity

- 0; Small (default)
- 1; Large
Chapter 4   Element Library

Real Constants

- \( r_1 \) = Shell thickness
- \( r_2 \) = Temperature gradient
- \( r_3 \) = Unrelated constant to this type of analysis
- \( r_4 \) = Material angle (Beta)
- \( r_5 \) = Prestress value for x- and y-directions of the element coordinate system
- \( r_6 \) = Prestrain value for x- and y-directions of the element coordinate system

Material Properties

- \( E_X \) = Modulus of elasticity in the first material direction
- \( E_Y \) = Modulus of elasticity in the second material direction
- \( K_X \) = Thermal conductivity in the first material direction
- \( K_Y \) = Thermal conductivity in the second material direction
- \( NUXY \) = Poisson's ratio relating the first and second material directions
- \( C \) = Specific heat
- \( ECON_X \) = Electric conductivity in the first material direction (thermal analysis only)
- \( ECON_Y \) = Electric conductivity in the second material direction (thermal analysis only)
- \( ALP_X \) = Coefficient of thermal expansion in the first material direction
- \( ALP_Y \) = Coefficient of thermal expansion in the second material direction
- \( DENS \) = Density
- \( GXY \) = Shear modulus relating the first and second material directions
- \( DAMP \) = Material damping coefficient

* Since no flexural stiffness is considered with the membrane option, it is essential to include the geometric stiffness in the analysis regardless the large displacement option. For flat membrane structures with transverse loads, it is always required that the initial configuration of the structure start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. If material nonlinearity is involved, it is difficult to include the initial state of stress. A prestress and prestrain (as defined by the real constant command) should be specified along with the assumed deflected shape. Approximate values for prestress and prestrain values may be evaluated by applying a small load to the structure and using the regular shell analysis in Op. 2. Rotational degrees of freedom are to be fixed and three translational degrees of freedom are left per node.
Chapter 4  Element Library

ETAN  = Tangent modulus for bilinear elasto-plastic material models
SIGYLD = Yield stress of bilinear elasto-plastic material models
MOONEY_A = First constant for Mooney-Rivlin material model
MOONEY_B = Second constant for Mooney-Rivlin material model
MOONEY_C = Third constant of the Mooney-Rivlin material model
MOONEY_D = Fourth constant of the Mooney-Rivlin material model
MOONEY_E = Fifth constant of the Mooney-Rivlin material model
MOONEY_F = Sixth constant of the Mooney-Rivlin material model
MU1  = First constant of the Ogden material model
MU2  = Second constant of the Ogden material model
MU3  = Third constant of the Ogden material model
MU4  = Fourth constant of the Ogden material model
ALPH1 = First power coefficient of the Ogden material model
ALPH2 = Second power coefficient of the Ogden material model
ALPH3 = Third power coefficient of the Ogden material model
ALPH4 = Fourth power coefficient of the Ogden material model
G1, G2,..., G8 = Shear relaxation (first, second,..., eighth) moduli
TAUG1, TAUG2,
  ..., TAUG8 = Time associated with G1 through G8
K1, K2,..., K8 = Bulk relaxation (first, second,..., eighth) moduli
TAUK1, TAUK2,
  ..., TAUK8 = Time associated with K1 through K8
REFTEMP = Glassy transition temperature
VC1, VC2 = First and second constants of the WLF equation

Element Loadings

• Thermal
• Gravitational
• Pressure (with or without deformation-dependency)

Output Results

Stress components and von Mises stress are available in the defined element local coordinate directions at the centroid of the element top and bottom fibers. In addition, nodal forces (per unit length) and stresses can be calculated and printed in the output file (Op. 3). Nodal stresses are calculated in either the global Cartesian coordinate system, or in the local coordinate system defined by the ECS for each
element (Op. 4). For hyperelastic material models, the current thickness of the
element and the strain energy density are also printed.

For large strain plasticity model, the element current thickness is printed.

**Figure 4-74. Nonlinear Triangular Thick Shell**

- **XYZ**: Global Cartesian Coordinate System
- **xyz**: Element Coordinate System
- **β**: Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)
- Local y axis defined by ECS
- First material direction
- Second material direction
- Local x axis defined by ECS
- If ECS = -1, the x axis of the element is the vector from node 1 to node 2 in the element connectivity.
Chapter 4  Element Library

Figure 4-75. Direction of Force and Moment Components Per Unit Length as Defined by COSMOS/M for Nonlinear Thick Shells

References

4-Node Nonlinear Quadrilateral Thick Shell Element (SHELL4T)

General Description

SHELL4T is a 4-node quadrilateral thick shell element with membrane and bending capabilities for nonlinear analysis of three dimensional structural models. The element accounts for shear deformation effects. Six degrees of freedom (three translations and three rotations) are considered per node.

The formulation supports orthotropic material properties and assumes constant thickness throughout the element.

For problems involving thin plates or shells, as determined by standard guidelines, SHELL4 is recommended.

The nodal input pattern for this element is shown in Figure 4-76. Both clockwise and counterclockwise node numbering are allowed. A triangular element is assumed if the third and fourth nodes have the same global node number.

Special Features

Orthotropic materials, Temperature-dependent material properties, Large displacements, Plasticity, Mooney-Rivlin and Ogden hyperelasticity models, Nonlinear elasticity, Viscoelasticity and Wrinkling membrane.

Default Element Coordinate System (ECS = -1)

The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the first three nodes, perpendicular to the element x-axis toward the fourth node. The element z-axis completes a right-hand Cartesian system.

Other Element Coordinate Systems (ECS ≠ -1)

When a defined element coordinate system \((x_\text{c}y_\text{c}z_\text{c})\), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system \((xyz)\) as follows:

- The element z-axis is normal to the shell plane. The positive direction of \(z\) follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle \(\alpha\) between the \(x_\text{c}\) axis and the normal to the surface \((z)\) is greater than 45° \((\alpha > 45°)\), the element x-axis is considered as the projection of \(x_\text{c}\) on the element plane.
Chapter 4  Element Library

- If the angle ($\alpha$) between the $x_e$ axis and the normal to the surface ($z$) is less than or equal to 45° ($\alpha \leq 45^\circ$), the element $x$-axis is considered as the projection of $y_e$ on the element plane.

- The element $y$-axis is defined so that $z$-axis completes a right-hand Cartesian system with $x$- and $y$-axes.

**Element Group Options**

**Op. 1:** Type of shell element (see Note 1 of linear SHELL4)
- = 0; QUAD2 element (2 triangles to form a quadrilateral)
- = 1; QUAD4 element (4 triangles to form a quadrilateral) (default)
- = 2; QUAD
- = 3; QM6

**Op. 2:** Analysis
- = 0; Regular (Membrane + bending) shell analysis (default)
- = 1; Membrane analysis *
- = 2; unrelated option to this type of analysis

**Op. 3:** Stress print-out option
- = 0; print forces and stresses at the center of the element
- = 1; add print-out of nodal forces
- = 2; add print-out of nodal stresses

**Op. 4:** Stress Direction
- = 0; stresses are calculated in the global Cartesian coordinate system
- = 1; stresses are calculated in the defined element local coordinate system
- = 2; stresses are calculated in the material directions (see figure 4-76)

**Op. 5:** Material Type
- = 0; linear elastic material model (default)
- = 1; von Mises elasto-plastic model (isotropic hardening)
- = 2; von Mises elasto-plastic model (kinematic hardening)
- = 3; Mooney-Rivlin hyperelastic model
- = 4; nonlinear elastic model
- = 6; Ogden hyperelastic model
- = 8; viscoelastic material model
- = 10; wrinkling membrane model (with Op. 2 = 1)

**Op. 6:** Displacement Formulation
- = 0; Small displacement formulation (default)
- = 1; Large displacement formulation

**Op. 7:** Unused option for this element

**Op. 8:** Strain plasticity
- = 0; Small strain formulation
= 1; Large strain formulation

* Since no flexural stiffness is considered with the membrane option, it is essential to include the geometric stiffness in the analysis regardless the large displacement option. For flat membrane structures with transverse loads, it is always required that the initial configuration of the structure start with an assumed deflected shape obtained from the regular shell analysis as defined by Op. 2. If material nonlinearity is involved, it is difficult to include the initial state of stress. A prestress and prestrain (as defined by the real constant command) should be specified along with the assumed deflected shape. Approximate values for prestress and prestrain values may be evaluated by applying a small load to the structure and using the regular shell analysis in Op. 2. Rotational degrees of freedom are to be fixed and three translational degrees of freedom are left per node.

Real Constants

r1 = Shell thickness
r2 = Temperature gradient
r3 = Unrelated constant to this type of analysis
r4 = Material angle (Beta)
r5 = Prestress value for x- and y-directions of the element coordinate system
r6 = Prestrain value for x- and y-directions of the element coordinate system

Material Properties

EX = Modulus of elasticity in the first material direction
EY = Modulus of elasticity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions
KX = Thermal conductivity in the first material direction
KY = Thermal conductivity in the second material direction
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
ECONX = Electric conductivity in first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)
Chapter 4   Element Library

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DENS</td>
<td>Density</td>
</tr>
<tr>
<td>GXY</td>
<td>Shear modulus relating the first and second material directions</td>
</tr>
<tr>
<td>ETAN</td>
<td>Tangent modulus for bilinear elasto-plastic material model</td>
</tr>
<tr>
<td>SIGYLD</td>
<td>Yield stress of bilinear elasto-plastic material model</td>
</tr>
<tr>
<td>MOONEY_A</td>
<td>First constant of the Mooney-Rivlin material model</td>
</tr>
<tr>
<td>MOONEY_B</td>
<td>Second constant of the Mooney-Rivlin material model</td>
</tr>
<tr>
<td>MOONEY_C</td>
<td>Third constant of the Mooney-Rivlin material model</td>
</tr>
<tr>
<td>MOONEY_D</td>
<td>Fourth constant of the Mooney-Rivlin material model</td>
</tr>
<tr>
<td>MOONEY_E</td>
<td>Fifth constant of the Mooney-Rivlin material model</td>
</tr>
<tr>
<td>MOONEY_F</td>
<td>Sixth constant of the Mooney-Rivlin material model</td>
</tr>
<tr>
<td>MU1</td>
<td>First constant of the Ogden material model</td>
</tr>
<tr>
<td>MU2</td>
<td>Second constant of the Ogden material model</td>
</tr>
<tr>
<td>MU3</td>
<td>Third constant of the Ogden material model</td>
</tr>
<tr>
<td>MU4</td>
<td>Fourth constant of the Ogden material model</td>
</tr>
<tr>
<td>ALPH1</td>
<td>First power coefficient of the Ogden material model</td>
</tr>
<tr>
<td>ALPH2</td>
<td>Second power coefficient of the Ogden material model</td>
</tr>
<tr>
<td>ALPH3</td>
<td>Third power coefficient of the Ogden material model</td>
</tr>
<tr>
<td>ALPH4</td>
<td>Fourth power coefficient of the Ogden material model</td>
</tr>
<tr>
<td>G1, G2,..., G8</td>
<td>Shear relaxation (first, second, ..., eighth) moduli</td>
</tr>
<tr>
<td>TAUG1, TAUG2,..., TAUG8</td>
<td>Time associated with G1 through G8</td>
</tr>
<tr>
<td>K1, K2,..., K8</td>
<td>Bulk relaxation (first, second, ..., eighth) moduli</td>
</tr>
<tr>
<td>TAUK1, TAUK2,..., TAUK8</td>
<td>Time associated with K1 through K8</td>
</tr>
<tr>
<td>REFTEMP</td>
<td>Glassy transition temperature</td>
</tr>
<tr>
<td>VC1, VC2</td>
<td>First and second constants of the WLF equation</td>
</tr>
</tbody>
</table>

**Element Loadings**
- Thermal
- Gravitational
- Pressure (applied normal to element faces)

**Output Results**
Stress components and von Mises stress are available in the defined element local coordinate directions at the centroid of the element top and bottom fibers. For
Chapter 4  Element Library

hyperelastic material models, the current thickness of the elements and the strain energy density are also printed. Nodal forces or stresses are optionally added (see Op. 3). Nodal stresses are computed in either the global Cartesian coordinate system or in the coordinate system defined by the ECS for each element (see Op. 4).

For large strain plasticity model, the element current thickness is printed.

Figure 4-76. Nonlinear Quadrilateral Thick Shell

References

6-Node Nonlinear Triangular Thick Shell Element (SHELL6T)

SHELL6T is a 6-node triangular thick shell element with membrane and bending capabilities for nonlinear structural analysis. The element accounts for shear deformation effects. Six degrees of freedom (three translations and three rotations) are considered per node.

For problems involving very thin plates or shells, as determined by standard guidelines, SHELL6 is recommended. The element’s formulation is based on an assembly of SHELL3T elements. The nodal input pattern for this element is shown in the figure.

For all other details, refer to the nonlinear SHELL3T element.
Chapter 4   Element Library

Nonlinear Composite Triangular Plate and Shell Element (SHELL3L)

General Description
SHELL3L is a 3-node multi-layer triangular shell element with membrane and bending capabilities for the analysis of three-dimensional nonlinear structural models. Up to 50 layers can be used. Six degrees of freedom (three translations and three rotations) are considered per node. Each layer can be associated with different isotropic or orthotropic material properties.

The nodal input pattern for this element is shown in Figure 4-77. Both clockwise and counter-clockwise node numbering are allowed.

Special Features
Orthotropic materials, Temperature-dependent material properties, Large displacement analysis, Failure analysis of laminated composites using Tsai-Wu's failure criterion.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second. The element y-axis lies in the plane defined by the three nodes, perpendicular to the x-axis toward the third node. The element z-axis completes a right-hand Cartesian system with the x and y axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xeyezc), as shown in Figure 4-27, is different from the default element coordinate system (ECS = -1), the program considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure 4-27.
- If the angle (α) between the x_e axis and the normal to the surface (z) is greater than 45° (α > 45°), the element x-axis is considered as the projection of x_e on the element plane.
- If the angle (α) between the x_e axis and the normal to the surface (z) is less than or equal to 45° (α ≤ 45°), the element x-axis is considered as the projection of y_e on the element plane.
The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

**Op. 1:** Unused option for this element

**Op. 2:** Number of Layers in the element (1 to 50)

**Op. 3:** Stress Direction (This option applies only to graphical display and listing of stresses inside GEOSTAR).
- = 0; stresses are calculated in the global Cartesian coordinate system (default)
- = 1; stresses are calculated in the defined element local coordinate system
- = 2; stresses are calculated in the material directions (See figure 4-77)

**Op. 4:** Unused option for this element

**Op. 5:** Failure Analysis.
- = 0; Linear Elastic (default)
- = 7; Tsai-Wu (failure analysis of laminated composites)

**Op. 6:** Displacement Formulation
- = 0; Small displacement formulation (default)
- = 1; Large displacement formulation

**Op. 7:** Layer flag (prompted only if Number of Layers = 3 in Op. 2)
- = 0; Composite
- = 1; Sandwich

**Op. 8:** Unused option for this element

**Real Constants**

Figure 4-78 shows the convention for thickness definition and temperature distribution of a multi-layered composite shell element. The material angle (β) for each layer is defined relative to the element coordinate system as shown in Figure 4-77.

*If Op. 2 ≠ 3 or Op. 2 = 3 but Op. 7 = 0*

- r1 = Distance from reference plane to upper surface (r1 is positive when upper surface is above the reference plane)*
- r2 = Temperature gradient
- r3 = Thickness of layer 1
- r4 = Material set number associated with layer 1
Chapter 4   Element Library

r5 = Material angle (β) for layer 1
r6 = Thickness of layer 2
r7 = Material set number associated with layer 2
r8 = Material angle (β) for layer 2
r[3(NL - 1) + 3] = Thickness of layer NL
r[3(NL - 1) + 4] = Material set number associated with layer NL
r[3(NL - 1) + 5] = Material angle (β) for layer NL

*(If Op. 2 = 3 and Op. 7 = 1)*

r1 = Distance from reference plane to upper surface (r1 is positive when upper surface is above the reference plane)
r2 = Temperature gradient
r3 = Thickness of layers 1 and 3
r4 = Material set number of layer 1 and 3
r5 = Thickness of layer 2
r6 = Material set number of layer 2

* If the default value (1.0e6) of r1 is accepted, the reference surface is defined as the neutral surface and r1 will be calculated as follows:

1. For calculating the mass moment of inertia:

\[
\sum_{i=1}^{NL} \rho(i)[z^2(i + 1) - z^2(i)]
\]

\[
r1 = \frac{\sum_{i=1}^{NL} \rho(i)[z(i + 1) - z(i)]}{\sum_{i=1}^{NL} \rho(i)[z^2(i + 1) - z^2(i)]}
\]

where,

NL = number of layers
\(\rho(i)\) = density for layer i
\(z(i)\) and \(z(i+1)\) = z-coordinates of bottom and top surfaces of layer i

2. For calculating the bending strains, stresses, and material matrix:

\[
\sum_{i=1}^{NL} E_k(i)[z^2(i + 1) - z^2(i)]
\]

\[
\xi_k = \frac{\sum_{i=1}^{NL} E_k(i)[z(i + 1) - z(i)]}{\sum_{i=1}^{NL} E_k(i)[z^2(i + 1) - z^2(i)]}
\]

where \(E_k\) = modulus of elasticity in k-direction


**Material Properties**

EX = Modulus of elasticity in the first material direction  
EY = Modulus of elasticity in the second material direction  
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)  
ALPX = Coefficient of thermal expansion in the first material direction  
ALPY = Coefficient of thermal expansion in the second material direction  
KX = Coefficient of thermal conductivity in the first material direction  
KY = Coefficient of thermal conductivity in the second material direction  
GXY = Shear modulus relating the first and second material directions  
DENS = Density  
ECONX = Electric conductivity in the first material direction  
ECONY = Electric conductivity in the second material direction  
SIGXT = Tensile strength in the first material direction  
SIGXC = Compressive strength in the first material direction  
SIGYT = Tensile strength in the second material direction  
SIGYC = Compressive strength in the second material direction  
SIGXY = Shear strength in the plane defined by first and second material directions

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:

1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the $i^{th}$ and $j^{th}$ material directions: \( \frac{\nu_{ij}}{E_i} = \frac{\nu_{ji}}{E_j} \)

Where $\nu_{ij}$, $E_i$, and $E_j$ are provided as input and $\nu_{ji}$ calculated internally by the program.

**Element Loadings**

- Thermal
- Gravitational
- Pressure (with or without deformation-dependency)
Chapter 4  Element Library

Output Results
Stress components and von Mises stress are available in the element coordinate directions at the center of the top and bottom surfaces of each layer. If failure analysis is performed (see Op. 5), von Mises stress is replaced by the failure indices.

Figure 4-77. Composite Triangular Plate and Shell

If \( \text{ECS} = -1 \), \( \beta \) is measured differently for each element which may not be proper to use for non-isotropic materials.
Chapter 4  Element Library

Figure 4-78. Convention for Thickness Definition and Temperature Distribution for Composite Plates and Shells

Convention for Thickness Definition and Temperature Distribution:

- (r1) is positive when upper-surface is above the reference plane.

References

Chapter 4   Element Library

Nonlinear Composite Quadrilateral Plate and Shell Element (SHELL4L)

General Description
SHELL4L is a 4-node multi-layer quadrilateral shell element with membrane and
bending capabilities for the analysis of three-dimensional nonlinear analysis of three
dimensional structural models. Six degrees of freedom (three translations and three
rotations) are considered per node. Each layer can be associated with different
isotropic or orthotropic material properties.

The nodal input pattern for this element is shown in Figure 4-79. Both clockwise and
counter-clockwise node numbering are allowed. A triangular element is assumed if
the third and fourth nodes have the same global node number.

Special Features
Temperature-dependent material properties, Large displacement analysis, Failure
analysis of laminated composites using Tsai-Wu's failure criterion.

Default Element Coordinate System (ECS = -1)
The element x-axis goes from the first node to the second, and the element y-axis
lies in the plane defined by the first three nodes, perpendicular to x-axis toward the
fourth node. The element z-axis completes a right-hand Cartesian system with x- and
y-axes.

Other Element Coordinate Systems (ECS ≠ -1)
When a defined element coordinate system (xeyez), as shown in Figure 4-27, is
different from the default element coordinate system (ECS = -1), the program
considers a modified element coordinate system (xyz) as follows:

- The element z-axis is normal to the shell plane. The positive direction of z
  follows a right-hand rule (as directed by nodes 1, 2 and 3) as shown in Figure
  4-27.
- If the angle (α) between the xe axis and the normal to the surface (z) is greater
  than 45° (α > 45°), the element x-axis is considered as the projection of xe on
  the element plane.
- If the angle (α) between the xc axis and the normal to the surface (z) is less than
  or equal to 45° (α ≤ 45°), the element x-axis is considered as the projection
  of yc on the element plane.
The element y-axis is defined so that z-axis completes a right-hand Cartesian system with x- and y-axes.

**Element Group Options**

**Op. 1:** Type of shell element (See Note 1 of linear SHELL4)
- = 0; QUAD2 element (2 triangles to form a quadrilateral)
- = 1; QUAD4 element (4 triangles to form a quadrilateral)
- = 2; unrelated option to this type of analysis

**Op. 2:** Number of Layers in the element (1 to 50)

**Op. 3:** Stress Direction (This option applies only to graphical display of stresses)
- = 0; stresses are calculated in the global Cartesian coordinate system (default)
- = 1; stresses are calculated in the defined element local coordinate system
- = 2; stresses are calculated in material coordinate system (see figure 4-79 for material directions when ECS = n, where n is the local element coordinate system label)

**Op. 4:** Unused option for this element

**Op. 5:** Failure Analysis.
- = 0; Linear Elastic (default)
- = 7; Tsai-Wu criterion (failure analysis of laminated composites)

**Op. 6:** Displacement Formulation
- = 0; Small (default)
- = 1; Large

**Op. 7:** Layer flag (prompted only if NL = 3 in Op. 2)
- = 0; Composite
- = 1; Sandwich

**Op. 7:** Unused option for this element

**Real Constants**

Figure 4-78 shows the convention for thickness definition and temperature distribution of a multi-layered composite shell element. The material angle (β) for each layer is defined relative to the default element coordinate system (ECS = -1) as shown in Figure 4-79.

*(If Op. 2 ≠ 3 or Op. 2 = 3 but Op. 7 = 0)*
- r1 = Distance from reference plane to upper surface (r1 is positive when upper surface is above the reference plane)*
- r2 = Temperature gradient
- r3 = Thickness of layer 1
Chapter 4  Element Library

\[ r4 \] = Material number for layer 1
\[ r5 \] = Material angle (\( \beta \)) for layer 1
\[ r6 \] = Thickness of layer 2
\[ r7 \] = Material number for layer 2
\[ r8 \] = Material angle (\( \beta \)) for layer 2
\[ r[3(NL - 1) + 3] \] = Thickness of layer NL
\[ r[3(NL - 1) + 4] \] = Material set number associated with layer NL
\[ r[3(NL - 1) + 5] \] = Material angle (\( \beta \)) for layer NL

(If Op. 2 = 3 and Op. 7 = 1)
\[ r1 \] = Distance from reference plane to upper surface (r1 is positive when upper surface is above the reference plane)
\[ r2 \] = Temperature gradient
\[ r3 \] = Thickness of layers 1 and 3
\[ r4 \] = Material set number of layers 1 and 3
\[ r5 \] = Thickness of layer 2
\[ r6 \] = Material set number of layer 2

* If the default value (1.0e6) of r1 is accepted, the reference surface is defined as the neutral surface and r1 will be calculated as follows:

1. For calculating the mass moment of inertia:

   \[ r1 = \xi = \frac{\sum_{i=1}^{NL} \rho(i)[z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} \rho(i)[z(i+1) - z(i)]} \]

   where,

   \( NL \) = number of layers
   \( \rho(i) \) = density for layer i
   \( z(i) \) and \( z(i+1) \) = z-coordinates of bottom and top surfaces of layer i

2. For calculating the bending strains, stresses, and material matrix:

   \[ \xi_k = \frac{\sum_{i=1}^{NL} E_k(i)[z^2(i+1) - z^2(i)]}{\sum_{i=1}^{NL} E_k(i)[z(i+1) - z(i)]} \]

   where \( E_k \) = modulus of elasticity in k-direction
Material Properties

EX  = Modulus of elasticity in the first material direction
EY  = Modulus of elasticity in the second material direction
KX  = Thermal conductivity in the first material direction
KY  = Thermal conductivity in the second material direction
NUXY = Poisson's ratio relating the first and second material directions (strain in the second direction due to unit strain along the first direction)
ALPX = Coefficient of thermal expansion in the first material direction
ALPY = Coefficient of thermal expansion in the second material direction
ECONX = Electric conductivity in the first material direction (thermal analysis only)
ECONY = Electric conductivity in the second material direction (thermal analysis only)
DENS = Density
SIGXT = Tensile strength in the first material direction
SIGXC = Compressive strength in the first material direction
SIGYT = Tensile strength in the second material direction
SIGYC = Compressive strength in the second material direction
SIGXY = Shear strength in the plane defined by first and second material directions

The element is assigned orthotropic material properties if at least one of the following conditions is satisfied:
1. Moduli of elasticities in two directions are defined and are unequal.
2. Poisson's ratio in two planes are defined and are unequal.
3. Thermal coefficients in two directions are defined and are unequal.

The following condition must be met for proper representation of orthotropic properties in the i\(^{th}\) and j\(^{th}\) material directions: \(\nu_{ij}/E_i = \nu_{ji}/E_j\)

Where \(\nu_{ij}\), \(E_i\), and \(E_j\) are provided as input and \(\nu_{ji}\) calculated internally by the program.

Element Loadings

• Thermal
• Gravitational
• Pressure (with or without deformation-dependency)
Output Results
Stress components and von Mises stress are available in the defined element local coordinate directions at the center of top and bottom surfaces of each layer. If failure analysis is performed (see Op. 5), von Mises stress is replaced by the failure indices.

Figure 4-79. Composite Quadrilateral Plate and Shell

- XYZ: Global Cartesian Coordinate System
- xyz: Element Coordinate System
- abc: Material Coordinate System

Face numbers for Applying Loads and Boundary Conditions (pressure is positive when applied inward)

If ECS = -1, the x axis of the element is the vector from node 1 to node 2 in the element connectivity.
Chapter 4   Element Library

References
**Chapter 4   Element Library**

---

**Nonlinear General Mass Element (MASS)**

**General Description**
MASS is a one node concentrated mass element for nonlinear structural models. The element is used to specify a lumped mass at a node. Up to six degrees of freedom are considered per node.

**Special Features**
*(None)*

**Default Element Coordinate System (ECS = -1)**
The global Cartesian coordinate system is always considered as the default element coordinate system.

**Element Group Options**
*(None)*

**Real Constants**
- \( r_1 \) = Mass in the global Cartesian X-direction
- \( r_2 \) = Mass in the global Cartesian Y-direction
- \( r_3 \) = Mass in the global Cartesian Z-direction
- \( r_4 \) = Rotary inertia about the global Cartesian X-axis
- \( r_5 \) = Rotary inertia about the global Cartesian Y-axis
- \( r_6 \) = Rotary inertia about the global Cartesian Z-axis
- \( r_7 \) = Unrelated constant to this type of analysis

**Material Properties**
*(None)*

**Element Loadings**
*(None)*

**Output Results**
*(None)*
Nonlinear Spring Element (SPRING)

General Description
SPRING is a 1-, 2-, or 3-node element for use in structural models. The element can have axial, transverse, and rotational stiffnesses. The transverse degrees of freedom are not supported for 1-node elements. For 2-node elements, the transverse stiffness is assumed constant in all transverse directions.

Special Features
A user-defined force-displacement or moment-rotation curve, as shown in Figure 4-81, reflects a material nonlinear behavior. Only a nonlinear elastic behavior is considered for this element. Large displacement effects can also be included in the case of the 2-node axial spring. The torsional degree of freedom is not supported when the large displacement option is activated. For a given spring, either the axial or the rotational stiffness may be nonlinear (associated with a force-displacement or moment/rotation curve). The transverse degree of freedom is always assumed to be linear.

Default Element Coordinate System (ECS = -1)
The element coordinate system is illustrated in Figure 4-80. For 1-node elements the element x axis (also called r axis) is along the global X, Y, or Z as specified in option 2 of the element group definition. For 2- and 3-node elements, the x (or r) direction goes from node 1 to node 2. To define the s and t directions, let ss denote a unit vector defined as follows:

- For 3-node elements, ss connects node 1 to node 3
- For 2-node elements, ss is the global X axis unless the element is defined along the X axis, in which case ss becomes the global Y axis
- The s and t directions are then determined by: t = r x ss and s = t x r, where the x operator refers to vector cross product

Refer to Figure 4-80 for a schematic representation of the SPRING element.

Element Group Options
Op. 1: Spring Type
- 0; Axial and transverse spring (default)
- 1; Rotational spring
- 2; Axial, transverse, and Rotational
Chapter 4   Element Library

Op. 2: Number of nodes
= 1; 1-node element (local coordinate system is based on global directions as defined by Op. 3)
= 2; 2-node element (default)
= 3; 3-node element (the third node defines the s and t transverse directions as shown in Figure 4-80)

Op. 3: DOF Directions of 1-node element (prompted only if Op. 2 = 1)
= 1; UX, translational degree of freedom along global Cartesian X-direction
= 2; UY, translational degree of freedom along global Cartesian Y-direction
= 3; UZ, translational degree of freedom along global Cartesian Z-direction
= 4; ROTX, rotational degree of freedom about global Cartesian X-direction
= 5; ROTY, rotational degree of freedom about global Cartesian Y-direction
= 6; ROTZ, rotational degree of freedom about global Cartesian Z-direction
= 7; UX and ROTX
= 8; UY and ROTY
= 9; UZ and ROTZ

Op. 4: Unused option for this element

Op. 5: Spring behavior
= 0; linear spring (default)
= 1; nonlinear spring (force-displacement or moment-rotation curve has to be defined)
= 2; viscoelastic behavior

Op. 6: Displacement formulation
= 0; small displacement formulation (default)
= 1; large displacement formulation (for the 2-node translational spring only)

Op. 7: Unused option for this element
Op. 8: Unused option for this element

Real Constants

The prompted real constants depend on entries used in defining the element group. r3 and r4 are not used with 1-node elements.

r1 = Axial stiffness
r2 = Rotational stiffness
r3 = Transverse stiffness in the s direction
r4 = Transverse stiffness in the t direction

Material Properties
Chapter 4  Element Library

For Nonlinear Elastic Spring (Op5 = 1)

1. Define the label and the type of force-displacement or moment-rotation curve (material property) using:

   LoadsBC > FUNC CURVE > Mat. Curve Type

   The default value, elastic, which refers to an elastic curve, must always be used for this element.

For Nonlinear Viscoelastic Spring (Op5 = 2)

1. Define the force-displacement or moment-rotation curve (material property) using: LoadsBC > FUNC CURVE > Material Curve
2. G1,G2,…,G8 = Rotation relaxation (first, second, …., eight) moduli
3. TAUG1, TAUG2,…,TAUG8 = Time associated with G1 through G8
4. K1,K2,…K8 = Translation relaxation factors (first, second, ….,eight) moduli
5. TAUK1, TAUK2,…, TAUK8 = Time associated with K1 through K8
6. REFTEMP = Glassy transition temperature
7. VC1, VC2 = First and second constants of the WLF equation

   In the case of viscoelastic spring, constitutive equation 3-15 given in chapter 3 of the Nonlinear section of the Advanced Modules Manual is divided into two independent equations: one equation describes force versus displacement using the K terms, and the other equation describes torque versus rotation with the G terms.

Element Loadings

(None)

Output Results

Axial force and torsional moment are available in the element coordinate system.
Chapter 4   Element Library

Figure 4-80. Spring Element

3-Node SPRING Element
XYZ Global Cartesian Coordinate System
rst Element coordinate System

2-Node SPRING Element
The r axis is along the global X axis.
The ss vector is parallel to the global Y-axis

2-Node SPRING Element
The r axis has a general orientation. The
ss vector is parallel to the global X axis

Figure 4-81. User-Defined Nonlinear Force-Displacement Curve

D2 = local displacement component at node (2)
D1 = local displacement component at node (1)
General Stiffness Element for Nonlinear Module (GENSTIF)

General Description
The GENSTIF is a 2-node user-defined element for three-dimensional Structural models. Up to six degrees of freedom per node are considered as shown in Figure 4-82.

The stiffness matrix \([K]\) must be symmetric, positive or semi-positive definite, and defined in the global Cartesian coordinate system. 78 constants are used to supply the upper half of the stiffness matrix. The stiffness matrix \([K]\) will not change throughout the analysis.

Special Features
(None)

Element Group Options
(None)

Real Constants
\[ r1 = K_{1,1}: \text{stiffness term at row 1 and column 1} \]
\[ r2 = K_{1,2}: \text{stiffness term at row 1 and column 2} \]
\[ r3 = K_{1,3}: \text{stiffness term at row 1 and column 3} \]
\[ \vdots \]
\[ r12 = K_{1,12}: \text{stiffness term at row 1 and column 12} \]
\[ r13 = K_{2,2}: \text{stiffness term at row 2 and column 2} \]
\[ r14 = K_{2,3}: \text{stiffness term at row 2 and column 3} \]
\[ \vdots \]
\[ r78 = K_{12,12}: \text{stiffness terms at row 12 and column 12} \]

The real constants (r1 to r78) as related to the stiffness matrix elements \(K_{ij}\) are shown in Figure 4-83:

Material Properties
(None)

Element Loadings
(None)
Output Results

No special output directly related to the General Stiffness element are provided by the program. Only nodal displacements are calculated and printed in the output file.

Figure 4-82. General Stiffness Element

Figure 4-83. Stiffness Matrix Terms KI J

\[
\begin{array}{cccccccccccc}
\text{Col J} & 1 & 2 & 3 & 4 & 5 & 6 & 7 & 8 & 9 & 10 & 11 & 12 \\
\text{Row I} & & & & & & & & & & & & \\
1 & r_1 & r_2 & r_3 & r_4 & r_5 & r_6 & r_7 & r_8 & r_9 & r_{10} & r_{11} & r_{12} \\
2 & r_{13} & r_{14} & r_{15} & r_{16} & r_{17} & r_{18} & r_{19} & r_{20} & r_{21} & r_{22} & r_{23} & \\
3 & r_{24} & r_{25} & r_{26} & r_{27} & r_{28} & r_{29} & r_{30} & r_{31} & r_{32} & r_{33} & & \\
4 & r_{34} & r_{35} & r_{36} & r_{37} & r_{38} & r_{39} & r_{40} & r_{41} & r_{42} & & & \\
5 & r_{43} & r_{44} & r_{45} & r_{46} & r_{47} & r_{48} & r_{49} & r_{50} & & & & \\
6 & r_{51} & r_{52} & r_{53} & r_{54} & r_{55} & r_{56} & r_{57} & & & & & \\
7 & r_{58} & r_{59} & r_{60} & r_{61} & r_{62} & r_{63} & & & & & & \\
8 & r_{64} & r_{65} & r_{66} & r_{67} & r_{68} & & & & & & & \\
9 & r_{69} & r_{70} & r_{71} & r_{72} & & & & & & & & \\
10 & r_{73} & r_{74} & r_{75} & & & & & & & & & \\
11 & r_{76} & r_{77} & & & & & & & & & & \\
12 & r_{78} & & & & & & & & & & & \\
\end{array}
\]

Sym
Nonlinear Gap-Friction Element (GAP)

**General Description**

GAP is a two- or three-dimensional interface element for linear or nonlinear structural models analyzed by the NSTAR module. Two types of gap elements can be defined: a) Two-node (or Node-to-Node Gap) elements, and b) One-node (or Node-to-Line and Node-to Surface Contact) elements.

1. **Node-to-Node Gap**

   For the two-node gap element, as shown in Figures 4-84 and 4-85, it is assumed that the contact location and direction are known and do not change during the application of external loads. The two-node gap elements are placed between the contacting bodies such that the direction of the gap represents the direction of the contact force (normal to the surface at the contact point).

   The two-node element can behave either like a rigid link (referred to as "regular gap" shown in Figure 4-84) or as a flexible gap (referred to as "general gap" shown in Figures 4-84 and 4-85) for which a non-zero stiffness has to be defined.

   The direction of the node-to-node gap element is specified by the line connecting the gap's first and second nodes as shown in Figure 4-84. A third node is required only if friction is considered.

   Friction (Coulomb damping) effects, when present for the two-node element, are accounted for by equivalent forces which resist the relative velocity (incremental relative displacement for static analysis) between two nodes, acting in a plane parallel to the interface. The direction of the friction force always opposes the relative velocity between the two nodes and its magnitude is limited to the product of the gap's normal force and the coefficient of friction. The friction effect is only considered with the compressive gaps.

   The node-to-node gap element can resist either compression or tension forces in the direction normal to the interface:

   - a compression gap resists compression once the relative contraction between the two nodes exceeds the defined gap distance.
   - a tensile gap limits the relative expansion between the two nodes to the gap distance.

2. **Node-to-Line and Node-to-Surface Contact**

   The one-node gap element can be used for two-dimensional (node-to-line) and three-dimensional (node-to-surface) contact problems as shown in Figures 4-86
Both line and surface contact problems can be considered with the effect of Coulomb friction. In order to consider the contact between two bodies, one body is declared "contactor", while the other is designated as the "target". The region of contact between the two bodies is governed by the overall problem geometry, applied loads, material properties, and other relevant conditions. In COSMOS/M, the contact problem is defined in accordance with the following procedure:

1. The region of contact of the "contactor" body is established by a series of nodal points to which one-node gap elements should be assigned.
2. The region of contact on the "target" body is defined by a series of contact lines (in 2D problems) or surfaces (in 3D problems).
3. The extent of contact between the two bodies is limited to areas defined by the one node gap elements. With the small-displacement restriction removed, each gap can come in contact with any of the surface segments in that same group.
4. Each surface (or line) of the "target" body is assigned a positive and a negative side based on its node connectivity as described in the element Coordinate system section. The negative side is where the gap nodes are forbidden to enter.

The following commands within the Analysis > NONLINEAR > CONTACT submenu are used for the definition of contact lines or surfaces with 1-node gap elements:

- **Contact Surface**: defines a contact line or surface. A maximum of 3 nodes per line and 9 nodes per surface may be specified.
- **Contact Surface by geometry**: generates gap elements and associated line or gap surfaces based on geometric entity specification.
- **Initial Interference**: used for initial interference problems when the contact condition is initially violated.

More information about these commands can be found in COSMOS/M Command Reference Manual. Chapter 4 of the Nonlinear Section in the Advanced Modules Manual also provides additional coverage on the Gap/Contact capabilities.

**Special Features**

*Regular Node-to-Node Gap*

The regular gap element is formulated based on the use of equivalent forces rather than its stiffness. The advantages of this approach are as follows:
Chapter 4  Element Library

1. When there is no source of nonlinearities other than gaps and frictions, stiffness reformation is not required during a step-by-step static or dynamic analysis.

2. In a linear static analysis, where gaps do exist but no friction effect is considered, the final configuration can be attained in just one step without the need for an incremental solution. (By linear, it is meant that, with the exception of gaps, no other material or large displacement nonlinearities exist).

3. The element is considered perfectly rigid, thus no confusion arises in the selection of the gap stiffness.

It is to be noted that since no stiffness is included for gap elements, soft truss elements must be used if the structure is free to move without considering gaps and friction forces.

General Node-to-Node Gap

The general gap element can be used to model a variety of nonlinear spring or linear/nonlinear spring-dampers. By using two of these elements (one compressive and one tensile) between two nodes, symmetric or unsymmetric two-way systems can be constructed. If damping exists, the damping force is assumed to be proportional to a power of the relative velocity. Figure 4-85 illustrates the compressive and tensile models.

As in the case of regular gap elements, general gap elements do not affect the structure stiffness. If other nonlinearities do not exist, then:

1. The structure stiffness does not need to be updated during a step-by-step solution.
2. No equilibrium iterations are required.
3. In a static analysis the solution can be reached in one step.

Some applications of the “general gap” element are described below:

1. Flexible contact surfaces (with or without friction).
2. Flexible one- or two-way springs, where a maximum distance (G) is used to prevent the spring from deflecting to a length of zero or negative.
3. The preload, \( f_o \) (as defined in Figure 4-85), is useful for contact problems where an initial interference exists.
4. Linear/nonlinear one- or two-way spring dampers (using one or two gap elements).
5. Damping can be nonlinear if the power of velocity \( (p) \) is not equal to one. Note that the total gap force is the summation of the forces in the damper and the spring.
6. Moving boundary problems which occur in metal forming process.
7. Gaps can be used with axisymmetric elements. In this case, the gap forces have the units of force per radian.
   The geometric location of nodes i and j, shown in Figure 4-85, is used to define the direction of the gap force. The contact of the two nodes is determined based on the open gap distance \((g)\) and the maximum allowable deflection of the spring \((G)\). While the connecting nodes may be far apart geometrically, a gap distance of zero means that the two nodes are in contact.

**One-Node Gap Elements**

The special features of node-to-line and node-to-surface contact elements are:

1. There is no need to define the point of contact. The location of contact points and the corresponding contact forces are automatically determined based on the deformed shape of the line or surface of contact.
2. The initial gap distance between the contacting bodies need not be specified by the user.
3. The contact line or surface options can handle initial interference problems (e.g. shrink fit models) where a portion of the model is forced to assume a new position.
4. Friction can be considered for both static and dynamic analyses.
5. All nonlinear effects including large displacements, elasto-plastic materials, and other nonlinear conditions can be accounted for in the solution of contact problems.

**Default Element Coordinate System (ECS = -1)**

**Node-to-Node Elements**

The normal axis \((n)\), along the direction of the gap as shown in Figure 4-84, goes from the first node to the second. In case of friction, a third node \((K)\) has to be defined so that the \((s)\) axis, which defines the direction of the friction force, is normal to \((n)\) and lies in the plane \((D)\) formed by the three nodes \((1, 2 \text{ and } K)\). The \((s)\) axis is oriented such that the projection of the vector \(z = s \times n\) on the Z-axis points toward the positive sense of Z. A special case arises when the Z-axis is parallel to the plane \((D)\) as shown in part (b) of Figure 4-84. In this case, the \((s)\) axis is oriented such that the projection of the vector \(z = s \times n\) on the X-axis points toward the positive sense of X, unless \(z\) is parallel to the Y-axis. In this case, \(z\) is chosen in the positive sense of Y.
Node-to-Line Elements

In two dimensional analysis, contact lines can be generated by a combination of straight lines and curves. A contact line is defined by 2 or 3 nodes as shown in Figure 4-86, where \( r \) is the vector connecting node (1) to node (2). The positive side of the line as denoted by the \( p \) vector is defined as follows:

- \((Z \times r)\) points to the positive side if the contact line is in the X-Y plane.
- \((X \times r)\) points to the positive side if the contact line is in the Y-Z plane.
- \((Y \times r)\) points to the positive side if the contact line is in the X-Z plane.

Node-to-Surface Elements

Three dimensional analysis uses a series of flat or curved surfaces to define the contact areas. A contact surface is defined by 3 to 9 nodes as illustrated in Figure 4-87. Letting \( r \) and \( s \) be the surface coordinate axes, the cross product of \((r \times s)\) points to the positive side of the surface (noted by the \( p \) vector).

Element Group Options

Op. 1: Flag to update line or surface coordinates (for node-to-line and node-to-surface contact problems only)
- \( = 0 \); coordinates are not updated
- \( = 1 \); coordinates are updated (representing sides or faces of elements)

Op. 2: Flag for friction
- \( = 0 \); no friction is considered
- \( = 1 \); generalized friction (Contact may or may not be sliding; the status is determined by the program, and the solution is obtained accordingly)
- \( = 2 \); friction exists but the structure is sliding

Op. 3: Flag for friction outside X-Y plane (only for node-to-node gap elements)
- \( = 0 \); no friction outside X-Y plane
- \( = 1 \); friction outside X-Y plane (a third node has to be defined)

Op. 4: Flag defining type of gap
- \( = 0 \); node-to-node gap
- \( = 1 \); node-to-line contact (2D analysis)
- \( = 2 \); node-to-surface contact (3D analysis)

Op. 5: Flag specifying number of nodes per line or surface segments (not prompted in case of node-to-node gap) (See Contact Surface. command)
- \( = 2 \) or \( 3 \); number of nodes per line
- \( = 3 \) to \( 9 \); number of nodes per surface
Chapter 4  Element Library

**Op. 6:** Compressive gap measurement flag
- 0; defined by user
- 1; automatically defined by the program

**Op. 7:** Flag to ignore all GAP elements
- 0; consider GAP elements
- 1; ignore all GAP elements

**Op. 8:** Unused option

**Real Constants**

*For Regular Node-to-Node Gap Element*

\[ r_1 = \text{Gdist} - \text{allowable relative displacement (between the gap's 2 nodes)} \] with no gap resistance.
- > 0.0 gap resists compression
- = 0.0 gap is originally closed and resists compression (default)
- < 0.0 gap resists tension

\[ r_2 = \text{Gfric} - \text{Coefficient of friction used for defining the maximum friction force.} \]

For constants \( r_3 \) to \( r_7 \), use the default values. They are only required for the general Gap element.

*For General Node-to-Node Gap Element*

(See Figure 4-85 for definition of constants)

\[ r_1 = \text{Gdist} - \text{allowable relative displacement (between the gap's 2 nodes)} \] with no gap resistance.
- > 0.0 gap resists compression
- = 0.0 gap is originally closed and resists compression (default)
- < 0.0 gap resists tension

\[ r_2 = \text{Gfric} - \text{Coefficient of friction used for defining the maximum friction force.} \]

\[ r_3 = \text{Spring stiffness associated with the gap. Default is 0.0 for no spring (perfectly rigid gap). Non-zero values define the spring constant.} \]

The following constants \( r_4, r_5, r_6 \) and \( r_7 \) are considered only when \( r_3 > 0.0 \):

\[ r_4 = \text{Preload in gaps (f0). See Figure 4-85 (default is 0.0)} \]
\[ r_5 = \text{Maximum allowable distance (G) beyond which gap responds as perfectly rigid (default is 1. x 108)} \]
\[ r_6 = \text{Damper constant (c). See Figure 4-85 (default is 0.0)} \]
\[ r_7 = \text{Damper constant (p). See Figure 4-85 (default is 1.0)} \]
r8 = Source Stiffness in the X-direction  
r9 = Source Stiffness in the Y-direction  
r10 = Source Stiffness in the Z-direction  
r11 = Target Stiffness in the X-direction  
r12 = Target Stiffness in the Y-direction  
r13 = Target Stiffness in the Z-direction

Note that constants (r3 to r7) must all be defined by positive real values.

For One-Node Gap elements, only r2 and r3 are used if needed. Other constants are ignored. Use the default values for (r1 and r4 to r7).

Material Properties

(None)

Element Loadings

(None)

Output Results

For every solution step, the node-to-node gap's normal force (negative for compressive gaps) is available along the (n) direction. The friction force output represents the force which is applied to the structure at the gap's second node in (s) direction. The friction force at the first node with the same magnitude but opposite in direction, will not be listed in the output file.

For node-to-line and node-to-surface elements, the magnitude of the normal force (normal to the contact line or surface) and the friction force are given in the output file along with their direction cosines relative to the global Cartesian coordinate system.

Limitations

The total number of gap elements is restricted to 20,000.
Chapter 4  Element Library

References


Part (A) General Case

![Diagram of a Node-to-Node Gap Element in a Global Cartesian Coordinate System and an Element Coordinate System. The figure includes vectors for gap distance, relative velocity, force components, and the coordinate axes.](image)

Part (B) Special Case:
Global Z is Parallel to D

![Diagram showing a special case where the Global Z axis is parallel to D.](image)

**Variables:**
- **XYZ:** Global Cartesian Coordinate System
- **snz:** Element Coordinate System
- **Vrel:** Relative Velocity in s-direction
- **Fn:** Compressive gap force in n-direction
- **Fs:** Friction force in s-direction
  - \( F_s < gfric.F_n \) where \( gfric \) is the coefficient of friction
- **K:** A third node is required only if friction is to be considered

**Figure 4-85. Parameters for the General Node-to-Node Gap Element**

![Diagram of parameters for the General Node-to-Node Gap Element](image)

- \( G \): Open gap distance
- \( k \): Spring stiffness
- \( f_0 \): Spring preload, \( F_g = f_0 + k (U_{rel} - g) \), where \( F_g \) is the force applied between nodes "i" and "j" in the gap direction. Note that \( f_0 \) is a nonlinear property, i.e., it can only resist relative motion in one direction, and cannot cause motion in the other direction.
- \( G \): Maximum allowable deflection of the spring. Once the distance is closed, the element will react perfectly rigid to any motion beyond this point.
- \( c, p \): Damping Properties (used with dynamic analysis only)

The damping force is defined by:

\[
F_d = c \, \text{abs} (V_{rel}) \, | - \text{Sign} (V_{rel}) |
\]

\( V_{rel} \) = Relative velocity between nodes i and j
Chapter 4  Element Library

Figure 4-86. Node-to-Line Gap Element (2D Contact Problem: Case of X-Y Plane)

Figure 4-87. Node-to-Surface Gap Element (3D Contact Problem)
Nonlinear Immersed Pipe/Cable Element (IMPIPE)

General Description
IMPIPE is a 2-node uniaxial element for three-dimensional immersed nonlinear structural models. Six degrees of freedom (three translations and three rotations) are considered per node. The element can be regarded as a special case of the 3D BEAM since input requirements are reduced due to the tubular cross section geometry. Unlike the 3D BEAM, the element coordinate system is defined by the program without defining a third node.

The element can be totally immersed, partially immersed or used as a regular pipe/cable element. It should be noted that the origin of any problem having the IMPIPE must be located at the free surface (mean sea level). The z-axis is always the vertical axis pointing opposite to the gravity direction.

Special Features
Linear elasticity, Large displacement, Temperature-dependent linear elasticity, Hydrostatic and hydrodynamic analysis.

Default Element Coordinate System (ECS = -1)
The nodal input pattern is shown in Figures 4-88 and 4-89. The element x-axis goes from the first node to the second. The zp-axis of the element projection on X-Y plane is parallel to and in the positive sense of the global Cartesian Z-axis. The xp, yp, and zp complete a right-hand Cartesian system. The element y-axis is parallel to and in the positive sense of the yp-axis. The element z-axis completes a right-hand Cartesian system with x- and y-axes. When the element is parallel to the global Z-axis, the element y-axis is always parallel to and in the positive sense of the Y-axis, as shown in Figure 4-89.

Element Group Options
Op. 1: Element type
= 0; pipe option: It may be used for torque balanced pipes (default)
= 1; cable option
= 2; pipe with twist-tension option: It may be used for non-torque balanced pipes. The option adds a twist-tension stiffness constant as a function of the helical winding of the armoring.
Chapter 4   Element Library

**Op. 2:** Load vector  
- 0; consistent load vector  
- 2; reduced load vector (default)

**Op. 3:** Unused option for this element

**Op. 4:** Wave theory (to be used only with dynamic analysis. For static analysis, use default value).  
- 0; small amplitude wave theory modified by a depth-decay function (default)  
- 1; small amplitude wave theory without modification

**Op. 5:** Unused option for this element

**Op. 6:** Large displacement formulation  
- 0; small displacement formulation (default)  
- 1; large displacement formulation

**Op. 7:** Element printout (To be used only with dynamic analysis. For static analysis, use the default value.)  
- 0; basic element printout (default)  
- 1; add the printout of the 2 integration points used for the hydrodynamic analysis

**Op. 8:** Unused option for this element

**Real Constants**

- **r1** = Outside diameter of the pipe  
- **r2** = Thickness of the pipe (if the input value = 0, r2 is taken = r1/2)  
- **r3** = Flexibility factor = \( Io / I \)  

\[
I_o = \frac{\pi}{64} \left( \frac{r_1^4 - d_i^4}{d_i^4} \right)
\]

- **d_i** = internal diameter of the pipe  
- **I** = moment of inertia to be used by the program

It should be noted that the default value for (r3) is (1.0) if input as (0.0).

- **r4** = End-release code  
  The code consists of two digits. The first digit represents the end condition for the first node, and the second digit refers to the end condition for the second node. The possibilities for end release code are: 00, 01, 10 and 11. A “0” means that the node can sustain moments and a “1” indicates that a hinge condition is considered.

- **r5** = Internal pressure  
- **r6** = Internal fluid density
Chapter 4  Element Library

\[ r7 = \text{Global Z-coordinate of the pipe internal fluid's free surface} \]
\[ r8 = \text{Mass of internal fluid/hardware} \]
\[ r9 = \text{External insulation density} \]
\[ r10 = \text{Thickness of external insulation} \]
\[ r11 = \text{Coefficient of buoyant force:} \]
  - The value for \( r11 \) is set to \( 1.0 \) if input as \( 0.0 \)
  - If \( r11 \) is required to be \( 0.0 \), it has to be input as any negative number
  - Any other positive input value will be taken as is
\[ r12 = \text{Coefficient of axial strain correction due to external hydrostatic and hydrodynamic pressures:} \]
  - The value for \( r12 \) is set to \( 1.0 \) if input as \( 0.0 \)
  - If \( r12 \) is required to be \( 0.0 \), it has to be input as any negative number
  - Any other positive input value will be taken as is
\[ r13 = \text{Coefficient of added mass:} \]
  - The value for \( r13 \) is set to \( 1.0 \) if input as \( 0.0 \)
  - If \( r13 \) is required to be \( 0.0 \), it has to be input as any negative number
  - Any other positive input value will be taken as is
\[ r14 = \text{Coefficient of fluid inertia force:} \]
  - The value for \( r14 \) is set to \( r13 \) if input as \( 0.0 \)
  - If \( r14 \) is required to be \( 0.0 \), it has to be input as any negative number
  - Any other positive input value will be taken as is
\[ r15 = \text{Coefficient of normal drag} \]
\[ r16 = \text{Coefficient of tangential drag} \]
\[ r17 = \text{Prestrain} \]

**Structural Mass**

- Total structural mass \( m \) (mass/length):
  \[
m = \rho A + m_i + \rho_o A_o
  \]
  where:
  \[
m_i = \text{Mass on internal fluid/hardware (r8)}
  \]
  \[
\rho_o = \text{External insulation density (r9)}
  \]
  \[
d_o = [(d_o^+ - d_o^2)] \pi/4
  \]
  \[
d_o^+ = d_o + 2t_o
  \]
  \[
d_o = \text{Outside diameter of the pipe (r1)}
  \]
  \[
t_o = \text{Thickness of external insulation (r10)}
  \]

Required real constants are \( r1, r8, r9, \) and \( r10 \).
Chapter 4  Element Library

Material Properties

EX = Modulus of elasticity
ALPX = Coefficient of thermal expansion
NUXY = Poisson's ratio
DENS = Density
GXZ = Twist-tension stiffness constant (to be used only when Op. 1 = 2)
VISC = Viscosity (used only to determine the Reynolds number of the fluid outside the pipe/cable)

Water Motion Table

A water motion table has to be defined (using the Define command in the ANALYSIS > NONLINEAR > WATERTABLE menu) for hydrostatic and/or hydrodynamic analyses. Constants associated with (subset_number = 1), (subset_number = 2), and (subset_number = 7) are illustrated in Figures 4-90, 4-91, and 4-92.

Element Loadings

• Thermal
• Gravitational
• Hydrostatic

The hydrostatic effects include: internal pressure, external hydrostatic pressure, and buoyant force.

Hydrostatic

A. Internal pressure $p_i$:

$$p_i = p_i (z - h_o) \ g_z + p (> 0)$$

*where:*

- $p_i$ = Internal pressure (r5)
- $\rho_i$ = Internal fluid density (r6)
- $h_o$ = Global Z-coordinate of the pipe internal fluid's free surface (r7)
- $z$ = Z-coordinate of the measured point
- $g_z$ = Acceleration of gravity

Required real constants are r5, r6, and r7.
B. External hydrostatic pressure $p_o$:

$$p_o = \rho_w \cdot z \cdot g \cdot z (>0)$$

where:

$\rho_w$ = Water density (input during motion table definition)

C. Correction of axial strain $\varepsilon_{xx}$ due to thermal loading and hydrostatic and/or hydrodynamic pressures:

$$\varepsilon_{xx} = \alpha \cdot T + C_p \left( \frac{p_I \cdot d_i^2 - p_o \cdot d_o^2}{d_o^2 - d_i^2} \right) \left( \frac{1 - 2\nu}{E} \right)$$

where:

$C_p$ = Coefficient of axial strain correction (r12)
$\alpha$ = Thermal coefficient
$T$ = Element temperature
$E$ = Elastic modulus
$\nu$ = Poisson's ratio
$p_o$ = External hydrostatic/dynamic pressure

D. Buoyant force $f_\beta$ (force/length):

$$f_\beta = -C_\beta \cdot \beta_w \cdot A^+ \cdot g \cdot z (>0)$$

where:

$C_\beta$ = Coefficient of buoyant force (r11)

Hydrodynamic:

The hydrodynamic effects include: a moving structure in a motionless fluid, a fixed structure in a moving fluid, a moving structure in a moving fluid. The fluid motion consists of wave and current motions.
A. Added mass $M_f$ (mass/length):

$$m_f = C_i \rho_w A^+$$

where:

$C_i$ = Coefficient of added mass (r13)

Added mass is added to the total structural mass for effective stiffness matrix and residual vector calculation.

B. Fluid induced inertia force $f_{\sim f}$ (force/length):

$$f_{\sim f} = C_M \rho_w A^+ A_f^n$$

where:

$C_M$ = Coefficient of fluid inertia force (r14)

$A_f^n$ = Normal fluid acceleration relative to the pipe axis

C. Fluid induced drag force $f_{\sim D}$ (force/length):

$$f_{\sim D}^n = C_D \rho_w r_o^+ \left( \frac{v_f - v}{r_o} \right)^n \left( \frac{v_f - v}{r_o} \right)^n$$

$$f_{\sim D}^t = C_T \rho_w r_o^+ \left( \frac{v_f - v}{r_o} \right)^t \left( \frac{v_f - v}{r_o} \right)^t$$

where:

$f_{\sim D}^{n,t}$ = Normal and tangential drag forces relative to the pipe axis

$C_D$ & $C_T$ = Coefficients of normal and tangential drag (r15 and r16)

$r_o$ = Outer pipe radius

The hydrodynamic loading is present only when nonlinear analysis is performed.

D. Reynolds number-dependency of drag coefficients $C_D$ and $C_T$:

$$R_{\sim e}^n = \left( \frac{v_f - v}{r_o} \right)^n \frac{d_o^+ \rho_w / \mu}{\mu}$$

$$R_{\sim e}^t = \left( \frac{v_f - v}{r_o} \right)^t \frac{d_o^+ \rho_w / \mu}{\mu}$$

where:

$\mu$ = Viscosity
The users are required to provide information in water motion table definition: subset-3, 4, and 5 for interpolation. Temperature-dependency of viscosity: Users are required to provide information in motion table definition: subset-6 and define the viscosity versus temperature curve through temperature curve definition for interpolation.

E. Fluid motion:

- **Current:**
  - Define current velocity, current direction angle versus elevation table in motion table definition.
  - Obtain current velocity and the associated angle by interpolation.
  - Available in both static and dynamic analysis. Static analysis to simulate steady-state condition.

- **Wave - Total Wave Height:**

\[
\eta_h = \sum_{i=1}^{N_w} \frac{H_i}{2} \cos \beta_i 
\]

*where:*

- \(N_w\) = Number of wave components
- \(H_i\) = Wave amplitude - \(i\)
- \(\beta_i = 2\pi \left( \frac{R}{\lambda_i} - \frac{t}{\tau_i} + \frac{\psi_i}{360} \right)\)
- \(R\) = Radial distance to point of element from origin in x-y plane in the direction of the wave
- \(\lambda_i\) = Wave length - \(i\)
- \(\tau_i\) = Wave period - \(i\)
- \(\psi_i\) = Phase shift - \(i\)

- **Fluid particle velocities \(VR\) and \(VZ\):**

\[
V_R = \sum_{i=1}^{N_w} \cosh \left( \frac{k_i \eta_i}{\lambda_i} \right) \frac{w_i}{\sinh \left( \frac{k_i d}{\lambda_i} \right)} \eta_i \\
V_Z = \sum_{i=1}^{N_w} \cosh \left( \frac{k_i \eta_i}{\lambda_i} \right) \frac{w_i}{\sinh \left( \frac{k_i d}{\lambda_i} \right)} \eta_i 
\]
where:

\[ k_i = \text{Wave number} - i (=2\pi\lambda_i) \]
\[ w_i = \text{Wave frequency} - i (=2\pi/\tau_i) \]
\[ \eta_i = \text{Wave height} - i \]
\[ \eta'_i = \frac{d\eta_i}{dt} \]
\[ \xi = d + z \text{ (d = water depth)} \]
\[ f = \text{Depth-decay function:} \]
\[ f = 1 \quad \text{if element group Option 4 = 1} \]
\[ f = \frac{d}{d = \eta_s} \quad \text{if element group Option 4 = 0} \]

- Fluid particle accelerations \( A_R \) and \( A_Z \):

\[ A_R = \sum_{i=1}^{N_w} \frac{\cosh \left(\frac{k_i \xi f}{d} \right)}{\sinh \left(\frac{k_i d}{d} \right)} w_i \left( \eta'_i - C \eta_i \right) \]
\[ A_Z = \sum_{i=1}^{N_w} \frac{\cosh \left(\frac{k_i \xi f}{d} \right)}{\sinh \left(\frac{k_i d}{d} \right)} w_i \left( -w_i \eta_i - C \eta'_i \right) \]

where:

\[ C = \frac{\xi d}{(d + \eta_s)^2} \]

- Hydrodynamic pressure \( p_o^d \):

\[ p_o^d = p_w g z \sum_{i=1}^{N_w} \frac{\cosh \left(\frac{k_i \xi d}{d + \eta_s} \right)}{\cosh \left(\frac{k_i d}{d} \right)} \]

Output Results

Forces and stresses are available in the element coordinate system. The direction of forces for this element is similar to the 3D BEAM element shown in Figure 4-7.

The following information is listed in the output file:

- Fr, Vs, Vt = Nodal forces in the element x-, y-, and z-directions
- Tr, Ms, M = Nodal moments in the element x-, y-, and z-directions
Chapter 4   Element Library

Sdir = Centroidal stress (Fr/A)
Tlf = Maximum shear stress due to lateral force (V/As)
Ttor = Torsional stress \( T \bar{r}/J \ T \)
Sbend = Maximum bending stress \( M_{\bar{r}}/I \)
Sh = Hoop stress at outer surface of the pipe due to pressure
S1,S3 = Maximum and minimum principal stresses at outer surface of the pipe
Se = Maximum effective stress at outer surface of the pipe
SI = Maximum stress intensity at outer surface of the pipe

where:
A = area of the pipe
V = \((V_s^2 + V_t^2)^{1/2}\)
As = shear
r = outer radius of the pipe
J = torsion constant
I = moment of inertia

Stress Output

A. Nodal force in the element x-direction \( F_r \):

\[
F_r = F_r^0 + \text{Sgn} \left( p_i d_i^2 - p_o d_o^2 \right) \pi/4
\]

where:
\( F_r^0 \) = Nodal force by calculation
\( \text{Sgn} \) = Sign convention for node

B. Hoop stress \( S_h \):

\[
S_h = \left[ 2p_i d_i^2 - p_o \left( d_o^2 + d_i^2 \right) \right] / \left( d_o^2 + d_i^2 \right)
\]

If additional printout is required in case of hydrodynamic analysis, the following information will be listed at the integration points:

\( V_r, V_z \) = Water particle velocities in wave and Z-directions
\( A_r, A_z \) = Water particle accelerations in wave and Z-directions
\( \text{Phydn} \) = Hydrodynamic pressure due to the wave
Chapter 4  Element Library

ETA  = Total wave height
Tfluid = Fluid temperature
VISC = Viscosity (temperature-dependent-property)
Ren, Ret= Reynolds numbers in the directions normal/tangential to the element
Cd, Ct = Coefficients of normal and tangential drags respectively (Reynolds number-dependent properties)
Cm = Coefficient of fluid inertia force
Cd  = Cd.ζ(r+)
Ct  = Ct.ζ(r+)
Cdw = Cm.ζ.p.(r+)²
Urt,y,z = Relative velocities in the element x-, y-, and z-directions
|Urm| = Relative velocity in the direction normal to the element
Ay,z = Accelerations in the element y- and z-directions
Fx,y,z = Hydrodynamic force densities in the element x-, y-, and z-directions

where:
ζ = water density
r+ = r1/2 + r10
π = 3.14159

Figure 4-88. Immersed Pipe (General Case)
Figure 4-89. Immersed Pipe (Special Case)

- XYZ: Global Cartesian Coordinate System
- xyz: Element Coordinate System

Figure 4-90. Constants Associated with (subset_number=1) and (subset_number=2) in the Water Motion Table Definition

- Global Coordinate System (Origin must be at water surface)
- Immersed Pipe
- Water Depth
- Sea Bed
- Current Direction Angle - j
- Wave Direction Angle

- Elevation - j
- Water Surface
Chapter 4  Element Library

Figure 4-91. Constants Associated with subset_number=2 in the Water Motion Table Definition

![Water Surface](image1)

Figure 4-92. Constants Associated with subset_number=7 in the Water Motion Table Definition

![Water Surface](image2)

References


Nonlinear Immersed Buoy Element (BUOY)

General Description
BUOY is a one-node immersed (sphere) buoy element for nonlinear structural analysis. The element can be regarded as an extension of the nonlinear general mass element (MASS). It is usually used with the immersed pipe/cable (IMPIPE) elements for hydrostatic/hydrodynamic analysis. Up to six degrees of freedom are considered per node.

The buoy element shares the same water-motion-table with the immersed pipe/cable element.

Special Features
Hydrostatic and hydrodynamic analysis.

Element Group Options

Op. 1 to Op. 3: Unused options for this element

Op. 4: Wave theory

= 0; Small amplitude wave theory modified by a depth-decay function (default)
= 1; Small amplitude wave theory without modification

Op. 5 to Op. 8: Unused options for this element

Real Constants

r1 = Mass in the global Cartesian X-direction
r2 = Mass in the global Cartesian Y-direction
r3 = Mass in the global Cartesian Z-direction
r4 = Rotary inertia about the global Cartesian X-direction
r5 = Rotary inertia about the global Cartesian Y-direction
r6 = Rotary inertia about the global Cartesian Z-direction
r7 = Outside diameter of the buoy
r8 = Coefficient of buoyant force:

- The value for (r8) is set to (1.0) if input as (0.0)
- If (r8) is required to be (0.0), it has to be input as any negative number
- Any other positive input value will be taken as is
Chapter 4  Element Library

r9  =  Coefficient of added mass:
   - The value for (r9) is set to (1.0) if input as (0.0)
   - If (r9) is required to be (0.0), it has to be input as any negative number
   - Any other positive input value will be taken as is

r10=  Coefficient of fluid inertia force:
   - The value for (r10) is set to (r9) if input as (0.0)
   - If (r10) is required to be (0.0), it has to be input as any negative number
   - Any other positive input value will be taken as is

r11=  Coefficient of drag

Material Properties

(None)

Element Loadings

• Hydrostatic
• Hydrodynamic

Output Results

(None)
**General Description**

RLINK is a 2-node element to model the heat flow between two nodes due to radiation. One degree of freedom for each node is used in two- or three-dimensional thermal models.

The nodal input pattern for this element is shown in Figure 4-93. The two nodes may or may not be coincident. If one of the nodes is not connected to the model, its temperature must be specified as a boundary condition (source temperature).

**Special Features**

(None)

**Element Group Options**

(None)

**Real Constants**

\[ q_{12} = \frac{\sigma(T_1^4 - T_2^4)}{1 - \epsilon_1 + \frac{1}{A_1\epsilon_1} + \frac{1 - \epsilon_2}{A_2\epsilon_2}} \]

Where:

- \( q_{12} \) = heat transfer rate through the element
- \( \sigma \) = Stefan-Boltzmann's constant
- \( T_1 \) and \( T_2 \) are temperatures of nodes 1 & 2
- Other parameters are described in the Real Constants section.

**Material Properties**

(None)

**Element Loadings**

Thermal

**Output Results**

Heat flow due to radiation is available for each element.
**Thermal Convection Link (CLINK)**

**General Description**
CLINK is a 2-node element to model the heat flow due to convection between two nodes. One degree of freedom per node is used in two- or three-dimensional thermal models.

The nodal input pattern for this element is shown in Figure 4-94. The two nodes may or may not be coincident. Temperature boundary conditions must be specified at the node which is not directly connected to the model. This temperature boundary condition represents the convection source temperature.

**Special Features**
*(None)*

**Element Group Options**
*(None)*

**Real Constants**
\[ r1 = \text{Area of the convection surface} \]

**Material Properties**
\[ HC = \text{Film coefficient} \]

**Element Loadings**
- Thermal

**Output Results**
Heat flow due to convection is available for each element.
### Thermal 3D Fluid Pipe Element (FLUIDT)

#### General Description

**Figure** The FLUIDT element is a 2-nod fluid element designed to simulate the cooling and heating of solids by running fluids. Given that the rate of the fluid flow is known, the element considers heat conduction within the fluid and heat convection between the solid and the fluid through the pipe wall. The element also considers the effects of fluid mass transport.

The program uses the information provided by the **FLINKDEF** command to associates each node of a FLUIDT element with a number of nodes on the thermal solid. These nodes represent the area of convection (portion of the pipe wall) associated with this fluid node.

Each node of the FLUIDT element has one degree of freedom (temperature).

#### Default Element Coordinate

The nodal input pattern shown in Figure 4-95 specifies the direction of the element axis. The x-axis goes from the first node to the second node. Positive rate of flow indicates flow in the positive x-axis direction. Similarly, negative rate of flow indicates flow in the negative x-axis direction.
Material Properties

- Thermal conductivity of the fluid
- Mass density of the fluid
- Specific heat of the fluid
- Viscosity of the fluid
- Film coefficient

Element Group Options

There are no element group options for this element.

Special Features

- Temperature-dependent properties
- Unsymmetric thermal conductivity matrix
- Steady state and transient thermal analysis

Required Input

- The mass flow rate.
- The film coefficient as a material property, or the required parameters to evaluate a flow-dependent film coefficient using Nusselt number.
- Fluid pressure (required only if the density is dependent on the pressure as specified by the ideal gas law).
- The FLINKDEF command must be used along with the FLUIDT element group to define the region(s)/surface(s) that form the pipe wall on the thermal solid and associate them with the geometric curve that makes the FLUIDT elements. The area of convection associated with each node of the FLUIDT element is determined by the program.

Temperature for evaluating the film coefficient is obtained by averaging the temperature of a solid node on the convection area and the associated fluid node. For any other purpose, temperature is defined by the average temperature of the two fluid nodes.
Real Constants

r1 = Hydraulic diameter (D)
r2 = Cross-sectional area of the flow (A)
   (default = \(\pi D^2/4\))
r3 = Mass flow rate (W)
   W > 0: Flow direction is in the positive x-axis of the element
   W < 0: Flow direction is in the negative x-axis of the element

Real constants to define flow-dependent film coefficient
(used only if material property HC=0.0)

r4, ..., r7 = Real constants for determining the Nusselt’s number. The flow-
dependent film coefficient is evaluated from:

\[ h_f = (\text{Nu}) \left( \frac{K}{D} \right) \]

where:
K = Fluid thermal conductivity
D = Hydraulic diameter
\(\text{Nu} = \text{Nusselt number} = r4 + (r5) (\text{Re})^{r6}(\text{Pr})^{r7} \)

where:
\(\text{Re} = \text{Reynolds number} = (W.D)/(v.A)\)
\(\text{Pr} = \text{Prandtl number} = c.v/K\)
W = Mass flow rate
c = Specific Heat
v = Viscosity

Real constants to evaluate density from the ideal gas law
(used only if material property DENS=0.0)

r8 = gas constant (Rgas)
r9 = Pressure (p) in the ideal gas law
\[ d = \frac{p}{(R_{\text{gas}} T_{\text{abs}})} \]

where:
d = density
\(T_{\text{abs}} = \text{Absolute temperature} = T + T_{\text{offset}}\)
T = Average element temperature = \((T_i + T_j) / 2\)
Material Properties

KX = Fluid Thermal Conductivity
DENS = Fluid Mass Density
C = Specific Heat
VISC = Fluid Viscosity
HC = Film Coefficient

Basic Element Formulation

The matrix equation governing the element behavior is:

\[ [C] \{ T' \} + [K] \{ T \} = \{ Q \} + \{ Q_g \} \]

where:

[C] = specific heat matrix
[K] = conductivity matrix (includes effects of convection and mass transport
\{ T \} = vector of nodal temperatures
\{ T' \} = vector of variations of nodal temperatures with respect to time
\{ Q \} = vector of nodal heat flow
\{ Q_g \} = internal heat generation vector
**Pipe Flow Element (HLINK)**

**General Description**

HLINK is a 4-node or 2-node element to model the flow through a pipe with heat transfer. All 4-node elements must be defined in the X-Y plane. Nodes 1 and 2 must lie along the axis of the pipe and nodes 3 and 4 lie on the pipe wall as shown in Figure 4-95. The nodes on the axis of the pipe have pressure and temperature degrees of freedom whereas the nodes on the pipe wall have only temperature degree of freedom. The 2-node element is used only if users are interested in getting the hydraulic solution (i.e., calculation of nodal pressures).

In order to consider the heat transfer with the flowing fluid, a heat transfer coefficient is specified through an empirical correlation of the following form:

$$\text{Nu} = C_1 + C_2 \cdot \text{Re}^{C_3} \cdot \text{Pr}^{C_4}$$

where

- \(\text{Nu}\) is the Nusselt number,
- \(\text{Re}\) is the Reynolds number, and
- \(\text{Pr}\) is the Prandtl number.

The constants \(C_1, C_2, C_3\) and \(C_4\) are specified through a real constant set.

**Special Features**

(None)

**Element Group Options**

**Op. 1:** Type of calculations (elements)
- = 0; calculate hydraulic solution: 2-node element (default)
- = 1; calculate thermal and hydraulic solutions: 4-node element

**Op. 2 to Op. 8:** Unused options for this element

**Real Constants**

- \(r_1\) = Diameter of the pipe
- \(r_2\) = Friction factor
- \(r_3\) = Value of \(C_1\) in the heat transfer correlation
Chapter 4   Element Library

Chapter 4   Element Library

r4 = Value of C2 in the heat transfer correlation
r5 = Value of C3 in the heat transfer correlation
r6 = Value of C4 in the heat transfer correlation

Material Properties
KX = Thermal conductivity of the fluid
DENS = Density of the fluid
C = Specific heat of the fluid
VISC = Dynamic viscosity of the fluid

Element Loadings
(None)

Output Results
Pressure and temperature values are printed at each nodal point.

Figure 4-96. Pipe Flow Element

Reference
Fluid Flow 2D 4-Node Isoparametric Element (FLOW2D)

General Description
FLOW2D is a 4-node quadrilateral element. It can be used to model both two dimensional and axisymmetric fluid flow problems. All the elements must be defined in the X-Y plane as shown in Figure 4-97. Axisymmetric models have to be defined in the positive X half-plane in which X represents the radial direction and Y refers to the axis of symmetry.

Each node has three (3) degrees of freedom: u and v (which are the components of velocity in X and Y directions) in addition to the temperature. For the nodal input pattern both clockwise and counter-clockwise numbering are allowed.

Special Features
(None)

Element Group Options
Op. 1:
  = 0; PLANE2D element (default option)
  = 1; axisymmetric element
Op. 2 to Op. 8: Unused for this element

Real Constants
(None)

Material Properties
VISC = Dynamic viscosity of the fluid
DENS = Density of the fluid
KX = Thermal conductivity of the fluid
C = Specific heat of the fluid
BETA = Coefficient of volumetric expansion
M, N = Parameters in the power law model for non Newtonian fluids (to be specified through the Flow Model command)
For compressible fluid flow analysis, only the following material properties are to be specified:

\[ C \] Specific heat at constant pressure
\[ \text{GAMMA}= \text{Ratio of specific heat at constant pressure to specific heat at constant volume}\]

**Element Loadings**
- Pressure (applied normal to element faces)
- Thermal convection
- Internal heat generation
- Applied heat flux

**Output Results**
Velocity, pressure and temperature values are printed at each nodal point. The nodal pressure is an average over the elements that are connected to the node.

**Figure 4-97. 4-Node Isoparametric Quadrilateral Element**

**Reference**
Fluid Flow 3D 8-Node Isoparametric Element (FLOW3D)

General Description
FLOW3D is an 8-node element for three-dimensional fluid flow problems. The nodal input pattern for this element is shown in Figure 4-98. Each node has four degrees of freedom: u, v, and w (which are the velocity components in X, Y and Z directions) in addition to the temperature.

Special Features
(None)

Element Group Options
(None)

Real Constants
(None)

Material Properties
- VISC = Dynamic viscosity of the fluid
- DENS = Density of the fluid
- KX = Thermal conductivity of the fluid
- C = Specific heat of the fluid
- BETA = Coefficient of volumetric expansion
- M,N = Parameters in the power law model for non-Newtonian fluids (to be specified through the Flow Model command)

Element Loadings
- Pressure (applied normal to element faces)
- Thermal convection
- Internal heat generation
- Applied heat flux
Output Results

Velocity, pressure and temperature values are printed at each nodal point. The nodal pressure is calculated by averaging the pressure values at the same node from different elements.

Figure 4-98. 3D Fluid Flow Element

Reference

John Wiley & Sons, 1982
Magnetic 2D 4-Node Element (MAG2D)

General Description
MAG2D is a 4-node quadrilateral element. It can be used to model both two
dimensional and axisymmetric electromagnetic analysis. All the elements must be
defined in the X-Y plane as shown in Figure 4-99. Axisymmetric models have to be
defined in the positive X half-plane in which X represents the radial direction and Y
refers to the axis of symmetry.

Each node has one (1) degree of freedom representing the magnetic potential. The
element node numbering is shown in Figure 4-99. For this element, a 2 x 2 Gauss
point integration scheme is used. In case of a collapsed-to-triangle element, a one(1)-
point integration is performed.

Special Features
(Not available)

Element Group Options

Op. 1:
= 0; for PLANE2D analysis (default)
= 1; for axisymmetric analysis

Op. 2:
= 0; virtual displacement is fixed and set to zero (default)
= 1; virtual displacement is movable and set to 1

Op. 3 to Op. 8: Unused options for this element

Real Constants
(Not available)

Material Properties
MPERM = Magnetic permeability
ECONX = Electric conductivity in X-direction
ECONY = Electric conductivity in Y-direction
PMAGX = Coercivity of permanent magnets in X-direction
PMAGY = Coercivity of permanent magnets in Y-direction
PMAGZ = Coercivity of permanent magnets in Z-direction
PMAGR = Coercivity of permanent magnets in the radial direction (R) of a global cylindrical coordinate system
PMAGT = Coercivity of permanent magnets in the circumferential direction (θ) of a global cylindrical coordinate system

where
R and θ are defined with respect to the global Cartesian coordinate system.

Element Loadings
- Current density
- Electric charge density

Output Results
Magnetic flux densities, magnetic field intensities, magnetic forces, electric field intensity, magnetic current density and potential voltage are given at each node. Magnetic flux densities, magnetic field intensities, electric field intensities, current density and power losses are available for each element.

References
Magnetic 3D 8-Node Element (MAG3D)

General Description
MAG3D is an 8-node element for three-dimensional electromagnetic analysis. Magnetic potential is the only degree of freedom considered at each node. The element node numbering is shown in Figure 4-100. For this element a 2 x 2 x 2 Gauss point integration scheme is used.

Special Features
(Not available)

Element Group Options
Op. 1:
  = 0; virtual displacement is fixed and set to zero (default)
  = 1; virtual displacement is movable and set to 1
Op. 2: Unused option for this element
Op. 3: Corresponding current source number
Op. 4 to Op. 8: Unused options for this element

Real Constants
(Not available)

Material Properties
MPERM = Magnetic permeability
ECONX = Electric conductivity in X-direction
ECONY = Electric conductivity in Y-direction
ECONZ = Electric conductivity in Z-direction
PMAGX = Coercivity of permanent magnets in X direction
PMAGY = Coercivity of permanent magnets in Y direction
PMAGZ = Coercivity of permanent magnets in Z direction
PMAGR = Coercivity of permanent magnets in the radial direction (R) of a global cylindrical coordinate system
PMAGT = Coercivity of permanent magnets in the circumferential direction (θ) of a global cylindrical coordinate system
where:

θ and R are defined with respect to the global Cartesian coordinate system

Element Loadings

- Electric charge density

Output Results

Magnet flux densities, magnetic field intensities, magnetic forces, electric field intensity, magnetic current density and potential voltage are given at each node. Magnetic flux densities, magnetic field intensities, electric field intensities, current density and power losses are available for each element.

Figure 4-100. 3D Magnetic Element

References

Magnetic 3D 4- or 10-Node Tetrahedron Solid Element (TETRA4 or TETRA10)

General Description
TETRA4 or TETRA10 is a 4- or 10-node three dimensional solid element of the analysis of electromagnetic problems. Magnetic potential is the only degree of freedom considered at each node. The element node numbering is shown in Figure 4-101 or the 4-node element and Figure 4-102 for the 10-node element. Both clockwise and counter-clockwise numbering are allowed.

Special Features
(None)

Element Group Options

Op. 1:
- 0; virtual displacement is fixed and set to zero (default)
- 1; virtual displacement is movable and set to 1

Op. 2: Unrelated option to this type of analysis (use default value)

Op. 3: Corresponding current source number

Op. 4 to Op. 8: Unrelated option to this type of analysis (use default values)

Real Constants
(None)

Material Properties

MPERM = Magnetic permeability
ECONX = Electric conductivity in X-direction
ECONY = Electric conductivity in Y-direction
ECONZ = Electric conductivity in Z-direction

PMAGX = Coercivity of permanent magnets in X-direction
PMAGY = Coercivity of permanent magnets in Y-direction
PMAGZ = Coercivity of permanent magnets in Z-direction
PMAGR = Coercivity of permanent magnets in the radial direction (R) of a global cylindrical coordinate system
PMAGT = Coercivity of permanent magnets in the circumferential direction (θ) of a global cylindrical coordinate system

where:
θ and R are defined with respect to the global Cartesian coordinate system

Element Loadings
• Electric charge density

Output Results
Magnetic flux densities, magnetic field intensities, magnetic forces, electric field intensity, magnetic current density and potential voltage are given at each node. Magnetic flux densities, magnetic field intensities, electric field intensities, current density and power losses are available for each element.
References

Introduction

This chapter presents examples for the creation and meshing of geometric entities in GEOSTAR. Most of these examples are introduced in complete detail, with step-by-step procedures and illustrations. The examples are not intended to cover all the features of GEOSTAR, but rather to explain a selected subset of them. It is hoped that these examples will help you understand and confidently apply the individual commands in the Geometry, Meshing menus and part of the Propsets menus. These examples include.

List of Modeling Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>See page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyway Model.</td>
<td>5-3</td>
</tr>
<tr>
<td>Model of a Lever.</td>
<td>35</td>
</tr>
<tr>
<td>Example on Region Meshing.</td>
<td>10</td>
</tr>
<tr>
<td>Surface Intersection Model.</td>
<td>38</td>
</tr>
<tr>
<td>Sprocket Model.</td>
<td>13</td>
</tr>
<tr>
<td>Example on Dragging Meshed Regions to Generate 3D Mesh.</td>
<td>46</td>
</tr>
<tr>
<td>Turbine Casing Model.</td>
<td>15</td>
</tr>
<tr>
<td>A Wheel Section: 3D Automatic Meshing Example.</td>
<td>49</td>
</tr>
<tr>
<td>Model of a Helicoid.</td>
<td>19</td>
</tr>
<tr>
<td>3D Automatic Meshing for a Widget with Openings.</td>
<td>58</td>
</tr>
</tbody>
</table>
Moreover, input files for many verification problems are provided. The session files for these problems are located in the vprobs folder in the COSMOS/M directory. The verification problems for each type of analysis are provided in a separate folder. The prefix in the file name indicates the its type. For GEOSTAR modeling examples a prefix G is used. In order to use these examples, move to your work directory and copy any file (for example, G12.GEO) from the PROBLEMS directory created as explained above. At the system level, type GEOSTAR (or double click on the “GOESTAR” icon on Windows platforms), and furnish a problem name. When the GEO Panel appears, issue the File > Load command, and type in the input file name as G12.GEO. Accept the default parameters.

You will notice that the finite element model will be simultaneously constructed and displayed on the screen as the input file is read into GEOSTAR. You may need to scale and/or adjust the view of the model in the display area.

**List of Modeling Examples (Concluded)**

| Model of a Pipe and Curved Surface Connection. See page 22 | Crank Shaft Connector Using 3D Automatic Meshing. See page 74 |
| Model of an Open Pipe with Flange. See page 25 | Welded Angle Connection: 3D Automatic Meshing. See page 98 |
| Model of a Tank with Stiffeners. See page 29 | Example on Selection Lists, Coloring, Property Changing. See page 118 |
| Pipe Intersection Model. See page 32 | Example on Using Parametric Variables. See page 132 |

Moreover, input files for many verification problems are provided. The session files for these problems are located in the vprobs folder in the COSMOS/M directory. The verification problems for each type of analysis are provided in a separate folder. The prefix in the file name indicates the its type. For GEOSTAR modeling examples a prefix G is used. In order to use these examples, move to your work directory and copy any file (for example, G12.GEO) from the PROBLEMS directory created as explained above. At the system level, type GEOSTAR (or double click on the “GOESTAR” icon on Windows platforms), and furnish a problem name. When the GEO Panel appears, issue the File > Load command, and type in the input file name as G12.GEO. Accept the default parameters.

You will notice that the finite element model will be simultaneously constructed and displayed on the screen as the input file is read into GEOSTAR. You may need to scale and/or adjust the view of the model in the display area.
Chapter 5  Modeling Examples

Keyway Model

Figure 5-1 shows the geometry of the model to be constructed and meshed in GEOSTAR. The outer boundary of the model is made of straight lines and an elliptical curve. The inner keyway comprises of only straight lines. In the following description you will find that the straight boundaries are constructed using just one command, followed by another one to construct a quarter of an ellipse.

Figure 5-1. Model Geometry

From the system level, type GEOSTAR (or double click on the “GEOSTAR” icon on Windows platforms)

Name for the problem: keyway
Click on ok to conclude the dialog box

When you enter keyway as a name for the problem, all files related to this problem will have this name and some extensions determined by the type of information they contain. It takes GEOSTAR few seconds to set up the data base files.

Clear the Display Window by clicking on the Clear button in the Control Panel. Then adjust the view inside the Display Window.

Geo Panel:  View
Click on the XY-view button
Close the View
Chapter 5  Modeling Examples

GEOSTAR requires you to set up a grid if you want to snap keypoints with the mouse. To display the grid, the plane where the grid is to be displayed should be set. A plane is defined by its normal (the Z-axis in this case).

Geo Panel:  Geometry > GRID > Plane
Click on accept to accept all default options

Geo Panel:  Geometry > GRID > Grid On
Click on accept

GEOSTAR will now define a grid starting from the origin of the axes, with 20 divisions on each axis representing 5 units each. This will allow for maximum coordinate values of 100 for both X and Y on the grid. The dimensions of the grid can be specified as desired.

Figure 5-2. Default Grid Setting

Click on the STATUS1 button, a table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (keypoints “PT”, curves “CR”, contours “CT”, regions “RG” etc.), their colors, labels, label colors and other options are shown. The table allows the user to toggle the flags to ON/OF and select the color of the various entities. We will change the label status of points, curves, contours and regions from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on ON/OFF label flags for PT, CR, CT and RG. Click the left button of the mouse to switch from OFF to ON. After making these changes, save them by clicking on SAVE.
Chapter 5  Modeling Examples

Now, you need to create a keypoint at the center of the elliptic curve. You can enter the coordinates of the point by typing from the keyboards or by snapping.

**Geo Panel:**  Geometry > POINTS > Define
Keypoint number: 1
Keypoint coordinates (or snap it from the grid): (10, 90, 0)
As you move the mouse, you will notice a point snapping to the nearest grid on the grid plane. The coordinates of the point will appear in a dialog box. You can move the mouse until you see the coordinates (10, 90, 0) and then click the left button once to confirm its placement.

Accept the entries

To construct the straight sides of the model, we can create a polyline by snapping keypoints from the grid. As you move from the first point, a line will rubber-band till you establish the next point.

**Geo Panel:**  Geometry > CURVES > Draw Polyline
Curve number: 1
Coordinates of keypoint 1: (45,90,0)
Coordinates of keypoint 2: (90,90,0)
Coordinates of keypoint 3: (90,15,0)
Coordinates of keypoint 4: (10,15,0)
Coordinates of keypoint 5: (10,35,0)
Coordinates of keypoint 6: (10,35,0)
Accept the entries

It should be noted that in order to terminate the polyline definition the last keypoint (point 6) located at (10, 35, 0) has to be entered twice. Five new keypoints (2 through 6) and four straight curves (1 through 4) will be created. The labels of the keypoints and the curves will be displayed on the screen.

Next, we create the elliptic part. Keypoint 1 will be the center of the ellipse. Keypoints 6 and 2 will be used to define the ends of the major and minor axes respectively. Since a quarter of an ellipse is used to build the model geometry, the number of quadrants should be specified as 1. Once you terminate the command, an elliptical curve will be constructed between keypoints 6 and 2 with label 5.

**Geo Panel:**  Geometry > CURVES > Ellipse
Curve number: 5
Keypoint at the end of major axis: 6
Keypoint at the end of minor axis: 2
Keypoint at center: 1
Number of quadrants: 1
Accept the entries
Chapter 5  Modeling Examples

With the outer boundary of the model being completed, you can next proceed to the inner boundary. Since all sides of the keyway are straight, it can be constructed as a polyline.

**Geo Panel:** Geometry > CURVES > Draw Polyline
- Curve number: 6
- Coordinates of keypoint 1: (60,55,0)
- Coordinates of keypoint 2: (70,45,0)
- Coordinates of keypoint 3: (70,30,0)
- Coordinates of keypoint 4: (50,30,0)
- Coordinates of keypoint 5: (50,45,0)
- Coordinates of keypoint 6: (60,55,0)
- Coordinates of keypoint 6: (60,55,0)
- Accept the entries

As before, the last point should be entered twice. There will be five new keypoints (7 through 11) and five curves (6 through 10). Figure 5-3 shows the geometry of the model and the labels of the points and curves.

**Figure 5-3. Geometry Plot (Points and Curves) with Grid Not Shown**

To mesh the model geometry, the automatic mesh generation capability of COSMOS/M will be used. In order to use automatic mesh generation, you need to define the region which is going to be filled with finite elements. A region in general is made up of an outer contour and may also have inner contours. Therefore, in order to define the region, you need first to define the outer and inner contours which define the connectivity for this problem.
Chapter 5  Modeling Examples

The average element size or the number of elements (mesh density) is specified during the process of contour definition. However, the mesh density can be later modified during meshing if necessary. It should be noted that if a contour is made up of more than one curve, you don’t have to select all of them to uniquely define a contour. For this problem, one curve is sufficient to describe the outer contour, and that curve is known as the reference curve. Any one of the outer curves can be selected. Curve 4 is arbitrarily selected as the reference curve for the outer contour.

**Geo Panel:** Geometry > CONTOURS > Define
- Contour number: 1
- Select mesh flag: element size, then continue
- Average element size: 6
- Number of reference boundary curves: 1
- Continue
- First boundary curve: 4
- Accept the entries

You will notice that a contour with label 1 is displayed on the screen. The inner contour of the keyway will be defined in a similar way, with the same element size average. Curve 9 is chosen as the reference curve.

**Geo Panel:** Geometry > CONTOURS > Define
- Contour number: 2
- Select mesh flag: element size, then continue
- Average element size: 6
- Enter number of reference boundary curves: 1
- Continue
- First boundary curve: 9
- Accept the entries

Next, you can define the region bounded by contours 1 and 2. When defining regions, the outer contour must be selected first, then the inner one(s) if any.

**Geo Panel:** Geometry > REGIONS > Define
- Region number: 1
- Number of contours to define the region: 2
- Continue
- Outer contour: 1
- Inner contour 1: 2
- Underlying surface: 0
- Accept the entries
Click the Clear button to clear the display window. Then list and plot the contours and the region.

**Geo Panel:**  Edit > List > **Contour**  
Beginning region: 1  
Ending region: 2  
Increment: 1  
Accept the entries

**Geo Panel:**  Edit > List > **Region**  
Beginning region: 1  
Ending region: 1  
Increment: 1  
Accept the entries

**Geo Panel:**  Edit > Plot > **Contour**  
Beginning region: 1  
Ending region: 2  
Increment: 1  
Accept the entries

**Geo Panel:**  Edit > Plot > **Region**  
Beginning region: 1  
Ending region: 1  
Increment: 1  
Accept the entries

**Figure 5-4. Contour and Region Plot with Grid Not Shown**
Chapter 5  Modeling Examples

To automatically generate the finite element mesh in the region defined above, you can use the automatic meshing capability of GEOSTAR. When executing the meshing command you can always select the intended region by moving the mouse pointer to the region and click the left button once. The region will be highlighted.

*Geo Panel:*  Meshing > AUTO MESH > Regions
Beginning region number: 1
Ending region number: 1
Increment: 1
Number of smoothening iterations: 0
Meshing method: **Sweeping**
Accept the entries

The region will be automatically meshed with triangular elements as shown in Figure 5-5. You can change the elements to quadrilaterals (Meshing > AUTO MESH > Region Mesh Type).

**Figure 5-5. Finite Element Mesh with Grid Not Shown**

After the finite element mesh is generated, you can proceed to other stages of finite element analysis such as defining the material properties, boundary conditions, etc.

You may completely exit from GEOSTAR by clicking on the **EXIT** (File > Exit) button or you can start a new problem by clicking on the **NEWPROB** (File > New) button.
Chapter 5   Modeling Examples

**Example on Region Meshing**

This example illustrates the creation and meshing of regions using a rectangular plate with four openings. The following commands define the geometry of the model in the X-Y plane. These commands should be typed after the GEO > prompt in the console window. Read the on-line help (type “help” followed by the command name in the console window) to find out how to issue these commands by using the control panel.

- **PLANE.Z,0,1,**
  - Choose the X-Y plane
- **VIEW,0,0,1,0,**
  - Set the screen view to the X-Y plane

Type **STATUS1** or click on the **STATUS1** button. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, contours “CT”, regions “RG”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves, contours and regions from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for **PT**, **CR**, **CT** and **RG**. Press either button of the mouse to switch from OFF to ON. After making the four changes, save them by moving the mouse cursor to **SAVE** and click any of its buttons.

- **CRPCORD,1,0,0,0,100,0,100,0,100,0,0,0,**
  - Create sides of the plate
- **CRPCORD,5,50,85,0,35,45,0,65,45,0,50,85,**
  - Create the triangular openings
- **PT,8,80,80,0,**
  - Define center of the right circular opening
- **PT,9,20,80,0,**
  - Define center of the left circular opening
Chapter 5   Modeling Examples

CRPCIRCLE,8,8,5,10,360,4,
   Generate the right circle

CRPCIRCLE,12,9,5,10,360,4,
   Generate the left circle

PT,18,95,45,0,
   Define keypoint 18 at X=95, Y=45 and Z=0

PT,19,5,45,0,
PT,20,50,45,0,
PT,21,50,35,0,
PT,22,50,25,0,
CRELLIPSE,16,19,21,20,2,
   Generate half an ellipse with points 19 and 21 at the end of major and minor axes. The center is at point 20

PT,23,50,10,0,
CRELLIPSE,18,19,23,20,2,
   Generate half an ellipse with points 19 and 23 at the end of major and minor axes. The center is located at point 20

CRBLEND,16,18,0.5,1,0
   Blend curves 16 and 18

CRBLEND,17,19,0.5,1,0
   Blend curves 17 and 19

Before defining a region, we must define all the contours to be used in its definition. The outer edges of the plate are used to define contour 1, while the edges of the four openings are used to define contours 2, 3, 4 and 5. An average element size (5.0) is used for contour 5, and an average element size (4.0) is used for the rest of the contours. It should be noted that instead of specifying the average element size, the number of elements on each contour could have been specified. A more explicit definition is to use the CTNU command which enables the user to specify the number of elements on each curve associated with the contour. Note that one curve is sufficient to uniquely define each contour.

CT,1,0,4,1,1,0,
   Define the first contour with element size (4.0)
Define contour 5 with element size (5.0)

Create region 1 with contour 1 as the outer contour and contours 2 through 5 as inner contours. Note that it is allowed to use contours for which an average element size is used and contours for which an approximate number of elements is used, in the definition of the same region. The created region is meshed, and two iterations are used to refine the mesh.

Create a region with 5 contours

Automesh the region

The created finite element mesh is shown in Figure 5-6. The MARGCH command can be used to change the mesh to quad elements.
**Sprocket Model**

**Figure 5-7. Finite Element Mesh of Sprocket with Five Holes**

The command list for the Sprocket model is given below for command driven modeling. Type each line after the GEO > prompt in the console window exactly as shown, followed by pressing the ENTER key. Read on-line Help for each command to find out how to issue it using the Control Panel.

VIEW;
   Set the screen view to the X-Y plane

PLANE;
   Choose the X-Y plane

PT,1,0,0,0
   Define the center of outer circle

PT,2,0,30,0
   Define a point on the zero degree plane of the circular boundary

CRPCIRCLE,1,1,2,60,360,4
   Generate the outer circle with a 60 unit radius
Chapter 5  Modeling Examples

SCALE;
   Fit the model in the screen
CRPCIRCLE,5,2,1,10,360,4
   Generate one of the interior holes
CRGEN,4,5,8,1,1,0,0,72
   Create four more circles
CT,1,0,10,1,4,0
   Establish the outer contour with element size (10)
CT,2,1,12,1,5,0
   Generate the first interior contour with element number (12)
CT,3,1,12,1,9,0
CT,4,1,12,1,13,0
CT,5,1,12,1,17,0
CT,6,1,12,1,21,0
RG,1,6,1,2,3,4,5,6,0
   Define a region using 6 contours
MA_RG,1,1,1,0,0
   Mesh the region using the automatic feature
CLS,1,
   Clear the screen
EPLOT;
   Plot all the elements

You may exit completely from GEOSTAR by selecting the command EXIT from the File menu. Alternately, you can issue the command NEWPROB (File > New) and specify a problem name to start the next example problem.
Chapter 5  Modeling Examples

*Turbine Casing Model*

Type the commands after the GEO > prompt in the console window exactly as shown to create the model. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key. Read the on-line help for each command to find out how to issue it using the Control Panel (type “help” followed by the command name in the console window).

**Figure 5-8. Model of a Turbine Casing**

```
VIEW;
   Set the screen view to refer to the X-Y plane

CLS;
   Clear the screen

AXIS;
   Display the X-Y coordinate system

PLANE;
   Set the X-Y plane

GRIDON;
   Turn on the grid so that you can pick keypoints with the mouse
```
Type **STATUS1**. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to **SAVE** and click any of its buttons.

PT, 1, 15, 85, 0,
*Define keypoint 1 at X=15, Y=85, Z=0*

PT, 2, 15, 50, 0,
PT, 3, 30, 50, 0,
PT, 4, 30, 15, 0,
PT, 5, 65, 15, 0,
PT, 6, 65, 50, 0,
CRLINE, 1, 1, 2,
*Define line 1 between keypoints 1 and 2*

CRLINE, 2, 2, 3,
CRLINE, 3, 3, 4,
CRLINE, 4, 4, 5,
CRLINE, 5, 3, 6,
CRLINE, 6, 6, 5,
VIEW, 1, 1, 1;
*Set isometric view*

PT, 7, 80, 15, 0,
PT, 8, 80, 15, 15,
Chapter 5  Modeling Examples

CRARC,7,5,8,7,15,
   Define a circular arc between keypoints 5 and 8, with center of curvature toward keypoint 7 and a radius of (15)

SFEXTR,7,7,1,Y,35,
   Generate a surface by extruding curve 7 by (35) units in Y-direction

SF2CR,2,4,5,0,
   Define a surface between boundary curves 4 and 5. A plot of the basic curves is shown in Figure 5-9

SCALE;
   Scale the screen

CLS;

SFPLT,1,2,1;
   Plot surfaces 1 and 2

SFGN,5,1,2,1,0,60,0,
   Generate (5 times) surfaces similar to 1 and 2 by a rotation angle of 60 degrees about the Y-axis

SCALE;

AXIS

CLS;

CRPLT,1,3,1,
   Plot curves 1 and 3

SFSPWEP,1,3,1,Y,360,6,
   Generate surfaces by sweeping curves 1, 2 and 3 about the Y-axis 360 degrees with 6 segments

CLS;

AXIS;

CRPLT,4,6,2,

SFSPWEP,4,6,2,Y,360,6
   Generate surfaces by sweeping curves 4 and 6

CLS;
Chapter 5  Modeling Examples

SFLOT;
  Plot all surfaces

M_SF,1,21,1,4,4,4;
  Mesh surfaces 1 to 21 with 4-node elements considering 4 elements along each major side of these surfaces

NMERGE;
  Merge nodes on common boundaries

NCOMPRESS;
  Remove node numbering gaps

M_SF,22,42,1,4,4,4;
  Mesh surfaces 22 to 42

NMERGE;

NCOMPRESS;

HIDDEN,1,
  Turn the hidden line option on

CLS;

EPLLOT;
  Plot all elements

Figure 5-9. Basic Curves
Chapter 5  Modeling Examples

Model of a Helicoid

Type the commands at the GEO > prompt in the console window as shown below to create the model. Read the on-line help for each command to find out how to issue it using the Control Panel. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After you type a command line, hit ENTER.

Figure 5-10. Model of a Helicoid

```
VIEW,1,1,1,0,
Set isometric view
```

Type STATUS1. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons.
Chapter 5  Modeling Examples

PT,1,20,0,20,
   Define keypoint 1 at X=20, Y=0 and Z=20
PT,2,50,0,20,
PT,3,0,20,30,
PT,4,0,50,30,
PT,5,0,0,25,
CRARC,1,1,3,5;
   Define a circular arc between keypoint 1 and 3 with center of curvature
toward keypoint 5
CRARC,2,2,4,5;
SFEXTR,1,1,1,Z,40,
   Generate a surface by extruding curve 1 (40 units) in the Z direction
SF2CR,2,1,2,0,
   Define a surface between two boundary curves 1 and 2 (surfaces 1
   and 2 are shown in Figure 5-11)
SFGEN,15,1,2,1,2,,,10,,,90,
   Generate surfaces by a translation of (0,0,10) in X, Y and Z and a rota-
tion of (0,0,90) about X, Y and Z, of surfaces 1 and 2
SCALE;
   Scale the screen
CLS;
SFPLT;
   Plot all surfaces
M_SF,1,32,1,4,4,2,1,1,0,
   Mesh surfaces 1 to 32 with 4-node elements considering 4 elements
   along one major side of the surface and 2 elements along the other
   major side of the surface
CLS;
   Clear the screen
Chapter 5  Modeling Examples

HIDDEN;
   Turn the hidden line option on

EPLLOT;
   Plot all elements

Figure 5-11. Base Model
Chapter 5  Modeling Examples

Model of a Pipe and Curved Surface Connection

Type the commands after the GEO > prompt in the console window as shown below to create the model. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After you type a command line, hit ENTER. Read the on-line help for each command to find out how to use it using the Control Panel.

Figure 5-12. Model of a Pipe and Curved Surface

VIEW;

Set the screen to view the X-Y plane

Type STATUS1. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons.
Chapter 5  Modeling Examples

PT,1,15,80,0,
    Define keypoint 1 at X=15, Y=80 and Z=0
PT,2,15,20,0,
PT,3,85,80,0,
PT,4,85,15,0,
PT,5,50,45,0,
CRCONIC,1,2,4,5,0.3,
    Define an elliptic curve between keypoints
CRCONIC,2,3,1,5,0.4,2 and 4
CRARC,3,4,3,5;
    Define a circular curve between keypoints 4 and 3 with center of curvature toward keypoint 5
CRARC,4,1,2,5;
VIEW,1,1,1;
SCALE;
    Scale to the screen size
PT,6,50,45,40,
PLANE,Z,40;
    Set a plane X-Y at Z=40
VIEW,1,1,1;
CRPCIRCLE,5,6,2,10,360,4,
    Define a circle with center at keypoint 6 and radius (10) in a plane parallel to X-Y at Z=40
SF2CR,1,1,5,0,
    Define a surface between two boundary curves
SF2CR,2,3,6,0,1 and 5 (A curve plot is given in Figure 5-13)
SF2CR,3,2,7,0,
SF2CR,4,4,8,0,
CLS;
SFPLOT;
    Plot all surfaces
CRPLOT,5,8,1,

*Plot curves 5 to 8*

AXIS;

SFEXTR,5,8,1,Z,30,

*Generate 4 surfaces by extruding curves (5 to 8) 30 units in the Z direction*

CLS;

SFPLT;

M_SF,1,8,1,4,6,6,1,1,0,

*Mesh surfaces 1 to 8 with 4-node elements considering 6 elements along each major side of these surfaces*

CLS;

*Clear the screen*

HIDDEN;

*Turn the hidden line option on*

EPLT;

*Plot all elements*

ROTATE,0,30,0;

*Rotate the picture by 30 degrees about the Y-axis (see Figure 5-12)*

**Figure 5-13. Curve Plot**
Type the commands after the GEO > prompt in the console window as shown below to create the model. You are encouraged however to use the commands interactively to learn more about the different options. Read the on-line help to find out how to issue commands by using the Control Panel. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After you type a command line, hit ENTER.

---

**Model of an Open Pipe with Flange**

Type the commands after the GEO > prompt in the console window as shown below to create the model. You are encouraged however to use the commands interactively to learn more about the different options. Read the on-line help to find out how to issue commands by using the Control Panel. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After you type a command line, hit ENTER.

---

**Figure 5-14. Model of an Open Pipe with Flange**

![Model of an Open Pipe with Flange](image)

**VIEW;**

*Set the screen to view the X-Y plane*

Type **STATUS1**. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, volumes “VL”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves, surfaces and volumes from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for **PT, CR, SF** and **VL**. Press either button of the mouse...
to switch from OFF to ON. After making the four changes, save them by moving the mouse cursor to **SAVE** and click any of its buttons.

```
PT,1,15,90,0,
  Define keypoint 1 at X=15, Y=90 and Z=0
PT,2,15,40,0,
PT,3,15,30,0,
PT,4,30,90,0,
PT,5,30,40,0,
PT,6,30,30,0,
PT,7,30,20,0,
PT,8,50,35,0,
PT,9,50,15,0,
PT,10,50,25,0,
CRLINE,1,1,4,
  Define a line between keypoints 1 and 4
CRLINE,2,2,5,
CRLINE,3,3,6,
CRLINE,4,5,8,
CRLINE,5,7,9,
CRLINE,6,6,10,
SF2CR,1,1,2,0,
SF2CR,2,2,3,0,
SF2CR,4,6,5,0,
  Define a surface between two boundary curves 1 and 2 (The generated surfaces
SF2CR,3,4,6,0,
  (1 to 4) to are shown in Figure 5-15)
CLS;
  Clear the screen
VIEW,1,1,1,0;
SFPL0T,1,4,
VLSWEEP,1,4,1,Y,180,2;
  Generate volumes by sweeping surfaces 1 to 4 about the Y axis by 180
  degrees (2 segments)
```
Chapter 5   Modeling Examples

CLS;

VLPLOT;

\textit{Plot all volumes}

SCALE;

\textit{Scale to the screen size}

\texttt{M\_VL,1,2,1,8,3,6,3,1,1,1,}

Mesh volumes 1 and 2 with 8-node solid elements. The three major sides of each volume are divided into 3, 6 and 3 segments respectively

\texttt{M\_VL,3,8,1,8,3,3,3,1,1,1,}

Mesh volumes 3 to 8 with 8-node solid elements. All sides are divided into 3 segments each

CLS;

HIDDEN;

\textit{Turn the hidden line option on}

EPLOT;

\textit{Plot all elements}

\texttt{ROTATE,0,45,0,0;}

\textit{Rotate the picture about the Y-axis by 45 degrees (see Figure 5-14)}

\textbf{Figure 5-15. Plot of Profile Surfaces}
Type the commands after the GEO > prompt in the console window exactly as shown to create the model. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After you type a command line, hit ENTER. Read the on-line help to find out how to issue commands by using the Control Panel.

**Figure 5-16. Model of a Tank with Stiffeners**

Type STATUS1. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, volumes “VL”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves, surfaces and volumes from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR, SF and VL. Press either button of the mouse to switch from OFF to ON. After making the four changes, save them by moving the mouse cursor to SAVE and click any of its buttons.
PT,1,40,75,0,
    Define keypoint 1 at X=40, Y=75 and Z=0
PT,2,40,25,0,
PT,3,75,25,0,
PT,4,60,75,0,
PT,5,95,25,0,
PT,6,55,50,0,
CRCONIC,1,4,3,6,0.6,
    Define a hyperbola between keypoints 4 and 3
CRLINE,2,1,2,
    Define a line between keypoints 1 and 2
CRLINE,3,3,5,
SF2CR,1,2,1,0,
    Define a surface between two boundary curves 2 and 1
VLSWEEP,1,1,1,Y,24,1,
    Define a volume by sweeping surface 1 about the Y axis by 24 degrees
    (1 segment)
SFSWEEP,3,3,1,Y,24,1,
    Generate a surface by sweeping curve 3 about the Y axis by 24 degrees
    (1 segment)
SFSWEEP,2,3,1,Y,-48,1,
SF2CR,10,18,20,0,
    Define a surface between two boundary curves 18 and 20
SFGEN,4,7,10,1,1,0,72,0,
    Generate (4 times) surfaces similar to surfaces (7 to 10) a rotation of
    (0,72,0) about X, Y and Z (A plot of one fifth of the model is given in
    Figure 5-17)
CLS;
VLPlot;
    Plot volume 1
VLGEN,4,1,1,1,1,0,72,0,
    Generate (4 times) volumes similar to volume 1 by a rotation of
    (0,72,0) about X, Y and Z
SCALE;
   Scale the screen

M_VL,1,5,1,8,4,2,2,1,1,1,
   Mesh volumes 1 to 5 with 8-node solid elements. The three major
   sides of each volume are divided to 4, 2 and 2 segments respectively

M_SF,7,23,4,4,2,1,1,
M_SF,9,25,4,4,2,3,1,1,
M_SF,8,24,4,4,4,3,1,1,
   Mesh surfaces 7, 11, 15, 19 and 23 with 4 node elements considering
   2 elements along each major side of these surfaces

M_SF,10,26,4,4,3,2,1,1,

CLS;
   Clear the screen

ROTATE,0,-20;
   Rotate the model by -20 degrees about the Y axis

HIDDEN;
   Turn the hidden line option on

EPLOT;
   Plot all elements

Figure 5-17. Plot of One Fifth of the Model
Chapter 5   Modeling Examples

Pipe Intersection Model

Type the commands after the GEO > prompt as shown below to create the model. Try to use the commands interactively by using the Control Panel as well. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After you type a command line, hit ENTER.

Figure 5-18. Model of an Intersection of Two Pipes

Type STATUS1 or pull down the CONTROL menu, select the UTILITY submenu and then the STATUS1 command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons.
PT,1,0,0,0,
    Define keypoint 1 at the origin of the global coordinate system

PT,2,20,0,0,
PT,3,0,20,0,
PT,4,0,0,50,
PT,5,0,50,0,
CRARC,1,3,2,1,20,
CRARC,2,5,4,1,50,
    Define an arc of radius (20) located between keypoints 3 and 2 with
    keypoint 1 towards its center of curvature

SFEXTR,1,1,1,Z,100,
SFEXTR,2,2,1,X,75,
    Generate a surface by extruding curve 1 by 100 units in the Z-direction
CRINTSS,1,2,2,1,0.001,
    Generate a curve at the intersection of surfaces 1 and 2
CRBRK,9,9,1,2,0,
    Break curve 9 into two segments

CLS;
SFPLTO,2,2,1,
PTPLOT,8,12,4,
CRONSF,12,8,2,0.001,0,
    Define a curve connected by keypoints 12 and 8 and located on sur-
    face 2

CRPLOT;
CRLINE,12,11,9,
    Define a line between keypoints 11 and 9
CRARC,13,5,10,1,50,
CLS;
CRPLOT,7,13,2,
    Plot curves 7, 9, 11 and 13
SF4CR,3,13,9,11,7,0,
    Define a surface bounded by the curves 13,9,11 and 7
Chapter 5   Modeling Examples

CLS;
CRPLOT
SF4CR,4,12,10,11,6,0,
CRBRK,3,3,1,2,0,
SF2CR,5,9,14,0,
   Define a surface using curves 9 and 14 (See Figure 5-19)
SF2CR,6,10,15,0,
M_SF,3,6,1,4,6,6,1,1,
   Mesh surfaces 3,4,5 and 6 with 4-node elements considering
   6 elements along each major side of these surfaces
VIEW,1,1,1,0,
ACTDMESH,SF,1,
   Activate the default meshing flag
SFSYM,3,6,1,X,1,0,
   Create additional surfaces and their meshes by the symmetric reflec-
   tion of surfaces 3 to 6 about the YZ plane
SFSYM,3,10,1,Y,1,0,
CLS;
SCALE;
CLS;
HIDDEN;
E PLOT;

Figure 5-19. Surface Plot of a Quarter Model
Model of a Lever

Type the commands after the GEO > prompt exactly as shown to create the model. The user is advised to get familiar with the Control Panel input. A semicolon accepts all the default values of the command. A comma is similar to clicking the mouse or hitting the ENTER key to confirm a value. After type a command line, hit ENTER.

**Figure 5-20. Model of a Lever**

- **View:**
  - *Set the screen to view the X-Y plane*

Type `STATUS1` or pull down the CONTROL menu, select the UTILITY submenu and then the `STATUS1` command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF
to ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons.

\begin{verbatim}
PT,1,50,80,0,
   Define keypoint 1 at X=50, Y=80 and Z=0
PT,2,55,80,0,
PT,3,65,80,0,
PLANE;
   Set the X-Y plane at Z=0
CRPCIRCLE,1,1,2,5,45,1,
   Define a 45 degree circular arc with the center at keypoint 1 and radius of 5 starting from keypoint 2 with 1 segment
CRPCIRCLE,2,1,3,15,45,1,
PT,6,50,95,0,
CSYS,3,0,1,3,6,
   Define a Cartesian coordinate system (3) using three keypoints 1, 3 and 6
ACTNUM,CR,0;
   Deactivate curve labeling
ACTDMESH,SF,1,
   Activate the surface default meshing flags
SF2CR,1,1,2,0,0,
   Define a surface between two boundary curves 1 and 2
M_SF,1,1,1,4,2,2,1,1,
   Generate mesh for surface 1
SFGEN,7,1,1,1,1,0,0,45,
   Generate and mesh 7 new surfaces from surface 1 with a rotation of (0, 0, 45) about X, Y and Z
SFSCALE,1,8,1,0,1.5,1.5,1,0,-80,0,
   Generate and mesh 8 new surfaces by scaling the X and Y coordinates of surfaces 1 to 8 by a factor of 1.5 and then translate them 80 units in the Y direction
\end{verbatim}
SCALE;
   Scale to the screen size

PT,34,0,-35,0,
PT,35,80,-80,0,
PT,36,95,-80,0,
PT,37,80,-65,0,
CSYS,4,0,35,37,36,
   Define a local coordinate system (4) using keypoints 35, 37 and 36

ACTSET,CS,0,
   Activate the global Cartesian coordinate system (0)

CRCONIC,51,17,21,34,0.5,
   Define a conical curve between keypoints 21 and 34

CRCONIC,52,13,25,34,0.5,

CRLINE,53,15,23,
   Define a line between keypoints 15 and 23

SF4CR,17,52,19,53,34,0,
   Define a surface between four boundary curves: 52, 20, 53 and 36

SF4CR,18,51,22,53,31,0,

ACTSET,CS,3,
   Activate local coordinate system (3)

SFCOPY,1,8,1,4,
   Copy surfaces 1 to 8 from the active coordinate system (3) to the local
   coordinate system (4)

M_SF,17,18,1,4,6,2,1,1,

SFCOPY,17,18,1,4,

CLS;
   Clear the screen

EPLLOT;
   Plot all elements
Surface Intersection Example

This example uses the intersection of a dome with a cylinder to demonstrate many features like surface intersections, meshing of discontinuous surfaces, generation of a curve on a surface, generation of a surface on an underlying surface, generation of a region on an underlying surface, pushing nodes to the corresponding surface and many other features.

Type “PRB5-11” when GEOSTAR prompts you for a problem name.

Type STATUS1 or pull down the CONTROL menu, select the UTILITY submenu and then the STATUS1 command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons.

Generate a circular arc and sweep it to generate the dome. Surfaces 1 through 4 are generated.

    PT,1,0,0,0,
    PT,2,0,0,-10,
    PT,3,302,0,0,
    CRCIRCLE,1,1,2,3,302,-90,1,
    SCALE;
    SFSWEEP,1,1,1,Y,360,4,
    "90 degree for each segment"
    SCALE;

A 90 degree angle is used for the arc and for each segment in the SFSWEEP command. For better accuracy, you are recommended to use smaller angles (30 to 60 degrees) for sweeping surfaces. A larger angle of 90 degrees has been used here only to illustrate the procedure.
Generate a circle at a Y-coordinate of 500 and extrude its curves in the negative Y-direction to generate a cylinder. Surfaces 5 through 8 are generated.

\[
\begin{align*}
\text{PT,9,0,0,200,} \\
\text{PT,10,0,500,200,} \\
\text{PT,11,0,500,257.5,} \\
\text{CRCIRCLE,11,10,9,11,65,360,4,} \\
\text{SFEXTR,11,14,1,Y,-500,}
\end{align*}
\]

Define the curves resulting from the intersection of the dome and the cylinder, and mesh surfaces 1 and 2 since they are not affected by the intersection. Surfaces 3 and 4 need to be treated separately.

\[
\begin{align*}
\text{CRINTSS,3,5,6,1,0.001,} \\
\text{CRINTSS,4,7,8,1,0.001,} \\
\text{M_SF,1,2,1,4,6,6,1,1,}
\end{align*}
\]

Figure 5-21 shows the curves resulting from the intersection and the mesh of surfaces 1 and 2. In order to do that you can follow the commands:

\[
\begin{align*}
\text{CLS;} \\
\text{EPLT;} \\
\text{CRPLOT,23,26,1,}
\end{align*}
\]

Change the label flag to OFF in \texttt{STATUS1} and then use \texttt{(CRPLOT;)}. After plotting, change the label to ON again.
Define the surfaces of the cylinder above the dome and mesh them.

\[ SF2CR,9,14,26,0, \]
\[ SF2CR,10,13,25,0, \]
\[ SF2CR,11,12,24,0, \]
\[ SF2CR,12,11,23,0, \]
\[ M_SF,9,12,1,4,6,6,1,1 \]

Since the meshing of surfaces with holes is not supported at present, we must divide surfaces 3 and 4 of the dome into continuous surfaces. Figure 5-22 is a top view of the dome to illustrate the discontinuity in surfaces 3 and 4 caused by the intersection. To obtain this view, use the command \((VIEW,0,-1,0;)\), \((SFPLT,1,4;)\), \((CRPLT,23,26;)\), \((PTPLT,3,23,20;)\), \((CRPLT,4,4;)\) and \((SCALE;)\).

The procedure to break surfaces 3 and 4 into continuous surfaces is performed by first generating a curve that lies on surface 4 and connects keypoints 3 and 23:

\[ CRONSF,3,23,4,0.001,0, \]

Then, break curves 4 and 33 as follows:

\[ PTPLT,20,22,2, \]
\[ CRPTBRK,4,20,0, \]
\[ CRPTBRK,33,22,0, \]
Chapter 5  Modeling Examples

Now, we are ready to define two continuous surfaces (13 and 14) from surface 4.

\[
\text{SF4CR,13,10,31,26,32,4,} \\
\text{SF4CR,14,31,1,34,25,4,}
\]

Surface 3 can be treated similarly, but since symmetry exists, the breaking of surface 3 is done by using the \text{SFSYM} command, to generate surfaces 15 and 16 similar to 13 and 14, respectively.

\[
\text{SFSYM,13,14,1,X,1,0,}
\]

Figure 5-23 shows the newly generated surfaces 13 through 16. To obtain this view, type the commands (\text{CLS;}), (\text{VIEW;}) and (\text{SFPLOT,13,16;}).

Figure 5-23. Continuous Surfaces 13 Through 16 Generated from Surfaces 3 and 4

Mesh surfaces 13 through 16, issue the \text{HIDDEN} command and plot all elements.

\[
\text{M_SF,13,16,1,4,6,6,1,1,} \\
\text{HIDDEN;} \\
\text{EPLOT;}
\]

Next, type the command (\text{VIEW,1,1,1;}) and also specify (\text{AXIS,0;}). If you reissue the \text{EPLOT} command, the view shown in Figure 5-24 will be obtained.
Instead of breaking surfaces 4 and 3, you can mesh defined regions associated with these curved surfaces. Let's not interrupt the current problem and open a new one:

NEWPROB, PRB5-11N,

Once GEOSTAR creates the new database, use the SYSTEM command to access the operating system. Copy the session file “PB5-11.SES” to another file “TEMP.SES”. Edit the TEMP.SES file and delete the command used before to mesh surfaces 13 to 16:

M_SF, 13,16,1,4,6,6,1,1,

Save changes, exit the editor and return back to GEOSTAR. When the GEO > prompt appears, issue the FILE command and type in the input filename as TEMP.SES. Accept the default parameters for the remaining prompts. You will notice that the model will be simultaneously constructed and displayed on the screen as the input file is read into GEOSTAR.

Let's display the part of the model that we are interested in:

CLS;
VIEW,0,-1,0;
ACTNUM,SF,1,
ACTNUM,CR,1,
SFPL0T,1,4;
CRPLOT,23,26;
CRPLOT,9,10;
CRPLOT,1,3,2,
CRPLOT,32,34,2,
Chapter 5  Modeling Examples

Define a contour using curves 1, 10, 32, 26, 25 and 34 with an element size of 6 for all curves. In order to have you acquainted with new features, let's use the CTNU command:

$$\text{CTNU,1,6,1,6,10,6,32,6,26,6,25,6,34,6,}$$

Create a region with surface 4 as the underlying surface and then mesh it:

$$\text{RG,1,1,1,4,}$$
$$\text{MA_RG,1,1,1,0,0}$$

You can define another region associated with surface 3 and mesh it similarly. You can use MARGCH to change the triangular elements into quadrilateral ones.

Now let's go back to our old problem.

GEO > NEWPROB
Problem name > PROB5-11
Database already exists
Open as an old Problem [Yes] >

The generated nodes are practically on the surfaces, however there can be a small error. The error may be so small that it can be ignored. Nevertheless, GEOSTAR provides the NSFPUSH command to push nodes to surfaces within a specified tolerance. First, the selection list for nodes is initialized by the INITSEL command. Nodes associated with each surface are selected and pushed to the corresponding surface. The process is repeated for all surfaces. The selection of nodes for surfaces 1 and 2 can be easily done by plotting a top view of all nodes and then using the SELWIN command to select the nodes. Note that the SELWIN command will appear in the session file as equivalent SELINP commands. The selection for surfaces 13 through 16 is easily done through the SELREF command. It is important to plot the selected entities (in this case nodes), to ensure the proper selection. Initializing the selection set (if necessary) is also important.

The following commands (as they appear in a session file) may be used to push nodes to the corresponding surface. Try to implement the SELWIN command as explained above.

$$\text{NMERGE,1,4,9,0,1,0.0001,0,0,1,}$$
$$\text{Merge nodes}$$
$$\text{SCALE,0,}$$
$$\text{Adjust model to window size VIEW,0,1,0; Top view}$$
Chapter 5  Modeling Examples

SELINP,ND,1,56,1;

Use SELWIN command to select nodes of surface 1. The session
file lists equivalent SELINP commands

SELINP,ND,63,98,7;
SELINP,ND,295,344,49;
SELINP,ND,345,350,1;
SELINP,ND,442,442,1;
NPLOT;

Plot selected nodes

NSFPUSH,1,1000,1,1,.01,0,

Push nodes in the selected list to surface 1. Note that the total number
of nodes is less than 1000

INITSEL,ND,1;

Initialize node selection list

SELINP,ND,57,62,1;

Pushing of nodes for surface 2 is similar to that of surface 1

SELINP,ND,64,69,1;
SELINP,ND,71,76,1;
SELINP,ND,78,83,1;
SELINP,ND,85,90,1;
SELINP,ND,92,97,1;
SELINP,ND,399,443,44;
SELINP,ND,444,448,1;
NPLOT;

NSFPUSH,1,1000,1,2,.01,0,
INITSEL,ND,1;

Initialize node selection list

SELREF,ND,SF,9,9,1,

Select nodes generated by meshing of surface 9
NPLOT;

Plot nodes to ensure proper selection

NSFPUSH,1,1000,1,9,.01,0,

Push nodes in the selection list to surface 9
INITSEL,ND,1;

Process surface 10

SELREF,ND,SF,10,10,1,
NPLOT;

Figure 5-25 is the response to this command

NSFPUSH,1,1000,1,10,.01,0,
Surfaces 11 through 16 can be similarly processed. Convergence can be achieved for all nodes using 0.01 tolerance. Notice that multi-selection list is a very nice feature that you should know and practice. See Section 5.17 for more information.

Figure 5-25. Nodes Associated with Surface 9.

To show the advantage of automatic meshing in cases like the one at hand, replace all the \texttt{M\_SF} commands in the input file by the corresponding \texttt{MA\_SF} commands using an element size of 45. Use the modified session file in a new problem. The resulting mesh is shown in Figure 5-26. Note that better mesh is obtained at the top of the dome.

Figure 5-26. Final Finite Element Mesh using Automatic Meshing
This example illustrates the use of the \texttt{PHEXTR} command to generate a 3D mesh from an existing 2D mesh. The \texttt{PHDRAG}, \texttt{PHGLIDE}, \texttt{PHEXTR} and \texttt{PHSWEEP} commands can operate on regions or surfaces. When used with meshed surfaces, these commands are similar to the \texttt{VLDRAG}, \texttt{VLGLIDE}, \texttt{VLEXTR} and \texttt{VLSWEEP}, respectively (if default meshing is active for volumes using \texttt{STATUS1} command). The only difference is that no volumes are generated by the \texttt{PH} commands.

The region shown in Figure 5-27 is to be extruded (with the mesh) along the z-axis.

Type \texttt{STATUS1} or pull down the \texttt{CONTROL} menu, select the \texttt{UTILITY} submenu and then the \texttt{STATUS1} command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “\texttt{PT}”, curves “\texttt{CR}”, surfaces “\texttt{SF}”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between \texttt{ON/OFF} and select the color of the various entities. We will change the label status of points, curves and surfaces from \texttt{OFF} to \texttt{ON}. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the \texttt{ON/OFF} flag for \texttt{PT}, \texttt{CR} and \texttt{SF}. Press either button of the mouse to switch from \texttt{OFF} to \texttt{ON}. After making the three changes, save them by moving the mouse cursor to \texttt{SAVE} and click any of its buttons.

\textbf{Figure 5-27. Meshed Region}
Create and mesh the region by typing the following commands. Try to use the commands interactively.

    PLANE,Z,0,1,
    VIEW,0,0,1,0,
    CRPCORD,1,30,50,0,30,10,0,80,10,0,80,50,0,80,50,0,
    CRPCIRDIA,4,4,1,180,2,
    CRPCIRCLE,6,5,4,15,360,4,
    CRPORD, 10,50,15,0,50,20,0,35,20,0,35,30,0,75,30,0,75,20,0,60,20,0,60,
    15,0,50,15,0,
    CT,1,0,5,1,4,0,
    CT,2,0,5,1,6,0,
    CT,3,0,5,1,13,0,
    RG,1,3,1,2,3,0,
    MA_RG,1,1,1,3,0,
    MARGCH,1,1,1,Q,4,1,0.4,
    ECOMPRESS,1,146,1,
    VIEW,1,1,1,0,

Define the 3D element group.

    EGROUP,1,SOLID;

Activate default meshing for polyhedra (active by default).

    ACTDMESH,PH,1

Use the **PHEXTR** command.

    PHEXTR,RG,1,1,1,Z,15,3,1;
    SHADE;
    ROTATE,-30,0,0,0,1,
    CLS;
    AXIS;
    EPLOT;

The generated mesh is shown in Figure 5-28.
Chapter 5  Modeling Examples

As an exercise, try a similar problem. Create and mesh the region as explained before. Generate the profile shown in Figure 5-29.

\[
\text{CREXTR,3,3,1,Z,80, CREATR,19,19,1,X,80, CRFILLET,20,18,19,40,1,0;}
\]

Define the 3D element group.

\[
\text{EGROUP,1,SOLID;}
\]

Activate default meshing for polyhedrons (active by default).

\[
\text{ACTDMESH,PH,1}
\]

Use the PHDRAG command.

\[
\text{PHDRAG,RG,1,1,1,1,18, 4,20,8,19,4;}
\]

The generated mesh is shown in Figure 5-30.
Three dimensional automatic mesh generation of solids and surfaces is available using tetrahedral and triangular elements. Models with holes at arbitrary angles or complex intersections can be easily meshed for structural, thermal and electromagnetic problems. You can use either the 4-node tetra (TETRA4, TETRA4R) or the 10-node tetra (TETRA10) solid elements as well as a variety of triangular shell elements (TRIANG, SHELL3, SHELL3L, SHELL3T) in your analysis.

The 3D automatic mesh generation feature uses the advancing front technique. In this mesh generation scheme, the nodes are initially placed throughout the model systematically and then the elements are formed by connecting these nodes. The elements are checked for aspect ratio and smoothed if necessary to improve the overall global aspect ratio of the mesh.

The 3D automatic meshing capability has been developed to work in a systematic and convenient manner using the GEOSTAR entities including two special geometric entities (POLYHEDRON - a hollow volume entity, and PART - a solid volume entity). With these geometric entities, the procedure for 3D automatic meshing of solids and surfaces is very simple and straightforward: you just need to build your geometry, define it as hollow or solid, and use the appropriate command, **MA_PH** (surface meshing) or **MA_PART** (solid meshing) to generate your mesh.

For 3D automatic solid or surface meshing, all boundary faces of the solid must be enclosed, i.e., they must be defined as either a region (using the REGION submenu) or a surface (using the SURFACE submenu) to completely enclose a solid or hollow volume. However, cut-outs, holes and openings are permitted in the model. You only need to make sure that the internal faces of these openings are properly defined as surfaces or regions. Models with open faces can be dealt with by deleting the elements on the required surface or region.

The example illustrated here considers the 3D automatic mesh generation of a 455 solid wheel section using the 4-node tetrahedron element. The figure below shows the geometry and solid model depiction of the wheel section.
Type **STATUS1** or pull down the CONTROL menu, select the UTILITY submenu and then the **STATUS1** command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, surfaces “SF”, contours “CT”, regions “RG”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves, contours and regions from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for **PT**, **CR**, **SF**, **CT** and **RG**. Press either button of the mouse to switch from OFF to ON. After making the five changes, save them by moving the mouse cursor to **SAVE** and click any of its buttons.

The geometry of the wheel section illustrated above can be easily developed in GEOSTAR by first constructing the cross section and then sweeping it about an axis by 455 to create the 3D geometry. To start with, we will establish a working plane for constructing the cross section as illustrated below using the **PLANE** command:

```
GEO > PLANE
  Axis symbol normal to the plane [Z] >
  Value [0] >
  Grid line type [1] > 0
```
Turn on the SNP and PIC icons using the right button of the mouse. Execute the commands **VIEW** and **GRIDON** with default options successively. For constructing the cross section, type the command **CRPCORD** and input the coordinates of points as illustrated below:

```
GEO > CRPCORD
Curve [1] >
Digitize/Input Coordinates > 50,20,0
Digitize/Input Coordinates > 80,20,0
Digitize/Input Coordinates > 80,10,0
Digitize/Input Coordinates > 90,10,0
Digitize/Input Coordinates > 90,20,0
Digitize/Input Coordinates > 100,20,0
Digitize/Input Coordinates > 100,30,0
Digitize/Input Coordinates > 90,30,0
Digitize/Input Coordinates > 90,40,0
Digitize/Input Coordinates > 80,40,0
Digitize/Input Coordinates > 80,30,0
Digitize/Input Coordinates > 50,30,0
Digitize/Input Coordinates > 50,20,0
```

Figure 5-32 shows the keypoints and curves of the cross section constructed using the **CRPCORD** command.

**Figure 5-32. Construction of the Cross Section**
Chapter 5   Modeling Examples

Turn off the grids using the command **GRIDOFF** with default options. Clear the screen using **CLS** command with default options and issue **CRPLOT** command to plot the curves generated. Some of the sharp corners of the cross section need to be smoothed using the **CRFILLET** command, as illustrated below:

```
GEO > CRFILLET
   Curve [13] >
   Pick/Input Curve 1 > 2,
   Pick/Input Curve 2 > 3,
   Radius of fillet > 3
   Trim flag [1] >
   Original curve keeping flag if trim flag on [0] >
   Tolerance [1e-06] >
```

Repeat the **CRFILLET** command and smooth the corners formed by curves 3-4, 5-6, 6-7, 8-9, and 9-10. If you clear the screen and issue **CRPLOT** command again, the following view will be obtained:

**Figure 5-33. Smoothing of Cross Section Using Fillets**

As mentioned earlier, to use the 3D automatic meshing capability, all faces of the solid must enclose a volume, i.e., they must be defined as either surfaces or regions. Curves 1 through 18 which constitute the cross section shown above will be swept about the Y-axis by 45 degrees to form the surfaces at the top and bottom faces. One of the end faces will be formed by defining the area enclosed by curves 1 through 18 as a region entity. This region can be regenerated (**RGGEN** command) by an angle of 45 degrees using the rotation option to define the other end face.
Chapter 5  Modeling Examples

Let us proceed with the definition of a region entity for describing one of the end faces. First, you can define a contour entity connected by curves 1 through 18 as follows:

\[\text{GEO} > \text{CT} \]
\[\text{Contour [1]} > \]
\[\text{Mesh flag 0=Esize 1=Num. elems [0]} > \]
\[\text{Average element size } > 1 \]
\[\text{Number of reference boundary curves [1]} > \]
\[\text{Pick/Input Curve 1 > 1,} \]
\[\text{Use selection set 0=No 1=Yes [0]} > \]

The average element size can be any number in the above command. The actual element size for 3D automatic meshing is specified in the \text{PH} command when defining a polyhedron. Next, use the \text{RG} command to define a region bounded by curves 1 through 18 (i.e., contour 1) as follows:

\[\text{GEO} > \text{RG} \]
\[\text{Region [1]} > \]
\[\text{Number of contours [1]} > \]
\[\text{Pick/Input Outer Contour } > 1, \]
\[\text{Underlying surface [0]} > \]

If you clear the screen and issue \text{RGPLOT}, the view in Figure 5-34 will be obtained:

Figure 5-34. Contour and Region Plots of the End Face
Chapter 5   Modeling Examples

The region R1 defined above will be regenerated using the command `RGGEN` and specifying an angle of rotation about the Y-axis, as illustrated below:

```
GEO > RGGEN
Generation number [1] >
Pick/Input Beginning Region > 1,
Pick/Input Ending Region > 1,
Increment [1] >
Generation flag [0] > 1
X-Rotation [0] >
Y-Rotation [0] > 45
Z-Rotation [0] >
```

In the above command, the prompt, Generation flag, refers to regeneration by translation (flag = 0) or rotation (flag = 1). The rotation option was chosen to form the other end face using the existing one. When the above command is executed, a new region R2 as well as all the associated contour (labeled 2), curves (labeled 19 through 36) and keypoints will be formed. Clear the screen and type `VIEW,1,1,1;` followed by the `RGPLOT` command. You will then see the end faces of the wheel section created using `RG` and `RGGEN` commands as shown in Figure 5-35:

![Figure 5-35. Generation of the End Faces](image_url)

Next, the top and bottom surfaces will be created by sweeping curves 1 through 18 about the Y-axis by an angle of 45 degrees. Clear the screen and issue `CRPLOT` command for curves 1 through 18. You can use the `SFSWEEP` command from the Geometry > SURFACES > SFGNR menu tree as illustrated below to create these surfaces:
Chapter 5  Modeling Examples

GEO > SFSWEEP
Pick/Input Beginning Curve > 1,
Pick/Input Ending Curve > 18,
Increment [1] >
Axis symbol [Y] >
Angle of the arc [360] > 45
Number of segments [1] >

The new surfaces and the associated keypoints and curves are automatically generated as shown in the figure below. The SFSWEEP command also generates additional keypoints on the Y-axis about which the curves 1 through 18 were swept to form surfaces.

Figure 5-36. Generation of Top and Bottom Surfaces by Sweeping

All bounding faces of the wheel section have now been defined as either surfaces or regions. You can next proceed to defining a polyhedron entity using the PH command which describes a completely enclosed hollow volume. Clear the screen and issue RG PLOT and SF PLOT commands successively to obtain the view shown in Figure 5-37.
Chapter 5  Modeling Examples

Figure 5-37. Bounding Surfaces and Regions of the Wheel Section

From the Geometry > POLYHEDRA menu tree, select the **PH** command. When you use this command, you will be prompted to input the reference boundary entity which is either a surface or a region. The average element size is also specified in this command, overriding the input specified earlier in the **CT** command. The prompts and inputs for the **PH** command are illustrated below:

```
GEO > PH
   Polyhedron Label [1] >
   Reference entity name SF or RG [SF] >
   Pick/Input beginning Surface > 1,
   Average element size > 10
   Tolerance [0.001] >
   Redefine element size on boundary [1] >
```

At this point, if only the surface of the wheel section needs to be meshed with triangular elements, you can use the **MA_PH** command from the Meshing > AUTO_MESH menu tree. However, since the wheel section is solid, you need to use the command **PART** which defines a solid volume entity using polyhedra. A part can be made up of more than one polyhedron. From the Geometry > PARTS menu tree, select the **PART** command and input the polyhedron label as illustrated below:

```
GEO > PART
   Part label [1] >
   Pick/Input Polyhedron 1 > 1
   Pick/Input Polyhedron 2 > 1
```
You can use the commands `PHPLOT` and `PARTPLOT` to view the polyhedra and parts defined above. The geometry of the wheel section is now ready for 3D automatic mesh generation using tetrahedral finite elements. From the Meshing > AUTO_MESH menu tree, select the `MA_PART` command and specify the element order as low (for using the 4-node tetrahedron element). The prompts and inputs for this command are shown below:

```
GEO > MA_PART
   Pick/Input Beginning Part > 1
   Pick/Input Ending Part > 1
   Increment [1] >
   Hierarchy check flag [1] >
   Element order 0=Low 1=High [1] > 0
   Number of smoothing iterations [4] >
```

After the mesh generation is completed, there will be a summary of the number of nodes and elements generated as well as the total volume of the solid. You can use the command `Hidden` from the Display > DISP_PAR menu tree in order to see the finite element mesh without the hidden lines.

Use the commands `NLIST` and `ELIST` to list the nodal coordinates and element connectivity of the finite element mesh generated. You can use the command `STATUS1` to activate the labels if you like to see the node and/or element numbers. The `SHRINK` command can be used to obtain an exploded view of the finite element mesh. The `SHADE` command fills the elements with specified colors.

Figure 5-38 shows the finite element mesh of the wheel section with and without hidden lines.

**Figure 5-38. Generated Finite Element Mesh (with and without Hidden Lines)**
Chapter 5  Modeling Examples

3D Automatic Meshing for a Widget with Openings

This example presents step-by-step procedures for building the geometry and automatically generating the 3D finite element mesh of a solid widget with openings. The circular and rectangular openings cross each other orthogonally and they do not intersect. The geometry of the model for automatic meshing is shown in Figure 5-39. The plan view, side view, front view as well as an isometric view of the model are shown along with a solid model depiction to help you visualize the model for 3D automatic meshing.

Figure 5-39. Geometry of the Solid for Meshing

The faces with two circular openings (see front view) are considered as front and back faces of the widget. The faces with the rectangular slots (see end view) are considered as side faces. The remaining two faces (see plan view) form the top and bottom faces.

At the GEO > prompt, enter the commands Plane and View successively with default options. This will establish a working plane X-Y and it will be displayed on the screen. Turn on the grids by using the command GRIDON with default options. Select the REP, PIC, and SNP icons with the right button of the mouse.

Type STATUS1 or pull down the CONTROL menu, select the UTILITY submenu and then the STATUS1 command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities
(points “PT”, curves “CR”, surfaces “SF”, contours “CT”, regions “RG”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves, surfaces, contours and regions from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for PT, CR, SF, CT and RG. Press either button of the mouse to switch from OFF to ON. After making the five changes, save them by moving the mouse cursor to SAVE and click any of its buttons.

We will first construct a rectangle using the CRPCORD command. At the GEO > prompt, type this command and establish the four corners and curves of the rectangle as illustrated below (for some of the prompts, the default values are assumed to apply if you do not see an input in bold letters: click the left mouse button once to accept default values):

```
GEO > CRPCORD
  Curve [1] >
  Digitize/Input Coordinates > 0,50,0
  Digitize/Input Coordinates > 0,0,0
  Digitize/Input Coordinates > 80,0,0
  Digitize/Input Coordinates > 80,50,0
  Digitize/Input Coordinates > 0,50,0
```

You will see keypoints and curves 1 through 4 displayed after the above command is executed, as shown in Figure 5-40.

**Figure 5-40. Rectangle Constructed Using CRPCORD Command**
Next, the two corners at the top of the rectangle are trimmed to form smooth edges. This is done by forming fillets at these locations using the command, **CRFILLET** from the Geometry > CURVES > CRMANIP menu tree. The command and its input are shown below:

```plaintext
GEO > CRFILLET
Curve [5] >
Pick/Input Curve 1 > 1,
Pick/Input Curve 2 > 4,
Radius of fillet > 8
Trim flag [1] >
Original curve keeping flag if trim flag on [0] >
Tolerance [1e-06] >
```

Repeat the **CRFILLET** command for curves 4 and 3. Figure 5-41 shows a view of the rectangle after the corners are trimmed. This rectangle will be later extruded in the Z-direction to form a solid block.

![Figure 5-41. Formation of Fillets at the Top Corners](image)

The formation of fillets results in the addition of keypoints to the geometry. These keypoints (5 and 8) may be deleted using **PTDEL** command. The numbering gaps in keypoints may be removed by using the command **PTCOMPRESS**.

Next, you need to establish two points within the above rectangle in order to construct two circles. These two points will define the centers of the circles. The circles will be later extruded to form the circular openings. The coordinates of the points are shown in the illustration below:

```plaintext
GEO > PT
Keypoint [7] >
Digitize/Input Coordinates > 20,35,0
```
You can next proceed to constructing a circle of radius 10 at keypoint 7. The command **CRPCIRCLE** can be selected from the Geometry menu, CURVES > CIRCLES submenu. The command and its inputs are shown below along with the prompts:

GEO > **CRPCIRCLE**  
Curve [7] >  
Pick/Input Keypoint at center > 7,  
Pick/Input Keypoint on zero degree line > 3,  
Radius [21.1896] > 10  
Angle of the arc [360] >  
Number of segments [4] >

Repeat the above procedure and establish another circle at keypoint 8 with the same radius of 10, as illustrated below:

GEO > **CRPCIRCLE**  
Curve [11] >  
Pick/Input Keypoint at center > 8,  
Pick/Input Keypoint on zero degree line > 5,  
Radius [21.1896] > 10  
Angle of the arc [360] >  
Number of segments [4] >

Figure 5-42 shows the circles constructed in the rectangle at keypoints 7 and 8. Curves 1 through 6 represent the rectangle with fillets, and curves 7 through 14 represent the circles.

**Figure 5-42. Rectangle with Circular Openings**
Chapter 5  Modeling Examples

The rectangle with the circles constructed above will be next converted to a region entity. In order to do this, you must first describe the outer and inner contours using the CT command. We will first define the outer contour (rectangle with fillets) with a unit average element size (the actual mesh density is specified when you define the polyhedra). When you use the CT command, you only need to select one curve as the reference curve for the outer contour, as illustrated below:

GEO > CT
  Contour [1] >
  Mesh flag 0=Esize 1=Num. elems [0] >
  Average element size > 1
  Number of reference boundary curves [1] >
  Pick/Input Curve 1 > 3,
  Use selection set 0=No 1=Yes [0] >

Repeat the CT command and proceed to defining the inner contours at the two circles, as illustrated below:

GEO > CT
  Contour [2] >
  Mesh flag 0=Esize 1=Num. elems [0] >
  Average element size > 1
  Number of reference boundary curves [1] >
  Pick/Input Curve 1 > 8,
  Use selection set 0=No 1=Yes [0] >

GEO > CT
  Contour [3] >
  Mesh flag 0=Esize 1=Num. elems [0] >
  Average element size > 1
  Number of reference boundary curves [1] >
  Pick/Input Curve 1 > 14,
  Use selection set 0=No 1=Yes [0] >

With the contour definitions completed, you can proceed to defining the semisMOOTH rectangle with openings as a plane region using the RG command. When you are defining the regions, remember to pick the outer contour (rectangle) first and then proceed to selecting the inner contours.

GEO > RG
  Region [1] >
  Number of contours [1] > 3
  Pick/Input Outer Contour > 1,
Chapter 5  Modeling Examples

Pick/Input Inner Contour 1 > 2,
Pick/Input Inner Contour 2 > 3,
Underlying surface [0] >

Figure 5-43 shows the contour and region plots.

Figure 5-43. Contour and Region Plots

We will construct a three dimensional solid block by regeneration and extrusions. First, the region defined above will be regenerated in the Z-direction to form the front and back faces of the widget. Then, some of the curves of region 1 can be extruded in the Z-direction to form the top and bottom faces as well as the inside faces of the circular openings. The side faces are described by defining them as regions using the curves formed during extrusion. After this, you can proceed to creating the rectangular opening which will complete the construction of the model geometry.

Turn off the grid by using the command GRIDOFF with default options. Change the plane view to a three dimensional one by using the VIEW command with a unit value for each of X, Y and Z coordinates. Clear the screen with CLS command and issue RGPLOT command. Use the command Repaint or click the right button of the mouse on the PNT icon if necessary.

We will regenerate the above region in the Z-direction to form the front and back faces of the widget. From the Geometry menu, REGIONS > RGENR submenu, select the command RGEN. There is only one region (with label 1) to regenerate and it can be picked by the left button of the mouse. Accept the default generation flag of 0 which results in translating the region during regeneration (there is also a rotation option). Specify a Z-displacement of 60 units, as illustrated below:
GEO > RGGEN
Generation number [1] >
Pick/Input Beginning Region > 1,
Pick/Input Ending Region > 1,
Increment [1] >
Generation flag [0] >
X-Displacement [0] >
Y-Displacement [0] >
Z-Displacement [0] > 60

The above operation results in the creation of region 2 by regeneration of region 1 as shown in Figure 5-44. The keypoints, curves, and contours of the new region are also created automatically.

Figure 5-44. Construction of Second Region by Regeneration

You can next proceed to extruding some curves of the first region to form the outer faces of the widget as well as the internal faces of the circular openings. In region 1, curves 1 through 6 represent the semi-smooth rectangle, and curves 7 through 14 represent the circular openings. Extrusion of curves 2 and 4 forms the top and bottom faces. Extrusion of curves 5 and 6 will result in the formation of curved (fillet) surfaces which connect the top, bottom, and side faces of the widget. When you extrude curves 7 through 14, the faces of the circular openings are formed. Since the side faces have the rectangular openings, curves 1 and 3 will not be extruded to form surfaces. Instead, they will be modeled as regions using the curves generated during extrusion. This is inevitable as there are rectangular openings in these faces and it is easier to model an opening in a region entity than in a surface entity. All the extrusions are carried by using the command SFEXTR from the
Geometry > SURFACES > SFGENR menu tree. Since there are many curves to be extruded, it plausible to proceed in stages.

In the first stage, extrude curves 4 through 14 along the Z-direction by 60 units. The prompts and inputs for \texttt{SFEXTR} are shown below:

```
GEO > SFEXTR
    Pick/Input Beginning Curve > 4,
    Pick/Input Ending Curve > 14,
    Increment [1] >
    Axis symbol [Z] >
    Value > 60
```

Figure 5-45 shows the new surfaces generated by extruding the curves 4 through 14.

**Figure 5-45. Formation of Surfaces by Extrusion - First Stage**

In the second stage of extrusion, you will form the bottom face of the widget. Repeat the \texttt{SFEXTR} command and select curve 2. The prompts and inputs are shown below:

```
GEO > SFEXTR
    Pick/Input Beginning Curve > 2,
    Pick/Input Ending Curve > 2,
    Increment [1] >
    Axis symbol [Z] >
    Value > 60
```
Figure 5-46 shows a partial geometry of the widget, obtained by regenerating and extruding region 1 and its curves.

The regeneration and extrusion operations performed so far result in the description of all outer faces except the sides which have the rectangular opening. As mentioned earlier, it is easier to create the opening in a region entity. We can therefore create a rectangular opening on one of the sides, define it as a region and regenerate it along the perpendicular axis to form the other side.

First, you need to change the view in order to draw the rectangular opening. Issue the VIEW and PLANE commands as illustrated below:

```
GEO > VIEW
X-Value [0] > 1
Y-Value [0] >
Z-Value [0] >
Coordinate system [0] >
```

```
GEO > PLANE
Axis symbol normal to the plane [Z] > X
Value [0] >
Grid line type [1] >
```
Next, issue the \texttt{GRIDON} command to turn on the grids. Figure 5-47 shows the view after the above commands are executed.

\textbf{Figure 5-47. View for Creating the Rectangular Slot}

You can next proceed to drawing the rectangular slot using \texttt{CRPCORD} command. The coordinates of the points for this command and the prompts are shown below:

\begin{verbatim}
GEO > CRPCORD
  Curve [43] >
  Digitize/Input Coordinates > 0,20,10
  Digitize/Input Coordinates > 0,20,50
  Digitize/Input Coordinates > 0,5,50
  Digitize/Input Coordinates > 0,5,10
  Digitize/Input Coordinates > 0,20,10
\end{verbatim}

Figure 5-48 shows the view when you conclude the \texttt{CRPCORD} command. Curves 43 through 46 describe the rectangular opening.
In order to conveniently define the contours and region on the side face, you need to change the viewing position. Issue the **VIEW** command as illustrated below:

```
GEO > VIEW
  X-Value [0] > -3
  Y-Value [0] > 2
  Z-Value [0] > 1
  Coordinate system [0] >
```

Figure 5-49 shows a view of the widget after the view command is executed.

---

**Chapter 5  Modeling Examples**

**Figure  5-48. Creation of Rectangular Slot**

![Rectangular Slot Diagram](image)

In order to conveniently define the contours and region on the side face, you need to change the viewing position. Issue the **VIEW** command as illustrated below:

```
GEO > VIEW
  X-Value [0] > -3
  Y-Value [0] > 2
  Z-Value [0] > 1
  Coordinate system [0] >
```

Figure 5-49 shows a view of the widget after the view command is executed.

---

**Figure  5-49. View for Region Definition on the Side Face**

![Region Definition Diagram](image)
You can now proceed to defining contours and region on the side face. First, you can define the inner contour which consists of curves 43 through 46 of the rectangular slot. The contour command and its inputs are shown below:

```
GEO > CT
  Contour [7] >
  Mesh flag 0=Esize 1=Num. elems 0 >
  Average element size > 1
  Number of reference boundary curves [1] >
  Pick/Input Curve 1 > 46,
  Use selection set 0=No 1=Yes 0 >
```

Next, proceed to defining the outer contour. All curves of the outer contour have to picked in order to define a contour. The contour command and its inputs are shown below:

```
GEO > CT
  Contour [8] >
  Mesh flag 0=Esize 1=Num. elems 0 >
  Average element size > 1
  Number of reference boundary curves [1] > 4
  Pick/Input Curve 1 > 19,
  Pick/Input Curve 2 > 41,
  Pick/Input Curve 3 > 1,
  Pick/Input Curve 4 > 31;
```

With the two contours defined, you can proceed to defining a region (label 3) as illustrated below:

```
GEO > RG
  Region [3] >
  Number of contours [1] > 2
  Pick/Input Outer Contour > 8,
  Pick/Input Inner Contour 1 > 7,
  Underlying surface [0] >
```

The region defined above is regenerated by using the RGGEN command with an X-displacement of 80 units. This process is illustrated below:

```
GEO > RGGEN
  Generation number [1] >
  Pick/Input Beginning Region > 3,
  Pick/Input Ending Region > 3,
```
Increment [1] >  
Generation flag [0] >  
X-Displacement [0] > 80  
Y-Displacement [0] >  
Z-Displacement [0] > 

The above command will generate region 4 from region 3. If you clear the screen and issue a \texttt{RGPLOT} command, the view in Figure 5-50 will be observed:

\textbf{Figure 5-50. Region Plot After All Regenerations}

Finally, to describe the faces of the rectangular opening, you simply need to extrude curves 43 through 46 along the X-direction by 80 units. This is illustrated below:

\texttt{GEO > SFEXTR}  
Pick/Input Beginning Curve > 43,  
Pick/Input Ending Curve > 46,  
Increment [1] >  
Axis symbol [Z] > X  
Value > 80

Figure 5-51 shows the new curves and surfaces generated after all extrusions are performed.
The procedures up to this point conclude the geometry construction of the widget. Figure 5-52 shows the final geometry of the widget for meshing.

With the construction of widget geometry completed, you can now proceed to defining POLYHEDRON and PART geometric entities required for 3D automatic meshing. Clear the screen and issue RGPLLOT and SFPLLOT commands. From the Geometry > POLYHEDRA menu tree, select the PH command. You will be prompted to input the reference entity, which is either a surface or a region. If you issued RGPLLOT command above, you can input RG for this prompt and proceed to picking any region on the screen. The average element size is specified as 10 and
Chapter 5  Modeling Examples

this value overrides any other value defined earlier during contouring. The prompts and inputs for the **PH** command (with surface as the reference entity) are shown below:

```
GEO > PH
  Polyhedron Label [1] >
  Reference entity name SF or RG [SF] >
  Pick/Input beginning Surface > 1,
  Average element size > 10
  Tolerance [0.001] >
  Redefine element size on boundary [1] >
```

The **PH** command defines a hollow 3D volume. Since the widget is solid, you need to execute the **PART** command (from the Geometry > PART menu tree) which defines a solid volume entity. The prompts and inputs for the **PART** command are shown below:

```
GEO > PART
  Part label [1] >
  Pick/Input Polyhedron 1 > 1
  Pick/Input Polyhedron 2 > 1
```

You can then move to the Meshing menu and select **MA_PART** command from the AUTO_MESH submenu. The command and its inputs are shown below:

```
GEO > MA_PART
  Pick/Input Beginning Part > 1
  Pick/Input Ending Part > 1
  Increment [1] >
  Hierarchy check flag [1] >
  Element order 0=Low 1=High [1] >
  Number of smoothing iterations [4] >
```

GEOSTAR will then start placing the nodes in the model, and connect each node by a 10-node tetrahedron element. After the meshing is completed, you will see the total number of elements and nodes generated and the volume of the solid in the command window. Figure 5-53 shows the element mesh of the widget with hidden lines removed.
Chapter 5  Modeling Examples

Figure 5-53. Finite Element Mesh (Hidden Lines Removed)

Figure 5-54 shows a different view of the mesh with the openings more clearly visible.

Figure 5-54. A Different View of the Finite Element Mesh
Chapter 5  Modeling Examples

Crank Shaft Connector Using 3D Automatic Meshing

This example presents step-by-step procedures for building the geometry and automatically generating the 3D finite element mesh of a solid crank shaft connector. Since the crank shaft connector has an axisymmetric geometry, a part of the model is considered for geometry building and meshing. The crank shaft connector has top and bottom plates connected by circular and hexagonal rods. As the selected part is symmetric, one half of the model will be built and meshed. The geometry and finite element mesh of the other half can be obtained by making use of the symmetry commands in GEOSTAR.

The geometry of the model for automatic meshing is shown in Figure 5-55. The plan view, side view, front view as well as an isometric view of the model are shown along with a solid model depiction to help you visualize the model for 3D automatic meshing.

Figure 5-55. Geometry of the Solid for Meshing

Similar to the previous examples, this example will make use of many model building features of GEOSTAR such as regeneration, extrusion, and others. To start with, you will construct a plane region and use the regeneration and extrusion features on this region to build more complicated parts of the model geometry.
Chapter 5  Modeling Examples

Type **STATUS1** or pull down the CONTROL menu, select the UTILITY submenu and then the **STATUS1** command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “**PT**”, curves “**CR**”, surfaces “**SF**”, contours “**CT**”, regions “**RG**”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves, surfaces, contours and regions from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for **PT**, **CR**, **SF**, **CT** and **RG**. Press either button of the mouse to switch from OFF to ON. After making the five changes, save them by moving the mouse cursor to **SAVE** and click any of its buttons.

At the GEO > prompt, enter the commands **PLANE,**; and **VIEW,0,-1,0;** successively. This will establish a working plane X-Z and it will be displayed on the screen. Turn on the grids by using the command **GRIDON** with default options. Select the REP, PIC, and SNP icons with the right button of the mouse.

First, we need to create a keypoint at (0,0,0) to function as the center for the circular sectors of the bottom plate. Issue the **PT** command and establish the first keypoint at the origin. We will next construct an edge of the bottom plate using the **CRPCORD** command. At the GEO> prompt, type this command and establish the keypoints and curves of the edge as illustrated below (for some of the prompts, the default values are assumed to apply if you do not see an input in bold letters):

```
GEO > CRPCORD
  Curve [1] >
  Digitize/Input Coordinates > 25,0,0,
  Digitize/Input Coordinates > 65,0,0,
  Digitize/Input Coordinates > 70,0,5,
  Digitize/Input Coordinates > 75,0,5,
  Digitize/Input Coordinates > 80,0,0,
  Digitize/Input Coordinates > 100,0,0,
  Digitize/Input Coordinates > 100,0,0,
```

Figure 5-56 shows the curves and keypoints of the edge constructed using the **CRPCORD** command.
Next, you need to construct two circular arcs of 45° using `CRPCIRCLE` command with keypoint 1 as the center. The command and its inputs are illustrated below:

GEO > `CRPCIRCLE`
   Curve [6] >
   Pick/Input Keypoint at center > 1,
   Pick/Input Keypoint on zero degree line > 2,
   Radius [25] >
   Angle of the arc [360] > -45
   Number of segments [1] >

GEO > `CRPCIRCLE`
   Curve [7] >
   Pick/Input Keypoint at center > 1,
   Pick/Input Keypoint on zero degree line > 7,
   Radius [100] >
   Angle of the arc [360] > -45
   Number of segments [1] >

The construction of the arcs as described above leads to the generation of two more keypoints, 8 and 9. You need to connect these two points by a straight line using the command `CRPLINE` as illustrated below:

GEO > `CRPLINE`
   Curve [8] >
   Pick/Input Keypoint 1 > 8,
   Pick/Input Keypoint 2 > 9,
   Pick/Input Keypoint 3 > 9,

Next, repeat the above command and connect keypoints 3 and 6 by a straight line as illustrated below:
The commands executed up to this point establish a plane region. We will define a circle in this plane region. You need to first define a keypoint to locate the center of the circle, as illustrated below:

GEO > PT
   Keypoint [10] >
   Digitize/Input Coordinates > 65,0,30,

Execute the CRPCIRCLE command to draw a circle at the keypoint defined above. The command its inputs are shown below:

GEO > CRPCIRCLE
   Curve [10] >
   Pick/Input Keypoint at center > 10,
   Pick/Input Keypoint on zero degree line > 7,
   Radius [46.0977] > 10
   Angle of the arc [360] >
   Number of segments [4] >

Figure 5-57 shows a plot of the plane region generated by the above commands. This region forms a basis for regeneration and extrusion to form the more complex three dimensional geometry of the crank shaft model.

**Figure 5-57. Basic Region for Model Building**
At this point, you can turn off the grid by using the command \textbf{Grid Off} with default values. Next, you need to define contours of the plane region shown above. There are three contours in this region. However, one of the contours connecting curves 2-3-4-9 forming a trapezoid (see Figure 5-58) will not be used for contour definition as these curves will be later extruded to form the surfaces of the connecting rod.

\textbf{Figure 5-58. Curves of Outer Contour}

Execute the contour command and select the curves for outer contour (excluding curve 9) as illustrated below:

\begin{verbatim}
GEO > CT
  Contour [1] > 
  Mesh flag 0=Esize 1=Num. elems [0] >
  Average element size > 1
  Number of reference boundary curves [1] > 5
  Pick/Input Curve 1 > 1,
  Pick/Input Curve 2 > 2,
  Pick/Input Curve 3 > 3,
  Pick/Input Curve 4 > 4,
  Pick/Input Curve 5 > 5,
  Use selection set 0=No 1=Yes [0] >
\end{verbatim}

Repeat the contour command and select one curve of the inner contour (circle) as illustrated below:
Next, define a region connecting these two contours, as illustrated below:

```
GEO > RG
Region [1] >
Number of contours [1] > 2
Pick/Input Outer Contour > 1,
Pick/Input Inner Contour 1 > 2,
Underlying surface [0] >
```

Figure 5-59 shows a plot of the contours and region defined above:

```
Figure 5-59. Region 1
```

Change the plane view to a three dimensional one by using the command `VIEW` with a unit value for each of X, Y and Z coordinates. Next, the curves 2-3-4-9 which form a trapezoidal region will be extruded along the Y-axis to form one of the connecting rods. To start with, curves 2 through 4 will be extruded using the `SFEXTR` command as illustrated below:
Chapter 5  Modeling Examples

GEO > SFEXTR
   Pick/Input Beginning Curve > 2,
   Pick/Input Ending Curve > 4,
   Increment [1] >
   Axis symbol [Z] > Y
   Value > 80

In the next step, curve 9 which forms the base of the trapezoid as well curves 10 through 13 of the circle will be extruded in the Y-direction as illustrated below:

GEO > SFEXTR
   Pick/Input Beginning Curve > 9,
   Pick/Input Ending Curve > 13,
   Increment [1] >
   Axis symbol [Z] > Y
   Value > 80

The extrusion of these curves leads to the construction of the connecting rods as shown in Figure 5-60:

Figure 5-60. Extrusion of Curves to Form Connecting Rods

To form the bottom plate, curves 1-9-5-6-7-8 need to be extruded in the negative Y-direction by 10 units. In the first step, curves 6 through 8 are extruded as illustrated below:
In the next step, curves 1, 5, and 9 which have an increment of 4 between them are extruded as illustrated below:

GEO > SFEXTR
Pick/Input Beginning Curve > 1,
Pick/Input Ending Curve > 9,
Increment [1] > 4
Axis symbol [Z] > Y
Value > -10

Clear the screen and issue SFPLOT to see the generated surface plots. The generated surfaces shown in Figure 5-61 can be obtained by a 10 degree rotation about Y-axis:

Figure 5-61. Surfaces Generated by Extrusion

The bottom face of the plate does not have a circular opening and is currently not described as either a region or a surface. Since all curves that are required to define this region already exist, let us define it as a region entity.
Clear the screen and issue a **CRPLOT** command. In order to obtain a better view, rotate about the Y-axis by -90 degrees and zoom in on the plate as illustrated below:

**GEO > ROTATE**

-X-Rotation [0] >
-Y-Rotation [0] > -90;

**Figure 5-62. Curve Plot for Contour Definition of the Bottom Face**

The bottom face of the plate is connected by curves 36-30-37-41-39-33 as shown in Figure 5-62. When you issue the contour command, you must select all these curves to uniquely define a contour. The prompts and inputs for the contour command are shown below:

**GEO > CT**

-Contour [3] >
-Mesh flag 0=Esize 1=Num. elems [0] >
-Average element size > 1
-Number of reference boundary curves [1] > 6
-Pick/Input Curve 1 > 36,
-Pick/Input Curve 2 > 30,
-Pick/Input Curve 3 > 37,
-Pick/Input Curve 4 > 41,
-Pick/Input Curve 5 > 39,
-Pick/Input Curve 6 > 33,
-Use selection set 0=No 1=Yes [0] >
Next, you can define a region as illustrated below using the contour defined above.

```
GEO > RG
   Region [2] >
   Number of contours [1] >
   Pick/Input Outer Contour > 3,
   Underlying Surface [0] >
```

All faces of the bottom plate are now completely described using regions and surfaces. Regions 1 and 2 describe the top and bottom faces whereas surfaces 9 through 14 describe the side faces of the plate. You can next use the regeneration feature of GEOSTAR to regenerate these regions and surfaces (RGEN and SGEN commands) to form the top plate. Clear the screen and issue RGPLOT command.

You can start by regenerating the top region of the bottom plate (region 1) using RGEN command. The inputs and prompts for this command are shown below:

```
GEO > RGEN
   Generation number [1] >
   Pick/Input Beginning Region > 1,
   Pick/Input Ending Region > 1,
   Increment [1] >
   Generation flag [0] >
   X-Displacement [0] >
   Y-Displacement [0] > 80
   Z-Displacement [0] >
```

Repeat the RGEN command for region 2 and specify the Y-displacement as 100 as illustrated below:

```
GEO > RGEN
   Generation number [1] >
   Pick/Input Beginning Region > 2,
   Pick/Input Ending Region > 2,
   Increment [1] >
   Generation flag [0] >
   X-Displacement [0] >
   Y-Displacement [0] > 100
   Z-Displacement [0] >
```
Chapter 5  Modeling Examples

Figure 5-63, using ZOOMOUT command, shows the plot of all regions after regeneration:

**Figure 5-63. Regeneration of Regions for the Top Plate**

To form the side faces of the top plate, you need to regenerate the side surfaces of the bottom plate. In the surface plot shown in Figure 5-64, you can verify that surfaces 9 through 14 form the side faces of the bottom plate.

**Figure 5-64. Surface Plot of the Bottom Plate**
You can next proceed to executing the **SFGEN** command and pick regions 9 through 14 for regeneration as illustrated below:

```
GEO > SFGEN
    Generation number [1] >
    Pick/Input Beginning Surface > 9,
    Pick/Input Ending Surface > 14,
    Increment [1] >
    Generation flag [0] >
    X-Displacement [0] >
    Y-Displacement [0] > 90
    Z-Displacement [0] >
```

You can clear the screen and issue a **SFPLOT** command to see a plot of all surfaces. Figure 5-65 shows a plot of all surfaces generated by extrusion and regeneration.

**Figure 5-65. Surface Plot After Extrusion and Regeneration**

Change the view by using the command **VIEW** with a unit value for each of X, Y and Z coordinates. Next, enter the commands **PLANE** and **VIEW** successively with default options. This will establish a working plane X-Y and it will be displayed on the screen. Turn on the grids by using the command **GRIDON** with default options. Make sure the REP, PIC, and SNP icons are still active. Use the **SCALE** command if necessary.
Chapter 5  Modeling Examples

The next step in geometry modeling is to construct a small length of the crank shaft which connects to the top plate. You can start by defining two keypoints as illustrated below:

```
GEO > PT
Keypoint [39] >
Digitize/Input Coordinates > 25,95,0

GEO > PT
Keypoint [40] >
Digitize/Input Coordinates > 20,95,0
```

Turn off the grid, change the view to coordinates (1,1,1) using `VIEW` command and zoom in on the top half of the model as shown in Figure 5-66. You need to define an arc between keypoint 40 and 38 with the center at keypoint 39. This arc will be used to define a curved surface in the transition zone between the crank shaft and the connector.

![Figure 5-66. Top Half of the Model](image)

Execute the command `CRARC` as illustrated below:

```
GEO > CRARC
Curve [59] >
Pick/Input Keypoint at one end > 40,
Pick/Input Keypoint at other end > 38,
```
Pick/Input Keypoint towards Center > 39, 
Radius [5] >

If you clear the screen and issue a **CRPLOT** command, the view in Figure 5-67 will be seen.

**Figure 5-67. Curve Plot of the Top Half**

Curve 59 in Figure 5-67 is used in generating a curved surface by **SFDRAG** command. The inputs and prompts for this command are shown below:

```
GEO > SFDRAG
  Pick/Input Beginning Curve > 59,
  Pick/Input Ending Curve > 59,
  Increment [1] >
  Number of profile curves [1] >
  Pick/Input Curve 1 of Profile > 52,
```

Figure 5-68 shows all surfaces after the above command is executed:
Note that surface 15 forms an internal partition in the crank connector geometry and it should be deleted. Use the command `SFDEL` as illustrated below:

```
GEO > SFDEL
Pick/Input Beginning Surface > 15,
Pick/Input Ending Surface > 15,
Increment [1] >
```

Change the view by rotating about the Y-axis by 30 degrees as illustrated below:

```
GEO > ROTATE
X-Rotation [0] >
Y-Rotation [0] > 30;
```

Turn on the grid by using the command `Grid On` with default options. Establish a keypoint at the coordinates indicated below:

```
GEO > PT
Keypoint [42] >
Digitize/Input Coordinates > 0,80,0
```

The above command will place keypoint 42 on the grid as shown in Figure 5-69. This keypoint will be connected with keypoints by means of a surface generated by `SFPTCR`. 

Figure 5-68. Creation of New Surfaces by SFDRAG Command
Execute the command **SFPTCR** as illustrated below:

```
GEO > SFPTCR
   Surface [22] >
   Pick/Input Curve > 46,
   Pick/Input Keypoint > 42,
   Underlying surface [0] >
```

The above command will generate a surface 22 connecting keypoints 42, 32 and 29, as shown in Figure 5-70. This surface describes the bottom face of the crank shaft.
Next, curve 61 will be extruded in the Y-direction to form another face of the crank shaft, as illustrated below:

**GEO > SFEXTR**
- Pick/Input Beginning Curve > 61,win
- Pick/Input Ending Curve > 61,
- Increment [1] >
- Axis symbol [Z] > Y
- Value > 20

The above command will generate surface 23 as shown in Figure 5-71.
Establish another keypoint (label 45) at the following coordinates:

GEO > PT  
Keypoint [45] >  
X-Coordinate Value [0] >  
Y-Coordinate Value [0] > 115  
Z-Coordinate Value [0] >

The keypoint defined above will be used to describe another face of the crank shaft. Connect this keypoint with keypoint 42 by a straight line as illustrated below:

GEO > CRLINE  
Curve [68] >  
Pick/Input Keypoint 1 > 42,  
Pick/Input Keypoint 2 > 45,

Use the command SFPTCR to connect keypoint 45 with curve 65 by means of a surface.

GEO > SFPTCR  
Surface [24] >  
Pick/Input Curve > 65,  
Pick/Input Keypoint > 45,  
Underlying surface [0] >
Chapter 5  Modeling Examples

The above command will generate surface 24, forming another face of the crank shaft. Figure 5-72 shows an enlarged view of the crank shaft.

Figure 5-72. Enlarged View of the Crank Shaft

Note that there are still two faces of the crank shaft that are not defined as either surfaces or regions. One such face is bounded by curves 71-68-64-54-60-67. We can define this face as a region and regenerate it to describe the other face.

First, start by first defining the contour of the face bounded by curves 71-68-64-54-60-67 as illustrated below:

```
GEO > CT
   Contour [7] >
   Mesh flag 0=Esize 1=Num. elems [0] >
   Average element size > 1
   Number of reference boundary curves [1] > 6
   Pick/Input Curve 1 > 71,
   Pick/Input Curve 2 > 68,
   Pick/Input Curve 3 > 64,
   Pick/Input Curve 4 > 54,
   Pick/Input Curve 5 > 60,
   Pick/Input Curve 6 > 67,
   Use selection set 0=No 1=Yes [0] >
```
The above process will result in the definition of contour 7. Use the RG command and specify contour 7 as the outer contour.

GEO > RG
Region [5] >
Number of contours [1] >
Pick/Input Outer Contour > 7,
Underlying surface [0] >

You can next regenerate the region defined above to describe the last face of the crank shaft. This procedure is illustrated below. Note that this time, the region is regenerated by rotation, specifying a value of 1 for the generation flag.

GEO > RGGEN
Generation number [1] >
Pick/Input Beginning Region > 5,
Pick/Input Ending Region > 5,
Increment [1] >
Generation flag [0] > 1
X-Rotation [0] >
Y-Rotation [0] > 45
Z-Rotation [0] > 0

If you clear the screen and issue SFPLOT and RG PLOT commands, the view in Figure 5-73 will be obtained.

**Figure 5-73. Surface and Region Plot of the Crank Shaft**
All parts of the crank shaft connector are now built and all faces have been defined as either surfaces or regions. Figure 5-74 shows the geometry of the crank shaft connector constructed.

Figure 5-74. Final Geometry (Half Model)

As mentioned earlier, you need to mesh only half of the model and then use the symmetry command (**ELSYM**) to replicate the other half. This feature saves a significant amount of time as automatic mesh generation in three dimensions is computationally intensive.

In order to use the symmetry features, you must first define a coordinate axis about which the model will be duplicated. Use the command **CSYS** as illustrated below and define a coordinate system at the bottom plate of the connector.

```
GEO > CSYS
  Coordinate system [3] >
  Coordinate system type [0] >
  Pick/Input Keypoint at origin > 24,
  Pick/Input Keypoint on the X-axis > 26,
  Pick/Input Keypoint on the X-Y plane > 8,
```

If you issue the **CSPLLOT** command and specify coordinate system 3, the coordinate system defined above will be plotted as shown in Figure 5-75.
With the construction of the model geometry completed, you can now proceed to defining POLYHEDRON and PART geometric entities required for 3D automatic meshing. Clear the screen and issue **RGPLOT** or **SFPLOT** command. From the Geometry > POLYHEDRA menu tree, select the **PH** command. You will be prompted to input the reference entity, which is either a surface or a region. If you issued **RGPLOT** command above, you can input **RG** for this prompt and proceed to picking any region on the screen. The average element size is specified as 10 and this value overrides any other value defined earlier during contouring. The prompts and inputs for the **PH** command (with surface as the reference entity) are shown below:

```
GEO > PH
    Polyhedron Label [1] >
    Reference entity name SF or RG [SF] >
    Pick/Input beginning Surface > 1,
    Average element size > 10
    Tolerance [0.0001] >
    Redefine element size on boundary [1] >
```

The **PH** command defines a hollow 3D volume. Since the connector assembly is solid, you need to execute the **PART** command (from the Geometry > PART menu tree) which defines a solid volume entity. The prompts and inputs for the **PART** command are shown below:
Chapter 5  Modeling Examples

GEO > PART
   Part label [1] >
   Pick/Input Polyhedron 1 > 1,
   Pick/Input Polyhedron 2 > 1,

You can then move to the MESHING menu and select MA_PART command from the AUTO_MESH submenu. The command and its inputs are shown below:

GEO > MA_PART
   Pick/Input Beginning Part > 1,
   Pick/Input Ending Part > 1,
   Increment [1] >
   Hierarchy check flag [1] >
   Element order 0=Low 1=High [1] >
   Number of smoothing iterations [4] >

GEOSTAR will then start placing the nodes in the model, and connect each node by a 10-node tetrahedron element. Figure 5-76 shows the element mesh of the connector assembly with hidden lines removed.

To duplicate the finite element mesh about an axis of symmetry, you can first find out how many elements have been generated. Execute the command ELIST command and abort after the second prompt by hitting the ESC key. As indicated below, there will be about 809 elements generated. Note that you may not get exactly the same number of elements illustrated below:

GEO > ELIST
   Beginning Element [1] >
   Ending Element [809] >

Next, activate the coordinate system defined earlier by using command (ACTSET,CS,3). You can now proceed to using the ELSYM command as illustrated below:

GEO > ELSYM
   Beginning Element > 1
   Ending Element [1] > 809
   Increment [1] >
The reverse direction flag in the above command will make sure that every new element is created by using the opposite direction of its source, resulting in proper orientation of the mirrored elements.

Figure 5-77 shows the complete finite element mesh of the crank shaft connector with hidden lines removed. For better quality of element plots, you are recommended to use the following command:

```
GEO > BOUNDARY
   Boundary Plot 0=None 1=Face 2=Edge [1] >
   Geometry associated boundary plot flag 0=No 1=Yes [1] >
```

You will notice, however, that only half of the model is plotted. This behavior is ascribed to the value of the `BOUNDARY` command's second flag. It was chosen so that only element faces associated with boundary surfaces or regions be plotted. For three dimensional elements that are not created out of geometry (the second half of the model), you can use `EVAL_BOUND` to check all elements and identify their boundary faces similar to the association with geometric entities. The procedure is shown below:

```
GEO > EVAL_BOUND
   Boundary face evaluation flag [0] > 1
   Boundary edge evaluation flag [0] > 1
GEO > BOUNDARY,1,1,
GEO > HIDDEN;
GEO > EPLT;
```

At this point, users are advised to read about the `HIDE_OPT` command (in the Command Reference Manual) to control the algorithm used for the hidden option for better quality plots in some situations.
**Welded Angle Connection: 3D Automatic Meshing**

This example presents step-by-step procedures for building the geometry and automatically generating the 3D finite element mesh of a solid welded angle connection. The geometry in this example is much simpler when compared to the earlier examples. However, this example illustrates how you can deal with different material properties in a model.

The geometry of the model for automatic meshing is shown in Figure 5-78. The plan view, side view, front view as well as an isometric view of the model are shown along with a solid model depiction to help you visualize the model for 3D automatic meshing.

**Figure 5-78. Geometry of the Solid for Meshing**

The angle connection model consists of three different polyhedra: the horizontal plate and the vertical plate, made of the same material, and the L-shape angle made of a different type of material. As seen in Figure 5-78, the two plates have a common curve whereas the L-shaped angle and the plates have common surfaces. You need to therefore define the POLYHEDRON and PART entities separately for each part of the model and mesh them one by one. Before meshing the angle, you need to activate a different material property set in order to define the material properties of the angle.
Chapter 5   Modeling Examples

Type **STATUS1** or pull down the Control menu, select the UTILITY submenu and then the **STATUS1** command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “**PT**”, curves “**CR**”, surfaces “**SF**”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on the ON/OFF flag for **PT**, **CR** and **SF**. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to **SAVE** and click any of its buttons.

At the GEO> prompt, enter the commands **PLANE** and **VIEW** successively with default options. This will establish a working plane X-Y and it will be displayed on the screen. Turn on the grids by using the command **GRIDON** with default options. Select the REP, PIC, and SNP icons with the right button of the mouse.

In order to construct the geometry, the vertical plate and the vertical face of the angle will be first constructed. These parts will be regenerated to form the horizontal parts of the connection.

To start with, we will construct a rectangle using the **CRPCORD** command. At the GEO> prompt, type this command and establish the four corners and curves of the rectangle as illustrated below (for some of the prompts, the default values are assumed to apply if you do not see an input in bold letters: click the left mouse button once to accept default values):

```
GEO > CRPCORD
  Curve [1] >
  Digitize/Input Coordinates > 0,0,0
  Digitize/Input Coordinates > 35,0,0
  Digitize/Input Coordinates > 65,0,0
  Digitize/Input Coordinates > 100,0,0
  Digitize/Input Coordinates > 100,40,0
  Digitize/Input Coordinates > 0,40,0
  Digitize/Input Coordinates > 0,0,0
```
Repeat the **CRPCORD** command to draw another rectangle with the following coordinates:

```
GEO > CRPCORD
   Curve [7] >
   Digitize/Input Coordinates > 35,0,0
   Digitize/Input Coordinates > 35,15,0
   Digitize/Input Coordinates > 65,15,0
   Digitize/Input Coordinates > 65,0,0
   Digitize/Input Coordinates > 65,0,0
```

Figure 5-79 shows the keypoints and curves generated using **CRPCORD** command. This rectangle is used for construction of the remaining parts of the model by regeneration.

**Figure 5-79. Rectangles for Geometry Generation**

Change the plane view to a three dimensional one by using the command **VIEW** with a unit value for each of X, Y and Z coordinates. Clear the screen and issue **AXIS**; and the command **CRPLOT** to obtain a plot of curves as shown in Figure 5-80.
Curves 1 through 6 which form the boundary of the rectangular plate will be extruded next along the negative Z-axis by 5 units. The command \texttt{SFEXTR} and its inputs are shown below:

```
GEO > SFEXTR
  Pick/Input Beginning Curve > 1,
  Pick/Input Ending Curve > 6,
  Increment [1] >
  Axis symbol [Z] >
  Value > -5
```

Next, use the command \texttt{SF2CR} to construct a surface for the interior rectangle bounded by curves 7-8-9-2, as illustrated below:

```
GEO > SF2CR
  Surface [7] >
  Pick/Input Curve 1 > 2,
  Pick/Input Curve 2 > 8,
  Underlying surface [0] >
```

If you clear the screen and issue the \texttt{SFPLOT} command, the view in Figure 5-81 will be seen.
Clear the screen and issue **CRPLOT** command for curves 3 through 9. Repeat this command, and this time, plot curve 1 only. You will see a region as shown in Figure 5-82. This area needs to be defined as the first region geometric entity.

Issue the **CT** command and select three curves of the area in Figure 5-82 as reference curves, as illustrated below:
GEO > CT
  Contour [1] >
  Mesh flag 0=Esize 1=Num. elems [0] >
  Average element size > 1
  Number of reference boundary curves [1] > 3
  Pick/Input Curve 1 > 1,
  Pick/Input Curve 2 > 8,
  Pick/Input Curve 3 > 3,
  Use selection set 0=No 1=Yes [0] >

Execute the RG command to define the region entity as illustrated below:

GEO > RG
  Region [1] >
  Number of contours [1] >
  Pick/Input Outer Contour > 1,
  Underlying surface [0] >

Clear the screen and issue CRPLOT command to plot curves 10 through 22. Curves 10-13-15-17-19-21 form a rectangle as shown in Figure 5-83. This rectangle will be defined as the second region entity.

Figure 5-83. Curve Plot for Definition of Region 2

Execute the CT command as illustrated below to define a contour for the rectangle shown in Figure 5-83.
GEO > CT
   Contour [2] >
   Mesh flag 0=Esize 1=Num. elems [0] >
   Average element size > 1
   Number of reference boundary curves [1] > 6
   Pick/Input Curve 1 > 10,
   Pick/Input Curve 2 > 13,
   Pick/Input Curve 3 > 15,
   Pick/Input Curve 4 > 17,
   Pick/Input Curve 5 > 19,
   Pick/Input Curve 6 > 21,
   Use selection set 0=No 1=Yes [0] >

Next, execute the RG command to define the second region entity using contour 2 as illustrated below:

GEO > RG
   Region [2] >
   Number of contours [1] >
   Pick/Input Outer Contour > 2,
   Underlying surface [0] >

Clear the screen and issue SFPLOT command. The surfaces 1 through 7 will be plotted as shown in Figure 5-84.

**Figure 5-84. Surface Plot for Regeneration**
Chapter 5   Modeling Examples

The surfaces shown in the figure will be regenerated using the rotation option of \textit{SFGEN} command. This operation forms the horizontal plate. The illustration below shows the command and inputs for surface regeneration:

\begin{verbatim}
GEO > SFGEN
    Generation number [1] >
    Pick/Input Beginning Surface > 1,
    Pick/Input Ending Surface > 7,
    Increment [1] >
    Generation flag [0] > 1
    X-Rotation [0] > -90
    Y-Rotation [0] >
    Z-Rotation [0] >
\end{verbatim}

The new surfaces created after regeneration using \textit{SFGEN} (surfaces 8 through 14) are shown in Figure 5-85.

\textbf{Figure 5-85. Surface Plot After Regeneration}

Clear the screen and plot regions 1 and 2 using \textit{RGPLOT} command. These two regions will be regenerated using the rotation option to form the bottom plate. The \textit{RGGEN} command and its input are shown below:

\begin{verbatim}
GEO > RGGEN
    Generation number [1] >
    Pick/Input Beginning Region > 1,
    Pick/Input Ending Region > 2,
    Increment [1] >
\end{verbatim}
Chapter 5   Modeling Examples

Generation flag [0] > 1
X-Rotation [0] > -90
Y-Rotation [0] >
Z-Rotation [0] >

The new regions created after regeneration using RGGEN (regions 3 and 4) are shown in Figure 5-86.

Figure 5-86. Region Plot After Regeneration

The new surfaces created after regeneration using SFGEN (surfaces 8 through 14) and the regions created after regeneration using RGGEN (regions 3 and 4) will be flipped about the Z-axis (in the X-Y plane) to form the geometry of the welded connection.

We will first flip the surfaces using the command SFFLIP. Clear the screen and issue SFPLOT for surfaces 8 through 14. The SFFLIP command and its input are shown below:

GEO > SFFLIP
  Pick/Input Beginning Surface > 8,
  Pick/Input Ending Surface > 14,
  Increment [1] >
  Axis representing normal to plane [Z] >
  Reverse direction flag [1] >
  Offset [0] >
Figure 5-87 shows the surface plot after flipping.

**Figure 5-87. Surface Plot After Flipping**

Clear the screen and issue `RGPLOT` command for regions 3 and 4. The regions 3 and 4 are flipped using the command `RGFLIP` as illustrated below:

```
GEO > RGFLIP
   Pick/Input Beginning Region > 3,
   Pick/Input Ending Region > 4,
   Increment [1] >
   Axis representing normal to plane [Z] >
   Reverse direction flag [1] >
   Offset [0] >
```

Figure 5-88 shows the regions and new curves generated after flipping.
Clear the screen and issue a `CRPLOT` command. In order to define the points forming the cross section of the L-shaped angle, we will define a grid in a the Y-Z plane at a distance of 35 units from the origin along the X-axis, where the left end of the angle is located. Execute the `PLANE` command as illustrated below:

```
GEO > PLANE
   Axis symbol normal to the plane [Z] > X
   Value [0] > 35
   Grid line type [1] >
```

Turn on the grids on the plane defined above using the command `GRIDON`. Zoom in on the left end of the L-shaped angle where the grid plane is positioned.

```
GEO > CRPCORD
   Curve [67] >
   Digitize/Input Coordinates > 35,15,0
   Digitize/Input Coordinates > 35,15,5
   Digitize/Input Coordinates > 35,5,5
   Digitize/Input Coordinates > 35,5,15
   Digitize/Input Coordinates > 35,0,15
   Digitize/Input Coordinates > 35,0,15
```

The `CRPCORD` command executed above will establish new curves 67 through 70 in the Y-Z plane as shown in Figure 5-89. Along with existing curves 7 and 57, these new curves define the boundary of the cross section of the L-shaped angle.
Note that surfaces 7 and 14 already defined, form the bottom and back faces of the L-shaped angle. To define the remaining faces of the L-shaped angle, the cross section will be first defined as a region entity. This region will be regenerated using the RGGEN command, completing the description of the two end faces. The remaining exposed faces of the L-shaped angle can be described by extruding some of the curves forming the cross section (curves 6-68-60-70).

Use the CT command as illustrated below as a first step to define the cross section of the angle as a region entity:

```
GEO > CT
  Contour [7] >
  Mesh flag 0=Esize 1=Num. elems [0] >
  Average element size > 1
  Number of reference boundary curves [1] > 6
  Pick/Input Curve 1 > 7,
  Pick/Input Curve 2 > 67,
  Pick/Input Curve 3 > 68,
  Pick/Input Curve 4 > 69,
  Pick/Input Curve 5 > 70,
  Pick/Input Curve 6 > 57,
  Use selection set 0=No 1=Yes [0] >
  Redefinition criterion 0=Prev 1=Redef 2=Max 3=Min elements [1] >
```
Chapter 5  Modeling Examples

Next, use the RG command as illustrated below:

GEO > RG
   Region [5] >
   Number of contours [1] >
   Pick/Input Outer Contour > 7,
   Underlying surface [0] >

Next, you can use RGGEN command as illustrated below to duplicate region 5 along the X-axis to form the other end faces of the L-shaped angle.

GEO > RGGEN
   Generation number [1] >
   Pick/Input Beginning Region > 5,
   Pick/Input Ending Region > 5,
   Increment [1] >
   Generation flag [0] >
   X-Displacement [0] > 30
   Y-Displacement [0] >
   Z-Displacement [0] >

Figure 5-90. Formation of End Faces of the L-Angle

Next, you can proceed with extruding curves 67 through 70 to form the remaining exposed faces of the angle, as illustrated below:
The extrusion process leads to the definition of surfaces on the remaining exposed faces of the angle, as shown in Figure 5-91. The new surfaces formed are 15 through 18, as illustrated in the figure.

Figure 5-91. Curve and Surface Formation of L-Angle by Extrusion

The geometry description of the L-shaped angle is now complete. As mentioned earlier, the angle connection model consists of three parts: the horizontal plate and the vertical plate, made of the same material, and the L-shape angle made of a different type of material. All three parts have to be meshed separately with the same average element size in order to maintain compatibility of nodes at the common boundaries. The vertical plate will be designated as part-1, the horizontal plate as part-2, and the L-shape angle as part-3.

To proceed with the meshing of the vertical plate, you need to first identify the surfaces and regions bounding part-1, and place them in the selection list for polyhedron definition. Placing the bounding surfaces and regions in the selection list ensures that only those entities placed in this list will be considered when you
execute \textbf{PH} command. After completing the part definition, you can issue the meshing command \textbf{MA\_PART} to develop the finite element mesh of the plate.

Surfaces 1 through 7 and regions 1 and 2 describe all faces of the vertical plate. Clear the screen and issue \textbf{SF\_PLO\_T} for surfaces 1 through 7 and \textbf{RG\_PLO\_T} for regions 1 and 2. You will see all bounding faces of part-1 displayed on the screen as shown in Figure 5-92.

\textbf{Figure 5-92. Surfaces and Regions for Part-1}

To place the surfaces and regions of part-1 in the selection list, execute the \textbf{INIT\_SEL} command as illustrated below, once for surfaces, and again for regions:

\begin{verbatim}
GEO > INIT\_SEL
Entity Name [EL] > SF
Initialization flag 1=YES,-1=CMPLMNT [1] > 1
Selection set number 0=All n=Set number [1] >

GEO > INIT\_SEL
Entity Name [EL] > RG
Initialization flag 1=YES,-1=CMPLMNT [1] > 1
Selection set number 0=All n=Set number [1] >
\end{verbatim}

Next, issue the \textbf{SEL\_INP} command once for surfaces 1 through 7, and again for regions 1 and 2, as illustrated below:
To confirm the placement of entities in the selection list, you can issue `RGPLOT` and `SFPLLOT` commands. You will notice that the surfaces and regions plotted are same as those shown in Figure 5-92.

You can now proceed to defining the polyhedron for part 1 using the `PH` command as illustrated below (the average element size of 10 is specified in this command). It should be noted that you don't have to apply the same element size value for all parts in order to maintain node compatibility. In case you use different element sizes for two parts, the mesh size of the common region follows the firstborn meshed part. Compatibility is not achieved if the two parts have a common surface (not a region). However, you can change a surface into a region using the `SFRG` command. The polyhedra and parts are automatically upgraded to consider this region-to-surface transformation.

The `PART` command for this polyhedron is defined as illustrated below:
You can next proceed to placing the bounding surface entities of part-2. Surfaces 8 through 14, and regions 3 and 4 describe all faces of the horizontal plate. To place the surfaces and regions of part-2 in the selection list, execute the `INITSEL` command as illustrated earlier, once for surfaces, and again for regions. Clear the screen and issue `SFPLOT` for surfaces 8 through 14 and `RGPLOT` for regions 3 and 4. You will see all bounding faces of part-2 displayed on the screen as shown in Figure 5-93.

**Figure 5-93. Surfaces and Regions for Part-2**

```
Next, execute the `SELINP` command for surfaces and regions as illustrated below:

GEO > SELINP
Entity Name [EL] > SF
Pick/Input Beginning Entity > 8
Pick/Input Ending Entity [8] > 14
Increment [1] > 1
Selection set number [1] >

GEO > SELINP
Entity Name [EL] > RG
Pick/Input Beginning Entity > 3
Pick/Input Ending Entity [3] > 4
Increment [1] > 1
Selection set number [1] >
```

You can now proceed to defining the polyhedron for part-2 using the `PH` command as illustrated below (as in part 1, the average element size of 10 is specified in this command):
Chapter 5  Modeling Examples

GEO > PH
   Polyhedron Label [2] >
   Reference entity name SF or RG [SF] >
   Pick/Input beginning Surface > 14,
   Average element size > 10
   Tolerance [0.001] >
   Redefine element size on boundary [1] >

The Part command for this polyhedron is defined as illustrated below:

GEO > PART
   Part label [2] >
   Pick/Input Polyhedron 1 > 2
   Pick/Input Polyhedron 2 > 2

You can next proceed to placing the bounding surface entities of part-3. Surface 7 as well as surfaces 14 through 18, and regions 5 and 6 describe all faces of the horizontal plate. To place the surfaces and regions of part-3 in the selection list, execute the INITSEL command as illustrated earlier, once for surfaces, and again for regions. Clear the screen and issue SFPLLOT for surfaces 7, 14 through 18, and RGPLOT for regions 5 and 6. You will see all bounding faces of part-3 displayed on the screen as shown in Figure 5-94.

Figure 5-94. Surfaces and Regions for Part-3

Next, execute the SELINP command for surfaces and regions as illustrated below:
Repeat the \texttt{SELINP} command separately for surface 7 and proceed to defining the polyhedron for part-3 using the \texttt{PH} command as illustrated below:

\texttt{GEO > PH}

Polyhedron Label [3] >
Reference entity name SF or RG [SF] >
Pick/Input beginning Surface > 14,
Average element size > 10
Tolerance [0.001] >
Redefine element size on boundary [1] >

The \texttt{PART} command for this polyhedron is defined as illustrated below:

\texttt{GEO > PART}

Part label [3] >
Pick/Input Polyhedron 1 > 3
Pick/Input Polyhedron 2 > 3

You can now issue the meshing commands separately for parts 1, 2, and 3. Use the command \texttt{MA_PART} for the vertical plate as illustrated below:

\texttt{GEO > MA_PART}

Pick/Input Beginning Part > 1
Pick/Input Ending Part [1] > 1
Increment [1] >
Hierarchy check flag [1] >
Element order 0=Low 1=High [1] >
Number of smoothing iterations [4] >
Repeat the command **MA_PART** for the second part. By default, **PART1** and **PART2** will be meshed with material property set number 1. Before proceeding to **PART3** (angle), you therefore need to activate a different material set number, using **ACTSET** command as illustrated below:

```
GEO > ACTSET
  Set Label > MP
  Material set number [1] > 2
```

You can next issue the **MA_PART** command to mesh the last part, the angle.

The finite element mesh (with hidden lines removed) of the angle connection is shown in Figure 5-95. You can use **ELIST** command to make sure that the elements have been generated with proper material set numbers.

**Figure 5-95. Generated Finite Element Mesh**

Since the welded angle connection has multiple PARTs, the nodes and elements are generated independently for each PART. Therefore, you must merge nodes using the **NMERGE** command before applying loads and boundary conditions. Merging of nodes is necessary in order to maintain the compatibility of displacements between the angle and the plates.
Chapter 5  Modeling Examples

Example on Selection Lists, Element Coloring
and Element Property Changing

Because of the importance and perhaps the complexity of this utility, a detailed description is given in this example. The SELECT submenu in the Control menu provides commands to initialize, add to or remove from a selection list for a particular entity. A number of convenient commands are provided for adding to and removing from selection lists including selection by specifying labels, picking by the mouse, using windows, using another reference entity or element properties. An active selection list causes denial of access to members of the entity that are not on the list. Multiple selection lists are available for each entity type at any time. The utility can be extremely useful in many situations because whenever a selection list is active for a particular entity, GEOSTAR will only process the members of this entity that are in the selection list and will ignore all others. The utility should be used with care because the program reaction could depend on the status of the selection lists. The STATUS3 command shows the status of the selection lists which can be changed using the mouse. The user should initialize or deactivate the selection list once the purpose for which it was created is achieved. A reminder message is issued whenever an entity with an active selection list is listed.

As a conceptual Example, imagine a 1000-node finite element model in which you are required to apply a nodal temperature of 100 degrees to all nodes which fall in between X-coordinates of 1.0 and 1.1. To all other nodes, you are required to apply a nodal temperature of 20 degrees. One way to perform the above mentioned task is as follows:

a. Initiate a selection list for all nodes which fall into the X-coordinate range of 1.0 to 1.1, using the SELRANGE command.

GEO > SELRANGE
   Entity Name [EL] > ND
   Coordinate system (0) >
   Coordinate activation flag for X [1] >
   Coordinate activation flag for Y [1] > 0
   Coordinate activation flag for Z [1] > 0
   X Coordinate lower range [0] > 1.0
   X Coordinate higher range [100] > 1.10
   Selection set number [1] >
Chapter 5  Modeling Examples

At this point GEOSTAR recognizes and will only process the nodes that are in the selection list. Issue the NLIST or the NPLOT command to see that all other nodes that do not satisfy the above criterion are filtered out. The STATUS3 table will show an active selection list for nodes under the ND labeled column for set number 1.

b. Next you need to apply a temperature of 100 degrees to all nodes of the model, but since the node selection list is active, nodal temperatures will be only applied to the nodes in the selection list (those nodes in the X-coordinate range, 1.0 to 1.1).

   GEO > NTND
   Beginning Node > 1
   Value > 100.0
   Ending Node [1] > 1000
   Increment [1] >

c. You need to then use the INITSEL command to remove all the nodes that are currently on the list and replace them by all the nodes that are not currently on the list.

   GEO > INITSEL
   Entity Name [EL] > ND
   Initialization flag 1=YES, -1=CMPLMNT [1] > -1
   Selection set number 0=All n=Set number [1] >

   The NLIST lists command at this point lists nodes that do not satisfy the original criterion.

d. You can now apply a temperature of 20 degrees to all nodes, but since the node selection list is active, nodal temperatures will be only applied to the nodes in the selection list, i.e. all nodes whose X-coordinate is outside the specified range.

   GEO > NTND
   Beginning Node > 1
   Value > 20.0
   Ending Node [1] > 1000
   Increment [1] >

e. Now you need to deactivate the node selection list and regain access to all nodes in the model.
Chapter 5  Modeling Examples

Another way to perform the same task is as follows:

1. Repeat the two commands used before in steps (a) and (b).

2. Instead of INITSEL you can use the following command:

   GEO > SELSETOP
   Target Selection set number [1] > 2
   Entity Name [EL] > ND
   Set operation 0=C 1=U 2=I 3=FD 4=BD [0] >
   Source selection set number > 1

   For the set operation type we chose (0) which refers to finding the complement of an existing set similar to the initialization flag (-1) in the INITSEL command. But with this SELSETOP command you have the option to store the complement of set 1 in another set number as compared to INITSEL where you have to replace set number 1 by its complement.

3. Type STATUS3. A table will be displayed in which up to 10 selection list represented by the first column under SET, are controlled. Ten different entities can be considered including keypoints, curves, surfaces, volumes, contours, regions, polyhedra, parts, nodes and elements. You will notice that the second set is highlighted (the active set) with a red frame surrounding all the entities. Only one set can be active at a time. You can see that nodes (ND) for sets 1 and 2 are ON but only set 2 is active. Place the mouse cursor on the first set and press any of the mouse buttons. With set 1 highlighted, move the cursor to the SAVE box and click one of the buttons. Now you are back to the dialog box. Type STATUS3. You will notice that set number 1 is the active set now. Activate the second set as shown before for set 1. Save the changes.

4. Apply a temperature of 20 degrees to the nodes in set 2 (the active set) as shown in step (d).

5. In order to deactivate the node selection list you can use the INITSEL command as shown in step (c) but with slight modification:
Chapter 5  Modeling Examples

GEO > INITSEL
Entity Name [EL] > ND
Initialization flag 1=YES, -1=COMPLMNT [1] >
Selection set number 0=All n=Set number [1] > 1

Type STATUS3. You will see that nodes of set 1 changed from ON to X. This means that there are no nodes defined in the first selection set anymore. However, set number 2 is active and includes nodes in it. To initialize the second set, let's try a different approach. Move the mouse cursor to the ON flag and click any of the mouse buttons. You will notice that ON changes to “-”. Press the mouse button one more time to change “-” to OFF. The OFF flag means that the selection is not active but you can change it to ON anytime later without performing the selection procedure shown in steps (a), (b) and (2). However, if “-” is chosen instead, the set will be initialized and in case you need to use these selected nodes you have to repeat steps (a), (b) and (2). Let's choose OFF and use the ABORT icon to save the changes. Type STATUS3. You will notice that the nodes (ND) flag is still OFF. Change OFF to “_” and save. Type STATUS3 one more time. You will see that the flag in the ND column for set number 2 is now initialized to X.

A detailed example which elaborates on the above procedure is discussed next. The example is designed to illustrate the following features:

- Element Coloring
- Selection Lists
- Element Property Changing

The example uses 3 surfaces, 2 material property sets, 2 element groups and 3 real constant sets to demonstrate the above features. The user is encouraged to actually run the problem and spend some time to examine the effect of each command.

PLANE,Z,0,1,
   Define an X-Y plane at z=0

VIEW,0,0,1,0,
   Set the screen view to the X-Y plane

EGROUP,1,SHELL4;
   Define element group 1 as SHELL4 element with default options

MPROP,1,EX,30000000.0;
   Define EX for material property set 1


Chapter 5  Modeling Examples

MPROP,2,EX,10000000.0;
RCONST,1,1,1,1,1.0,

Define thickness for real constant set 1

RCONST,1,2,1,1,2.0,
RCONST,1,3,1,1,3.0,

SF4CORD,1,0,100,0,100,100, 0,100,65,0,0,65,0,
SF4CORD,2,0,65,0,100,65,0, 100,30,0,0,30,0,
SF4CORD,3,0,30,0,100,30,0,100,0,0,0,0,0,

Create surfaces 1, 2 and 3. In a session file, "_" is used for continuing command input in the next line. You don't use "&" for interactive input

ACTSET,MP,1,

Activate material property set 1

ACTSET,RC,1,

Activate real constant set 1

M_SF,1,1,1,4,6,3,1,0,1.0,

Use parametric meshing to mesh surface 1. The generated elements are associated with element group 1, material property set 1 and real constant set 1

ACTSET,MP,2,

Activate material property set 2

ACTSET,RC,2,

Activate real constant set 2

M_SF,2,2,1,4,6,3,1,0,1.0,

Mesh surface 1. The generated elements are associated with element group 1, material property set 2 and real constant set 2

ACTSET,RC,3,

Activate real constant set 3

M_SF,3,3,1,4,6,3,1,0,1.0,

Mesh surface 3. The generated elements are associated with element group 1, material property set 2 and real constant set 3
Chapter 5  Modeling Examples

NMERGE;
   Merge all coinciding nodes

NCOMPRESS;
   Compress nodes to remove gaps in node numbering

SHRINK,0.15,
   Specify 15% element shrinking for future element plots

ACTNUM,EL,1,
   Activate element numbering. (You can use STATUS1 command instead)

Element coloring is a convenient tool to view elements according to their association with element groups, material property sets, or real constant sets. Default colors can be used, or the user can specify other colors using the ECLRSET command. The following commands demonstrate the use of the element coloring feature.

SHADE;
   Activates shading for element plots

ACTECLR,1,EG,1,
   Activate default element colors with respect to element groups. Elements belonging to the same element group will be plotted in the same default color after repainting. Since all the elements are associated with group 1, one color is used to draw all elements.

REPAINT;
   Repaint the window

ACTECLR,1,MP,1,
   Activate default element colors with respect to material property sets. Elements associated with the same material property set will be plotted in the same default color after repainting. Elements of surfaces 2 and 3 will be plotted in the same color since they are associated with the same material property set. A different color is assigned to elements of surface 1.

REPAINT;
   Repaint the window
Chapter 5  Modeling Examples

Figure 5-96.  A Plot of Shrunk Elements, Element Coloring is Active with Respect to Real Constants

ACTECLR,1,RC,1,

Activate default element colors with respect to real constant sets. Elements associated with the same real constant set will be plotted in the same default color after repainting. Elements of each surface will be plotted in a different default color since each surface has a different thickness.

REPAINT;

Repaint the window

ACTECLR,0,

Deactivate default element color flag. All elements will be plotted in the default STATUS1 color after repaint.

REPAINT;

Repaint the window

MPROP,3,EX,2E7;

Define EX for material property 3

Selection lists are controlled by commands in the CONTROL-SELECT submenu. Selection lists can also be activated or deactivated using the STATUS3 command. The SELWIN command shows in the session file as equivalent SELINP commands,
since the selected list depend on the current plot on the active window. The following commands demonstrate the use of selection lists.

INITSEL, EL, 1, 1,
    
    Initialize element selection list. Initialization is always recommended unless adding to the present list is desired. This statement nullifies the element selection list

ACTNUM, EL, 1,
    
    Activate the plotting of element numbers

REPAINT;
    
    Repaint the window

SELINP, EL, 21,39,6;
    
    Elements are selected by specifying a pattern. Elements 21, 27, 33 and 39 are selected and saved in the element selection list

CLS;
    
    Clear the screen

EPLOT;
    
    At this point, the program only recognizes elements in the selection list and this command will result in plotting elements 21, 27, 33 and 39 only

Changing element properties, like changing the element association with an element group, material property set or real constant set can be conveniently carried out by selecting the desired elements and issuing the EPROPCHANGE command.

EPROPCHANGE, 1,54,1,MP,3,5,
    
    Material property set 3 and color 5 are assigned to all elements saved in the element selection list and are numbered 1 through 54. Namely elements 21, 21, 27, 33 and 39

ACTECLR,1,MP,1,
    
    Activate default element colors with respect to material property sets

REPAINT;
    
    Repaint the window

ACTECLR,1,RC,1,
    
    Activate default element colors with respect to real constant sets
Chapter 5   Modeling Examples

ACTNUM,EL,0,
   Deactivate plotting of element numbers (You can use STATUS1 command instead)

REPAINT; Repaint the window

INITSEL,EL,1,1,
   Initialize element selection list

SELPIC,EL,1,25,49,52,54,0,
   Elements are picked one by one, 1, 25, 49, 52, 54, from the plotted elements in the window. The picked elements are saved in the element selection list. "0" terminates the selection of elements

ECLRSET,1,1,1,RC,9,
   Assign color 9 to all elements associated with real constant set 1. This overrides the default colors used by the ACTECLR command

CLS;

EPLOT;
   Plot active elements. (Only elements 25, 49, 52 and 54 are active)

INITSEL,EL,1,1,
   Initialize element selection list

EPLOT;
   Plot active elements (all elements are active now)

DCR,1,All,0.0,1,1,
   Fix all nodes associated with curve 1 (i.e., zero displacement boundary conditions)

CLS;
   Clear the window

INITSEL,ND,1,1,
   Initialize node selection list

ACTNUM,ND,1,
   Activate node number plotting (you can use STATUS1 command instead)
Chapter 5  Modeling Examples

AXIS,0;

NPL0T;

*Plot all nodes (see Figure 5-97)*

**Figure 5-97. A Plot of All Nodes with Active Node Numbering**

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>30</td>
<td>31</td>
<td>32</td>
<td>33</td>
<td>34</td>
<td>35</td>
</tr>
<tr>
<td>36</td>
<td>37</td>
<td>38</td>
<td>39</td>
<td>40</td>
<td>41</td>
<td>42</td>
</tr>
<tr>
<td>43</td>
<td>44</td>
<td>45</td>
<td>46</td>
<td>47</td>
<td>48</td>
<td>49</td>
</tr>
<tr>
<td>50</td>
<td>51</td>
<td>52</td>
<td>53</td>
<td>54</td>
<td>55</td>
<td>56</td>
</tr>
<tr>
<td>57</td>
<td>58</td>
<td>59</td>
<td>60</td>
<td>61</td>
<td>62</td>
<td>63</td>
</tr>
<tr>
<td>64</td>
<td>65</td>
<td>66</td>
<td>67</td>
<td>68</td>
<td>69</td>
<td>70</td>
</tr>
<tr>
<td>71</td>
<td>72</td>
<td>73</td>
<td>74</td>
<td>75</td>
<td>76</td>
<td>77</td>
</tr>
<tr>
<td>78</td>
<td>79</td>
<td>80</td>
<td>81</td>
<td>82</td>
<td>83</td>
<td>84</td>
</tr>
</tbody>
</table>

SELNIP,ND,22,50,7,1,

*Nodes are selected by specifying a pattern. Nodes 22, 29, 36, 43 and 50 are selected and saved in the node selection list (set number 1)*

DND,1,UX,0.0,70,1,UY;

*Assign zero displacements in the X- and Y-directions for all nodes numbered 1 through 70 that are in the selection list. In this case only nodes 22, 29, 36, 43 and 50 are considered*

INITSEL,ND,1,1,

*Initialize the first set of the node selection list*

SELPIC,ND,32,35,54,67,70,0,

*Pick nodes from the nodes plotted in the window and save them in the first set of the node selection list*

FND,1,FX,100.0,70,1,

*Specify 100 unit force in the X-direction for nodes numbered 1 through 70 that are presently in the active selection list*
Chapter 5  Modeling Examples

INITSEL,ND,1,1,

Initialize the active node selection list

CLS;

Clear the window

CRPLOT;

Plot all curves

INITSEL,EL,1,1

EPLOT;

All elements are plotted since the element selection list was initialized

SELREF,EL,CR,7,7,1,1,

Elements associated with curve 7 are selected and saved in the element selection list

CLS;

CRPLOT,7,7,1

Plot curve 7

EPLOT;

Plot elements in the active selection list (only elements associated with curve 7)

EGROUP,2,SHELL4T;

Define element group 2 as 4-node thick shell element with default options

EPROPCHANGE,1,54,1,EG,2,10,

Element group 2 and color 10 are assigned to all elements saved in the element selection list

CLS;

EPLOT;

Plot all elements

ACTECLR,0,

Activate the default element color

REPAINT,

Repaint the window
Chapter 5  Modeling Examples

INITSEL,EL,1,1,
    Initialize element selection list

EPLLOT;

INITSEL,ND,1,1,
    Initialize node selection list

SELRFF,EL,ND,18,18,1,0,
    All elements connected to node 18 are selected and saved in the ele-
    ment
    selection list

EPLLOT;

ACTNUM,ND,0,
    Deactivate node number plotting

VIEW,1,1,1,0,
    Set an isometric view

SCALE;
    Scale to the window size

PEL,1,100.0,5,54,1,3,
    Specify a pressure of 100 units in the Z-direction on elements saved in
    the active element selection list (elements connected to node 18)

VIEW,0,0,1,0,
    Specify X-Y plane view

ELIST;
    List all elements

SELRFINP,EL,1,36,7,2,
    Elements are selected by specifying a pattern. Elements 1, 8, 15, 22,
    29 and 36 are selected and stored in set number 2

ELIST;
    Elements stored in set 2 will be listed

EPROCHANGE,1,54,1,MP,3,5,
    Change the present association of elements 1 through 54 that are
    saved in the active element selection list (set number 2), so that they
    are associated with material property set 3 and color
Chapter 5   Modeling Examples

CLS;

EPLOT;

QEL,1,30.0,54,1,

Specify element heat generation of 30 units for elements 1 through 54 that are currently saved in the active element selection list, namely elements 1, 8, 15, 22, 29 and 36

AXIS,0;

Deactivate axis plotting

VIEW,1,2,3,0,

Change the view

STATUS3

Set number 2 is active. Notice that the elements selection flag is ON for the first and second sets

Activate the first selection set and save the change.

CLS;

EPLOT;

Plot elements in the active selection list (set number 1)

STATUS3

Set number 1 is active. Notice that the elements selection flag is still ON for set 1 and set 2

Deactivate the first selection set by changing the elements selection flag from ON to OFF and save.

CLS;

EPLOT;

Plot all elements

STATUS3

Set number 1 is active but OFF

Change the OFF flag to ON and save.

CLS;
Chapter 5 Modeling Examples

EPLOT;
  *Plot elements in selection set number 1*

STATUS3
  *Set number 1 is active and ON*

Change the ON flag for the first set to “-” and save.

CLS;

EPLOT;
  *Plot all elements*

STATUS3
  *For set number 1, element selection flag shows an X. The elements stored before in this set (connected to node 18) cannot be retrieved unless the SELREF command is used one more time*

Activate the second set and save this change.

CLS;

EPLOT;
  *Plot elements in the active selection list (set number 2)*

STATUS3
  *Set number 2 is active and ON*

Change the ON flag to “-” and save.

CLS;

EPLOT;
  *Plot all elements*

STATUS3
  *All selection sets are initialized*

Press the ESC key to exit from the STATUS3 table.
Chapter 5  Modeling Examples

Example on Using Parametric Variables

The COSMOS/M command language offers a wide range of capabilities starting from simple tasks such as calculating the square root of a number to more complicated tasks such as designing your own command. This example deals with the use of parametric variables which is one feature out of the numerous and powerful COSMOS/M language commands. Appendix E includes more information about the language.

One of the purposes of the PARAMETRIC commands is to give the user the flexibility to change the dimensions, material properties, finite element mesh and other parameters by using simple commands (such as PARASSIGN) in the session file and resubmitting the job. It should be noted that parametric input is accepted by all GEOSTAR commands in place of numeric values.

Let's consider a rectangular plate with a hole at its center. A rectangular area around the hole, is designed to be thicker than the rest of the plate. The dimensions of the thicker part is to be specified as ratios of the external dimensions of the plate. The plate is subjected to pressures in the X and Y directions. Several materials are to be tested.

Sketch the model and assign variable names to the geometric quantities that are to be varied. The parameter names are not case sensitive. Numeric values have to be given to unchanged quantities. The following variables, as shown in Figure 5-98, are used:

A: dimension of the plate in the X-direction.
B: dimension of the plate in the Y-direction.
C: dimension of the thicker part of the plate in the X-direction (to be specified as a ratio of A).
D: dimension of the thicker part of the plate in the Y-direction (to be specified as a ratio of B).
R: radius of the hole.
Assign numeric values to create the first model:

```
PARASSIGN,A,REAL,50,
    Assign a numeric value for A

PARASSIGN,B,REAL,35,
    Assign a numeric value for B

PARASSIGN,C,REAL,0.4*A,
    Define C as a ratio of A

PARASSIGN,D,REAL,0.4*B,
    Define D as a ratio of B

PARASSIGN,R,REAL,80.0,
    Assign a numeric value for R

PARASSIGN,R,REAL,8.0,
    Redefine R. R assumes the most recent value of (8.0)

PARASSIGN,RADIUS,REAL,10.0,
    Define an extra variable and delete it only to show the use of the command

PARDEL,RADIUS,
```
Chapter 5   Modeling Examples

At this point the **PARLIST** command results in the following list on the screen:

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>Real</td>
<td>50.00000</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>Real</td>
<td>25.00000</td>
</tr>
<tr>
<td>3</td>
<td>C</td>
<td>Real</td>
<td>20.00000</td>
</tr>
<tr>
<td>4</td>
<td>D</td>
<td>Real</td>
<td>14.00000</td>
</tr>
<tr>
<td>5</td>
<td>R</td>
<td>Real</td>
<td>8.00000</td>
</tr>
</tbody>
</table>

It should be noted that if a session file has a list command and is read through the **FILE** command, the list will be displayed on the screen until the user hits the space bar, any other key, or clicks the mouse.

Use the defined variables to generate the required entities as shown below:

- **PT,1,0,0,0,0,0,**  
  *Define lower left corner of the plate*

- **PTGEN,1,1,1,0,2.0*B,0,**  
  *Define upper left corner*

- **PTGEN,1,1,2,1,0,2.0*A,0,0,**  
  *Define the two other corners*

- **PLANE,Z,0,1,**  
  *Define the plane of the plate*

- **VIEW,0,0,1,0,**  
  *Set view to X-Y plane*

- **CRPLINE,1,1,2,4,3,1,**  
  *Connect the corners of the plate*

- **PT,5,A,B,0,**  
  *Create a keypoint at the center*

- **PT,6,A-C,B-D,0,**  
  *Define the corners of the thicker region*

- **PTGEN,1,6,6,1,0,2.0*D,0,**  
  **PTGEN,1,6,7,1,0,2.0*C,0,0,**
Plan a strategy for the generation of the finite element mesh including the generation of additional geometric entities like contours, surfaces, and regions. The strategy for this example is to define 3 contours and two regions. The first contour is defined by the outer edges of the plate, the second contour is defined by the outer edges of the thicker part of the plate, and the third is defined by the edges of the hole. The first region is the area enclosed between the first and the second contours, and the second region is the area enclosed between the second and the third contours. The same number of elements is to be used for all the contours to have a finer mesh around the hole. The variable \( \text{NEL} \) is used to allow changing this number through the \text{PARASSIGN} command. The following commands are used to perform the mesh generation:

\[
\begin{align*}
\text{PARASSIGN, NEL, INT, 44,} \\
& \text{Assign an integer value for the approximate number of elements to be used for each of the 3 contours} \\
\text{CT, 1, 1, NEL, 1, 1, 0,} \\
& \text{Define the first contour as the outer boundary of the plate} \\
\text{CT, 2, 1, NEL, 1, 5, 0,} \\
& \text{Define the second contour as the outer boundary of the thicker region} \\
\text{CT, 3, 1, NEL, 1, 10, 0,} \\
& \text{Define the third contour as the boundary of the circular hole} \\
\text{RG, 1, 2, 1, 2, 0,} \\
& \text{Define the first region between contours 1 and 2} \\
\text{RG, 2, 2, 2, 3, 0,} \\
& \text{Define the second region between contours 2 and 3}
\end{align*}
\]

Determine the required material properties and real constant sets and assign variable names to them, if different materials or real constant sets are to be used:

- \( E \): for \( EX \) and \( EY \) of the material.
- \( NU \): for \( NUXY \) of the material.
- \( T1 \): thickness of the plate in region 1.
- \( T2 \): thickness of the plate in region 2.
Chapter 5  Modeling Examples

PARASSIGN,E,REAL,30.0E6,

Assign a numeric value for E

PARASSIGN,NU,REAL,0.30,

Assign a numeric value for NU

MPROP,1,EX,E;

Define some material properties

MPROP,1,EY,E;

MPROP,1,NUXY,NU;

PARASSIGN,T1,REAL,1.0,

Assign a numeric value for T1

PARASSIGN,T2,REAL,1.5,

Assign a numeric value for T2

RCONST,1,1,1,1,T1,

Define real constant set 1

RCONST,1,2,1,1,T2,

Define real constant set 2

Generate the finite element mesh shown in Figure 5-99 by meshing the two regions:

MA_RG,2,2,1,0,0,

Mesh the second region. Note that real constant set number 2 is the active one. The active real and material sets are the most recently defined so that region 2 is meshed while associated with real constant set 2, defining the thickness T2

ACTSET,RC,1,

Activate the first real constant set

MA_RG,1,1,1,0,0,

Mesh the first region. The first real constant set is activated before meshing region 1 to associate it with real constant set 1, defining the thickness T1

Define pressures in the X and Y directions:
Chapter 5  Modeling Examples

PARASSIGN,PX,REAL,10.0,
    Assign a value for PY

PARASSIGN,PY,REAL,-5.0,
    Assign a value for PY

PCR,1, PX, 3, 2;
    Define a pressure PX along the vertical edges of the plate. Positive pressure, defined by the PCR command points toward the element. In this case, PX is compressive

PCR,2, PY, 4, 2;
    Define a pressure PY along the horizontal edges of the plate. PY is tensile as shown in Figure 5-99

![Figure 5-99. Finite Element Mesh of the Model](image)

After adding the necessary commands to specify the desired boundary conditions and type of analysis, the session file can be copied and edited by any text editor to change the values assigned by the PARASSIGN command before reading it into GEOSTAR through the FILE command. Note that if pressure PX is to be changed to zero, a very small value (e.g., 1.E-16) must be specified since (0.0) is not accepted by the program. As an example, let us make the following changes:
### Chapter 5  Modeling Examples

<table>
<thead>
<tr>
<th>Required Changes</th>
<th>Commands in the Existing Session File</th>
<th>New Commands in the New Session File</th>
</tr>
</thead>
<tbody>
<tr>
<td>C = 0.8A</td>
<td>PARASSIGN, C, REAL, 0.4&quot;A,</td>
<td>PARASSIGN, C, REAL, 0.8&quot;A,</td>
</tr>
<tr>
<td>R = 10</td>
<td>PARASSIGN, R, REAL, 8,</td>
<td>PARASSIGN, R, REAL, 10,</td>
</tr>
<tr>
<td>NEL = 40</td>
<td>PARASSIGN, NEL, INT, 44,</td>
<td>PARASSIGN, NEL, INT, 40,</td>
</tr>
<tr>
<td>PX = 20</td>
<td>PARASSIGN, PX, REAL, 10,</td>
<td>PARASSIGN, PX, REAL, 20,</td>
</tr>
<tr>
<td>PY = 0</td>
<td>PARASSIGN, PY, REAL, -5,</td>
<td>PARASSIGN, PY, REAL, 1E-16,</td>
</tr>
</tbody>
</table>

Figure 5-100 shows the resulting model.

**Figure 5-100.** Finite Element Mesh of the Model after Assigning New Values to Some Parameters
Analysis Examples

Introduction

This chapter presents examples on the use of GEOSTAR for creation, analysis and post-processing of several FEA problems. Except for the first example, most of the commands used to create these example problems should be typed after GEO > prompt in the console window. Read the on-line help to find out how to issue the same commands by using the Geo Panel. The presented material should be sufficient to help the user fully understand the procedure to calculate displacements and stresses for static problems, perform natural frequency and mode shape calculations, and obtain critical load buckling loads. These examples are:

List of Analysis Examples

The Extruded Spline Model. See page 3
Buckling of a Beam. See page 14
Natural Frequencies of a Ring. See page 17
Beam Loading and Generation of Shear and Moment Diagrams. See page 19
Stress Output for 3D Beam Elements. See page 22
Substructuring in Linear Static Analysis. See page 25

For more detailed examples on linear static analysis and calculations of natural frequencies and buckling loads, refer to Basic System Guide. For detailed examples on other types of analyses, refer to the Advanced Modules Manual.
Chapter 6  Analysis Examples

In addition, COSMOS/M package includes input files for many verification problems. As explained before in Chapter 5, the session files for these analysis problems can be obtained from the subdirectory, Vprobs, installed in the COSMOS/M directory. The problems are classified according to the type of analysis by assigning a prefix letter, as listed below:

B  Linear Buckling
D  Linear Dynamic
EM Electromagnetic
F  Frequency (normal modes)
FS  Steady State Fluid Flow
FT  Transient Fluid Flow
FTG  Fatigue
ND  Nonlinear Dynamic
NS  Nonlinear Static
O  Optimization
S  Linear Static
TL  Linear Thermal (heat transfer)
TN  Nonlinear Thermal (heat transfer)

In order to use these examples, move to your work directory and copy any file (for example, S1.GEO) from the Vprobs directory created as explained before in Chapter 5. At the system level, enter the command GEOSTAR (or double click on the “GEOSTAR” icon on Windows platforms), and furnish a problem name. Issue the FILE (File > Load) command, and type in the input file name as S1.GEO. Accept the default parameters for the remaining prompts as shown below:

Geo Panel:  Geometry > FILE > Load
Input file name:  S1.GEO
Accept defaults for all other options

You will notice that the finite element model will be simultaneously constructed and displayed on the screen as the input file is read into GEOSTAR. You may need to issue Scale and View commands to rescale and properly view the model in the display area. For those example files which have analysis commands (all files except those starting with letter G), you will see the execution of finite element analysis immediately after the input file is read. If you do not want this to happen, edit the example file and remove the analysis commands.
Chapter 6  Analysis Examples

**The Extruded Spline Model**

Figure 6.1 shows the geometry of the model in three dimensional space for finite element modeling and analysis. It consists of a curved shell structure fixed along three edges and subjected to pressure loading which is normal to the curved surface. Since there is no variation of curvature along the Z axis, the curved shell geometry can be easily constructed by defining a spline in the X-Y plane and extruding it in the Z direction as required. GEOSTAR provides you with various capabilities to extrude, sweep, translate, and rotate various geometric entities so that you can construct more complicated surfaces and volumes from primitives.

![Figure 6-1. Geometry of the Spline Model](image)

For this model, we will first establish a working plane. This plane will be normal to the Z axis which passes through the origin. A plane can be defined as follows:

**Geo Panel:**  Geometry > GRID > Plane
Accept the default values

Next, we will create a grid on the plane defined above. The grid is necessary for snapping to points on the grid when defining points. Accepting the default values will result in a grid with five increments along the X and Y axes for a total of 20 increments along each axis. The grid will be positioned with its lower left corner at the origin. The grid can be created as follows:
Chapter 6  Analysis Examples

Geo Panel:  Geometry > GRID > Grid On
Accept the default values

You will notice a grid as shown in Figure 6-2 displayed on the screen.

By default, GEOSTAR does not write the labels of entities. For this example writing labels of keypoints, curves and surfaces will be activated.

Click on Status1 button at the bottom of the Control Panel. Use the mouse to toggle LABL for points (PT), curves (CR), and surfaces (SF) to ON, move the mouse arrow to SAVE and click the mouse.

Figure 6-2. 3D View of the Grid in the X-Y Plane

From the Geometry menu, select the POINTS submenu and click the left button on the Define command. Enter the default keypoint label of 1. Help may also be obtained by clicking on the Help button. When you move the mouse, the numerical values of the point nearest to the grid will be displayed in the dialog box. Move the mouse till you see the coordinates of the first point at (50,0,0) and click the left button to establish this point. The procedure to define keypoint 1 is summarized as follows:

Geo Panel:  Geometry > POINTS > Define
Keypoint number: 1
X-Y-Z-coordinate value: 50,0,0
Click on the “OK” button

You may snap to grid points or edit the input to specify any coordinates.

Repeat the same procedure to establish the following coordinates for keypoints 2, 3, and 4 respectively:
Next, you need to create a spline which passes through the keypoints defined above. From the Geometry > CURVES > SPLINES menu, select Spline Curve. Accept the default curve label of 1 and the default end condition for the spline. Move the mouse pointer to keypoint 1 and click the left button twice to accept it as the first point on the spline (or just type 1). Repeat this procedure for keypoints 2, 3, and 4. Select keypoint 4 a second time and the Accept button to end this command. The procedure is shown below:

Geo Panel: Geometry > CURVES > SPLINES > Spline Curve
Curve label: 1
End condition: Natural Spline
Keypoint 1: 1
Keypoint 2: 2
Keypoint 3: 3
Keypoint 4: 4
Keypoint 5: 4
Click on "OK"

Figure 6.3 shows a plot of the spline in three dimensional space generated using the above command with the grid lines removed. Curves 1 through 3 which lie in the X-Y plane will be extruded in the Z direction to construct a curved surface.

In the display area, you will see a spline constructed at keypoints 1 through 4. The curves are numbered from 1 to 3. In order to generate the curved surface with constant curvature in the Z direction, you need to extrude these curves. From the
Geometry > SURFACES > GENERATION MENU menu, select the Extrusion command. Move the mouse cursor to curve 1 and click the left button twice to select it as the beginning curve (or just type 1). Next, move to curve 3 and click the left button twice to select it as the ending curve. Accept the default increment of 1. Since the curves were generated in the X-Y plane, the default direction of extrusion is Z, indicated in the dialog box the value of extrusion as 50. The procedure for this command is shown below:

**Geo Panel:** Geometry > CURVES > GENERATION MENU > Extrusion
- Beginning curve: 1
- Ending curve: 3
- Increment: 1
- Axis symbol: Z
- Value: 50
- Click on “OK”

Since you started with three curves and extruded them, there will be three surfaces generated as shown in the figure below. The figure also shows the new curves along with their labels which are automatically generated during extrusion. You can now turn the grid off using the following menu tree:

**Geo Panel:** Geometry > GRID > Grid Off

You can rescale the view to fit the display area by clicking on the “Auto” button in the “Scaling” area of the Control Panel.

![Figure 6-4. Curve and Surface Plot](image)

Next, we will create a 3 by 3 element mesh of quadrilateral elements on each of the three surfaces using the M_SF (Meshing > PARAMETRIC MESH > Surfaces) command. Move the mouse pointer to surface number 1 and click the left button.
Chapter 6  Analysis Examples

twice to select it as the beginning surface. Then, move the mouse cursor to surface number 3 and select it as the ending surface. Enter an increment of 1 for the third option. Since we are going to be using quadrilateral elements in the analysis, select “4” as the default number of nodes per element. The number of elements on the first and second curve is specified as 3 since we are constructing a 3 by 3 mesh. For the spacing ratios, accept the default values. The inputs for this command are shown below:

**Geo Panel:**  Geometry > MESHING > PARAMETRIC MESH > Surfaces
- Beginning surface: 1
- Ending surface: 3
- Increment: 1
- Number of nodes per element: 4
- Click on “Continue”
- Number of elements on first curve: 3
- Click on “Continue”
- Number of elements on second curve: 3
- Click on “OK”

The finite element mesh generated is shown in the figure below.

**Figure 6-5. Finite Element Mesh**
The nodes and elements for each surface are generated independently. The elements from one surface are related (or connected) to the elements of adjacent surfaces. However, the nodes on the common boundaries have to be merged. Use the following procedure to merge nodes:

**Geo Panel:** Meshing > NODES > Merge
Click on “OK” to accept all default values

Next we need to assign a specific element type to be used in the analysis. This is done in the Propsets menu which also provides commands for defining the material and sectional properties and others. You can therefore proceed to defining the element properties by selecting the command **Element Group** from the Propsets menu. Since the curved surface is subjected to pressure loading normal to the surface, we need to use shell elements. COSMOS/M features a variety of shell elements applicable to thick, thin, and composite shell structures. For this problem, we will use a 4-node thin shell element (SHELL4). The procedures is shown below:

**Geo Panel:** Propsets > Element Group
- Element group number: 1
- Element type: Surface
- Element name: Shell4
Click on “Continue”
Click on “OK” to accept all default values

COSMOS/M features a variety of materials whose properties can be readily accessed from the built-in library by using the command **PICK_MAT** (Propsets > Pick Material Lib) Alternately, you can define your own material properties using the command **MPROP** (Propsets > Material Property). For this problem, we will select a material from the library using **PICK_MAT**. The material names can be obtained by using on-line help for this command. Accept the material property set number as 1 by clicking the left button once and repeat this for the remaining two prompts. This leads to the definition of material properties for Alloy Steel in FPS system, as shown in the prompts below:

**Geo Panel:** Propsets > Pick Material Lib
Click on “OK” to accept all default values
To define the section properties of the curved surface, use the command \texttt{RCONST} from the Propsets > \texttt{Real Constant} menu. Accept the default options for the first four options and specify a thickness of 1.0. The corresponding inputs are shown below:

\begin{itemize}
  \item \textit{Geo Panel:} Propsets > \texttt{Real Constant}
  \item Click on "Continue" to accept the defaults for the first 2 options
  \item Click on "Continue" to accept the defaults for options 3 and 4
  \item Thickness: 1.0
  \item Click on "OK"
\end{itemize}

After defining the properties, you can move on to defining the boundary conditions and loads. Since the curved surface is fixed along the two short edges and one of the long edges, you can constrain all components of displacements along these curves. COSMOS/M allows you to apply constraints or loads at individual nodes and elements, or directly at the geometric entities resulting in loads or constraints being applied to all associated nodes and elements. This feature greatly reduces the time required to generate the complete finite element model.

From the LoadsBC > STRUCTURAL > DISPLACEMENT menu, select the Define and Curves options to apply displacement on curves. Apply the constraints first on a long edge which is made of curves 1 through 3. Using the left button of the mouse, select the curve with label 1 as the beginning curve, and select “AL” components to be constrained (fixed boundary). Specify the displacement value as 0. Select curve 3 as the ending curve and accept the default for the increment.

\begin{itemize}
  \item \textit{Geo Panel:} LoadsBC > STRUCTURAL > DISPLACEMENT > Define, Curves
  \item Beginning curve: 1
  \item Displacement label: AL
  \item Value: 0.0
  \item Ending curve: 3
  \item Increment: 1
  \item Click on "OK"
\end{itemize}

Repeat this procedure separately for curves 5 and 10 which represent the top and bottom short edges of the curved shell. The figure below shows the applied boundary conditions.
To apply the pressure loading on the curved shell, use the PSF (LoadsBC > STRUCTURAL > PRESSURE > Define, Surfaces) command. Click the left button twice on surface with label 1 as the beginning surface, and specify a pressure magnitude of 5 psi. Click the left button twice on surface with label 3 and select it as the ending surface. Accept the default values for the remaining options. The inputs for this command are shown below:

**Geo Panel:** LoadsBC > STRUCTURAL > PRESSURE > Define, Surfaces
   - Beginning surface: 1
   - Pressure magnitude: 5
   - Ending surface: 3
   - Increment: 1
   - Click on “OK”

The execution of the PSF command results in a pressure of 5 psi applied normal to the curved shell surface as shown in Figure 6-7.
With the definition of boundary conditions and loads, the finite element model is complete and can be submitted for analysis. However, it is a good idea to verify that all modeling has been performed correctly before beginning an analysis. COSMOS/M features automatic model checking which is accessed by the **R_CHECK** (Analysis > Run Check) command.

To perform linear static stress analysis on the curved shell structure, use the **R_STATIC** (Analysis > STATIC > Run Static Analysis) command. The program will temporarily exit GEOSTAR and run the static analysis using the STAR and STRESS modules after performing data checking, node renumbering, and some other miscellaneous operations. When the analysis is complete, the program will return to GEOSTAR. In the display area, you will see the image which existed when you issued the **R_STATIC** command. Clear the screen by clicking on the “Clear” button.

You can proceed to postprocessing the analysis results. Postprocessing is performed using the Results submenu. First, we will look at the displacement results. This includes displacement contours as well as deformed shape plots. Further, you can use the animation capability to dynamically visualize how the structure deforms under applied loads. We will use three windows to view the results. Click on the “New Win” button three times to create 3 new windows. Click on the “Select Active Window” button and select “3” to activate window 3. In window 3, we will process the resultant displacements.
To view the displacement contours, do the following procedure:

**Geo Panel:** Results > PLOT > **Displacement**

Click on "Contour" in the dialog box
Click on "ok" to accept all defaults

*Figure 6-8. Postprocessing of Results*

In window 1, we will view the deformed shape plot. Activate this window using the "Select Active Window" button. To see the deformed shape plot of the structure, clear the screen and issue the command **DEFPLOT** (Results > PLOT > **Deformed Shape**) command. Accept all default options. Note that deformed plots are drawn on an exaggerated scale, and COSMOS/M provides you with an option to control this scale. Window 1 (Figure 6-8) shows the deformed shape of the structure. You also may use the **LSECPLOT** (Results > PLOT > **DISPLACEMENT** > **Path Graph**) command to plot displacement variation along a selected path.
Use the command **Animate** (Results > PLOT > **Animate**) command to dynamically visualize the way the structure deforms. When you use this command, you have an option to control the speed of animation by means of a slow down factor. If a section plot was produced by the **LSECPLOT** command, it will be animated as well.

To see the stress results do the following:

- **Geo Panel:** Results > PLOT > **Stress**
  
  - Click on “Contour”
  - Click on “ok” to accept all defaults

The von Mises stress contours of the structure are shown in window 2, Figure 6-8.

To exit from GEOSTAR, use the command **Exit** (File > **Exit**).
Buckling of a Beam

The general procedure to calculate buckling loads in GEOSTAR is as follows:

1. Define all desired loading.
2. Run the buckling analysis.
3. Buckling loads are calculated by multiplying the defined loads by the resulting eigenvalues. (Use the FREQLIST (Results > LIST > Natural Frequency) command for listing the eigenvalues.)
4. A negative eigenvalue means that all loads must be applied in the reverse direction in order for buckling to occur.

Figure 6-9. Buckling Example

Given
L = 20 in.
AB = 4 in² (cross-sectional area of beams)
Chapter 6   Analysis Examples

\( AT = 0.1 \text{ in}^2 \) (cross-sectional area of the truss)
\( IB = 2 \text{ in}^4 \) (moment of Inertia of beams)
\( E = E_B = E_T = 30 \times 10^6 \text{ psi} \) (Young's moduli)

**Analytical Solution**

The theoretical result for critical load is obtained from:

\[
P_{1cr} = AT E \sin \alpha \cos^2 \alpha \left/ \left[ 1 + \left( \frac{AT}{AB} \right) \sin^3 \alpha \right] \right.
\]

**Listing of the Input File**

```
VIEW,0,0,1,0,
PT,1;
PT,2,20,20;
PT,3,20,0;
SCALE,0,
CRLINE,1,1,2,
CRLINE,2,2,3,
EGROUP,1,BEAM3D;
MPROP,1,EX,30E6,
MPROP,1,DENS,0.000728,
RCONST,1,1,1,5,4.,2.,2.,4.490,1.632,
M_CR,2,2,1,3,4,1,1,
EGROUP,2,TRUSS2D;
RCONST,2,2,1,1,0.1,
M_CR,1,1,1,2,1,1,
NMERGE;
DND,1,UZ,0,6,1,RX,RY;
DND,5,UX,0,6,1,UY;
DND,6,RZ,0,6,1;
FND,1,FY,-1000,1,1,
R_BUCKLING
```

(To plot buckling mode shapes, use the `DEFPLOT` (Results > PLOT > Deformed Shape) command. The buckling load is calculated by multiplying the defined load by the eigenvalue which can be listed using the `FREQLIST` command.)
Comparison of Results

<table>
<thead>
<tr>
<th></th>
<th>Theory</th>
<th>COSMOS/M</th>
</tr>
</thead>
<tbody>
<tr>
<td>$P_{cr1}$ (lb)</td>
<td>$1051.367 \times 10^3$</td>
<td>$1051.59 \times 10^3$</td>
</tr>
</tbody>
</table>

Figure 6-10. Buckling Mode Shape

Mode Shape 1

Reference

This problem illustrates a buckling analysis using TRUSS2D and BEAM3D elements. The problem reference is:

Chapter 6 Analysis Examples

Natural Frequencies of a Ring

For this problem, you are required to determine the first two natural frequencies of a uniform ring making use of the problem symmetry. The element type to be used is SHELL4.

The general procedure for calculating frequencies and mode shapes is as follows:

1. Define the model.
2. Use the A_FREQUENCY command to specify the number of frequencies and the eigenvalue extraction method.
3. Use the R_FREQUENCY command to perform the analysis.
4. Use the FREQLIST command to list the frequencies. The DEFPLT and Animate commands can be used to plot and then animate the mode shapes. If rigid body modes exist, turn on the shift flag (read the help for the A_FREQUENCY command).

Figure 6-11. Sketch of the Ring

Given

\[
\begin{align*}
E &= 30 \times 10^6 \text{ psi (Young's modulus)} \\
\nu &= 0 \text{ (Poisson's ratio)}
\end{align*}
\]
Chapter 6  Analysis Examples

L = 4 in (Length)
h = 1 in (Thickness)
R = 1 in (Radius)
ρ = 0.25 x 10^{-2} (lb sec^2)/in^4 (Mass density)

Comparison of Results

<table>
<thead>
<tr>
<th></th>
<th>Theory</th>
<th>COSMOS/M</th>
</tr>
</thead>
<tbody>
<tr>
<td>F_1 (Hz)</td>
<td>135.05</td>
<td>134.92</td>
</tr>
<tr>
<td>F_2 (Hz)</td>
<td>735.14</td>
<td>723.94</td>
</tr>
</tbody>
</table>

Listing of the Input File

```
TITLE:NATURAL FREQUENCIES OF A RING
PT,1,0,10;
PT,2,0,10,4;
CRLINE,1,1,2;
SFSWEEP,1,1,1,Z,-90,1;
SCALE;
EGROUP,1,SHELL4;
MPROP,1,EX,30E6;
MPROP,1,NUXY,0;
MPROP,1,DENS,0.25E-2;
RCONST,1,1,1,1,1;
M_SF,1,1,1,4,1,12,1,1;
DSF,1,UZ,0,1,1,RX,RY;
DCR,1,UX,0,1,1,RY,RZ;
DCR,2,UY,0,2,1,RX,RZ;
A_FREQUENCY,2;
R_FREQUENCY
```

Reference

The reference for the problem is:

Chapter 6 Analysis Examples

Beam Loading and Generation of Shear and Moment Diagrams

This example presents the procedure to specify beam loading and plot shearing forces and bending moment diagrams for beam elements resulting from linear static analysis.

In addition to the common loading commands, loading on beams can be specified in any coordinate system by the PBEL command. The active value of the coordinate system for an element specifies the coordinate system to be used in applying the load. The user is encouraged to study the on-line help for commands PBEL, PBELIST and PBEDEL. The commands are respectively used to specify, list and delete beam loading. The coordinate system for an element can be changed by the EPROPCHANGE command. The scale of plotting moments and shears is controlled by the SYMSIZ command available from the Control > UTILITY > Set Symbol Size submenu.

Two more important commands are needed: SMPLLOT and SMLIST. The IAISC flag (for American Institute of Steel Structures specifications) in the A_STRESS command must be turned on before issuing the R_STATIC, otherwise no file is generated to record shear and moment values. The BEAMRESLIS and BEAMRESMAX commands are useful in listing the nodal forces and stresses.

In this problem, it is required that the shearing forces and bending moments for a plane frame subject to the shown loading (Figure 6-12) be calculated, listed and plotted. Three load cases are to be considered. The solution process is given as follows:

1. Generate the model.

   PLANE,Z,0,1,
   VIEW,0,0,1,0,
   CRPCORD,1,50,35,0,50,60,0,0,60,0,0,0,0,0,
   EGROUP,1,BEAM2D;
   PICK_MAT,1,A_STEEL,FPS,
   RCONST,1,1,1,8,1,.0833,1;
   M_CR,1,3,1,2,1,1,
   DND,6,AL,0,6,1,
   NMERGE;
Chapter 6  Analysis Examples

2. Issue the **ELIST** command and note that the Ec value for all elements is -1 (local).

3. Apply desired loading, using 3 load cases.
   
   **FND,1,FX,-100,1,1,**
   
   *Concentrated load at the tip*
   
   **PBEL,2,FY,100,0.5,2,1,100,0.5,**
   
   *Concentrated load at midspan*
   
   The **FND** command could have been substituted by (PBEL, 1, FY, 100, 0, 1, 1, 100, 0)
   
   **ACTSET,LC,2,**

   If you need to change the coordinate system for some elements, use the ECS flag in the **EPROPCHANGE** command.

   **EPROPCHANGE,1,1,1,ECS,0,**
   
   **PBEL,1,FX,0,0,1,1,100,1,**
   
   *Triangular loading*
   
   **ACTSET,LC,3,**
   
   **PBEL,2,FY,-100,0,2,1,-100,1,**
   
   *Constant pressure*

4. Perform linear static analysis.

   **R_STATIC**

5. Use the **SMPLOT** command to plot desired shear or moment components. The **SMLIST** lists the numerical values (both commands are in the RESULTS menu). For example to plot the MT component for load case 1, the following command is used:

   **SMPLOT,1,MT,1,3,1,**

   Figure 6-12 shows the loading and corresponding bending moment diagrams for load cases 1 and 3. The **SYMBSIZ** command can be used to change the scale.
Figure 6-12. Load Cases 1 and 3 and the Corresponding Moment Diagrams
Stress Output for 3D Beam Elements

In this problem, a 3D cantilever beam is subjected to concentrated loads in the X, Y and Z directions at the free end. It is required to find the forces and stresses at the support.

Figure 6-13. Problem Sketch and Finite Element Model for a 3D Cantilever Beam

The following properties are assumed:

- \( E = 30 \times 10^6 \text{ psi} \)
- \( I_y = I_z = 1.3333 \text{ in}^4 \)
- \( A = 4 \text{ in}^2 \)
- \( h = 2 \text{ in} \)
- \( L = 80 \text{ in} \)
- \( F_x = 1000 \text{ lb} \)
- \( F_y = 50 \text{ lb} \)
- \( F_z = -100 \text{ lb} \)
The GEOSTAR input for the problem is as follows:

```
TITLE, P1: STRESSES OF A CANTILEVER BEAM
VIEW,0,0,1,0,
PT,1,0,0,0,
PT,2,80,0,0,
PT,3,0,10,0,
CRLINE,1,1,2,
EGROUP,1,BEAM3D,0,0,0,0,0,0,0,0,0,0,0,0,0,0,
MPROP,1,EX,30000000.0,
RCONST,1,1,1,8,4,0,1,333330,1.333330,1.333330,2,0,2,0,0,0,0,2.666667,
M_CR,1,1,1,3,18,1,0,3,
DND,1,AL,0.0,1,1,
FND,1,FX,1000.,19,1,
FND,1,FY,50,19,1,
FND,1,FZ,-100,19,1,
R_STATIC
```

The detailed printout of the stresses for beam element number 1 is provided below:

```
STRESS EVALUATION FOR STATIC ANALYSIS
STRESS OUTPUT FOR BEAM ELEMENT GROUP 1         CASE NO. 1

<table>
<thead>
<tr>
<th>ELEMENT</th>
<th>FORCES</th>
<th>MOMENTS</th>
<th>STRESSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUMBER</td>
<td>NODE 1</td>
<td>NODE 2</td>
<td>NODE 1</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>0.2500E+03</td>
</tr>
<tr>
<td></td>
<td>0.1000E+03</td>
<td></td>
<td>0.0000E+00</td>
</tr>
<tr>
<td>Fr = -1000E+03</td>
<td>0.0000E+00</td>
<td>Tr = 0.0000E+00</td>
<td>0.0000E+00</td>
</tr>
<tr>
<td>Vs = -500E+02</td>
<td>0.5000E+02</td>
<td>Ms = -0.8000E+04</td>
<td>7.556E+04</td>
</tr>
<tr>
<td>Mt = 1000E+03</td>
<td>0.0000E+00</td>
<td>Ms = -0.8000E+04</td>
<td>0.3778E+04</td>
</tr>
<tr>
<td>Mt/St = 0.3000E+04</td>
<td>0.2833E+04</td>
<td>Smax = 0.9250E+04</td>
<td>0.8750E+04</td>
</tr>
</tbody>
</table>
```

Smax = 0.9250E+04
Smin = 0.8750E+04
Please note that the forces and stresses for the beam elements are calculated in the local element coordinate system, denoted by (r, s, t) in Figure 6-13. The positive directions for the local forces at the two ends of the beam are shown in Figure 4-7. The orientation of s and t vectors is governed by the position of the third node of the beam. Positive stresses indicate tension and negative stresses indicate compression.

At the first node of the beam, the internal forces and stresses are:

- **Fr** = Axial force = -1000 at node 1 and +1000 at node 2 which means the beam is in tension.

- **Vs** = Shear force in local s (Global Y) direction = -50.

- **Vt** = Shear force in local t (Global Z) direction = +100.

- **Tr** = Torsional Moment = 0.

- **Ms** = Bending moment about the local s (Global Y) direction = -8000.

- **Mt** = Bending moment about the local t (Global Z) direction = -4000.

- **P/A** = Axial stress = Fr/A = +250.

- **Ms/Ss** = Bending Stress due to the bending moment Ms = +6000.

- **Mt/St** = Bending Stress due to the bending moment Mt = +3000.

- **Smax** = Maximum Stress in the cross-section = (+250) + |6000| + |3000| = 9250 (tension).

- **Smin** = Minimum Stress in the cross-section = (+250) - |6000| - |3000| = -8750 (compression).
Chapter 6   Analysis Examples

Substructuring in Linear Static Analysis

This example describes in detail the steps to perform substructuring analysis of a typical problem, including the formation, assembly and solution of the main structure and the super elements.

In this problem, we will calculate the deflections and stresses of the two-bay pin-jointed cantilever truss shown in Figure 6-14. Two approaches will be considered to solve the problem. The following material properties, cross-sectional areas and loads are assumed:

Figure 6-14. Two-Bay Truss Structure

Given

Modulus of Elasticity: \( E = 10 \text{E6 lb/in}^2 \)
Loads: \( P_1 = P_2 = P_3 = 1 \text{ lb} \)
Cross-sectional areas of vertical and horizontal bars = 1 in\(^2\)
Cross-sectional areas of diagonal bars = 2.707 in\(^2\)

The First Approach

The main structure and a substructure are defined as shown in Figure 6-15.
**Super Element Creation**

1. Create super element 1. Use “SUB1” as the problem name.

2. Define the element group (TRUSS2D), material properties (EX), and two real constant sets (in this case cross-sectional areas).

   ```
   GEO > GGROUP,1,TRUSS2D;
   GEO > MPROP,1,EX,10E6
   GEO > RCONST,1,1,1,1,1
   GEO > RCONST,1,2,1,1,0.707
   ```

3. Define the geometry of the model.

   ```
   GEO > PLANE;
   Defines xy plane
   GEO > VIEW;
   GEO > GRIDON;
   GEO > CRPCORD
   Curve [1] >
   Digitize/Input coordinates > 0,0,0
   Digitize/Input coordinates > 20,0,0,
   Digitize/Input coordinates > 20,20,0,
   Digitize/Input coordinates > 0,20,0,
   Digitize/Input coordinates > 0,20,0,
   ```
Chapter 6   Analysis Examples

4. Define elements and nodes by meshing the curves.

GEO > CRLINE
   Curve [4] >
   Pick/Input Keypoint 1 > 1
   Pick/Input Keypoint 2 > 3

GEO > CRLINE
   Curve [5] >
   Pick/Input Keypoint 1 > 2
   Pick/Input Keypoint 2 > 4

GEO > GRIDOFF;
GEO > SCALE;

GEO > ACTSET,RC,1

GEO > M_CR
   Pick/Input Beginning Curve > 1
   Pick/Input Ending Curve > 3
   Increment [1] >
   Number of nodes per element [3] > 2
   Number of elements on each curve [2] > 1;

GEO > ACTSET,RC,2

GEO > M_CR,4,5,1,2,1;

GEO > NMERGE;
GEO > NCOMPRESS;
GEO > CLS;
GEO > ACTNUM,ND;
GEO > ACTNUM,EL;
GEO > ACTECLR,1,RC;
GEO > NPLT;
GEO > EPLOT;

5. Input the nodal forces.

GEO > FND
   Pick/Input Beginning Node > 2
   Force label > FX
   Value > 1.0
   Pick/Input Ending Node > 3;
6. Define the substructure (super element number 1).

   GEO > SPSTR
   Analysis type [0] > 1
   Super Element [1] >

7. Define super element connectivity.

   GEO > SPELE
   Super Element [1] >
   Starting location in the node set [1] >
   Number of nodes to be entered [1] > 2
   Pick/Input Node 1 > 1
   Pick/Input Node 2 > 4

8. Deactivate stress analysis (so that only displacements are calculated).

   GEO > STRESS,0
   GEO > DND,1,UZ,0,4,1,RX,RY,RZ,

9. Perform static analysis to condense substructure 1.

   GEO > R_STATIC

   The condensed stiffness matrix is now stored in file TMP.S01, and the condensed force vector is stored in file TMP.F01. If the main structure is created on another machine, the above files must be copied to that machine during super element assembly.

Main Structure Creation and Solution

1. Create the main structure.

   GEO > NEWPROB
   Problem name > MAIN1

2. Define the element group (TRUSS2D), material properties (EX), and two real constant sets (in this case cross-sectional areas).

   GEO > EGROUP,1,TRUSS2D;
   GEO > MPROP,1,EX,10E6
Chapter 6   Analysis Examples

3. Define the geometry of the main structure:

   GEO > **PLANE**;
   
   *Defines xy plane*

   GEO > **VIEW**;
   GEO > **GRIDON**;

   GEO > **CRPCORD**
   
   Curve [1] >
   Digitize/Input coordinates > 0,0,0
   Digitize/Input coordinates > 20,0,0
   Digitize/Input coordinates > 20,20,0
   Digitize/Input coordinates > 0,20,0
   Digitize/Input coordinates > 0,0,0

   GEO > **CRLINE**,5,1,3
   GEO > **CRLINE**,6,2,4
   GEO > **GRIDOFF**;
   GEO > **SCALE**;

4. Define the elements and nodes.

   GEO > **ACTSET**,RC,1
   GEO > **M_CR**,1,4,1,2,1;

   GEO > **ACTSET**,RC,2
   GEO > **M_CR**,5,6,1,2,1;

   GEO > **NMERGE**;
   GEO > **NCOMPRESS**;
   GEO > **CLS**;
   GEO > **ACTNUM**,ND;
   GEO > **ACTNUM**,EL;
   GEO > **ACTECLR**,1,RC;
   GEO > **NPLOT**;
   GEO > **EPLOT**;
5. Specify displacement constraints.

   GEO > DCR
   Beginning Curve > 4
   Displacement label > ALL;

6. Specify the type of substructure analysis. This step calculates the displacements of the main structure which involves the solution of the entire system of equations including the substructure. Note that the substructure information is read from files TMP.S01 and TMP.F01.

   GEO > SPSTR
   Analysis type [0] > 2
   GEO > DND,1,UZ,0.0,4,1,RX,RY,RZ

7. Define super element connectivity.

   GEO > SPELE
   Super Element [1] >
   Starting location in the node set [1] >
   Number of nodes to be entered [1] > 2
   Node 1 > 2
   Node 2 > 3

8. Run static and stress analysis to get results for the main structure.

   GEO > R_STATIC

9. Use DEFPLT and Animate commands to see the deformed shape of the main structure.

**Displacement and Stress Recovery**

1. To recover the displacements of super element 1, switch back to problem SUB1.

   GEO > NEWPROB
   Problem name > SUB1
   Open as an old problem [yes] >
2. Specify displacement recovery and run the static analysis.

```
GEO > SPSTR,3,1
GEO > R_STATIC
```

3. Use the `DEFPLOT` command to plot the deformed shape of substructure 1.

**The Second Approach**

The main structure and two substructures are defined as shown in Figure 6-16. The main structure is defined by the nodes common to the two substructures.

**Figure 6-16. The Second Approach: Main and Substructures**

The creation procedure for substructure 1 is similar to the first approach. For substructure 2 we use `MAIN1` as problem name to use the same model as Approach I.

**Creation of Super Element Creation**

1. Create the main structure. Use “MAIN1” as the problem name.

2. Create super element 2.

```
GEO > SPSTR
Analysis type [0] > 1
Super element [1] > 2
```
3. Define the super nodes.
   
   GEO > SPELE,2,1,2,2,3

4. Deactivate stress analysis.
   
   GEO > STRESS,0

5. Run static analysis to create super element (substructure) number 2.
   
   GEO > R_STATIC

The condensed stiffness and loading matrices are now stored in files TMP.S02 and TMP.F02, respectively.

**Main Structure Creation and Solution**

1. Create the main structure.
   
   GEO > NEWPROB
   Problem name > MAIN2

2. Define nodal coordinates.
   
   GEO > ND,1,20,20;
   GEO > ND,2,20,0;
   GEO > DND,1,UZ,0.0,2,1,RX,RY,RZ

3. Specify main structure displacement calculation in the **SPSTR**.
   
   GEO > SPSTR,2

4. Define super nodes connectivity for substructures 1 and 2 and calculate the displacements of the main structure.
   
   GEO > SPELE,1,1,2,2,1
   GEO > SPELE,2,1,2,2,1
   GEO > STRESS,0,
   GEO > R_STATIC

The displacement recovery for super element 1 can be done in the same manner as shown in the first approach. To recover the displacements of super element 2, follow the steps shown below:
Chapter 6 Analysis Examples

Displacement and Stress Recovery

GEO > NEWPROB
Problem name > MAIN1
Open as an old problem [yes] >

1. Specify displacement recovery.

GEO > SPSTR,3,2
GEO > R_STATIC

The full structural analysis for the main and the substructures is complete. You can view the output file or process the results as desired.
Units

Introduction

A brief description for the two commonly used systems of units in structural analysis is presented in this appendix. These are the: (1) International System of Units (SI) and (2) U.S. Customary Units.

In COSMOS/M, the user can adopt any system of units, including standard and non-standard systems. However, units must be consistent and the user should remember to interpret the output accordingly. Failure to use consistent units could result in incorrect and misleading results. Detailed description is given for the consistent units of the basic quantities in COSMOS/M modules.

International System of Units

The basic units in this system are the units of length, mass and time and are, respectively, the meter (m), the kilogram (kg), and the second (s). Other units are derived from these basic units, the unit of acceleration for example is the unit of length divided by the squared unit of time (m/s/s), the unit of force, called Newton (N), is defined as the force required to give a unit of acceleration to a unit of mass (kg m/s/s). The weight of a body, like any other force, must be expressed in Newtons, the weight of a one kilogram mass is the mass multiplied by the acceleration of gravity or 1.0 x 9.81 kg.m/s².
The SI system is an absolute system of units, where measurements are independent of the location. The units in this system can be used anywhere on earth, as well as on other planets and will always have the same significance.

Principal SI Units used in structural mechanics are illustrated in Table B-1.

U.S. Customary System of Units

The basic units in this system are the foot (ft) for length, the pound (lb) for weight, and the second (s) for time. The weight (not mass) is a basic system, contrary to the SI system. The system is gravitational (and not absolute) since the weight of a body depends on the value of the acceleration of gravity. For instance, the weight of a body varies slightly on Earth and the same weight on Earth is about six times its weight on the moon. The pound is defined as the weight of a platinum standard, called the standard pound, at sea level and latitude of 45 degrees.

While the standard pound is used as a unit of mass in many commercial transactions, it should not be so used in engineering practice. The mass in the U.S. customary system is the slug. The slug is defined as the mass which attains a unit acceleration (ft/s²) when subjected to a unit force (lb).

Principal U.S. customary units used in mechanics and their equivalent in the SI system are shown in Table B-2.
### Table B-1. Principal SI Units used in COSMOS/M Modules

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Unit</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Meter</td>
<td>m</td>
</tr>
<tr>
<td>Mass</td>
<td>Kilogram</td>
<td>kg</td>
</tr>
<tr>
<td>Time</td>
<td>Second</td>
<td>s</td>
</tr>
<tr>
<td>Area</td>
<td>Square meter</td>
<td>m²</td>
</tr>
<tr>
<td>Solids volume</td>
<td>Cubic meter</td>
<td>m³</td>
</tr>
<tr>
<td>Liquid volume</td>
<td>Liter</td>
<td>L=10⁻⁶ m³</td>
</tr>
<tr>
<td>Velocity</td>
<td>Meter per second</td>
<td>m/s</td>
</tr>
<tr>
<td>Acceleration</td>
<td>Meter per second squared</td>
<td>(m/s²)</td>
</tr>
<tr>
<td>Angle</td>
<td>Radian</td>
<td>rad</td>
</tr>
<tr>
<td>Angular velocity</td>
<td>Radian per second</td>
<td>rad/s</td>
</tr>
<tr>
<td>Angular acceleration</td>
<td>Radians per second squared</td>
<td>rad/s²</td>
</tr>
<tr>
<td>Density</td>
<td>Kilogram per cubic meter</td>
<td>kg/m³</td>
</tr>
<tr>
<td>Force</td>
<td>Newton</td>
<td>N</td>
</tr>
<tr>
<td>Moment of a force</td>
<td>Newton-meter</td>
<td>N·m</td>
</tr>
<tr>
<td>Stress and pressure</td>
<td>Pascal</td>
<td>Pa=1N/m²</td>
</tr>
<tr>
<td>Frequency</td>
<td>Hertz</td>
<td>Hz=1cycle/s</td>
</tr>
<tr>
<td>Impulse</td>
<td>Newton-second</td>
<td>N·s</td>
</tr>
<tr>
<td>Work</td>
<td>Joule</td>
<td>J=N·m</td>
</tr>
<tr>
<td>Power</td>
<td>Watt</td>
<td>W</td>
</tr>
<tr>
<td>Thermal conductivity (K)</td>
<td>Watt per meter per degree Centigrade</td>
<td>W/m·°C</td>
</tr>
<tr>
<td>Specific heat (C)</td>
<td>Joule per kilogram per degree Centigrade</td>
<td>J/kg·°C</td>
</tr>
<tr>
<td>Convection film coefficient</td>
<td>Watt per meter squared per degree Centigrade</td>
<td>W/m²·°C</td>
</tr>
<tr>
<td>Heat generation per node (Q)</td>
<td>Watt</td>
<td>W</td>
</tr>
<tr>
<td>Heat flux (heat generation per area)</td>
<td>Watt per meter squared</td>
<td>W/m²</td>
</tr>
<tr>
<td>Heat generation per unit volume (QE)</td>
<td>Watt per cubic meter</td>
<td>W/m³</td>
</tr>
</tbody>
</table>
Table B-2. Conversion Table for U.S. Customary and SI Units

<table>
<thead>
<tr>
<th>Quantity</th>
<th>US Customary Unit</th>
<th>SI Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>ft</td>
<td>0.3048 m</td>
</tr>
<tr>
<td></td>
<td>in</td>
<td>25.40 mm</td>
</tr>
<tr>
<td></td>
<td>mi</td>
<td>1.609 km</td>
</tr>
<tr>
<td>Area</td>
<td>ft²</td>
<td>0.0929 m²</td>
</tr>
<tr>
<td></td>
<td>in²</td>
<td>25.40 mm²</td>
</tr>
<tr>
<td></td>
<td>m²</td>
<td>645.2 mm²</td>
</tr>
<tr>
<td>Volume</td>
<td>ft³</td>
<td>0.02832 m³</td>
</tr>
<tr>
<td></td>
<td>in³</td>
<td>16.39 cm³</td>
</tr>
<tr>
<td>Liquid Volumes</td>
<td>gal</td>
<td>3.785 L</td>
</tr>
<tr>
<td></td>
<td>qt</td>
<td>0.9464 L</td>
</tr>
<tr>
<td>Velocity</td>
<td>ft/s</td>
<td>0.3048 m/s</td>
</tr>
<tr>
<td></td>
<td>in/s</td>
<td>0.0254 m/s</td>
</tr>
<tr>
<td></td>
<td>mi/h (mph)</td>
<td>0.4470 m/s</td>
</tr>
<tr>
<td></td>
<td>mi/h</td>
<td>1.609 km/h</td>
</tr>
<tr>
<td>Acceleration</td>
<td>ft/s²</td>
<td>0.3048 m/s²</td>
</tr>
<tr>
<td></td>
<td>in/s²</td>
<td>0.0254 m/s²</td>
</tr>
<tr>
<td>Mass</td>
<td>oz mass</td>
<td>28.35 g</td>
</tr>
<tr>
<td></td>
<td>lb mass</td>
<td>0.4536 kg</td>
</tr>
<tr>
<td></td>
<td>slug</td>
<td>14.59 kg</td>
</tr>
<tr>
<td></td>
<td>ton</td>
<td>907.2 kg</td>
</tr>
<tr>
<td>Force</td>
<td>kip</td>
<td>4.448 kN</td>
</tr>
<tr>
<td></td>
<td>lb weight</td>
<td>4.448 N</td>
</tr>
<tr>
<td></td>
<td>oz weight</td>
<td>0.2780 N</td>
</tr>
<tr>
<td>Moment of Force</td>
<td>lb ft</td>
<td>1.356 N m</td>
</tr>
<tr>
<td></td>
<td>lb in</td>
<td>0.1130 N m</td>
</tr>
<tr>
<td>Area moment of Inertia</td>
<td>in⁴</td>
<td>0.4162 x 10⁶ mm⁴</td>
</tr>
<tr>
<td>Mass moment of Inertia</td>
<td>lb ft s²</td>
<td>1.356 kg m²</td>
</tr>
<tr>
<td>Pressure or Stress</td>
<td>lb/ft²</td>
<td>47.88 Pa</td>
</tr>
<tr>
<td></td>
<td>lb/in² (psi)</td>
<td>6.895 kPa</td>
</tr>
<tr>
<td>Work or Energy</td>
<td>ft lb</td>
<td>1.356 J</td>
</tr>
<tr>
<td>Impulse or Momentum</td>
<td>lb s</td>
<td>4.448 N s</td>
</tr>
<tr>
<td>Power</td>
<td>ft lb/s</td>
<td>1.356 W</td>
</tr>
</tbody>
</table>
Engineering Prefixes

Multiple and submultiple units commonly used in engineering practice are shown in Table B-3.

Table B-3. Common Engineering Prefixes and Symbols

<table>
<thead>
<tr>
<th>Multiplication</th>
<th>Prefix</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>$10^{12}$</td>
<td>tera</td>
<td>T</td>
</tr>
<tr>
<td>$10^{9}$</td>
<td>giga</td>
<td>G</td>
</tr>
<tr>
<td>$10^{6}$</td>
<td>mega</td>
<td>M</td>
</tr>
<tr>
<td>$10^{3}$</td>
<td>kilo</td>
<td>k</td>
</tr>
<tr>
<td>$10^{2}$</td>
<td>hekto</td>
<td>h</td>
</tr>
<tr>
<td>$10^{1}$</td>
<td>deka</td>
<td>da</td>
</tr>
<tr>
<td>$10^{-1}$</td>
<td>deci</td>
<td>d</td>
</tr>
<tr>
<td>$10^{-2}$</td>
<td>centi</td>
<td>c</td>
</tr>
<tr>
<td>$10^{-3}$</td>
<td>milli</td>
<td>m</td>
</tr>
<tr>
<td>$10^{-6}$</td>
<td>micro</td>
<td>m</td>
</tr>
<tr>
<td>$10^{-9}$</td>
<td>nano</td>
<td>n</td>
</tr>
<tr>
<td>$10^{-12}$</td>
<td>pico</td>
<td>p</td>
</tr>
<tr>
<td>$10^{-15}$</td>
<td>femto</td>
<td>f</td>
</tr>
<tr>
<td>$10^{-18}$</td>
<td>atto</td>
<td>a</td>
</tr>
</tbody>
</table>

Tables of Consistent Units for COSMOS/M Modules

As mentioned earlier, standard as well as nonstandard systems of units can be used in COSMOS/M products. The following tables list proposed consistent units for COSMOS/M.

The following applies to Tables B-4 through B-10.

* Units are consistent with the COSMOS/M material library database.
1 FPS refers to the U.S. customary system of units.
2 SI refers to the International system of units.
3 MKS refers to the Metric system of units.
4 CGS refers to the French system of units.
Table B-4. Table of Consistent Units for Linear Static Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>* FPS ¹ (gravitational)</th>
<th>* SI² (absolute)</th>
<th>* MKS³ (gravitational)</th>
<th>CGS⁴ (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Material Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elastic Modulus</td>
<td>EX, EY, EZ</td>
<td>lbs/in²</td>
<td>Newton/m² or Pascal</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Shear Modulus</td>
<td>GXY, GYZ, GXZ</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Poisson's Ratio</td>
<td>NUXX, NUYY, NUZZ</td>
<td>in/in (no units)</td>
<td>m/m (no units)</td>
<td>cm/cm (no units)</td>
<td>cm/cm (no units)</td>
</tr>
<tr>
<td>Mass Density</td>
<td>DENS</td>
<td>lbs sec²/in⁴</td>
<td>kg/m²</td>
<td>kg sec²/cm⁴</td>
<td>g/cm³</td>
</tr>
<tr>
<td>Coefficient of Thermal</td>
<td>ALPX, ALPY, ALPZ</td>
<td>in/(in °F)</td>
<td>m/(m °K)</td>
<td>cm/(cm °C)</td>
<td>cm/(cm °K)</td>
</tr>
<tr>
<td>Material Angle</td>
<td>Beta</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
</tr>
<tr>
<td>Anisotropic Matl Stiffness</td>
<td>MC11,..., MC66 (total of 21 constants)</td>
<td>lbs/in²</td>
<td>Newton/m² or Pascal</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Matrix Constants (option 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anisotropic Matl Stiffness</td>
<td>MC11,..., MC66 (total of 21 constants)</td>
<td>lbs²/in</td>
<td>m² or Newton</td>
<td>cm³/kg</td>
<td>cm³/dyne</td>
</tr>
<tr>
<td>Matrix Constants (option 2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Piezoelectric Material</td>
<td>PC11,..., PC63 (total of 18)</td>
<td>—</td>
<td>Volt/m</td>
<td>—</td>
<td>Volt/cm</td>
</tr>
<tr>
<td>Matrix Constants</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dielectric Material Matrix</td>
<td>DC11,..., DC33 (total of 6)</td>
<td>—</td>
<td>Farad/m</td>
<td>—</td>
<td>10⁻¹³ Farad/cm</td>
</tr>
<tr>
<td>Constants</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table B-4. Table of Consistent Units for Linear Static Analysis (Concluded)

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>* FPS ¹ (gravitational)</th>
<th>* SI² (absolute)</th>
<th>* MKS³ (gravitational)</th>
<th>CGS⁴ (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loads and Boundary Conditions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>Temp</td>
<td>°F</td>
<td>°K</td>
<td>°C</td>
<td>°K</td>
</tr>
<tr>
<td>Translational</td>
<td>UX, UY, UZ</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Displacements</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rotational</td>
<td>RX, RY, RZ</td>
<td>radians</td>
<td>radians</td>
<td>radians</td>
<td>radians</td>
</tr>
<tr>
<td>Displacements</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forces (nodal)</td>
<td>FX, FY, FZ</td>
<td>lbs</td>
<td>Newton</td>
<td>kg</td>
<td>dyne</td>
</tr>
<tr>
<td>Moments (nodal)</td>
<td>MX, MY, MZ</td>
<td>in lbs</td>
<td>m N</td>
<td>cm kg</td>
<td>cm dyne</td>
</tr>
<tr>
<td>Pressure</td>
<td>P</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>ACEL</td>
<td>in/sec²</td>
<td>m/sec²</td>
<td>cm/sec²</td>
<td>cm/sec²</td>
</tr>
<tr>
<td>Distributed Beam Load</td>
<td>P</td>
<td>lbs/in</td>
<td>N/m</td>
<td>kg/cm</td>
<td>dyne/cm</td>
</tr>
</tbody>
</table>
### Angular Velocity

<table>
<thead>
<tr>
<th>Angular Velocity</th>
<th>OMEGA, CGOMEGA</th>
<th>rad/sec</th>
<th>rad/sec</th>
<th>rad/sec</th>
<th>rad/sec</th>
</tr>
</thead>
</table>

### Angular Acceleration

<table>
<thead>
<tr>
<th>Angular Acceleration</th>
<th>DOMEGA, DCGOMEGA</th>
<th>rad/sec²</th>
<th>rad/sec²</th>
<th>rad/sec²</th>
<th>rad/sec²</th>
</tr>
</thead>
</table>

### Results

<table>
<thead>
<tr>
<th>Results</th>
<th>UX, UY, UZ lbs</th>
<th>Newton m</th>
<th>kg cm kg</th>
<th>cm dyne</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Reaction Moments</th>
<th>RX, RY, RZ in lbs</th>
<th>m N cm kg</th>
<th>cm dyne</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Displacements</th>
<th>UX, UY, UZ, RES in</th>
<th>m cm</th>
<th>cm cm</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Stresses</th>
<th>SX, SY, SZ, TXY, TYZ, TXZ, P1, P2, P3, VON, INT lbs/in²</th>
<th>N/m² or Pa kg/cm²</th>
<th>dyne/cm²</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Strains</th>
<th>EPSX, EPSY, EPSZ, GMXY, GMYZ, GMXZ, ESTRN in/in</th>
<th>m/m</th>
<th>cm/cm</th>
</tr>
</thead>
</table>

|                | (no units) (no units) (no units) (no units) |
|----------------|---------------------------------------------|-----|-------|
### Table B-5. Table of Consistent Units for Linear Dynamic Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>* FPS (gravitational)</th>
<th>* SI (absolute)</th>
<th>* MKS (gravitational)</th>
<th>CGS (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td><strong>Material Properties</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elastic Modulus</td>
<td>EX, EY, EZ</td>
<td>lbs/in²</td>
<td>Newton/m² or Pascal</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Shear Modulus</td>
<td>GXY, GYZ, GXZ</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Poisson's Ratio</td>
<td>NUXY, NUZY, NUXZ</td>
<td>in/in (no units)</td>
<td>cm (no units)</td>
<td>cm/cm (no units)</td>
<td>cm/cm (no units)</td>
</tr>
<tr>
<td>Mass Density</td>
<td>DENS</td>
<td>lbs sec²/in⁴</td>
<td>kg/m³</td>
<td>kg sec²/cm⁴</td>
<td>g/cm³</td>
</tr>
</tbody>
</table>

**Table B-5. Table of Consistent Units for Linear Dynamic Analysis (Concluded)**

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>* FPS (gravitational)</th>
<th>* SI (absolute)</th>
<th>* MKS (gravitational)</th>
<th>CGS (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Loads and Boundary Conditions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material Angle</td>
<td>Beta</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
</tr>
<tr>
<td>Time</td>
<td></td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
</tr>
<tr>
<td>Frequency</td>
<td></td>
<td>Hz or rad/sec</td>
<td>Hz or rad/sec</td>
<td>Hz or rad/sec</td>
<td>Hz or rad/sec</td>
</tr>
<tr>
<td>Translational Displacements</td>
<td>DISP</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Linear Velocity</td>
<td>VEL</td>
<td>in/sec</td>
<td>m/sec</td>
<td>cm/sec</td>
<td>cm/sec</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>ACC</td>
<td>in/sec²</td>
<td>m/sec²</td>
<td>cm/sec²</td>
<td>cm/sec²</td>
</tr>
<tr>
<td>Forces (nodal)</td>
<td>FX, FY, FZ</td>
<td>lbs</td>
<td>Newton</td>
<td>kg</td>
<td>dyne</td>
</tr>
<tr>
<td>Moments (nodal)</td>
<td>MX, MY, MZ</td>
<td>in lbs</td>
<td>m N</td>
<td>cm kg</td>
<td>cm dyne</td>
</tr>
<tr>
<td>Pressure</td>
<td>P</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Concentrated Damper</td>
<td>P-dyn</td>
<td>lbs sec/in</td>
<td>N sec/m</td>
<td>kg sec/cm</td>
<td>dyne sec/cm</td>
</tr>
<tr>
<td>Damping Ratio</td>
<td></td>
<td>C/Cr (no units)</td>
<td>C/Cr (no units)</td>
<td>C/Cr (no units)</td>
<td>C/Cr (no units)</td>
</tr>
<tr>
<td>Phase Angle Input</td>
<td>Phase</td>
<td>degrees</td>
<td>degrees</td>
<td>degrees</td>
<td>degrees</td>
</tr>
<tr>
<td>Power Spectral Density, (PSD)</td>
<td></td>
<td>(in/sec)²/Hz</td>
<td>(rad/sec)²/Hz</td>
<td>(rad/sec)²/Hz</td>
<td>(cm/sec)²/Hz</td>
</tr>
<tr>
<td>Results</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td></td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
</tr>
<tr>
<td>Frequency</td>
<td>FREQ</td>
<td>Hz or rad/sec</td>
<td>Hz or rad/sec</td>
<td>Hz or rad/sec</td>
<td>Hz or rad/sec</td>
</tr>
<tr>
<td>Reaction Forces</td>
<td>UX, UY, UZ</td>
<td>lbs</td>
<td>Newton</td>
<td>kg</td>
<td>dyne</td>
</tr>
</tbody>
</table>
## Chapter

<table>
<thead>
<tr>
<th>Category</th>
<th>Variables</th>
<th>Units</th>
<th>Units</th>
<th>Units</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reaction Moments</td>
<td>RX, RY, RZ</td>
<td>in lbs</td>
<td>m N</td>
<td>cm kg</td>
<td>cm dyne</td>
</tr>
<tr>
<td>Displacements</td>
<td>(DISP), UX, UY, UZ</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Linear Velocity</td>
<td>(VEL), UX, UY, UZ</td>
<td>in/sec</td>
<td>m/sec</td>
<td>cm/sec</td>
<td>cm/sec</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>(VEL), RX, RY, RZ</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>(ACC), UX, UY, UZ</td>
<td>in/sec²</td>
<td>m/sec²</td>
<td>cm/sec²</td>
<td>cm/sec²</td>
</tr>
<tr>
<td>Angular Acceleration</td>
<td>(ACC), RX, RY, RZ</td>
<td>rad/sec²</td>
<td>rad/sec²</td>
<td>rad/sec²</td>
<td>rad/sec²</td>
</tr>
<tr>
<td>Stresses</td>
<td>SX, SY, SZ, TXY,</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td></td>
<td>TYZ, TXZ, P1, P2,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>P3, VON, INT</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Strains</td>
<td>EPSX, EPSY, EPSZ,</td>
<td>in/in (no units)</td>
<td>m/m (no units)</td>
<td>cm/cm (no units)</td>
<td>cm/cm (no units)</td>
</tr>
<tr>
<td></td>
<td>GMXY, GMYZ, GMXZ,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ESTRN</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table B-6. Table of Consistent Units for Nonlinear Static Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>* FPS¹ (gravitational)</th>
<th>* SI² (absolute)</th>
<th>* MKS³ (gravitational)</th>
<th>CGS⁴ (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td><strong>Material Properties</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elastic Modulus</td>
<td>EX, EY, EZ</td>
<td>lbs/in²</td>
<td>Newton/m² or Pascal</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Shear Modulus</td>
<td>GXY, GYZ, GXZ</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Poisson's Ratio</td>
<td>NUXY, NUYZ, NUXZ</td>
<td>in/in (no units)</td>
<td>m/m (no units)</td>
<td>cm/cm</td>
<td>cm/cm</td>
</tr>
<tr>
<td>Mass Density</td>
<td>DENS</td>
<td>lbs sec⁻²/ln⁴</td>
<td>kg/m³</td>
<td>kg sec⁻²/cm⁴</td>
<td>g/cm³</td>
</tr>
<tr>
<td>Coeff. of Thermal Expansion</td>
<td>ALPX, ALPY, ALPZ</td>
<td>in/(in °F)</td>
<td>m/(m °K)</td>
<td>cm/(cm °C)</td>
<td>cm/(cm °K)</td>
</tr>
<tr>
<td>Tangent Modulus</td>
<td>ETAN</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Yield Stress</td>
<td>SIGYLD</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Tensile Strength</td>
<td>SIGXT, SIGYT</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Compressive Strength</td>
<td>SIGXC, SIGYC</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Tensile Shear Strength</td>
<td>SIGXYT</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Compressive Shear Strength</td>
<td>SIGXYC</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Mooney-Rivlin Hyperelastic Constants</td>
<td>MOONEY_A, MOONEY_B</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Creep Constants</td>
<td>CREEPC, CREEPX</td>
<td>Units are determined by the creep law used</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cohesive Strength (Drucker-Prager model)</td>
<td>COHESN</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Friction Angle (Drucker-Prager model)</td>
<td>FRCANG</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
</tr>
<tr>
<td>Material Angle</td>
<td>Beta</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
</tr>
<tr>
<td><strong>Loads and Boundary Conditions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>Temp</td>
<td>° F</td>
<td>° K</td>
<td>° C</td>
<td>° K</td>
</tr>
<tr>
<td>Load Step</td>
<td>Time</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
</tr>
<tr>
<td>Translational Displacements</td>
<td>UX, UY, UZ</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Rotational Displacements</td>
<td>RX, RY, RZ</td>
<td>radians</td>
<td>radians</td>
<td>radians</td>
<td>radians</td>
</tr>
<tr>
<td>Forces (nodal)</td>
<td>FX, FY, FZ</td>
<td>lbs</td>
<td>Newton</td>
<td>kg</td>
<td>dyne</td>
</tr>
<tr>
<td>Moments (nodal)</td>
<td>MX, MY, MZ</td>
<td>in lbs</td>
<td>m N</td>
<td>cm kg</td>
<td>cm dyne</td>
</tr>
<tr>
<td>Pressure</td>
<td>P</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
</tbody>
</table>
### Table B-6. Table of Consistent Units for Nonlinear Static Analysis (Concluded)

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>* FPS(^1) (gravitational)</th>
<th>* SI(^2) (absolute)</th>
<th>* MKS(^3) (gravitational)</th>
<th>CGS(^4) (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributed Beam Load</td>
<td>PB</td>
<td>lbs/in</td>
<td>N/m</td>
<td>kg/cm</td>
<td>dyne/cm</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>ACEL</td>
<td>in(^2)/sec(^2)</td>
<td>m/sec(^2)</td>
<td>cm/sec(^2)</td>
<td>cm/sec(^2)</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>OMEGA,</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
</tr>
<tr>
<td></td>
<td>CGOMEGA</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Angular Acceleration</td>
<td>DOMEGA,</td>
<td>rad/sec(^2)</td>
<td>rad/sec(^2)</td>
<td>rad/sec(^2)</td>
<td>rad/sec(^2)</td>
</tr>
<tr>
<td></td>
<td>DCGOMEGA</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Results</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reaction Forces</td>
<td>UX, UY, UZ</td>
<td>lbs</td>
<td>Newton</td>
<td>kg</td>
<td>dyne</td>
</tr>
<tr>
<td>Reaction Moments</td>
<td>RX, RY, RZ</td>
<td>in lbs</td>
<td>m N</td>
<td>cm kg</td>
<td>cm dyne</td>
</tr>
<tr>
<td>Displacements</td>
<td>UX, UY, UZ, RES</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Stresses</td>
<td>SX, SY, SZ, TXY, TYZ, TXZ, P1, P2, P3, VON, INT</td>
<td>lbs/in(^2)</td>
<td>N/m(^2) or Pa</td>
<td>kg/cm(^2)</td>
<td>dyne/cm(^2)</td>
</tr>
<tr>
<td>Strains</td>
<td>EPSX, EPSY, EPSZ, GMXY, GMYZ, GMXZ, ESTRN</td>
<td>in/in (no units)</td>
<td>m/m (no units)</td>
<td>cm/cm (no units)</td>
<td>cm/cm (no units)</td>
</tr>
<tr>
<td>Description</td>
<td>COSMOS Name</td>
<td>* FPS¹ (gravitational)</td>
<td>* SI² (absolute)</td>
<td>* MKS³ (gravitational)</td>
<td>CGS⁴ (absolute)</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>------------------------</td>
<td>------------------</td>
<td>------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Material Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elastic Modulus</td>
<td>EX, EY, EZ</td>
<td>lbs/in²</td>
<td>Newton/m² or Pascal</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Shear Modulus</td>
<td>GXY, GYZ, GXZ</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Poisson's Ratio</td>
<td>NUXY, NUZY, NUXZ</td>
<td>in/in (no units)</td>
<td>m/m (no units)</td>
<td>cm/cm (no units)</td>
<td>cm/cm (no units)</td>
</tr>
<tr>
<td>Mass Density</td>
<td>DENS</td>
<td>lbs sec²/in⁴</td>
<td>kg/m³</td>
<td>kg sec²/cm⁴</td>
<td>g/cm³</td>
</tr>
<tr>
<td>Tangent Modulus</td>
<td>ETAN</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Yield Stress</td>
<td>SIGYLD</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Tensile Strength</td>
<td>SIGXT, SIGYT</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Compressive Strength</td>
<td>SIGXC, SIGYC</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Tensile Shear Strength</td>
<td>SIGXYT</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
</tbody>
</table>

| Compressive Shear Strength | SIGXCYC | lbs/in² | N/m² or Pa | kg/cm² | dyne/cm² |
| Mooney-Rivlin Hyperelastic Constants | MOONEY_A, MOONEY_B | lbs/in² | N/m² or Pa | kg/cm² | dyne/cm² |
| Creep Constants | CREEPC, CREEPX | Units are determined by the creep law used |
| Cohesive Strength (Drucker-Prager model) | COHESN | lbs/in² | N/m² or Pa | kg/cm² | dyne/cm² |
| Friction Angle (Drucker-Prager model) | FRCANG | degree | degree | degree | degree |
| Material Angle | Beta | degree | degree | degree | degree |

| Loads and Boundary Conditions |
| Time | Time | seconds | seconds | seconds | seconds |
| Translational Displacements | UX, UY, UZ | in | m | cm | |
| Rotational Displacements | RX,RY, RZ | radians | radians | radians | radians |
| Forces (nodal) | FX, FY, FZ | lbs | Newton | kg | dyne |
### Chapter

<table>
<thead>
<tr>
<th>Moments (nodal)</th>
<th>MX, MY, MZ</th>
<th>in lbs</th>
<th>m N</th>
<th>cm kg</th>
<th>cm dyne</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure</td>
<td>P</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Distributed Beam Load</td>
<td>PB</td>
<td>lbs/in</td>
<td>N/m</td>
<td>kg/cm</td>
<td>dyne/cm</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>ACEL</td>
<td>in/sec²</td>
<td>m/sec²</td>
<td>cm/sec²</td>
<td>cm/sec²</td>
</tr>
</tbody>
</table>

### Results

<table>
<thead>
<tr>
<th>Reaction Forces</th>
<th>UX, UY, UZ</th>
<th>lbs</th>
<th>Newton</th>
<th>kg</th>
<th>dyne</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reaction Moments</td>
<td>RX, RY, RZ</td>
<td>in lbs</td>
<td>m N</td>
<td>cm kg</td>
<td>cm dyne</td>
</tr>
<tr>
<td>Displacements</td>
<td>UX, UY, UZ, RES</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td></td>
</tr>
<tr>
<td>Linear Velocity</td>
<td>(VEL), UX, UY, UZ</td>
<td>in/sec</td>
<td>m/sec</td>
<td>cm/sec</td>
<td>cm/sec</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>(VEL), RX, RY, RZ</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>(ACC), UX, UY, UZ</td>
<td>in/sec²</td>
<td>m/sec²</td>
<td>cm/sec²</td>
<td>cm/sec²</td>
</tr>
<tr>
<td>Angular Acceleration</td>
<td>(ACC), RX, RY, RZ</td>
<td>rad/sec²</td>
<td>rad/sec²</td>
<td>rad/sec²</td>
<td>rad/sec²</td>
</tr>
<tr>
<td>Stresses</td>
<td>SX, SY, SZ, TXY, TYZ, TXZ, P1, P2, P3, VON, INT</td>
<td>lbs/in²</td>
<td>N/m² or Pa</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Strains</td>
<td>EPSX, EPSY, EPSZ, GMXX, GMXY, GMYZ, GMXZ, ESTRN</td>
<td>in/in (no units)</td>
<td>m/m (no units)</td>
<td>cm/cm (no units)</td>
<td>cm/cm (no units)</td>
</tr>
</tbody>
</table>
### Table B-8. Table of Consistent Units for Heat Transfer Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>° FPS¹ (gravitational)</th>
<th>° SI² (absolute)</th>
<th>° MKS³ (gravitational)</th>
<th>CGS⁴ (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material Properties</strong></td>
<td></td>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td><strong>Thermal Conductivity</strong></td>
<td>KX, KY, KZ</td>
<td>BTU/in sec °F</td>
<td>W/m °K</td>
<td>Cal/cm sec °C</td>
<td>W/cm °K</td>
</tr>
<tr>
<td><strong>Thermal Contact Resistance</strong></td>
<td>KC</td>
<td>BTU/in³ sec °F</td>
<td>W/m³ °K</td>
<td>Cal/cm³ sec °C</td>
<td>W/cm³ °K</td>
</tr>
<tr>
<td><strong>Specific Heat</strong></td>
<td>C</td>
<td>BTU in/lbs sec² °F</td>
<td>J/kg °K</td>
<td>Cal cm/kg sec² °C</td>
<td>J/g °K</td>
</tr>
<tr>
<td><strong>Mass Density</strong></td>
<td>DENS</td>
<td>lbs sec²/in³</td>
<td>kg/m³</td>
<td>kg sec²/cm²</td>
<td>g/cm³</td>
</tr>
<tr>
<td><strong>Emissivity</strong></td>
<td>EMIS</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
<td></td>
</tr>
<tr>
<td><strong>Stefan Boltzmann Constant</strong></td>
<td>SB_CONST</td>
<td>3.3063e-15 BTU/sec in²</td>
<td>5.6703e-8 W/m² °K</td>
<td>1.3552e-12 Cal/sec cm² °K</td>
<td>5.6703e-12 W/cm² °K</td>
</tr>
<tr>
<td><strong>Convection Film Coefficient</strong></td>
<td>HC (for CLINK elements)</td>
<td>BTU/sec in² °F</td>
<td>W/m² °K</td>
<td>Cal/sec cm² °C</td>
<td>W/cm² °K</td>
</tr>
<tr>
<td><strong>Material Angle</strong></td>
<td>Beta</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
<td>degree</td>
</tr>
<tr>
<td><strong>Electric Conductivity</strong></td>
<td>ECONX</td>
<td>mho/in</td>
<td>mho/m</td>
<td>mho/m</td>
<td>10⁻¹³ mho/cm</td>
</tr>
<tr>
<td><strong>Loads and Boundary Conditions</strong></td>
<td></td>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>Temp, TREF, NT</td>
<td>° F</td>
<td>° K</td>
<td>°C</td>
<td>°K</td>
</tr>
<tr>
<td>Absolute Temperature Offset</td>
<td>TOFFSET</td>
<td>460 °R</td>
<td>none</td>
<td>273 °K</td>
<td>none</td>
</tr>
<tr>
<td>Time</td>
<td>Time</td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
</tr>
<tr>
<td>Concentrated Heating</td>
<td>Nodal Heat, Q</td>
<td>BTU/sec</td>
<td>Watt</td>
<td>Cal/sec</td>
<td>Watt</td>
</tr>
<tr>
<td>Volume Heating</td>
<td>Element Heat, QE</td>
<td>BTU/sec in³ °F</td>
<td>W/m³</td>
<td>Cal/sec cm³</td>
<td>W/cm³</td>
</tr>
<tr>
<td>Surface Heating</td>
<td>Heat Flux,HX</td>
<td>BTU/sec in³ °F</td>
<td>W/m²</td>
<td>Cal/sec cm²</td>
<td>W/cm²</td>
</tr>
<tr>
<td>Convection Film Coefficient</td>
<td>CE</td>
<td>BTU/sec in² °F</td>
<td>W/m² °K</td>
<td>Cal/sec cm² °C</td>
<td>W/cm² °K</td>
</tr>
<tr>
<td>Radiation Emissivity</td>
<td>RE</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td></td>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>Temp</td>
<td>° F</td>
<td>° K</td>
<td>°C</td>
<td>°K</td>
</tr>
<tr>
<td>Temperature Gradient</td>
<td>GRADX, GRADY, GRADZ</td>
<td>° F/in</td>
<td>°K/m</td>
<td>°C/cm</td>
<td>°K/cm</td>
</tr>
<tr>
<td>Heat Flux</td>
<td>HFLUXX, HFLUXY, HFLUXZ, HFLUXN</td>
<td>BTU/sec in³ °F</td>
<td>W/m²</td>
<td>Cal/sec cm²</td>
<td>W/cm²</td>
</tr>
</tbody>
</table>
**Table B-9. Table of Consistent Units for Fluid Flow Analysis**

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th>FPS1 (gravitational)</th>
<th>SI2 (absolute)</th>
<th>MKS3 (gravitational)</th>
<th>CGS4 (absolute)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>in</td>
<td>m</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td><strong>Material Properties</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic Viscosity</td>
<td>VISC</td>
<td>lbs sec/in²</td>
<td>N sec/m²</td>
<td>kg sec/cm²</td>
<td>dyne sec/cm²</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>KX</td>
<td>BTU/in sec °F</td>
<td>W/m °K</td>
<td>Cal/cm sec °C</td>
<td>W/cm °K</td>
</tr>
<tr>
<td>Specific Heat</td>
<td>C</td>
<td>BTU/in/lbs sec °F</td>
<td>J/kg °K</td>
<td>Cal cm/kg sec °C</td>
<td>J/g °K</td>
</tr>
<tr>
<td>Mass Density</td>
<td>DENS</td>
<td>lbs sec³/in⁴</td>
<td>kg/m³</td>
<td>kg sec³/cm³</td>
<td>g/cm³</td>
</tr>
<tr>
<td>Coefficient of Volumetric Expansion</td>
<td>BETA</td>
<td>1/°F</td>
<td>1/°K</td>
<td>1/°C</td>
<td>1/°K</td>
</tr>
<tr>
<td>Ratio of Specific Heats</td>
<td>GAMMA</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
<td>no units</td>
</tr>
<tr>
<td><strong>Loads and Boundary Conditions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>Temp, TREF, NT</td>
<td>°F</td>
<td>°K</td>
<td>°C</td>
<td>°K</td>
</tr>
<tr>
<td>Time</td>
<td>Time</td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
<td>seconds</td>
</tr>
<tr>
<td>Velocity</td>
<td>VX, VY, VZ</td>
<td>in/sec</td>
<td>m/sec</td>
<td>cm/sec</td>
<td>cm/sec</td>
</tr>
<tr>
<td>Pressure</td>
<td>P</td>
<td>lbs/in²</td>
<td>N/m²</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Volume Heating</td>
<td>Element Heat, QE</td>
<td>BTU/sec in³</td>
<td>W/m³</td>
<td>Cal/sec cm³</td>
<td>W/cm³</td>
</tr>
<tr>
<td>Linear Acceleration</td>
<td>acel</td>
<td>in/sec²</td>
<td>m/sec²</td>
<td>cm/sec²</td>
<td>cm/sec²</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>omega, cgomega</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
<td>rad/sec</td>
</tr>
<tr>
<td>Dissipation Rate</td>
<td>EPS</td>
<td>in³/sec³</td>
<td>m³/sec³</td>
<td>cm³/sec³</td>
<td>cm³/sec³</td>
</tr>
<tr>
<td>Density</td>
<td>DNS</td>
<td>lbs sec³/in⁴</td>
<td>kg/m³</td>
<td>kg sec³/cm³</td>
<td>g/cm³</td>
</tr>
<tr>
<td>Density Gradient</td>
<td>DX</td>
<td>(lbs sec³/in⁴)/in</td>
<td>(kg/m³)/m</td>
<td>(kg sec³/cm³)/cm</td>
<td>(g/cm³)/cm</td>
</tr>
<tr>
<td>Velocity Gradient</td>
<td>UX, VX, WX</td>
<td>(in/sec)/in</td>
<td>(m/sec)/m</td>
<td>(cm/sec)/cm</td>
<td>(cm/sec)/cm</td>
</tr>
<tr>
<td>Temperature or Energy Gradient</td>
<td>TEX</td>
<td>°F/in</td>
<td>°K/m</td>
<td>°C/cm</td>
<td>°K/cm</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td>VX, VY, VZ, RES</td>
<td>in/sec</td>
<td>m/sec</td>
<td>cm/sec</td>
<td>cm/sec</td>
</tr>
<tr>
<td>Temperature</td>
<td>TEMP</td>
<td>°F</td>
<td>°K</td>
<td>°C</td>
<td>°K</td>
</tr>
<tr>
<td>Temperature Gradient</td>
<td>GRADX, GRAYD, GRADZ</td>
<td>°F/in</td>
<td>°K/m</td>
<td>°C/cm</td>
<td>°K/cm</td>
</tr>
<tr>
<td>Pressure</td>
<td>PRESS</td>
<td>lbs/in²</td>
<td>N/m²</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Stream Function</td>
<td>STREAM</td>
<td>in³/sec</td>
<td>m³/sec</td>
<td>cm³/sec</td>
<td>cm³/sec</td>
</tr>
<tr>
<td>Shear Stress</td>
<td>TAUXX, TAUZZ, TAUZXX</td>
<td>lbs/in²</td>
<td>N/m²</td>
<td>kg/cm²</td>
<td>dyne/cm²</td>
</tr>
<tr>
<td>Turbulence Kinetic Energy</td>
<td>TKE</td>
<td>in³/sec²</td>
<td>m³/sec²</td>
<td>cm³/sec²</td>
<td>cm³/sec²</td>
</tr>
<tr>
<td>Dissipation Rate</td>
<td>EPS</td>
<td>in³/sec³</td>
<td>m³/sec³</td>
<td>cm³/sec³</td>
<td>cm³/sec³</td>
</tr>
</tbody>
</table>

**Customarily referenced as MKS system by user community. Use MKS (option 2) in**
Table B-10. Table of Consistent Units for Electromagnetic Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>COSMOS Name</th>
<th><strong>SI2 (absolute)</strong></th>
<th><strong>CGS4 (absolute)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measure</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>X, Y, Z</td>
<td>m</td>
<td>cm</td>
</tr>
<tr>
<td><strong>Material Properties</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnetic Permeability</td>
<td>MPERM</td>
<td>Henry/m</td>
<td>10^5 Henry</td>
</tr>
<tr>
<td>Permittivity (dielectric constant)</td>
<td>PERMIT</td>
<td>Farad/m</td>
<td>10^{-13} Farad/cm</td>
</tr>
<tr>
<td>Coercivity</td>
<td>PMAQX, PMAFY, PMAQZ, PMAQR</td>
<td>Amp/m</td>
<td>Oersted</td>
</tr>
<tr>
<td>Electric Conductivity</td>
<td>ECONX, ECONY, ECONZ</td>
<td>mho/m</td>
<td>10^{-13} mho/cm</td>
</tr>
<tr>
<td>Residual Flux Density (BH curve)</td>
<td>Br</td>
<td>Telsa</td>
<td>Gauss</td>
</tr>
<tr>
<td><strong>Loads and Boundary Conditions</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Time</td>
<td>seconds</td>
<td>seconds</td>
</tr>
<tr>
<td>Potential (electrostatic and current analysis)</td>
<td>NP</td>
<td>Volt</td>
<td>Volt</td>
</tr>
<tr>
<td>Vector Magnetic Potential (2D analysis)</td>
<td>NP</td>
<td>Weber/m</td>
<td>Gauss cm</td>
</tr>
<tr>
<td>Scaler Magnetic Potential (3D analysis)</td>
<td>NP</td>
<td>Amp</td>
<td>Gilbert</td>
</tr>
<tr>
<td>Concentrated Current</td>
<td>Nodal Current, NJ</td>
<td>Amp</td>
<td>AbAmp</td>
</tr>
<tr>
<td>Volume Current</td>
<td>Element Current, J</td>
<td>Amp-Turn/m^2</td>
<td>AbAmp-Turn/cm^2</td>
</tr>
<tr>
<td>Current Source</td>
<td>JS</td>
<td>Amp-Turn</td>
<td>AbAmp-Turn</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Potential (electrostatic and current analysis)</td>
<td>MPOTEN</td>
<td>Volt</td>
<td>Volt</td>
</tr>
<tr>
<td>Vector Magnetic Potential (2D analysis)</td>
<td>MPOTEN</td>
<td>Weber/m</td>
<td>Gauss cm</td>
</tr>
<tr>
<td>Scaler Magnetic Potential (3D analysis)</td>
<td>MPOTEN</td>
<td>Amp</td>
<td>Gilbert</td>
</tr>
<tr>
<td>Magnetic Flux</td>
<td>mfluxx, mfluxy, mfluxz, mfluxR</td>
<td>Telsa</td>
<td>Gauss</td>
</tr>
<tr>
<td>Magnetic Field Intensity</td>
<td>MFIELDX, MFIELDY, MFIELDZ, MFIELDR</td>
<td>Amp/m</td>
<td>Oersted</td>
</tr>
<tr>
<td>Electric Field Intensity</td>
<td>EFIELDX, EFIELDY, EFIELDZ, EFIELDR</td>
<td>Volt/m</td>
<td>10^4 Volt/cm</td>
</tr>
<tr>
<td>Magnetic Force</td>
<td>MFORCEX, MFORCEY, MFORCEZ, MFORCER</td>
<td>Newton</td>
<td>dyne</td>
</tr>
<tr>
<td>Current Density</td>
<td>CURDENX, CURDENY, CURDENZ, CURDENR</td>
<td>Amp/m^2</td>
<td>AbAmp/cm^2</td>
</tr>
</tbody>
</table>

**Customarily referenced as MKS system by user community. Use MKS (option 2) in...**
Introduction

This appendix contains description of the COSMOS/M database files as well as information about the COSMOS/M database utility program.

Database Files

This section lists files that are used and/or generated by COSMOS/M modules. Most of the files are transparent to the user where no interaction is needed with them. A brief description is given for the contents of each file.

GEOSTAR Module

The user most-dealt-with files are:

1. ufn.SES stores history of all action commands issued during a session.
2. ufn.GFM is a geometric or neutral format file similar to the session file.
3. ufn.OUT details the analysis input, results and error messages.
4. GEOFUN assigns valid commands to function keys. You may edit the GEOFUN file as desired by a text editor.

An example of key definitions for GEOFUN file is shown in Table C-1 based on version 5.0 of MS-DOS.
The geometric entities information is placed in the following files:

1. ufn.GPT for keypoints.
2. ufn.GCR for curves.
3. ufn.GSF for surfaces.
4. ufn.GVL for volumes.
5. ufn.GCT for contours.
6. ufn.GRG for regions.
7. ufn.CSY for coordinate systems.
8. ufn.GPH for polyhedra.
9. ufn.GPA for parts.

The finite element information is stored in the following files:

1. ufn.NOD for nodes.
2. ufn.ELE for elements.
3. ufn.LOD for loads.
4. ufn.EPR for pressure loads.
5. ufn.EGR for element groups.
6. ufn.MAT for material properties.
7. ufn.RLC for real constants.
8. ufn.MAS for communication with other modules.
9. ufn.RUF for debugging information.
10. ufn.GEN for general information.
11. ufn.LIS for list and help commands (default name). See the LISTLOG command.
12. ufn.I?? for saving image files (default name). (? = 0, 1, 2,...,9)
13. ufn.H?? for saving HALO files (default name). (? = 0, 1, 2,...,9)
14. ufn.P?? for saving images in PostScript format (default name). (? = 0, 1, 2,..., 9)
15. ufn.M?? for saving images in meta format (default name). (? = 0, 1, 2,..., 9)
16. ufn.D?? for saving images in DXF/2D format (default name). (? = 0, 1, 2,..., 9)
### Table C-1. Default GEOfun File

<table>
<thead>
<tr>
<th>ASCII Code</th>
<th>COSMOS/M Command</th>
<th>ASCII Code</th>
<th>COSMOS/M Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
<td>status1;</td>
<td>94</td>
<td>nplot;</td>
</tr>
<tr>
<td>60</td>
<td>distance</td>
<td>95</td>
<td>eplot;</td>
</tr>
<tr>
<td>61</td>
<td>status3;</td>
<td>96</td>
<td>view,1,0,0,0;</td>
</tr>
<tr>
<td>62</td>
<td>view,1,1,1;</td>
<td>98</td>
<td>initSel;</td>
</tr>
<tr>
<td>63</td>
<td>plane,z;</td>
<td>99</td>
<td>selRange;</td>
</tr>
<tr>
<td>64</td>
<td>gridon;</td>
<td>100</td>
<td>selwin;</td>
</tr>
<tr>
<td>65</td>
<td>acttemp</td>
<td>101</td>
<td>translate</td>
</tr>
<tr>
<td>67</td>
<td>tempPlot;</td>
<td>102</td>
<td>idRes</td>
</tr>
<tr>
<td>68</td>
<td>actDisp</td>
<td>103</td>
<td>listLog</td>
</tr>
<tr>
<td>133</td>
<td>actStr</td>
<td>137</td>
<td>animate;</td>
</tr>
<tr>
<td>134</td>
<td>strPlot,,,,,1,1,</td>
<td>138</td>
<td>cmdList;</td>
</tr>
<tr>
<td>84</td>
<td>ptPlot;</td>
<td>71</td>
<td>rotate,0,45,0,0,0;</td>
</tr>
<tr>
<td>85</td>
<td>crPlot;</td>
<td>72</td>
<td>ZoomOut;</td>
</tr>
<tr>
<td>86</td>
<td>sfPlot;</td>
<td>73</td>
<td>system</td>
</tr>
<tr>
<td>87</td>
<td>view;</td>
<td>75</td>
<td>pScale</td>
</tr>
<tr>
<td>88</td>
<td>ctPlot;</td>
<td>77</td>
<td>scale;</td>
</tr>
<tr>
<td>89</td>
<td>rgPlot;</td>
<td>79</td>
<td>rotate,0,0,45,0,0;</td>
</tr>
<tr>
<td>90</td>
<td>shade,1,1,6,;</td>
<td>80</td>
<td>ZoomIn</td>
</tr>
<tr>
<td>91</td>
<td>shade,0,;</td>
<td>81</td>
<td>rotate,30,0,0,0,0;</td>
</tr>
<tr>
<td>93</td>
<td>actXypre,</td>
<td>82</td>
<td>repaint;</td>
</tr>
<tr>
<td>135</td>
<td>actXypost,</td>
<td>83</td>
<td>CLS;</td>
</tr>
<tr>
<td>136</td>
<td>xyPlot;</td>
<td>119</td>
<td>rotate,0,-45,0,0,0;</td>
</tr>
<tr>
<td>104</td>
<td>ACTNUM,EL,1,</td>
<td>141</td>
<td>sf4Cord</td>
</tr>
<tr>
<td>105</td>
<td>ACTNUM,ND,1,</td>
<td>132</td>
<td>rotate,-30,0,0,0,0;</td>
</tr>
<tr>
<td>106</td>
<td>ACTNUM,EL,0,</td>
<td>115</td>
<td>eGroup</td>
</tr>
<tr>
<td>108</td>
<td>rotate,9,0,0,0,0;</td>
<td>116</td>
<td>RCONST</td>
</tr>
<tr>
<td>109</td>
<td>rotate,0,9,0,0,0;</td>
<td>117</td>
<td>rotate,0,0,-45,0,0;</td>
</tr>
<tr>
<td>110</td>
<td>rotate,0,0,9,0,0;</td>
<td>145</td>
<td>PICK_MAT;</td>
</tr>
<tr>
<td>113</td>
<td>exit;</td>
<td>118</td>
<td>rotate,-30,0,0,0,0;</td>
</tr>
<tr>
<td>139</td>
<td>nl_gsList;</td>
<td>146</td>
<td>el,pt,0,1</td>
</tr>
<tr>
<td>140</td>
<td>nl_gsPlot</td>
<td>147</td>
<td>el,cr,0,2</td>
</tr>
</tbody>
</table>
STAR Module (Linear Static Analysis)

**Input files**
1. ufn.MAS  Master control
2. ufn.NOD  Nodes
3. ufn.CSY  Coordinate systems
4. ufn.ELE  Elements
5. ufn.EGR  Element groups
6. ufn.RLC  Real constant sets
7. ufn.MAT  Material property sets
8. ufn.ILC  Element special loadings
9. ufn.SUB  Substructures
10. ufn.ITC  Temperature curves
11. ufn.ICT  Constraints
12. ufn.LOC  Prescribed displacements and local constraints
13. ufn.DIS  General information for displacements
14. ufn.IDA  ID array
15. ufn.LDS  Load vectors
16. ufn.ELM  Grouped element information
17. ufn.MSF  Information for frequency analysis
18. ufn.DIR  Large-file management information

**Output files**
18. ufn.OUT  ASCII output file
19. ufn.LCD  Displacements for plotting and stress calculations
20. ufn.STF  Working file for storing the stiffness matrix
21. ufn.DIA  Diagonal terms of stiffness matrix

STRESS Module (Stress Analysis)

**Input files**
1. ufn.MAS  Master control
2. ufn.NOD  Nodes
Chapter

3. ufn.CSY  Coordinate systems
4. ufn.ELE  Elements
5. ufn.EGR  Element groups
6. ufn.RLC  Real constant sets
7. ufn.MAT  Material property sets
8. ufn.SUB  Substructures
9. ufn.ITC  Time curves
10. ufn.DYN  Post
11. ufn.LOC  Prescribed constraints
12. ufn.DIS  General information for displacements
13. ufn.IDA  ID array
14. ufn.ELM  Element information
15. ufn.FRC  Fixed end forces for beam loading
16. ufn.LCD  Displacements for stress calculations

Output files
17. ufn.OUT  ASCII output file
18. ufn.AIS  AISC code check
19. ufn.STE  Element and nodal stresses for linear static analysis
20. ufn.STP  Element and nodal stresses for post dynamics

RENUMBER Module

Input files
1. ufn.MAS  Master control
2. ufn.NOD  Nodes
3. ufn.ELE  Elements
4. ufn.ICT  Constraints

Output files
5. ufn.RNM  ASCII output for renumbered nodes
6. ufn.REN  Binary file for renumbered nodes
Chapter

**DSTAR Module (Frequency and Buckling Analyses)**

**Input files**
1. ufn.MAS  Master control
2. ufn.NOD  Nodes
3. ufn.IDA  ID array
4. ufn.MAS  Frequency analysis

**Output files:**
5. ufn.OUT  ASCII output
6. ufn.EIG  Eigenfunctions (values and vectors)
7. ufn.LCM  Eigenfunctions for postprocessing

**HSTAR Module (Thermal Analysis)**

**Input files**
1. ufn.MAS  Master control
2. ufn.NOD  Nodes
3. ufn.CSY  Coordinate systems
4. ufn.ELE  Elements
5. ufn.EGR  Element groups
6. ufn.RLC  Real constant sets
7. ufn.MAT  Material property sets
8. ufn.ITC  Time/temp curves
9. ufn.TR1  Surface relation for view factor in GEOSTAR
10. ufn.TR2  Node information for view factor in GEOSTAR
11. ufn.INI  Initial conditions
12. ufn.EPR  Heat generation rates
13. ufn.DSP  Node temperature
14. ufn.HRT  Restart
15. ufn.WRK  Temporary unformatted work unit
16. ufn.BFG  Unformatted unit required for BFGS vectors
17. ufn.ICT  Constraint information
Chapter

18. ufn.JB1 Joint-bond information
19. ufn.JB2 Joint-bond information
20. ufn.LOD Load cases
21. ufn.RSD Convergence information
22. ufn.VWF Radiation view factor

Output files
23. ufn.TEM ASCII output
24. ufn.HTO Heat transfer results for graphical display

NSTAR Module (Nonlinear Static and Dynamic Analysis)

Input files
1. ufn.MAS Master control
2. ufn.NOD Nodes
3. ufn.CSY Coordinate systems
4. ufn.ELE Elements
5. ufn.EGR Element group sets
6. ufn.RLC Real constant sets
7. ufn.MAT Material property sets
8. ufn.PSR Element pressure
9. ufn.INI Initial conditions (displacement, velocity and acceleration)
10. ufn.ILC Centrifugal and gravity loading
11. ufn.ICT Constraints
12. ufn.LDS Mechanical load vectors written in single precision corresponding to various time curves
13. ufn.IDA ID array
14. ufn.LDT List of flags from PRE1 prescribed displacements and reaction forces
15. ufn.NTP Nodal temperatures for different time curves
16. ufn.ELM Grouped element
17. ufn.HTO File written in HSTAR with nodal temperatures at different time steps
### Variables for nonlinear material models

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>18. ufn.NP1</td>
<td>Variables for nonlinear material models</td>
</tr>
<tr>
<td>19. ufn.NP2</td>
<td>Variables for nonlinear material models</td>
</tr>
<tr>
<td>20. ufn.STF</td>
<td>Stiffness matrix is written in blocks</td>
</tr>
<tr>
<td>21. ufn.CBM</td>
<td>Used for Lagrangian beam</td>
</tr>
<tr>
<td>22. ufn.CBS</td>
<td>Used for Lagrangian beam</td>
</tr>
<tr>
<td>23. ufn.BML</td>
<td>Beam stress and strains at different integration points</td>
</tr>
<tr>
<td>24. ufn.STR</td>
<td>Stress and strain information for PLANE2D (QM6)</td>
</tr>
<tr>
<td>25. ufn.BFG</td>
<td>Updating vectors for stiffness matrix in BFGS method</td>
</tr>
<tr>
<td>26. ufn.GAP</td>
<td>Gap information</td>
</tr>
<tr>
<td>27. ufn.WMT</td>
<td>Water motion table</td>
</tr>
<tr>
<td>28. ufn.SDM</td>
<td>Rayleigh damping stiffness at time=0</td>
</tr>
<tr>
<td>29. ufn.RES</td>
<td>Results verification (read by NSTAR)</td>
</tr>
<tr>
<td>30. ufn.ITC</td>
<td>Time/temperature/stress-strain curve</td>
</tr>
<tr>
<td>31. ufn.MSH</td>
<td>Contact related information</td>
</tr>
<tr>
<td>32. ufn.PLN</td>
<td>Restart related information</td>
</tr>
<tr>
<td>33. ufn.DSP</td>
<td>Local boundary conditions</td>
</tr>
<tr>
<td>34. ufn.JB2</td>
<td>Joint-bond information</td>
</tr>
<tr>
<td>35. ufn.MSF</td>
<td>Save mass/stiffness for other module(s) (use the same dummy unit number)</td>
</tr>
<tr>
<td>36. ufn.DIA</td>
<td>Save mass/stiffness for other module(s) (use the same dummy unit number)</td>
</tr>
</tbody>
</table>

### Output files

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>37. ufn.OUT</td>
<td>ASCII output file, detailed information, disp, stress and strain output</td>
</tr>
<tr>
<td>38. ufn.LCN</td>
<td>Nodal response (displacement, velocity and acceleration) for <strong>NL_PLOT</strong> and <strong>NL_NRESP</strong></td>
</tr>
<tr>
<td>39. ufn.STN</td>
<td>Element/Nodal stress/force/strain for <strong>NL_PLOT</strong> and <strong>NL_NRESP</strong></td>
</tr>
<tr>
<td>40. ufn.PL3</td>
<td>Nodal displacements for plot files at user specified time steps using <strong>DEPLT</strong> command (to be used with FSTAR)</td>
</tr>
<tr>
<td>41. ufn.PL4</td>
<td>Nodal stress, strain information at user specified time steps using <strong>DEPLT</strong> command. This stress and strain information is written in single precision (to be used with FSTAR)</td>
</tr>
</tbody>
</table>
Chapter

FSTAR Module (Fatigue Analysis)

Input files
1. ufn.MAS Master control
2. ufn.NOD Nodes
3. ufn.CSY Coordinate systems
4. ufn.ELE Elements
5. ufn.EGR Element group sets
6. ufn.RLC Real constant sets
7. ufn.MAT Material property sets
8. ufn.FTC Fatigue
9. ufn.HTO Heat transfer
10. ufn.STE Element and nodal stresses of linear static analysis
11. ufn.STN Element and nodal stresses of nonlinear analysis

Output files
12. ufn.FTG Fatigue output
13. ufn.FTI Fatigue postprocessing

FLOWSTAR Module (Computational Fluid Dynamic Analysis)

Input files
1. ufn.MAS Master control
2. ufn.NOD Nodes
3. ufn.CSY Coordinate systems
4. ufn.ELE Elements
5. ufn.EGR Element group sets
6. ufn.MAT Material property sets
7. ufn.DSP Nodal constraints
8. ufn.EPR Thermal loading
9. ufn.PSR Element pressure
10. ufn.INI Initial conditions
11. ufn.ITC Time/temperature curves
Chapter

12. ufn.RNM    Renumbering
13. ufn.RST    Restart

Output files

14. ufn.OUT    ASCII output
15. ufn.FLO    Plotting

ESTAR Module (Electromagnetics Analysis)

Input files

1. ufn.MAS    Master control
2. ufn.NOD    Nodes
3. ufn.CSY    Coordinate systems
4. ufn.ELE    Elements
5. ufn.EGR    Element groups
6. ufn.DSP    Nodal potentials
7. ufn.MAT    Material property sets
8. ufn.HRT    Restart
9. ufn.SUB    Substructures
10. ufn.ITC    Time curves
11. ufn.ICT    Constraints
12. ufn.EPR    Charge or current density
13. ufn.INI    Initial conditions
14. ufn.MAG    3D current sources
15. ufn.REN    Renumber
16 ufn.WRK    Temporary unformatted work unit
17. ufn.ELM    Temporary unformatted unit

Output files

16. ufn.OUT    ASCII output file
17. ufn.MGN    Electromagnetic results for nodes
18. ufn.MGE    Electromagnetic results for elements
19. ufn.VER    Formatted results verification unit
ASTAR Module (Post Dynamic Analysis)

Input files
1. ufn.MAS Master control
2. ufn.NOD Nodes
3. ufn.CSY Coordinate systems
4. ufn.LOD Prescribed nodal forces
5. ufn.INI Initial conditions
6. ufn.DYN Master control
7. ufn.CVC Load curves
8. ufn.FPS Nodal forces
9. ufn.PIN Initial conditions
10. ufn.GDS Gaps and dampers
11. ufn.IDA ID array
12. ufn.MSF Frequency analysis
13. ufn.EIG Eigenfunctions from frequency analysis
14. ufn.RLD Dummy file (response spectrum analysis)
15. ufn.RES Mode displacements (response spectrum analysis)
16. ufn.BAS Base motion information (time-history analysis)
17. ufn.MDP Modal response (time-history analysis)
18. ufn.VBS Base PSD information (random vibration analysis)
19. ufn.VSD PSD of modal response (random vibration analysis)
20. ufn.VMS RMS of modal response (random vibration analysis)
21. ufn.HBS Base motion information (harmonic analysis)
22. ufn.HRS Modal response (harmonic analysis)
23. PHI.DAT Dummy file
24. SPEC.DUM Dummy file

Output files
25. ufn.OUT ASCII output
26. ufn.PLT Graphs
27. ufn.LAB Labels for the PLT file
28. ufn.PSV Pseudo velocity spectra
29. ufn.PSA  Pseudo acceleration spectra
30. ufn.RLD  Relative displacement spectra
31. ufn.RLV  Relative velocity spectra
32. ufn.ABA  Absolute acceleration spectra
33. ufn.CR1  1st generated time history
34. ufn.CR2  2nd generated time history
35. ufn.CR3  Corrected first generated time history
36. ufn.CR4  Corrected 2nd generated time history

**OPTSTAR Module (Design Optimization)**

**Input files**
1. ufn.MAS  Master control
2. ufn.DVA  Design variables for optimization and sensitivity
3. ufn.DCO  Behavior constraints for optimization
4. ufn.DOB  Objective function for optimization
5. ufn.DSN  Response quantities for sensitivity

**Output files**
6. ufn.OPT  ASCII output

**Database Utility**

The COSMOS/M database utility program consists of an object library, link information file, several sample problems and a READ.ME file. The utility enables the user to communicate with the COSMOS/M database files.

For more information about this section, please contact Structural Research.
Translators

Introduction

In this appendix, the capabilities and limitations of translators available in the COSMOS/M system are presented. The translators used in GEOSTAR are:

**IGES**
A two-way interface to read or write files in the IGES format that are created by other CAD packages (IGES_GS and GS_IGES programs).

**DXF**
A two-way interface to read or write files in the DXF format that are created by other CAD packages (DXF_GS and GS_DXF programs).

**PATRAN**
A two-way interface to translate data between COSMOS/M and PATRAN (COS2PAT and PAT2COS programs).

**Pro/ENGINEER**
A one-way interface to translate Pro/ENGINEER and PT/Modeler geometry to GEOSTAR (PRO2GEO program).

**ABAQUS**
A one-way interface to translate COSMOS/M input to the ABAQUS (COS2ABQ program).

**ANSYS**
A two-way interface to translate data between COSMOS/M and ANSYS (COS2ANS and ANS2COS programs).
NASTRAN  A two-way interface to translate data between COSMOS/M and NASTRAN (COS2NAS, POSTNAS and NAS2COS programs).

SINDA  A one-way interface to translate COSMOS/M input to SINDA (COS2SND program).

**Working with CAD**

You may build your geometry directly in GEOSTAR or you may use your favorite CAD or solid modeling system and export the geometry to GEOSTAR. Models created by the following CAD systems can be imported to GEOSTAR as shown in the CAD_INP (Control > CAD System > Read CAD Input) command:

- **0: Generic**  Try this option to read IGES files from a CAD system not included in one of the other options in the menu.
- **1: Pro/E 1-17, PT/M 1**  Pro/ENGINEER releases 1 through 17 and PT/Modeler release 1
- **2: BSI-Modeler**  MicroStation Modeler
- **2: SolidWorks**  SolidWorks
- **3: CV-CADDS5**  Computervision CADDS5
- **4: Unigraphics**  Unigraphics
- **4: Pro/E 18+, PT/M 2+**  Pro/ENGINEER releases 18 or later and PT/Modeler releases 2 or later
- **4: Helox**  Helix Modeling.
- **4: Eureka**  Eureka (Cad.Lab)
- **5: IDEAS**  IDEAS (SDRC)

Assemblies from SolidWorks are directly imported as geo files through COSMOS/Works. You may run basic types of analyses in COSMOS/Works or import the geo file to GEOSTAR to perform advanced analyses.

COSMOS/DesignSTAR is a product of Structural Research and Analysis Corp. that is dedicated to working with CAD systems.
In the following sections, a brief description of the available translators is presented.

**IGES Translator**

The GEOSTAR IGES format translator is based on the Initial Graphics Exchange Specification, a trademark of the National Institute of Standards and Technology.

The translator provides two-way interface. IGES files created by other CAD packages can be imported to GEOSTAR to perform finite element analysis. Also, based on existing database files generated by GEOSTAR, the translator can be used to export geometry from GEOSTAR to other CAD systems.

**Limitations of the IGES Translator**

The GEOSTAR IGES format translator supports the following IGES Geometry entities:

<table>
<thead>
<tr>
<th>Entity No.</th>
<th>Entity Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Circular arc</td>
</tr>
<tr>
<td>102</td>
<td>Composite Curve (maximum number of component GEOSTAR curves is 250)</td>
</tr>
<tr>
<td>104</td>
<td>Conic Arc</td>
</tr>
<tr>
<td>106</td>
<td>Copious Data (forms 1, 2, 3, 11, 12, 13, 63)</td>
</tr>
<tr>
<td>108</td>
<td>Plane (normal to axis only)</td>
</tr>
<tr>
<td>110</td>
<td>Line</td>
</tr>
<tr>
<td>112</td>
<td>Parametric Spline Curve (up to 4000 segments)</td>
</tr>
<tr>
<td>114</td>
<td>Parametric Spline Surface (up to 4000 patches)</td>
</tr>
<tr>
<td>116</td>
<td>Point</td>
</tr>
<tr>
<td>118</td>
<td>Ruled surface</td>
</tr>
<tr>
<td>120</td>
<td>Surface of Revolution</td>
</tr>
<tr>
<td>122</td>
<td>Tabulated Cylinder</td>
</tr>
<tr>
<td>124</td>
<td>Transformation Matrix</td>
</tr>
<tr>
<td>126</td>
<td>Rational B-Spline Curve (degree=3 only, number of control points is between 4 and 500)</td>
</tr>
<tr>
<td>128</td>
<td>Rational B-Spline Surface (degree=3 only, number of control points in either u or v direction is between 4 and 40)</td>
</tr>
<tr>
<td>130</td>
<td>Offset curve (uniformed offset or single value)</td>
</tr>
</tbody>
</table>
If an IGES file generated by other CAD package has any entities other than those listed above, the program will write information about these unsupported entities in the report file for user reference.

**How to Use the IGES Translators**

The IGES format translator has two separate programs: GS_IGES.EXE and IGES_GS.EXE. These two programs can be executed from GEOSTAR or independently from a DOS window.

1. **IGES_GS.EXE**

   The IGES_GS Program can be invoked through GEOSTAR by using the “IGES_INP” command (Control > CAD System > Read IGES).

   IGES_GS takes an IGES format file (file with “igs” extension) generated by other CAD systems as input, and generates a GEOSTAR input file (file with “geo” extension) which can be read by GEOSTAR to recreate the model. The translator creates a report file (with “rpt” extension) which contains information about processed entities and a list of encountered entities which are not supported.

   When running IGES_GS independently from a DOS window, the available options are listed below:

<table>
<thead>
<tr>
<th>Entity No.</th>
<th>Entity Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>140</td>
<td>Offset surface</td>
</tr>
<tr>
<td>141</td>
<td>Boundary</td>
</tr>
<tr>
<td>142</td>
<td>Curve on a Surface</td>
</tr>
<tr>
<td>143</td>
<td>Bounded Surface (except for regions with an underlying surface) (explicit outer boundary curve, underlying surface must be single patch after translation or flat)</td>
</tr>
<tr>
<td>144</td>
<td>Trimmed Surface (except for regions with an underlying surface) (explicit outer boundary curve, underlying surface must be single patch after translation or flat)</td>
</tr>
<tr>
<td>308</td>
<td>Subfigure (up to 400 subfigures)</td>
</tr>
<tr>
<td>402</td>
<td>Group (form 1, 7, 14, 15) (up to 400 groups)</td>
</tr>
<tr>
<td>408</td>
<td>Singular subfigure instance</td>
</tr>
</tbody>
</table>
Chapter

/H     Print help messages for user reference.
/S     Run silent version, no screen output. By default, the program will run the nonsilent version which will print processing information on the screen for user reference. The user can suppress this information to speed up the program execution.
/cr    Translate curves only.
/SF    Translate spline and B-spline surfaces only (114 and 128 entities).
/NP    No pause at the end of screen output. By default, the program will wait for the user to hit a key before terminating itself. This feature gives the user more time to assess the screen output. The /NP option will force the program to terminate right after processing all entities in the IGES file.
/I=Input_file Specify input file name. If the user does not specify this option, the program will prompt for the input file name. To run IGES_GS, the input file must be given a name with the “IGS” extension.

The following options specify the order of translation:

/ff    First read, first translate.
/el    Lower entity level first, i.e. transformation matrix, points, curves, surfaces, contours, regions, groups, subfigures, and subfigure instances.
/tm    Translate transformation matrix first.

Examples
a.  iges_gs /i=data /s
    Run silent version of the translator with input file DATA.IGS. Two files are generated: DATA.GEO as the output file and DATA.RPT as the report file.

b.  iges_gs /i=data /np
    Run nonsilent version of the translator with DATA.IGS as the input file. No pause at the end of screen output.

c.  iges_gs
    Run nonsilent version of the translator interactively. The program will ask for the input file name and start execution with default settings.
2. **GS_IGES.EXE**

The GS_IGES program can be invoked through GEOSTAR by using the “IGES_OUT” command (Control > CAD System > Write IGES).

Based on existing database files generated by GEOSTAR, the GS_IGES translator creates a file in the IGES format with “igs” extension. It can then be read by another CAD system. At the end of the created IGES file, a summary of processed entities is given.

When running GS_IGES independently from a DOS window, the available options are listed below:

- **/H**
  - Print help messages for user reference.

- **/S**
  - Run silent version, no screen output. By default, the program will run the nonsilent version which will print processing information on the screen for user reference. The user can suppress this information to speed up the program execution.

- **/NP**
  - No pause at the end of screen output. By default, the program will wait for user to hit a key before terminating itself. This feature will give the user more time to assess the screen output. The /NP option will make the program terminate right after generating the IGES file.

- **/I=Input_file**
  - Specify input database file name. If the user does not specify this option, the program will prompt for the input database file name.

- **/O=Output_file**
  - Specify the output filename. If the user does not specify this option, the program will take input filename as default.

**Examples**

a. `gs_iges /i=data /s`
   - Run silent version of the translator based upon the database files of problem “data”. An output file DATA.IGS will be generated.

b. `gs_iges /i=data /np`
   - Run nonsilent version of the translator based upon the database files of problem “data”. An output file DATA.IGS will be generated and no pause is given at the end of screen output.

c. `gs_iges`
Chapter

Run nonsilent version of the translator interactively. The program will ask for
the name of the input database files and start execution with default settings.

**DXF Translator**

The GEOSTAR DXF format translator is based on the Drawing Interchange and
File Formats of AutoCAD from Autodesk Inc.

DXF files created by other CAD packages can be read by GEOSTAR to perform
finite element analysis. Also, GEOSTAR can generate DXF files that can be read
by other CAD systems.

**Limitations of the DXF Translator**

The GEOSTAR DXF format translator supports the following entities:

- **LINE**
- **POINT**
- **CIRCLE**
- **ARC**
- **POLYLINE**
  
  (The option of a non-zero bulge for VERTEX in a POLYLINE is
  VERTEX supported to generate arc segments rather than line
  segments.)
- **3DLINE**
- **3DFACE**

If the DXF file generated by other CAD package has any entities other than those
listed above, the program will write information about these unsupported entities in
the report file for user reference. Entities contained in a BLOCK will not be
translated. It is recommended that the geometric model be written into IGES format
and translated to GEOSTAR through IGES_GS which now supports subfigure and
singular subfigure insertion.
Chapter

How to Use the DXF Translators

The GEOSTAR DXF format translator has two separate programs:

- **DXF_GS.EXE**: Translates DXF files created by other CAD systems to “GEO” files which can be read by GEOSTAR.
- **GS_DXF.EXE**: Extracts information from GEOSTAR database files and generates DXF files which can be read by other CAD systems.

These two programs can be executed from GEOSTAR or independently from a DOS window.

1. **DXF_GS.EXE**

   Program DXF_GS can be invoked through GEOSTAR by using the “**DXF_INP**” command (Control > CAD System > **Read DXF**).

   Program DXF_GS takes a DXF format file (file with “DXF” extension) generated by other CAD systems as input, and generates a GEOSTAR input file (file with “GEO” extension) which can be read by GEOSTAR to recreate the model. At the same time, the program creates a report file (file with “RPT” extension) which contains information about how many entities have been processed and a list of encountered entities which are not supported.

   In running DXF_GS independently, the available options are listed below:

   - **/H**: Print help messages for user reference.
   - **/S**: Run silent version, no screen output. By default, the program will run the nonsilent version which will print processing information on the screen for user reference. The user can suppress this information to speed up the program execution.
   - **/NP**: No pause at the end of screen output. By default, the program will wait for user to hit a key before terminating itself. This feature will give the user more time to assess the screen output. /NP option will cause the program to terminate right after processing all entities in the DXF file.
   - **/I=Input_file**: Specify input file name. If the user does not specify this option, the program will prompt for the input file name. To run DXF_GS, the input file must be given a name with the “DXF” extension.
Examples

a. dxf_gs /i=data /s
   Run silent version of the translator with input file DATA.DXF. Two files are
   generated: DATA.GEO as the output file and DATA.RPT as the report file.

b. dxf_gs /i=data /np
   Run nonsilent version of the translator with DATA.DXF as input file. No
   pause at the end of screen output.

c. dxf_gs
   Run nonsilent version of the translator interactively. The program will ask for
   the input file name and start execution with default settings.

2. GS_DXF.EXE

The GS_DXF program can be invoked through GEOSTAR by using the
“DXF_OUT” command (Control > CAD System > Write DXF).

Based upon existing database files generated by GEOSTAR, the GS_DXF
program creates a DXF format output file (for points and curves only) (file with
“DXF” extension) which can be read by other CAD systems. At the end of the
created DXF file (all information after the EOF is ignored by DXF), a summary
of processed entities will be given and no report file is generated.

In running GS_DXF independently, the available options are listed below:

/H
   Print help messages for user reference.

/S
   Run silent version, no screen output. By default, the
   program will run the nonsilent version which will
   print processing information on the screen for user
   reference. The user can suppress this information to
   speed up the program execution.

/NP
   No pause at the end of screen output. By default, the
   program will wait for user to hit a key before
   terminating itself. This feature will give the user
   more time to assess the screen output. The /NP
   option will cause the program terminate right after
   generating the DXF file.

/I=Input_file
   Specify input database file name. If the user does not
   specify this option, the program will prompt for the
   input database file name.

/O=Output_file
   Specify the output filename. If the user does not
   specify this option, the program will take input
   filename as default.
Examples

a. `gs_dxf /i=data /s`
   Run silent version of the translator based upon the database files of problem “data”. An output file (DATA.DXF) is generated.

b. `gs_dxf /i=data /np`
   Run nonsilent version of the translator based upon the database files of problem “data”. An output file (DATA.DXF) is generated and no pause is given at the end of screen output.

c. `gs_dxf`
   Run nonsilent version of the translator interactively, and the program will prompt for the input database files name and start execution with default settings.

ABAQUS Translator

The ABAQUS Translator offers a one-way interface from COSMOS/M to ABAQUS. The program, COS2ABQ translates Static, Frequency, Buckling, Nonlinear and Thermal (steady state and transient) COSMOS/M models to an ABAQUS input file. The translator can be activated either from the operating system, or from GEOSTAR using the `ABAQUSINP` command (Control > FEM INPUT > Write ABAQUS).

The following entities can be converted:

1. Coordinate systems.
2. Nodes.
3. Element group data of the following elements:
   - TRUSS2D Two dimensional Truss/Spar element
   - TRUSS3D Three dimensional Truss/Spar element
   - BEAM2D Two dimensional Elastic Beam element
   - BEAM3D Three dimensional Elastic Beam element
   - PIPE Elastic Straight pipe element
   - ELBOW Elastic curved pipe (Elbow) element
   - SPRING Spring element
   - MASS General Mass element
   - PLANE2D Two dimensional 4- to 8-node plane element
Chapter

4. Material properties and temperature curves.
5. Real constants.
7. Nodal and element loads.
10. Time and temperature curves.
11. Analysis type.

**ANSYS Translator**

The translator offers a two-way data interface between COSMOS/M and ANSYS. The translator is comprised of two programs: COS2ANS and ANS2COS.

**COSMOS/M to ANSYS**

COS2ANS prepares an ANSYS “Prep7” file using the COSMOS/M database files. The translator has the ability to convert Static, Frequency, Buckling and Thermal (steady state and transient) models. The translator can be activated either from the
operating system or from GEOSTAR using the ANSYSINP command (Control > FEM INPUT > Write ANSYS).

The following entities can be converted:

1. Coordinate systems.
2. Nodes.
3. Element group data of the following elements:
   - TRUSS2D  Two dimensional Truss/Spar element
   - TRUSS3D  Three dimensional Truss/Spar element
   - BEAM2D  Two dimensional Elastic Beam element
   - BEAM3D  Three dimensional Elastic Beam element
   - PIPE    Elastic Straight pipe element
   - ELBOW   Elastic curved pipe (Elbow) element
   - BOUND   Boundary element
   - SPRING  Spring element
   - MASS    General Mass element
   - GENSTIF General stiffness element
   - PLANE2D Two dimensional 4- to 8-node plane element
   - SHELLAX Axisymmetric shell element
   - SHELL3T Three node thick shell element
   - SHELL4T Four node thick shell element
   - SHELL3L Multi-layer shell/plate (3-Node) element
   - SHELL4L Multi-layer shell/plate (4-Node) element
   - SHELL3 Three-node thin shell element
   - SHELL4 Four node thin shell element
   - SOLID   Three dimensional solid (8-to 20-Node) element
   - SOLIDL  Composite 8-node solid element
   - RLINK   Radiation link
   - CLINK   Convection link
   - GAP     Gap element
   - FLOW2D  2D Fluid flow element
   - FLOW3D  3D Fluid flow element
   - MAG2D   2D Magnetic element
   - MAG3D   3D Magnetic element
   - SHELL9  9/8 node shell elements
ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M

ANSYS to COSMOS/M
The “/AUX12” utility is activated by adding the following commands to the end of the ANSYS “FILE18”:

\begin{verbatim}
NWRITE
EWRITE
MPWRITE
FINISH
/AUX12
\end{verbatim}

The translator automatically loads the above mentioned files and ignores any corresponding input data from a “Prep7” file.

\textbf{NASTRAN Translator}

The translator offers a two-way data interface between COSMOS/M and NASTRAN. The translator is comprised of three programs: COS2NAS, POSTNAS and NAS2COS.

\textbf{COSMOS/M to NASTRAN}

COS2NAS prepares a NASTRAN input file using the COSMOS/M database files. The translator has the ability to convert Static, Frequency, Buckling and Thermal (steady state and transient) models. The translator can be activated either from the operating system or from GEOSTAR using the \texttt{NASTRANINP} command (Control > FEM INPUT > \texttt{Write NASTRAN}).

Output from the COS2NAS translator can be generated in four different formats:

1. Short format
2. Long format
3. Short-form fixed format
4. Long-form fixed format

Next to the prompt for the type of format, the number corresponding to the chosen format can be entered. If an SPC (Single Point constraint) forces output is needed, option 5 may be used. If an older NASTRAN version is used, some old NASTRAN cards can be accessed by entering 6.
1. Coordinate systems.
2. Nodes.
3. Element group data of following elements:
   - TRUSS2D Two dimensional Truss/Spar element
   - TRUSS3D Three dimensional Truss/Spar element
   - BEAM2D Two dimensional Elastic Beam element
   - BEAM3D Three dimensional Elastic Beam element
   - PIPE Elastic Straight pipe element
   - ELBOW Elastic curved pipe (Elbow) element
   - BOUND Boundary element
   - SPRING Spring element
   - MASS General Mass element
   - GENSTIF General stiffness element
   - PLANE2D Two dimensional 4- to 8-node plane element
   - SHELLAX Axisymmetric shell element
   - SHELL3T Three-node thick shell element
   - SHELL4T Four-node thick shell element
   - SHELL3L Multi-layer shell/plate (3-Node) element
   - SHELL4L Multi-layer shell/plate (4-Node) element
   - SHELL3 Three-node thin shell element
   - SHELL4 Four-node thin shell elements
   - SOLID Three dimensional solid (8- to 20-Node) element
   - RLINK Radiation link
   - CLINK Convection link
   - GAP Gap element
   - SHELL9 9/8 node shell element
   - RBAR Rigid Bar element
   - TETRA4 Four-node tetrahedral solid element
   - TETRA10 Ten-node tetrahedral solid element
   - TRIANG Three- to nine-node triangular element
   - SHELL9L Composite 9/8 node shell elements

2. Nodes.
4. Material properties and temperature curves.
5. Real constants.
7. Nodal and element loads (Static and thermal).

Postprocessing NASTRAN Results In GEOSTAR

POSTNAS is a translator to allow postprocessing NASTRAN generated results (in the ".F06" or ".PRT" output files) using GEOSTAR for models initially preprocessed in GEOSTAR. The translator can be used from the operating system.

The translator's generated binary files can be used in GEOSTAR for the postprocessing of:
1. Displacements.
2. Mode shapes.
3. Nodal temperatures.
4. Bending moment diagrams.
5. Nodal or element stresses.

It should be noted that the NASTRAN output file has to copied into the directory where the model was translated by the COS2NAS program.

NASTRAN to COSMOS/M

NAS2COS converts a NASTRAN bulk data file into a GEOSTAR input session ".SES" file. The translator has the capability to convert Static, Frequency and Buckling models. The translator can be used from the operating system.

Input to the NAS2COS translator can be in four different formats:
1. Short format
2. Long format
3. Short-form fixed format
4. Long-form fixed format
The following NASTRAN entities can be converted by NAS2COS:

1. Coordinate systems.
2. Nodes.
3. Element group data.
4. Material properties.
5. Real constants.
7. Nodal and element loads.

The following NASTRAN commands can be converted by the NAS2COS:

```
APP CMAS3 CSET1 FORCE2 PBCOMP
AXIC CMAS4 CSHEAR FORCEAX PBEAM
AXIS CONM1 CTETRA GRAV PBEND
BAROR CONM2 CTRIARG GPSTR PCOMP
BEAMOR CONROD CTRAPRG GRDSET PCONAX
BSET BORDIC TRIAAX GRID PELAS
BSET1 BORDIR TRAPAX MAT1 PGAP
CBAR Cordis1 TRIA1 MAT2 PHBDY
CBEAM CORD2C TRIA2 MAT3 PHEX
CBEND CORD2R TRIA3 MAT4 PLOAD
CCONAX CORD2S TRIA6 MAT5 PLOADX
CELAS1 CPENTA TRIA6 MAT8 PLOAD1
CELAS2 CQMEM1 TRIM6 MAT9 PLOAD2
CELAS3 CQMEM2 TRIM7 MMAX PLOAD3
CELAS4 CQMPLT TRPLT MOMENT PLOAD4
CFUBE CQUAD1 CUBE1 MOMENT1 PMASS
CGAP CQUAD2 OWEDGE MOMENT2 PDMEM
CHEA CQUAD4 CRIGD1 MPC PONTAX
CHEX CQUAD8 CRIGD2 MPCAX PROD
CHEX20 CQUAD8 ESTR OMIT PSHEAR
CMAS1 CROD FORCE OMIT1 PSHL
CMAS2 CSET FORCE1 PBAR PSOLID

PATRAN Translator

The translator offers a two-way data interface between COSMOS/M and PATRAN. The translator is comprised of two programs: COS2PAT and PAT2COS.
COSMOS/M to PATRAN

COS2PAT generates a PATRAN neutral file “.PAT” using COSMOS/M database files. The translator can be activated either from the operating system or from GEOSTAR using the PATRAN command (Control > FEM INPUT > Write PATRAN).

The following entities can be converted:
1. Coordinate systems.
2. Nodes.
3. Element group data of the following elements:
   - MASS Mass element
   - TRUSS2D Two dimensional Truss/Spar element
   - TRUSS3D Three dimensional Truss/Spar element
   - RBAR Rigid bar element
   - SPRING Spring element
   - BEAM2D Two dimensional Elastic Beam element
   - BEAM3D Three dimensional Elastic Beam element
   - TRIANG Three-node triangular element
   - PLANE2D Two dimensional 4- to 8-node plane element
   - SHELL3 Three-node shell element
   - SHELL4 Four-node shell element
   - SOLID Three dimensional solid (8- to 20-node) element
   - TETRA4 Four-node tetrahedral solid element
   - TETRA10 Ten-node tetrahedral solid element
4. Material properties.
5. Real constants.
7. Static and Thermal Nodal loads.

PATRAN to COSMOS/M

PAT2COS prepares a GEOSTAR input file “.GEO” using PATRAN neutral input file (PHASE-II). The translator can be used from the operating system.
Chapter

The following entities can be converted:

1. Coordinate systems.
2. Nodes.
3. PATRAN elements (BAR, TRI, QUAD4, TET, PYR, WEDGE, HEX) to the following element groups:
   - MASS General Mass element
   - SPRING Spring element
   - TRUSS2D Two dimensional Truss/Spar element
   - TRUSS3D Three dimensional Truss/Spar element
   - BEAM2D Two dimensional Elastic Beam element
   - BEAM3D Three dimensional Elastic Beam element
   - TRIANG Three-node triangular element
   - PLAN2D Two dimensional 4- to 8-node plane element
   - SHELL3 Three-node shell element
   - SHELL4 Four-node shell element
   - SOLID Three dimensional solid (8- to 20-node) element
   - TETRA4 Four-node tetrahedral solid element
   - TETRA10 Ten-node tetrahedral solid element
4. Material properties.
5. Real constants.
7. Static and Thermal Nodal and element loads.

Pro/ENGINEER and PT/Modeler Translators

This translator offers a one-way interface from Pro/ENGINEER to COSMOS/M. The Pro/ENGINEER part geometry can be easily transferred into GEOSTAR for finite element meshing and analysis with the aid of this translator. The PRO2GEO program translates a file with the extension (.ntr) generated by the “COSMOS GEOM” command in Pro/ENGINEER.
You may also use the **CAD_INP** (Control > CAD System > Read PRO/E 1-17, PT/M 1) command to read in geometry from Pro/ENGINEER releases 1 through 17 as well as PT/Modeler version 1. Similarly, se the **CAD_INP** (Control > CAD System > Read PRO/E 18+, PT/M 2+) command to read in geometry newer release of Pro/ENGINEER and PT/Modeler.

### SINDA Translator

The SINDA translator offers a one-way interface between COSMOS/M and SINDA, a thermal analysis code, along with an interface to postprocess SINDA results in GEOSTAR.

The translator can be activated either from the operating system or from GEOSTAR using the **SINDAINP** command (Control > FEM INPUT > Write SINDA). The input file may be directly uploaded and used to execute SINDA. As well, any text editor may be used to modify the input file to add additional information, such as latent heat effects, or access the built-in SINDA subroutines. The following entities are converted:

1. Node Data (including SIV, SPV, DIV and DPV for variable properties)
2. Source Data (including SIV, SPV, DIV and DPV for variable properties)
3. Connector Data (including SIV and SPV for variable properties)
4. Constants Data
5. Array Data (for any tabular data entered in GEOSTAR)

The SINDA data file also contains section headers and enough input in to produce an executable input file without adding any additional information. The following sections are created:

1. EXECUTION
2. VARIABLES 1
3. VARIABLES 2
4. OUTPUT CALLS

The problem results may also be displayed in GEOSTAR through a series of commands which create GEOSTAR input files. The OUTPUT section contains a FORTRAN routine to write the SINDA output temperatures back into the COSMOS/M database.
Installation

The files on the translator disk are:

- **WS87.EXE, COS2SND.BAT** The executable translator program and batch file (PC version).
- **WS87, COS2SND** Executable and script file for the translator (workstations).
- **TPLOT, L_PLOT** GEOSTAR script files for graphical displays.
- **COS2SND.CFG** Example of a translator configuration file.
- **TKER, T_PLET, TSOLID.GEO** Sample problems.

For workstations, the file “mod.defaults” in the cosmosm/modsdir directory needs to be copied to the cosmosm directory.

Three sample problems are included to illustrate the flexibility of the interactive graphic modeling process to build thermal models for SINDA’87.

Using the Translator

GEOSTAR can be used in three different modes to build SINDA models:

1. Read the GEOSTAR input from a command list file.
2. Enter the data interactively from the GEOSTAR line prompt.
3. Use the mouse to access the command menus and follow the resulting prompts.

For the PC version, SINDA is linked to GEOSTAR through the COS2SND.BAT file which is used instead of the SINDA.BAT file given with SINDA. This file can be copied to the users directory and modified with a text editor to suit the users preference for operation.

To see how the translator works, run the three sample problems and verify that the paths used in the COS2SND.BAT file conform to your system. The results of the three problems are summarized in Table D-1.
To see how these problems are solved by SINDA, use the command line options and type:

`C:\COSWORK > GEOSTAR DEMO TKER.GEO`

GEOSTAR will then execute the problem in the batch mode where the commands are read sequentially from the input file. The commands are then transferred to the SINDA translator module to write the SINDA input file. In this demo, the problem is executed by SINDA ending back in the GEOSTAR module. GEOSTAR then reads a second command file (TPLOT) which displays the temperature contours from the SINDA steady state solution. After exiting GEOSTAR, any text editor can be used from the operating system to examine the SINDA input file (TAPE5) written by the translator or the SINDA output file (TAPE6).

Now try the GEOSTAR command line option to build and run the TPLATE.GEO problem:

Start GEOSTAR by entering:

`C:\COSWORK > GEOSTAR DEMO2`

The following commands are used:

```
EGROUP,1,SHELL4,0
   Use 4-node shell elements

MPROP,1,KX,1.0
   Define the material thermal conductivity

RCONST,1,1,1,1,1.0
   Define the length of the cylinder as 1.0

VIEW,0,0,1,0
   Set the view to use in displaying the model. This views the X-Y plane where the plate will be modeled

PT,1,0,0,0
```

---

**Table D-1. Results of the Three SINDA Sample Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Description</th>
<th>Analytical Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPLATE</td>
<td>Circular plate with source terms and convection</td>
<td>$T(1) = 250$</td>
</tr>
<tr>
<td>TSOLID</td>
<td>Solid rod with end boundary conditions</td>
<td>$T(1) = 121.42$</td>
</tr>
<tr>
<td>TKER</td>
<td>Kershaw problem for unsymmetric elements</td>
<td>$T = 100\times y$ coordinate</td>
</tr>
</tbody>
</table>
Define the first point to describe the plate and surfaces. The first point is the center line cylinder

\[
\text{PT}, 2, 1, 0, 0
\]

The second point defines the radius of the cylinder

\[
\text{CRLINE}, 1, 1, 2
\]

Define a line between the points

\[
\text{SFSWEEP}, 1, 1, 1, Z, 45;
\]

Rotate the line by 45 degrees

\[
\text{SCALE};
\]

Scale the display of the model. Note that a semicolon terminates input and uses defaults for all values not entered

\[
\text{M_SF}, 1, 1, 1, 4, 6, 7, 1, 1
\]

Mesh the problem using 6 elements radially and 7 elements tangentially

\[
\text{NTCR}, 4, 0, 4, 1
\]

Curve 4 describes the cylinder O.D. and is set to 0 degrees. The nodes with fixed temperatures are indicated by a diamond surrounding the node

\[
\text{HXSF}, 1, 1000, 1, 1
\]

Define a surface heat flux to the cylinder. A triangle is displayed in the center of each element where the heat flux is applied

\[
\text{NMERGE};
\]

Merge the generated nodes

\[
\text{NCOMP};
\]

Compress the generated nodes

\[
\text{TUNIF}, 125.
\]

Set the initial temperature

\[
\text{TIMES}, 0, 500, 500
\]

Define the iteration limits
Chapter

SINDAINP

Use SINDA translator

After executing SINDA and returning to GEOSTAR and displaying the temperature contours computed by SINDA, the default temperature limits can be changed to examine a small region of the model, or rotated to get a different view. Now use interactive GEOSTAR input to analyze the problem in a transient mode by entering more data.

MPROP,1,DENS,1
   Specify density

MPROP,1,C,1
   Enter the specific heat

TUNIF,0
   Set the initial temperatures to zero

A,Thermal,T
   Set the analysis mode to transient analysis

TIMES,0,0,2,1
   Set the transient run conditions

TEMPGRAPH,1,1,2,3,4,5
   Specify the nodes to plot results for

SINDAINP

Use SINDA translator

After executing SINDA and returning to GEOSTAR and displaying the final temperature contours computed by SINDA, the temperature histories of the specified nodes are displayed by:

GEO > FILE,LPLT;

A temperature data set is available for each printout time in a transient analysis and can be selected with the ACTTEMP command.
Guidelines for Thermal Modeling with GEOSTAR

Several options are available to customize the SINDA input file, and can be implemented by modifying the COS2SND.CFG file. This file must be copied from the COSMOS/M directory to the work directory to use these options. The first line of the default COS2SND.CFG file contains a /F to enable direct interaction with COSMOS/M. This can be changed with a text processor to add or remove “/” options as follows:

/F adds FORTRAN commands to write data in the .HTO file.
/M puts multiple statements on a line for smaller input files.
/A puts arithmetic statements in the input file for easier modification.
/Q adds QNPRNT output to TAPE6.
/C uses “CYC” instead of “DI ICYC” for cyclic heating.
/R uses NEVADA view factors for RESF, and RECR commands.

A NEVADA translator will soon be available to write the NEVADA input file for the COSMOS/M model. Either Gebhart (default) or Openheim modeling can be used.

When SINDA is used on a different platform from COSMOS/M (e.g. mini- or main-frame computer), the FORTRAN section of the “OUTPUT CALLS” will probably not work so that adding the SINDA temperature data to the database from the ASCII SINDA output file must be done by executing the translator from the system prompt to read the SINDA output file and write the binary “.HTO” and “.HGP” database files. The command syntax for using the SINDA translators from the system prompt is displayed by typing WS87 or WS85 from the system command line without any arguments. The default test strings in the translator may not work with your version of SINDA so a “COS2SND.CFG” file is furnished showing the default character strings used to locate the temperature data in the SINDA output file. These may be changed to match the text in your output file with any text processor. The temperature data itself must conform to the general format used in most SINDA versions of:
Two script files are included as examples in the 1.65 release to illustrate the commands necessary to display the problem results graphically, and can be used as GEOSTAR input files. If the script files “TPLOT” and/or “LPLOT” are copied to the users work directory, they will be automatically updated for each problem so that plotting contours can be done with the GEOSTAR command “FILE,TPLOT” and time histories with “FILE,LPlot”.

Be sure to include all parameters in the TIMES command rather than using the defaults. The TIMES command must be entered even for steady state problems where it is used to set the maximum number of iterations allowed. To define variable thermal properties, use CURDEF,TEMP,n,... and ACTSET,TP,n before the MPROP,m,... command. Also define all constant properties before using these commands as a safety measure. Use either the TUNIF command or the INITIAL,TEMP command to set initial temperatures for the problem. Boundary temperatures can be set with the NTND, or NTSF command if not set by a convection or radiation command. Use the CURDEF,TIME,n,... and ACTSET,TC,n commands before the boundary condition command to define time varying boundary conditions. Use the TOFFSET and SB CONST commands to specify the correct units for radiation in the problem.

Any text following the COMMENT command will be listed in the SINDA input file when using the full COSMOS/M system.

### Thermal Boundary Conditions

Source terms, convection and radiation boundary conditions can be added in several ways as shown in Table D-2.

#### Table D-2. Thermal Boundary Conditions

<table>
<thead>
<tr>
<th>Boundary Type</th>
<th>Convection</th>
<th>Radiation</th>
<th>Source Terms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodal</td>
<td>CLINK</td>
<td>RLINK</td>
<td>QND (q)</td>
</tr>
<tr>
<td>Element</td>
<td>CEL</td>
<td>REL</td>
<td>QEL (q/vol)</td>
</tr>
<tr>
<td>Surface</td>
<td>CESF</td>
<td>RESF</td>
<td>HXSF (q/a)</td>
</tr>
<tr>
<td>Curves</td>
<td>CECR</td>
<td>RECR</td>
<td>HXCR (q/a)</td>
</tr>
</tbody>
</table>
Chapter

Contact Resistance's

The CLINK element group can also be used to define contact resistance's between nodes as well as convection boundary conditions. Use the RCONST command to define the appropriate area, and the HC material property to define conductance/area for the connector. Do all merges before defining CLINK elements for contact resistance's.

It may be necessary to use the BOUNDARY,1,0 command to display temperatures for solid elements.

To include thermal effects in a stress analysis, you must use the TEMPERATURE command after the A_STAT,T command to activate the appropriate temperature set in GEOSTAR.

Coolant Loop Modeling

Currently, the translator does not interface with the fluid modeling capabilities of either SINDA’87 or SINDA’85. These capabilities will be added in a future release.

However, simple coolant loops where the fluid temperature is calculated during problem solution can be included in thermal problems by using the HLINK element to generate one-way thermal conductors which simulate the fluid flow. Then use the CLINK element to define convection conditions. At this time, the CEL family of commands can only be used with user defined fluid boundary temperatures.

Use the HLINK elements to define the fluid flow path from the upstream end which must be defined as a boundary temperature with the NTND command. The fluid path can contain branches, but cannot recombine flows. If the fluid specific heat is defined, it is used with the user specified flow rate, otherwise the user must specify the (Cp*wdot) value to use. The user input data must maintain the fluid mass balance for the flow network.

The CLINK elements are used to define the interface between the structure and fluid based on the RCONST and HC values defined for the element. CLINK elements use the second real constant of the set to define the natural convection exponent to be used (based on the wall to fluid temperature difference).

The HLINK and CLINK elements are used with different RCONST values as listed in Table D-3.
Table D-3. Real Constants

<table>
<thead>
<tr>
<th>Real Constant</th>
<th>HLINK Description</th>
<th>CLINK Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Zero</td>
<td>Surface Area</td>
</tr>
<tr>
<td>2</td>
<td>Zero</td>
<td>Exponent [0]</td>
</tr>
<tr>
<td>3</td>
<td>C_p*wdot (wdot: if C defined)</td>
<td>Zero</td>
</tr>
</tbody>
</table>
COSMOS/M Command Language

Introduction

COSMOS/M language is a systematic notation by which users can describe computational processes. A set of commands are provided so that an interaction with the program capabilities can be easily achieved. The language gives a great stimulus to the user not only to perform simple calculations such as finding the square root of a number but even to devise his/her own set of commands for convenient and efficient computational operations.

The COSMOS/M language is a very powerful and efficient tool that is simple enough to fully understand and apply to tackle complex tasks and complete them quickly and satisfactorily. It is intended that this command language satisfy two diverse needs. On one hand, it provides notations and procedures which are natural and familiar to the COSMOS/M user so that he/she can deal with different situations in an easy manner. On the other hand, the language gives the user a wide range of capabilities to create optimal and convenient modeling techniques.

The COSMOS/M language allows the user to build the geometry of the model, mesh it, apply boundary conditions, specify loads, run analysis, visualize results and evaluate them, all in terms of parameters or user-defined variables. With this kind of parametric modeling, the entire design and analysis is not, as usually experienced, a long and arduous one. As soon as you decide to put a design change on paper, you can modify the model, conduct the analysis and perform response sensitivity study to different design options, easily and conveniently by just changing the values of the design parameters. Moreover, this command language
establishes a solid ground for more sophisticated processes such as shape optimization, adaptive techniques and many others.

This appendix starts with introducing the concepts of the language. The arithmetic operations for parametric expressions and the three available parametric quantities (variables, arrays and functions) are then presented. Three distinctive features (GOTO, IF-ELSEIF-ELSE and LOOP) are incorporated for more control and manipulation of the command design procedures. Finally, a macro file capability is described to provide a subroutine-like environment with which users can call a user-defined procedure comprised of a series of commands for the purpose of performing a given task (or creating the user's own command).

**Concepts of COSMOS/M Language**

The COSMOS/M language is oriented towards creating programming procedures that are likely to be of practical use. The emphasis is concentrated on providing users with enough tools that they can confidently apply and implement in analysis and design. The language satisfies the following criteria:

- **Generality** in the sense that all features are composed of different aspects of few basic concepts.
- **Consistency** with commonly used notations.
- **Subsets** where the idea is that users do not have to understand the whole language in order to use part of it.
- **Simplicity** on the user interface level.

The centerfold of the language is to provide the user with the flexibility to define parametric variables. In COSMOS/M language users may do the following:

- Create single variables in addition to using built-in parameters to interact with the database.
- Define one-, two- and three-dimensional arrays to store and organize information.
- Specify user-defined functions in addition to direct access to variety of library-like standard, preprocessing and postprocessing functions.

With five main arithmetic operators (addition, subtraction, multiplication, division and exponentiation) users can combine these parameters to generate parametric
expressions. In addition, and similar to most programming languages (FORTRAN for example), COSMOS/M language includes capabilities to transfer control from one point of the procedure to another. These capabilities are:

- GOTO statement for unconditional control structures.
- IF-ELSEIF-ELSE to control a procedure according to a condition in terms of logic expressions.
- LOOP statement to repeat a specified set of commands or operations a certain number of times (analogous to the DO loop in FORTRAN for instance).

Moreover, users can create their own subprogram (or command) just like other computer languages. This feature involves creating macro(s) that must be included in a file named GEOMACRO.MAC which resides in the COSMOS/M directory. A macro may be called from GEOSTAR at any time.

All these features (except for the control structures) can be used either interactively or via a session file in GEOSTAR. The control statements can only be utilized in a file or a macro. The outlines of COSMOS/M language and interaction of all components are shown in Figure E-1.

Figure E-1. Outline of the COSMOS/M Command Language
Chapter

Arithmetic Operations

Often arithmetic expressions include several operations among parameters and numbers used in the COSMOS/M language and regular GEOSTAR commands. Table E-1 illustrates the definition and action of valid arithmetic operations. Addition, subtraction, multiplication, division and exponentiation can be combined in arithmetic expressions. The program scans expressions from left to right. Should two or more operators appear in that expression, a defined hierarchy determines the order in which the operands are combined. The hierarchy among the arithmetic operators is shown in Table E-1.

The order in which the operations are performed can be changed by the presence of parentheses "( )" as shown below:

<table>
<thead>
<tr>
<th>Priority</th>
<th>Operation</th>
<th>Order of Successive Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Parentheses</td>
<td>From left to right and intermost first</td>
</tr>
<tr>
<td>Second</td>
<td>Exponentiation</td>
<td>From right to left</td>
</tr>
<tr>
<td>Third</td>
<td>Multiplication and Division</td>
<td>From left to right</td>
</tr>
<tr>
<td>Fourth</td>
<td>Addition and Subtraction</td>
<td>From left to right</td>
</tr>
</tbody>
</table>

This precedence means that when a parametric expression is encountered, several calculation stages are followed. In the first stage, all exponentiations are performed. In the second stage, multiplications and divisions are considered in the order of occurrence. In the third stage, additions, subtractions and negations are evaluated. Expressions in parentheses and functions are calculated first. As a departure from the normal left-to-right evaluation of successive operations, exponentiations (without parentheses) are performed from right to left.

Try to keep in mind the rules outlined above as you go through the examples shown in Table E-2. Omitting necessary parentheses results in incorrect calculations. Using extra parentheses to emphasize the order of calculations is permissible even though they may not be needed. It is always recommended that you insert additional parentheses in expressions if it makes them more readable.
Chapter

Table E-1. The Five Arithmetic Operator

<table>
<thead>
<tr>
<th>Operation</th>
<th>Operator</th>
<th>Precedence</th>
<th>COSMOS/M</th>
<th>Meaning</th>
<th>Algebraic Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponentiation</td>
<td>^</td>
<td>Highest</td>
<td>A ^ B</td>
<td>Exponentiate A to the power of B</td>
<td>A^B</td>
</tr>
<tr>
<td>Division</td>
<td>/</td>
<td>Intermediate</td>
<td>A / B</td>
<td>Divide A by B</td>
<td>A / B</td>
</tr>
<tr>
<td>Multiplication</td>
<td>*</td>
<td>Intermediate</td>
<td>A * B</td>
<td>Multiple A and B</td>
<td>A x B</td>
</tr>
<tr>
<td>Subtraction (or negation)</td>
<td>–</td>
<td>Lowest</td>
<td>A - B</td>
<td>Subtract B from A</td>
<td>A - B</td>
</tr>
<tr>
<td>Addition (or identity)</td>
<td>+</td>
<td>Lowest</td>
<td>A + B</td>
<td>Add A and B</td>
<td>A + B</td>
</tr>
</tbody>
</table>

Table E-2. Evaluating Arithmetic Expressions

<table>
<thead>
<tr>
<th>Example</th>
<th>Step 1</th>
<th>Step 2</th>
<th>Step 3</th>
<th>Step 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>A * B ^ C * D - F</td>
<td>B^C</td>
<td>A x B^C</td>
<td>A x B^C x D</td>
<td>A x B^C x D - F</td>
</tr>
<tr>
<td>(A * B) ^ C * D - F</td>
<td>A * B</td>
<td>(A x B)^C</td>
<td>(A x B)^C x D</td>
<td>(A x B)^C x D - F</td>
</tr>
<tr>
<td>A * B ^ (C * D) - F</td>
<td>C * D</td>
<td>B^(CxD)</td>
<td>A x B^(CxD)</td>
<td>A x B^(CxD) - F</td>
</tr>
<tr>
<td>A ^ B ^ C</td>
<td>B^C</td>
<td>A^B</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>-A ^ B</td>
<td>A^B</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Parameters

The central characteristic of imperative programming languages is that they allow the creation of parameters. A parameter is composed of a name, a type and a value. An identifier (or a name) is usually some combination of alphabetic and numeric characters of restricted length. The type means the kind of values it may hold (real or integer). The value may be fixed once and for all or may be dependent on other parameters.
COSMOS/M language allows the declaration and use of three different types of parameters.

- single variables,
- arrays, and
- functions

Parametric expressions may use all of the above types. Expressions are composed of operands such as constants and parameters, and operators. As an example:

\[(A \times B) \times C + D / E - 2.0 \times F\]

is an expression where the process of evaluation involves substituting values for the operands (or parameters A, B, C, D, E and F) and perform the operations (+, -, *, /, and ^). The operands can be single variables, functions and elements of arrays as will be defined later.

Each parameter must have a different name, which you provide. The names may contain up to ten (10) alphabetic (A to Z) and numeric (0 to 9) characters. However, the first character of a name must be alphabetic. Examples of valid and invalid parameter names are shown below:

<table>
<thead>
<tr>
<th>Assigned Parameter Name</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter</td>
<td>Valid —</td>
</tr>
<tr>
<td>Incredible44</td>
<td>Invalid More than 10 characters</td>
</tr>
<tr>
<td>PII</td>
<td>Valid —</td>
</tr>
<tr>
<td>H%</td>
<td>Invalid Illegal character (%)</td>
</tr>
<tr>
<td>3Y</td>
<td>Invalid First character must be alphabetic</td>
</tr>
<tr>
<td>X-Ray</td>
<td>Invalid Illegal character (–)</td>
</tr>
</tbody>
</table>

In addition, there are some names that are reserved for predefined variables and functions as will be shown later. These names cannot be assigned to parameters. It is permitted to use names that match commonly used COSMOS/M commands, labels or attributes. However, it is recommended that you avoid such names as much as you can.
It should be mentioned that “C*” is used in COSMOS/M to write comments. All written characters and/or numbers to the right of “C*” are considered a comment statement. Therefore, in defining parametric expressions, users should avoid utilizing a “C” followed by an asterisk “*”.

**Parametric Variables**

A single variable represents a memory location that is assigned a name with up to ten (10) characters. The memory location contains a value that is referred to by the given name. In the example shown below:

```
PARASSIGN,TEMP,REAL,19.52
```

a memory location named (TEMP) has been assigned to the value (19.52).

**Predefined Variables**

For some of the database information, names have been predefined in COSMOS/M as shown in Table E-3. The user can directly use these variables. For example, **RGMAX** refers to the highest label of regions in database. You can mesh the regions you have in your model as follows:

```
GEO > MA_RG
    Beginning Region [1] > 1
    Ending Region [1] > RGMAX
    *Use the parameter instead of providing a number*
    Increment [1] >
    Number of smoothing iterations [0] >
    Method 0=sweep 1=postup [0] > OFF
```

We used in the above command the OFF parameter shown in Table E-3 to replace the (0). However this is not a good application for the ON/OFF parameters. You can use them in commands that involve ON/OFF flags as shown below:

```
GEO > AXIS
    Draw Axis [1] > ON
    *ON means (1) to draw axes*
    AXIS Color [16] >
```

or you can use AXIS,OFF, to erase the axes from screen.
Table E-3. Predefined Parametric Single Variables

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTMAX</td>
<td>Highest label of keypoints in database</td>
<td></td>
</tr>
<tr>
<td>CRMAX</td>
<td>Highest label of curves in database</td>
<td></td>
</tr>
<tr>
<td>SFMAX</td>
<td>Highest label of surfaces in database</td>
<td></td>
</tr>
<tr>
<td>VLMAX</td>
<td>Highest label of volumes in database</td>
<td></td>
</tr>
<tr>
<td>NDMAX</td>
<td>Highest label of nodes in database</td>
<td></td>
</tr>
<tr>
<td>ELMAX</td>
<td>Highest label of elements in database</td>
<td></td>
</tr>
<tr>
<td>CTMAX</td>
<td>Highest label of contours in database</td>
<td></td>
</tr>
<tr>
<td>RGMAX</td>
<td>Highest label of regions in database</td>
<td></td>
</tr>
<tr>
<td>PHMAX</td>
<td>Highest label on polyhedra in database</td>
<td></td>
</tr>
<tr>
<td>PAMAX</td>
<td>Highest label of parts in database</td>
<td></td>
</tr>
<tr>
<td>CSMAX</td>
<td>Highest label of coordinate systems in database</td>
<td></td>
</tr>
<tr>
<td>EGMAX</td>
<td>Highest label of element groups in database</td>
<td></td>
</tr>
<tr>
<td>MPMAX</td>
<td>Highest label of material property sets in database</td>
<td></td>
</tr>
<tr>
<td>RCMAX</td>
<td>Highest label of real constant sets in database</td>
<td></td>
</tr>
<tr>
<td>EGCUR</td>
<td>Label of the active element group</td>
<td></td>
</tr>
<tr>
<td>MPCUR</td>
<td>Label of the active material property set</td>
<td></td>
</tr>
<tr>
<td>RCCUR</td>
<td>Label of the active real constant set</td>
<td></td>
</tr>
<tr>
<td>LCCUR</td>
<td>Label of the active load case</td>
<td></td>
</tr>
<tr>
<td>CSCUR</td>
<td>Label of the active coordinate system</td>
<td></td>
</tr>
<tr>
<td>SELCUR</td>
<td>Label of the active selection list</td>
<td></td>
</tr>
<tr>
<td>MAXPR</td>
<td>Number of the user-defined parameters in database</td>
<td>COSMOS/M Language (PARASSIGN command)</td>
</tr>
<tr>
<td>MAXARR</td>
<td>Number of the user-defined arrays in database</td>
<td>COSMOS/M Language (ARRDEF command)</td>
</tr>
<tr>
<td>MAXFUNC</td>
<td>Number of the user-defined functions in database</td>
<td>COSMOS/M Language (FUNCDEF command)</td>
</tr>
<tr>
<td>CURPOST</td>
<td>Label of the active analysis type</td>
<td>Postprocessing (ACTPOST command)</td>
</tr>
<tr>
<td>ON</td>
<td>Can be used to replace (1)</td>
<td>Convenient for ON/OFF flags</td>
</tr>
<tr>
<td>OFF</td>
<td>Can be used to replace (0)</td>
<td>Convenient for ON/OFF flags</td>
</tr>
<tr>
<td>YES</td>
<td>Can be used to replace (1)</td>
<td>Convenient for ON/OFF flags</td>
</tr>
<tr>
<td>NO</td>
<td>Can be used to replace (0)</td>
<td>Convenient for ON/OFF flags</td>
</tr>
<tr>
<td>PI</td>
<td>$\pi = 3.141593$</td>
<td></td>
</tr>
</tbody>
</table>
Chapter

Defining a Variable

Except for the names reserved for variables shown in Table E-3, you can declare any variable name, type (real or integer) and value using the **PARASSIGN** command (Control > PARAMETER > *Assign Parameter*):

**PARASSIGN, Name, Type (REAL or INT), Value**

The command can be used interactively or in a one-line format. It should be noted that the parameter value can be numeric or an expression of predefined and/or user-defined single variables, elements of arrays, and functions.

Let’s assume that you want to mesh all surfaces using the **M_SF** command with different element numbers on their first and second parametric curves:

GEO > **PARASSIGN,NEL1,INT,10,**
Assign an integer value of 10 to NEL1
GEO > **PARASSIGN**
Parameter name > NEL2
Assign an integer value of 8 to NEL2
Data Type [REAL] > INT
Parametric Integer Value > 8

Instead, you might choose to define NEL2 as a function of NEL1:

GEO > **PARASSIGN,NEL2,INT,(NEL1+1)^2,**
NEL2=(NEL1+1)^2
GEO > **M_SF**
Beginning Surface [1] >
Ending Surface [1] > SFMAX
Increment [1] >
Number of nodes per element [4] >
Number of elements on first curve [2] > NEL1
Number of elements on second curve [2] > NEL2
Spacing ratio for first curve [1] >
Spacing ratio for second curve [1] >

The parameter value takes the most recent definition of the variable. For example,

GEO > **PARASSIGN,DIAMETER,REAL,15.0,**
GEO > **PARASSIGN,DIAMETER,REAL,20.0,**
assume a value of 20 unless redefined one more time throughout the remaining calculations. On the other hand, defining a variable after it is used in a command or an expression does not update the command or the already evaluated expression. For instance the following group of commands:

```
GEO > PARASSIGN,X,REAL,100.0,
GEO > PARASSIGN,Y,REAL,20.0,
GEO > PARASSIGN,Z,REAL,-160.0,
GEO > PARASSIGN,W,REAL,X+Y*Z,
GEO > PT,PTMAX+1,X,Y,Z,
GEO > PARASSIGN,Y,REAL,5.0,
```

evaluates W as (-3100.0) and assigns the coordinates (100,20,-160) for the keypoint. Redefining parameter Y as (5.0) does not update W or the point coordinates. Notice how convenient it is to use the \texttt{PTMAX} (predefined variable) to create the point label by adding (1) to the highest available label of keypoints in the database.

### Listing Variables

The \texttt{PARLIST} (Control > PARAMETER > List Parameter) command can be used to list the most recent value of a requested variable or all available parametric variables in the database. Predefined variables shown in Table E-3 cannot be listed unless you assign them to new names (using the \texttt{PARASSIGN} command) and then list these new names.

#### \texttt{PARLIST, Name}

A table showing the serial number, name, type and the numeric value of each parameter will be displayed on the screen. To list all variables, use the asterisk (*) character in place of the variable name.

If you have already followed the examples illustrated before and issue the (\texttt{PARLIST,W,}) command, you will see the following information:

<table>
<thead>
<tr>
<th>Num</th>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>W</td>
<td>REAL</td>
<td>-3100.0</td>
</tr>
</tbody>
</table>
if you use the (PARLIST, *) information about all declared parametric variables will be displayed as shown below:

<table>
<thead>
<tr>
<th>Num</th>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NEL1</td>
<td>INT</td>
<td>10.0</td>
</tr>
<tr>
<td>2</td>
<td>NEL2*</td>
<td>INT</td>
<td>8.0</td>
</tr>
<tr>
<td>3</td>
<td>DIAMETER</td>
<td>REAL</td>
<td>20.0</td>
</tr>
<tr>
<td>4</td>
<td>X</td>
<td>REAL</td>
<td>100.0</td>
</tr>
<tr>
<td>5</td>
<td>Y**</td>
<td>REAL</td>
<td>5.0</td>
</tr>
<tr>
<td>6</td>
<td>Z</td>
<td>REAL</td>
<td>–160.0</td>
</tr>
<tr>
<td>7</td>
<td>W</td>
<td>REAL</td>
<td>–3100.0</td>
</tr>
</tbody>
</table>

*NEL2 here refers to the first definition we used
**Y refers to the most recent value

Deleting a Variable

You can delete a parametric variable using the PARDEL (Control > PARAMETER > Delete Parameter) command:

PARDEL, Name

If an asterisk (*) is inserted in the name's location, only the most recently declared parameter (the last one shown on the screen by the list command) will be deleted.

It should be emphasized that deleting a parametric variable is not equivalent to assigning a zero (0.0) value to it.

Array Parameters

An array is a group of storage locations that are referred to by the same name. Individual members of an array are called elements. In COSMOS/M language, as shown in Figure E-2, there are three types of arrays.

- One-dimensional arrays which can be visualized as one column of data.
- Two-dimensional arrays described as a group of columns or a table-type data arrangement in a plane specified by rows and columns.
Three-dimensional arrays which provides a cube-like storage space (rows, columns and planes).

The following limitations apply to arrays:
- Maximum length of an array name = 10
- Maximum number of defined arrays = 20

**Defining Arrays**

The array name, dimension, reserved memory space (storage requirements) and type of data (real or integer) have to be specified first using the `ARRDEF` (Control > PARAMETER > Declare Array) command as shown below:

<table>
<thead>
<tr>
<th>ARRDEF, Name of Array, Type of data (REAL or INT)</th>
</tr>
</thead>
</table>

In choosing the array's name, it is recommended not to use the predefined variables or function names shown in Tables E-3 through E-9. The elements of the array can be either all real or all integer variables. The elements of the array are distinguished by using the array's common name followed by a number of bracket sets “[ ]” depending on the array dimension. One set of brackets is used for one-dimensional arrays while two and three consecutive bracket sets define two- and three-dimensional arrays respectively. The dimensions of the array are specified by numeric values within each of the bracket sets. For example (as shown in Figure E-2):

- `ARRAY1 [5]` declares a one-dimensional array named `ARRAY1` with 5 storage locations (rows).
- `ARRAY2 [4][6]` specifies the name for a two-dimensional array with 4 rows and 6 columns.
- `ARRAY3 [3][2][4]` defines a 3x2x4 three-dimensional array (3 rows, 2 columns and 4 planes).

Once the array is declared, all of its elements are initialized to zeros (0.0 for real and 0 for integer types). You can assign a value, for each of the array's elements, that is numeric, or an expression of predefined or user-defined single variables, functions, and/or elements of arrays. The command `ARRASSIGN` (Control > PARAMETER > Assign to Array) is used to assign values to the array elements:
As an example, let's define the arrays shown in Figure E-2:

GEO > **ARRDEF**
Array Declaration > ARRAY1[5]
Data Type [REAL] > INT
*Define a one dimensional array with 5 integer storage locations*

GEO > **ARRASSIGN**
Array Element > ARRAY1[1]
*Specify the first element*
Parametric Integer Value > 3

Now, define the rest of the first array's elements:

GEO > **ARRASSIGN**, ARRAY1[2], 2*ARRAY1[1],
The second element is a parametric expression in terms of the first element

GEO > **PARASSIGN**, NN, INT, 2,
Declare an integer variable (NN)

GEO > **ARRASSIGN**, ARRAY1[5], -17+NN*ARRAY1[2],
The fifth element = (NN) times the second element

It should be noted that you may define the non-zero elements only. Similarly, you can now declare the 2D and 3D arrays:

GEO > **ARRDEF**
Array Declaration > ARRAY2[4][6]
Data Type [REAL] > ARRAY2 is declared a 4x6 two-dimensional real array

GEO > **ARRDEF**
Array Declaration > ARRAY3[3][2][4]
Data Type [REAL] > REAL
ARRAY3 is declared a 3x2x4 three-dimensional real array
Let's specify one element of each array:

GEO > ARRASSIGN
ARRAY Element > ARRAY2[3][4]
Parametric Real Value > 60.7
Assign a value of 60.7 to the element in the third row and fourth column in ARRAY2

GEO > PARASSIGN,XX,REAL,17.0,
Define a parametric variable (XX)
Assign a value for the element in the third row, first column and fourth plane of ARRAY3.

Unlike parametric variables, a previously declared array cannot be redefined unless being deleted first.

Listing Array Elements

The **ARRLIST** (Control > PARAMETER > List Array) command list the parameters of the requested array as shown below:

---

**ARRLIST, Array Name**

Let's list ARRAY1:

```
GEO > ARRLIST
Array (*) > ARRAY1
```

The array label (dependent on the sequence of defining the arrays), name, dimensions and type of data as well as the numeric values of each element will be displayed on the screen.

```
Array No. 1
ARRAY1[5]   INT
ARRAY1[1]   3
ARRAY1[2]   6
ARRAY1[3]   0
ARRAY1[4]   0
```

An asterisk (*) can be used in place of the array's name if you wish to list all defined arrays.
Deleting Arrays

To delete an array, simply use the `ARRDEL` (Control > PARAMETER > Delete Array) command:

`ARRDEL, Array Name`

If an asterisk (*) is used instead of an array's name, only the most recently declared array (the last shown on the screen with the `ARRLIST` command) will be deleted. As mentioned before for parametric variables, deleting an array is not equivalent to initializing its elements to zeros.

Functions

A function is a combined sequence of arithmetic operations for defined parameters to compute (or return with) a single value, such as finding the square root of a number. In COSMOS/M there are two types of functions:

- Predefined functions which are accessible directly in the program.
- User-defined functions which can be created following a simple procedure.

The name of the function is always followed by the input to that function (which is called the arguments of the function) separated by pipes (|) and enclosed in parentheses. Arguments can be predefined variables or user-defined parametric variables (using the `PARASSIGN` command).

Predefined Functions

Three main types of built-in functions are available in COSMOS/M:

- Standard functions, such as the intrinsic functions, are shown in Table E-4.
- Preprocessing functions are defined in Table E-5.
- Postprocessing functions:
  - Structural models functions are shown in Table E-6,
  - Thermal problems functions are detailed in Table E-7,
  - Fluid flow functions are illustrated in Table E-8, and
  - Electromagnetic models functions are given in Table E-9.
You should read the list of these library-type functions to become aware of the operations that can be performed with each one of them. It can be noticed from Tables E-4 through E-9 that arguments are separated by the pipe symbol (|). Each argument should collectively represent a single value. The arguments of the functions are generally, but not necessarily, of the same type (real or integer) as the output of the function itself.

Some examples of the predefined functions are shown below:

GEO > PARASSIGN,NODE1,INT,NEARND (4.0|11.2|-90.8),
Define NODE1 as the nearest node to the location specified by the coordinates (4.0,11.2,-90.8)

GEO > PARASSIGN,LOADCASE,INT,1,
GEO > PARASSIGN,SIGMAYY,REAL,SY (LOADCASE|ND|51),
    Find \(\sigma_{yy}\) of node 51 for the first load case

GEO > PARASSIGN,SYYMAX,REAL,SY (LOADCASE+1|ND|-1),
    Search for the maximum algebraic of \(\sigma_{yy}\) for all nodes in the second load case

GEO > PARASSIGN,SYYMIN,REAL,SY (LOADCASE+1|ND|-2),
    Determine the minimum algebraic of \(\sigma_{yy}\) for all nodes in the second load case

GEO > PARASSIGN,SYYMAXABS,REAL,SY (LOADCASE+1|ND|0),
    Find the maximum absolute value of \(\sigma_{yy}\) for all nodes but keep the original sign of the value

Let's assume there are five different stress values for \(\sigma_{yy}\)
(-10.0, 4.0, 1.0, 3.2, 5.1). The maximum algebraic value is (5.1), the minimum algebraic value is (-10.0), while the maximum absolute value (with the original sign) will be (-10.0)

GEO > ARRDEF
    Array Declaration > S[10000][6]

GEO > ARRASSIGN
    Array Element > S[1][3]
    Parametric Real Value > COS(1.0)
    Define an array's element in terms of the built-in cosine intrinsic function

GEO > ARRASSIGN
    Array Element > S[2][6]
    Parametric Real Value > SIGMAYY-2.0

User-Defined Functions

Similar to the predefined functions, each user-defined function has a name, arguments (separated by the pipe symbol) enclosed in parentheses and a parametric expression to define it. The following limitations apply for predefined functions:

- Maximum length of the function name = 10
- Maximum number of user-defined functions = 200
Defining a Function

The names reserved for the built-in functions, as shown in Tables E-4 through E-9 cannot be used to name a function. Moreover, names of previously defined functions cannot be utilized, similar to the array declaration procedure, unless these functions are deleted first. It is recommended not to use the predefined parametric variable names mentioned in Table E-3. The FUNCDEF (Control > PARAMETER > Define Function) command shown below declares the function name, type (real or integer) and definition:

**FUNCDEF, Function Name and Arguments, Type (real or integer), Defining Expression**

To illustrate the concept, let's show a few examples:

GEO > **PARASSIGN**, X, REAL, XND(63|0),

Declare a real parametric variable (X) using the predefined preprocessing function (XND) to find the global Cartesian X-coordinate of node 63

GEO > **FUNCDEF**

Define a real function (ANA) in terms of one argument

Function Name > **ANA(X)**

Function Type [REAL] >

Func Expr > X\(X\)-X+2.5

The function expression is defined as function of a parametric variable

GEO > **PARASSIGN**, M, INT, 3,

GEO > **PARASSIGN**, N, INT, 15,

Declare and define integer parametric variables (M) and (N)
GEO > ARRDEF,NUM[4],INT,
    Declare an integer one-dimensional array

GEO > ARRASSIGN,NUM[3],CEIL(X)
    Assign a value to the third element of the array in terms of
    predefined standard function CEIL(X) which returns with the
    closest higher integer to (X)

GEO > FUNCDEF
    Define an integer function (JOB) in terms of three arguments
Function Name > JOB(M|N|X)
Function Type [REAL] > INT
Func Expr > M-N+NEARPT(X|X|X)
    The function expression is given in terms of parametric variables
    and a predefined preprocessing function (NEARPT)

GEO > PARASSIGN,Q,REAL,EXP(X),
    Q = ex

GEO > PARASSIGN,D,REAL,SQRT(ANA(X))
    Define a real variable (D) as the square root of the real function
    (ANA(X))

GEO > PARASSIGN,V,REAL,EPSZ(3|116),
    Use a predefined postprocessing function (EPSZ) to define a real
    variable (V)

GEO > ARRASSIGN,NUM[2],3,
    Assign a value of 3 to the second element in array NUM

GEO > FUNCDEF
    Define a real function in terms of four arguments
Function Name > KART(Q|D|V|X)
Function Type [REAL] >
Func Expr > Q\times X+D/V-Q

As can be seen above, the function expression may be composed of a different combination of variables, as well as functions. It should be noted however that all arguments have to be declared and specified (numerically or parametrically) before being used in a function definition.
Listing a Function

The **FUNCLIST** (Control > PARAMETER > List Function) command, shown below, lists the function label (depending on the order of declaring functions), name, type (real or integer) and parametric expression:

### FUNCLIST, Function Name

Now, let's list the three functions defined before:

```
GEO > FUNCLIST
Function name [*()] >
```

An asterisk (*) can be used to request all functions. The information displayed on the screen is shown below.

<table>
<thead>
<tr>
<th>Num</th>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ANA (X)</td>
<td>real</td>
<td>X * X – X + 2.5</td>
</tr>
<tr>
<td>2</td>
<td>JOB (M</td>
<td>N</td>
<td>X)</td>
</tr>
<tr>
<td>3</td>
<td>KART (Q</td>
<td>D</td>
<td>V</td>
</tr>
</tbody>
</table>

Deleting a Function

You can delete a function, simply by issuing the **FUNCDEL** (Control > PARAMETER > Delete Function) command:

### FUNCDEL, Function Name

If an asterisk (*) is used instead of the function's name, only the most recently declared function (the last shown on the screen with the **FUNCLIST** command) will be deleted. As mentioned before for parametric variables and arrays, deleting a function is not equivalent to initializing its output value to zero.
### Table 3-5. Predefined Preprocessing Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>XND(nd</td>
<td>cs)</td>
<td>x-coordinate of node (nd) in coordinate system (cs)</td>
</tr>
<tr>
<td>YND(nd</td>
<td>cs)</td>
<td>y-coordinate of node (nd) in coordinate system (cs)</td>
</tr>
<tr>
<td>ZND(nd</td>
<td>cs)</td>
<td>z-coordinate of node (nd) in coordinate system (cs)</td>
</tr>
<tr>
<td>XPT(pt</td>
<td>cs)</td>
<td>x-coordinate of keypoint (pt) in coordinate system (cs)</td>
</tr>
<tr>
<td>YPT(pt</td>
<td>cs)</td>
<td>y-coordinate of keypoint (pt) in coordinate system (cs)</td>
</tr>
<tr>
<td>ZPT(pt</td>
<td>cs)</td>
<td>z-coordinate of keypoint (pt) in coordinate system (cs)</td>
</tr>
<tr>
<td>NEARND(x</td>
<td>y</td>
<td>z)</td>
</tr>
<tr>
<td>NEARPT(x</td>
<td>y</td>
<td>z)</td>
</tr>
<tr>
<td>NDEL(el</td>
<td>pos)</td>
<td>Node in location (pos) of an element (el)</td>
</tr>
<tr>
<td>LISTSEL(en</td>
<td>lab)</td>
<td>Checks the accessibility of an entity (en) with label (lab):</td>
</tr>
<tr>
<td></td>
<td>• If there is no active selection set, it returns with (1 or TURE)</td>
<td>rg: regions</td>
</tr>
<tr>
<td></td>
<td>• For an active selection set, it returns with: (1 or TRUE) if entity is in the list (0 or FALSE) otherwise</td>
<td>cr: curves</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ph: polyhedra</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sf: surfaces</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pa: parts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>vl: volumes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>nd: nodes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ct: contours</td>
</tr>
<tr>
<td></td>
<td></td>
<td>el: elements</td>
</tr>
<tr>
<td>Function</td>
<td>Definition</td>
<td>Remarks</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PRIMMAX (en)</td>
<td>Highest label of the specified entity type in the database (similar to PTMAX, CRMAX, etc.)</td>
<td>en = pt: points, rg: regions, cr: curves, ph: polyhedra, sf: surfaces, pa: parts, vi: volumes, nd: nodes, ct: contours, el: elements</td>
</tr>
<tr>
<td>EXIST (en</td>
<td>lab)</td>
<td>Checks existence of an entity (en) with label (lab). It returns with: (1 or TRUE) if entity exists (0 OR false) otherwise</td>
</tr>
<tr>
<td>ELFACE (el</td>
<td>en</td>
<td>lab)</td>
</tr>
<tr>
<td>XELF (el</td>
<td>fnum</td>
<td>cs)</td>
</tr>
<tr>
<td>YELF (el</td>
<td>fnum</td>
<td>cs)</td>
</tr>
<tr>
<td>ZELF (el</td>
<td>fnum</td>
<td>cs)</td>
</tr>
<tr>
<td>VOLUME (el)</td>
<td>Returns with volume of element (el)</td>
<td>—</td>
</tr>
<tr>
<td>WEIGHT (el)</td>
<td>Returns with weight of element (el)</td>
<td>—</td>
</tr>
</tbody>
</table>
Table E-6. Predefined Postprocessing Functions for Structural Models

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| nd = Node number: find displacement of the specified node.  
0 : Maximum absolute value of all nodal displacements  
(but returns with the value's original sign)  
–1 : Algebraic maximum of all nodal displacements  
–2 : Algebraic minimum of all nodal displacements |                                                                             |
| UX(lcts | nd | cs) | Displacement in the x-direction for load case/time step (lcts) at node (nd) | x is defined in coordinate system (cs) |
| UY(lcts | nd | cs) | Displacement in the y-direction for load case/time step (lcts) at node (nd) | y is defined in coordinate system (cs) |
| UZ(lcts | nd | cs) | Displacement in the z-direction for load case/time step (lcts) at node (nd) | z is defined in coordinate system (cs) |
| RX(lcts | nd | cs) | Rotation about the x-axis for load case/time step (lcts) at node (nd) | x is defined in coordinate system (cs) |
| RY(lcts | nd | cs) | Rotation about the y-axis for load case/time step (lcts) at node (nd) | y is defined in coordinate system (cs) |
| RZ(lcts | nd | cs) | Rotation about the z-axis for load case/time step (lcts) at node (nd) | z is defined in coordinate system (cs) |
| URES(lc | nd | cs) | Resultant displacement for load case/time step (lcts) at node (nd) | —                                           |
Table E-6. Predefined Postprocessing Functions for Structural Models (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>nd = Node number: find velocity of the specified node. 0: Maximum absolute value of all nodal velocities (but returns with the value’s original sign) –1: Algebraic maximum of all nodal velocities –2: Algebraic minimum of all nodal velocities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VX(step</td>
<td>nd)</td>
<td>Velocity in the x-direction for time step (step) at node (nd)</td>
</tr>
<tr>
<td>VY(step</td>
<td>nd)</td>
<td>Velocity in the y-direction for time step (step) at node (nd)</td>
</tr>
<tr>
<td>VZ(step</td>
<td>nd)</td>
<td>Velocity in the z-direction for time step (step) at node (nd)</td>
</tr>
<tr>
<td>WX(step</td>
<td>nd)</td>
<td>Angular velocity about the x-axis for time step (step) at node (nd)</td>
</tr>
<tr>
<td>WY(step</td>
<td>nd)</td>
<td>Angular velocity about the y-axis for time step (step) at node (nd)</td>
</tr>
<tr>
<td>WZ(step</td>
<td>nd)</td>
<td>Angular velocity about the z-axis for time step (step) at node (nd)</td>
</tr>
<tr>
<td>VRES(step</td>
<td>nd)</td>
<td>Magnitude of resultant velocity for time step (step) at node (nd)</td>
</tr>
</tbody>
</table>
### Table E-6. Predefined Postprocessing Functions for Structural Models (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| nd = Node number: find acceleration at the specified node.  
   0 : Maximum absolute value of all nodal accelerations  
     (but returns with the value's original sign)  
   –1 : Algebraic maximum of all nodal accelerations  
   –2 : Algebraic minimum of all nodal accelerations |
| AX(step | nd) | Acceleration in the x-direction for time step (step) at node (nd) | x is a global Cartesian axis |
| AY(step | nd) | Acceleration in the y-direction for time step (step) at node (nd) | y is a global Cartesian axis |
| AZ(step | nd) | Acceleration in the z-direction for time step (step) at node (nd) | z is a global Cartesian axis |
| BX(step | nd) | Angular acceleration about the x-axis for time step (step) at node (nd) | x is a global Cartesian axis |
| BY(step | nd) | Angular acceleration about the y-axis for time step (step) at node (nd) | y is a global Cartesian axis |
| BZ(step | nd) | Angular acceleration about the z-axis for time step (step) at node (nd) | z is a global Cartesian axis |
| ARES(step | nd) | Magnitude of resultant acceleration for time step (step) at node (nd) | — |
### Table E-6. Predefined Postprocessing Functions for Structural Models (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>( el = )</td>
<td>Element number: find strains at the specified element</td>
<td></td>
</tr>
<tr>
<td>0 : Maximum absolute value of all elements strains (but returns with the value’s original sign)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(-1) : Algebraic maximum of all elements strains</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(-2) : Algebraic minimum of all elements strains</td>
<td></td>
<td></td>
</tr>
<tr>
<td>( EPSX(lcts</td>
<td>el) )</td>
<td>Normal strain for load case/time step ((lcts)) and element ((el)) in (x)-direction</td>
</tr>
<tr>
<td>( EPSY(lcts</td>
<td>el) )</td>
<td>Normal strain for load case/time step ((lcts)) and element ((el)) in (y)-direction</td>
</tr>
<tr>
<td>( EPSZ(lcts</td>
<td>el) )</td>
<td>Normal strain for load case/time step ((lcts)) and element ((el)) in (z)-direction</td>
</tr>
<tr>
<td>( GMXY(lcts</td>
<td>el) )</td>
<td>(xy)-shear strain for load case/time step ((lcts)) and element ((el))</td>
</tr>
<tr>
<td>( GMYZ(lcts</td>
<td>el) )</td>
<td>(yz)-shear strain for load case/time step ((lcts)) and element ((el))</td>
</tr>
<tr>
<td>( GMZX(lcts</td>
<td>el) )</td>
<td>(zx)-shear strain for load case/time step ((lcts)) and element ((el))</td>
</tr>
<tr>
<td>( ESTRN(lcts</td>
<td>el) )</td>
<td>Effective strain for load case/time step ((lcts)) and element ((el))</td>
</tr>
<tr>
<td>( SED(lcts</td>
<td>el) )</td>
<td>Strain energy density for load case/time step ((lcts)) and element ((el))</td>
</tr>
</tbody>
</table>
### Table E-6. Predefined Postprocessing Functions for Structural Models (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>nd/el = nd: nodes el: elements lab = label: find stresses at the specified nd/el label. 0: Maximum absolute value of all nd/el stresses (but returns with the value's original sign) –1: Algebraic maximum of all nd/el stresses –2: Algebraic minimum of all nd/el stresses</td>
<td>Normal stress in the x-direction for load case/time step (lcts), node/element label (lab)</td>
<td>x is defined according to element and analysis</td>
</tr>
<tr>
<td>SX(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>SY(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>SZ(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>TXY(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>TXZ(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>TYZ(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>P1(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>P2(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>VON(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>INT(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>ERR(lcts</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
</tbody>
</table>
### Table E-6. Predefined Postprocessing Functions for Structural Models (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>nd = ( R )</td>
<td>Node number: find reaction force at the specified node.</td>
<td></td>
</tr>
<tr>
<td>( R )</td>
<td>0: Maximum absolute value of all reaction forces (but returns with the value's original sign)</td>
<td></td>
</tr>
<tr>
<td>( R )</td>
<td>–1: Algebraic maximum of all reaction forces</td>
<td></td>
</tr>
<tr>
<td>( R )</td>
<td>–2: Algebraic minimum of all reaction forces</td>
<td></td>
</tr>
<tr>
<td>( RFX )</td>
<td>Reaction force in the ( x )-direction for load case/time step (lcts) at node (nd)</td>
<td>cs may be any coordinate system</td>
</tr>
<tr>
<td>( RFY )</td>
<td>Reaction force in the ( y )-direction for load case/time step (lcts) at node (nd)</td>
<td>cs may be any coordinate system</td>
</tr>
<tr>
<td>( RFZ )</td>
<td>Reaction force in the ( z )-direction for load case/time step (lcts) at node (nd)</td>
<td>cs may be any coordinate system</td>
</tr>
<tr>
<td>( RFRES )</td>
<td>Resultant reaction force for load case/time step (lcts) at node (nd)</td>
<td>—</td>
</tr>
<tr>
<td>( RMX )</td>
<td>Reaction moment about the ( x )-axis for load case/time step (lcts) at node (nd)</td>
<td>cs may be any coordinate system</td>
</tr>
<tr>
<td>( RMY )</td>
<td>Reaction moment about the ( y )-axis for load case/time step (lcts) at node (nd)</td>
<td>cs may be any coordinate system</td>
</tr>
<tr>
<td>( RMZ )</td>
<td>Reaction moment about the ( z )-axis for load case/time step (lcts) at node (nd)</td>
<td>cs may be any coordinate system</td>
</tr>
<tr>
<td>( RMRES )</td>
<td>Resultant reaction moment for load case/time step (lcts) at node (nd)</td>
<td>—</td>
</tr>
</tbody>
</table>
Table E-6. Predefined Postprocessing Functions for Structural Models (Concluded)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>NATURAL FREQUENCY</td>
<td>FREQ(mode)</td>
<td>Returns with natural frequency for mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>number (mode)</td>
</tr>
<tr>
<td>LINEARIZED BUCKLING</td>
<td>FREQ(mode)</td>
<td>Returns with load factor for buckling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>mode number (mode)</td>
</tr>
<tr>
<td>FATIGUE FORCE</td>
<td>FTG(nd)</td>
<td>Fatigue usage factor at node (nd)</td>
</tr>
<tr>
<td>LINE POINT</td>
<td>LPLF( )</td>
<td>Returns with limit point load factor as</td>
</tr>
<tr>
<td></td>
<td></td>
<td>calculated by the arc-length control method.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The function returns with a zero value if</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the limit point does not exist.</td>
</tr>
</tbody>
</table>
### Table E-7. Predefined Postprocessing Functions for Thermal Models

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>nd = Node number: find value at the specified node</td>
<td>nd = Node number: find value at the specified node</td>
<td>nd = Node number: find value at the specified node</td>
</tr>
<tr>
<td>0 : Maximum absolute value (but returns with the value's original sign)</td>
<td>0 : Maximum absolute value (but returns with the value's original sign)</td>
<td>0 : Maximum absolute value (but returns with the value's original sign)</td>
</tr>
<tr>
<td>–1 : Algebraic maximum of all values</td>
<td>–1 : Algebraic maximum of all values</td>
<td>–1 : Algebraic maximum of all values</td>
</tr>
<tr>
<td>–2 : Algebraic minimum of all values</td>
<td>–2 : Algebraic minimum of all values</td>
<td>–2 : Algebraic minimum of all values</td>
</tr>
<tr>
<td>TEMP(step</td>
<td>nd)</td>
<td>Temperature at time step (step) and node (nd)</td>
</tr>
<tr>
<td>GRADX(step</td>
<td>nd)</td>
<td>Temperature gradient in the x-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>GRADY(step</td>
<td>nd)</td>
<td>Temperature gradient in the y-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>GRADZ(step</td>
<td>nd)</td>
<td>Temperature gradient in the z-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>GRADN(step</td>
<td>nd)</td>
<td>Normal temperature gradient at time step (step) and node (nd)</td>
</tr>
<tr>
<td>HFLUXX(step</td>
<td>nd)</td>
<td>Heat flux in the x-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>HFLUXY(step</td>
<td>nd)</td>
<td>Heat flux in the y-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>HFLUXZ(step</td>
<td>nd)</td>
<td>Heat flux in the z-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>HFLUXN(step</td>
<td>nd)</td>
<td>Magnitude of resultant heat flux at time step (step) and node (nd)</td>
</tr>
</tbody>
</table>
## Table E-8. Predefined Postprocessing Functions for Fluid Flow Models

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>nd =</td>
<td>Node number: find value at the specified node</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Maximum absolute value (but returns with the value's original sign)</td>
<td></td>
</tr>
<tr>
<td>-1</td>
<td>Algebraic maximum of all values</td>
<td></td>
</tr>
<tr>
<td>-2</td>
<td>Algebraic minimum of all values</td>
<td></td>
</tr>
<tr>
<td>VX(step</td>
<td>nd)</td>
<td>Velocity in the x-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>VY(step</td>
<td>nd)</td>
<td>Velocity in the y-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>VZ(step</td>
<td>nd)</td>
<td>Velocity in the z-direction at time step (step) and node (nd)</td>
</tr>
<tr>
<td>VRES(step</td>
<td>nd)</td>
<td>Magnitude of resultant velocity at time step (step) and node (nd)</td>
</tr>
<tr>
<td>PRESS(step</td>
<td>nd)</td>
<td>Pressure at time step (step) and node (nd)</td>
</tr>
<tr>
<td>TEMP(step</td>
<td>nd)</td>
<td>Temperature at time step (step) and node (nd)</td>
</tr>
<tr>
<td>DENS(step</td>
<td>nd)</td>
<td>Density at time step (step) and node (nd)</td>
</tr>
<tr>
<td>MACH#(step</td>
<td>nd)</td>
<td>Mach number at time step (step) and node (nd)</td>
</tr>
<tr>
<td>TKE(step</td>
<td>nd)</td>
<td>Turbulent kinetic energy at time step (step) and node (nd)</td>
</tr>
<tr>
<td>EPS(step</td>
<td>nd)</td>
<td>Dissipation rate at time step (step) and node (nd)</td>
</tr>
<tr>
<td>STREAM(step</td>
<td>nd)</td>
<td>Stream function at time step (step) and node (nd)</td>
</tr>
<tr>
<td>TAUXY(step</td>
<td>nd)</td>
<td>Shear stress in x-direction (x-z plane) at time step (step) and node (nd)</td>
</tr>
<tr>
<td>TAUYZ(step</td>
<td>nd)</td>
<td>Shear stress in y-direction (x-y plane) at time step (step) and node (nd)</td>
</tr>
</tbody>
</table>
### Table E-8. Predefined Postprocessing Functions for Fluid Flow Models (Concluded)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>nd = Node number: find value at the specified node</td>
<td>0 : Maximum absolute value (but returns with the value's original sign)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>–1 : Algebraic maximum of all values</td>
<td></td>
</tr>
<tr>
<td></td>
<td>–2 : Algebraic minimum of all values</td>
<td></td>
</tr>
<tr>
<td>TAUZX(step</td>
<td>nd) Shear stress in z-direction (y-z plane) at time step (step) and node</td>
<td>y, z are global Cartesian axes</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>GRADX(step</td>
<td>nd) Temperature gradient in the x-direction at time step (step) and node</td>
<td>x are global Cartesian axes</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>GRADY(step</td>
<td>nd) Temperature gradient in the y-direction at time step (step) and node</td>
<td>y are global Cartesian axes</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>GRADZ(step</td>
<td>nd) Temperature gradient in the z-direction at time step (step) and node</td>
<td>z are global Cartesian axes</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>GRADN(step</td>
<td>nd) Normal temperature gradient at time step (step) and node (nd)</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTENRG(step</td>
<td>nd) Internal energy at time step (step) and node (nd)</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WX(step</td>
<td>nd) Angular velocity about the x-direction at time step (step) and node</td>
<td>x is a global Cartesian axis</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>WY(step</td>
<td>nd) Angular velocity about the y-direction at time step (step) and node</td>
<td>y is a global Cartesian axis</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>WZ(step</td>
<td>nd) Angular velocity about the z-direction at time step (step) and node</td>
<td>z is a global Cartesian axis</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
<tr>
<td>WRES(step</td>
<td>nd) Magnitude of resultant angular velocity at time step (step) and node</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>(step) and node (nd)</td>
<td></td>
</tr>
</tbody>
</table>
Table E-9. Predefined Postprocessing Functions for Electromagnetic Models

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>step = Time step number. Use (1) for steady state analysis.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nd/el = nd: nodes; el: elements.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>lab = label: find value at the specified nd/el label.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 : Maximum absolute value (but returns with the value's original sign)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-1 : Algebraic maximum of all values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-2 : Algebraic minimum of all values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MFLUXXR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXXI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXXA(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXYR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXYI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXYA(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXZR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXZI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXZA(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFLUXI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFIELDX(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFIELDY(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFIELDZ(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>MFIELDR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>Function</td>
<td>Definition</td>
<td>Remarks</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>step</td>
<td>Time step number. Use (1) for steady state analysis.</td>
<td></td>
</tr>
<tr>
<td>nd/el</td>
<td>nd: nodes; el: elements.</td>
<td></td>
</tr>
<tr>
<td>lab</td>
<td>label: find value at the specified nd/el label.</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Maximum absolute value (but returns with the value's original sign)</td>
<td></td>
</tr>
<tr>
<td>-1</td>
<td>Algebraic maximum of all values</td>
<td></td>
</tr>
<tr>
<td>-2</td>
<td>Algebraic minimum of all values</td>
<td></td>
</tr>
<tr>
<td>MFORCEXR(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEXI(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEXA(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEYR(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEYI(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEYA(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEZR(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEZI(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEZA(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCER(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEXR(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEXI(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>MFORCEYI(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
</tbody>
</table>
### Table E-9. Predefined Postprocessing Functions for Electromagnetic Models (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>step = Time step number. Use (1) for steady state analysis.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nd/el = nd: nodes; el: elements.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>lab = label: find value at the specified nd/el label.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: Maximum absolute value (but returns with the value's original sign)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-1: Algebraic maximum of all values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-2: Algebraic minimum of all values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AFORCEX(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>AFORCEY(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>AFORCEZ(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>AFORCE(step</td>
<td>nd</td>
<td>lab)</td>
</tr>
<tr>
<td>EIFIELDX(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>EIFELDY(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>EIFIELDZ(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>EIFELDR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENXR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENXI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENXA(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENYR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENYI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENYA(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENZR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
</tbody>
</table>
Control Structures: GOTO, IF-ELSEIF-ELSE and LOOP

Similar to any programming language (Fortran, for example), steps for building an algorithm can be divided into three general structures:

- **Sequence**: Contains all the steps (commands) that are performed sequentially including defining parameters (PARASSIGN, ARRDEF, ARRASSIGN, FUNCDEF).

### Table E-9. Predefined Postprocessing Functions for Electromagnetic Models (Concluded)

<table>
<thead>
<tr>
<th>Function</th>
<th>Definition</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURDENZI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENZA(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>CURDENI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>NPOTENR(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>NPOTENI(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>NPOTEN(step</td>
<td>nd/el</td>
<td>lab)</td>
</tr>
<tr>
<td>PLOSSR(step</td>
<td>el</td>
<td>lab)</td>
</tr>
<tr>
<td>PLOSSI(step</td>
<td>el</td>
<td>lab)</td>
</tr>
<tr>
<td>PLOSSA(step</td>
<td>el</td>
<td>lab)</td>
</tr>
</tbody>
</table>
Control  To jump steps (commands) or conditionally execute a defined task (commands). In the COSMOS/M language, GOTO and IF-ELSEIF-ELSE structures are used for path control.

Repetition  To loop over steps (commands) a specified number of times. The LOOP structure takes care of this part of the algorithm.

These features, as summarized in Table E-10, can be executed from a session file but they are particularly useful in macro(s) (discussed later). However, they cannot be used interactively within GEOSTAR. It should be noted that the following limitations apply to the control structure commands:

- Maximum length of the labelname = 10
- Maximum number of command lines starting with the number symbol (#) in the entire session file or in a macro file (discussed later) = 500

Table E-10. Control Structure Commands

<table>
<thead>
<tr>
<th>Command Line</th>
<th>Arguments</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>#GOTO #LABEL</td>
<td>Labelname Labelname</td>
<td>Unconditionally go to the specified label.</td>
</tr>
<tr>
<td>#IF</td>
<td>Condition</td>
<td>Perform all instructions until the next #ELSEIF, #ELSE, or corresponding #ENDIF, only if conditions are true.</td>
</tr>
<tr>
<td>#ELSEIF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#ELSE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#ENDIF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#LOOP</td>
<td>Labelname No. of loops</td>
<td>Loop over a sequence of commands ended by the specified label.</td>
</tr>
<tr>
<td>#LABEL</td>
<td>Labelname</td>
<td>Loop over a sequence of commands ended by the specified label.</td>
</tr>
</tbody>
</table>

Logical Expressions

A logical expression is similar to a parametric expression but is always evaluated to be either false or true as compared to just finding a value out of the parametric expression. Logical expressions can be formed using the following operators:
In addition, multiple logical expressions can be combined with the following connectors:

<table>
<thead>
<tr>
<th>COSMOS/M (similar to C)</th>
<th>Fortran</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;&amp;</td>
<td>.AND.</td>
<td>And</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For example, consider the logical expression:

\[ A \equiv B \]

where \( A \) and \( B \) can be defined parametric variables, elements of arrays, functions, or parametric expressions. If the value of \( A \) is equal to the value of \( B \), the logical expression \((A\equiv B)\) is true. Otherwise, the expression is false. If however you used \((A)\) by itself as an expression, then the logical expression becomes true if \( A \) is not equal to zero. Otherwise, the logical expression \((A)\) is false.

When you connect two logical expressions joined by \(||\), the entire expression is true if either or both expressions is true, and false only when both expressions are false. On the other hand when two logical expressions are joined by \(&&\), the entire expression is true only if both expressions are true. It should be noted that the connectors (\(&&\) and \(||\) ), are used only with complete logical expressions on both sides of the connector itself. Shown below are some examples to clarify this point:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>( A \leq B )</td>
<td>Valid; ( A \leq B ) and ( A &gt; C ) are both complete logical expressions</td>
</tr>
<tr>
<td>( A = C )</td>
<td>Invalid; ( B ) is not a complete logical expression</td>
</tr>
<tr>
<td>( A \equiv B )</td>
<td>Valid; ( A = B ) and ( B &lt; C ) are both complete logical expressions</td>
</tr>
<tr>
<td>( C \equiv B &gt; A )</td>
<td>Invalid; ( C ) is not a complete logical expression</td>
</tr>
</tbody>
</table>
Chapter D-40

COSMOS/M User’s Guide

IF Statement

The two available IF statement structures (IF and ELSEIF control commands utilize a condition to determine the path they should take. The condition can be a logical expression or a combination of logical expressions. Whether you want to execute one command or a number of commands (if the condition is true), the command(s) have to be sandwiched between the (#IF) and (#ENDIF) command lines. A typical IF statement in case of using only one command is shown below:

```plaintext
#IF (condition)
  command
#ENDIF
```

The general form for the IF statement in case of handling an (m) number of commands is as follows:

```plaintext
#IF (condition)
  command 1
  ....
  command m
#ENDIF
```

Moreover, nested IF statements can be constructed. The example shown below illustrates an IF statement (with condition 2) within the main IF statement (with condition 1):

```plaintext
#IF (condition 1)
  command 1
  ....
  command m
    #IF (condition 2)
      command m+1
      ....
      command n
    #ENDIF
  command n+1
  ....
  command p
#ENDIF
```
Chapter

The IF-ELSE control structure permits the program to perform a selected set of commands (1 to m) if the condition (of the #IF command line) is true, and execute another set of commands (m+1 to n) if the condition is false as shown below:

```
#IF (condition)
  command 1
  ....
  command m
#ELSE
  command m+1
  ....
  command n
#ENDIF
```

When many conditions are involved, nested IF statements may become complicated to use in order to keep track of required conditions. Instead, you can use the IF-ELSEIF-ELSE control structure as shown below for three conditions:

```
#IF (condition 1)
  command 1
  ....
  command m
#ELSEIF (condition 2)
  command m+1
  ....
  command n
#ELSEIF (condition 3)
  command n+1
  ....
  command p
#ELSE
  command m+1
  ....
  command n
#ENDIF
```

Looping

The #LOOP command line performs counting or iterative-type calculations. In the command, a label name has to be specified to mark the end of the loop, in addition
to a limit representing the number of cycles that the loop has to go through as shown below:

```plaintext
#LOOP LABEL10 NODES
Start an iterative sequence identified by a label name LABEL10 and the variable NODES representing the total number of loops to be command m completed.

command 1
.... command m

#LABEL LABEL10
End of the loop
```

An increment of one (1) is always assumed. The user has to make sure that a counter is initialized before entering the loop, and modified inside to assure exiting when the counter reaches a specified value. You can add your own loop controls by using the IF statements in addition to the GOTO feature explained later. It should be noted that you can branch out of a loop structure (using IF and GOTO statements) but you cannot branch in (from outside the loop).

The best strategy to illustrate these features is to implement them in a problem. Let's assume, as shown in Figure E-3, that you want to find the global Cartesian X-component of a radial force of a magnitude equal to the radius applied at all the nodes. The steps to perform such a task (in a session file) are shown below:

```plaintext
PARASSIGN,CSID,INT,1,
Define the label of the cylindrical coordinate system (CSID=1)

PARASSIGN,I,INT,0,
Initialize a counter (I=0).

#LOOP LABEL20 NDMAX
Start a loop structure specified by a label LABEL20. The limit of the number of loops is the maximum number of nodes in the database as defined the predefined variable NDMAX

PARASSIGN,I,INT,I+1,
Modify the counter each time by adding an increment of one (1)
```
Check the existence of each node and its accessibility using the predefined preprocessing functions EXIST and LISTSEL.

Find the angle \((\theta)\) in degrees using the predefined preprocessing function \(\text{TND}(i | \text{csid})\).

Find the radius using the predefined preprocessing function \(\text{XND}(i | \text{csid})\).

Find the force value in the X-direction as function of radius. Notice that the angle \(\theta\) has to be converted to radians.

This is a GEOSTAR command to input a force at a node in the X-direction.

End of the IF statement

End of the loop

Figure E-3. Force at a Node in the X-Direction
Unconditional Transfer of Control

The #GOTO statement bears its function in its name. It is so obvious that you can use it without any formal introduction. For example (#GOTO LABEL33) forces control to transfer to the statement bearing the label (LABEL33) and skip all commands in between. The unconditional GOTO statement should not be utilized frequently because its indiscriminate use may lead to unreadable procedures.

Macro(s)

COSMOS/M language allows the user to package logical units of regular GEOSTAR commands, parametric expressions and control structure commands into subprograms or macro(s). In a previous section, functions were introduced where you have seen how useful this feature is. A macro, similar to a subroutine in FORTRAN programming, is closely related (in concept) to a function. Although these functions are useful when you need to compute a single value, there are applications in which the user would like to generate a procedure to return many values or to execute certain steps. In these instances, macro(s) may be required. A macro has to be given a name only for documentation purposes and not to represent a value. The macro is referenced with this name and is called upon to execute its designed job by the CALLMACRO (Control > PARAMETER > Call Macro) command:

```
CALLMACRO, Macro Name, Argument Number (1),....., Argument Number (n)
```

where as noticed in the above command, the arguments of the macro are included. The macro uses these arguments not only for the subprogram input but also for its output; the macro's output is returned by its arguments rather than by its name.

The following limitations apply for the macro(s) and arguments:

- Maximum length of a macro name (has to start with an alphabetic letter) = 10
- Maximum Number of arguments = 10
- Minimum Number of arguments = 0
- Maximum length of an argument name = 10
In addition, the following restrictions apply:

- An argument has to be a single parametric variable. Functions, parametric expressions, an array or even an array's element cannot be passed unless redefined as single parametric variables (using the PARASSIGN command) before calling the macro(s); these single variables can then be passed.
- You cannot use a number in place of an argument in the CALLMACRO command. You have to assign this number to the argument's name (single variable name) using the PARASSIGN command before calling the macro(s).
- All arguments have to be declared (using the PARASSIGN command) before calling the macro(s).

Creating a Macro

Writing a macro is much like writing a subroutine in FORTRAN program. In COSMOS/M language, the macro has to be included in a GEOMACRO.MAC file where your COSMOS/M executable files are located. All the macro's commands have to be sandwiched between two statements starting with the dollar sign ($). The first statement is shown below:

```
$MACRO, Macro Name, Argument Number (1),..., Argument Number (n)
```

where the same limitations discussed before in the CALLMACRO command apply here as well. It should be noted however that the arguments in the CALLMACRO command must match in type, number and order those arguments used in the macro definitions shown above. The argument variable names themselves, though, don't have to match; the choice of the macro argument names is independent of the choice of passed variable names in the session file (or interactively) via GEOSTAR.

The macro has to end with the second dollar sign ($) statement:

```
$ENDM
```

In order to illustrate the main features of a macro, let's consider the same example discussed before in the control structures section and include the previously detailed steps in a macro:
As you can see, we used FORCEX as the macro's name with one (1) argument CSID. The argument has to be declared before calling the macro but there is no need to declare it (using the PARASSIGN command) inside the macro itself. We used local parameters inside the macro (PI, I, THETA, RADIUS, FXMAG) that are not passed through the arguments. In addition, we used predefined variables (NDMAX) and predefined functions (ATAN, EXIST, LISTSEL, YND, XND, COS). Although not mentioned in the above example, you can declare and specify values to arrays and your own defined functions. The names of these local parameters (single variables excluding arguments, functions and arrays) are independent of the main program (session file) and they don't have to be declared before calling the macro(s). There are some limitations for the macro's local parameters:

- Maximum number of single variables (including the arguments) in a macro = 50
- Maximum number of local functions in a macro = 50
- Maximum number of local arrays in a macro = 10

Unlike the local parameters, the effect of local regular GEOSTAR commands (such as FND in the above example) is not considered local but rather similar to its use outside a macro in the session file.

It should be mentioned at this point that the same limitations that control the parameter names (variables, arrays and functions), function arguments, function expressions, dimensions of arrays, maximum number of the (#) control statements,... etc., are similar to the same values mentioned before for a session file.
Nested Macros

Macro(s) can call each other. However, COSMOS/M language is not recursive; a macro cannot call itself. All the macro(s) have to be included in the GEOMACRO.MAC file in the COSMOS/M directory without any required order of arrangement in the file. The same procedure discussed before, to call a macro from a session file including the limitations organizing its arguments, local parameters and commands, still applies for a macro calling another macro. An example is shown below:

```
$MACRO,MACRO1,ARG1,ARG2,ARG3
    Start the first macro named MACRO1 with three arguments
    CALLMACRO,MACRO2,
    ................
    CALLMACRO,MACROM,LC,
$ENDM
    End of the third macro
$MACRO,MACRO2,
    ................
    CALLMACRO,MACRON,C1,C2,
    ................
    Define the second macro
$ENDM
    End of the second macro
$MACRO,MACRON,T1,T2,
    Start macro MACRON with two arguments
    ................
$ENDM
    End of macro MACRON
$MACRO,MACROM,LCC,
    ............
    Define macro MACROM with one argument
$ENDM
    End macro MACROM
```

There is no limit over the number of nesting levels. After each nested macro is executed, control returns to the previous level. It has to be mentioned however that you should avoid having two macro(s) calling each other where an infinite nested process may occur.
**Application Example**

In this section, a simple structural problem is used to demonstrate some of the COSMOS/M command language features. Figure E-4 shows the geometry, loads and boundary conditions of the problem. The model consists of outer and inner circles where the inner circle is totally fixed. The objectives of this simple example is twofold:

- Mesh the model and apply a uniform pressure on the outer circle for the first load case. Use COSMOS/M language to find the maximum von Mises stress and its location.
- Find the displacements of nodes associated with the outer circle based on the first load case and apply them as prescribed boundary conditions on the same meshed model in a second load case. COSMOS/M language will be used to transfer the results of load case (1) as input data for load case (2).

**Figure E-4. Geometry, Loads and Boundary Conditions**

As suggested in Chapter 2, creation of databases in COSMOS/M directory should be avoided. Move to a work directory and type GEOSTAR.

C:\WORK > GEOSTAR

GEOSTAR will prompt you for a problem name. Choose any name. Type STATUS1 or pull down the CONTROL menu, select the UTILITY submenu and then the STATUS1 command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities.
(points “PT”, curves “CR”, surfaces “SF”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on ON/OFF flag for PT, CR and SF. Press either button of the mouse to switch from OFF to ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons.

The following commands define the geometry, mesh, boundary conditions and applied pressure for the first load case:

```
VIEW,0,0,1,0,
    Set the view to X-Y plane
PLANE,Z,0,1,
    Define the plane of modeling (for 2D problems, you have to use the X-Y plane)
CRSCIRCLE,1,0,0,0,100,0,0,4,
    Create the outer circle
SCALE,0,
    Create the inner circle
CRSCIRCLE,5,0,0,0,50,0,0,4,
    Define a surface using 4 curves
CRLINE,9,6,2,
    Generate a line between points (9) and (6)
CRLINE,10,7,3,
    Define a surface using 4 curves
CRLINE,11,8,4,
    Mesh the four surfaces with (6) elements on the surface's first curve and (20) elements on the second curve
CRLINE,12,9,5,
SF4CR,1,9,1,4,6,20,1,1,
M_SF,1,4,1,4,6,20,1,1,
NMERGE;
    Merge nodes
```
NCOMPRESS;
  Compress nodes

CLS;

EPLOT;

CRPLOT,1,8,1,
PCR,1,10,0.4,1,10,4,
  Define pressure on the outer circle

DCR,5,ALL,0,8,1,
  Define boundary conditions on the inner circle

EGROUP,1,PLANE2D,0,1,0,0,0,0,0,
  Use the 4-node PLANE2D element group with plane stress analysis option

RCONST,1,1,2,0.1,0,
  Specify thickness of the plate

PICK_MAT,1,A_STEEL,FPS,
  Pick the alloy steel material which has the following properties:
  EX=30.0E+6 psi; NUXY= 0.28

R_STATIC

Run the Static Module

You can use the STRMAX command to find out the maximum von Mises stresses calculated at nodes. Let's however try to utilize one the COSMOS/M predefined postprocessing functions VON to find the maximum (algebraic) von Mises stress (review this function in Table E-6). Declare a single variable VONMAX1 as the single output of the function VON:

  PARASSIGN,VONMAX1,REAL,VON(1|ND|-1),

List the value of VONMAX1 using the PARLIST command and compare it with the values you obtained out of the STRMAX command.

Now, let's create a macro to do the same job in addition to finding the location of the maximum value. The SYSTEM command can take you to the operating system level without leaving GEOSTAR. Go to the COSMOS/M directory and open a new file called GEOMACRO.MAC. If you have an existing file with the same name which you used before to create macro(s), you can append to its existing contents. Insert the following macro in the file:
$MACRO,MAXVON,LC,NODE,VONMAX,  
Start a macro called MAXVON with three arguments  
PARASSIGN,I,INT,0,  
PARASSIGN,J,INT,0,  
#LOOP,LOOP1,NDMAX,  
Loop over the maximum number of nodes in the database  
PARASSIGN,I,INT,I+1,  
#IF (EXIST(ND|I))  
Perform the following steps only if the node exists  
PARASSIGN,X,REAL,VON(LC|ND|I)  
#IF (J == 0 || X > VONMAX)  
PARASSIGN,VONMAX,REAL,X,  
PARASSIGN,NODE,INT,I,  
#Endif  
PARASSIGN,J,INT,I,  
#Endif  
#LABEL,LOOP1,  
$ENDM

Save the file and go back to your working directory before hitting any key to return to GEOSTAR. The macro returns the maximum von Mises stress as VONMAX and its nodal location as NODE for the specified load case LC which is an input to the macro. We used the predefined preprocessing function EXIST (shown in Table E-5) and the predefined postprocessing function VON (shown in Table E-6).

As discussed in the preceding sections, you have to declare the macro's arguments before you call it. Specify the load case number through the variable LC and initialize the single parameters VONMAX2 and NODE which will return the maximum value of von Mises stress and its nodal location. Notice that we used a different name (VONMAX2) for one of the macro's arguments (VONMAX).

PARASSIGN,LC,INT,1,  
PARASSIGN,VONMAX2,REAL,0.0,  
PARASSIGN,NODE,INT,0,

Now, let's call the macro:

GEO > CALLMACRO  
Input macro name > MAXVON  
Input argument variable 1: > LC
Check the parametric values VONMAX2 and NODE, using the PARLIST command, and compare them with the previous results. You can try to modify the macro to find all locations of the same maximum von Mises stresses. We will not attempt it here. Instead we will go now to the GEOMARCO.MAC file and create the macro shown below to read the displacements of nodes in an active selection list and utilize them as prescribed displacements using the DND command.

$MACRO,PRISCBC,LC,CS
    Start a macro with two arguments which refer to the load case for which displacements will be retrieved and the coordinate system
    PARASSIGN,I,INT,0,
    Initialize a counter I
    #LOOP,LOOP1,NDMAX,
    Loop over the maximum number of nodes in the database
    PARASSIGN,I,INT,I+1,
    #IF(EXIST(ND|I)&&LISTSEL(ND|I))
    Check the existence of the node in database and in the active selection list
    DND,I,UX,UX(LC|I|CS),I,1,
    Define prescribed displacements in the x-direction for the active load case
    DND,I,UY,UY(LC|I|CS),I,1,
    DND,I,UZ,UZ(LC|I|CS),I,1,
    #ENDIF
    #LABEL,LOOP1,
$ENDM

You can return to the working directory and then to GEOSTAR after saving the GEOMACRO.MAC file. Before calling the macro we have to activate a second load case and select only the nodes associated with the outer circle. The macro will then find displacements of the nodes associated with the outer circle and apply them as prescribed boundary conditions.

ACTSET,LC,2,
SELREF,ND,CR,1,4,1,
Declare and define a variable LC1 to refer to the load case for which displacements are utilized in the macro:

\[
\begin{align*}
\text{PARASSIGN}, & \text{LC1}, \text{INT}, 1, \\
\text{PARASSIGN}, & \text{CS}, \text{INT}, 0, \\
\text{CALLMACRO}, & \text{PRISCBC}, \text{LC1}, \text{CS}, \\
\end{align*}
\]

Call the macro

\[
\text{R_STATIC}
\]

Run the Static Module

Once the run is over, you can find the minimum algebraic DXMIN, maximum algebraic DXMAX and maximum absolute (but returning with the original sign) DXMAXABS of displacements in the X-direction as follows:

\[
\begin{align*}
\text{PARASSIGN}, & \text{DXMIN}, \text{REAL}, \text{UX}(2|-2|\text{CS}), \\
\text{PARASSIGN}, & \text{DXMAX}, \text{REAL}, \text{UX}(2|-1|\text{CS}), \\
\text{PARASSIGN}, & \text{DXMAXABS}, \text{REAL}, \text{UX}(2|0|\text{CS}),
\end{align*}
\]

Special Application: Hydrostatic Pressure

A macro (named HSPR) has been prepared and included in the GEOMACRO.MAC file in the COSMOS/M directory to facilitate calculating the pressure value (required by the PEL command) for elements subjected to hydrostatic pressure. The macro and the description of its arguments are shown in Figure E-5. The macro loops over all elements available in the database defined by the ELMAX predefined variable (Table E-3). It then checks the existence of the element in the database and the selection list using the EXIST and LISTSEL preprocessing functions (Table E-5). The macro finds the face number of the element associated with the entity subjected to the hydrostatic pressure using the ELFACE preprocessing function (Table E-5). The YELF function (Table E-5) is then used to determine the y-coordinate of the center of gravity of the element's face. The pressure at the center of gravity is calculated and applied on the face of the element. It should be mentioned that:

- The type of entities subjected to hydrostatic pressure can be curves (CR), surfaces (SF) or regions (RG).
- The process is faster if the user placed all the elements associated with the entity in a selection list (e.g., using SELREF command).
The macro assumes that \((y)\) is the vertical axis for the hydrostatic pressure calculations. However, the user can modify the macro by replacing the \textit{YELF} function with either \textit{XELF} or \textit{ZELF} to consider \(x\) or \(z\) as the vertical axis.

The macro can be easily customized to include non-uniform fluid density and the effect of pressure at the free surface.

**Figure E-5. A Macro for Hydrostatic Pressure Calculations**

\[
\text{CSID} = \text{Label of the coordinate system considered for pressure calculations.} \\
\text{HOFF} = \text{y-coordinate of the free surface measured in CSID system.} \\
\text{COEF} = \text{Unit weight of the fluid.} \\
\text{PTYP} = \text{Type of entity subjected to the hydrostatic pressure (CR, SF or RG)} \\
\text{PNUM} = \text{Label of PTYP}
\]

---

The \textit{HSPR} macro is included in the \textit{GEOMACRO.MAC} file (COSMOS/M directory)

```plaintext
$MACRO, HSPR, PTYP, PNUM, HOFF, COEF, CSID
PARASSIGN, I, INT, 0
#LOOP LP1 ELMAX
   PARASSIGN, I, INT, I+1,
   #IF (EXIST (EL|I) && LISTSEL (EL | I))
     PARASSIGN, FNUM, INT, ELFACE (I|PTYP|PNUM),
     #IF FNUM
       PARASSIGN, Y, REAL, YELF (I|FNUM | CSID),
       PARASSIGN, PVAL, REAL, (Y-HOFF) *COEF,
       PEL, I, FVAL, FNUM,
     #ENDIF
   #ENDIF
#ENDIF
#LABEL LP1
$ENDM
```
Chapter

The macro can be used within GEOSTAR as follows:

- First, define the macro's arguments:

  GEO > PARASSIGN,CSID,INT,........,
      .... Label of the Coordinate system for pressure calculations ....
  GEO > PARASSIGN,HOFF,REAL,........,
      .... y-coordinate of the free surface ....
  GEO > PARASSIGN,COEF,REAL,........,
      .... unit weight of the fluid ....
  GEO > PARASSIGN,PTYP,INT,........,
      .... CR or SF or RG ....
  GEO > PARASSIGN,PNUM,INT,........,
      .... label of PTYP ....

- Second, call the macro:

  GEO > CALLMACRO,HSPR,PTYP,PNUM,HOFF,COEF,CSID,

As an example, let's create a three-dimensional model of a gravity dam where it is required to apply hydrostatic pressure on its upstream face. The following commands will generate the model's geometry and mesh it:

- PLANE,Z,0,1,
- VIEW,0,0,1,0,
- CRSPOLY,1,25,20,0,L,25,30,0,L,15,30,0,L,&
  15,10,0,L,85,10,0,L,85,0,0,L,95,0,0,L,95,&
  20,0,L,75,20,0,L,60,75,0,L,60,85,0,L,50,&
  85,0,L,50,75,0,L,35,20,0,L,25,20,0,
- CT,1,0,10,1,0,
- RG,1,1,1,0,
- VIEW,1,1,1,0,
- PT,15,-100,0,0,
- CSYS,3,0,15,4,3,
- PHSWEEP,RG,1,1,1,Y,60,1,6,1,1,15,0.001,
- PART,1,1,
- MA_PART,1,1,1,1,0,4,

Now, create coordinate system (4) for hydrostatic pressure calculations:

  CSYS,4,0,12,11,10,
Prepare for calling the hydrostatic pressure macro:

```
PARASSIGN,CSID,INT,4,
    Coordinate system for pressure calculations = 4
PARASSIGN,PTYP,INT,SF,
    Define the entity's type as surface.
PARASSIGN,PNUM,INT,13,
    Surface subjected to hydrostatic pressure = 13
PARASSIGN,H OFFSET,REAL,10.0,
    y-coordinate (CSID=4) of free surface = 10
PARASSIGN,COEF,REAL,1.0,
    Unit weight of water = 1.0
```

Now, call the hydrostatic pressure macro:

```
CALLMACRO,HSPR,PTYP,PNUM,H OFFSET,COEF,CSID,
```

**Simple Optimization Application**

The growing use of the finite element method in the area of structural optimization has led to the introduction of new techniques and procedures for the solution of such problems. In using COSMOS/M for structural analysis of real-life problems, users do not have access to the source program to introduce changes that would suit their particular applications. Yet, they can still use the software package as a black box, with the help of its powerful parametric language, to develop procedures for challenging and relatively new applications such as structural optimization.

Let's consider an aluminum cantilever beam, as shown in Figure E-6, subjected to pressure load ($P=-1000$ psi) in the (Y) direction. The beam dimensions are as follows:

- $L$ = Length (40 inches)
- $H$ = Height (10 inches)
- $T$ = Thickness (2 inches)
- $RF$ = Radius of Fillet (inches) ($0.5 < RF < 39.5$)
It is desired to find the radius of the fillet (RF), specifying it as a design variable, in order to achieve a minimum weight (W) for the beam subject to the constraint that maximum von Mises stress is less than or equal to 20,000 psi. The total weight is given by the following expression:

\[ W = T \times (L \times H + (2 - \frac{p}{2}) \times RF^2) \times DENSITY \]

It can be noticed that the smaller the radius of the fillet (RF), the lower the weight of the beam. The objective can then be shifted to finding a minimum value of (RF) so that the maximum von Mises stress is less than or equal to 20,000 psi. In this analysis, and also because of manufacturing considerations, a tolerance of (0.5 in) in the fillet radius will be specified. Although this problem might seem very simple, nevertheless it can show the concept used in conjunction with COSMOS/M parametric language operations. The bisection method is used for this problem to find the optimal radius of the fillet.

As suggested before, creation of databases in COSMOS/M directory should be avoided. Move to a work directory and type GEOSTAR.

GEOSTAR will prompt you for a problem name. Choose any name. Type STATUS1 or pull down the CONTROL menu, select the UTILITY sub-menu and then the STATUS1 command. A table will be displayed in which current information on the status of several flags controlling the plot of geometrical entities (points “PT”, curves “CR”, regions “RG”, etc.), their colors, labels, label colors and other options are shown. This table allows the user to toggle the flags between ON/OFF and select the color of the various entities. We will change the label status of points, curves and surfaces from OFF to ON. Although this process is not always required, we need it in this example to make it easier for you to follow the modeling procedure. The operation is accomplished by placing the mouse cursor on ON/OFF flag for PT, CR and RG. Press either button of the mouse to switch from OFF to
ON. After making the three changes, save them by moving the mouse cursor to SAVE and click any of its buttons. Next, start issuing the following commands to define parametrically the dimensions and properties of the beam model:

```
PARASSIGN,L,REAL,40,
PARASSIGN,H,REAL,10,
PARASSIGN,T,REAL,2,
    Define the cantilever length (L) height (H) and thickness (T)
PARASSIGN,RF1,REAL,0.5
PARASSIGN,RF2,REAL,39.5
    Set the lower bound of (RF) as RF1 and the upper bound of (RF) as RF2
PARASSIGN,VONADM,REAL,20000,
    Specify von Mises stress constraint
PARASSIGN,ABSERR,REAL,0.5,
    Set the tolerance for the radius
PARASSIGN,P,REAL,-1000
    Define the pressure (P=-1000)
EGROUP,1,TRIANG,0,1,0,0,0,0,0,0,0,0,
    Use plane stress triangular elements with thickness T=2 and pick
    the Aluminum material
RCONST,1,1,1,2,T,0,
PICK_MAT,1,ALUMINUM,FPS,
PLANE;
VIEW;
```

Now let's start the optimization process by specifying an initial estimate for the fillet's radius (RF=RF1):

```
PARASSIGN,RF,REAL,RF1,
```

We will next generate a procedure to create the problem's geometry, mesh it using 3-node triangular elements, increase the order of elements and run static analysis. We will need to repeat this procedure many times during the optimization process and therefore it can be included in a macro as illustrated before in the previous examples. In this problem however, we will try another approach. We will include all these steps in a file and we will import this file to GEOSTAR using the FILE command. You may now access the operating system through the SYSTEM or OSCOMMAND commands and edit a file (we will call it here “NEWANA.GEO”) to include the following commands:
After saving the file, hit any key to go back to GEOSTAR and type the following command:

```
FILE,NEWANA.GEO;
```

You will notice that the finite element model will be simultaneously constructed and displayed on the screen as the input file is read into GEOSTAR. You will also see the execution of the analysis module.

Next, perform the following commands:

```
ARRDEF,MAXVON[20],REAL,
    Define a one-dimensional array MAXVON
ARRASSIGN,MAXVON[1],VON(1|ND|0),
    Store the maximum von Mises stress value at nodes in the first element of the MAXVON array
```

Before starting another cycle of calculations, we need to delete all geometry and associated elements from the database. You can include the following commands in a file and call it “CLEAN.GEO”.

```
MARGDEL,1,
RGDEL,1,
PTDEL,1,10,
```

Import the cleaning procedure using the `FILE` command as shown below:

```
FILE,CLEAN.GEO;
```
Chapter

Now, let's find the maximum von Mises stress using the upper bound of the fillet's radius (RF=RF2):

\[
\text{PARASSIGN,RF,REAL,RF2,}
\text{FILE,NEWANA.GEO;}
\text{ARRASSIGN,MAXVON[2],VON(1|ND|0),}
\]

\[
\text{Store the maximum von Mises stress value at nodes in the second element of the MAXVON array}
\]

We will now use the bisection method to decide the next radius value. It should be mentioned that the procedure is not intended to be general in any way but rather illustrative to show the COSMOS/M language features:

\[
\text{PARASSIGN,DVM1,REAL,VONADM-MAXVON[1],}
\text{PARASSIGN,DVM2,REAL,VONADM-MAXVON[2],}
\text{#IF (DVM1*DVM2 > 0)}
\]

\[
\text{Notice that this part has to be input through a session file. The # statements cannot be used interactively in GEOSTAR.}
\]

\[
\text{#GOTO END}
\text{#ENDIF}
\text{PARASSIGN,RF,REAL,(RF1+RF2)/2,}
\text{FILE,CLEAN.GEO;}
\text{FILE,NEWANA.GEO;}
\text{ARRASSIGN,MAXVON[3],VON(1|ND|0),}
\]

We can repeat a similar procedure to estimate the fillet's radius by looping over a controlled number of cycles:

\[
\text{PARASSIGN,I,INT,3,}
\text{PARASSIGN,MAXITER,INT,18,}
\]

\[
\text{Set the maximum number of optimization cycles}
\]

\[
\text{#LOOP LABEL1 MAXITER}
\text{It should be emphasized one more time that this part of the procedure (enclosed by the #LOOP and #LABEL statements) has to be imported from a file or read from a session file.}
\]

\[
\text{PARASSIGN,DVM,REAL,VONADM-MAXVON[I],}
\text{PARASSIGN,I,INT,I+1,}
\text{#IF (DVM*DVM1 > 0)}
\]

\[
\text{PARASSIGN,RF1,REAL,RF,}
\text{PARASSIGN,DVM1,REAL,DVM,}
\]
PARASSIGN, RF2, REAL, RF
PARASSIGN, DVM2, REAL, DVM

PARASSIGN, RF, REAL, (RF1 + RF2)/2,
FILE, CLEAN.GEO;
FILE, NEWANA.GEO;
ARRASSIGN, MAXVON[I], VON(1|ND|0),
PARASSIGN, DRF, REAL, RF2-RF1,
#IF (ABS(DRF) < ABSERR)
    #GOTO END
#ENDIF

#LABEL LABEL1
#LABEL END
PARASSIGN, DVM, REAL, MAXVON[I],
#IF (DVM > VONADM)
    Make sure that maximum von Mises stress does not exceed 20,000 psi.
    PARASSIGN, RF, REAL, RF2,
#ENDIF
FILE, CLEAN.GEO;
FILE, NEWANA.GEO;

Run the analysis one more time to find the final stress distribution.

You can list all parameters and elements of the MAXVON array using the PARLIST and ARRLIST commands respectively. A value of (17.87 in) is obtained for the fillet's radius. The initial and final geometries of the cantilever beam are shown in Figure E-7. You can now plot von Mises stress distribution as follows:

    ACTSTR;
    STRPLOT;

Notice that maximum value of von Mises stresses, as shown in Figure E-8, does not exceed the imposed constraint. You can now try to run the same problem using the macro feature.

More complicated sizing and shape optimization procedures may be programmed using the COSMOS/M command language in conjunction with GEOSTAR and the Analysis Modules capabilities.
Chapter

Figure E-7. Initial and Final Design of the Cantilever

Initial Geometry

- Fillet Radius = 0.5 inch

Final Geometry

- Fillet Radius = 17.87 inch

Figure E-8. Von Mises Stress Distribution
Troubleshooting

Introduction

Much effort has gone into the design and organization of the various COSMOS/M program modules to provide you with clear messages in case of failure during a solution step. The difficulties encountered in running a finite element analysis program can in general be classified into the following categories:

1. Installation problems,
2. Modeling and input file preparation (pre- and postprocessing problems), and
3. Analysis problems.
4. Input/Output problems

This appendix will provide coverage on some of the more commonly encountered problems in pre- and postprocessing. For installation problems, refer to the Setup chapter in the COSMOS/M 2.0 Getting Started manual. For analysis problems, refer to the Troubleshooting chapter in the Basic System manual for the basic modules (STAR and DSTAR), COSMOS/FFE Modules manual for FFE modules, and the “Advanced Modules User Guide” for the advanced modules (ASTAR, HSTAR, NSTAR, ESTAR, FSTAR, FLOWSTAR, FLOWPLUS, and OPTSTAR).
Common Problems

Blank Screen While Building a Model

Users may think that their models are lost because they accidentally cleared the screen. Clearing the screen however does not delete any entities, but users must distinguish between database information and screen plots. Information in the database is not shown on the screen unless plotted or listed. A blank screen does not indicate an empty database, it means that no entities are currently plotted. Plotting commands like PTPLOT, CRPLOT, SFPLOT, VLPLOT, CTPlot, RGPlot, PHPlot, PARTPLOT, NPLOT, and EPLOT may be used to generate the desired picture.

Small Dimensions

If the dimensions of the model are very small, problems related to precision might occur in geometry operations. To fix the problem, change to smaller units so that larger numbers for the dimensions are obtained.

Losing the Session File

If an existing problem is opened by error as a new problem, the old database files including the session file are initialized. GEOSTAR however keeps a copy of the old session file in a file with the same name as the problem name and extension “BCK”. The “BCK” file may be read to another new problem using the “FILE” command to rebuild the database if desired.

Unexpected Number of Keypoints Generated from IGES or DXF Files

This problem usually happens because the keypoint merging tolerance in GEOSTAR is different from the keypoint merging tolerance in the package which generated the IGES or the DXF file. To fix this problem, the user should know in advance the keypoint merging tolerance used in the source program. The user should then open a new GEOSTAR problem, use the PTTOL command to specify that tolerance and then read-in the file.
Chapter

Keeping Lower Entities

When an entity is deleted, GEOSTAR by default deletes all lower entities associated with it. For example, if a part is deleted, then all polyhedra, regions, contours, curves, elements, and nodes associated with the deleted part are also deleted. In many cases, it is desired to delete a higher entity without deleting some of the lower entities associated with it. Suppose that you want to delete a part, but keep curves, elements and nodes. To accomplish this, the ACTKEEP command may be used to activate keeping curves, elements and nodes before deleting the part. The keep flag may also be activated or deactivated from the STATUS1 table.

For some geometric entities, undeleting commands are also available, but must be issued before creating new entities. If the part in the above example was deleted and the user forgot to issue the “ACTKEEP, CR, 1” command, then curves may be recovered by using the CRUNDEL command.

Carrying Element Attributes In Generations

It is convenient in many cases to carry the mesh when creating new geometric entities by symmetry, generation, copying, etc. If the source entities are meshed and you want to carry the mesh while operating on geometric entities, then the default meshing flag must first be activated. The new entities then will be automatically meshed as soon as they are generated. Default meshing is controlled by the ACTDMESH command or from the STATUS1 table. GEOSTAR by default assigns the source element attributes to all new generated elements. As an example suppose that half of a model was generated by meshing surfaces, and suppose that different real constant sets were used for different surfaces. If the user activates default meshing for surfaces and used the SFSYM command to generate the other half, then all new elements would have the corresponding source elements. The “EPROPSET” command may, however, be used to instruct GEOSTAR to assign the active attributes to all elements or increment the corresponding attribute by some integer value. (Refer to on-line help for the EPROPSET command).

Cannot Find Fillet

When trying to create fillets between curves or surfaces using the “CRFILLET”, or the “SFFILLET” commands, a message saying that GEOSTAR cannot find fillet between two curves may be obtained. To fix the problem, check your input, use a different radius or tolerance and try again.
Failure During Geometry Creation or Parametric Meshing

This problem is most commonly caused by bad curves. A bad curve will usually extend beyond one or both of its end keypoints and will look like a loop if enough zooming-in is done. Bad curves may sometimes be generated by intersections. To fix such a curve, the CRBRK command may be used to generate 2 keypoints along the curve which then may be used by the CR4PT command to redefine the curve.

Triangulation Error During Automatic Meshing

This error is usually caused by stringent meshing specifications that will not allow enough transition for element size changes. The problem may be fixed by changing element sizes or the number of elements on different curves to some reasonable specifications that will give the program enough room for transition.

Contour Creation is Too Slow

If there are too many curves, contour creation might be very slow, the command may be interrupted by the “Esc” key. To accelerate creating a contour, select curves in the neighborhood of the contour to be created and specify that only curves in the selection set are to be used for contour creation. An alternative is to specify all curves of the contour.

GEOSTAR Fails to Create a Polyhedron

The user must verify that all regions and/or surfaces connected to each other within the specified tolerance, cover all surface areas of the 3D enclosure to be defined as a polyhedron. Every small area on the boundary of the enclosure must be included as a part of either a surface or a region. Overlapping is not allowed. Use the selection list utility to exclude surfaces and regions which are connected to the entities to be used for the polyhedron creation, but are not part of it.

The problem may also happen if the geometry is imported from some other programs, or if gaps exist between surfaces and/or regions forming the polyhedron. Use a little larger tolerance in the PH command and try again. Do not specify an element size smaller than the tolerance in the neighborhood of the gap. The CRMERGE command may also fix this kind of problems.
Probable Free Edges During Part or Polyhedra Meshing

Verify that the element size you specified is reasonable. An element size smaller than the tolerance specified for the polyhedron may result in this error. An element size which is larger than twice the smallest curve may also cause this error. The tolerance and the smallest curve size should be the bounds on the element size for a given region. GEOSTAR will tell you the curves with probable free edges. Try to mesh the regions and/or surfaces that use these curves individually until they are meshed, or bad curves are identified. Fix bad curves and try to mesh again. The RGSF and CRMERGE commands might solve the problem.

Mesh Mismatch for Polyhedra and Parts with Common Surfaces

If meshing of various polyhedra and parts is done after all meshing specifications are input, a compatible mesh will always be obtained unless some surfaces are common to different polyhedra or parts. The CRDENSITY, CTDENSITY, RGDENSITY, and PHDENSITY commands work in conjunction with contours and regions, but do not work for surfaces. To ensure a compatible mesh, use the RGSF command to convert surfaces into regions, redefine the polyhedra and then mesh again. The meshing process itself should be delayed until all mesh control parameters are specified.

Chart is Shown but Elements are not Plotted in Postprocessing

This problem happens in the case of 3D elements because the hiding algorithm is active and boundary element faces are not associated with any geometry. To fix the problem, use the EVAL_BOUND command to identify boundary faces and issue the postprocessing command again. An alternative is to use the “BOUNDARY,1,0” command which forces the plotting of every face of every element.

Special Element Plots are not Generated Properly

The SETEPLT command contains a flag that instructs the program to generate 3D schematic plots showing the cross-section for subsequent plotting of TRUSS2D, TRUSS3D, BEAM2D, BEAM3D, PIPE, and ELBOW elements. If intersections of such elements are not properly shown, activate the z-buffer algorithm in the HIDE_OPT command and plot the elements again.
Problems with Hidden Face Element Plots

Usually this happens with the depth-sort algorithm. This problem may be corrected by specifying the z-buffer option in the HIDE_OPT command. If the “plot-every-face” option is active, use the “BOUNDARY,1,1” to deactivate it and then use the “EVAL_BOUND” instead to identify boundary faces.

Using C* in Parametric Expressions

The string “C*” indicates a comment. The “*” is used in parametric expressions for multiplication. If “C” or a name ending with a “C” was used as a variable name and that variable appears with a “*” next to it, then the expression will not be evaluated properly since the “C*” and the rest of the expression will be regarded as a comment. The user should either avoid using variable names ending with a “C”, or enclose such variables between parenthesis whenever a “*” appears after such variable names.
**Input File Structure**

**Introduction**

The following input command blocks provide the required input for the analysis of 2D and 3D linear static, frequency, buckling, and thermal problems by the COSMOS/M Finite Element Analysis program.

**COSMOS/M Input File Structure**

Write the command blocks in the order shown below. This is only a recommended sequence as COMSOS/M provides flexibility for the definition of various input strings. Also note that not all command blocks are always required. Choose them as deemed necessary and on the basis of the original problem definition.

**Title and Subtitle Commands** (First command block)

```
TITLE,
A text string of up to 80 characters

SUBTITLE,
A text string of up to 80 characters [optional]
```
Element Group Commands (Second command block)

Issue one or more of the following element group commands as shown to define your element types. The text is considered comment and therefore is optional.

Note that the element groups defined below may be used for either STRUCTURAL or THERMAL (HEAT TRANSFER) problems. Use all default options (i.e., ignore them) except when noted otherwise.

```
EGROUP,group_no,elem_name,option(1),...,option(8)
```

Element group types available are the following:

```
EGROUP,group_no,MASS
  1-node concentrated mass element
EGROUP,group_no,TRUSS3D
  2-node three-dimensional truss element
EGROUP,group_no,BEAM3D
  3-node three-dimensional beam element
EGROUP,group_no,PIPE
  2-node elastic straight pipe element
EGROUP,group_no,ELBOW
  3-node elastic curved pipe element
EGROUP,group_no,SPRING
  2-node spring element
EGROUP,group_no,TRIANG
  3-or 6-node plane stress element in XY-plane
EGROUP,group_no,TRIANG,,,1
  3-or 6-node axisym element in XY-plane
EGROUP,group_no,TRIANG,,,2
  3 or 6-node plane strain element in XY-plane
EGROUP,group_no,PLANE2D
  4-to 8-node plane stress element in XY-plane
EGROUP,group_no,PLANE2D,,,1
  4-to 8-node axisym element in XY-plane
EGROUP,group_no,PLANE2D,,,2
  4-to 8-node plane strain element in XY-plane
```
EGROUP,group_no,SHELL3
  3-node thin shell element
EGROUP,group_no,SHELL3T
  3-node thick shell element
EGROUP,group_no,SHELL3L
  3-node composite shell element
EGROUP,group_no,SHELL4
  4-node thin shell element
EGROUP,group_no,SHELL4T
  4-node thick shell element
EGROUP,group_no,SHELL4L
  4-node composite shell element
EGROUP,group_no,SHELL6
  6-node thin shell element
EGROUP,group_no,SHELL9
  8/9-node shell element
EGROUP,group_no,SHELL9L
  8/9-node composite shell element
EGROUP,group_no,TETRA4
  4-node 3D tetra element
EGROUP,group_no,TETRA10
  10-node 3D tetra element
EGROUP,group_no,TETRA4R
  4-node 3D tetra element with rotation
EGROUP,group_no,SOLID
  8- to 20-node 3D solid element
EGROUP,group_no,CLINK
  2-node convection link element
EGROUP,group_no,RLINK
  2-node radiation link element
EGROUP,group_no,HLINK
  2-node or 4-node pipe flow element
EGROUP,group_no,GAP
  2-node gap element
EGROUP,group_no,FLOW2D  
4-node 2D fluid flow element

EGROUP,group_no,FLOW3D  
8-node 3D fluid flow element

EGROUP,group_no,MAG2D  
4-node 2D magnetic element

EGROUP,group_no,MAG3D  
8-node 3D magnetic element

Example 1
For a model built from TETRA4R and SHELL3T, the element groups may be defined as follows:

EGROUP,1,SHELL3T
EGROUP,2,TETRA4R

For each element group, the associated Real Constants, section properties and associated Material Properties must also be defined.

Real Constant Set Commands: Element Section Properties (Third command block)

The Real Constant set command is as follows:

RCONST,el_group_no,rc_set_no,starting_rc,total_of_rc,values(i)

For the actual number of real constants and their definitions for each element group, please refer to Chapter 4 of this manual.

You may define several real_constant sets for the same element group, or if the model should consist of more than one element type, then a different real constant set should be assigned to each element type.

Below, the real constant commands for the commonly used elements are explicitly given. In all cases it is assumed that both Real Constant and Element Group set numbers are 1.

1. MASS element real constants:

   RCONST,1,1,7,X_mass,Y_mass,Z_mass,X_rot_inertia,Y_rot_inertia,Z_rot_inertia
2. TRUSS3D element real constants:
   RCONST,1,1,1,2,cross_section_area,cross_section_perimeter

3. BEAM3D element real constants:
   For beam elements, it is recommended that you refer to Chapter 4 in this manual.

4. PIPE element real constants:
   RCONST,1,1,1,3,outer_diameter,wall_thickness,internal_pressure

5. ELBOW element real constants:
   RCONST,1,1,1,4,outer_diam,wall_thickness,internal_press, radius_curvature

6. SPRING element real constants:
   RCONST,1,1,1,2,axial_stiffness,rotational_stiffness

7. TRIANG element real constants:
   RCONST,1,1,1,2,thickness,material_angle

8. PLANE2D element real constants:
   RCONST,1,1,1,2,thickness,material_angle

9. SHELL3, SHELL3T, SHELL4, SHELL4T, SHELL6, SHELL9 real constants:
   RCONST,1,1,1,2,thickness,temp_gradient,foundation_stiffness
   Foundation stiffness is used in STAR for SHELL3, SHELL3T, SHELL4, and SHELL4T.

10. SHELL3L, SHELL4L, SHELL9L real constants:
    For composite shell elements, it is recommended that you refer to Chapter 4 in this manual

11. SOLID element real constants:
    For solid elements, the nine real constants establish the location of three points defining the material coordinate system.
    RCONST,1,1,1,9,x1,y1,z1,x2,y2,z2,x3,y3,z3

12. TETRA4, TETRA10, TETRA4R real constants:
    Tetra elements do not have any real constants to be defined
Below an example of real constant definition is given:

**Example 2**
Issue the real constant commands for elements of Example 1.

```
RCONST,1,1,1,1,0.5
```

*Shell Thickness is the only RC, and defined as 0.5. Temperature gradient is assumed 0.*

The TETRA4R does not have any real constant to be defined.

**Material Property Set Commands: Element Properties (Fourth command block)**

Material properties may in general be associated with temperature, in which case the appropriate temperature curve must be activated before the property definition.

```
ACTSET,TP,temp_curve_no
MPROP,mat_set_no,mat_name,mat_values
```

**Example 3**
Examples for isotropic and orthotropic materials are shown below:

For isotropic materials defined as material set 1 and associated with temperature curve 0, i.e., no temp curves.

```
ACTSET,TP,0
  Set temp curve equal to zero
MPROP,1,EX,value
  Young's modulus
MPROP,1,NUXY,value
  Poisson's ratio
MPROP,1,ALPX,value
  Coeff of thermal expansion
MPROP,1,DENS,value
  Mass density
MPROP,1,GXY,value
  Shear modulus
```
MPROP,1,SIGYLD,value
  Yield stress
MPROP,1,ETAN,value
  Tangent modulus
MPROP,1,SIGXT,value
  Tensile strength in material x-dir
MPROP,1,SIGYT,value
  Tensile strength in material y-dir
MPROP,1,SIGXC,value
  Compressive strength in material x-dir
MPROP,1,SIGYC,value
  Compressive strength in material y-dir
MPROP,1,SIGXYT,value
  Tensile shear strength in material xy-plane
MPROP,1,SIGXYC,value
  Compressive shear strength in material xy-plane
MPROP,1,KX,value
  Thermal conductivity
MPROP,1,EMIS,value
  Emissivity
MPROP,1,HC,value
  Convection film coeff
MPROP,1,C,value
  Specific heat
MPROP,1,DAMP,value
  Material damping coeff
MPROP,1,VISC,value
  Viscosity
MPROP,1,MPERM,value
  Magnetic permeability
MPROP,1,PERMIT,value
  Permittivity (dielectric constant)
MPROP,1,PMAGX,value
  Coercivity of a permanent magnet
MPROP,1,ECON,value

*Electric conductivity*

For orthotropic materials, additional properties are required as shown below:

MPROP,1,EY,value
MPROP,1,EZ,value

*Young's moduli and other properties for other directions*

MPROP,1,NUYZ,value
MPROP,1,NUXZ,value
MPROP,1,ALPY,value
MPROP,1,ALPZ,value
MPROP,1,GYZ,value
MPROP,1,GXZ,value

ACTSET,TP,0

It is recommended that after defining each material set, the temperature curve be set equal to zero.

For other property definitions including the anisotropic materials, see the element sections noted above; also, see the MPROP command description in the Command Reference Manual. Note that you can define as many as 90 different material sets. It is suggested that before each new material set, the temperature curve be set equal to 0.

**Coordinate System Definition Commands (Fifth command block)**

Three types of coordinate systems can be defined, namely, Cartesian, Cylindrical, and Spherical. The global Cartesian, Cylindrical, and Spherical coordinate systems are predefined and are denoted by coordinate labels 0,1,2. Local coordinate system definitions start from label 3, and can be specified as one of the three types noted above. A total of 500 coordinate systems may be specified. For more information on this topic, please see Section 3.1 of Chapter 3 in this manual.

Local coordinate systems can be defined in three different ways, using three different commands as shown below:

1. Defining point at origin, point on x-axis, and point on xy-plane.

   CSYS,cs_label,cs_type,pt_at_origin, pt_on_x-axis,pt_on_xy-plane
2. Defining coordinates of the origin and three rotations with the respect to global Cartesian axes.
   
   \texttt{CSANGL,cs\_label,cs\_type,x\_origin,y\_origin, z\_origin,x\_rot,y\_rot,z\_rot}

or

3. Defining a \((4 \times 3)\) matrix, where first three rows define the orientations of the new axes, and the fourth row establishes its origin relative to the Global Cartesian system. This command is intended for use primarily with IGES files when transformations are needed in a direct manner.

   \texttt{CSMATRIX,cs\_label,cs\_type,T[1,1],T[1,2], T[1,3],T[2,1],...,T[4,3]}

The command to delete a defined coordinate system is:

\texttt{CSDEL,beg\_cs,end\_cs,increment}

**Node Definition Commands** (Sixth command block)

The coordinates are specified in the Global Cartesian system.

\texttt{ND,1,X\_coord,Y\_coord,Z\_coord}

\texttt{ND,2,X\_coord,Y\_coord,Z\_coord}

\texttt{ND,3,X\_coord,Y\_coord,Z\_coord}

*Continue until all nodes are defined.*

**Element Definition Commands** (Seventh command block)

After defining all the nodes, the element connectivity should be defined. However before each group of elements, the appropriate element group number and the corresponding material property and real constant sets, and also the element coordinate system must be activated. These are considered the element ATTRIBUTES and must be specified before defining each group of elements as shown below:

\texttt{ACTSET,EG,el\_group\_no}

\texttt{ACTSET,RC,rc\_set\_no}

\texttt{ACTSET,MP,mat\_set\_no}

*Element group number, property and real constant set numbers should correspond to the correct ones already defined for each element type.*
ACTSET,ECS,-1

Set ECS always equal to -1.

EL,el_label,geom_type,geom_label,num_nodes,node(1),node(2),...node(20)

Note that each element depending on its type should be associated with the appropriate geometry, i.e., concentrated mass elements with points (PT), beam and truss elements with curves (CR) or contours (CT), shell and triang elements with surfaces (SF) or regions (RG), and different tetra and solid elements with volumes (VL). The label of geometric entities will be specified as 0 for all cases when only the finite element information is created and the geometry is left out.

Example 4
Element commands for zero-, one-, two-, and three-dimensional type elements are shown below with the activation of their attributes. Depending on the model one or more of these element groups may be defined.

ACTSET,EG,1
ACTSET,RC,1
ACTSET,MP,1
ACTSET,ECS,-1
EL,1,PT,0,1,8

A mass elem associated with pt 0 defined at node 8

EL,2,PT,0,1,9

A mass elem associated with pt 0 defined at node 9

ACTSET,EG,2
ACTSET,RC,2
ACTSET,MP,1
ACTSET,ECS,-1
EL,3,CR,0,3,10,11,20

Two beam elements associated with curve 0 and defined with 3 nodes where the third node specifies cross-sectional orientation of the beam.

EL,4,CR,0,3,11,12,20
ACTSET,EG,3
ACTSET,RC,3
ACTSET,MP,2
ACTSET,ECS,-1
Two shell or triangular PLANE2D elements associated with surface 0 and defined with 3 nodes

ACTSET,EG,4
ACTSET,RC,4
ACTSET,MP,2
ACTSET,ECS,-1
EL,7,VL,0,4,1,5,6,10
EL,8,VL,0,4,5,6,10,12

Two tetra elements associated with volume 0 and defined with 4 nodes.

Similar type commands should be used until all element groups representing the model are properly defined.

Displacement Boundary Condition Commands (Eighth command block)

The following set of commands may be used only if displacement boundary conditions are to be applied.

ACTSET,CS,0

Activate Global Cartesian Coordinate System. Boundary conditions may also be applied in the global cylindrical or spherical systems by issuing 1 or 2 instead of 0.

DND,beg_node,dof_label,disp_value,end_node,increment,add_dof_label

See the Command Reference Manual for more information on the DND command.

Example 5

ACTSET,CS,0

Activate Global Cartesian coordinate system or other systems if required.

DND,2,UX,0,2,,UY,RZ
DND,3,UX,0,3,,UY,RZ
Displacements in X and Y directions and rotations about Z axis are set equal to zero for nodes 2, 3, and 5.

Alternatively, the displacement boundary conditions can be specified for each node and DOF direction separately.

Deletion command for deleting defined Boundary Conditions. (If all boundary conditions are to be deleted, then one command could be used to delete them all as shown in the example.)

Example 6

This command deletes all B.C. labels applied to any sequence of nodes in the range between 1 and 1000. In this example it is assumed that the maximum node label is 1000.

These commands delete the displacement UX and UY applied to nodes 20 and 21.
Structural Loading: Nodal Forces and Element Pressures (Ninth command block)

Nodal force and/or element pressure commands must be used only if required. Structural loads can be defined as different load cases and may be associated with different time curves. Therefore activate the appropriate load case number and time curve number prior to load definitions. The time curve number may be arbitrarily set equal to 1 if there is no way to specify it.

1. Nodal Force (nodal forces may be applied in other coordinate systems).
   - ACTSET,LC,load_case_no
   - ACTSET,CS,coord_sys_no
   - ACTSET,TC,time_curve_no
   
   Activate the load case number, the coordinate system in which the load is to be applied and also the time curve to be associated with the load.

   FND,beg_node,force_dir,force_value, end_node,increment

   See the Command Reference Manual for more information on the FND command.

   Example 7
   
   ACTSET,LC,1
   ACTSET,CS,0
   
   Forces will be applied in global Cartesian system.

   ACTSET,TC,1
   FND,8,FY,100.0,8,
   FND,9,FY,100.0,9,
   FND,12,FZ,150.0,12,
   ACTSET,CS,0
   ACTSET,TC,0
   
   It is useful to deactivate coordinate system and time curve after each load definition to avoid confusion when other load conditions are defined.

2. Pressure loading on element faces.
   - ACTSET,LC,2
ACTSET, TC,
   *Activate the appropriate load case number and the associated time*
   *curve number (set time curve always equal to 1).*
PEL, beg_elem, press_value, face_no, end_elem, increment

See the Command Reference Manual and also the sections of Chapter 4 in this
manual which were referenced above for element face numbers needed for
element pressure definition.
The convention used by COSMOS/M simply requires that the pressure be
applied to the correct element face number. A positive pressure value
corresponds to inward pressure normal to that element face.

**Example 8**

ACTSET, LC, 2
ACTSET, TC, 1
PEL, 10, 50.0, 5, 10,
PEL, 11, 50.0, 5, 11,
PEL, 12, 50.0, 5, 12,

_A pressure of 50.0 psi is applied to face 5 of elements 10, 11, and 12
as the 2nd load case._

ACTSET, TC, 0

3. Commands for deleting nodal forces and/or element pressures.
a. Nodal force delete command:
   FNDEL, beg_node, force_dir, end_node, increment
b. Element pressure delete command:
   PEDEL, beg_elem, face_no, end_elem, increment

**Example 9**

*Nodal Force Delete Example:*

FNDEL, 1, ALL, 200, 1

_This command deletes all loads applied to any sequence of nodes in
the specified range of 1 to 200._

FNDEL, 10, FX, 10, 1
FNDEL, 10, FY, 10, 1
FNDEL, 10, MZ, 10, 1
FNDEL,11,FX,11,1
FNDEL,11,FY,11,1
FNDEL,11,MZ,11,1

These commands delete force and moment components FX, FY, MZ applied to nodes 10 and 11, respectively.

Element Pressure Delete Example:

PEDEL,1,5,1000,1

This command deletes pressure applied to face 5 of all sequence of elements in the specified range of 1 to 1000.

Reaction Force Calculation Commands (Tenth command block)

Ignore reaction force calculation commands if not required.

REACTION, on/off

See the Command Reference Manual for more information on the REACTION command. Please note that reaction force calculation is applicable for nodes and degrees of freedom that have already been constrained.

Example 10

REACTION,1,

Reaction forces are to be calculated for all constrained degrees of freedom.

Gravity and Centrifugal Loading Option Commands (Eleventh command block)

Ignore gravity and centrifugal loading commands if not required.

ACTSET,LC,load_case_no
ACTSET,TC,time_curve_no

Activate the appropriate load case and time curve numbers.

ACEL,accel_x,accel_y,accel_z

Gravitational acceleration.

OMEGA,omega_x,omega_y,omega_z

Angular velocity.
Example 11

ACTSET,LC,3
ACTSET,TC,1
ACEL,0.0,0.0,386.4

Gravitational acceleration of 386.4 in Z-dir.

ACTSET,TC,0

See the Command Reference Manual for information on the **ACEL** and **OMEGA** commands. Note that with the **ACEL** command the gravitational acceleration should be defined in the proper Global Cartesian direction. Also the mass density for all material sets should be given. The **OMEGA** command is necessary when centrifugal loading is to be specified in which case the **ACEL** command is not needed, unless both centrifugal and gravity loadings are to be applied.

### Nodal Temperature Commands (Twelfth command block)

Ignore nodal temperature loading commands if not required.

- ACTSET,LC,load_case_no
- ACTSET,TC,time_curve_no
- NTND,beg_node,temp_value,end_node,increment

See the Command Reference Manual for more information on the **NTND** command.

Example 12

ACTSET,LC,1
ACTSET,TC,1
NTND,10,150.0,10,,
NTND,15,150.0,15,,
NTND,20,150.0,20,,
ACTSET,TC,0

For linear static analysis, thermal loadings may be considered at any load case, and their effects will be combined with other mechanical loadings. For NSTAR, the temperatures defined at the active load case are considered. For heat transfer analysis problems, all thermal boundary conditions may be associated with the time curves and some with temperature curves as noted below. It should be mentioned that load cases need not be activated for thermal loading.
**Nodal Heat Generation Rate Commands** (Thirteenth command block)

Ignore nodal heat generation commands if not required.

ACTSET,TC,time_curve_no
ACTSET,TP,temp_curve_no
QND,beg_node,heat_value,end_node,increment

See the Command Reference Manual for more information on the QND command. Please refer to Appendix B of this manual for detailed explanation of all load units used in conjunction with these commands.

**Example 13**

ACTSET,TC,1
ACTSET,TP,0
QND,50,40.0,50,,
QND,51,40.0,51,,
QND,52,40.0,52,,
QND,53,40.0,53,,
ACTSET,TC,0
ACTSET,TP,0

**Element Heat Generation Rate Commands** (Fourteenth command block)

Ignore element heat generation commands if not required.

ACTSET,TC,time_curve_no
ACTSET,TP,temp_curve_no
QEL,beg_elem,heat_value,end_elem,increment

See the Command Reference Manual for more information on the QEL command.

**Example 14**

ACTSET,TC,1
ACTSET,TP,0
QEL,25,80.0,25,,

---

*COSMOS/M User’s Guide*
Heat Flux Commands on Element Faces (Fifteenth command block)

Ignore heat flux commands if not required.

ACTSET,TC,time_curve_no
HXEL,beg_elem,flux_value,face_no,end_elem,increment

See the Command Reference Manual for more information on the HXEL command.

Example 15
ACTSET,TC,1
HXEL,56,25.0,6,56,,
HXEL,57,25.0,6,56,,
HXEL,58,25.0,6,56,,
ACTSET,TC,0

Convection Film Coefficient and Ambient Temperature on Element Faces (Sixteenth command block)

Ignore convection coefficient commands if not required.

ACTSET,TC,time_curve_no
ACTSET,TP,temp_curve_no
CEL,beg_elem,conv_coeff,ambient_temp,face_no,end_elem,incre,timeCurve

See the Command Reference manual for more information on the CEL command.

Example 16
ACTSET,TC,1
ACTSET,TP,0
CEL,40,525.0,70.0,5,40,,,
CEL,41,525.0,70.0,5,41,,,
CEL,42,525.0,70.0,5,42,,,
ACTSET,TC,0
ACTSET,TP,0

Radiation View Factor, Emissivity, and Ambient Temperature Commands on Element Faces (Seventeenth command block)

Ignore radiation commands if not required.

ACTSET,TC,time_curve_no
ACTSET,TP,temp_curve_no
REL,beg_elem,emiss_value,view_factor,ambient_temp,face_no,end_elem,incre

See the Command Reference Manual for more information on the REL command.

Example 17
ACTSET,TC,1
ACTSET,TP,0
REL,10,1.0,1.5,70.0,5,10,,
REL,11,1.0,1.5,70.0,5,11,,
REL,12,1.0,1.5,70.0,5,12,,
ACTSET,TC,0
ACTSET,TP,0

Absolute Temperature Offset Command (Eighteenth command block)

Ignore the temperature offset command if not required.

TOFFSET,460.0
\textit{In the FPS unit system.}

or

TOFFSET,273.0
\textit{In the MKS unit system.}
Analysis Commands (Nineteenth command block)

Ignore analysis specification commands if not required.

A_STATIC,G
This command must be issued when gravity loading is applied.

A_STATIC,C
This command must be issued when centrifugal loading is applied.

A_STATIC,T
This command must be issued when thermal loading is applied.

A_STATIC,CG
This command must be issued when both gravity and centrifugal loadings are applied.

A_STATIC,GT
This command must be issued when both gravity and thermal loadings are applied.

A_STATIC,CT
This command must be applied when both centrifugal and thermal loadings are applied.

A_STATIC,CGT
This command must be issued when centrifugal, gravity, and thermal loadings are all applied together.

A_FREQUENCY,number_freq
This command must be issued when more than one frequency is to be calculated. The "number_freq" specifies how many frequencies are to be determined.

A_THERMAL,S
This command must be issued for steady state heat transfer analysis.

A_THERMAL,T
This command must be issued for transient heat transfer analysis.

SCALE,
This command must be issued at the end to scale the model to the screen size for proper visual effect.

This completes all nineteen command blocks required by COSMOS/M for the linear static, frequency, buckling, and some thermal problems.
COSMOS/M User’s Guide

Index

Numerics
3 Angles 3-3
3 Points 3-3
3D Solid Meshing 3-31
3D Surface Meshing 3-31

A
ABAQUS 1-3, 3-70
ABAQUS translator C-10
activating a set 3-61
ADAMS 3-70
adaptive H-method 1-9, 4-39, 4-65, 4-71
adaptive HP-method 1-9, 4-39
adaptive meshing 1-6, 3-21, 3-38
adaptive P-method 1-9, 4-33, 4-39, 4-60, 4-112
AISC code 4-12
AISC Sect Table 3-17
analysis 1-28, 3-1, 3-46, 3-47, 3-57
Analysis menu 2-4
angle 3-40
animate 3-54
anisotropic material 1-9, 3-18, 4-58, 4-62
ANS2COS C-1
ANSYS 1-3, 3-71

area 3-40
arithmetic expressions D-4
arithmetic operations D-16
arithmetic operators D-2
arrays 3-72
ASME Boiler 1-15
aspect ratio 3-26, 3-46
ASTAR 1-2, 1-12
asymmetric 1-9, 4-33
AutoCAD 1-3, 1-5
automatic alignment flag 3-10
automatic meshing 1-6, 3-21, 3-24, 3-28, 3-31, 3-34, 5-6
automatic meshing example 5-1
automatic stepping 1-14
average element size 5-11
averaging 3-54, 3-55
axial spring 4-122
axisymmetric 1-9, 1-10, 1-21, 4-33, 4-69, 4-158
axisymmetric models 4-262
axisymmetric shell 3-13

B
bars 3-13
base motion 1-14, 3-41
basic units A-1, A-2
beam 1-9, 3-13
beam loading 4-14, 6-19
beam section 3-18
BEAM2D 4-12, 4-136
BEAM3D 3-22, 4-16, 4-142
behavior constraints 1-18
bending 4-71, 4-77, 4-83, 4-86, 4-95, 4-99, 4-100, 4-106, 4-112, 4-188, 4-198, 4-199, 4-205, 4-210, 4-217
bending moment diagrams 6-19
Bezier curves 3-7
BFGS - Broyden-Fletcher-Goldfarb-Shano 1-14
B-H curve 3-19, 3-67
B-H material curves 1-16
Blatz-Ko 1-13, 4-158, 4-164, 4-170, 4-180
bonding 1-9, 1-11, 3-4, 3-5, 3-39
bonding incompatible meshes 3-21
BOUND 4-122
boundary conditions 1-6, 3-1, 3-4, 3-5, 3-45, 3-69
British system (FPS) 3-18
bubble functions 4-36
buckling 1-17, 3-46, 4-8, 4-10, 4-12, 4-16, 4-28, 4-33, 4-39, 4-44, 4-60, 4-69, 4-71, 4-77, 4-83, 4-86, 4-
Index

buckling loads 6-14
built-in functions D-16, D-19
bulk relaxation 4-202, 4-208
buoy element 4-252
buoyant force 4-243
C
  cables 3-13
cable-type 4-129, 4-133
  CAD 1-2, 1-3, 1-5, 3-75
  capacitance 1-17
carrying the mesh with geometry 3-21
  Cartesian coordinate system 3-2, 3-40
cascading techniques 1-21
cavities 1-21
center of gravity 3-40
centrifugal loading 1-9, 3-41, 3-46
Choosing a Solver 3-49
CLINK 4-255
  coefficient of friction 4-125
  color 3-54–3-69
command language features 1-28
  compatible meshes 3-39
  composite 1-9
  compressible 1-16
  Computervision CADDS5 1-3, 1-5
  concentrated mass element 4-117
  concrete 1-13
  concrete model 4-168, 4-175
  conical curves 3-7
  conjugate 1-15
  consistent units A-5
  console window 2-2
  constraint 1-9, 1-14, 3-41
  contact 1-13, 3-40
  contact lines 3-39
  contact lines and surfaces 3-21
  continuum 3-13
  contour plotting 3-57
counters 3-6, 3-10
control D-38
control commands D-40
control features 3-61
Control menu 2-4, 3-34
count of mesh density 3-4
control structure D-3, D-44
convection 1-15, 3-18, 4-255
convergence 1-14
coordinate systems 3-2, 3-3, 3-55, 3-67
COS2ABQ C-1, C-10
COS2ANS C-11
COS2NAS C-2, C-14
COS2PAT C-1, C-17, C-18
COS2SN D C-2
COSMOS/CA VITY 1-21
COSMOS/FFE 1-3, 1-11
COSMOS/HFS 1-20
COSMOS/HFS 2D 1-20
COSMOS/HFS 3D 1-22
COSMOS/M language D-1
COSMOS/M logo 3-76
COSMOS/M program group 2-2
COSMOS/Works 1-6
Coulomb damping 4-230
  coupling 1-9, 1-11, 1-14, 1-17
  creep 3-41, 4-129, 4-133, 4-158, 4-164, 4-170, 4-180
  creep constants 4-183
  crosstalk 1-21
  current 1-17
  current density 4-267
  current source 4-270
cracked surface connection 5-2
curves 3-6, 3-7
D
damage factor 4-131, 4-168, 4-175
damping 1-12, 1-14, 3-18
damping coefficient 4-9, 4-11, 4-31, 4-46, 4-52, 4-58, 4-62, 4-70, 4-73, 4-79, 4-84, 4-190, 4-195
dashpot 1-12
database 1-28, 3-57, 3-61, 3-63, B-12
database files B-1
default meshing 3-68
defining parameters D-37
defection 4-71, 4-188
deforemed shape 3-57
degenerate 3-46
degrees of freedom 2-11
density 4-62
depth-sort algorithm E-6
design variables 1-18
DesignSTAR 1-5
DEVICES menu 3-73
dielectric material matrix 4-59
dielectric resonators 1-21
direct 1-21
direct iterative 1-17
direct mesh generation 3-21
Direct Sparse 1-26, 3-52
direct sparse 1-27
Direct Sparse solver 1-24, 1-26, 1-27, 3-50, 3-52, 3-53
discrete geometry 3-6
discrete viscous 1-12
dispersion 1-21
displacement 4-188, 4-193, 4-199, 4-205
displacement control 1-13
display 3-54, 3-57
Display menu 2-4
display window 2-2
Displays 3-57
distance 3-40
distortion 1-21, 3-46
distributed 1-15
divergence 1-14
drag force 4-245
dragging 1-6, 3-7, 3-26, 3-36, 5-1
Drucker-Prager 1-13
DSTAR 1-2, 1-10
DXF 3-70
dynamic 1-17
Index

E
Eddy current 1-17
Edit menu 2-4
eigenvalue extraction 6-17
eigenvalues 1-10
elasticity 4-61, 4-129
elasto-plastic models 4-161, 4-167, 4-174
elasto-plasticity 4-136, 4-142
ELBOW 4-31
electric charge density 4-269
electric conductivity 4-9, 4-11, 4-14, 4-23, 4-46, 4-47, 4-62, 4-73, 4-79, 4-190, 4-195, 4-196
electric field 4-267, 4-269, 4-271
electric potential 4-56
electromagnetic 1-20, 1-21, 3-1
electrostatic 1-16
element attributes 3-15
element coordinate system 3-15, 3-20, 3-67, 4-2, 4-231, 4-233
element group 1-6, 1-27, 4-1
element library 1-6, 1-27, 4-1
element size 3-34, 3-38
elements 3-4
elements display 3-60
emissivity 4-254
end-release code 4-13, 4-17, 4-19
erasing 3-61
error messages B-1
escape key 2-5
ESTAR 1-2, 1-16
Eureka 1-3, 1-5
examples 5-1
extreme 3-55
extruding 1-6, 3-7, 3-26, 3-36
F
failure analysis 4-211, 4-212, 4-215, 4-217, 4-221
failure criteria 1-9, 4-100, 4-101, 4-106
fatigue events 1-15
fatigue location 3-67
features 1-27
FFE FREQUENCY 1-2
FFE Frequency 1-11
FFE STATIC 1-2
FFE Static 1-11
FFE THERMAL 1-2
FFE Thermal 1-11
File menu 2-4
film coefficient 1-16, 4-255
finite element mesh 3-4
finite rotation 4-136, 4-142
flexural stiffness 4-190, 4-195, 4-201, 4-207
flipping 3-7, 3-11
FLOW2D 4-262
FLOW3D 4-264
FLOWPLUS 1-2
fluid elements 4-47
fluid flow 3-1, 4-262
fluid-solid 1-9
fluid-solid interaction 4-33, 4-44
force control 1-13
foundation stiffness 4-79, 4-81, 4-97
frequency domain 1-21
frequency shift 1-10
friction 1-13
friction effect 4-232
friction force 4-236
FSTAR 1-2, 1-15
full integration 4-37, 4-45, 4-50, 4-56, 4-170
functions 3-72, D-39
G
GAP 4-230
gap 1-9, 1-12, 1-13, 3-22, 3-45
gap distance 4-124
gap/contact 1-23, 3-48
Gauss integration 4-36, 4-37
general stiffness element 4-229
GENSTIF 4-126, 4-228
Geo panel 2-2
Geo Panel window 1-5
generic entities 3-4, 3-6
generic file format 1-8, 2-6
generic nonlinearity 1-13, 4-170
generic stiffness 4-44, 4-60
geo-coordinate 3-1
Geometry menu 2-4
gyometric-dependent mesh generation 3-5
GEOSTAR 1-4, 1-27
GEOSTAR screen 2-2
GFM File 1-8
gliding 1-6, 3-7, 3-26, 3-36
global Cartesian system 3-67
global coordinate systems 4-2
gravitational loading 1-9
gravity 3-41, 3-46
grid 2-15
guiding structure 1-21
Guyan 1-10
H
hard copies 3-54, 3-74
harmonic 3-41
heat flow 4-254, 4-255
heat flux 1-16
heat sources 1-10
heat transfer 1-18
Helix Design System 1-3, 1-5
heterogeneous 3-18
hexahedral 3-13
HFS 2D 1-2
HFS 3D 1-2
HFS CAVITY 1-2
hierarchical 3-6, 3-25
HLINK 4-260
H-method 1-6, 2-10
homogeneous 3-18
HP-version 3-13, 3-38
HSTAR 1-2, 1-10
H-version 3-13, 3-38
hybrid element 4-45, 4-50
hydrodynamic 4-240, 4-252
hydrodynamic effects 4-244
hydrostatic 4-240, 4-252
hydrostatic pressure 4-243, 4-244
Index

hyperelasticity 1-13

I
icon 2-2, 2-5
IDEAS (SDRC) 1-3, 1-5
identify 3-27
IF statement D-40
IF-ELSE control structure D-41
IGES 1-3, 1-5, 3-70
Ill-conditioned 1-23, 3-48
image mapping 3-74
images 3-54, 3-73, 3-74
IMPIPE 4-240, 4-252
importing 3-61, 3-63
incompatible mesh 3-37
incompressible 1-16
infinite elements 1-16
initial axial force 4-130
initial axial strain 4-130
inplane 1-9, 1-10
inplane loading 3-46, 4-8, 4-10, 4-12, 4-16, 4-28, 4-33, 4-39, 4-44, 4-60, 4-69, 4-71, 4-77, 4-83, 4-86, 4-90, 4-95, 4-100, 4-106, 4-112
input file structure 1-28, F-1
integration method 4-87, 4-113
interaction 3-43
interactive mode 2-3
interface 3-70
interference problems 4-233
internal friction 4-183
internal pressure 4-29, 4-32, 4-243
International System (SI) 3-19, A-1
intersection 3-66
inverse power 1-10
isoparametric 4-158
isosurface 3-58
isotropic 1-9, 3-18, 4-46, 4-50, 4-57, 4-59, 4-67, 4-69, 4-100
isotropic heat conduction 3-18
isotropic thermal expansion/contraction 3-18
Iterative 3-49
iterative 1-21
Iterative (PCG) 3-50
J
Jacobi 1-10
J-integral 1-14
K
keypoint 2-32, 3-6, 3-7, 3-22
keypoint merging tolerance E-2
labels 3-67
laminated composites 4-112, 4-211, 4-212, 4-217
Lanczos 1-10
large displacement 1-13, 4-129, 4-133, 4-136, 4-142, 4-158, 4-164, 4-170, 4-180, 4-188, 4-193, 4-199, 4-205, 4-211, 4-224, 4-240
large displacement analysis 4-217
large displacement formulation 4-194, 4-206, 4-212, 4-218
large strain formulation 4-165, 4-181
lattice geometry 3-6
length 3-13, 3-40
limit load analysis 1-14
line search 1-14
linear 1-10
linear elastic anisotropic 3-18
linear elastic isotropic 3-18
linear elastic material 4-139, 4-150, 4-212
linear elastic orthotropic 3-18
linear elasticity 4-133, 4-136, 4-142, 4-240
linear static 3-45
load 1-6, 3-1, 3-4, 3-5, 3-69
load case 3-45, 3-54, 3-55, 3-67
LoadsBC menu 2-4
local coordinate system 3-20, 4-2
local mesh control 3-21, 3-36
logic expressions D-3, D-38
lower entities E-3
lumped mass 4-223
M
macro 1-7, 1-28, 3-54, 3-72, D-3, D-44, D-46
MAG2D 4-266
MAG3D 3-23, 4-268
magnet demagnetization 1-16
magnet flux 4-269
magnetic current 4-269
magnetic current density 4-271
magnetic field 4-267, 4-269, 4-271
magnetic flux 4-267, 4-271
magnetic forces 4-267, 4-269, 4-271
magnetic potential 4-266, 4-268, 4-270
magnetostatic 1-16
MASS 3-22, 4-117, 4-223
mass material properties 3-18
mass property 3-40
material angle 4-51, 4-52, 4-212
material coordinate system 4-45, 4-62
material curve 3-67
material damping 4-14, 4-23, 4-88
material direction 4-52, 4-57, 4-61, 4-182
material property 3-1, 3-15, 3-18, 3-46, 3-67
membrane 4-69
membrane 4-71, 4-77, 4-83, 4-86, 4-95, 4-99, 4-100, 4-106, 4-112, 4-188, 4-198, 4-199, 4-205, 4-210, 4-217
membrane structures 4-72, 4-96
memory 1-23, 3-48
merge 2-20
mesh 3-1, 3-20, 3-57
mesh density 3-34, 3-37
mesh generation 1-6, 3-5
mesh refinement 3-21, 3-38
Meshing menu 2-4
METAFILE 3-75, 3-79
metric system 3-19
MicroStation Modeler 1-3, 1-5
microwave 1-20
millimeter-wave 1-20
Miner’s Rule 1-15
mixed boundary representation 1-4
modal 1-12
mode 3-74
mode extraction 1-25, 1-26
mode shape 1-10, 6-17
modeling 1-5
modeling procedures 1-28
modified element coordinate system 4-83, 4-86, 4-211
modified feasible directions 1-20
modified Newton-Raphson 1-13
modified Raphson 1-13
modular 1-1
moment 6-1
moments of inertia 3-40
Mooney-Rivlin 1-13, 4-158, 4-164, 4-170, 4-180, 4-188, 4-193, 4-199, 4-205
multi-base 1-12
multi-layer 4-50, 4-106
multiple load cases 1-9, 1-17
multiple selection lists 3-66
modified Newton-Raphson 1-13
modified Raphson 1-13
neutral file format 1-8
neutral format 2-6, 3-61, 3-62, 3-63
new problem 3-64
Newmark-Beta 1-14
Newtonian 1-15
Newton-Raphson 1-11, 1-13, 1-17
node-to-line 4-230, 4-234
node-to-node gap 4-230, 4-232,
4-233
node-to-surface 4-230, 4-234
non-axisymmetric 4-69
nonlinear 1-10, 1-18
nonlinear analyses 3-46
nonlinear elastic behavior 4-224
nonlinear elasticity 1-13, 4-136,
4-158, 4-164, 4-170, 4-180, 4-188,
4-193, 4-199, 4-205
nonlinear material 3-18, 4-139, 4-150
non-parametric 3-6, 3-23
non-uniform 3-23
nonuniform contours 3-10
normalized distance 3-58
NSSTAR 1-2, 1-13
Nusselt number 4-260
O
objective function 1-19
Ogden 1-13, 4-158, 4-164, 4-170,
4-180
Ogden hyperelasticity 4-188, 4-
193, 4-199, 4-205
one-dimensional line elements 3-13
one-node gap 4-233, 4-236
OPTSTAR 1-2, 1-17
orientation 3-68, 4-142
orientation angle 4-17, 4-19, 4-
143, 4-145
orthotropic 4-188, 4-193, 4-199,
4-205, 4-211
orthotropic 1-9, 3-18, 4-36, 4-46,
4-47, 4-50, 4-57, 4-59, 4-61, 4-67,
4-69, 4-100, 4-103, 4-115, 4-184
orthotropic heat conduction 3-18
orthotropic material 4-109, 4-
161, 4-167, 4-174, 4-214, 4-220
orthotropic thermal expansion/contraction 3-18
oscillators 1-21
output file 2-7
Output Options submenu 2-7
P
paper 3-74
paper setting 3-76
parameters D-6
parametric 1-7, 3-23
parametric entities 3-6
parametric expression D-4, D-38
parametric expressions 3-72, D-
6, D-39, D-44
parametric meshing 3-21
parametric variables 5-2, D-2, D-
11, D-39
parasitic shear effects 4-36
part 3-25
parts 3-6, 3-11
PAT2COS C-1, C-17, C-18
PATRAN 1-3
PCG 3-49
PCG_OPTIONS 3-50
PCX 3-75
picture manipulation 3-60
piezoelectric 1-10
piezoelectric material matrix 4-
59
piezoelectric solid element 4-56
PIPE 4-28
pipe intersection 5-2
plane strain 4-33, 4-39, 4-158, 4-
164
plane stress 2-11, 4-33, 4-39, 4-
158, 4-164
PLAN2D 3-22, 3-38, 4-33, 4-56,
4-158
plasticity 4-129, 4-133, 4-158, 4-
164, 4-170, 4-180, 4-188, 4-193, 4-
199, 4-205
plates 3-13
plotting 3-68
plotting X-Y type graphs 3-20
P-method 1-7, 2-10
Poisson's ratio 4-61
polyhedra 3-6, 3-11, 3-23
polyhedron 3-25
popped 3-60
porous 1-15
post-buckling 1-14
Index

POSTNAS C-2, C-14, C-16
postprocessing 1-8, 3-5, 3-53
postprocessing functions D-16
postprocessor 1-2
potential voltage 4-267, 4-269, 4-271
potentials 1-17
power losses 4-267, 4-269, 4-271
Prandtl number 4-260
predefined functions D-16
predefined variables D-10
preprocessing 3-4
prescribed 1-11, 1-14
prescribed displacements 1-9
Pressure Vessel Code 1-15
primary load cases 3-45, 3-55
principal stresses 4-36, 4-41, 4-48, 4-73, 4-79, 4-85, 4-92, 4-97, 4-103, 4-110, 4-191, 4-196
Print Ops 4-131, 4-162, 4-168, 4-184
prism 1-15
Pro/ENGINEER 1-3, 1-5, 3-71
PRO2GEO C-1, C-19
problem title 3-62
Propsets menu 2-4, 2-12
PSD 1-12
pseudo-variable 3-41
PT/Modeler 1-3, 1-5
pull-down menus 1-5, 2-4
push button 2-4
P-version 3-13, 3-38

Q
QM6 4-36
QM6 incompatible element 4-34, 4-158
Quasi-Newton (BFGS) 1-14

R
radiation 3-18, 4-254
radiation view factors 1-11
radiative 1-16
radii of gyration 3-40
random 3-41
RBAR 4-121
real constant 3-15, 3-17, 3-46, 3-67
real constant set 4-2
real constant sets 2-8, 2-12
reduced integration 4-34, 4-36, 4-44, 4-56, 4-83, 4-171
regeneration 3-26
region meshing 5-1
regions 3-6, 3-10, 3-23, 3-25
reparameterization 3-8
repetition D-38
resetting 3-61
resized 3-60
resonant 1-21
restart 1-14, 1-20
restore 1-20
restoring 3-74
Results menu 2-4
Reynolds number 1-16, 4-245, 4-260
rigid 4-121
rigid body 4-121
rigid body modes 1-25, 3-51
Riks arc-length control 1-13
RLINK 4-254
rods 3-13
rotational spring 4-122

S
sandwich plate 4-101, 4-212
saving 3-62, 3-73, 3-74, 3-78
scaling 3-54
scattering 1-21
screen 3-54, 3-60, 3-61
searching 3-54
secondary load cases 3-45, 3-55
sectioning 3-58
SELECT submenu 3-34
selection list 1-7, 3-65, 3-67, 5-2
semi-batch 2-3
sensitivity 1-7, 1-17, 1-19
sequence D-37
session file 1-8, 2-6, 3-61, B-1
shade 3-27
shape 1-18
shape optimization 1-17
shear 4-86
shear center 4-142
shear deformation 4-83, 4-193
shear diagrams 6-1
shear factor 4-13, 4-17
shear forces 6-19
shear modulus 4-62
shear panel 4-72, 4-91
shear relaxation 4-202, 4-208
shell 3-13
SHELL3 3-39, 4-71, 4-188, 4-199
SHELL3L 3-24, 4-100, 4-211
SHELL3T 3-24, 3-39, 4-71, 4-188, 4-198, 4-199
SHELL4 3-22, 4-77, 4-193
SHELL4L 4-106, 4-217
SHELL4T 4-95, 4-205
SHELL6 4-83
SHELL9 4-86
SHELL9L 3-38, 4-112
SHELLAX 4-69
shock spectra 1-12
shrink 3-27, 3-61
shrink fit 4-233
SI system A-2
SINDA 1-3, 3-71, C-20, C-24, C-25
single variables 3-72
singular value decomposition 1-20
sinks 1-10
size limitations 3-79
size limits 3-31
sizing 1-17, 1-18
skewed 3-46
skyline 3-46
small displacement formulation 4-194, 4-206, 4-212, 4-218
small strain formulation 4-165, 4-181
snapping 3-7
snap-through/snap-back 1-14
soft spring 1-9, 1-10
### Index

<table>
<thead>
<tr>
<th>SOLID</th>
<th>3-23, 4-44, 4-170</th>
</tr>
</thead>
<tbody>
<tr>
<td>solid element</td>
<td>4-60, 4-65</td>
</tr>
<tr>
<td>Solid/Edge</td>
<td>1-3, 1-5</td>
</tr>
<tr>
<td>SOLIDL</td>
<td>4-50</td>
</tr>
<tr>
<td>SOLIDPZ</td>
<td>4-56</td>
</tr>
<tr>
<td>SolidWorks</td>
<td>1-3, 1-5</td>
</tr>
<tr>
<td>SOLID</td>
<td>4-50</td>
</tr>
<tr>
<td>SOLIDPZ</td>
<td>4-56</td>
</tr>
<tr>
<td>SolidWorks</td>
<td>1-3, 1-5</td>
</tr>
<tr>
<td>sorting</td>
<td>3-54</td>
</tr>
<tr>
<td>Spars</td>
<td>3-48</td>
</tr>
<tr>
<td>Sparse solver</td>
<td>3-51</td>
</tr>
<tr>
<td>sparse solver</td>
<td>3-48</td>
</tr>
<tr>
<td>specific heat</td>
<td>4-62</td>
</tr>
<tr>
<td>Spectra</td>
<td>3-41</td>
</tr>
<tr>
<td>spherical</td>
<td>3-2</td>
</tr>
<tr>
<td>SPICE</td>
<td>1-21</td>
</tr>
<tr>
<td>splines</td>
<td>3-7</td>
</tr>
<tr>
<td>SPRING</td>
<td>4-118, 4-224</td>
</tr>
<tr>
<td>standard functions</td>
<td>D-16</td>
</tr>
<tr>
<td>STAR</td>
<td>1-2, 1-9</td>
</tr>
<tr>
<td>static</td>
<td>1-17</td>
</tr>
<tr>
<td>Status1 table</td>
<td>3-67</td>
</tr>
<tr>
<td>Status2 table</td>
<td>3-69</td>
</tr>
<tr>
<td>Status3 table</td>
<td>3-69</td>
</tr>
<tr>
<td>steady-state</td>
<td>1-10, 1-12</td>
</tr>
<tr>
<td>Stefan-Boltzman constant</td>
<td>4-254</td>
</tr>
<tr>
<td>step</td>
<td>3-41</td>
</tr>
<tr>
<td>step-by-step</td>
<td>1-27, 2-11</td>
</tr>
<tr>
<td>stiffeners</td>
<td>3-13</td>
</tr>
<tr>
<td>straight lines</td>
<td>3-7</td>
</tr>
<tr>
<td>STRESS</td>
<td>1-9</td>
</tr>
<tr>
<td>structural</td>
<td>3-1</td>
</tr>
<tr>
<td>Sturm sequence</td>
<td>1-10</td>
</tr>
<tr>
<td>submodeling</td>
<td>1-9</td>
</tr>
<tr>
<td>subsonic</td>
<td>1-16</td>
</tr>
<tr>
<td>subspace</td>
<td>1-10</td>
</tr>
<tr>
<td>substructuring</td>
<td>1-9, 6-1</td>
</tr>
<tr>
<td>substructuring analysis</td>
<td>6-25</td>
</tr>
<tr>
<td>superposition</td>
<td>3-45</td>
</tr>
<tr>
<td>supersonic</td>
<td>1-16</td>
</tr>
<tr>
<td>surface</td>
<td>3-25</td>
</tr>
<tr>
<td>surface intersection</td>
<td>5-1, 5-37</td>
</tr>
<tr>
<td>surfaces</td>
<td>2-18, 2-32, 3-5, 3-6, 3-7, 3-23</td>
</tr>
<tr>
<td>sweeping</td>
<td>1-6, 3-7, 3-26, 3-36</td>
</tr>
<tr>
<td>symbol size</td>
<td>3-61</td>
</tr>
<tr>
<td>symbols</td>
<td>3-64</td>
</tr>
<tr>
<td>symmetric</td>
<td>4-33</td>
</tr>
<tr>
<td>symmetry</td>
<td>3-7, 3-9, 3-11, 3-35</td>
</tr>
<tr>
<td>T</td>
<td>tabulating results</td>
</tr>
<tr>
<td>TEAP</td>
<td>3-71</td>
</tr>
<tr>
<td>temperature contours</td>
<td>2-33</td>
</tr>
<tr>
<td>temperature curve</td>
<td>3-67</td>
</tr>
<tr>
<td>Temperature-dependent</td>
<td>4-211</td>
</tr>
<tr>
<td>temperature-dependent</td>
<td>1-9, 1-10, 1-13, 3-19</td>
</tr>
<tr>
<td>temperature-dependent material</td>
<td>4-188, 4-193, 4-199, 4-205, 4-217</td>
</tr>
<tr>
<td>TETRA10</td>
<td>3-24, 3-38, 3-39, 4-180, 4-270</td>
</tr>
<tr>
<td>TETRA4</td>
<td>3-23, 3-24, 3-39, 4-60, 4-180, 4-270</td>
</tr>
<tr>
<td>TETRA4R</td>
<td>3-24, 3-39, 4-65</td>
</tr>
<tr>
<td>tetrahedral</td>
<td>1-15, 3-13</td>
</tr>
<tr>
<td>thermal</td>
<td>1-9, 2-33, 3-1, 3-46, 4-62</td>
</tr>
<tr>
<td>thermal analysis</td>
<td>2-33</td>
</tr>
<tr>
<td>thermal conductivity</td>
<td>2-33</td>
</tr>
<tr>
<td>thermo-plasticity</td>
<td>4-129, 4-133, 4-158, 4-164, 4-170, 4-180</td>
</tr>
<tr>
<td>thick plates</td>
<td>4-71</td>
</tr>
<tr>
<td>three-dimensional elements</td>
<td>3-13</td>
</tr>
<tr>
<td>TIFF</td>
<td>3-75</td>
</tr>
<tr>
<td>time curve</td>
<td>3-67</td>
</tr>
<tr>
<td>title</td>
<td>3-61</td>
</tr>
<tr>
<td>tolerance</td>
<td>E-4</td>
</tr>
<tr>
<td>torsion constant</td>
<td>4-17</td>
</tr>
<tr>
<td>total Lagrangian formulation</td>
<td>1-13, 4-165, 4-181</td>
</tr>
<tr>
<td>transient</td>
<td>1-10, 1-16</td>
</tr>
<tr>
<td>translated</td>
<td>3-60</td>
</tr>
<tr>
<td>translations</td>
<td>3-11</td>
</tr>
<tr>
<td>translators</td>
<td>1-28, C-1</td>
</tr>
<tr>
<td>transonic</td>
<td>1-16</td>
</tr>
<tr>
<td>TRIANG</td>
<td>3-38, 3-39, 4-39, 4-164</td>
</tr>
<tr>
<td>troubleshooting</td>
<td>1-28</td>
</tr>
<tr>
<td>TRUSS2D</td>
<td>3-22, 4-8, 4-129</td>
</tr>
<tr>
<td>TRUSS3D</td>
<td>4-10, 4-133</td>
</tr>
<tr>
<td>Tsai-Wu’s failure</td>
<td>4-211, 4-217</td>
</tr>
<tr>
<td>turbulent flow</td>
<td>1-15</td>
</tr>
<tr>
<td>two-dimensional elements</td>
<td>3-13</td>
</tr>
<tr>
<td>types of arrays</td>
<td>D-11</td>
</tr>
<tr>
<td>U</td>
<td>U.S. Customary Units</td>
</tr>
<tr>
<td>uniform</td>
<td>1-12, 3-23</td>
</tr>
<tr>
<td>uniform contours</td>
<td>3-10</td>
</tr>
<tr>
<td>Unigraphics</td>
<td>1-3, 1-5</td>
</tr>
<tr>
<td>union</td>
<td>3-66</td>
</tr>
<tr>
<td>units</td>
<td>1-28</td>
</tr>
<tr>
<td>updated Lagrangian formulation</td>
<td>1-13, 4-165, 4-181</td>
</tr>
<tr>
<td>usage factor</td>
<td>1-15</td>
</tr>
<tr>
<td>user-defined functions</td>
<td>D-2, D-16, D-18</td>
</tr>
<tr>
<td>user-defined material</td>
<td>1-13, 4-158, 4-170, 4-180</td>
</tr>
<tr>
<td>user-defined stress-strain</td>
<td>1-13</td>
</tr>
<tr>
<td>V</td>
<td>vector display</td>
</tr>
<tr>
<td>very large problems</td>
<td>1-27, 3-53</td>
</tr>
<tr>
<td>view</td>
<td>3-59, 3-60</td>
</tr>
<tr>
<td>view factor</td>
<td>4-254</td>
</tr>
<tr>
<td>viewing transformation</td>
<td>3-60</td>
</tr>
<tr>
<td>virtual displacement</td>
<td>4-266, 4-268, 4-270</td>
</tr>
<tr>
<td>viscoelasticity</td>
<td>1-13, 4-136, 4-142, 4-158, 4-164, 4-170, 4-180, 4-188, 4-193, 4-199, 4-205</td>
</tr>
<tr>
<td>voltage</td>
<td>1-17</td>
</tr>
<tr>
<td>volume</td>
<td>3-6, 3-9, 3-40</td>
</tr>
<tr>
<td>von Mises</td>
<td>1-13, 3-55</td>
</tr>
<tr>
<td>W</td>
<td>warped</td>
</tr>
<tr>
<td>water motion table</td>
<td>4-243, 4-246</td>
</tr>
<tr>
<td>wave theory</td>
<td>4-241, 4-252</td>
</tr>
<tr>
<td>wedge</td>
<td>1-15</td>
</tr>
<tr>
<td>Wilson-Theta</td>
<td>1-14</td>
</tr>
<tr>
<td>window environment</td>
<td>1-7, 3-60</td>
</tr>
<tr>
<td>wrinkling membrane</td>
<td>4-158, 4-164, 4-188, 4-193, 4-199, 4-205</td>
</tr>
<tr>
<td>X</td>
<td>X-Y type</td>
</tr>
</tbody>
</table>
Index

Y
yield factor 4-131, 4-168, 4-175
yield stress 4-183

Z
z-buffer option E-6
zoomin 3-60